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Preface

As part of an effort to improve and enhance the performance and capabilities of its product
lines, EMC periodically releases revisions of its software. Therefore, some functions described
in this document may not be supported by all versions of the software or hardware currently
in use. For the most up-to-date information on product features, refer to your product release
notes.
If a product does not function properly or does not function as described in this document,
please contact your EMC representative.

Audience
This guide is part of the NetWorker documentation set, and is intended for use by
system administrators who are responsible for setting up and maintaining backups
on a network. Operators who monitor daily backups will also find this guide useful.

NetWorker product documentation
This section describes the additional documentation and information products that
are available with NetWorker.
NetWorker 7.6 Service Pack 2 Administration Guide
Describes how to configure and maintain the NetWorker software.
NetWorker Release 7.6 Service Pack 2 Installation Guide
Provides instructions for installing or updating the NetWorker software for clients,
console, and server on all supported platforms.
NetWorker Release 7.6 Service Pack 2 Cluster Installation Guide
Contains information related to installation of the NetWorker software on cluster
server and clients.
NetWorker Release 7.6 Service Pack 2 Release Notes
Contain information on new features and changes, fixed problems, known
limitations, environment and system requirements for the latest NetWorker software
release.
NetWorker Data Domain Deduplication Devices Integration Guide
Provides planning and configuration information on the use of Data Domain devices
for data deduplication backup and storage in a NetWorker environment.
NetWorker VMware Integration Guide
Provides planning and configuration information on the use of VMware in a
NetWorker environment.
EMC NetWorker Release 7.6 Service Pack 2 Administration Guide
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NetWorker Avamar Integration Guide
Provides planning and configuration information on the use of Avamar in a
NetWorker environment.
NetWorker Licensing Guide
Provides information about licensing NetWorker products and features.
NetWorker License Manager 9th Edition Installation and Administration Guide
Provides installation, setup, and configuration information for the NetWorker
License Manager product.
NetWorker 7.6 Service Pack 2 Disaster Recovery Guide
Provides information about preparing for and recovering from a disaster related to
the loss or damage of a NetWorker server, storage node, client, or NMC server.
NetWorker 7.6 Service Pack 2 Error Message Guide
Provides information on common NetWorker error messages.
NetWorker 7.6 Service Pack 2 Performance Optimization Planning Guide
Contains basic performance tuning information for NetWorker.
NetWorker 7.6 Service Pack 2 Command Reference Guide
Provides reference information for NetWorker commands and options.
NetWorker Management Console Online Help
Describes the day-to-day administration tasks performed in the NetWorker
Management Console and the NetWorker Administration window. To view Help,
click Help in the main menu.
NetWorker User Online Help
The NetWorker User program is the Windows client interface. The NetWorker User
Online Help describes how to use the NetWorker User program, which is the
Windows client interface connect to a NetWorker server to back up, recover, archive,
and retrieve files over a network.

NetWorker related documentation
The following documents provide more information about the NetWorker software:
EMC Information Protection Software Compatibility Guide
A list of supported client, server, and storage node operating systems for the
following software products: AlphaStor, ArchiveXtender, DiskXtender for
UNIX/Linux, DiskXtender for Windows, Backup Advisor, AutoStart, AutoStart SE,
RepliStor, NetWorker, and NetWorker Modules and Options.
NetWorker Procedure Generator
The NetWorker Procedure Generator (NPG) is a stand-alone Windows application
used to generate precise user driven steps for high demand tasks carried out by
customers, support, and the field. With the NPG, each procedure is tailored and
generated based on user-selectable prompts. This generated procedure gathers the
most critical parts of NetWorker product guides and combines experts' advice into a
single document with a standardized format.
Note: To access the NetWorker Procedure Generator, log on to
http://www.Powerlink.emc.com. You must have a service agreement to use this site.
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Technical Notes and White Papers
Provides an in-depth technical perspective of a product or products as applied to
critical business issues or requirements. Technical Notes and White paper types
include technology and business considerations, applied technologies, detailed
reviews, and best practices planning.

Conventions used in this document
“UNIX” is used in this guide to denote all suported UNIX and Linux operating
systems.
EMC uses the following conventions for special notices.
Note: A note presents information that is important, but not hazard-related.

IMPORTANT
An important notice contains information essential to operation of the software.
Typographical conventions
EMC uses the following type style conventions in this document:
Normal

Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, buttons,
fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL
statements, keywords, clauses, environment variables, filenames, functions,
utilities
• URLs, pathnames, filenames, directory names, computer names, links, groups,
service keys, file systems, notifications

Bold:

Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services,
applications, utilities, kernels, notifications, system call, man pages
Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, buttons,
fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic:

Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier:

Used for:
• System output, such as an error message or script
• URLs, complete paths, filenames, prompts, and syntax when shown outside of
running text.

Courier bold:

Used for:
• Specific user input (such as commands)

Courier italic:

Used in procedures for:
• Variables on command line
• User input variables

<>

Angle brackets enclose parameter or variable values supplied by the user

[]

Square brackets enclose optional values
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|

Vertical bar indicates alternate selections - the bar means “or”

{}

Braces indicate content that you must specify (that is, x or y or z)

...

Ellipses indicate nonessential information omitted from the example

Where to get help
EMC support, product, and licensing information can be obtained as follows.
Product information — For documentation, release notes, software updates, or for
information about EMC products, licensing, and service, go to the EMC Powerlink
website (registration required) at:
http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on
Powerlink. To open a service request through Powerlink, you must have a valid
support agreement. Please contact your EMC sales representative for details about
obtaining a valid support agreement or to answer any questions about your account.
Your comments
Your suggestions will help us continue to improve the accuracy, organization, and
overall quality of the user publications. Please send your opinion of this document to:
BSGdocumentation@emc.com

If you have issues, comments, or questions about specific information or procedures,
please include the title and, if available, the part number, the revision (for example,
A01), the page numbers, and any other details that will help us locate the subject you
are addressing.
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The EMC NetWorker environment
The EMC® NetWorker® environment provides the ability to protect an enterprise
against data loss. As the enterprise grows, so does the complexity and importance of
protecting data. NetWorker software provides the power and flexibility to meet these
challenges.
The NetWorker software is a cross-platform, client-server application that provides
the ability to remotely manage all NetWorker clients and servers from a web-enabled,
graphical interface.

NetWorker components
Figure 1 on page 32 illustrates the main components in a NetWorker environment.
Console server
All NetWorker servers and clients are managed from the NetWorker Console server.
The Console server also provides reporting and monitoring capabilities for all
NetWorker servers and clients.
Console user interface
The Console server is accessed through a graphical interface that can be run from any
computer that has a supported web browser and Java Runtime Environment (JRE).
The NetWorker Installation Guide provides information on supported web browsers
and versions of the JRE. Multiple users can access the Console server concurrently
from different browser sessions. A computer that hosts the web browser can also be a
NetWorker client.
NetWorker server
NetWorker servers provide services to back up and recover data for the NetWorker
client computers in a datazone.
Datazone
A datazone is a single NetWorker server and its client computers. Datazones can be
added as backup requirements increase.
NetWorker storage node
A NetWorker storage node can be used to improve performance by offloading from
the NetWorker server much of the data movement involved in a backup or recovery
operation.
NetWorker client
A NetWorker client computer is any computer whose data must be backed up. The
NetWorker Console server, NetWorker servers, and NetWorker storage nodes are also
NetWorker clients.
Deduplication nodes
NetWorker supports EMC Avamar® and Data Domain deduplication. The NetWorker
Avamar Integration Guide, provides detailed information about setting up Avamar
deduplication to work with NetWorker. The NetWorker Data Domain Deduplication
Devices Integration Guide provides detailed information about setting up Data Domain
deduplication to work with NetWorker.
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Virtual environments
NetWorker clients can be created for virtual machines for either traditional backup or
VMware Consolidated Backup (VCB). Additionally, the NetWorker software can
automatically discover virtual environments and changes to those environments on
either a scheduled or on-demand basis and provides a graphical view of those
environments.
NetWorker bare metal recovery (BMR) HomeBase Server
A NetWorker BMR server is an EMC HomeBase Server that manages and restores
operating system and server state data, collected as profiles. The HomeBase Server is
the collection point for profiles produced by HomeBase Agents. HomeBase Agents
are automatically installed with the NetWorker client software. The profile data
includes:
◆

hardware configurations

◆

operating system levels

◆

system tuning

◆

network connections

◆

security

◆

storage layouts.

The HomeBase Agent captures this information on a scheduled basis with a
NetWorker save set, and sends the profile results to a HomeBase Server for
management and analysis.
A BMR recovery enables the restoration or migration of a server from one hardware
type to another. This type of recovery begins with the HomeBase Server and the
profile data that is gathered and includes the file system and application data restore
from the NetWorker server through the Console server.
HomeBase Server installation is separate from NetWorker server installation. The
HomeBase Server must be configured and available when:
◆

A BMR client resource is created.

◆

BMR backup data (profiles) are generated from NetWorker clients.

Chapter 26, “Support for HomeBase” provides detailed information on BMR. The
EMC HomeBase product documentation provides details about HomeBase Server
installation, profile management, and recovery specifics.

The EMC NetWorker environment
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GEN-000615

NetWorker components

NetWorker features
This section describes the major features that distinguish the NetWorker software.
Optional additions to the NetWorker software are also listed.

Performance features
Standard NetWorker performance features include:
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◆

Server parallelism, which enables several save streams to flow to the server or
storage node at the same time.

◆

Multiplexing, which enables more than one save stream to write to the same
device at the same time.

◆

Client parallelism, which enables the client to send more than one save stream at
a time.

◆

Session management, which enables one to control the number of save streams
per device to maximize the performance of each device.

◆

Backup to file-based devices and optional subsequent staging and cloning to
near-line or offline volumes.

◆

Backup to a cloud storage configuration.
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Ease of use
NetWorker software provides tools to make protection of critical data easy to
manage. With these tools, you can:
◆

Use either the graphical interfaces or command-line programs to manage
NetWorker tasks and functions.

◆

Use wizards to set up the following NetWorker items:
• Client resources
• AFTD and Data Domain devices
• Common Console configuration tasks
• LDAP user authentication

◆

Administer and configure NetWorker functions from any network computer with
a web browser.

◆

Grant permission to provide directed recovery operations. Directed recovery is
the capability for recovery of one client’s data to another client computer.

◆

Obtain immediate answers to questions by accessing online help and UNIX man
pages. Microsoft Windows users can also access the NetWorker command
reference guide, which provides information similar to the UNIX man pages.

◆

Take advantage of the automatic media management feature to enable the
NetWorker server or storage node to label and mount volumes as needed for
backups.

◆

Drag-and-drop functionality allows for an easy transfer of single or multiple
objects.

◆

Use the integrated knowledge base and technical bulletins at the EMC
Powerlink® website to find answers to common questions.

◆

Automatically discover and view a graphical map of virtual environments.

◆

Set up NetWorker Console server authentication to an external LDAP v3.1
compliant server.

◆

Support for automated Windows Disaster Recovery.

Scalability
NetWorker software can be scaled as storage management needs grow. For example,
you can:
◆

Upgrade the basic level of server functionality, add support for additional (or
larger) autochangers, add support for more clients, or add optional software
modules without the need to reinstall the server software.

◆

Add special NetWorker Module client software to back up databases and other
non-file-system data.

◆

Add support for remote storage nodes to control backup devices, while the data
management tasks remain centralized on a controlling NetWorker server.

◆

Add the NetWorker License Manager (NLM) software to administer all of your
network’s EMC software licenses from a single server.

NetWorker features
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Optional software additions
Optional additions to the NetWorker software include:
◆

NetWorker Autochanger Module

◆

NetWorker Silo Software Module

◆

NetWorker Archive Module

◆

NetWorker Database Modules (for backing up several types of databases)

◆

NetWorker SNMP (Simple Network Management Protocol)

◆

NDMP (Network Data Management Protocol) support

◆

EMC DiskXtender® Data Manager File System Support

◆

Support for OpenVault remote storage systems (Windows only)

◆

Cluster support, including EMC AutoStart™ software

◆

NetWorker License Manager

◆

Advanced reporting capability

IPv4 to IPv6 transition
Internet Protocol version 6 or IPv6 is designed to replace the current Internet Protocol
which is IPv4. IPv6 fixes a number of problems in IPv4, such as the limited number of
available IPv4 addresses. It also adds many improvements to IPv4 in areas such as
routing and network autoconfiguration. IPv6 is expected to gradually replace IPv4,
with the two coexisting for a number of years during a transition period. The
NetWorker Installation Guide provides information about using NetWorker in an IPv6
environment.

Common NetWorker tasks
This section identifies some of the most common tasks performed with the
NetWorker Console. These include:
◆

“How to add a new host” on page 34

◆

“How to schedule a backup” on page 35

◆

“How to configure devices” on page 35

◆

“How to label media” on page 35

◆

“How to view failed backups” on page 36

“NetWorker Management Console interface” on page 36 has information about
starting the NetWorker Console.

How to add a new host
To add a new host in the NetWorker Console:
1. Log in to Console as a NetWorker Administrator.
2. Click the Enterprise button

on the taskbar.

3. Right-click Enterprise in the navigation tree.
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4. Select New > Host.
5. In the Create Host dialog box, type in the new host name and click Next. The
Select Managed Application dialog box appears.
6. Click Next. The Manage NetWorker dialog box appears.
7. Make sure the following checkboxes are enabled:
• For NetWorker: Capture Events and Gather Reporting Data
• For Avamar: Capture Events
8. Click Finish.

How to schedule a backup
To schedule backups from the NetWorker Console:
1. Log in to the Console as a NetWorker Administrator.
2. Click the Enterprise button

on the taskbar.

3. Highlight a host in the navigation tree, right-click NetWorker and select Launch
Application. The NetWorker Administration window appears.
4. Click the Configuration button

on the taskbar.

5. Define schedules, groups, and clients.
“Planning a scheduled backup” on page 54 provides information about scheduling
backups.

How to configure devices
To configure devices from the NetWorker Console:
1. Log in to the Console as a NetWorker Administrator.
2. Click the Enterprise button

on the taskbar.

3. Highlight a host in the navigation tree, right-click NetWorker and select Launch
Application. The NetWorker Administration window appears.
4. Click the Configuration button
5. Click the Devices button

on the taskbar.

on the taskbar.

6. In the navigation tree view, right-click a host and select Scan for Devices.
Chapter 3, “Configuring Libraries and Devices” information about configuring
media.

How to label media
To label tapes from the NetWorker Console:
1. Log in to the Console as a NetWorker Administrator.
2. Click the Enterprise button

on the taskbar.

3. Highlight a host in the navigation tree, right-click NetWorker and select Launch
Application. The NetWorker Administration window appears.
4. Click the Configuration button

on the taskbar.

Common NetWorker tasks
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5. Click the Devices button

on the taskbar.

6. In the navigation tree view, expand Libraries and highlight a library, or select
Devices.
7. In the Device list, right-click a device and select Label.
Chapter 12, “Media Management” provides information about labeling tapes.

How to view failed backups
To see whether any backups have failed:
1. Log in to the Console as a NetWorker Administrator.
2. Click the Enterprise button

on the taskbar.

3. Highlight a host in the navigation tree, right-click NetWorker and select Launch
Application. The NetWorker Administration window appears.
4. Click the Configuration button
5. Click Monitoring

on the taskbar.

.

6. Select Groups in the docking panel.
Chapter 15, “Events and Monitoring” provides information about viewing backup
status information

NetWorker user interfaces
The NetWorker application consists of these user interfaces:
◆

“NetWorker Management Console interface” on page 36

◆

“NetWorker client interface” on page 43

◆

“NetWorker character-based interface” on page 48

◆

“NetWorker command-line interface” on page 48

NetWorker Management Console interface
The interface for NetWorker Management Console, also called the NetWorker
Console, consists of two main windows:

36

◆

Console window

◆

Administration window
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Console window
When NetWorker software is started, the Console window appears as shown in
Figure 2.

Figure 2

Console window

The Console window is the first point of access for NetWorker tasks. Table 1 on
page 37 lists the task-based windows that can be opened from the Console window
taskbar.
Table 1

Button

Windows opened from the Console window

Window

Description

Events

View important messages about all NetWorker servers that have been added
as Enterprise applications, as well as the Console server, and Avamar server.
“Events” on page 388 provides information about managed events.

Enterprise

Select a NetWorker server to manage and monitor the server and its backup
clients. The Enterprise window allows you to open the Administration window
for a NetWorker server.

Libraries

View summary information and manage libraries for all NetWorker servers.
The Administration window can also be opened from this location.

Reports

Configure and view Console reports. Chapter 14, “Reporting.” provides
information about reports.

Setup

Control administrative functions:
• User management — Add, edit, and delete Console user accounts, restrict
user views of servers. “Managing NetWorker Console server users” on
page 406 provides information about user management.
• License management — Manage NetWorker licenses. The new for 7.6
Service Pack 1 NetWorker Licensing Guide provides information about
license management.
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Administration window
NetWorker servers are managed through the Administration window as shown in
Figure 3.

Figure 3

Administration window

You can toggle between the Administration window and the Console window.
Table 2 on page 38 lists the windows that can be launched from the Administration
window taskbar.
Table 2

Button
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Windows launched from the Administration window(1 of 2)

Window

Description

Monitoring

Monitor various activities related to the NetWorker server. For example,
you can monitor the progress of a scheduled backup and view any alerts.
A portion of the Monitoring window appears at the bottom of the
Administration window at all times, providing monitoring information on
Log Messages and Alerts.
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Table 2

Button

Windows launched from the Administration window(2 of 2)

Window

Description

Configuration

Manage the NetWorker server and its resources such as clients, backup
schedules, and policies. For example, you can create a backup schedule,
add NetWorker clients, and apply the backup schedule to several
NetWorker clients.

Devices

Add, configure, and operate single or multiple devices, libraries, and silos
for the NetWorker server.

Media

Manage activities and resources related to backup volumes. For example,
you can mount a backup volume or create a template for labeling backup
volumes.

Starting Console for the first time
These steps assume that the NetWorker software is installed and that all of the
software and hardware requirements have been met on the computer that will access
Console. The NetWorker Installation Guide provides more information.
To open Console for the first time:
1. Start a web browser session.
2. Type the following command to specify the Console server URL:
http://server_name:http_service_port

where:
• server_name is the name of the computer where the Console server component
is installed.
• http_service_port is the IP port for the embedded HTTP server. The HTTP port is
specified during installation. The default HTTP port is 9000.
3. From the Welcome page, click Start NetWorker Management Console.
4. From the Security Warning screen, click Start to run NetWorker Console.
• If the JRE was not already installed on the system, a prompt to install it
appears. Follow the on-screen instructions to install JRE.
• Once the JRE has been installed, the Java Web Start Desktop Integration dialog
box appears.
5. Complete the Java Web Start Desktop Integration banner dialog box by selecting
one of these options:
• To place a shortcut on the desktop, click Yes.
• To decline having a shortcut placed on the desktop, click No.
• To have the option to decide later, click Ask Later.
6. In the NetWorker Management Console Login banner dialog box, type the
username and password.
Note: The default password for the administrator account is administrator. For added
security, change the password during the first login session. “Resetting the administrator
password (native authentication only)” on page 412 provides information if the
administrator password needs to be changed.
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7. Click OK and the Console window appears.
Start Console after the first time
After Console has been started the first time, you can restart it by using any of these
methods:
◆

Point the browser to the same URL. “Starting Console for the first time” on
page 39 provides information.

◆

Double-click the NetWorker Console product name in the Java Web Start
Application Manager.

◆

Double-click the desktop button, if one was set up through the Java Web Start
Application Manager.

Opening the Administration Window
To add and select a NetWorker server and open the Administration window:
1. From the Console window, click Enterprise.
2. Add one or more NetWorker servers:
a. Highlight Enterprise in the navigation tree.
b. From the File menu, select New>Host.
c. Type the name of the host on which the NetWorker server is running and click
Next.
d. Select NetWorker for the type of application to be managed.
e. Click Finish.
f. Repeat for all NetWorker servers in your network.
3. From the left pane, click a host in the Enterprise list.
4. From the right pane, click the application and select Enterprise>Launch
Application, or double-click the application. The Administration window is
launched as a separate application.
Sorting tables
Console software’s organization and display of tabular information can be changed.
Tables can be sorted by column heading, and then by alphabetic or numeric order
within those columns.
To rearrange information in a table:
1. Drag-and-drop the column heading to its new position.
2. Click the column heading to sort the items into alphabetic and numeric order. An
arrow appears in the column heading to indicate the sort order.
Example 1

Sorting managed events

John wants to see all the managed events about servers that were unreachable by the
Console server.
1. From the Console window, John clicks Events.
2. He clicks and drags the Message column until it is over the Priority column,
where he drops it.
3. He clicks the Message column heading so that a down-arrow appears.
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Now he can scan down the list of messages until he finds three servers, all with the
message Unable to connect to server.
John could also generate a Managed Event Details report to get the same
information, which could be printed or exported for use in another application.
Chapter 14, “Reporting” provides more information about reports.
Sorting selected rows in a table
To sort selected rows in a table:
1. From the Edit menu, select Find or press Ctl + F to view the Find panel.
2. Click the rows to be selected or select rows by using the Find criteria.
3. Select Sort Selected.
Selected rows will be sorted to the top of the table. This is particularly useful when
you select Highlight All from the Find panel to select all rows matching the Find
criteria and then moving all selected rows to the top of the table to view the results.
Sorting multiple columns in a table
To sort by two or more columns in a table:
1. Click the column to be used as the last sort key.
2. Click the column to be used as the next-to-last sort key and so on until the
primary column is selected.
For example, given a large table of events, you can select the Time column as the
tertiary sort key, the Category column for the secondary sort key, and the Server
name as the primary sort key. The resulting display would list the servers in
alphabetical order, and the events for each server would be grouped by category and
would display in chronological order.
Displaying columns in a table
To select which columns to display in a table:
1. From the View menu, select Choose Table Columns.
2. Click a column name to select or clear the column and then click OK.
Drag-and-drop functionality
Drag-and-drop functionality is available in the Console and Administration
interfaces to perform the following tasks:
◆

“Drag-and-drop between resource types in the Console window” on page 41

◆

“Client and group management in the Administration window” on page 42

◆

“Library operations in the Devices window” on page 42

◆

“Copy and paste tabular information to operating system clipboard” on page 43

Drag-and-drop between resource types in the Console window
The drag-and-drop functionality allows multiple resources to be selected and moved
from one resource type to another.
In the Enterprise window from the Console interface, you can drag-and-drop to
perform the following actions:
◆

Copy an individual folder in the enterprise hierarchy by selecting the folder,
holding down the Ctrl key, and dragging the folder to a new location.
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◆

Move an individual folder in the enterprise hierarchy to a new location by
selecting and dragging a folder to a new location.

◆

Copy an individual host node in the enterprise hierarchy by selecting and
dragging the host to a new parent folder.

◆

Move an individual host node in the enterprise hierarchy by selecting and
dragging the host to a new parent folder.

◆

Copy a selected number of objects in a folder to a new folder in the hierarchy tree
or folder contents table. Select an individual folder in the navigation tree to
display the contents of the folder, select the contents, hold down the Ctrl key, and
drag the contents to a new folder. Select a collection of folders and/or hosts and
drag them to a new folder by creating a copy of the selected contents in a new
location.

◆

Move a selected number of objects in a folder to a new folder in the hierarchy tree
or folder contents table. Select an individual folder in the navigation tree to
display the contents of the folder, select the contents and drag the contents to a
new folder. Select a collection of folders and/or hosts and drag them to a new
folder by moving the selected contents to a new location.

Note: Only one object may be selected for drag-and-drop in the navigation tree.

Client and group management in the Administration window
The drag-and-drop functionality allows multiple clients or groups to be selected and
moved from one location to another. You can use drag-and-drop functionality in the
Configuration window to do the following:
◆

Copy selected clients to a new NetWorker group. Expand a group in the directory
tree and select. Drag-and-drop the client objects in the Client Summary table to a
new group in the directory tree.

◆

Copy selected clients from one NetWorker group to a new group. Select a group
in the directory tree and move clients from the Client Summary table to another
NetWorker group.

◆

Move selected clients to a new NetWorker group. Expand a group in the directory
tree and select one or more clients. Drag-and-drop the client objects in the Client
Summary table to a new group in the directory tree. This will remove the client
objects from the initial NetWorker group.

◆

Change a group’s current schedule to a selected schedule. Select a group in the
directory tree to display the group objects. Drag-and-drop a schedule in the
Schedule Summary table to a different group in the directory tree.

Library operations in the Devices window
The drag-and-drop functionality allows multiple slots or devices to be managed in
the Devices window. You can use drag-and-drop functionality to manage media from
the Library window from the Devices task, for instance:
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◆

Mount an individual volume onto a device by selecting a slot in the Slots table
and dragging it to a device in the Devices table.

◆

Mount multiple volumes to available devices as assigned by the NetWorker
server by selecting multiple slots in the Slots table and dragging them anywhere
in to the Devices table.

◆

Unmount a volume from a selected device and deposit it back in its designated
slot. To unmount a volume, select an individual device from the Devices table
and drag it anywhere in the Slots table. The volume image will appear in the
corresponding slot.
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◆

Unmount multiple volumes from a selected device and deposit them back in their
designated slot. To unmount multiple volumes, select the devices from the
Devices table and drag them anywhere in the Slots table. The volumes will
appear in the corresponding slots.

Copy and paste tabular information to operating system clipboard
Tabular information can be selected and moved to an operating system clipboard by
using drag-and-drop functionality. All tables support selection of multiple rows in a
table and the ability to copy and paste the data in the selected rows to the system
clipboard. Subsequently, the data in the operating system clipboard can be moved to
a target application.
Note: Drag-and-drop operations from the operating system clipboard to a table are not
supported.

Multiple library devices and slots
A single operation can be performed on multiple library devices and slots. Multiple
rows can be selected in both the Devices and Slots tables simultaneously.
In the Devices table for a library, multiple devices can be selected to perform the
following operations:
◆

Unmount

◆

Release device (STL only)

◆

Enable/Disable

In the Slots table for a device, multiple volume operations can be performed for the
following operations:
◆

Mount

◆

Load without mount

◆

Withdraw

◆

Label

◆

Inventory

◆

Remove (STL and EMC AlphaStor® only)

Setting user interaction preferences
Depending on the window button that was selected (see Table 2), you can set various
user preferences such as the user interface font, font size, parallel windows, and table
settings. For the Reports window, there are ways you can enhance the viewing of
displayed reports.
To set user preferences:
1. Select View on the main menu.
2. Set the various options available under the selected window button. You may
need to click OK, depending on your option selection.

NetWorker client interface
The client interface is where users can recover data and perform manual backup and
archive operations. Manual operations are not scheduled. Instead, they are
performed when a user wants to back up or archive one or more files on the

NetWorker user interfaces

43

Overview

NetWorker client immediately. Scheduled backup and archive operations are set up
through the Console interface. For information about the Console interface, see
“NetWorker Management Console interface” on page 36.
Windows client interface
The NetWorker User program shown in Figure 4 is the Windows client interface.

Figure 4

NetWorker User program

Starting the User program on Windows
To start the NetWorker User program, perform one of the following:
◆

Click the Windows Start button and select Programs>EMC
NetWorker>NetWorker User.

◆

From the Administration window, click Start on the main menu, select
“NetWorker User...” If the NetWorker Module for Microsoft Applications is
installed on the client computer, this operation starts the NetWorker Module for
Microsoft Applications instead.

Note: The NetWorker client package must be installed on the host where you start the
NetWorker User program. Otherwise, you will see an error message similar to the following:
The user program you are trying to run (winworkr) is either not
installed on this computer, or is not in your path.

To start the NetWorker User program, you must belong to the appropriate Windows
groups. Table 3 lists the groups that you must belong to in order to run the
NetWorker User program.
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The Backup Operators and Administrators groups are the local and remote Microsoft
security groups.
NetWorker User Groups requirements

Table 3

Server (domain
controller only)

Logged on

Workstation

Server

Locally

Backup Operators or
Administrators

Backup Operators or
Administrators

Not applicable

To the domain

Domain Administrators

Domain Administrators

Backup Operators or
Administrators

Toolbar buttons
The NetWorker User program has a toolbar with buttons for common User program
tasks. Table 4 describes the function of each button.
Table 4

Button

NetWorker User toolbar functions

Name

Function

Backup

Starts an manual (unscheduled) backup of the client's data to a NetWorker server.

Recover

Starts a recovery operation to retrieve copies of saved data back to the client
computer.

Archive

Starts an archive operation to save copies of data to a server for storage on an
archive volume. Once the data is stored on the archive volume, you have the
option of removing the data from the disk.

Verify

Starts a verification operation to ensure that the data items just backed up are the
same as those currently on the disk.

Browse window
A browse window in the NetWorker User program appears when you select one of
the following:
◆

A toolbar button

◆

A Backup, Recover, Archive, Verify, or Local Directive command from the
NetWorker User File menu
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The browse window, shown in Figure 5 displays the directory tree of the file system
that is being browsed.

Figure 5

Example of the browse window
Note: When you mark a disk volume or directory for an operation, all of its nested
subdirectories and files are also marked.

A checkmark beside an item name indicates that the item is selected for backup,
recovery, archiving, or verification.
The Attributes column indicates any special handling option that was applied:
◆

P — The item is marked for password-protection. “Encrypting backup data” on
page 77 provides more information.

◆

E — The item is marked for password-protection and encryption, using the PW2
ASM. “Encrypting backup data” on page 77 provides more information.

◆

C — The item is marked for compression. “Compressing backup data” on page 78
provides more information.

Connecting to a NetWorker server
A typical user that runs the NetWorker User program needs to connect to the
NetWorker server that performs scheduled backups. However, to perform a directed
recovery or to back up files to another server, you might need to connect to a different
NetWorker server.
Before the NetWorker User program can connect to a NetWorker server, the client
computer must be set up as a Client resource on that NetWorker server. “Task 6:
Create a backup Client resource” on page 59 provides information about creating a
Client resource.
To connect to a NetWorker server:
1. From the Operation menu, select Change NetWorker Server.
2. In the Change Server dialog box, select a server from the list of available
NetWorker servers. If the server is not listed, do one of the following:
• Click Update List to search the network for available NetWorker servers.
• Type the server’s hostname.
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3. Click OK.
UNIX client recover interface
The UNIX version of the NetWorker client interface includes a graphical interface
program, nwrecover, for performing recoveries of backed up data and retrieving
archived data.
Command line utilities are used to perform manual backups (the save command) and
archiving (nsrarchive). For more information on these commands, refer to the EMC
NetWorker Command Reference Guide or the UNIX man pages.
The Recover program
Use the recover (nwrecover) program to recover backed-up files. You can start the
recover program from NetWorker Administration window or from the command
line.
To start the recover program from the NetWorker Administration window:
◆

From the Administration window, click Start on the main menu, select
“NetWorker Recover...”
Note: The NetWorker client package must be installed on the host where you start the
recover program. Otherwise, you will see an error message similar to the following:
The user program you are trying to run (nwrecover) is either not
installed on this computer, or is not in your path.

To start the recover program from the command line, type nwrecover:
◆

To specify the NetWorker server to connect to, type the -s servername option:
nwrecover -s servername

The /servers file, located in /nsr/res/servers, contains an entry for each available
server.
• If the -s option is not entered and there is only one server detected, that server
will be connected automatically.
• If there are no servers detected, or if there is more than one server available,
the Change Server dialog box appears, which allows you to choose the server.
◆

To specify the NetWorker client, use the -c client option:
nwrecover -s servername -c client

If the -c option is not entered, the local computer is used by default.

NetWorker user interfaces

47

Overview

Figure 6 displays the nwrecover program.

Figure 6

The nwrecover Program

NetWorker character-based interface
Use the NetWorker character-based interface (nsradmin) to perform configuration
and management tasks for a NetWorker server.
To start the nsradmin interface, type this command:
nsradmin

For more information about nsradmin, refer to the EMC NetWorker Command
Reference Guide or the UNIX man pages.

NetWorker command-line interface
Perform client and server tasks by typing commands at the prompt. The EMC
NetWorker Command Reference Guide or the UNIX man pages provides information
about these commands.

NetWorker services
This section provides information about the main services and programs for the
NetWorker server and NetWorker Client. It also describes how to start and stop these
services. For more information about:
◆
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◆

Service port requirements when configuring a firewall. Appendix B, “Firewall
Support” provides more information.

Services and programs on the NetWorker server
Table 5 describes the main services and programs that provide NetWorker software
functionality.
Table 5

Services or programs on the server

Service or program

Function

nsrexecd

Authenticates and processes the NetWorker server remote execution requests and
executes the save and savefs programs on the client.

nsrd

Monitors an active save or recover program session. This is an agent process spawned
by nsrd in response to a save or recover session. It (nsrd) is also the master service
that controls other services on the NetWorker server, clients, and storage nodes.

nsrmmdbd

Provides media database management services to the local nsrd and nsrmmd services
and records entries in the media database. This is the media management database
service.

nsrjobd

Monitors NetWorker activity during a backup or recovery operation.

nsrindexd

Provides a method for inserting entries into the client file index that is based on
information passed by the save program.

nsrmmgd

Manages media library operations. It provides an RPC-based service that manages all
jukebox operations on behalf of the nsrd service. The nsrd service starts one and only
one instance of nsrmmgd on the NetWorker server as needed.

Services and programs on the NetWorker client
The nsrd service calls on the NetWorker client service, nsrexecd, and several
programs on the client when a scheduled or on-demand backup request is received.
A temporary server agent, the ansrd service, starts on the NetWorker server to
monitor the progress of the backup session.
Table 6 describes the main service on the NetWorker client.
Table 6

Services or programs on the client

Service or program Function
nsrexecd

Authenticates and processes the NetWorker server remote execution requests and
executes the save and savefs programs on the client.
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Table 7 describes the main services or programs on the NetWorker Storage Node.
Table 7

Services or programs on the NetWorker Storage Node

Service

Function

nsrexecd

Authenticates and processes the NetWorker server remote execution requests and
executes the save and savefs programs on the client.

nsrmmd

Provides device support, generates mount requests, and multiplexes save set data
during a multiclient backup. It writes the data sent by save to storage media. An
additional nsrmmd service is started while mount requests are pending.The nsrd
service starts one nsrmmd service for each enabled device. Forwards storage
information to nsrmmdbd for recording in the NetWorker server media database.

Table 8 describes the main services or programs on the NetWorker Management
Console server.
Table 8

Services or programs on the NetWorker Management
Console server

Service or program

Function

nsrexecd

Authenticates and processes the NetWorker server remote execution requests and
executes the save and savefs programs on the client.

gstd

Known as the Generic Services Toolkit (GST), controls other services provided by the
Console server.

httpd

Starts NMC console on the client through a web browser.

dbsrv9

A database server that manages information pertaining to console management. For
example, Console reports.

Stopping and starting the Console server
This section describes how to stop and start the Console server service.
Stop the Console server on Windows
To stop the Console server:
1. Log in as a Windows Administrator and right-click My Computer and select
Manage.
2. Expand Services and Applications and select Services.
3. Right-click EMC GST Service (gstd), then select Stop.
Start the Console server on Windows
To start the Console server:
1. Log in as a Windows Administrator and right-click My Computer and select
Manage.
2. Expand Services and Applications and select Services.
3. Verify that the NetWorker client is running.
The NetWorker Remote Exec Service (nsrexecd) should have a status of Started. If
the service has not started:
a. Right-click NetWorker Remote Exec Service.
b. Select Start.
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4. Right-click EMC GST Service (gstd), then select Start.
Stop the Console server on UNIX
To stop the Console server:
1. Log in as root.
2. Type one of the following commands:
• Solaris and Linux: /etc/init.d/gst stop
• AIX: /etc/rc.gst stop
• HPUX: /sbin/init.d/gst stop
Start the Console server on UNIX
To start the Console server:
1. Log in as root.
2. Verify that the NetWorker client is running.
• For example, type the following command:
/usr/bin/ps -ef | grep nsr

• If the client is running, a message similar to this appears:
root240 1

0 ? 0:04 /usr/sbin/nsrexecd -s mysrvr

• If the client is not running, start it. “Start a NetWorker host on UNIX” on
page 52 provides information about starting the client.
3. Start the Console server by typing one of the following commands:
• Solaris and Linux: /etc/init.d/gst start
• AIX: /etc/rc.gst start
• HPUX: /sbin/init.d/gst start
Stopping and starting a NetWorker server, client, or storage node
This section describes how to manually stop and start the services for a NetWorker
server, client, or storage node.
Stop a NetWorker host on Windows
To stop a server, client, or storage node:
1. Log in as a Windows Administrator.
2. Right-click My Computer and select Manage.
3. Expand Services and Applications and select Services.
4. Right-click NetWorker Remote Exec Service (nsrexecd) and select Stop.
Start a NetWorker host on Windows
To start a server, client, or storage node:
1. Log in as a Windows Administrator.
2. Right-click My Computer and select Manage.
3. Expand Services and Applications and select Services.
4. Start the appropriate service.
• NetWorker server: Right-click the NetWorker Backup and Recover Server
service (nsrd) and select Start.
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• NetWorker client or storage node: Right-click the NetWorker Remote Exec
Service (nsrexecd) and select Start.
Stop a NetWorker host on UNIX
To stop the NetWorker services, log in as root and type the following command:
nsr_shutdown

Start a NetWorker host on UNIX
To start NetWorker services, log in as root and type the appropriate startup command
listed in Table 9.
Table 9

NetWorker startup commands

Operating system

Startup command

Solaris, Linux, IRIX

/etc/init.d/networker start

HP-UX

/sbin/init.d/networker start

HP Tru64 UNIX

/sbin/init.d/NSRstartstop start

AIX

/etc/rc.nsr

Stop a NetWorker host on Mac OS X
To stop the NetWorker host:
1. Log in as a Mac Administrator.
2. Open the Mac OS X Terminal application utility.
3. Stop the service by typing the following command:
# SystemStarter stop NetWorker

Start a NetWorker host on Mac OS X
To start the NetWorker host:
1. Log in as a Mac Administrator.
2. Open the Mac OS X Terminal application utility.
3. Start the client by typing the following command:
# SystemStarter start NetWorker
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Scheduled backups
The NetWorker server backs up client data regularly by using scheduled backups.
They are preferred over the “Manual backups” on page 64 because the backups occur
automatically, and data can be recovered more easily. You can also start scheduled
backups at any time.
This section explains how to plan and create scheduled backups, including:
◆

“Planning a scheduled backup” on page 54

◆

“Setting up a scheduled backup” on page 55

Planning a scheduled backup
This section uses a scenario with the requirements of an accounting department to
highlight tasks to consider when planning a scheduled backup.
Example 2

Planning scheduled backups for the accounting computers

Company XYZ wants to ensure that all of the computers in the Accounting
department are backed up according to the requirements listed in Table 10 on
page 54. This table also maps each requirement to specific NetWorker features.
Table 10

Accounting department backup requirements
NetWorker
feature

More information

Backups occur at the same time.

Backup Schedule
Backup Group

“Task 1: Set up a schedule for backups” on page 56
“Task 2: Set up a group for backup clients” on page 57

Accounting backups for the past 3 months are
available immediately.

Browse Policy

“Task 3: Set up policies for quick access and long term
storage” on page 57

Requirement
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Accounting backups for the past 7 years are Retention Policy
available, though not necessarily immediately.

“Task 3: Set up policies for quick access and long term
storage” on page 57

Backups are routed to volumes that can be
identified as Accounting backup volumes.

Label Template
Pools

“Task 4: Set up a label template to identify volumes” on
page 58 (if Match Bar Code Labels attribute is not used
for the Library resource)
“Task 7: Set up a pool to sort backup data” on page 61

To avoid unnecessary backups, do not back
up files with a .tmp extension.

Directives

“Task 5: Set up directives for special processing” on
page 59

The same files and folders are backed up on
each accounting computer.

Client resource

“Task 6: Create a backup Client resource” on page 59

Non-accounting data need only be
recoverable for one year.

Browse Policy
Retention Policy
Client resource

“Task 3: Set up policies for quick access and long term
storage” on page 57
“Task 6: Create a backup Client resource” on page 59
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Setting up a scheduled backup
You can create a scheduled backup quickly by using the Client Backup Configuration
Wizard or through manual configuration in the Console.
Using the Client Backup Configuration Wizard
The Client Backup Configuration Wizard provides the ability to:
◆

Create Client resources for scheduled backups.

◆

Create Group resources.

◆

Add new clients to existing backup groups.

◆

Modify existing client configurations.

The wizard supports NetWorker servers and clients in a stand-alone or cluster
environment.
Note: The Client Backup Configuration wizard cannot be used to configure a NetWorker
NDMP client or clients for NetWare.

Client Backup Configuration Wizard requirements
This section contains requirements or constraints specific to the use of the Client
Backup Configuration Wizard.
◆

The wizard user must:
• Have NetWorker server and client privileges, or have root (UNIX) or
Administrator (Windows) privileges.
• Have Configure NetWorker privileges on the NetWorker server where the
scheduled backup is to be configured.

◆

The NetWorker server’s host must be listed in the servers file on the client
machine that is being configured for a scheduled backup.

◆

Communication between the Console server, NetWorker client host, and
NetWorker server must use nsrauth strong authentication.

◆

The Console server, NetWorker client host, and NetWorker server must be using
NetWorker 7.5 or later.

◆

Multiple wizard hosts cannot access the same client machine simultaneously.

“Client wizard issues” on page 666 discusses known issues with the Client wizard.
Accessing the Client Backup Configuration Wizard
To access the Client Backup Configuration Wizard:
1. From the Administration window, click Configuration.
2. In the Configuration window, click Clients.
3. Add a client or modify an existing client:
• To add a new client, select Configuration menu > Client Backup
Configuration > New.
• To modify an existing client, select the client and then select Configuration
menu > Client Backup Configuration > Modify.
The wizard opens. If the wizard fails to open, ensure that all prerequisites in “Client
Backup Configuration Wizard requirements” on page 55 are met. Also check the
NetWorker daemon log for additional details. “Viewing log files” on page 661
provides more information.
Scheduled backups
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Manually creating a scheduled backup in the Console
To exercise more control over scheduled backups than is possible by using the Client
Backup Configuration wizard, complete these tasks:
◆

“Task 1: Set up a schedule for backups” on page 56

◆

“Task 2: Set up a group for backup clients” on page 57

◆

“Task 3: Set up policies for quick access and long term storage” on page 57

◆

“Task 4: Set up a label template to identify volumes” on page 58

◆

“Task 5: Set up directives for special processing” on page 59

◆

“Task 6: Create a backup Client resource” on page 59

◆

“Task 7: Set up a pool to sort backup data” on page 61

You do not have permissions to make configuration selections if the following error
message appears while completing any task in this section:
user user_name needs to be on administrator’s list

“Managing server access” on page 440 provides information about getting
permissions.
Note: Appendix F, “MAC OS X Support” provides information about backing up NetWorker
clients on Mac OS X

Task 1: Set up a schedule for backups
A schedule can be applied to each client backup. Chapter 4, “Backup Groups and
Schedules” provides information about schedules
To create a schedule for backups:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Schedules.
3. From the File menu, select New.
4. In the Name attribute, type a name for the schedule.
5. From the Period attribute, select Week or Month.
• Select Week to create a weekly backup schedule. For example, if a full backup
for a Friday is selected, every Friday will have a full backup.
• Select Month to create a monthly schedule. For example, if a full backup for
the first of the month is selected, every month will have a full backup on the
first of the month.
6. Select a backup level for each day in the weekly or monthly period:
a. Select a day.
b. Right-click and from the Set Level menu, select a backup level.
7. If required, select an override backup level for any day. An override occurs once
only for the selected day:
a. Select a day.
b. Right-click and from the Override Level menu, select a backup level.
8. Click OK.
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Task 2: Set up a group for backup clients
A backup group specifies the time of day when a backup occurs. Creating groups for
backup clients enables you to:
◆

Balance backup loads to reduce the impact on your network and the NetWorker
server.

◆

Sort data to specific backup volumes. To sort data, groups are used in conjunction
with backup pools.

Chapter 4, “Backup Groups and Schedules” provides information about groups.
To create a group:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Groups.
3. From the File menu, select New.
4. In the Name attribute, type a name for the group.
5. In the Comment attribute, type a description of the group.
6. For the Start Time attribute, type a new time, unless it is appropriate to maintain
the default time of 3:33 A.M. Ensure that start times for different groups are far
enough apart so that one group has completed backing up before the next group
starts.
7. For the Autostart attribute, select Enabled.
8. In the Printer attribute, type the name of the printer on which bootstrap save set
information will be printed. For information about setting up a printer on
Microsoft Windows systems, see “Using nsrlpr to print notifications” on
page 450.
9. Click the Advanced tab.
10. For the Client Retries attribute, change the number of retries, if necessary. This
value specifies the number of times the NetWorker software attempts to back up
a failed client.
11. Click OK.
Task 3: Set up policies for quick access and long term storage
Backup clients specify two policies: a browse policy and a retention policy.
◆

A browse policy determines how long backup data will be available for quick
recovery.

◆

A retention policy determines how long backup data will be available for
recovery, though not necessarily quickly. For example:
• If it is likely that accounting data would need to be recovered within the past
year, a browse policy of one year would be appropriate.
• If the same accounting data had to be recoverable for up to seven years even
though the likelihood of needing to recover it was low, a retention policy of
seven years would be appropriate.

“About browse and retention policies” on page 158 provides information about
browse and retention policies.
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To create a policy:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Policies.
3. From the File menu, select New.
4. In the Name attribute, type a name for the policy. Choose a name that reflects the
length of time for which the policy specifies. For example, if the policy is for 15
months, type 15 months.
5. In the Comment attribute, type a comment about the policy.
6. In the Number of Periods attribute, type the number of periods applied to the
policy. For example, if you choose months for the Period attribute and 3 for the
Number of Periods attribute, then the policy lasts for 3 months (one quarter).
7. From the Period list, select a period. This attribute works in conjunction with the
Number of Periods attribute. For example, a quarterly policy is configured in
terms of the number of months (3). A week as seven days beginning on Sunday, a
month is the calendar month, and a year is the calendar year.
8. Click OK.
Task 4: Set up a label template to identify volumes
If you are not using tapes with barcode labels, and the Match Bar Code Labels
attribute is not enabled for the Library resource, then every backup volume requires a
unique label for identification. The NetWorker server creates a unique label for each
volume by applying a label template. Chapter 7, “Sorting Backup Data” provides
more information about label templates.
To create a label template:
1. From the Administration window, click Media.
2. In the expanded left pane, select Label Templates.
3. From the File menu, select New.
4. In the Name attribute, type a name for the label template.
5. In the Comment attribute, type a description for the label template.
6. In the Fields attribute, type the label’s components. Place each label component
on a separate line. The template can use any or all of these components, although
at least one range component must be added:
• Range of numbers — for example, 001-999
• Range of lowercase letters — for example, aa-zz
• Range of uppercase letters — for example, AA-ZZ
• Character string — for example, Accounting
Ranges of numbers or letters change incrementally with each new label. For
example:
• First label: Accounting.001
• Second label: Accounting.002
• Third label: Accounting.003
7. Select a Separator and click OK. If no symbol is selected, the components will
have no separators (for example, Accounting001).
8. Click OK.
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Task 5: Set up directives for special processing
Directives are optional instructions that control how files and directories are
processed during backup and recovery. For instance, one could use a directive to skip
all temporary files (*.tmp) during backup.
Other common uses for directives include adding password-protection and data
compression to scheduled backups. Chapter 6, “Directives” provides information
about directives.
Note: Some operating systems contain files and directories that should not be backed up. Use
directives to ensure that these files and directories are not backed up. “Preconfigured global
directive resources” on page 174 provides more information.

To create a directive:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Directives.
3. From the File menu, select New.
4. In the Name attribute, type a name for the directive.
5. In the Comment attribute, type a description for the directive.
6. In the Directive attribute, type the directive instructions. For example, to skip all
files on C:\ that have a .tmp extension, type:
<< "C:\" >>
skip: *.tmp

7. Click OK.
Task 6: Create a backup Client resource
A client is both a physical computer with NetWorker client software installed on it
and a NetWorker resource that specifies a set of files and directories to be included in
a scheduled backup. A Client resource also specifies information about the backup,
such as the backup schedule, the backup group, browse policies, and retention
policies.
A single NetWorker client computer can have several Client resources, although
clients with the same save set cannot be in the same group. For instance, suppose the
accounting data on a computer should be backed up according to a different schedule
than the operating system files on the same computer. To accomplish this, one could
create two Client resources on each computer: one for accounting data and another
for operating system data.
Another common reason to create multiple Client resources for the same computer is
to back up large client file systems more efficiently. For instance, one could create two
Client resources: one for each file system on a computer. Each Client resource could
be scheduled to back up separately.
“Multiple clients from the same computer” on page 485 provides information about
multiple Client resources.
To create a Client resource:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clients.
3. From the File menu, select New.
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4. In the Name attribute, type the hostname of the NetWorker client computer.
5. In the Comment attribute, type a description of the client. If multiple Client
resources are being set up for the same host, type a comment that distinguishes
the Client resources.
6. From the Browse Policy attribute, select a browse policy from the list. The browse
policy determines how long backed-up data is available for quick access.
7. From the Retention Policy attribute, select a retention policy from the list. The
retention policy determines how long backed-up data is available though not
necessarily quickly.
8. Select the Scheduled Backups attribute.
9. From the Directive attribute, select a directive from the list, if applicable.
10. In the Save Set attribute, type the name of the files or directories to be backed up.
Place multiple entries on separate lines. For example, to back up a log file
directory named C:\log and all of the data under the directory named
D:\accounting, the entries would look similar to:
C:\log
D:\accounting

Type All to back up all client data. For Microsoft Windows operating systems, the
SYSTEM or Volume Shadow Copy Service (VSS) SYSTEM save sets that
determine the client system’s state should be backed up on a regular basis.
More information can be found in the following locations:
• “Save sets” on page 61 provides information on using the All save set and the
SYSTEM or VSS SYSTEM save sets.
• “The All save set” on page 62 describes how the components of the All save
set can differ significantly between the various supported Windows operating
systems.
• “Backing up a mapped drive” on page 95 provides information on backing up
a mapped drive.
• “Backing up Windows mount points” on page 81 provides information on
backing up mount points and nested mount points.
• “Scheduled backups of non-ASCII files or directories” on page 486 provides
information on using non-English paths in the Save Set attribute.
Note: Some operating systems contain files and directories that should not be backed up.
Use directives to ensure that these files and directories are not backed up. “Preconfigured
global directive resources” on page 174 provides information.

11. From the Group attribute, select a group from the list.
12. From the Schedule attribute, select a schedule from the list.
13. Select the Backup renamed directories attribute to back up the files and
subdirectories of a renamed directory even if only the name of the directory has
changed.
If this attribute is selected, and a directory is renamed, all files and subdirectories
under that directory will be backed up during the next scheduled full or non-full
backup. “Support for backing up renamed directories” on page 96 provides more
information about this feature.
14. Click OK. The client is now set up for scheduled backups.
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To determine whether a client is enabled for scheduled backups, locate the client
entry in the right pane and look for a check mark under the Scheduled backup
column.
Task 7: Set up a pool to sort backup data
A backup pool is a collection of volumes to which backup data is written. Use pools
to sort backup volumes so that the volumes are easy to locate when they are needed.
Chapter 7, “Sorting Backup Data” provides more information about pools.
To create a backup pool:
1. From the Administration window, click Media.
2. In the expanded left pane, select Media Pools.
3. From the File menu, select New.
4. In the Name attribute, type a name for the pool.A pool is associated with a label
template. Use a name that clearly associates the pool with the corresponding label
template.
5. In the Comment attribute, type a description of the pool.
6. Select the Enabled attribute.
7. For the Pool Type attribute, select Backup.
8. In the Label Template attribute, select the matching label template.
9. Modify the attribute to use to direct specific backup data to the volumes
belonging to this pool. Data can be sorted by group, backup clients, save sets, and
backup levels. “Using media pools” on page 184 provides more information
about sorting criteria.
10. Click OK.

Save sets
A Client resource identifies the client data to be backed up. The collection of data
items backed up during a backup session between the NetWorker server and the
Client resource is called a save set. A save set can consist of the following:
◆

A group of files or entire file systems.

◆

Application data, such as a database or operating system settings.

Note: A save set is defined when a Client resource is created. “Task 6: Create a backup Client
resource” on page 59 provides information about creating a Client resource.

Scheduling predefined save sets for backup
In addition to entering files or file systems in the Save Set attribute of the Client
resource, you can also type the names of predefined save sets when configuring the
NetWorker client.
For Microsoft Windows Server 2003 that has no VSS client license or has VSS
disabled, and for Windows XP Professional, these predefined save sets are available:
◆

All

◆

SYSTEM STATE (Windows only)
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◆

SYSTEM DB (Windows only)

◆

SYSTEM FILES (Windows only)

◆

Automated System Recovery (ASR) (Windows Server 2003 with no VSS client
license or with VSS disabled, and XP Professional only)

For Windows Server 2003 with VSS licensed and enabled, and for Windows Vista,
Windows 2008, 2008 R2, and Windows 7 these predefined save sets are available:
◆

All

◆

VSS SYSTEM BOOT

◆

VSS SYSTEM FILESET

◆

VSS SYSTEM SERVICES

◆

VSS USER DATA

◆

VSS OTHER

◆

VSS ASR DISK (Windows Server 2003 only)

◆

DISASTER_RECOVERY:\

Note: To properly protect NetWorker client computers, all of the SYSTEM or VSS SYSTEM
save sets must be backed up and recovered simultaneously. Failure to do so will yield
unpredictable results.

Note: Windows SYSTEM save sets do not support deduplication.

For information about:
◆

SYSTEM, VSS SYSTEM, SHAREPOINT, and ASR save sets, see Appendix A,
“SYSTEM and VSS SYSTEM Save Sets.”

◆

Support for ASR, see Chapter 23, “Support for Windows XP and 2003 Automated
System Recovery.”

◆

Support for Disaster Recovery on Windows 2008 / 2008 R2 and Windows 7, see
Chapter 24, “Support for Windows 2008 / 2008 R2 / Windows 7 Disaster
Recovery.”

The All save set
The All save set is the default save set used when a client is created:
◆

For UNIX operating systems, the All save set backs up all locally mounted file
systems.

◆

For Windows operating systems, the All save set backs up all locally mounted file
systems, critical volumes required for disaster recovery (Windows 2008, 2008 R2,
and Windows 7 only), plus operating system files that determine the client’s
system state.
Be aware that the VSS writer files associated with the system state or with
applications are skipped during the regular file system backup. These files are
backed up after the regular file system backup. Files that are associated with the
system state are backed up under the VSS SYSTEM savesets. Files that are
associated with applications are backed up under their corresponding VSS
savesets. When performing a recovery, system state files can be found under the
VSS system savesets, which include the VSS SYSTEM BOOT:, VSS SYSTEM
SERVICES:, and VSS SYSTEM FILESET: savesets. To recover the system state, it is
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strongly recommended that you recover all three VSS savesets at the same time.
“Recovering the Windows system configuration” on page 341 provides more
information about recovering the Windows system state.
◆

For Windows 2008, 2008 R2, and Windows 7 only, a new disaster recovery save
set is introduced. This save set backs up the system state critical volumes for an
operating system, and except for some applications such as clusters, Active
Directory, DFS-R, and Windows Server Failover Cluster, can completely replace
the VSS SYSTEM savesets. Chapter 24, “Support for Windows 2008 / 2008 R2 /
Windows 7 Disaster Recovery,” provides more information.

Table 11 provides a list of the save sets included in the All save set.
Table 11

Components in the All save set

Operating system

Files

UNIX

Backs up all file systems listed in these locations:
Solaris: /etc/vfstab
HP-UX, HP Tru64, Linux, and SGI: /etc/fstab
AIX: /etc/filesystems
Note: If a save set’s name includes a symbolic link, recovery by save set ID
is not supported.

Windows 2008, 2008 R2, and Windows 7

DISASTER_RECOVERY:\ (included in Full backup only)
All local physical drives
Notes:
You can revert the definition of the All save set to be equivalent to a
Windows 2003 host with VSS licensed and enabled by using the
VSS:DISASTER_RECOVERY=off keyword in the Save Operations
attribute. Chapter 24, “Support for Windows 2008 / 2008 R2 / Windows 7
Disaster Recovery,” provides more information about using the All save set
with Windows 2008, 2008 R2, and Windows 7.
For Extensible Firmware Interface (EFI) systems, Windows Disaster
Recovery backups are not supported. The All save set components for EFI
hosts are equivalent to a Windows 2003 host that has VSS licensed and
enabled.

Windows Server 2003 with VSS licensed and
enabled, and for Windows Vista or Windows
Server 2008

VSS SYSTEM BOOT
VSS SYSTEM FILESET
VSS SYSTEM SERVICES
VSS USER DATA
VSS OTHER
VSS ASR DISK (Windows Server 2003 only)
All local, physical drives

Windows XP Professional, Windows Server
2003 with no VSS client license or with VSS
disabled

SYSTEM STATE
SYSTEM DB
SYSTEM FILES
SHAREPOINT
ASR
All local, physical drives

Mac OS X

All local and mounted volumes
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Using the save set All to back up particular file systems
When there are multiple file systems locally mounted on the NetWorker host, you can use a
keyword to back up only one type of locally mounted file system.
To back up only those locally mounted file systems of a particular type, type All-filesystem in
the client’s Save Set attribute. For example, to back up all locally-mounted ZFS filesystems on
a Solaris host, type the following in the client’s Save Set attribute:
All-zfs

Using the save set All to back up Solaris zones
One or more NetWorker Client resources can be set up for each global and non-global zone
on a physical Solaris host. You can specify the All-local and All-global keywords in the Client
resource’s Save Set attribute to back up Solaris global and non-global virtual zones as follows:
◆

If the All-local keyword is specified for a global zone client, all non-global zones on the
physical host will be backed up.

◆

If the All-global keyword is specified for a global zone client, then it is equivalent to
specifying the All keyword except that all non-global zones on the physical host will be
skipped.

◆

If the All-local or the All keyword is defined for a non-global zone client, only the
non-global zone client on the physical host will be backed up.

◆

If the All-mounts keyword is specified for a non-global or global zone client, all currently
mounted filesystems are backed up as long as the filesystem is not one that is normally
skipped such as the NFS filesystem.

Manual backups
Manual backups enable users to make quick backups of a few files. Unlike scheduled
backups, manual backups do not:
◆

Generate bootstrap files

◆

Back up indexes

This may present recovery problems if the indexes are recovered after a disaster, but before a
scheduled backup has backed up the latest indexes. For this reason, scheduled backups are
the preferred backup method. However, indexes can be saved manually by using the savegrp
command. “Performing a manual backup from the command prompt” on page 67 provides
more information.
On Microsoft Windows, manual backups can be performed by using the graphical
NetWorker User program. On UNIX and Linux, manual backups can be performed from only
the command line.
Note: You can also start a scheduled backup manually. “Starting a group immediately” on page 395
provides information about starting a scheduled backup group manually.

Performing a manual backup on Windows
Note: If performing a NetWorker User backup on a NetWorker server, see “Excluding file type devices
from a manual backup on Windows” on page 65.

The NetWorker User program cannot be used to back up deduplication data. Deduplication
data must be backed up by using scheduled backups or from the command line.
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To start a manual backup on Windows:
1. In the NetWorker User program, click Backup. Chapter 1, “Overview” provides
general information about the NetWorker User program
Note: There are considerations to be aware of when performing a manual backup of
SYSTEM or VSS SYSTEM save sets. “Manual backups of the SYSTEM and VSS SYSTEM
save sets” on page 65 provides more information.

2. In the left pane of the Backup window, click the appropriate directory folder.
3. Select each directory or file, and click Mark. To clear an item, click Unmark.
4. Click Start to begin the manual backup. The Backup Status dialog box displays
the progress of the backup.
When the backup finishes, a message similar to this appears:
Backup completion time: 2-15-07 3:27p

If the backup fails due to a problem with VSS or a writer, an error message
appears. Use the Windows Event Viewer to examine the event logs for more
information. VSS backup error messages are also written to the NetWorker log
file.
Note: Certain kinds of corrupt files or errors on computer disk volumes are not detected.
NetWorker might back up this corrupt data. To avoid this situation, run diagnostic
programs regularly to correct disk volume errors.

Excluding file type devices from a manual backup on Windows
When performing a NetWorker User backup on a NetWorker server or storage node
that is backing up to a local file type device, do not include the local file type device in
the backup. If the local file type devices are included, the backup file will grow until
there is no more disk space. The following procedure must be performed before
selecting any files for backup or archiving, or before performing any activities from
the Operation menu of the NetWorker User program.
To ensure that file type devices are excluded from NetWorker User backups, create a
local directive on the NetWorker server as follows:
1. Start the NetWorker User program.
2. From the Options menu, select Local Backup Directives.
3. Click the filename of any file device to unmark it.
4. From the File menu, select Save Directive. This creates a directive file named
networkr.cfg. “Local directives within the NetWorker User program” on page 173
provides more information about the networkr.cfg file. Chapter 11, “Device
Operations” provides information about file type devices.
Manual backups of the SYSTEM and VSS SYSTEM save sets
This section discusses manual backups of the SYSTEM or VSS SYSTEM save sets.
These save sets are used to back up Windows system files. Appendix A, “SYSTEM
and VSS SYSTEM Save Sets” provides more information.
Note: To back up and recover SYSTEM and VSS SYSTEM save sets, you must have local
Windows Administrator privileges.

Manual backups
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Manual backups of the SYSTEM and VSS SYSTEM save sets from the NetWorker
User Program
In the NetWorker User Backup window, each of the SYSTEM or VSS SYSTEM save
sets appear as a distinct node in the left pane. Expanding any of these nodes reveals
its components in the right pane, as shown in Figure 7 on page 66 and Figure 8 on
page 66.

Figure 7

SYSTEM save sets in NetWorker User backup window

Figure 8

VSS SYSTEM save sets in NetWorker User backup window

The nodes that appear in the right pane reflect save set components that were eligible
for backup at the time the NetWorker User program was started. After the
NetWorker User Backup window is opened, the display does not dynamically refresh
to reflect save set components that have since become eligible or ineligible for
backup. However, all the eligible save set components are included in a backup when
the backup operation starts, including those components that become available after
the NetWorker User program starts.
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Note: The NetWorker User program’s special handling features (password-protect, encrypt, or
compress) cannot be used when any of the SYSTEM or VSS SYSTEM save sets are marked for
backup.

Performing a manual backup from the command prompt
A manual backup can also be performed from the command prompt by using the
save command. For example, to back up C:\myfile to the server jupiter, type:
save -s jupiter C:\myfile

If you do not specify the -s option with the save command, the file(s) will be backed
up to the NetWorker server defined in the /nsr/res/servers file that comes first in
alphabetical order.
Note: You can also manually back up the bootstrap and indexes for a group by using the
savegrp command with the -O option and a group name.

The EMC NetWorker Command Reference Guide or the UNIX man pages provides
information about save and savegrp.
Manual backups of the SYSTEM and VSS SYSTEM save sets
A manual backup of the SYSTEM and VSS SYSTEM save sets can also be performed
from the command prompt.
With no VSS licence or VSS disabled
This section describes how to back up SYSTEM save sets on a NetWorker client that is
running:
◆

Windows Server 2003 with no VSS license or VSS disabled

◆

Windows XP Professional

To back up all components of the Windows system state:
save [-s NetWorker_server_name] "SYSTEM STATE:"
save [-s NetWorker_server_name] "SYSTEM FILES:"

To back up all components of the SYSTEM DB, SHAREPOINT, and ASR save sets:
save [-s NetWorker_server_name] "SYSTEM DB:"
save [-s NetWorker_server_name] "SHAREPOINT:"
save [-s NetWorker_server_name] "ASR:"

With VSS enabled
This section describes how to back up VSS SYSTEM save sets on a NetWorker client
that is running Microsoft Windows Server 2003 with VSS licensed and enabled:
To back up all components of the Windows system state:
save [-s NetWorker_server_name] "VSS SYSTEM BOOT:"
save [-s NetWorker_server_name] "VSS SYSTEM FILESET:"

To back up all components of the VSS SYSTEM SERVICES, VSS USER DATA, VSS
OTHER, and VSS ASR DISK (Windows 2003 only) save sets:
save
save
save
save

[-s
[-s
[-s
[-s

NetWorker_server_name]
NetWorker_server_name]
NetWorker_server_name]
NetWorker_server_name]

"VSS
"VSS
"VSS
"VSS

SYSTEM SERVICES:"
USER DATA:"
OTHER:"
ASR DISK:"
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Requirements and limitations
When backing up SYSTEM or VSS SYSTEM save sets from the command line, these
requirements and limitations apply:
◆

Do not select individual components of any of the SYSTEM or VSS SYSTEM save
sets for backup.

◆

A maximum of one SYSTEM or VSS SYSTEM save set can be included in the same
save command.

◆

File system directories cannot be specified in the same save command.

◆

A maximum of one SYSTEM or the VSS SYSTEM save set can be specified in an
input file.

Note: An input file is specified in a save command with the -I option.

File system directories cannot be specified in an input file.
Examples of invalid command line entries include:
save -s servername "SYSTEM DB:" "SYSTEM STATE:"
save -s servername D:\letters "SYSTEM DB:"
save -s servername -I D:\list.txt

where list.txt is an input file. Examples of invalid input files include:
◆

The following input file is invalid because it includes a file system and a VSS
SYSTEM save set:
D:\letters
VSS SYSTEM BOOT:

◆

The following input value file is invalid because it includes multiple VSS
SYSTEM save sets:
VSS SYSTEM BOOT:
VSS SYSTEM SERVICES:

Examples of valid command line entries include:
save -s servername "VSS SYSTEM BOOT:"
save -s servername "VSS SYSTEM SERVICES:"
Note: If the backup fails due to a problem with VSS or a writer, an error message appears. Use
the Windows Event Viewer to examine the event logs for additional information. VSS backup
error messages are also written to the log file (networkr.raw) on the local client.

Backing up multiple SYSTEM save sets
To back up multiple SYSTEM or VSS SYSTEM save sets in one operation, choose one
of the following options:
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◆

In the NetWorker Administration window, edit the Client resource to include
multiple SYSTEM or VSS SYSTEM save sets. Alternatively, select the default save
set All, which will include all SYSTEM and VSS SYSTEM save sets.

◆

In the NetWorker User program, mark all of the required SYSTEM or VSS
SYSTEM save sets as well as any other required save sets, and then complete the
backup.
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Verifying backed-up data
Note: This feature is not available on UNIX clients.

Use the NetWorker Verify feature to ensure that backup data on the NetWorker
server matches the data on the local disk. The Verify feature compares the file types,
file modification times, file sizes, and file contents. It does not verify other system
attributes, such as read-only, archive, hidden, system, compressed, and file access
control list (ACL). The NetWorker server alerts you to any changes that have
occurred to your data since the backup. Verification also determines whether a
hardware failure kept the NetWorker server from completing a successful backup.
The Verify feature provides a way to test the ability to recover data.
Note: To verify files, you must have Windows Administrator privileges for the computer.

To verify backup data:
1. In the NetWorker User program, select Verify Files from the Operation menu.
2. Select the data items to be verified.
3. Click Start.
You can monitor the data verification progress in the Verify Files Status window.
After the verification is complete, the Verify Status dialog box shows any data
discrepancies.

Probe-based backups
The NetWorker server schedules probe-based backups that are based on user-defined
events for clients and NetWorker modules, not just on time.
To run probe-based backups, perform the following tasks:
1. Create a user defined client probe, as described in “Creating a client probe” on
page 473.
2. Associate a probe with a Client resource, as described in “Associating a probe
with a Client resource” on page 474.
3. Create a probe group, as described in “Creating and scheduling a probe group”
on page 132.
4. Run the probe group the same as you would a save group, as described in
“Scheduled backups” on page 54, or “Manual backups” on page 64.
Note: Running savegrp -g bypasses probing when running a probe group backup from the
command line.

Checkpoint restart backups
The checkpoint restart feature allows a failed backup operation to restart at a known
good point prior to the point-of-failure during the backup. A known good point is
defined as a point in the backup data stream where the data was successfully written
to tape and that data can be located and accessed by subsequent recovery operations.

Verifying backed-up data
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This feature allows client backups that are part of a scheduled backup to be restarted,
if they fail while running. This prevents the files and directories that have already
been backed up from being backed up again.
IMPORTANT
Checkpoint restart is only supported by both NetWorker 7.6 SP1 server and clients.
Previous versions of NetWorker software do not support this feature. If either the
NetWorker server or client is an earlier version, then the checkpoint restart feature is
not supported.
Backup failures can occur for various reasons. The most common reasons include
hardware failures, loss of network connectivity, and primary storage software
failures. The NetWorker server and storage node components must remain running
to manage the client failure and to create a partial save set. If the NetWorker server or
storage node components fail during a backup, partial save sets will not be created. In
this case, backup for the checkpoint-enabled client would have to be started from the
beginning.
If the checkpoint restart feature has not been enabled, a failure encountered during a
scheduled backup operation might require a re-run of an entire backup tape set. This
can be costly when a limited backup window of time is available, as a significant
portion of the backup data might have been successfully transferred to tape, and
NetWorker cannot resume a save set from the point of interruption.
For example, when performing a 800 GB backup that requires approximately 10
hours to complete and spans 6 tapes, if a failure occurs while writing to the last tape
the previous 5 tapes representing 9 hours of backup time may need to be re-run. As
data sets continue to increase in size, so does the impact of backup failures.
Note: Configuring a client as checkpoint-enabled might impact the backup speed. This is
dependent upon the data zone environment and configuration.

Checkpoint enabled clients provide the following enhancements:
◆

Failed save sets are marked as partial; not as aborted.

◆

Restarted save sets have a new SSID and savetime.

◆

Partial save sets are indexed.

◆

Partial save sets are not removed from the index, the media databases, and media
such as AFTD.

The Checkpoint option will be ignored for index and bootstrap save sets.
Note: The checkpoint restart feature is not enabled by default. If a NetWorker client is not
configured as checkpoint enabled and a backup fails, the next time when the group is run, the
software creates a new save set from the beginning.

This section includes the following information about the checkpoint restart feature:
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◆

“About partial save sets” on page 71

◆

“Configuring checkpoint enabled clients” on page 71

◆

“Monitoring checkpoint enabled backups” on page 72

◆

“Restarting a checkpoint enabled backup” on page 73

◆

“How to query partial save sets from the Console” on page 74

◆

“How to query partial save sets using the mminfo command” on page 74
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◆

“Recovering data” on page 75

◆

“Cloning and scanning partial savesets” on page 76

◆

“Cloud backup devices and partial savesets” on page 76

About partial save sets
The backup sequence of partial save sets is not the same as for complete backups.
Each partial save set provides protection for a part of the filesystem, but the
completeness and consistency of the coverage of the whole filesystem cannot be
guaranteed.
The checkpoint restart window is user-defined and can be large. If restarted hours
apart, the partial backups might provide an image of the filesystem that is different
from the state of the filesystem at any given point-in-time. The resulting filesystem is
not guaranteed to be consistent. It can be different than at any other point-in-time.
Files and directories are backed up in alphabetical order. If a crash occurs,
subsequent backups continue from the last point alphabetically from where they
were in progress. Previously backed up files or directories are not reviewed for
modifications. If a file or directory that is earlier alphabetically was modified or
added, it will not be backed up.
Example

A backup is interrupted while saving a directory and restarted after the directory
contents have changed. As a result, different files are saved than the original
filesystem entry.
For example:
1. A save set contains /disk1/dir. The files include file_a, file_c and file_d.
2. A point of interruption occurs in the backup of the save set when file_d is being
backed up.
3. The first partial save set contains file_a and file_c.
4. Before the checkpoint restart is initiated for the save set, file_b is added to the
filesystem.
5. The second partial save set contains file_d and /disk1/dir.
Note: /disk1/dir contains file_a, file_b, file_c, and file_d.
6. Notice that file_b has not been backed up.

Configuring checkpoint enabled clients
NetWorker clients can be configured to allow an interrupted backup to restart from
the point-of-failure at the directory or file level. The checkpoint restart feature is not
enabled by default.
IMPORTANT
Configuring a client as checkpoint enabled might impact the backup speed. This is
dependent upon the data zone environment and its configuration.
To configure a client for checkpoint enabled backups:
1. From the Administration window, click Configuration.

Checkpoint restart backups
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2. Set the Checkpoint enabled attribute:
a. In the expanded left pane, select Clients.
b. Right-click the client to be enabled, then select Properties. The Properties
dialog box appears.
c. Click the General tab.
d. Click the Checkpoint enabled checkbox.
3. For the Checkpoint granularity attribute:
a. Select whether to restart the backup by directory or by file:
Restart by directory is the default. After each directory is saved, the data is
committed to the media and index database. If a directory contains a large
number of entries, intermediate checkpoints are created.

!

IMPORTANT
Use restarting by file only for save sets with few large files. Committing
every file to the index and the media database is time consuming. This
might lead to performance degradation during a backup that contains many
small files.
b. Click OK.
4. Select the group to which the checkpoint enabled client belongs.
a. In the expanded left pane, select Groups.
b. Click the Advanced tab.
c. If desired, change the Client Retries attribute to a value greater than 0. This
value specifies the number of times the NetWorker software attempts to back
up a failed client.
d. Click OK.

Monitoring checkpoint enabled backups
To view detailed information about a checkpoint enabled backup:
1. From the Administration window, click Monitoring.
2. Click Groups in the docking panel.
3. Right-click the group to which the checkpoint enabled client belongs, then select
Show Details. The Group Details dialog box appears.
4. View detailed information related to the group backups:
• If the partial save set is in the group's work list, it displays in the Waiting to
Run section.
• If the partial save set is running, it displays in the Currently Running section.
• If the entire partial save sets sequence of the savegrp is complete, it displays in
the Completed Successfully section.
• If the entire partial save sets sequence of the savegrp is not complete, it
displays in the Failed section.
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Note: If any messages are generated, the Show Messages button is enabled. Click Show
Messages to view the messages.

5. Click OK to close the Group Details window.

Restarting a checkpoint enabled backup
Restarting a checkpoint enabled backup of a partial save set is faster than restarting
the backup of a save set from the beginning. This depends on how much data was
saved in the previous backup.
There are two ways in which a checkpoint enabled backup can be initiated:
◆

Manually through a group restart operation.

◆

Automatically through setting the client retries attribute in the group resource of
the checkpoint enabled client.

Note: Changing the name of a save set will cause checkpoint restart to fail to find a match
against a previous run, and the restart will revert to a complete backup. Additionally, do not
modify browse or retention policies for the client in between checkpoint restarts, as an expired
partial save set may leave gaps in the backup set.

Manually restarting a checkpoint enabled backup by using the Group Restart attribute
When a group is restarted, the NetWorker software determines which save sets were
not completed within the backup:
◆

If the client is enabled for checkpoint restart, the incomplete save sets are
checkpoint restarted and continue from the point at which they were stopped.

◆

If the client has not been checkpoint enabled, the incomplete save sets are backed
up again in full.

To manually initiate a group restart:
1. Ensure that the client has been check-point enabled. “Configuring checkpoint
enabled clients” on page 71 provides detailed information.
2. From the Administration window, click Monitoring.
3. Click Groups in the docking panel.
4. Right-click the group to which the checkpoint enabled client belongs, then select
Restart.
5. Click Yes to confirm the restart.
Setting the Client Retries attribute
If the NetWorker server fails to connect to a client, the Client Retries attribute
specifies the number of times that the server will reattempt the connection to the
client before the backup is considered a failure.
If the NetWorker software detects that the backup failed and the number of client
retries is not exceeded, the software will checkpoint-restart the backup. This
operation takes into account the group restart window and will not restart the
backup if the backup window has expired.

Checkpoint restart backups
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To increase the number of times each client in a group is retried before the backup
attempt is considered unsuccessful, change the value in the Client Retries attribute in
the Group resource. “Configuring checkpoint enabled clients” on page 71 provides
information on setting the Client Retries attribute.

How to query partial save sets from the Console
To view information on the partial save sets:
1. In the Administration window, click Media. Media-related topics appear in the
navigation tree.
2. Select Save Sets. The following tabs appear in the Save Sets window:
• Query Save Set
• Save Set List
3. Select the Query Save Set tab to query:
• All partial save sets, select Checkpoint Enabled.
• All partial save sets with the same Checkpoint ID, in the Checkpoint ID field,
type the Checkpoint ID of the partial save set on which you want to perform
the query.
4. Select the Save Set List tab to view the result of the save set query:
• The Checkpoint ID column displays the partial save set Checkpoint ID and its
Sequence ID. The Checkpoint ID is listed first followed by the Sequence ID,
which is encased within brackets.
• Sort the Checkpoint ID column to view the complete sequence of partial save
sets.
• The Status column displays the status of the partial save sets:
– Checkpoint browsable indicates that the save sets can be browsed.
– Checkpoint aborted indicates that the backup of the partial save set was
stopped or aborted.
Note: If no partial save sets are found that match the query, ensure that the backup of the
partial save sets was started within the Save Time period. To change the values for the
Save Time attribute, open the Save Set Query tab and select a date and time from the Save
Time calendar.

How to query partial save sets using the mminfo command
By default, the mminfo command output only displays the browsable save sets. The
first and intermediate partial save sets are not displayed. Only complete checkpoint
enabled save sets or final partial save sets are displayed.
Use the mminfo command with specific queries to display more information about
checkpoint-enabled save sets.
The following new media attributes have been added to the mminfo command to
support the checkpoint restart feature:
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◆

checkpoint_id — Displays the checkpoint restart id of the partial save set in the
chkpt_id column

◆

checkpoint_seq — Displays the partial save set sequence id in the chkpt_seq
column.
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◆

checkpoint-restart — The flag attribute is used to only display checkpoint restart
enabled save sets.

In addition, several media sumflags are used with the checkpoint restart feature:
◆

k — Indicates this is a checkpoint enabled save set

◆

a — The first and all intermediate partial save sets of a checkpoint sequence will
have aborted status.

◆

b — The last partial or complete save set of a checkpoint sequence will be marked
browseable.

Displaying checkpoint enabled save sets
To display all checkpoint enabled save sets, type the following command:
# mminfo -q 'checkpoint-restart' -r 'client, nsavetime, ssid(11),
sumflags(3), name, checkpoint_id, checkpoint_seq'
client save time ssid flnamechkpt_id chkpt_seq
plapew12519103034204700319cak/space/work/test_dir12519103031
plapew12519103274187923127cbk/space/work/test_dir12519103032
plapew12519107104087260214cak/space/work/test_dir12519107101
plapew12519107254070483013cbk/space/work/test_dir12519107102

Displaying all partial save sets for the checkpoint id
To display all partial savesets for the Checkpoint id, type the following command:
# mminfo -q "checkpoint_id=1251910303"
volumeclientdatesizelevelname
plapew.001plapew09/02/0917 MBfull/space/work/test_dir
plapew.001plapew09/02/09799 MBfull/space/work/test_dir
plapew.001.ROplapew09/02/0917 MBfull/space/work/test_dir
plapew.001.ROplapew09/02/09799 MBfull/space/work/test_dir

Recovering data
This section outlines how to recover data in the following two scenarios:
◆

“How to recover data from the complete sequence of partial backups that
comprise the original save set” on page 75

◆

“How to recover data from a partial save set” on page 76

How to recover data from the complete sequence of partial backups that comprise the original save set
File-by-file recover is available only if there is a complete sequence of partial save sets
that span the original save set. The directory structure is saved after the files are
saved. If the directory structure is not available, then the browser cannot access the
files.
To restore data from a complete sequence of partial save sets that comprise the
original save set:
1. Perform a query for all partial save sets. “How to query partial save sets from the
Console” on page 74 provides detailed information.
2. If the sequence of partial save set comprises the original save set, use one of the
following programs to restore the data:
• For Windows - The NetWorker User program
• For UNIX - The nwrecover program

Checkpoint restart backups
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Note: If the sequence of partial save set is incomplete and does not comprise the original save
set, use the save set recovery procedure to recover the data from the partial save set. “How to
recover data from a partial save set” on page 76 provides more information.

How to recover data from a partial save set
Save set recovery enables you to recover data from a partial save set rather than by
browsing and selecting individual files for recovery. However, the partial save set
only contains successfully backed up files and not the entire set of data. An
incomplete set of partial save sets cannot be browsed.
The procedure to restore data from partial save sets is the same as recovering by save
set selection. “Recovering by save set selection” on page 325 provides detailed
information on performing data recovery.
nsrinfo can be used to display the contents of a partial save set. The nsrinfo man
page or the NetWorker command line reference guide provides more information on
using the nsrinfo command.

Cloning and scanning partial savesets
Partial save sets can be cloned and scanned individually. These operations must be
performed on every partial save set.
If automatic cloning has been enabled, all partial save sets are cloned since automatic
cloning is run as part of the scheduled backup.

Cloud backup devices and partial savesets
By default, the CheckPoint Restart feature does not support cloud backup devices
because partial save sets are not retained on cloud backup devices.
Workaround

When the cloud backup device is used as a backup device for a Checkpoint Restart
operation, on the Server Properties menu, enable the Keep Incomplete Backups
attribute.
If the Keep Incomplete Backups attribute is not enabled, the NetWorker software will
not keep the partial savesets.

Deduplication backups
The NetWorker Avamar Integration Guide provides more information about Avamar
deduplication backups. The EMC NetWorker Data Domain Devices Integration Guide
provides more information about Data Domain deduplication backups.
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BMR backups
NetWorker clients can be configured to take advantage of EMC HomeBase bare metal
recovery (BMR) technology to ensure that a client can be restored or migrated from one
hardware type to another. When a backup is run on a client, a HomeBase profile is
automatically generated and saved to a specified HomeBase Server. This process is enabled
with a HomeBase Agent license. “Support for HomeBase” on page 653 provides detailed
information about configuring and enabling a NetWorker client for BMR support.

Encrypting backup data
Backup and archive data on UNIX and Windows hosts can be encrypted with the aes
Application Specific Module (ASM). The aes ASM provides 256-bit data encryption. Backup
data is encrypted based on a user-defined pass phrase. If no pass phrase is specified, data is
encrypted with a default pass phrase.
IMPORTANT
Do not use AES encryption when backing up files that are encrypted by using the
Microsoft Windows Encrypting File System (EFS). Even though the backup will be
reported as successful, recovery of the file will fail and the following message will be
written to the NetWorker log file:
recover: Error recovering <filename>. The RPC call completed before all pipes were
processed.
Note: AES data encryption is supported in NetWorker release 7.3 and later. For compatibility with
earlier NetWorker releases, PW1 password protection and PW2 encryption are supported.

Set the Datazone pass phrase for a NetWorker server
To set the Datazone pass phrase:
1. From the Administration window, click Configuration.
2. Select the server name.
3. From the File menu, select Properties.
4. Click the Configuration tab and type a pass phrase in the Datazone pass phrase attribute.
5. Click OK.
Note: By default, the current Datazone pass phrase is automatically used to recover password-protected
files. If the current Datazone pass phrase was created after a password-protected backup was
performed, you must provide the password that was in effect when a file was originally backed up.
Keep password changes to a minimum.

Apply AES data encryption to clients in the datazone
To implement AES encryption. apply the Encyrption global directive to individual clients by
using the Directive attribute of the Client resource. For information about editing a Client
resource, see “Editing a client” on page 470.

BMR backups
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Compressing backup data
Compressing data for a backup generates less network traffic. However, compression
uses computing resources, so its benefits may be limited on low-powered systems. If
the storage device also compresses data, the result may be that more data is actually
written to tape.
Note: Both compression and password-protection cannot be selected.

Applying compression to a scheduled backup
To apply compression to a scheduled backup, use the compressasm ASM in a local or
global directive. Alternatively, use a preconfigured directive that is appropriate for
the client computer’s operating system. “Directives” on page 169 provides
information about creating and applying directives.

Applying compression to a manual backup
To compress data for a manual backup on Windows:
1. Mark the data to be compressed.
2. Select the Special Handling option from the File menu in the NetWorker User
program. “Special data handling for NetWorker clients on Windows” on page 78
provides more information.
To compress data for a manual backup on UNIX, you must use the compressasm in a
local directive file. “Directives” on page 169 provides more information.

Special data handling for NetWorker clients on Windows
To select directories and files for password-protection, encryption, and compression,
or to clear a selected data item:
1. In the NetWorker User program, click Backup.
2. In the Backup window, select each data item to be designated for compression,
encryption, or password-protection. If you select a disk volume or directory for
an operation, the special handing will be applied to all of its nested subdirectories
and files.
3. From the File menu, select Special Handling.
4. Select an option and click OK. You can also right-click the file and select a special
handling option.
Depending on which special handling options were selected, the letter P
(password-protection), E (encryption), or C (compression) displays next to the
folder or filename.
To remove special handling, select a data item and click Remove.
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Backing up NetWorker Console Management data
To protect NetWorker Console management data, such as report information,
perform regular backups of the NetWorker Console database. The Console database
remains available during the backup.
Note: The savepsm backup command backs up the Console database and also backs up the
database credential file and the authentication configuration files in a separate save set named
CONSOLE_BACKUP_FILES.

Scheduling backups for the NetWorker Console database
If a NetWorker server was specified during the setup of the Console server in the
Console Configuration Wizard, a Client resource was created to back up the
NetWorker Console database on a scheduled basis. If a Client resource was created,
tailor the Client resource with respect to the backup schedule, browse and retention
policies, and so on.
If a Client resource was not created to back up the NetWorker Console database,
create a Client resource as follows:
1. From the Console window, click Setup.
2. From the Setup menu, select Set Database Backup Server.
3. In the NetWorker server attribute, type the name of the NetWorker server that
will back up the Console server database.
4. Select the Create client resource on this server attribute.
5. In the Client name attribute, type the name of the Console server.
6. Click OK.
A Client resource is created with the following attributes:
• Name attribute: the name of the Console server computer.
• Save Set attribute:
NMCASA:/gst_on_server_name/lgto_gst
where <server_name> is the short name of the host where the Console server
component was installed.
• Backup Command attribute: savepsm (for a Windows Console server) or
savepsm.sh (for a UNIX Console server).
One can also specify a NetWorker server to back up the Console server database
through the Console Configuration Wizard. “Accessing the Console
Configuration Wizard” on page 420 provides more information.
“Setting up a scheduled backup” on page 55 provides information about creating and
tailoring a Client resource.
Note: Only full, incremental, and skip backup levels are supported. All other backup levels (1
through 9) are mapped to an incremental backup.

Backing up NetWorker Console Management data
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Performing a manual backup of the Console database
Before performing a manual backup on UNIX, set the appropriate library path
environment variable to:
◆

<Console_install_dir/sybasa/lib64>

◆

<Console_install_dir/sybasa/lib> (Linux)

The environment variable to set varies by platform:
• Solaris/Linux: LD_LIBRARY_PATH
• AIX: LIBPATH
• HPUX: SHLIB_PATH
To perform a manual backup of the NetWorker Console database, type the following:
savepsm -I "<Console_install_dir>" save options

where <Console_install_dir> is the installation directory for the Console server. For
example:
◆

On Solaris, the default installation directory is /opt/LGTOnmc

◆

On Linux/AIX/HP_UX, the default installation directory is /opt/lgtonmc

◆

On Windows, the default installation directory is C:\program
files\legato\management\GST

Installation directory paths that have spaces must be enclosed in quotations. For
example:
savepsm -I "C:\program files\legato\management\GST" save options

The EMC NetWorker Command Reference Guide or the UNIX man pages provides
information about the savepsm command.

Managing the size of the Console database log file
The Console database transaction log files are automatically truncated whenever a
scheduled or a manual backup of the Console database is performed.
To truncate the transaction log file without performing a backup, type the savepsm
command as follows:
savepsm -I "<Console_install_dir>" -T

Consideration for managing the Console database log file
If the transaction log file is truncated manually, the next backup of the Console
database that is performed after truncation must be a full backup. The next backup
can be either a scheduled backup or a manual backup.
To ensure that the next scheduled backup of the Console database is a full backup:
1. Open the backup schedule for the Client resource that is associated with the
Console database.
2. If necessary, perform a manual override on the next scheduled backup so that it is
a full backup. “Editing a schedule” on page 145 provides formation about editing
a backup schedule.
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When performing a manual backup, a full backup is performed by default.
“Performing a manual backup of the Console database” on page 80 provides
information about manual backups.

Backing up Windows mount points
A volume mount point (or mount point) is an NTFS file system feature of Windows
2008, 2008 R2, Server 2003, and Windows XP Professional.
Assigning a drive letter to a mount point is optional. Many disk volumes can be
linked into a single directory tree, with a single drive letter assigned to the root of the
host volume.
Note: NetWorker backup and recovery of mount points require special handling, as explained
in this section.

Including mount points in scheduled backups
To include mount points and their data in scheduled backups, you must specify the
host volume, and each mount point. For example, to back up a single mount point on
drive D: and all of its data, include this in the client’s Save Set attribute:
D:\mountpoint_name
To include nested mount points in scheduled backups, you can either specify save set
All, or specify the host volume and the full path to each mount point. For example, to
back up three nested mount points and their data on drive D:, include these in the
client’s Save Set attribute:
D:\mountpoint_name1
D:\mountpoint_name1\mountpoint_name2
D:\mountpoint_name1\mountpoint_name2\mountpoint_name3
“Scheduled backups” on page 54 provides for more information about setting up a
scheduled backup. “Directory specifications” on page 176 provides information
about including mount points and nested mount points in a backup directive.

Performing a manual backup of a mount point and its data
To back up a mount point and its data:
1. Start the NetWorker User program.
2. Click Backup.
3. In the Backup window, expand the host drive that contains the mount point to
back up, for example, drive D:\.
4. Under D:\, select the mountpoint_name.
5. Expand the mountpoint_name and verify that all data beneath it is selected for
backup.
6. Click Start.
“Manual backups” on page 64 provides information about performing manual
backups.

Backing up Windows mount points
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Performing a manual backup of nested mount points and their data
To perform a manual backup of nested mount points and their data, perform
successive backup operations for each nested mount point and its data.
To back up three nested mount points and their data on drive D:\, for example:
1. Start the NetWorker User program.
2. Back up the top-level mount point and its data:
a. Click Backup.
b. In the Backup window, expand drive D:\ and mark mountpoint_name1.
Note: When you mark a mount point for backup, all files, directories, and nested mount
points beneath it are marked by default. Before starting the backup, make sure only
mountpoint_name1 and the files and directories beneath it are marked. You must unmark
any mount points nested beneath mountpoint_name1.

c. Click Start to run the backup.
3. Back up the second mount point and its data:
a. Click Backup.
b. In the Backup window, expand D:\ and mountpoint1.
c. Select mountpoint_name2 and its data.
Note: Be sure to clear (unmark) any mount points nested beneath mountpoint_name2
before starting the backup.

d. Click Start to run the backup.
4. Back up the third mount point and its data:
a. Click Backup.
b. In the Backup window, expand D:\, then expand mountpoint_name1, then
expand mountpoint_name2.
c. Select mountpoint_name3 and its data.
d. Click Start.

Backing up the Windows Content Index Server
The Windows Content Index Server (CIS) indexes the full textual contents and
property values of files and documents stored on the local computer. The information
in the index can be queried from the Windows search function, the Indexing Server
query form, or a web browser.

Backing up CIS on Windows
The backup and recovery of the CIS occurs as part of the SYSTEM DB save set. If VSS
is enabled, the CIS is automatically regenerated upon system reboot.
Note: Back up the SYSTEM STATE and the SYSTEM DB save sets whenever a CIS database is
created, moved, or renamed.
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Before a CIS backup, the NetWorker software performs the following:
1. Pauses any CIS catalogs that are to be backed up.
2. Backs up all files that belong to those catalogs.
3. Turns the catalogs on again when the backup is finished. A catalog can still be
queried when it is paused, so no indexing functionality is lost during the CIS
backup.
The CIS deletes the catalog folder during a backup and restores it as part of a
recovery operation.
Troubleshooting problems with a CIS backup
To troubleshoot a problem with a CIS backup:
◆

Ensure that the catalog folder is named catalog.wci.

◆

Restart the CIS.

◆

Ensure that the CIS was installed correctly.

◆

Pause or stop the catalogs, and then try the backup again.

Directing NetWorker software to skip CIS catalog backups
To skip backing up the catalog.wci folder entirely, create a Directive resource in the
NetWorker Console by typing the following:
[intentionally leave first line blank in this directive]
<< / >>
+skip: *.wci

“Directives” on page 169 provides information about directives.

Backing up Windows DHCP and WINS databases
Windows Dynamic Host Configuration Protocol (DHCP) and Windows Internet
Naming Service (WINS) databases are not included in the NetWorker SYSTEM DB
save set. However, you can use the procedures in this section to configure NetWorker
software to protect these databases.
Note: If VSS is licensed and enabled, the DHCP and WINS databases are automatically
included when performing a backup of save set All. The procedures in this section are optional.
“Scheduled backups” on page 54 provides information about scheduling and recovering
backups.

Backing up a DHCP database
To back up a DHCP database, ensure that this directory is included in the save sets
for the NetWorker client that is the DHCP server, type:
%SystemRoot%\System32\dhcp

Backing up Windows DHCP and WINS databases
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Backing up a WINS database
To back up a WINS database:
1. Use Microsoft WINS administrative tools to configure an automated backup of
the WINS database to a local drive on the WINS server.
2. Ensure that the location chosen in step 1 is included in the save sets for the
NetWorker client that is the WINS server.
Note: The Microsoft documentation provides information about the Microsoft WINS
administrative tools.

Windows backup and recovery notes
This section contains notes about the backup and recovery of data on Windows
clients, including:
◆

“Enabling short filename support” on page 84

◆

“Enabling hard link support” on page 85

◆

“Recovery and case-sensitivity” on page 85

◆

“Failed backup and recovery attempts” on page 85

◆

“Granting full permissions for backup of Disk Quota database” on page 85

◆

“Security settings for logging operations performed by backup operator” on
page 86

Enabling short filename support
On Windows Server 2003 and Windows XP Professional, NetWorker software
provides backup and recovery support for the short filenames that are automatically
assigned by the Windows filename mapping feature. Windows filename mapping is
an operating system feature in which each file or folder with a name that does not
conform to the MS-DOS 8.3 naming standard is automatically assigned a second
name that does. For example, a directory named Microsoft Office might be assigned a
second name of MICROS~2.s
To improve performance, support for short filenames is disabled by default.
To enable support for short filenames on a NetWorker client:
1. From the Administration interface window, click Configuration.
2. In the left pane, click Clients.
3. Right-click the appropriate client and select Properties.
4. Click the Globals (2 of 2) tab.
5. Select the Short filenames attribute.
6. Click OK.
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Enabling hard link support
The NetWorker server backs up and recovers files with hard links. However, the
hard links of files created by using a Portable Operating System Interface (POSIX)
application are not preserved during recovery.
To improve performance, support for hard links is disabled by default.
To enable support for hard links on a NetWorker client:
1. From the Administration interface window, click Configuration.
2. In the left pane, click Clients.
3. Right-click the appropriate client and select Properties.
4. Click the Globals (2 of 2) tab.
5. Select the Hard links attribute.
6. Click OK.

Recovery and case-sensitivity
The NetWorker server is case-sensitive with regard to backup and recovery, although
Windows file systems are not case-sensitive. This may result in the creation of
multiple files with the same name but different cases.
For example, if you back up a file that is named temp.txt, delete it, then create a new
file named Temp.txt, and then recover the old file, you will have two identical files in
the directory -- one named temp.txt and the other named Temp.txt.
To avoid this problem, disable POSIX compliance by setting this system environment
variable:
NSR_DISABLE_POSIX_CREATE=YES

The Windows online help contains detailed instructions about setting system
environment variables.

Failed backup and recovery attempts
The NetWorker log file, located in <install_path>\logs\networkr.raw, contains a
record of every file that was part of an attempted manual backup or recovery that
was performed from the NetWorker User program. This file is overwritten with the
next manual backup or recovery. If the file contains information that should be saved,
you should rename the file or export the information by using the nsr_render_log
program. “Viewing log files” on page 661 provides information about viewing log
files with the nsr_render_log program.

Granting full permissions for backup of Disk Quota database
NetWorker software backs up and recovers the Windows disk quota database as a
component of the SYSTEM DB or VSS SYSTEM SERVICES save set. For any
NetWorker client that uses the Windows Disk Quota feature, during SYSTEM DB or
VSS SYSTEM SERVICES backup, NetWorker software creates temporary files to store
the disk quota database settings in the root directory of each drive on the client. If the
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permission settings for a local drive do not allow full control to the local system
account, the disk quota database backup fails and an error message, similar to this,
appears:
Failed to write to quota file, 0x80070005

To grant full permissions to the local system account:
1. Log in with administrator privileges to the NetWorker client host computer.
2. Using Windows Explorer, perform these steps for each local drive:
a. Right-click a drive icon.
b. In the Properties dialog box, select the Security tab.
c. Make sure the permissions settings allow full control to the system account.
Note: By default, everyone has full permissions. If that setting has been changed such that the
system account does not have full permissions, you must grant full permissions to the system
account in order for the disk quota database to be backed up. For more information on setting
permissions, refer to the Microsoft Windows documentation.

Security settings for logging operations performed by backup operator
By default, members of the Windows Backup Operators group do not have write
permission to the <NetWorker_install_path>\logs directory.
To enable NetWorker logging for Backup Operators, modify the security settings on
the <NetWorker_install_path>\logs directory.
For example:
1. In Windows Explorer, navigate to the <NetWorker_install_path>\logs directory.
2. Right-click the <NetWorker_install_path>\logs directory icon and select
Properties.
3. On the Security tab of the Properties dialog box, add the Backup Operators
group to the list of groups and users.
4. Select the Backup Operators group and click Allow Write.
5. Click OK.
NetWorker logs operations performed by members of the Windows Backup
Operators group.

Customizing the backup command
You can customize client backups by creating additional programs (scripts) that
affect the way the NetWorker server backs up client file system data. For example,
one can create a program that performs the following:
1. Shuts down a mail server or database before the NetWorker server performs a
backup operation.
2. Restarts the mail server or database after the backup has completed.
3. Prints a message, such as, "Backup started at 3:33 A.M."
4. Executes the backup.
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5. Prints a message, such as "Backup completed at 6:30 A.M."
You can customize a client’s scheduled backups in one of two ways:
• By creating a script that invokes the save program as part of its instructions.
When the client is backed up, the customized program is invoked instead of
the standard save program. “Using the save command with a customized
backup script” on page 87 provides more information.
• By typing savepnpc in the Backup Command attribute of the Client resource.
This way, the client backup invokes the savepnpc program instead of the save
program. The first time the client is backed up, savepnpc creates a default
backup program file, which you can then customize for future backups of the
client. “Using the savepnpc command with a customized backup program” on
page 91 provides more information.

Using the save command with a customized backup script
Additional processing instructions can be specified by entering the name of a custom
script in the Backup Command attribute in the Client resource. The script will be
executed instead of the default save program, when scheduled backups are initiated.
The instructions in the script run separately for each save set backed up for the client.
When you use the save program, a new instance of the customized script is invoked
for each save set listed in the client’s Save Set attribute, rather than just once for that
client (as happens with savepnpc). If you specify a save set value of All, the program
is executed for each file system on the client. As a result, if you create a Client
resource with a customized backup for a database, a command to shut down the
database will be executed for each save set listed.
Note: After the creation of a customized backup script for a client, try backing up the client
immediately. Any configuration or network problems that could prevent a backup should
become apparent during this test.

The syntax used in the backup script or batch file must adhere to these criteria:
◆

The program name must begin with either the prefix save or nsr and must not
exceed 64 characters.

◆

The program must reside on the client in the same directory as the NetWorker
save command.

◆

Always specify the full path of the save command in the script.

◆

The NetWorker save command must be used in the backup program to ensure
that the data is properly backed up.

◆

All commands within the program file must be successfully executed. Otherwise,
the NetWorker server cannot complete the remaining instructions.

◆

On UNIX and Linux, when you invoke the NetWorker save command, invoke the
command with these arguments: save "$@". Doing so enables the save command
in the script to accept the arguments usually passed to it by the NetWorker
savefs program during a routine backup operation.

Customizing the backup command
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Create a custom backup script by using the save program
To create a custom backup script by using the save program:
1. Use a text editor to create a script in the directory where the NetWorker save
command resides.
Note: For custom backup scripts that are to run on Windows clients, the script name must
start with save or nsr and must end with the .bat extension.

Commands in this script must be placed in this order:
a. Run a preprocessing command before each save set backup (optional).
b. Back up the data by using the NetWorker save command (mandatory).
c. Run a postprocessing command after each save set backup (optional).
2. In the Backup Command attribute of the Client resource, type the name of the
backup script.
3. Back up the client to ensure that the newly created backup command works.
Example 3

The save Backup command on Windows

In this example, for each save set, the customized backup program executes
pre-backup commands, runs the NetWorker save command, and then executes
post-backup commands.
The backup program consists of these parts:
◆

Pre-Backup Command: Redirects the output of the Net start DOS command to
create a netstart.txt file at the root of the C: drive and send all current computer
Services Started information to this file.

◆

Save: Executes NetWorker commands to run the required backup process.

◆

Post-Backup Command: Redirects the output of the Set DOS command to a set.txt
file at the root of the C: drive and send all computer system environment
information to this file.

The netstart.txt and set.txt files are placed in the C:\ directory. New information is
appended to these files each time a backup is run.
Also, you can check the batch file execution process in the Monitor Groups tab of the
Administration window, or by viewing the savegrp log file in the
<NetWorker_install_path>\logs directory.
“Monitoring window” on page 392 provides information about viewing execution
file details from the Monitor Groups tab.
“Viewing log files” on page 661 provides information about viewing log files.
This is an example backup script:
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@ECHO OFF
SETLOCAL
ECHO =======START BATCH FILE================
ECHO =====NetWorker PRE_BACKUP COMMAND======
ECHO =======NET START - creates netstart.txt file and
ECHO =======sends all Started Services information
ECHO =======to the file c:\netstart.txt
NET START >>C:\NETSTART.TXT
REM This command takes incoming arguments from
REM the savegrp command and handle them
REM to overcome batch file limitations:
REM
REM
REM
REM

PARSE ALL INCOMING ARGUMENTS
and pass single argument in case
more than 10 arguments are passed to this file
(ie %0-%9 is not enough).

ECHO =====NetWorker SAVE SET COMMAND=======
SHIFT
SET arg=%0
:loop
SHIFT
IF %0.==. GOTO save
SET arg=%arg% %0
GOTO loop
REM These are the save commands that run the required
REM NetWorker backup commands.
:save
REM Note: Enter correct path to your NetWorker bin
REM directory (line below is default path)
C:\PROGRA~1\nsr\bin\save.exe %arg%
ECHO =====NetWorker POST_BACKUP COMMAND====
ECHO ====="SET" - creates set.txt file and sends all
ECHO =====computer system environment information to
ECHO =====C:\set.txt file========
SET >>C:\SET.TXT
ECHO ======END OF BATCH FILE====
ENDLOCAL

This information is displayed from the Monitor Groups tab, logged to the
sevegrp.log file after the backup process is done, and verifies the execution of the
three processes.
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--- Successful Save Sets --:* jupiter:c:\inetpub =======START BATCH FILE============
* jupiter:c:\inetpub ===NetWorker PRE_BACKUP COMMAND===
* jupiter:c:\inetpub=======NET START
* creates netstart.txt file and sends all started
* jupiter:c:\inetpub ======services information to
* that file c:\netstart.txt==
* jupiter:c:\inetpub ===NetWorker SAVE SET COMMAND====
* jupiter:c:\inetpub save: using `C:\Inetpub' for
* `c:\inetpub'
jupiter: c:\inetpub level=full,194 KB 00:00:02 37 files
* jupiter:c:\inetpub =====NetWorker POST_BACKUP COMMAND
* jupiter:c:\inetpub ====="SET" - creates set.txt
* file and sends all computer system
* jupiter:c:\inetpub ==== environment information
* to C:\set.txt file
* jupiter:c:\inetpub ======END OF BATCH FILE====
jupiter: index:jupiter
level=full, 243 KB 00:00:00
23 files
jupiter: bootstrap
level=full,
47 KB 00:00:00
7
files
* jupiter:bootstrap nsrlpr: Either a printer isn't
* defined for printing the Bootstrap for
* this savegroup,
* jupiter:bootstrap 04/26/06 01:34:13 PM
full
* 3901113601 3901113601 0
jupiter.001
Example 4

The save backup command on UNIX

This script backs up a ClearCase version object base (VOB). The script file must reside
in the same directory as the NetWorker save command (for example, on a Solaris
system, the save program is installed in the /usr/sbin directory). Type the name of
the script into the Backup Command attribute of the Client resource that is used to
back up the ClearCase VOB. As a result, this script is invoked instead of the usual
save command during a scheduled backup.
Note: Include the save command in the script and place the script in the same directory as the
save program. Otherwise, the backup will fail.
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This script locks a ClearCase VOB, performs the backup, and then unlocks the VOB.
#!/bin/sh
# export the SHELL that we are going to use
SHELL=/bin/sh
export SHELL
# export the correct PATH so that all the required binaries can be
found
case $0 in
/* ) PATH=/usr/atria/bin:/bin:/usr/bin:`/bin/dirname $0`
c=`/bin/basename $0`
;;
* )PATH=/usr/atria/bin:/bin:/usr/bin:/usr/sbin
c=$0
;;
esac
export PATH
# These are the valid statuses that save reports upon completion of
the backup
statuses="
failed.
abandoned.
succeeded.
completed savetime=
"
# Perform the PRECMD (Lock VOB)
/usr/atria/bin/cleartool setview -exec
"/usr/atria/bin/cleartoollock -c \
‘VOB backups in progress’ -vob /cm_data/mis_dev" magic_view >
/tmp/voblock.log 2>&1
# Perform backup on client
save "$@" > /tmp/saveout$$ 2>&1
# cat out the save output
cat /tmp/saveout$$
# search for backup status in output reported by save
for i in ${statuses}; do
result=`grep "${i}" /tmp/saveout$$`
if [$? != 0]; then
echo ${result}
fi
done
# Perform the POSTCMD (Unlock VOB)
/usr/atria/bin/cleartool setview -exec
"/usr/atria/bin/cleartoolunlock -vob
/cm_data/mis_dev" \
magic_view > /tmp/vobunlock.log 2>&
# exit gracefully out of the shell script
exit 0

Using the savepnpc command with a customized backup program
As an alternative to using the save program with a custom script, use the savepnpc
program. The savepnpc program differs from using a custom script with the save
program in that preprocessing and postprocessing commands execute only once
during the client backup, instead of once for each save set. This command can be
useful if the client is running a database or other program that should be stopped
before the client is backed up, and then restarted after the backup has completed. The
options for the savepnpc command are identical to those for the save command.
The EMC NetWorker Command Reference Guide or the UNIX man pages provides For
information about the savepnpc command.
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To execute the savepnpc program:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clients.
3. Create a new Client resource or select an existing Client for editing.
4. Select the Apps & Modules tab.
5. In the Backup Command attribute, type:
savepnpc
6. Back up the client.
The first time a backup group with a client that uses savepnpc runs, a
standardized group-name.res file is created in one of the following:
• The /nsr/res (UNIX)
• The NetWorker_install_path\res (Microsoft Windows) directory on the client
where group-name is the same as the name in the Group resource selected for
that client. If the client belongs to multiple backup groups, a separate
group-name.res file is created for each group to which the client belongs.
The initial group-name.res file contains type, preprocessing, postprocessing,
timeout, and abort precmd with group attributes:
type: savepnpc;
precmd: "echo hello";
pstcmd: "echo bye";
timeout: "12:00pm";
abort precmd with group: No;
Note: The abort precmd with group attribute determines what will happen to the
preprocessing command when the savegroup process aborts prematurely. By default, the
preprocessing command process will not be killed if the savegroup process aborts
prematurely. To kill the preprocessing command when the savegroup process aborts, set abort
precmd with group to Yes.

Once the group-name.res file exists, use a text editor to customize the file’s attributes.
These customized instructions are then applied the next time the client is backed up.
Before performing a save operation on the client, the modified savepnpc program
performs the following:
◆

Any preprocessing commands listed for the precmd attribute in the
group-name.res file.

◆

The save by using the options specified for the savepnpc command itself.

◆

Any postprocessing commands listed for the pstcmd attribute.

When editing a group-name.res file, these points apply:
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◆

The command environment that is opened by the savepnpc command to run a
customized backup does not automatically inherit the system’s default
environment. Specifically, environment variables, including PATH, will either
not exist or will be set to NULL. The environment must be built as part of the
preprocessing (precmd) commands, especially the PATH variable. On UNIX
clients, be sure to source the .profile, .cshrc, and other login scripts.

◆

The save command should not be specified in the group-name.res file. The
savepnpc program will automatically invoke the save command and back up the
save sets specified in the Save set attribute for the client.
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◆

To exclude the environment variables in the group-name.res file, include full
pathnames for all commands and files.

◆

Resident commands, for which there is no executable file present, like time and
dir, will not work as commands in your group-name.res file. The log reports that
the executable file could not be found.

◆

On a Microsoft Windows client, do not use "@ECHO OFF" in the group-name.res
file.

◆

To add more than one command sequence to the precmd and pstcmd attributes,
insert a comma (,) to separate the commands.

◆

A complete command-line for an attribute must end with a semicolon (;).

◆

Escape any backslash (\) characters in the group-name.res file. For example, the
pathname C:\mydir\myprogram.exe must be written
C:\\mydir\\myprogram.exe.
This is an example of a fully functional group-name.res file:
type: savepnpc;
precmd: "V:\\usr\\sap\\PDB\\SYS\\exe\\run\\PDB-stop.cmd >
C:\\WINNT\\system32\\PDBStop.log 2>&1";
pstcmd: "V:\\usr\\sap\\PDB\\SYS\\exe\\run\\PDB-start.cmd
C:\\WINNT\\system32\\PDBStart.log 2>&1";
timeout: "12:00pm";

It is not necessary to escape any backslash characters in scripts called from the
group-name.res. To simplify the pathname issue, include all commands in a script
or batch file, and then include that script’s full pathname on the precmd or
postcmd line.
• A line break is required after the semicolon that ends the last command in the
group-name.res file.
• The following applies to text written to standard output:
– Text written during preprocessing appears in the NetWorker completion
notices. You can direct this output to a log file.
– Text written during postprocessing is discarded. Consider redirecting this
output to a log file so you can troubleshoot problems.
Timeout attribute
The Timeout attribute indicates when the postprocessing commands are to be run,
regardless of whether all of the save sets have been backed up or not. The timeout
entry must be specified in nsr_getdate format and must be enclosed in double quotes.
For more information about nsr_getdate, refer to the EMC NetWorker Command
Reference Guide or the UNIX man pages.
If an invalid time is entered for the timeout, the timeout is not executed and no error
message is produced.
The Timeout attribute is optional. To disable the Timeout attribute, add a comment
character (#) to the beginning of the line, for example:
# timeout: "12:00pm";

The value of the Timeout attribute may not be the exact time that postprocessing
actually commences. The savepnpc program’s pstclntsave subroutine uses a
one-minute polling interval to check for the completion of preprocessing tasks.
Therefore, the savepnpc log file may show that postprocessing was started up to 60
seconds after the designated timeout.
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Customize the savepnpc command for multiple groups
To customize pre- and postcommand processing for multiple groups:
1. Copy existing group-name.res files.
• Microsoft Windows clients:
NetWorker_install_path\tmp\group-name.res to NetWorker_install_path\tmp\
your_new_group.res
• UNIX clients:
/nsr/res/group-name.res to /nsr/res/your_new_group.res
2. Edit the new new_group-name.res file.
If you do not have an existing group-name.res file, activate the group for savepnpc
without the presence of this file. A default template will be created at one of the
following:
• /nsr/res/your_new_group.res
• NetWorker_install_path\res\your_new_group.res
You can then customize the template.
Message logging by the savepnpc command
Messages generated by savepnpc are written to the savepnpc log file, located in these
locations on the NetWorker client:
◆

UNIX: /nsr/logs

◆

Microsoft Windows: NetWorker_install_path\logs

The format of the savepnpc log file is similar to:
04/03/07 13:56:43 preclntsave: All command(s) ran successfully.
04/03/07 13:57:43 preclntsave: All save sets on the worklist are done.
“Viewing log files” on page 661 provides information about viewing log files.

Considerations for backing up raw partitions
The NetWorker software must have exclusive access to a file system to perform a raw
backup. Close as many applications as possible before doing a raw disk backup. If the
raw partition contains data managed by an active database management system
(DBMS), ensure that the partition is offline and the database manager is shutdown.
For greater flexibility when backing up partitions that contain DBMS data, use a
NetWorker Module application.

Backing up raw partitions on UNIX
To back up raw disk partitions on UNIX, use the rawasm directive. “Precautions
when using rawasm to back up UNIX raw partitions” on page 180 provides more
information.
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Backing up raw partitions on Windows
To back up a raw disk partition on Windows, specify the raw disk partition in a save
set. Identify the raw partition as a physical drive or as a logical drive. For example:
save -s NetWorker_server_name \\.\PhysicalDrive0
save -s NetWorker_server_name \\.\C:

Backing up a mapped drive
To back up a mapped drive, follow these guidelines:
◆

To specify a drive to back up in either a scheduled or manual backup, do not
specify the drive letter. Instead, specify the Universal Naming Convention (UNC)
path.
For example, to specify the accounts directory on the server jupiter, type:
\\jupiter\accounts

◆

For scheduled backups:
• Add the username required to access the UNC path to the Remote User
attribute in the Client resource.
• Add the password required to access the UNC path to the Remote Password
attribute in the Client resource.

Backing up access control lists
The backup and restore of ACLs (Access Control Lists) and extended ACLs is fully
supported. This support covers Linux, HP-UX, AIX, DEC, SOLARIS, OS/X, and
Windows.
There is no special attribute or keyword that controls this support. When a file that
has an associated ACL is backed up, the ACL is backed up along with the file data.
When the file is recovered, any associated ACLs will also be recovered.

Backing up BOOT/BCD Data on Windows 2008R2 and Windows 7
In earlier versions of Windows operating system, the BOOT directory was present in
the system drive. However, in Windows 7 and Windows 2008 R2, a hidden,
unmounted system reserved partition is created and the BOOT Configuration Data
(BCD) store is saved in this partition. The BCD store contains the boot configuration
parameters and controls the computer’s boot environment.
During a backup, NetWorker checks for the type of operating system. If it is
Windows 7 or Windows 2008 R2, it ensures that the partition containing the BCD is
mounted and then assigns a drive letter to the mounted partition and performs the
backup of the BCD. The VSS BOOT BCD FILES get backed up as a part of the VSS
SYSTEM FILE SET. After a backup, the partition is unmounted.

Backing up a mapped drive
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Support for backing up renamed directories
When a directory is renamed, the default behavior during a non-full level backup is
to skip the unchanged files and folders under the renamed directory. This behavior
can cause unexpected results during a recovery operation. If you attempt to recover
data under a renamed directory from a date between the time that the directory was
renamed and the next full level backup, it may appear that data is missing. For that
recovery time period, any files or folders that were unchanged will not display under
the renamed directory. Instead, they will be displayed under the old directory name.
In NetWorker 7.5 or greater, you can back up all of the files and folders under a
renamed directory regardless of whether or not they have changed. The advantage of
this feature is that data under the renamed directory does not appear to be lost when
performing a recovery.
Be aware of the following when deciding whether or not to enable this feature:
◆

The backup renamed directory feature is enabled on a client basis. Consider
enabling this feature only on clients that are prone to issues with recovering
renamed directories.

◆

Even if no renamed directories are encountered, enabling this feature will
increase the backup time for a client.

◆

Enabling this feature can further increase the backup time and result in increased
media usage, depending on the level at which a renamed directory is
encountered. A full backup will be performed on all sub-directories and files
under a renamed directory.

◆

The enterprise environment and the NetWorker server and client operating
system platforms have a large impact on the overhead associated with enabling
this feature.

To enable the backup renamed directory feature:
◆

Select the Backup renamed directories attribute in the Client resource. “Editing a
client” on page 470 provides information about editing a Client resource.
Note: If this option is selected and a renamed directory is at some future date given its
original name, files and subdirectories under that directory will not be eligible for backup
until the files or subdirectories are updated or the next full backup occurs.

Backing up only client file indexes and the bootstrap
You can set up a backup group to backup only the client file index information for
those NetWorker clients that belong to the backup group. The bootstrap will also be
backed up.
To backup only the client file indexes and the bootstrap:
1. Set up a backup group as described in“Task 2: Set up a group for backup clients”
on page 57
2. In the backup group properties Advanced tab, select Index only from the
Options attribute.
3. Click OK.
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Devices and libraries
NetWorker software automatically recognizes devices that are being used for
backups and recoveries. The maximum number of configured devices for any
NetWorker server and storage node combination is 512. The maximum number
varies depending on the particular server that is being administered. The maximum
number also does not include read-only devices created for advanced file type
devices. “File type (FTD) and advanced file type (AFTD) devices” on page 242
provides information about file type devices, advanced file type devices, and the
NetWorker DiskBackup option.
The NetWorker Console permits extensive handling of devices, including the ability
to autoconfigure:
◆

SCSI devices

◆

NDMP devices

◆

Silos

The details that describe a particular device can be viewed, and often changed, in the
device’s Properties.
To view details:
1. Select View > Diagnostic Mode to see the full range of settings and options
available in the Properties window.
2. In the Properties window, click Field Help for a description of the various fields
and attributes.
These options are available from many of the menus throughout the Devices task:
◆

Configure all Libraries

◆

Scan for Devices

If these options are started from the server folder instead of from the Storage Node
folder, then all storage nodes on the NetWorker server are automatically selected for
configuration in the wizard, or for scanning, respectively.
As with other Console functions, users can view and work with only those
NetWorker servers for which they have access permission.

Support for LTO-4 hardware-based encryption
The use of LTO-4 hardware-based encryption is supported by NetWorker when
controlled by management utilities that are provided with the LTO-4 hardware, or by
third-party key management software. EMC does not test or certify these key
management utilities; however, the NetWorker application can read from and write
to LTO-4 devices that use hardware-based encryption. The use of this encryption is
transparent to NetWorker. Neither the encryption nor the key management process is
managed by the NetWorker application. This includes the ability to turn encryption
on or off within NetWorker, and the management of encryption keys.
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Storage nodes
Storage nodes (including the NetWorker server) are host computers with attached
storage devices. A storage node has the physical connection and ownership of the
attached devices, but the NetWorker server maintains the client file index and media
database. With the NetWorker software, client data can be routed directly to a storage
node’s storage devices without the data first going to the NetWorker server. A
storage node may be a client of the NetWorker server, although this is not a
requirement. However, the storage node must have the NetWorker client software
installed.
From the NetWorker server, typical storage tasks can be performed, such as:
◆

Mounting and labeling volumes for the storage node devices.

◆

Configuring NetWorker resources associated with the storage nodes.

Only users who have the Configure NetWorker privilege can add to or change the
configuration of the NetWorker server, media devices, and libraries. “NetWorker
User Groups” on page 442 provides more information.

Prerequisites
To operate the NetWorker software with storage nodes, the following requirements
must be met:
◆

On UNIX systems, this software must be installed on the storage nodes. The
packages must be installed in the order listed:
1. NetWorker client software
2. NetWorker storage node software
3. (Optional) EMC AlphaStor software.
This enables multiple NetWorker servers to share the storage node. The
AlphaStor software must be used to manage the libraries, drives, and volumes
on that node. The AlphaStor server is available on Solaris and Microsoft
Windows only. AlphaStor DCP/LCP is available on all UNIX, Linux, and
Windows platforms. Refer to the EMC NetWorker Software Compatibility Guide
for information.

◆

On Windows systems, the Storage Node Option must be installed. This installs
both the NetWorker client and storage node software.

Licensing
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information on
NetWorker licensing support for storage nodes.

Storage node configuration
After the required software and enabler codes are installed, each storage node device
must be configured (by adding them to the NetWorker server). This procedure is
similar to the tasks required for other devices. “Configuring a storage node” on
page 100 provides more information.

Storage nodes
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Configuring a storage node
To configure a NetWorker storage node:
1. In the server’s Administration interface, click the Devices button.
2. Right-click Storage Nodes in the navigation tree, and select New. The Create
NSR Storage Node window appears, with the General tab shown.
3. In the Identity area:
a. Type the fully-qualified domain name or short name of the storage node in the
Name field.
b. Check a box (NDMP, SCSI, or silo) in the Type of Storage Node field. The
default is SCSI.
Note: If NDMP is selected, the remote username and password must be entered. If
configuring a silo for use with NDMP, select silo rather than NDMP. Also verify that the
silo robot arm is undetected by the NDMP storage nodes.

4. In the Device Management area, configure:
a. Select a Device Sharing Mode. The default is Server Default.
b. Select whether to search all LUNs (logical unit numbers) targets. Setting this
field to Yes may cause device detection operations to take a very long time. If
No is selected, NetWorker stops searching at the first unused LUN. The
default is No.
c. Select whether to use persistent names when performing device discovery and
autoconfiguration operations. The default is No. “Persistent binding and
naming” on page 270 provides more information on the use of persistent
device names.
d. Name SCSI targets to skip, if any, and if the storage node type is set to SCSI.
e. Type only one SCSI target per line.
5. In the Remote Host area, type the name of any remote user who is to be allowed
to access the remote host from the storage node along with the password for this
remote user.
Note: Only one remote user with password is allowed per storage node. This applies to
NDMP and advanced file type devices (AFTDs). “File type (FTD) and advanced file type
(AFTD) devices” on page 242 provides more information about AFTDs.

6. Click OK when done. The new storage node appears in the navigation tree.

Modifying timeout attribute for storage node operations
An attribute named Nsrmmd Control Timeout, which is set during NetWorker
server configuration, configures the amount of time a NetWorker server waits for a
storage node request to be completed. If the timeout value is reached without
completion of the request, the operation stops and an error message is logged. The
default value assigned to Nsrmmd Control Timeout is five minutes.
Other attributes involved in storage node timeouts include:
◆
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Nsrmmd polling interval, which determines the number of minutes between
storage node polls.
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◆

Nsrmmd restart interval, which determines the number of the minutes the
NetWorker software waits before restarting the nsrmmd process. A value of zero
for the Nsrmmd restart interval attributes indicates an immediate restart.

To modify these attributes:
1. In the server’s Administration interface, click the Configuration button.
2. Select View>Diagnostic Node.
3. Right-click the NetWorker server and select Properties.
4. Select the Media tab.
5. Modify the attributes as appropriate and click OK.

Timeouts for storage node remote devices
Timeouts that determine how long to wait for mount requests on a storage node
remote device before the save is redirected to another storage node are set in a
device’s Properties.
The Storage Node Devices area of the tab includes these attributes related to storage
node timeouts:
◆

Save Mount Timeout

◆

Save Lockout

Set the Save Mount Timeout and Save Lockout attributes to change the timeout of a
save mount request on a remote device.
If the mount request is not satisfied within the time frame specified by the Save
Mount Timeout attribute, the storage node is locked out from receiving saved data
for the time specified by the Save Lockout attribute.
The default value for Save Mount Timeout is 30 minutes. The default value for Save
Lockout is zero, which means the device in the storage node continues to receive
mount requests for the saved data.
Note: The Save Mount Timeout applies only to the initial volume of a save request.

To modify these attributes:
1. In the server’s Administration interface, click the Devices button.
2. Select View>Diagnostic Node.
3. Right-click the remote device and select Properties.
4. Select the Advanced tab.
5. Modify the attributes as appropriate and click OK.

Storage node affinity
The choice of which NetWorker servers and storage nodes receive a client’s
data—known as storage node affinity—is made by entering their hostnames in the
Storage Nodes attribute located in the Client Properties, on the Globals (2 of 2) tab.
The default setting for the Storage Nodes attribute on most Client resources is
nsrserverhost (the host NetWorker server).

Storage node configuration
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If the Client resource of a storage node computer is created after a remote device on
the storage node has been created, the default setting of the Storage Nodes attribute is
the storage node and the NetWorker server.
If a Client resource is created after a storage node is created, and the client is to back
up to that storage node, the name of the storage node must be entered in the client’s
Storage Nodes attribute above the default nsrserverhost. Storage node names can be
added to this list at any time. The client directs its data to the first storage node in the
list that has an enabled device and is capable of receiving the data.
To modify the Storage Nodes attribute:
1. In the server’s Administration interface, click the Configuration button.
2. Select Clients, right-click the appropriate client and select Properties.
3. Select the Globals (2 of 2) tab.
4. Modify the Storage Nodes attribute as appropriate and click OK.
Bootstrap backup on a storage node
When the server’s bootstrap save set is backed up, the data writes to a device that is
local to the NetWorker server. A bootstrap cannot be backed up to a remote device,
but a bootstrap can be cloned or staged to a remote device. When the mmrecov
command is used to recover a bootstrap save set, the data must be recovered from a
local device.
Staging bootstrap backups
Bootstrap backups can be directed to a disk device such as an AFTD or FTD device.
However, if a bootstrap backup is staged to another device, the staging operation will
complete and will be reported as complete even though the "recover space" operation
will not be executed. This means that the staged bootstrap will remain on the original
disk from which it was staged. Therefore, the original disk can be used to scan in the
bootstrap data if the staged bootstrap is accidentally deleted. Also be aware that if the
bootstrap data is not staged from the original disk, the data on the original disk will
be subject to the same browse and retention policies as any other saveset backup and
will, therefore, be subject to deletion after the retention policy has expired.
This bootstrap information also applies to NDMP devices.

Dedicated storage nodes
In NetWorker release 7.0 and later, all devices created on storage nodes (except
servers) include the Dedicated Storage Node attribute. A dedicated storage node can
back up only its own, local data.
Set this attribute when a device is created on a remote storage node. It is found in the
device’s Properties, on the Configuration tab. If the Dedicated Storage Node attribute
is set to Yes, a Dedicated Storage Node License is required for the storage node. If,
however, the Dedicated Storage Node attribute is set to No (the default value), a
standard storage node license is required. The Dedicated Storage Node License also
can be used for backing up virtual clients in a cluster.
Note: A storage node host cannot mix storage node types. Either all devices on a storage node
must be set up for a dedicated storage node, or all must be set up for a standard storage node.

In NetWorker release 7.6, NetWorker supports the installation of a dedicated storage
node in a Solaris 10 local zone to backup directly to a physically attached device
without sending data across the IP network. NetWorker allows sharing of a device
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between multiple dedicated storage nodes that are installed in multiple local zones of
a single physical host, assuming all the storage nodes belong to a single NetWorker
data zone.

Tips for troubleshooting storage nodes
If a backup fails, this message might appear:
no matching devices; check storage nodes, devices or pools

The problem could be related to storage node affinity.
Possible causes include:
◆

No enabled devices are on the storage nodes.

◆

The devices do not have volumes that match the pool required by the backup
request.

◆

All devices are set to read-only or are disabled.

For example, if the client has only one storage node in its Storage Node list, and all
devices on that storage node are disabled, fix the problem and then restart the
backup.
Complete one of the following actions to fix the problem:
◆

Enable devices on one of the storage nodes in the client’s list.

◆

Correct the pool restrictions for the devices in the storage node list.

◆

Configure an additional storage node that has enabled devices that meet the pool
restrictions.

◆

Set one of the devices to read/write.

Storage node configuration
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Data Domain deduplication devices
The EMC NetWorker Data Domain Devices Integration Guide provides information
about setting up and configuring Data Domain deduplication backup devices.

Avamar deduplication nodes and replication nodes
Deduplication nodes and replication nodes exist on Avamar servers. Contact EMC
Customer Support to configure these nodes on the Avamar server side. Once that has
been done, you can create access to them from the NetWorker side.
The NetWorker Avamar Integration Guide provides information on how to create a
NetWorker deduplication node.

Dynamic drive sharing
Dynamic Drive Sharing (DDS) is a feature that provides NetWorker software with
the ability to recognize shared drives. DDS enables NetWorker software to do the
following:
◆

Skip the shared drives that are in use.

◆

Route the backups or recoveries to other available shared drives.

Introduction to DDS
DDS controls application requests for media and allows the NetWorker server and all
storage nodes to access and share all attached devices.
A system administrator can configure DDS by setting a sharing policy for devices
that are accessible from multiple storage nodes.
Two terms central to the use of DDS are drive and device. Within the context of DDS,
these terms are defined as follows:
◆

Drive — The physical backup object, such as a tape drive, disk, or file.

◆

Device — The access path to the physical drive.

Note: DDS is currently supported only in a storage area network (SAN) Fibre Channel
environment and not in a direct-connect SCSI environment.

Benefits of DDS
Enabling DDS on a NetWorker system provides these benefits:
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◆

Reduces storage costs — A single tape drive can be shared among several storage
nodes. In fact, since NetWorker software uses the same open tape format for
UNIX, Windows, NetWare and Linux, the same tape can be shared between
different platforms (assuming that respective save sets belong to the same pool).

◆

Reduces LAN traffic — Clients can be configured as SAN storage nodes that can
send save sets over the SAN to shared drives.

◆

Provides fault tolerance — Within a SAN environment, hardware can be
configured to eliminate a single point of failure.

◆

Provides configuration over a greater distance — Allows configuration of a
system over a greater distance than with SCSI connections.
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DDS configuration overview
Figure 9 on page 105 illustrates the DDS process and potential configurations for
sharing drives. This basic configuration consists of a server, two storage nodes, and a
library with two tape drives.
In this figure:
◆

Storage nodes sn_1 and sn_2 are attached to the library.

◆

Each node, on its own, has access to drive_1 and drive_2.

◆

With DDS enabled, both nodes have access to both drives and can recognize
when a shared drive is in use.

◆

Under such a configuration, two DDS licenses are required, one for each drive.

NetWorker Server
Storage Node (sn_1)
SAN
Storage Node (sn_2)

Drive 1

(hardware id: drive_1)

Drive 2

(hardware id: drive_2)

Shared Autochanger
Figure 9

Dynamic Drive Sharing
Note: Ensure that all applicable devices can be seen from each storage node by running the
inquire -l command locally on each storage node.

Block-size compatibility
With DDS enabled, drives can be shared between storage nodes on different
platforms, such as UNIX and Microsoft Windows. For NetWorker software
operations (such as backups and recoveries) to take place successfully, ensure that the
block size is compatible between different platforms and/or hardware.
To ensure compatibility, make sure one of the following conditions is met:
◆

The various storage nodes sharing a drive support the same block sizes.

◆

When a tape is labeled on a drive, it is labeled with the block size defined on the
storage nodes.

“Compatible block size for UNIX and Windows” on page 261 provides information
about how to set block sizes for individual drives or tapes on different platforms.

Dynamic drive sharing

105

Configuring Libraries and Devices

Block-size incompatibility between UNIX and Windows
Incompatible block-size settings between UNIX and Microsoft Windows storage
nodes could result in any of these error scenarios:
◆

A backup taken on a UNIX node might not be recoverable on a Microsoft
Windows node if the Windows node does not support large block sizes.

◆

A UNIX process labels and saves data to a tape and leaves the tape mounted. A
Microsoft Windows process subsequently attempts to verify the label on this tape
and fails because the label verification is done by reading a header from the data
portion.

◆

A tape on a UNIX node is labeled with a large block size. The backup is started on
a Microsoft Windows node and the Windows node attempts to write the backup
by using the default block size. Internally, the backup on Windows is written by
breaking down the big buffer of data into smaller segments of writable block
sizes.
Attempting to recover a specific file on Windows in this situation fails due to
positioning errors on the tape. The data is still recoverable from the Windows
side, since the NetWorker software will switch from using file and block
positioning to reading the tape from the beginning to reach the correct position.
The data might not, however, be recoverable from the UNIX side.

SCSI Reserve/Release
The Reserve/Release attribute has been added to the Device resource for tape devices
to support Reserve/Release, including the Persistent Reserve commands.
Reserve/Release is a mechanism that uses SCSI commands to attempt to prevent
unintended access to tape drives that are connected by using a shared-access
technology, such as Fibre Channel, iSCSI, or SCSI multiplexers. It is a "cooperative"
and host-based mechanism, which means that all applications should respect the
reservations and not purposely break them. Access is granted based on the host
system that reserved the device. Other applications that run on that host cannot be
prevented from accessing a reserved device.
Reserve/Release cannot prevent a malicious or badly behaved application from
accessing a reserved device. It also cannot prevent all problems caused by hardware
issues (such as SCSI resets or FC LIPs) from interrupting data access.
The basic sequence requires that a host reserve a tape drive (using specific SCSI
commands) before attempting to access the tape drive. If this "reservation" succeeds,
then the host can use the drive. If the reservation fails (usually because the device is
reserved by someone else), then the host attempting the reservation should not
attempt to use the drive. When a host has finished using a reserved drive, that host
must release the drive by using the appropriate SCSI commands.
The reservation is maintained by the drive itself. With older (called "Simple" in
NetWorker software) Reserve/Release, the reservation is based on the SCSI ID of the
system that issued the reserve command. For tape drives connected to Fibre Channel
(FC) using FC-SCSI bridges, the mapping between FC host and reservation is done
inside the bridge, since the initiator on the SCSI side is always the bridge itself,
regardless which host actually issued the reserve command.
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For Persistent Reserve, the reservation is associated with a 64-bit "key" that is
registered by the host. Several keys can be registered with a given drive at any given
time, but only one may hold the active reservation. NetWorker software uses the
"exclusive" reservation method for Persistent Reserve. Only the host that holds the
active reservation is allowed to access the drive.
The Reserve/Release attribute does not support file type or advanced file type
devices.
The settings that relate to Reserve/Release and Persistent Reserve are found in a
device’s Properties window, on the Advanced tab. They are visible only when
diagnostic mode is turned on.
The default setting for Reserve/Release is None. Once any other Reserve/Release
setting is selected, it works automatically, without further user intervention. The
Reserve/Release attribute is supported only on Common Device Interface (CDI)
platforms, so if the CDI attribute in a device’s Properties is set to Not Used, then
Reserve/Release settings are ignored. “Common device interface” on page 268
provides more information regarding CDI.
For newer hardware, once a Reserve/Release setting (other than None) has been
selected, the appropriate Persistent Reserve commands are automatically issued
before a device is opened for reading or writing, and before the device is closed. With
older hardware, a SCSI-2 Reserve command is issued before opening the device, and
a SCSI-2 Release command is issued after the device is closed.
Reserve/Release has these possible settings:
◆

None (the default)

◆

Simple

◆

Persistent Reserve

◆

Persistent Reserve + APTPL (Activate Persist Through Power Loss)

The Persistent Reserve Key attribute has also been added. It is used with Persistent
Reservation calls.
Restrictions for use of the SCSI Reserve/Release setting
Note these restrictions for this feature:
◆

It is available on CDI platforms only. Consequently, since CDI is not supported
within an NDMP environment, Reserve/Release is not supported with NDMP. It
is also not supported on IRIX and SGI platforms.

◆

Not all drives support persistent Reserve/Release. (All drives support at least
simple reserve release. The code automatically drops back from Persistent
+APTPL or Persistent to Simple on drives that do not support Persistent.)

◆

SCSI resets can clear Simple reservations at the device.

◆

Even with Reserve/Release, there is no guarantee against data loss.

◆

If the operating system has its own Reserve/Release feature, that feature must be
disabled in order for the NetWorker Reserve/Release feature to work.

◆

Even if all of the enterprise’s NetWorker storage nodes have this feature enabled,
then it is possible that, on the storage node where a backup operation is run, data
loss can be caused by the operating system’s utilities or by third-party programs.
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Enabling DDS with NDMP
These sections explain the requirements for successfully enabling DDS with NDMP.
DDS on NDMP nodes in a SAN environment
Drives can be shared between NDMP nodes in a SAN environment. Ensure,
however, that the NDMP nodes are homogeneous.
For example, DDS can be enabled in these configurations:
◆

EMC Celerra® to EMC Celerra

◆

EMC IP4700 to EMC IP4700

◆

NetApp to NetApp (any NetApp nodes that Network Appliance supports within
a zone)

The current NDMP implementation does not allow the sharing of drives between
non-homogeneous NDMP nodes. There is, however, no inherent limitation within
DDS that would prevent this.
Figure 10 on page 108 illustrates a basic DDS configuration with NDMP.

NetWorker Server
SAN
NDMP Filer (sn_1)
Both nodes must be the same
kind for DDS to be enabled

NDMP Filer (sn_2)

Drive 1 (hardware id: drive_1)
Drive 2 (hardware id: drive_2)
Shared Autochanger

Figure 10

DDS with NDMP

DDS attributes in the device properties
Attributes used in DDS are found in the Properties window for a device:
◆

Hardware ID

◆

Shared Devices

Hardware ID attribute
The Hardware ID attribute tracks the drives that are being shared by multiple hosts.
Device instances sharing the same physical drive across multiple hosts have the same
hardware ID. The hardware ID is automatically assigned during the device
autoconfiguration process, or it can be added when manually configuring a device. It
is not editable by users.
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The hardware ID can be viewed in the Properties window for a device, on the
General tab, in the Device Sharing area.
The hardware ID is generated when a device is scanned or configured. The hardware
ID consists of the following:
◆

The hardware serial number

◆

The device type

◆

The worldwide part number (WWPN)

◆

The worldwide name (WWN)

Do not try to change a hardware ID once it has been generated. It is read-only.
Shared Devices attribute
The Shared Devices attribute appears on the Operations tab of a device’s Properties
when in diagnostic mode. It features values that can be used to manipulate all shared
instances of a drive at the same time. This attribute enables or disables all devices that
share the same hardware ID with a single action. Table 12 on page 109 lists this
attribute’s allowed values and their descriptions.
Table 12

Shared Devices attributes

Value

Description

Enable All

When selected, enables all devices by using the same hardware ID.

Disable All

When selected, disables all the devices by using the same hardware ID.

Done

This is the default setting. After the server has enabled or disabled all devices with the same
hardware ID, the attribute is reset to Done.

The Shared Devices attribute is not reflected in the jbconfig program.
Idle Device Timeout attribute and DDS
A tape might remain mounted in its drive after a backup has completed. Other
requests for the drive from another device path must wait during this timeout period.
The timeout value can be adjusted by changing the Idle Device Timeout attribute.
The Idle Device Timeout is not specifically a DDS attribute, but it can be useful in
configuring shared drives. This attribute appears on the Advanced tab of a device’s
Properties when in diagnostic mode. The default value is 0 (zero) minutes. Select a
time that is appropriate for the system configuration.
Note: Selection of zero means that the device never times out and the tape must be ejected
manually.

High availability and DDS
The NetWorker software relocates and restarts operations that were in progress
when a failure occurs on a cluster node. Currently, savegroups are the only highly
available operations.
The nsrjb program high availability limitations
If the NetWorker server fails over from one node to a new target node, standard
library operations (such as performing an inventory, labeling, mounting, or
unmounting a volume) do not automatically restart on the new target node.
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Example 5

Host crash requires user intervention

This example scenario includes: two physical hosts, A and B, with DDS enabled,
sharing the drives on a library.
Physical host A mounts a tape in a shared drive on the library. If physical host A
subsequently crashes, the volume is held in that shared drive until the reset
command nsrjb -H is issued (from host B, in this example) along with a reset from the
Library Operations Windows in the NetWorker Console.
This command unloads the drive and makes it available for future backups. The reset
command clears the drive by accessing the device through another shared path. In
this example, the other shared path would be on host B.
Successfully unloading a volume requires that the NetWorker software be able to
access the same path through which the volume was initially loaded.

Licensing
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information
about NetWorker licensing support for DDTS.

Autodetection of libraries and devices
This section provides information on scanning for libraries and devices.

Scanning for libraries and devices
Devices already known to the NetWorker server can be seen in the enterprise
hierarchy in the navigation tree. Use the Scan for Devices option described here to
find devices that are not yet known to the NetWorker server. Be aware that:
◆

A storage node must be added to the hierarchy before its devices can be scanned.

◆

The Scan for Devices option does not detect file type or advanced file type
devices.

◆

A specific network interface can be used between the NetWorker server and the
storage node when scanning for devices. “Identifying a specific network interface
for device scan operations” on page 111 provides more information.

To scan for available devices:
1. In the Console window, click Enterprise.
2. In the navigation tree, select a NetWorker server.
3. In the Name column of the Host detail table, double-click NetWorker. The
NetWorker Administration window for the selected server opens. Note that
while multiple NetWorker Administration windows can be open
simultaneously, each one displays information about only one host or server.
4. In the Administration window, click Devices.
5. In the navigation tree:
a. Right-click the server name, and select Scan for Devices.
b. Click the storage node to be scanned.
c. If the appropriate storage node is not listed, click Create a New Storage Node.
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d. When creating a new storage node, replace the default value in the Name field
with the fully-qualified domain name or short name of the new storage node.
e. Fill in any required information, such as whether to scan for SCSI or NDMP
devices and whether to search all LUNs.
f. Click Start Scan. To monitor the scan activity, click Monitoring, then select
the Log tab. Any relevant status information is displayed there.
6. Return to the Devices navigation tree to view the refreshed device information
(configured and unconfigured):
• To display SCSI and NDMP libraries available to the NetWorker server, select
Libraries in the navigation tree. Any available library or silo appears in the
Libraries detail table.
• To display stand-alone devices available to the NetWorker server, select
Devices in the navigation tree. Any available stand-alone device appears in
the Devices detail table, along with devices available in libraries.
• To display the libraries and devices that are available to a storage node, select
the storage node in the navigation tree. Available storage nodes appear in the
table. Double-click a storage node to see its details, along with the devices that
are available in the storage node.
Note: Autodetection should not be used for devices on a Storage Area Network (SAN) while
any of the devices are in use, because this may cause the device in use to become unresponsive.
To avoid this situation, do not configure a device in multiple NetWorker datazones.

Identifying a specific network interface for device scan operations
If the NetWorker server has multiple network interfaces, you can specify that a
specific network interface be used for scan operations. In this case, the dvdetect
(device scan) program will use the specified network address or hostname to
communicate with the NetWorker server.
To specify a specific network interface for device scan operations:
1. In the server’s Administration interface, click the Devices button.
2. Select View > Diagnostic Mode.
3. In the left pane, click on the Storage Nodes folder.
4. In the right pane, select a storage node.
5. Right-click the storage node and select Properties.
6. Select the Configuration tab.
7. In the Server network interface field, type the network address or the unique
hostname of the network interface on the NetWorker server that is to be used.
8. Click OK.
“Server Network Interface attribute” on page 279 provides information on similar
attributes that are available for other library and device operations.

Configuring the Sun StorEdge Network Foundation HBA/Driver
This section applies only to storage nodes that run Solaris 9 or earlier. The StorEdge
Network Foundation host bus adapter (HBA) requires a special configuration to bind
the device World Wide Port Names that are used by the EMC logical unit
specification (lus) driver.
Autodetection of libraries and devices
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The /usr/sbin/lus_add_fp_devs script adds the proper entries to the lus.conf files.
Before the script is run, however, ensure that all devices are powered on and
connected to the HBAs.
Note: The /usr/sbin/lus_add_fp_devs script should be used only to configure libraries over
Fibre Channel.

These are examples of additional entries for the /usr/kernel/drv/lus.conf script:
name="lus" parent="fp" target=0 lun=0 fc-port-wwn="22000090a50001c8";
name="lus" parent="fp" target=2 lun=0 fc-port-wwn="22000090a50001c8";
Note: Each time a new device is added, or an old device is removed, the new lus configuration
must be re-created and reinstalled. “How to add a library device” on page 114 provides
information about how to add or delete a device. When the /usr/sbin/lus_add_fp_devs script
runs, check whether the World Wide Port Names appear in the script output. If none appears,
the Fibre Channel might be configured incorrectly. Check the configuration by using the Sun
luxadm program.

Sample /usr/sbin/lus_add_fp_devs script output
This is an example of /usr/sbin/lus_add_fp_devs script output:
# /usr/sbin/lus_add_fp_devs
Updating /usr/kernel/drv/lus.conf
Found StorEdge HBA device:
/devices/pci@1f,0/pci@1/pci@1/pci@f/SUNW,qlc@4/fp@0,0:devctl
Found StorEdge HBA device:
/devices/pci@1f,0/pci@1/pci@1/pci@f/SUNW,qlc@5/fp@0,0:devctl
Mapping tape devices starting at target 0
Adding:
port WWN: 500104f000428e48 as SCSI target 0
port WWN: 500104f000428e49 as SCSI target 1
port WWN: 500104f000428f44 as SCSI target 2
port WWN: 500104f000428f45 as SCSI target 3
Mapping tape devices starting at target 4
Adding:
port WWN: 500104f000428e48 as SCSI target 4
port WWN: 500104f000428e49 as SCSI target 5
port WWN: 500104f000428f44 as SCSI target 6
port WWN: 500104f000428f45 as SCSI target 7
Adding medium changer devices starting at target 100
Adding:
port WWN: 100000e002000000 as SCSI target 100
port WWN: 100000e00201105a as SCSI target 101
Adding medium changer devices starting at target 102
Adding:
port WWN: 100000e002000000 as SCSI target 102
port WWN: 100000e00201105a as SCSI target 103
The changes made to lus.conf will not take effect until lus is
reloaded.
If you are sure that no process is currently using lus to control a
tape
library, then it may be safely unloaded.
Note: If lus is not currently loaded, proceed to the section in the script stating that lus is not
currently loaded.
Would you like to unload lus? (y/n)

y

Note: If no is selected, this output appears and the program exits:
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lus is currently loaded! It must be unloaded and reloaded for any
changes to lus.conf to take effect
Note: If lus is not currently loaded, respond to this prompt:
lus is not currently loaded
Would you like to run inquire? (this will cause lus to be loaded using
the newly modified lus.conf) (y/n) y
Note: If no is selected at the previous prompt, the program exits.
scsidev@0.0.0:FUJITSU MAJ3182M SUN18G 0804|Disk, /dev/rdsk/c0t0d0s2
scsidev@2.0.0:STK 9840 1.28|Tape, /dev/rmt/0cbn
scsidev@2.1.0:STK 9840 1.28|Tape, /dev/rmt/2cbn
scsidev@2.100.0:ADIC Scalar DLT 448 0114|Autochanger (Jukebox)
scsidev@2.101.0:ADIC Scalar DLT 448 0114|Autochanger (Jukebox)
scsidev@3.0.0:STK 9840 1.28|Tape/dev/rmt/6cbn
scsidev@3.1.0:STK 9840 1.28|Tape, /dev/rmt/8cbn

Add (configure) libraries
A device resource must be created for each library device, including silos, on a
storage node. Because a NetWorker server is also a storage node, this procedure
applies to a server and all its storage nodes. Users can choose between configuring
libraries automatically through use of a configuration wizard, or configuring them
manually and individually in the user interface.
Storage nodes must be created before devices can be configured to be used by them.
“Storage nodes” on page 99 provides information about storage nodes and how to
create them. Note that all scanning for devices is done at the storage node level, and
can be done across multiple storage nodes.
Only devices that have serial numbers can be autoconfigured. Use the jbconfig
command to configure devices that do not have serial numbers (the inquire or sn
commands can be used to determine if a device returns a serial number).
Devices must be updated to the most recent firmware and drivers.
These device types can be configured automatically:
◆

NDMP

◆

SCSI

◆

Silo (except DAS silo)

Note: On Microsoft Windows systems, Removable Storage Manager (RSM) should be disabled
prior to configuring a SCSI-attached library.

These device types must be configured by using the jbconfig command:
◆

AlphaStor devices.

◆

DAS silo

◆

Devices managed by Microsoft Removable Storage.

◆

IBM tape libraries controlled through the use of IBM’s tape driver. (This is
because the device autodetection code uses the internal lus driver to control
libraries.)
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◆

Any library that does not return a serial number for the robotic arm or any of its
tape devices.

How to add a library device
To configure a new library resource to a storage node automatically:
1. In the server’s Administration interface, click Devices.
2. Open the Storage Nodes folder in the navigation tree.
3. Right-click the storage node to which the device is to be configured, and select
Configure All Libraries (which is available from many of the menus throughout
the Devices task). This opens a wizard that can configure all detected libraries,
except those explicitly excluded in the library exclusion list during configuration.
Note: If Configure All Libraries is started from the server folder instead of from the
Storage Node folder, then all storage nodes on the NetWorker server are automatically
selected for configuration in the wizard.

The Configure All Libraries wizard appears. This lets you step through library
configuration, including this input (some of which is filled in by default):
• Library type (select SCSI/NDMP).
• An NDMP remote username and a password are required for an NDMP
device that acts as a storage node.
• Adjust the Enable New Device option, if necessary.
• Current server sharing policy. Use maximal sharing with Dynamic Drive
Sharing (DDS). By default, the sharing policy is displayed as "server default,"
which is maximal sharing.
• Storage nodes to which libraries can be configured (select a storage node to see
its details). If the appropriate storage node is not listed, click Create a New
Storage Node.
• When creating a new storage node, replace the default value in the Name field
with the fully-qualified domain name or short name of the new storage node.
• Update storage node properties, if required.
4. Click Start Configuration after filling in the requested information. The
configuration window displays a message that the Configure All Libraries
process has started, and that the configuration activity can be viewed by checking
the Monitoring > Log screen for status.
5. Click Finish on the configuration window to close the configuration wizard. If
problems occur during configuration, then the Back button on the configuration
window becomes active, which allows the user to return to the input screen to
adjust input.
How to add a silo device
To configure a new silo resource to a storage node automatically:
1. In the server’s Administration interface, click Devices.
2. Open the Storage Nodes folder in the navigation tree.
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3. Right-click the storage node to which the device is to be configured, and select
Configure All Libraries (which is available from many of the menus throughout
the Devices task). This opens a wizard that can configure all detected libraries,
except those explicitly excluded in the library exclusion list during configuration.
Note: If Configure All Libraries is started from the server folder instead of from the
Storage Node folder, then all storage nodes on the NetWorker server are automatically
selected for configuration in the wizard.

The Configure All Libraries wizard appears, and allows the user to step through
library configuration, including this input (some of which is filled in by default):
• Library type (select STL Silo).
• Adjust the Enable New Device option, if necessary.
• Current server sharing policy. (Use maximal sharing with Dynamic Drive
Sharing (DDS).)
• Storage nodes on which the libraries should configured. You can select a
storage node to see its details displayed; if the appropriate storage node is not
listed, click Create a New Storage Node.
When creating a new storage node, replace the default value in the Name field
with the name of the new storage node:
a. Update storage node properties if required.
b. Enter the Silo Controller count, which sets the number of silos to be
configured for the selected storage node. The default is 1. If a silo count of
greater than one is selected, then a library name and hostname must be
entered for each one.
c. Enter the Hostname of the silo controller.
d. Enter the Type of silo controller. The default is ACSLS Silo (StorageTek).
e. If a DAS silo controller was chosen, enter the DAS client name (which should
match the storage node name).
f. (Optional) Use the Test Silo Controller Connectivity button to see whether
the connection to a silo controller works. Use it once for each silo. An error
message appears if the connection to a given silo fails.
4. Click Start Configuration after filling in the requested information. The
configuration window displays a message that the Configure All Libraries
process has started, and that the configuration activity can be viewed by checking
the Monitoring > Log screen for status.
5. Click Finish on the Configuration window to close the configuration wizard. If
problems occur during configuration, then the Back button on the Configuration
window becomes active, which allows the user to return to the input screen to
adjust input.
Using NetWorker software with ACSLS silos
Note: In this section, the term "ACSLS server" refers to the name of the system that is running
any one of StorageTek's library manager programs.
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The ssi program is used indirectly by the nsrjb program to communicate with an
ACSLS server. The nsrjb program loads libstlstk, which handles the TCP calls to and
from the ssi program. The ssi program then handles all of communication to and
from the ACSLS server. Starting with ACSLS version 5.3, it is possible to run either a
NetWorker server or storage node on the same host that is running ACSLS.
To configure a library, the ssi and mini_el programs must be running on the system
on which library configuration is performed. The ssi and mini_el programs are
generally run as background processes, and are usually started automatically by the
system.
In addition to the ssi and mini_el programs, a shared library file (usually called
libstlstk.xxx where xxx is an operating system-dependent extension) is also required.
An appropriate version of this library is installed as part of NetWorker installation.
ACSLS silos and firewalls
With ssi version 2.0, communication with the ACSLS server on a specified port
number is supported, using the -a command line option. This is part of the STK
firewall enhancement. The ACSLS version 7 must be running on the ACSLS server to
use this functionality.
The UNIX man pages for these commands, or see the NetWorker Command Reference
Guide provides information on the ssi and mini_el programs.

Queuing device resources for AlphaStor
Because the NetWorker software detects devices as virtual devices, users can request
more devices than actually exist. The AlphaStor software queues these requests, and
can prioritize them according to whether a tape is mounted for reading, or for
writing. This allows AlphaStor users to prioritize recovery operations above backups
or other operations that might compete for the same devices.
This feature requires AlphaStor release 3.1 or later.
Configure the AlphaStor library with the jbconfig command. For information about
configuring resource queuing, refer to the EMC AlphaStor Administration and
Operator's Guide. The nsr_mount_request man page describes the resource-queuing
feature. Related attributes are also in the nsr_pool and nsr_jbox UNIX man pages
and the NetWorker Command Reference Guide.

Virtual Tape Library (VTL) configuration
During library configuration, the NetWorker software automatically detects that a
library is a VTL, and updates the read-only Virtual Jukebox attribute to Yes. If the
NetWorker software determines that the library being configured is not a VTL, it sets
the Virtual Jukebox attribute to No.
Licensing
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information
about NetWorker licensing support for a Virtual Tape Library.
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Library reconfiguration
Users with Configure NetWorker privileges can reconfigure a library in order to add or
remove access paths to the drives in a library. This includes access paths that allow libraries to
be shared.
Be aware of the following considerations when reconfiguring a library:
◆

The reconfiguring of stand-alone or file type devices is not supported. Instead, delete the
stand-alone or file type device, and then create a new one.

◆

The reconfigure library feature described in “Reconfiguring a library” does not support
adding NDMP drives to a non-NDMP library if both the NDMP server and the
NetWorker storage node are on the same host. Instead, use the jbedit command, which is
described in “Using the jbedit command” on page 117.

Reconfiguring a library
To reconfigure a library:
1. Run Scan for Devices, in case a device path has been added to, or removed from, the
library since the latest scan.
2. In the server’s Administration window, click Devices.
3. Select Libraries in the navigation tree. The Libraries detail table appears.
4. In the navigation tree, right-click the entry for the library to be reconfigured, or open the
Storage Nodes folder, open the library folder, and then right-click the library entry there.
5. Select Reconfigure Library. The Reconfigure Library window appears. Note that the
storage node name and library name cannot be changed in this window.
6. Make appropriate changes in the Configure devices on various storage nodes using
existing drive connectivity area, selecting or clearing checkboxes as necessary, or using
the buttons at the right side of the area (Check All, Clear All, Reset).
Drives that are already configured to be used by the library display check marks in the
boxes adjacent to their names:
• Selecting a box adds the drive to the library.
• Clearing a box removes the drive from the library.
• The Reset button returns the checkboxes to the condition they had when the
Reconfigure Library window was opened.
7. Click Start Configuration to reconfigure, or Cancel to leave the window.
8. Run Scan for Devices to refresh the navigation tree and show the reconfiguration results.

Using the jbedit command
The jbedit program can be used as a fallback means of editing library configurations if, for
some reason, the autoconfiguration program is not working. The command can be run on a
NetWorker server, storage node, or client (if the client is a storage node). It works without
disrupting any backup or recovery operations on the library.
The jbedit program supports all direct-attached SCSI/SJI, SAN, and NDMP libraries. It does
not currently support AlphaStor libraries.

Library reconfiguration
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The jbedit program is not intended to be a full-fledged editor of the Library resource.
The editing of Library resource attributes should be done as described in “Library
reconfiguration” on page 117. The jbedit options provide selection lists that make it
easy to find drives or devices to be added or deleted.
Note: Running the jbedit program requires Configure NetWorker privileges.

Table 13 on page 118 lists the most commonly used jbedit program options.
Table 13

Common jbedit options

Option

Description

-a

Add a drive or device.

-d

Deletes a drive or device.

-j

Name of the autochanger to be edited.

-f

Name of the device to be added or deleted.

-E

Element address of the device to be added or deleted.

The EMC NetWorker Command Reference Guide or the UNIX man page provides a
detailed description of the jbedit command, its options, and associated diagnostic
messages.

Add (configure) stand-alone devices
A Device resource must be created for each stand-alone device on a storage node.
Stand-alone drives must be configured individually.
Storage nodes must have been created before devices can be configured to be used by
them. “Storage nodes” on page 99 provides information about storage nodes and
how to create them. Note that all scanning for devices is done at the storage node
level, and can be done across multiple storage nodes. Only devices that have serial
numbers can be autoconfigured. Use the jbconfig command to configure devices that
do not have serial numbers.
Note: Devices must be updated to the most recent firmware and drivers.

Autodetecting and configuring a stand-alone tape drive
To configure a new stand-alone tape drive, automatically, by using Scan for Devices:
1. In the server’s NetWorker Administration interface, click Devices.
2. Right-click Devices in the navigation tree, and select Scan for Devices to detect
available devices. The Scan for Devices window appears.
3. Click Start Scan.
4. Check the scan status by clicking the Monitoring button and selecting the Log
tab. Then return to the Devices navigation tree.
5. Select either the Devices folder or the Storage Nodes folder in the navigation
tree. All detected drives are listed. Any still-unconfigured drives are preceded by
a circular icon that displays a wrench.
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6. Right-click the stand-alone drive to be configured, and select Configure Drive. A
Configuration dialog box appears.
7. Click Yes to confirm that the drive should be configured. The new drive is
automatically configured.

Adding a stand-alone device manually
To configure (add) a new stand-alone device on a storage node:
1. In the server’s NetWorker Administration interface, click Devices.
2. Right-click Devices in the navigation tree, and select New. The Create Device
window appears, with the General tab selected, and a default device path in the
Name field of the Identity area of the window.
3. Replace the default name with the path and name of the device:
a. If the device is configured on the server’s storage node, the name is the simple
device path, such as /tmp/d0 for a file type device. A tape device on
Microsoft Windows would have a format similar to \\.\Tape0.
b. If the device is configured on a remote storage node, however, then the name
must indicate that the storage node is remote, by including rd= and the name
of the remote storage node in the device path. For example, if the remote
storage node is neptune, then the device path might be rd=neptune:/tmp/d0
or .rd=neptune:\\.\Tape0.
4. In the Identity area, configure:
a. In the Comment field add an optional, descriptive comment.
b. In the Media Type field, select a media type.
5. In the Status area, configure the applicable checkboxes:
• Read Only
• Auto Media Management
6. In the Cleaning area, configure the applicable fields:
• Cleaning Required
• Cleaning Interval
The Date Last Cleaned is filled in automatically once a drive has been cleaned.
7. Select the Configuration tab to set attributes, such as:
• Target Sessions
• Max Sessions
• Local Backup to a dedicated storage node
NDMP settings (NDMP remote username and password are required for an
NDMP device that acts as a storage node.)
8. Click OK when the configuration is complete.
“File type (FTD) and advanced file type (AFTD) devices” on page 242 provides
instructions and restrictions on backing up to a file type device.

Add (configure) stand-alone devices
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Configuring NetWorker DiskBackup
The NetWorker DiskBackup solution greatly reduces the time to save and recover
data when compared to the use of tape. NetWorker DiskBackup enables data to be
saved to a computer’s local or network-attached disk, rather than by using a tape
device to write the data to storage media.
NetWorker software offers two variations of this method:
◆

File Type Device (local only)

◆

Advanced File Type Device (can be a networked drive)

“File type (FTD) and advanced file type (AFTD) devices” on page 242 provides
information about the NetWorker DiskBackup solution.

Support for cloud backup devices
This section describes how to configure the NetWorker Cloud Backup Option
(NCBO) to perform backup, staging, cloning, and recovery operations to cloud
configurations. Backups to cloud occur over a TCP/IP network and can be
compressed and encrypted. NetWorker supports EMC Atmos-based cloud storage.
More information on Atmos is available at www.EMC.com.

Cloud backup devices compared to other device types
NetWorker backup, staging, cloning, and recovery to cloud storage devices are
similar to those operations that are performed with conventional devices. However,
cloud devices also have unique features.
Table 14 on page 120 lists the major similarities with other backup device types as
well as the unique features of a cloud storage device.
A comparison of cloud devices to other device types

Table 14

Feature

Cloud backup device

AFTD device

Tape device

Same volume mounted
simultaneously on multiple
devices

Yes

No

No

Staging source

No

Yes

No

Staging destination

Yes

Yes

Yes

Cloning

Yes

Yes

Yes

Auto mount and unmount

Yes

No

Yes *

No **

No **

Data transformation engine
Yes
(enables encryption and
compression on storage node)

* When the tape is controlled by a tape library.
** Encryption and compression can still be enabled through NetWorker client side directives.

Cloud backup prerequisites and considerations
The following conditions must be met before you can backup to the cloud:
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◆

The NetWorker Cloud Backup Option must be licensed and enabled. The new for
7.6 Service Pack 1, NetWorker Licensing Guide provides information about
entering licence enablers.

◆

The NetWorker Cloud Backup Option is supported on Windows and Linux
storage nodes only.

◆

An Atmos cloud account is set up and you have a username and password to
access the cloud account. The EMC Atmos Installation Guide and the EMC Atmos
System Management GUI Guide provides information about setting up and
managing an Atmos account.

◆

If the Atmos server and the NetWorker server are separated by a firewall, TCP
ports 80 and 443 must be open to allow outgoing communication from the
NetWorker server to the Atmos server. If a proxy server is configured in the
environment, a firewall exception may also need to be created to ensure
unrestricted access. If these ports are not open, device operations will fail with
the following error:
Atmos label operation failed: Failed to write cloud label: Couldn't
connect to server.

Be aware of the following considerations with respect to cloud support:
◆

NetWorker Avamar deduplication storage nodes do not support cloud backups.

◆

For NDMP, only a Data Server Agent (DSA) is supported for cloud backups.

◆

NetWorker versions prior to 7.6 do not support cloud backups.

Cloud best practices
Consider the topics and recommendations in this section before implementing cloud
backups. For additional best practices information, refer to the Best Practices for Cloud
Backup with NetWorker Fast Start document, which is available in the NetWorker
Whitepapers and Technical Notes section on EMC Powerlink.
Directing NetWorker client backups to a cloud storage device
You direct client backups to a cloud storage device using media pools, in the same
way you would direct any other client backup to a device or set of devices. However,
be aware of the following recommendations:
◆

Set up a media pool for cloud storage devices and give the pool a unique label
template.

◆

Do not mix cloud backup devices with other types of backup devices in a media
pool. “Sorting Backup Data” on page 183 provides information about setting up
media pools.

Support for cloud backup devices

121

Configuring Libraries and Devices

Concurrent backup and recovery operations
A single cloud volume can be mounted on multiple cloud storage devices to support
concurrent backup and recovery operations. For example, to optimize performance
you could mount cloud volume A on three cloud storage devices: one for backup
(device CL1), one for recovery (device CL2), and one for clone operations (device
CL3). There is no limit to the number of cloud storage devices that can be mounted on
a single cloud volume. Consider such an approach to optimize backup and recovery
performance.
Network dependencies
Cloud backups are highly dependent on the network connection that is used to access
the cloud service. Any disruption in connectivity or a slowdown in network access
speed may adversely affect cloud backups or recoveries.

Creating and labeling a cloud storage device
This section contains the following topics:
◆

“Create the cloud storage device” on page 122

◆

“Label and mount the cloud storage device” on page 124

Create the cloud storage device
To create a cloud storage device:
1. In the server’s NetWorker Administration interface, click Devices.
2. Right-click Devices in the navigation tree, and select New. The Create Device
window appears, with the General tab selected, and a default device path in the
Name field of the Identity area of the window.
3. In the Name field, replace the default name with a name that uniquely identifies
the cloud storage device. If the device is configured on a remote storage node,
indicate that the storage node is remote, by including rd=hostname: in the name.
For example, if the remote storage node is neptune, then the device path might be
rd=neptune:cloud1.
Note: Unlike other devices, a cloud storage device name does not specify a path to the
device. You can use any combination of alphanumeric characters for the device name.

4. In the Comment field and the Description field, add an optional comment and
description, respectively.
5. In the Media Type field, select Atmos COS as the device type if you are using
Atmos as the cloud server.
6. In the Remote User field, type the username that is used to access the cloud
server. For an Atmos COS device, this is the token-id.
7. In the Password field, type the password that is used to access the cloud server.
For an Atmos device, this is the shared secret.
8. Select the Cloud tab to specify additional information specific to the cloud
backup device.
9. In the Server field, type the IP address or fully qualified domain name of the
cloud server.
10. Use the Parameter options to adjust network communication attributes:
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a. In the Network Write Size field, specify the amount of backup data, in
kilobytes, to cache in memory before sending to the cloud. Larger write sizes
typically result in better performance but results vary depending on the
underlying network characteristics. Also be aware that larger sizes consume
more memory on the storage node for the duration of the backup or recover
operation.
b. In the Number of Retries field, specify the number of times that NetWorker
will attempt to send backup or receive recover data in the event of a network
failure.
c. In the Send/Receive Timeout field, specify the number of seconds that
NetWorker will wait for confirmation that network send and receive
transmissions to the cloud server have occurred successfully. If the timeout
period expires, the data transmission is considered to have failed.
– Set the value of this field in conjunction with the Network Write Size field.
Larger Network Write Size values require larger Send/Receive Timeout
values to avoid failures. Optimal values for the Send/Receive Timeout
field vary depending on the network speed and bandwidth.
– The save group’s Inactivity Timeout value can potentially interact with the
Send/Receive Timeout value in unintended ways. To avoid this
possibility, ensure that the save group’s Inactivity Timeout value (default
is 30 minutes) is greater than the Send/Receive Timeout value (default is
30 seconds).
d. In the Network Failure Retry Interval field, specify the number of minutes
that a backup or recover session must wait before a failed network connection
results in an aborted backup or recover session.
11. In the Compression field, select a compression level for data that is sent to the
cloud. Faster compression speeds result in less data compression but also require
less CPU resources. The fastest compression speed, Compression Speed Fast,
performs the least amount of data compression and is selected by default.
To choose an optimal compression value, balance the potentially longer backup
window of using a slower compression speed against the potential efficiency and
cost savings of sending less backup data to the cloud.
Note: If the NetWorker Cloud Back Option determines that backup data cannot be
compressed effectively, compression may not occur regardless of the setting in this field.

12. In the Encryption field, specify whether to enable or disable encryption of data
sent to the cloud. Encryption is standard NetWorker AES 256 bit encryption and
is selected by default. If desired a NetWorker datazone passphrase can be defined
that would be used to recover encrypted data.
If this option is selected, encryption will occur regardless of any client-side
encryption directives. For more information about encryption including how to
specify a new datazone passphrase, refer to “Encrypting backup data” on
page 77.
Note: If encryption is already enabled for the NetWorker client and encryption is enabled
in this field, backups will be slower because encryption functions will occur twice.

13. Use the Cloud network interface field if the Storage node has multiple network
interfaces. If it does, specify the IP address of the network interface that will send
backup data to the cloud.

Support for cloud backup devices
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To display the Cloud network interface field, select View>Diagnostic Mode
from the menu bar.
14. Select Throttling and then click the Bandwidth icon
to display a dialog box
where you can adjust the maximum internet bandwidth that a cloud backup or
recovery operation can consume at any given time of the day or week. This option
enables you to prevent network congestion by limiting cloud backup and
recovery activity during peak internet usage.
a. Select New to add a bandwidth throttling policy.
b. From the Day field, select the day of week to which the policy applies.
c. Click the up and down arrows to select a time of the day to which the policy
starts and ends. Alternatively, type the times directly into the Start time and
End time fields.
d. Click the up and down arrows to select the maximum possible network
bandwith. in megabits per second, that a backup or recovery operation can
consume when the policy is in effect. Alternatively, type the values directly in
the fields.
You can create as many policies per day as required. You can also modify or
delete existing throttling policies as necessary.
15. Click OK when the configuration is complete.
Label and mount the cloud storage device
To label and mount a cloud storage device:
1. Select the cloud storage device, right-click and select Label. The Create new
cloud volume dialog box appears.
2. In the Pools field, select the media pool to be used for cloud storage devices.
Note: It is recommended that the media pool you select be used for cloud backup devices
only.

A label for the cloud storage device is generated and displayed in the Volume
Label field. The label name is based on the label template that was specified for
the cloud media pool.
3. Select Mount after labeling and click OK.
Note: If there are multiple cloud volumes, you will be able to select the volume to associate
with the cloud storage device.

Gathering report information on cloud backup
Use cloud backup information to monitor backup costs and help optimize your cloud
backups. Cloud backup information can be obtained from the following sources:
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◆

“Cloud backup and recover reports” on page 379

◆

mminfo command
Use the mminfo -avot command to get information on how much data is
consumed in a cloud backup.
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Staging with a cloud storage device
Staging with a cloud storage device works the same way as staging to a tape device.
You cannot however, use a cloud storage device as the source for a staging operation.
Chapter 10, “Staging Backups” provides more information.

Cloning to a cloud storage device
Cloning with a cloud storage device works the same way as cloning with any other
advanced file type device. Chapter 9, “Cloning”provides more information.

Deleting libraries and devices
There are slight differences between how to delete a library and how to delete a
device of any type.

How to delete a library
To delete a library from a storage node:
1. In the server’s Administration interface, click Devices.
2. Select Libraries in the navigation tree. The Libraries detail table appears.
3. In either the navigation tree or in the Libraries detail table, right-click the entry
for the library to be deleted, and select Delete.
4. When prompted, click Yes.
This message appears:
"Are you sure you want to delete this jukebox? If so, please
re-attempt
deletion within a minute."

5. Click OK to confirm the deletion.
The library's devices remain, and can still respond to NetWorker operations (such as
monitoring, labeling, deletion, and so on) after the library definition is deleted. A
deletion of a library deletes the library, not its devices.

How to delete a device
To delete a stand-alone device, file type device, advanced file type device, or a device
in a library (after the library’s definition has been deleted) from a storage node:
1. In the server’s Administration interface, click Devices.
2. Select Devices in the navigation tree. The Devices detail table appears.
3. Right-click the device entry in the detail table, and select Delete.
4. Click Yes to confirm the deletion.

Deleting libraries and devices
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Notes:
Any attempt to remove a device from a library before the library itself (the library’s definition)
has been removed will result in an error message.
An AFTD read-write device and volume as well as its corresponding read-only device and
volume must be unmounted before it can be deleted. If the read-write or read-only device or
volume is mounted, an error message will explain how to display and select the mounted
device or volume so that it can be unmounted.

Library slots
The available slots feature controls which volumes the NetWorker server uses for
backup. The server uses all of the volumes in a library to perform recoveries, but the
volumes that are automatically selected for backups can be controlled by designating
a range of available slots in the library.
Note: Ensure that volumes have been placed in all the available slots of the library so that the
NetWorker server can proceed uninterrupted with an automatic backup. With two-sided
media, the number of available slots is effectively doubled. For example, with 32 optical disks
labeled “jupiter.001.a” to “jupiter.032.b,” there is a total of 64 sides and, therefore, 64 slots from
which to choose.

How to configure library slots
To configure which slots are available in a library:
1. In the server’s NetWorker Administration interface, select View>Diagnostic
Mode from the menu bar.
2. Click Devices.
3. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
4. In either the navigation tree or in the Libraries detail table, right-click the library
on which the slots are to be designated, and select Properties. The Properties
window appears.
5. Select the Advanced tab of the Properties window.
6. In the Media Management Area, in the Available slots field, type a range of
contiguous slots, then click + to add the range of slots.
For example (assuming that no slots have already been configured), to designate
slots 1 through 3 as available, then skip a defective slot 4, and designate slots 5
through 7 as available, type this information in the Available Slots field:
a. Type 1-3, then click + to add these slots.
b. Type 5-7, then click + to add these slots.
c. Click OK. Slot 4 will be skipped when tapes are loaded.

Troubleshooting autoconfiguration failure
Common symptoms of library autoconfiguration failure include the following:
◆
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◆

The library is listed, but is listed as being unconfigured.

Common causes include:
◆

Device drivers are not properly installed.

◆

Autodetection fails to match a detected library with its devices due to:
• Out-of-date device firmware.
• Failure of the library to return its devices’ serial numbers.

◆

Autodetection failed to start on the storage nodes.

To troubleshoot this problem:
1. Check Monitoring > Log for relevant messages.
2. From the command prompt, type the following command to verify that the
library returns the serial numbers of its devices:
sn -a b.t.l.

where b.t.l. refers to the bus target LUN of the library. If the bus target LUN is
not known, run the inquire command first, to obtain this information.

Troubleshooting autoconfiguration failure
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Overview of NetWorker scheduling
Together, the following two items enable the scheduled backup of client data:
◆

Group

◆

Schedule

Time-based groups (backup groups) specify either the time of day when a backup
occurs, or a probe-based backup that is user defined.
For time scheduled backups, times typically occur after regular work hours. All
clients assigned to a group will be backed up at the time specified by the backup
group. Schedules enable you to specify the day of the week or month that the backup
occurs, as well as the level of backup (full, incremental, or level 1-9).
For probe-based backups the probe interval and backup window are used to schedule
group probes with clients, and clients with groups. The execution of the probes
determines if the backup of the group will proceed.
Note: Each client in a group can have a probe associated with it, but a probe is not required.
However, a probe-based backup group must have at least one probe-enabled client associated
with it.

Backup groups
Time-based backup groups specify the starting time for a client’s scheduled backup.
These backup groups enable you to:
◆

Schedule the backups to take place in the middle of the night, or some other time
when network traffic is low.

◆

Balance the backup loads by grouping clients in specific groups and staggering
their start times.
Note: Do not place both regular and deduplication clients in the same group.

◆

Sort data to specific backup volumes.
To sort data, groups are used in conjunction with backup pools. Chapter 7,
“Sorting Backup Data” provides more information.

The NetWorker server and time-based backup groups
When a Client resource is created, it is assigned to a backup group. The clients in each
time-based backup group begin their automatic scheduled backups according to the
start time of the group. Backup loads are balanced by taking the client’s backup
schedule into account when determining which clients to include in a specific group.
Example 6

Using groups to balance client backups

Figure 11 on page 131 illustrates how the NetWorker server uses two time-based
backup groups to back up multiple client save sets. In Figure 11, three client
computers (mars, jupiter, and saturn) are part of a group named Weekly Full. The
Weekly Full group starts its automatic scheduled backup at midnight.
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◆

Client mars runs a full backup of all its save sets every Monday and incremental
backups of its save sets on the other days.

◆

Client jupiter runs a full backup of all its save sets on Tuesday and incremental
backups on the other days.

◆

Client saturn runs a full backup of all its save sets on Wednesday and incremental
backups on the other days of the week.

Because each client runs its full backup on a different day of the week, the server is
not overloaded.
The second group, Accounting, illustrates how you can group clients by department.
The Accounting group contains client computers mercury and venus and starts its
backups at 7:00 P.M., when the computers in that department are available for
backup. Although the two client computers run full backups on the same day,
computer venus is scheduled to perform a full backup on only the /usr/home save
set, whereas all the save sets on computer mercury are backed up. By estimating how
long a backup takes, you can determine the start time to set for the next group.
The save sets from each group are written to appropriate volumes mounted on
storage devices. The NetWorker server uses pools to organize, track, and store save
sets. The server uses groups to determine the time clients start their scheduled
backups.
Group:

Weekly Full

Group:

Accounting

Daily Start Time: 24:00 (Midnight)

Daily Start Time: 19:00 (7:00 P.M.)

Client:

mars

Client:

mercury

Save Set:

All

Save Set:

All

Schedule:

Full on Monday

Schedule:

Full on 1st of month
Level 5 on 15th of month

Incremental, all other days

Incremental on all other days
Client:

jupiter

Save Set:

All

Schedule:

Full on Tuesday
Incremental on all other days

Client:

saturn

Save Set:

All

Schedule:

Full on Wednesday

Client:

venus

Save Set:

/usr/home

Schedule:

Full on 1st and 15th of month
Incremental on all other days

Incremental on all other days

The NetWorker server writes data to an
appropriate storage volume.

(NetWorker scheduled backup)

Labeled media volumes

Figure 11

How NetWorker groups are used to back up multiple clients

Backup groups

131

Backup Groups and Schedules

Creating and scheduling a probe group
Note: Each client in a group can have a probe associated with it, but a probe is not required.
However, a probe-based backup group must have at least one probe-enabled client associated
with it.

To configure the probe-enabled group:
1. In the server Administration interface, click Configuration.
2. Right-click Groups, and select New.
3. In the Advanced tab of the Create Groups window, complete the fields in the
Probe section as described in Table 15 on page 132.
Table 15

Probe group fields

Field

Description

Probe-based group:

Click the checkbox to enable probing.

Probe interval:

Determines the frequency of probing. Can be set from a minimum of 15 to a
maximum of 10,000 minutes.
Note: A successful backup does not disable probing. Be sure to set the
Probe interval to an appropriate value.

Probe start time:

The time at which probing will begin.

Probe end time

The time at which probing will end.

Probe success criteria

• Any: Any one of the probes associated with the group must succeed for
the backup to be performed.
• All: All of the probes associated with the group must succeed for the
backup to be performed.

Time since successful backup

The longest period of time tolerated without a backup.

Probe-based backup groups specify probe interval, and backup window to schedule
the group.
Probing occurs continuously throughout the probing window (the hours defined
Probe start time, and Probe end time), and only when the Autostart attribute of the
save group is enabled. If a save group is started manually, probes run immediately. If
autostart is used, then probes only run during the specified probe window.
Clients are associated with probe-based backup groups in the same manner as they
are with regular backup groups. However probe-based backup groups must include
at least one client which references a probe resource as described in “Creating a client
probe” on page 473.
Each client can reference only one probe but, since backup groups can contain many
clients, multiple probes can be run with the group.
Instead of a start time, the probe start and end times are used to schedule the group. It
is the outcome of the probing which determines if the backup will proceed.
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Preconfigured groups
The NetWorker product ships with a single preconfigured group named Default. To
ensure that all data is backed up, the NetWorker server automatically adds all clients
to the Default group. However, you must enable the Default group for the
NetWorker server to back it up. You can keep a client in the Default group, or you
can put the client in one or more customized groups.
You can also make changes to any Default group attribute, but you cannot delete the
group. You can, however, create or delete as many customized groups as required.

Key Group attributes
Table 16 displays some of the key attributes for the Group resource.
Table 16

Group attributes (1 of 2)

Attribute

Description

Start Time

The Default group is preconfigured to start its daily backup at 3:33 A.M. This time can be changed.

Autostart

Specifies whether the group is started automatically at a designated start time. You must enable the Autostart attribute for the
Default group, and any other group you create, before a scheduled backup can be run.

Schedule

This optional attribute can be used to select a Schedule resource for the group. If this attribute is set, it overrides the
schedules selected in the Client resource’s Schedule attribute for all clients in this group.

Interval

This attribute dictates how often a group starts a scheduled backup. The default value is 24:00 (once a day), but you can
change this value to start backups more often. “Setting the backup group time interval” on page 135 provides instructions on
modifying this attribute.

Autorestart

Specifies whether the group will be automatically restarted after an incomplete backup due to a power failure or administrator
intervention. If this attribute is enabled, the backup will restart when the NetWorker server is restarted provided that the
period of time specified in the Restart Window attribute has not elapsed.

Restart Window

For either auto or manual restarts, this attribute specifies the period of time in which an incomplete backup can be restarted.
If the period of time has elapsed, the restart will be treated as a regular backup start operation. The restart period is
calculated from the beginning of the start of the last incomplete backup. The default value is 12:00 hours. This value cannot
be greater than the Interval attribute.

Client Retries

When the NetWorker server fails to connect to a client, this attribute specifies the number of times that the server will
reattempt the connection before the backup is considered a failure. The first retry will not occur until after an attempt has been
made to at least contact each client in the group.

Inactivity Timeout

This attribute specifies the maximum time, in minutes, that a client is given to fail to communicate back to the server. If a client
fails to respond beyond the Inactivity Timeout value, the server will consider the client as having failed. If a client fails due to
any reason, a retry is initiated immediately. This ensures that no time is lost during the scheduled backup due to any failures.
Note: For large save sets, for save sets with large sparse files, and for incremental backups of a large number of small static
files, increase the timeout value if the backup consistently aborts due to an inactive job.

Soft runtime limit

This attribute indicates the time in minutes since the start time of a given group after which no new child process will be
launched. The Soft runtime limit is measured for each savegroup separately. Index and bootstrap saves are exempt and will
be started regardless of this setting. The default value is 0, which indicates that no Soft runtime limit is in effect.

Hard runtime limit

This attribute indicates the time in minutes that any save session still running will be terminated and the savegrp aborted. The
default value is 0, which indicates that no Hard runtime limit is in effect.
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Table 16

Group attributes (2 of 2)

Attribute

Description

Success Threshold

This attribute sets the criteria for reporting the success of all save sets within a group. The default value is Warning which
means if any save set completes with warnings it will be reported as successful. The client will also be reported as successful
with warnings in the completion report. If set to "Success", any save sets completed with warnings will be reported as failures.
The client will also be reported as failed in the savegroup completion report.
Note: Any failures will invoke a retry on the save set if retry count is not 0.

Probe based backup

If this attribute is set to ON, the probe attributes listed below become enabled.
Boolean ON/OFF. It is OFF by default.

Probe interval

This attribute indicates how often probes (in minutes) should be run. Default value is 60 minutes.

Probe start time/probe
end time

Probe start time and probe end time together define the backup window. Probe end time minus probe start time should be
greater than the probe interval. Start time default: 0:00; end time default: 23:59

Probe success criteria

This attribute determines if all probes or only one probe needs to succeed for a backup to proceed. Values are Any or All.

Time since successful
backup

If set to 0, time since the last successful backup will not matter: savegrp always runs probes. If interval is specified and
reached, savegrp will run the backup no matter what the result of the rest of the probes. The probes are run, so that the
probe state data can be updated. Default is 0 days.

Time of the Last
Successful Backup

Set to the time of the last successful backup by savegrp. Used to calculate interval since the last successful backup. GUI
read only.

savegrp Parallelism

Maximum number of save sets that can be backed up simultaneously by a NetWorker group. The default value is 0, which
means that parallelism is not restricted. “Parallelism” on page 437 provides information about savegrp parallelism.

Aborted backup groups
If the backup of a save set fails, then the NetWorker server marks the save set as
"aborted." In this situation, the automated report from the savegrp program does not
always show that the backup has completed. For example, if the client is being
backed up over a Network File System (NFS) connection and the NFS server crashes
and reboots, the NetWorker backup hangs until it times out. The NetWorker server
marks the save set "aborted."

How to create a group
“Task 2: Set up a group for backup clients” on page 57 provides information about
creating a group.

How to edit a group
Note: You cannot change the name of an existing backup group.

To edit a group:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Groups.
3. Select the group to be edited.
4. From the File menu, select Properties.
5. Edit the attributes of the group and click OK.
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How to delete a group
Note: You cannot delete the preconfigured Default group nor any group currently applied to a
Client resource.

To delete a group:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Groups.
3. Select the group to be deleted.
4. From the File menu, select Delete.

How to copy a group
To copy a group:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Groups.
3. In the right pane, right-click the group to be copied and select Copy. The Create
Group dialog box appears, containing the same information as the group that
was copied, except for the Name attribute.
4. In the Name attribute, type a name for the new group.
5. Edit the attributes and click OK.
Copying a group with clients
The Copy with Client feature allows you to copy an existing group resource
including the associated group and all client resources. The Copy with Clients
operation enables the following actions:
◆

Copy an existing NSR group.

◆

Ensure the original client list is preserved in the new group.

◆

All NSR client resources are automatically updated.

Note: The Copy with Clients operation is only available to a NSR group resource type.
Consequently, the new functionality is only available if a NetWorker group is selected in the
configuration window in the NetWorker console.

The Copy with Clients option is available in under the Edit menu. The option is also
available in a pop-up menu that appears when an individual group is selected in the
details pane or navigation tree.

Setting the backup group time interval
The NetWorker server allows you to run an individual scheduled backup group more
than once within a 24-hour period. The Interval attribute value of the Group resource
determines the frequency (in hours) that an individual group will start a backup.
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The default value is 24 hours (24:00), which results in one backup group run per day.
If you set the Interval attribute value at 12 hours, then the same group will back up
twice a day. For example, a group with the default start time of 3:33 A.M. and an
interval of 12:00 would back up twice a day, first at 3:33 A.M., and then again twelve
hours later at 3:33 P.M.
To set backup group time intervals:
1. Select the group to edit. For information about editing a group, see “How to edit a
group” on page 134.
2. Select the Advanced tab.
3. In the Interval attribute, type a value in the hh:mm format.
For best results, use time interval values that make it easy to determine the
backup group time, such as 24, 12, or 6 hours.
4. Click OK.
Note: An increase in the backup group time interval (for example, changing the interval from
once every 24 hours to once every 12 hours) can add strain on a network, the NetWorker server,
and associated devices.

Limiting full backups when the time interval is less than 24 hours
For groups that have more than one scheduled backup within a 24-hour period, use
the Force Incremental attribute to prevent more than one full or level backup per
24-hour period. By default, the Force Incremental attribute is set to Yes. If the Force
Incremental attribute is set to Yes, the first backup is performed at the configured
level. All subsequent scheduled backups during the next 24 hours after the start of
the first backup will be incremental. This means that only changed files will be
backed up regardless of the configured level. The Force Incremental attribute applies
only to scheduled backups that the NetWorker server runs automatically. If the
savegrp program is run by other means, such as from the command prompt or a
script, this attribute is not used.
If the Force Incremental attribute is set to No, multiple full or level backups are
allowed during the 24 hours after the start time of the first backup.
Forcing an incremental backup
To force incremental backups on groups:
1. Select the group to edit. “How to edit a group” on page 134 provides information
about editing a group.
2. Select the Advanced tab.
3. Select the Force Incremental attribute and click OK.
“Setting the backup group time interval” on page 135 provides information about
how to configure backup groups to occur more than once every 24 hours.

136

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Backup Groups and Schedules

Managing backup groups
Table 17 on page 137 lists backup group management tasks and where to find more
information about these tasks.
Table 17

Backup group management

Group Management Task

For more information

Start a group immediately

“Starting a group immediately” on page 395

Stop a group immediately

“Stopping a group” on page 396

Restart a group

“Restarting groups” on page 396

Preview a backup group

“Previewing a backup group” on page 137

Previewing a backup group
You can simulate a backup for a specific group. This feature generates an output that
includes this information:
◆

File System to be backed up

◆

Backup level

◆

Backup pool

Preview a backup to identify potential problems before the NetWorker server runs a
backup group.
To preview a backup group:
1. Select the group to edit. Information about editing a group is available in “How to
edit a group” on page 134.
2. Select the Advanced tab.
3. In the Option attribute, select Preview and click OK.
To see the simulated results of the backup, open the daemon log file located in the
<NetWorker_install_dir>\logs directory. Information about viewing log files is
available in“Viewing log files” on page 661.

Moving clients between groups
Multiple clients may be moved from one group to another by selecting the clients and
dragging them to another group.
Note: Do not place both regular and deduplication clients in the same group.

Managing backup groups
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Estimating save set sizes of a backup group
You can estimate the size of the save sets that will be produced in a backup group
before the backup is run.
To estimate save set sizes of the backup group:
1. Select the group to edit. Information about editing a group is available in “How to
edit a group” on page 134.
2. Select the Advanced tab.
3. In the Option attribute, select Estimate, No Save, and Verbose.
4. Click OK.
To see the estimated save set sizes, open the daemon log file located in the
NetWorker_install_dir\logs directory. “Viewing log files” on page 661 provides
information about viewing log files.
Note: Selecting the Estimate, No Save, and Verbose options produces an estimate that shows
all paths and filenames that will be saved in the backup group. Selecting the Estimate and
Verbose options produces a detailed estimate and performs the save in a single operation.
Selecting only the Estimate option (without the No Save or Verbose option) results in a save
operation without an estimate.

Backing up status reports
When the backup is completed, several types of backup status reports are generated:
◆

Chapter 14, “Reporting” provides information about these reports.

◆

Information about the status of backed-up groups is also written to the savegrp
log file, which is located in the NetWorker_install_dir\logs directory.

◆

“Viewing log files” on page 661 provides information about viewing log files.

Generating and printing bootstrap reports
When the backup group includes the NetWorker server, or if the server is not in an
active group, the server generates a special save set called the bootstrap, which
includes the media database and configuration files. In both of these cases, a
bootstrap email (default) or printout is generated whether the scheduled backup is
initiated automatically or manually. The bootstrap information is essential for
recovery from a disaster. For information on how the bootstrap is used during a
disaster recovery operation, refer to the EMC NetWorker Disaster Recovery Guide.
Note: If the NetWorker server is not a member of an active group, the bootstrap is created
when any group backup is run, even if the group has a level of "skip." However, in this case the
bootstrap will be created only once every 24 hours, regardless of how many groups are run
during that period. If you would like to create bootstraps for every group backup, you should
include the server in the group, with a very small save set (such as /etc/hosts).

By default, the bootstrap reports are generated and sent as an email to the default
email recipient, either the administrator or root. To change the email recipient, open
the Bootstrap notification and configure a new email recipient.

138

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Backup Groups and Schedules

Note: User can also choose to get the reports printed through the default printer configured for
the NetWorker server. To change the default printer, edit the Printer attribute in the Group
resource.

If the bootstrap notification is configured for email (default option) and an email
recipient is not configured, then the bootstrap reports are lost. However, when an
email recipient is later configured, the bootstrap reports are generated the next time
as part of the savegrp operation and the previous reports are also sent to the email
recipient along with the current report.
If the bootstrap notification is configured to the printer (not the default configuration)
and bootstrap report fails for any reason, then the contents can be viewed in the
savegrp.log file which is located in the <install_dir>\logs directory, or the savegrp
report. “Viewing log files” on page 661 provides information about viewing log files.

Backing up open files
Open files are a problem that all data backup applications must solve. Open files that
are not backed up properly represent a potential data loss. They might be skipped,
improperly backed up, or locked.
NetWorker can open two different types of files. Those that are owned by the
operating system and those that are owned by a specific application.

Opening files owned by the operating system
Most open files that are owned by the operating system can be backed up. However,
some applications can apply operating system locks to open files. These locks prevent
other applications, such as NetWorker software, from writing to or reading from the
open file.
The NetWorker software normally skips locked files and returns the message:
save: file_name cannot open

Additionally, a permission denied error may be returned from the operating system.
To back up locked open files, close any open files. However in most cases, this is
impractical. To automate this process, create a pre- and postprocessing backup
command that shuts down specific applications, backs up the open files, and then
restarts any applications after the backup finishes. Chapter 2, “Backing Up Data”
provides more information. Also use Open File Manager to back up open files.

Opening files owned by a specific application
The NetWorker software by itself cannot normally back up an open file that belongs
to a specific application, like a database. To back up these open files, use a NetWorker
Module. For example, use the NetWorker Module for Oracle to back up open files in
an Oracle database.

Backing up open files
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Files that change during backup
If a file changes during a backup, the NetWorker software alerts you by displaying
the following message in the Groups tab of the Monitoring option:
warning: file_name changed during save

To ensure that the changed file is backed up, do either of the following:
◆

Restart the backup group.

◆

Perform a manual backup. Information is available in “Manual backups” on
page 64.

Note: NetWorker Modules can back up these types of files correctly, if they are files related to
the database the module is backing up.

Backing up open files with VSS
In NetWorker releases 7.2 and later, if a VSS client license is present, the software
takes advantage of VSS technology to create snapshot backups of volumes and exact
copies of files, including all open files. In this way, files that have changed during the
backup process are copied correctly. Chapter 25, “Volume Shadow Copy Service,”
provides more information about VSS.

Schedules
Each Client resource is backed up according to a schedule. A Client resource’s backup
schedule tells the NetWorker server what level of backup (for example, full or
incremental) to perform on a given day. For instance, on Fridays it might perform a
full backup on a Client resource and the rest of the week perform incremental
backups. The time of day the backup begins is determined by the group to which the
Client resource is associated.
Schedules can be simple or complex, depending on the needs of the environment. All
Client resources can share the same schedule, or each can have a unique schedule.
The type and scope of the backup is determined by the specified backup level. The
level can be set to back up a client’s entire file system, or only data that has changed
since the last full backup.
“Backup levels” on page 147 provides information about backup levels.

Schedules for Avamar deduplication clients
Backups must be scheduled to avoid the Avamar node’s read-only periods when such
cron jobs as checkpoint and garbage-collection are run. The Avamar server
documentation provides more information.
The NetWorker Avamar Integration Guide provides backup level and schedule
information that is specific to Avamar clients.
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Preconfigured NetWorker schedules
The NetWorker software ships with preconfigured schedules. If these schedules meet
backup requirements, use them as is. Otherwise, create new schedules to
accommodate any site-specific needs.
Preconfigured schedules cannot be deleted. Preconfigured schedules that contain
“overrides” (indicated by an asterisk next to a backup level in the schedule’s
calendar) cannot be modified. All other preconfigured schedules can be modified.
Table 18 on page 141 describes the preconfigured schedules.
Table 18

Preconfigured NetWorker schedules

Schedule name

NetWorker backup operation

Default

Completes a full backup every Sunday, incremental backups on all other days.

Full Every Friday

Completes a full backup every Friday, incremental backups on all other days.

Full on First Friday of
Month

Completes a full backup on the first Friday of the month, incremental backups on all other days.
This schedule cannot be modified.

Full on First of Month

Completes a full backup on the first calendar day of the month, incremental backups on all other days.

Quarterly

Completes a full backup on the first day of a quarter. Performs a level 5 backup on the first day of the
other months in the quarter. Every seven days, a level 7 backup occurs. Incremental backups are
performed on all other days.
This schedule cannot be modified.

Consolidate Every Friday Completes a consolidated backup every Friday. Completes incremental backups on all other days.
Consolidate on First
Friday of Month

Completes a consolidated backup on the first Friday of the month. Completes incremental backups on
all other days.
This schedule cannot be modified.

Consolidate on First of
Month

Completes a consolidated backup on the first calendar day of the month. Completes incrementals on
all other days of the month.

Consolidate Quarterly

Completes a consolidated backup on the first day of each quarter. Completes incremental backups on
all other days of the quarter.
This schedule cannot be modified.

Backup cycles
The period of time from one full backup to the next full backup is called a backup
cycle.
The following examples demonstrate how to use schedules for different backup
cycles and client backup needs.
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Example 7

Weekly backup cycle

Figure 12 on page 142 illustrates a weekly backup cycle. In this example, a full
backup is performed on a client each Sunday, and incremental backups are
performed on the other days of the week.
Full

Sun

Full
Inc

Inc

Inc

Inc

Inc

Inc

Mon

Tue

Wed

Thur

Fri

Sat

Sun

Complete backup cycle

Figure 12

Weekly backup cycle

Use backup schedules to balance and stagger the load on a NetWorker server.
Depending on the size of a network, you could apply the same schedule to all clients.
For example, if no one works over the weekend and you want to run full backups
during this time, you could apply the Default schedule to all of the clients.
The Default schedule tells the NetWorker server to perform full backups on Sunday,
and incremental backups the rest of the week.
Example 8

Default schedule for multiple clients

Figure 13 on page 142 illustrates how the Default schedule works for three clients.
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Complete backup cycle

Figure 13

Default schedule for multiple clients
Note: If you have a short backup window period and need to create a full backup, you can use
the consolidation backup. A consolidation backup uses the most volume space because it holds
both a level 1 and a consolidated full backup. However, data recovery is faster because of the
full backup. “Save set consolidation” on page 153 provides details.

Since full backups transfer large amounts of data and typically take longer than other
backup levels, you may want to stagger them throughout the week. For example, you
could apply a schedule that performs a full backup for Client A on Thursday, a
second schedule that performs a full backup for Client B on Tuesday, and a third
schedule that performs a full backup for Client C on Sunday.
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Example 9

Staggered weekly schedules for multiple clients

Figure 14 on page 143 illustrates how to use a staggered backup schedule for multiple
clients.
Client A =
Client B =

= Incrementals

Client C =

= Fulls
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Complete backup cycle
Figure 14

Staggered weekly schedules for multiple clients

By balancing and staggering the load, and using different start times for different
groups of clients, you can increase the efficiency of a NetWorker server.

Scheduling and planning considerations
Deciding which schedules are most appropriate for an environment requires
planning.
When you create backup schedules, consider:
◆

How much data do you have to back up?

◆

How many backup media volumes do you plan to use?

◆

How much time do you have to complete a backup?

◆

Does it matter how many volumes are required to recover from a disaster, such as
a disk crash?

Additionally, determine a policy for recovering files. For example, if users expect to
be able to recover any version of a lost file that was backed up during a three-month
period (that is, the retention policy is three months), you need to maintain all of the
backup volumes for a three-month period. On the other hand, if users expect to be
able to recover data from only the last month, you will not need to maintain as many
volumes.
The length of time that data is available for recovery by the NetWorker server is
determined by the browse and retention policies associated with each client.
Chapter 5, “Browse and Retention Polices” provides information about browse and
retention policies.

Scheduling large client file systems
At a moderate backup rate of 400 KB per second, a full backup for a client with 10 GB
of data takes about seven hours to complete. Consequently, it might not be
convenient to perform a scheduled, full backup for client save sets as large as this
because of the amount of time required.
Schedule the client’s disk volumes for backup at different times by separating them
into different backup groups. When you split one client’s save sets into multiple
backup groups, you back up all the client’s files, but not all at once. It is less
time-consuming than a full backup of all the local data at one time.
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To back up the client’s file systems individually, add and configure the same client
several times by addressing the different file systems in the Client resource. For
example, configure the first Client resource to back up one file system (C:\) with a
single backup schedule in one group. Then, configure the second Client resource to
back up another file system (D:\) with a second backup schedule in another group.
Note: When you create separate backup schedules and explicitly list save sets, any files or file
systems not included in that list are omitted from backup. This includes any new disk volumes
that are added to the system. To avoid this risk, type the value All in the Save Set attribute.

Key components of a schedule
Table 19 on page 144 describes the key components of a Schedule resource.
Table 19

Key components of a schedule

Attribute

Description

Name

The name assigned to a customized schedule that appears in the Client resource as an attribute, and can be
applied to a client/save set. Assign a simple, descriptive name such as Monday Full.

Period

Determines how often a full backup is to run. Set the schedule to apply to either a weekly or a monthly period.
When you select Week and set up a schedule, the backup level full is applied to the same day of the week for all
weeks in the calendar year. For example, full backups every Sunday. Week is the default setting.
When you select Month and set up a schedule, the backup level full is applied to the same day of the month for all
months in the calendar year. For example, full backups on the fifteenth of each month.

Calendar

Displays the days of the month and the backup level scheduled for each day. In addition to full and incremental
backups, you can set intermediate backup levels. You can include one or more of these levels in a backup
schedule:
• Full
• Incremental
• Level (1 – 9)
• Consolidated
• Skip
The Override Levels option allows you to override an existing backup level for a specific day. For example, you
might not want a full backup to run on a holiday. You can override the schedule so the full backup runs on the day
before or the day after the holiday. An asterisk next to a backup level indicates that an override has been set for that
day.
“Backup levels” on page 147 and “Save set consolidation” on page 153 provides more information on how backup
levels work.

Note: The Force Incremental attribute in the backup group, determines the level used by the
NetWorker server when there is more than one backup per day. The default value for this
attribute is Yes, which means that an incremental backup will occur if the group is run more
than once a day. To perform more than one full or level backup per day, set this attribute to No.
“Limiting full backups when the time interval is less than 24 hours” on page 136 provides more
information.
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Working with schedules
This section provides information on how to edit, delete, and copy schedules.
Note: “Task 1: Set up a schedule for backups” on page 56 provides information about creating
a schedule.

Editing a schedule
To edit a schedule:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Schedules.
3. In the right pane, select the schedule to edit.
4. From the File menu, select Properties.
5. Edit the attributes and click OK.
Deleting a schedule
Note: You cannot delete preconfigured schedules or schedules that are currently selected in a
client’s Schedule attribute.

To delete a schedule:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Schedules.
3. In the right pane, select the schedule to delete.
4. From the File menu, select Delete.
5. When prompted, click OK to confirm the deletion.
Copying a schedule
To copy a schedule:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Schedules.
3. In the right pane, right-click the schedule to be copied and select Copy. The
Create Schedule dialog box appears with the same information as the schedule
that was copied, except for the Name attribute.
4. In the Name attribute, type a name for the new schedule.
5. Edit the attributes and click OK.

Overriding a client’s regular backup schedule
You can set the Schedule and Level attributes in the group to override a client’s
regular backup schedule. For example, one evening you could run a full backup on
all the clients in a group, regardless of the clients’ regular backup schedules. The
value specified in the group’s Level attribute overrides the backup level setting for
every client in the group.
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Alternatively, you could have a group of clients follow the same backup schedule
instead of each client’s individual schedule. You could assign a group of clients to
follow the default schedule (full every Sunday) regardless of each client’s individual
schedule. If you leave the group’s Level and Schedule attributes blank (the default
setting), clients follow the backup schedule assigned in the Client resource.
Disabling or enabling a client backup schedule
By default, the schedule assigned to the backup client is enabled.
To disable scheduled backups for a client:
1. Open the Client resource whose scheduled backups are to be disabled. “Editing a
client” on page 470 provides more information.
2. Clear the Scheduled Backup attribute and click OK.

Client timezone adjustment for Windows clients
The NetWorker software enables you to schedule backups over long-distance
networks. In some cases, scheduling can occur over multiple time zones.
To incorporate time zones into your backup schedules, adjust each client time zone
setting by editing the client’s AUTOEXEC.BAT file.
Adjusting the client time zone
To adjust the time zone for backups of a remote client:
1. Open the AUTOEXEC.BAT file by using a text editor.
2. Type these lines in the AUTOEXEC.BAT file:
TZ = <local_standard_timezone><+/- gmt_differences>
<local_daylight_savings_timezone>

Table 20 on page 146 describes the time zone strings that can be adjusted in the
AUTOEXEC.BAT file.
Table 20

Time zone strings

String

Description

Example

local_standard_timezone

The current standard time zone. All
three characters are required.

PST is the three-character
abbreviation for Pacific Standard
Time.

+/- gmt_differences

The difference in the local standard
time zones from Greenwich Mean Time
(GMT) in hours. Positive numbers
adjust westward from GMT and
negative numbers adjust eastward.

The number 8 would represent
Pacific Standard Time, while -1
would represent the central part
of Europe.

local_daylight_savings_timezone

(Optional) The current daylight savings
time zone.

PDT is the three-character
abbreviation for Pacific Daylight
Time.

A complete example of a time zone string is:
PST8PDT

If the TZ environment string is not present in the AUTOEXEC.BAT file, the
NetWorker software presumes a default setting of TZ = EST5EDT.
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Backup levels
Because it may not be practical or efficient to run full backups every day, you can
specify the level of the backup to be performed during scheduled backups. By
limiting the frequency of full backup, you help maintain server efficiency, while still
ensuring that data is protected. Different backup levels enable you to trade off the
number of volumes and amount of time required to complete a backup with that
required to recover from a disk crash.
Table 21 on page 147 describes the five kinds of backup levels:
Table 21

Backup levels

Backup Level

Function

Full

Backs up all files, regardless of whether or not they have changed.

Level [1 – 9]

Backs up files that have changed since the last backup with a lower-numbered backup level.
For example:
• A level 1 backup backs up all files that have changed since the most recent full backup
(considered a level zero).
• A level 3 backup backs up all files that have changed since the most recent backup at
level 2, level 1, or full. For example, if the most recent backup was at level full, then a level
3 backup will back up all files that changed since the full backup. However, if the most
recent backup was at level 2, then a level 3 backup will back up only those files changed
since the level 2 backup.
• A level 9 back up backs up all the files that have changed since the most recent backup of
any level except level 9.
Note: The NetWorker software ignores any incremental-level backups when determining
what files should be backed up.

Incremental

Backs up files that have changed since the last backup, regardless of level.

Consolidated

Backs up all data that has changed since last full backup and then merges these changes
with the last full backup. Information is available in “Save set consolidation” on page 153.

Skip

Skips the scheduled backup. For example, you can skip a backup on a holiday if no one will
be available to change or add more media volumes.

Note: Information on the special nature of deduplication backups is available in the NetWorker
Avamar Integration Guide and the NetWorker Data Domain Depulication Devices Integration
Guide.

How NetWorker backup levels work
Backup levels work in conjunction with a client’s backup schedule. The way you
define the backup levels directly affects how long a recovery from a disk crash takes
and how many backup volumes you need.
Planning level backups helps to minimize the number of volumes used. The fewer
volumes required to recover from a disk crash, the less time spent restoring the disk.
You can also reduce the size and time it takes to back up data by using directives. For
example, use a directive to skip certain files or file systems when performing a
backup. More information on directives is available in Chapter 6, “Directives.”
The following three examples illustrate the how backup levels affect the requirements
for data recovery.
Backup levels
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Example 10 Backup levels (part 1)

As shown in Figure 15 on page 148, a full backup runs on October 1. On October 2, an
incremental backup saves everything that changed since the full backup. On October
3, another incremental backup backs up everything that changed since October 2.
Then, on October 4, a level 7 backup backs up everything that changed since the full
backup on October 1.
To fully recover from a disk crash on October 4, you need the data from the full
backup from October 1 and the new level 7 backup. You no longer need the data from
October 2 and 3, because the level 7 volume includes that information.
Also, incremental backups on October 5, 6, and 7 back up everything that has
changed since the level 7 backup on October 4.
Full
Level 7
inc

Backup level

1

2

3

4

5

6

7

Day
Figure 15

Backups for October 1 through October 7

Example 11 Backup levels (part 2)

Figure 16 on page 148 continues the example illustrated in Figure 15 on page 148 by
showing a level 5 backup on October 8, which backs up everything that changed
since the full backup on October 1. To fully recover from a disk crash on October 8,
you only need the data from October 1 and the new level 5 volume. You no longer
need the data from the level 7 backup on October 4 (or the subsequent incremental
backups performed on October 5, 6, and 7) because the new level 5 backup includes
that data.

Full

Level 5
Level 7

Level 7
Backup level

inc

1

2

3

4

5

6

inc

7

8

9

10

11 12 13

14

Day
Figure 16

Backups for October 1 through October 14

Also, a level 7 backup on October 11 backs up all of the data that changed since the
last lower-numbered backup (in this case, the level 5 backup on October 8). To
recover from a disk crash on October 11, you need three volumes: the full volume
from October 1, the level 5 volume from October 8, and the new level 7 volume.
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Example 12 Backup levels (part 3)

Figure 17 on page 149 continues the example by showing a level 5 backup on October
15, which backs up all of the data that changed since the last lower-numbered
backup. Because no backup lower than level 5 has been performed since the full
backup on October 1, this level 5 backs up all of the data that changed since the full
backup. Therefore, to recover from a disk crash on October 15, you only need the data
from the full backup on October 1 and the new level 5 backup.
Full
Level 5
Level 5
Backup level
Level 7

Level 7

inc

inc

1

2

3

4

5

6

7

8

9

10

11 12

13

14 15

Day
Figure 17

Backups for October 1 through October 15

The NetWorker server and backup levels
A backup schedule defines what level backup to perform on a given day. You can
apply one or more backup levels to customize a backup schedule. To use backup
levels in a customized schedule, consider these issues to help you decide what best
suits your environment:
◆

Full backups generally take more time to complete than incremental backups. The
exception to this is the full backup of deduplication clients. With deduplication,
only the initial full backup takes longer. Thereafter, every full backup captures
only the exact bits that have changed. This allows the subsequent full backups to
be significantly smaller.

◆

If you have only one stand-alone storage device and the full backup does not fit
on a single piece of media, an operator must be available to monitor the backup
and change the media.

◆

Full backups cause the online indexes to grow more rapidly than incremental or
level backups.

◆

Level backups serve as checkpoints in schedules because they collect all the files
that have changed over several days, or even weeks, into a single backup session.

◆

Consolidated backups provide the same benefits at the same cost as do full
backups. The difference is that consolidated backups are less taxing on the
network and client because only a level 1 backup is performed. The server’s
performance, however, is slower because the server consolidates the changed
data with the most recent full backup.

Backup levels
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Table 22 on page 150 lists advantages and disadvantages of each backup level.
Table 22

Advantages and disadvantages of backup levels

Backup level

Advantages

Disadvantages

Full

• Faster recovery

•
•
•
•

Level

• Faster backup
• Low load on server
• Uses least volume space

• Slow recovery
• Data can spread across multiple volumes

Consolidated

• Faster backup (from the client’s perspective
only)
• Faster recovery
• Low load on client and network

• Longest high load on server
• Requires at least two volume drives
• Uses most volume space

Slow backup
High server load
High load on client and network
Uses more volume space

Online indexes and backup levels
The online indexes are backed up in the following way:
◆

The client file index for a NetWorker client is backed up every time the client is
backed up. When a client's backup level is incremental, the backup of its client
file index is at level 9. For a consolidated backup, the backups of the indexes are
level 9. The NetWorker server does not perform a level 1 backup for this data.
The files associated with the client file index of a NetWorker client reside on the
NetWorker server. So, when a client is being backed up, its client file index is also
backed up on the Networker server.

◆

The client file index for the NetWorker server client is backed up every time the
NetWorker server is backed up. When the server’s backup level is incremental,
the backup of its client file index is at level 9. For a consolidated backup, the
backups of the index is level 9. The NetWorker server does not perform a level 1
backup for this data.

◆

The media database and the resource database is backed up whenever the
NetWorker server is backed up, or after every scheduled backup if the server is
not in an active group.

For example:
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◆

If the NetWorker server is backed up at the level full, the backup levels of the
NetWorker server’s client file index, the media database, and the resource
database are also full.

◆

If the NetWorker server’s backup is a level 5, the backups of the server’s client file
index is also a level 5.
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Backup levels for the NetWorker online indexes
The NetWorker server backs up the online indexes (client file index and media
database) differently than regular files and other data. Knowing how the online
indexes are backed up is particularly important during disaster recoveries. Table 23
on page 151 compares the level at which the NetWorker server backs up regular files
and the online indexes.
Table 23

Regular file and index backup levels

Regular files

Online indexes

Full

Full

Level 1–9

Level 1–9

Incremental

Level 9

Manual (using the User program)

Not saved

The Windows Archive attribute
The Windows file Archive attribute is used by the NetWorker software to help
determine if the file should be backed up. The NetWorker software backs up a file if
the Archive attribute is enabled.
◆

After backing up the file, the NetWorker software turns off the Archive attribute.

◆

After restoring the file, the NetWorker software turns on the Archive attribute.

To disable NetWorker’s use of the Windows file Archive attribute:
1. Set the environment variable NSR_AVOID_ARCHIVE to a value of Yes.
To set this as a system environment variable, use the Control Panel's System
applet. If this variable is used, NetWorker determines a file's need to be backed up
based on the traditional save criteria of modification time.
2. Log off, reboot, or restart the NetWorker Remote Exec Service to make Windows
aware of the system environment variable change.

Backup levels for Windows SYSTEM and VSS SYSTEM save sets
This section discusses the required backup levels for the five SYSTEM save sets and
six VSS SYSTEM save sets used to back up Microsoft Windows system files. More
information about these save sets is available in Appendix A, “SYSTEM and VSS
SYSTEM Save Sets.”
Note: A backup or restore of any SYSTEM or VSS SYSTEM save set automatically includes all
eligible components of that save set.

Note: Deduplication does not support the backup of SYSTEM save sets.

SYSTEM save sets
These are the required backup levels for the SYSTEM save sets.

Backup levels
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SYSTEM STATE
For Windows XP and Windows Server 2003 with no VSS license or VSS disabled, the
system state is a single logical entity. To maintain the integrity of the system state and
ensure that a recovery will accurately restore the state of the machine to its condition
at the time of the backup, Windows requires that the system state always be backed
up in this manner:
◆

As a single, indivisible unit. Therefore, components of the NetWorker SYSTEM
STATE save set (such as COM+ and the registry) cannot be backed up or restored
individually as separate entities.

◆

At level full. Therefore, individual components of the SYSTEM STATE save set
cannot be backed up at any level other than full. Requesting an incremental
backup of the SYSTEM STATE save set, for example, always results in a full
backup of the save set.

SYSTEM FILES
As with the other SYSTEM save sets, when a backup of the SYSTEM FILES save set
occurs, it is always at level full. However, a requested backup of the SYSTEM FILES
save set is performed only if one or more of the system-protected files have changed
since the specified date and time. If no system-protected files have changed, none will
be backed up and no corresponding save set entry is made in the server's media
index. However, on an incremental or level 1-9 backup of the SYSTEM FILES save set,
all system-protected files are backed up if any system-protected files have changed
since the specified time.
SYSTEM DB
Each component of the SYSTEM DB save set (such as Disk Quota or Removable
Storage) is always backed up at level full, even if another backup level is requested.
SYSTEM DB save set components cannot be backed up or restored individually.
SHAREPOINT
The SHAREPOINT save set is always backed up at level full, even if another backup
level is requested. There are no individual components to back up or restore.
Automated System Recovery
The Automated System Recovery (ASR) save set is always backed up at level full,
even if another backup level is requested. There are no individual components to
back up or restore.
VSS SYSTEM Save Sets
These are the required backup levels for the VSS SYSTEM save sets.
VSS SYSTEM BOOT
For Windows Server 2003 with VSS licensed and enabled, the system state is a single
logical entity. To maintain the integrity of the system state and ensure that a recovery
will accurately restore the state of the machine to its condition at the time of the
backup, Windows requires that the system state always be backed up in this manner:
◆

As a single, indivisible unit.
Components of the NetWorker VSS SYSTEM BOOT save set (such as COM+ and
the registry) cannot be backed up or restored individually as separate entities.

◆

At level full.
Individual components of the VSS SYSTEM BOOT save set cannot be backed up
at any level other than full. Requesting an incremental backup of the VSS
SYSTEM BOOT save set, for example, always results in a full backup of the save
set.
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VSS SYSTEM FILESET
As with the other VSS SYSTEM save sets, when a backup of the VSS SYSTEM
FILESET save set occurs, it is always at level full. However, a requested backup of this
save set is performed only if one or more of the system-protected files have changed
since the specified date and time. If no system-protected files have changed, none will
be backed up and no corresponding save set entry is made in the server's media
index. However, on an incremental or level 1-9 backup of the VSS SYSTEM FILESET
save set, if any system-protected files have changed since the specified time, all
system-protected files are backed up. VSS SYSTEM FILESET components cannot be
backed up or restored individually.
VSS SYSTEM SERVICES
Each component of the VSS SYSTEM SERVICES save set is always backed up at level
full, even if another backup level is requested. VSS SYSTEM SERVICES components
cannot be backed up individually, but they can be restored individually.
VSS USER DATA
Each component of the VSS USER DATA save set is always backed up at level full,
even if another backup level is requested. VSS USER DATA save set components
cannot be backed up individually, but they can be restored individually.
VSS OTHER
Each component of the VSS OTHER save set is always backed up at level full, even if
another backup level is requested. VSS OTHER save set components cannot be
backed up individually, but they can be restored individually.
VSS ASR DISK
The VSS ASR DISK save set is always backed up at level full, even if another backup
level is requested. There are no individual components to back up or restore.

Save set consolidation
Save set consolidation merges a new level 1 backup with the last full backup of a save
set to create a new full backup. Consolidation is a level full backup. The resulting
save set is the same as a level full save set. Although a consolidated backup took
place, there is no such thing as a consolidated save set.
Save set consolidation eliminates the need to perform full backups at regular
intervals. After scheduling a save set consolidation backup, you only perform one full
backup during the first scheduled consolidated backup cycle. Afterward, all
subsequent backups of the consolidated save set are incremental backups.
Save set consolidation shifts the burden of backups to the NetWorker server, which
reduces Client resource use and network traffic. This shift to the server also results in
more frequent level saves, which results in fewer tapes to process in the event of a full
recovery.
When working with large files, save set consolidation shortens the backup window
by doing incremental saves, thus reducing the number of tape drives that are
required during a recovery.
Note: If a save set consolidation is performed on a save set that has no existing full backup, the
consolidation backup defaults to a level full backup and the browse and retention policy is set
to one week. Once a full backup exists, subsequent consolidation backups are performed as a
level 1 followed by consolidation with the existing full backup.

Save set consolidation
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Requirements
Save set consolidation requires at least three attached devices: two for reading and
one for writing.

Save set consolidation usage
Use save set consolidation if these conditions are present:
◆

A client is at a remote location and data transfer over the network to the server is
a performance issue for either the network or the client.

◆

Either the network bandwidth is small, or large backups over the network are
cost-prohibitive.

◆

You need to back up large file systems with little incremental data.

◆

The server has the necessary resources (a minimum of two volume drives and
preferably three or more volume drives) and the workload capacity to
consolidate full backups locally.

Note: Under the appropriate conditions, save set consolidation can free network bandwidth
and Client resources. Used inappropriately, save set consolidation can lower performance,
since it uses tape-to-tape transfer, which might be slower than the disk-to-tape data transfer
that is used by backups.

Limitations of save set consolidation
These are some of the limitations that can cause the save set consolidation process to
fail:
◆

Save sets cannot be consolidated when either the full or Level 1 save set contains a
file larger than 2 GB.

◆

Raw disk file partitions are not eligible for consolidation.

◆

Database systems cannot be consolidated.

◆

Renamed and deleted directories cannot be consolidated. If incremental data
contains renamed or deleted directories, the save set consolidation process will
detect it and abort.

Additionally, do not use save set consolidation if any of the following conditions are
present:
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◆

The client is connected to the server over a fast network or is a local client, and the
network data traffic generated by full backups is not a problem. In this case, save
set consolidation will not produce a measurable benefit.

◆

The file systems being backed up are either not very large or they contain a large
number of small files that are modified often.

◆

The incremental data usually contains a large amount of data, and the number of
files that have changed since the last full backup is large compared to the total
number of files in the file system.

◆

It is cost-prohibitive to allocate three tape drives for the exclusive use of the server
while it consolidates the full backup.
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Note: If a consolidated backup cannot be completed because of a system crash, tape drive
errors, or other problem, data integrity is assured. The transactional log assists save set
consolidation in putting back changes made to the online index.

Performing save set consolidation
You can schedule save set consolidation from the Administration window, or perform
a manual consolidation from the command prompt.

Setting up save set consolidation on a schedule
To set up save set consolidation on a schedule:
1. Open the schedule to which save set consolidation will be applied. More
information is available in “Editing a schedule” on page 145.
2. Select the day the save set consolidation is to occur.
3. Right-click and select Consolidate from the Set Level menu.
Note: Renamed or deleted directories cannot be consolidated. If incremental data contains
renamed or deleted directories, the save set consolidation aborts.

Perform a manual save set consolidation
You can invoke save set consolidation through two different command line programs:
◆

The savegrp program
The savegrp program must be used with the -lc option to indicate that the backup
level is consolidated, or with a schedule that has a level consolidate on the
schedule. This program automatically performs a level 1 backup, followed by the
actual consolidation process.

◆

The nsrssc program
The nsrssc program completes the consolidation process. For the nsrssc program
to be successful, a level 1 save set and a level full save set must already exist.

Note: When nsrssc is run from the command prompt, bootstrap information is not written to
the media used for consolidation. As a result, you still need the original media for disaster
recovery.

Both programs also offer other options to maximize the flexibility of save set
consolidation. For more information about the savegrp and nsrssc commands, refer
to the EMC NetWorker Command Reference Guide or the UNIX man pages.

Directing data from a consolidation backup to a specific pool
By default, save sets from a consolidation backup are written to whatever media is
mounted for the group that was most recently backed up.
To direct consolidated save sets to a specific set of media:
1. Create a Group for consolidation backups, as described in “Task 2: Set up a group
for backup clients” on page 57.
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2. Create a Pool for consolidation backups, as described in “Creating a media pool”
on page 191.
3. In the Pool resource, select the group that was created in step 1 as the value for
the Groups attribute.
4. Edit the Group attribute in each Client resource that is to have consolidated
backups, and assign the group that you created in step 1 .
Example 13 Consolidation of level 1 and full backups

On October 16, the level consolidated performs a level 1 backup, which backs up all
the data that has changed since the last full backup. The level 1 backup is merged
with the last full backup and builds a new level full backup. To recover from a disk
crash on October 17, use the volume that was created on October 16.
Figure 18 on page 156 illustrates how the NetWorker server merges a level 1 backup
with an existing full level backup to create another level full backup.

Recover on Day 17 requires the
Day 16 save set consolidation

Full
Level 1
(consolidation)

Backup
level

Level 5
Level 5
Level 7

Level 7
inc

1

2

3

4

5

6

inc

7

8

9

Day
Figure 18
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About browse and retention policies
The browse policy determines how long files are maintained in the client’s file index on
the NetWorker server. During the period of the browse policy, users can browse
backed-up data from the NetWorker client computer, and select individual files or
entire file systems for recovery. After the browse policy for a file is exceeded, the
entry for that file is deleted.
The retention policy determines how long save set entries are maintained in the
NetWorker server’s media database. During the period of the retention policy, an
entry for a save set cannot be accidentally overwritten.
For at least the period of the retention policy, you can recover a client’s backed-up
data by save set selection:
◆

No save set is considered recyclable until, at a minimum, it has exceeded its
retention policy.

◆

No storage volume can be relabeled and overwritten until, at a minimum, all save
sets on the storage volume (including save sets that depend on them) have
exceeded their retention policies.

Entries for a save set can remain in the media database forever, long after the
retention policy has expired. Entries are removed from the media database when
these occur:
◆

Storage volume is relabeled.

◆

Entries are manually deleted.

The NetWorker server maintains one file index for each client computer (regardless of
the number of Client resources configured for it), and one media database that tracks
data from all clients and all save sets.

Browse policies
You can recover a file that has an entry in the client file index by using the NetWorker
client computer. Users can browse and mark files, and initiate data recovery. The
NetWorker server does not remove the entry for a file until all the save sets that are
dependent on the file have also exceeded their browse policies. In general, the entries
for a full backup that are older than the browse policy are not removed until one
backup cycle has passed. This extra time ensures that you can reconstruct a file to any
point in time included in the browse policy period.
The example in this section demonstrates how a browse policy affects data
availability in the client file index. “Schedules” on page 140 provides information
about schedules and “Backup levels” on page 147 provides information about
backup levels
Example 14 One-week browse policy

In Figure 19 on page 159, both the backup cycle and the browse policy are set at one
week. A backup cycle is the length of time between full backups. Entries for the first
full backup on October 1 remain in the client file index until all the dependent
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incremental and level 5 backups exceed the one-week browse policy. The full backup
performed on October 1 is not removed until October 15, when the incremental and level 5
backups that depend on the full backup expire.
Week 1
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Full

Full
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Day
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1
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6

Complete
backup cycle

Browse policy

Figure 19
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Complete
backup cycle

File index entries for
Week 1 are removed.

One-week browse policy

To further illustrate, suppose that on October 12, you recover information that is backed up
on October 5. The backup performed on October 5 is an incremental backup that is dependent
on the October 4 backup, which is a level 5 backup. The October 4 (level 5) backup, in turn, is
dependent on the full backup performed on October 1.
The entry for the full backup performed on October 1 must remain in the client file index for a
period of time equal to the sum of the following:
◆

The browse policy (one week)

◆

One complete backup cycle (one additional week)

That is, it must remain in the client file index until the level 5 backup on October 4 and all
incremental backups dependent on the full backup pass their browse policy. In Figure 19 on
page 159, entries from the Week 1 backup cycle are removed from the client file index on
October 15.
Example 15 Two-week browse policy

In Figure 20 on page 160, the browse policy is two weeks, which is twice as long as the backup
cycle (one week). In this example, on October 18 a user can still find browsable entries in the
client file index from backups created on October 4. The backup performed on October 5 is an
incremental backup dependent on the October 4 backup, which is a level 5 backup. The
October 4 (level 5) backup, in turn, is dependent on the full backup performed on October 1.
The full backup performed on October 1, and the incremental and level backups that depend
on it, must remain in the client file index for a period of time equal to the combination of the
following:
◆

The browse policy (two weeks)

◆

One complete backup cycle (one additional week)
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In this example, entries for the Week 1 backup cycle are not removed from the client
index until October 22.
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Retention policies
The NetWorker media retention policy specifies a period during which backed-up
data is protected from an accidental overwrite. After the retention period is exceeded,
the save set is eligible to change its status from recoverable to recyclable. The term
recyclable means “eligible for recycling.” The save set’s status, however, does not
change to recyclable until it, and all the save sets that depend on it, have passed their
retention policy. The NetWorker server keeps track of save set dependencies
regardless of whether the dependent save sets are stored on the same or different
volumes. The expiration of a save set’s retention policy does not remove the save set’s
entries from the media database.
A storage volume becomes recyclable when:
◆

The retention policy for every save set on a volume expires.

◆

The status for every save set on a volume changes from recoverable to recyclable.

Since a volume can contain save sets from multiple backup sessions, all with different
retention policies, the mode of a volume might not change to recyclable for a long
time. All the data on the volume remains available for recovery by using either save
set recover or the scanner program. All the entries for recyclable save sets remain in
the media database.
If a volume contains one or more deduplication save sets, the resource for the
deduplication node that was used to create the backup must exist when the save sets
pass their retention time. If the resource for the deduplication node has been deleted,
the volume cannot be made recyclable or relabeled. Furthermore, when
deduplication save sets pass their retention time, the NetWorker server will begin the
process of deleting the deduplicated data from the deduplication node. Therefore,
deduplication data may not be recoverable using the scanner program once the
deduplication save set has passed its retention time.
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The change in status to recyclable means that the volume can be overwritten if
conditions are right. The volume can be relabeled under the following conditions:
◆

The volume is placed in an autochanger or mounted in a stand-alone device.

◆

The Auto Media Management attribute in the Device resource is enabled.

The existing data is nonrecoverable after the volume is relabeled. “Auto Media
Management” on page 288 provides information about the Auto Media Management
attribute.
Save set entries are also removed from the media database when they are manually
deleted. However, the data on that volume is still available for recovery by using the
scanner program. The scanner program retrieves the information needed to re-create
entries in either the client file index, in the media database, or in both places:
◆

If you re-create the entries in the client file index, a user with the proper
permissions can recover data by using the NetWorker client computer.

◆

If you re-create the save set’s entries in the media database, a UNIX root user or a
member of the Windows Administrators group can recover data by using save
set recovery.

“Restore a save set entry in the online indexes” on page 338 provides more
information about re-creating entries in the client file index or the media database.
Note: If only one full browsable saveset backup exists, then its browse policy is equal to its
retention policy.

Example 16 Three-week retention policy

Figure 21 illustrates how a retention policy works. In this example, the backup cycle
is set at one week and the retention policy is set at three weeks.
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About browse and retention policies

161

Browse and Retention Polices

Figure 21

One-week backup cycle and three-week retention policy

The save set entries for Week 1 have passed their browse policy and retention policy,
but they remain available for recovery by using the scanner program or via a save set
recovery until you relabel the volume. When all the save set entries on a volume
change status to recyclable, the volume mode changes from full or appendable to
recyclable, and the volume is ready to be relabeled for reuse.
Note: Once a volume is relabeled, data on the volume cannot be recovered.

For more information on these topics, see these sections:
◆

“Viewing volume status information” on page 290

◆

“Schedules” on page 140

◆

“Backup levels” on page 147

Retention policies for client file index save sets
The client file indexes that reside on the NetWorker server are backed up as are any
other files. However, the retention policy for these files is calculated differently than
for other files. The retention policy for a client file index is based on the retention
policy that is specified for the NetWorker client to which the client file index
corresponds. For example, if NetWorker client jupiter has a retention policy of seven
years, then the client file index that corresponds to jupiter will also have a retention
policy of seven years regardless of any retention policy that may be set up for the
NetWorker server. This ensures that if a NetWorker client is recovered, the
corresponding client file index can also be recovered.
Retention policies and media pools
A retention policy can also be specified for a media pool. If the retention policy is
specified for a media pool as well as the client, the NetWorker software will the
longer of the two policies.
Assigning a retention policy to a clone pool has special implications. When a
retention policy is specified in a clone pool, all save sets that are directed to the clone
pool take on the retention policy of the clone pool regardless of the retention policy of
the save set client. “Specifying browse and retention policies for clone data” on
page 226 provides more information.
When browse and retention policies are specified with a command line program,
such as save -w -y, the browse and retention policies are taken from that program.
“Browse and retention policies for manual backups” on page 167 provides more
information.

Managing the data lifecycle
Browse and retention policies control the growth of the client file index and the media
database, and how long data remains available for recovery.
Figure 22 on page 163 traces the data lifecycle through the client file index and the
media database. In the example, the entries for the September 1 through September 7
backup cycle remain in the client index for one month (the browse policy), plus the
length of a full backup cycle (one week), to ensure that all dependent entries pass
their browse policies. In this case, the file index entries for the September 1 through
September 7 backup cycle are removed on October 13. Since the entries exist in the
client file index, you can browse and recover the data through the NetWorker client
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computer. As long as the save set’s file entries remain in the client file index, the
status of the source save set is browsable. After the save set status changes from
browsable to recoverable, you must know the full path to the file in order to recover it
directly.
The status for each save set backed up during the September 1 through September 7
cycle remains recoverable until their retention policies expire and all the dependent
save sets exceed their retention policies. In this case, the entries from the September 1
through September 7 backup cycle change from recoverable to recyclable on
December 8. When all of the save set entries on a volume change status to recyclable,
the mode of the volume changes to recyclable and the volume can be overwritten.
While a save set is either recoverable or recyclable, you can recover any save set by
using either the save set recovery procedure or the scanner program. Alternatively,
you can use the scanner program to re-create a save set’s entries in the client file
index, which enables file recovery directly from the NetWorker client computer.
“Recovering by save set selection” on page 325 and “Restore a save set entry in the
online indexes” on page 338 provide more information.
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Figure 22

Data lifecycle in the client index and the media database

On October 13, all data entries from September 1 to September 7 are removed from
the client file index. On December 8, the save set entries from September 1 to
September 7 in the media database change status from recoverable to recyclable.
After all save sets on a volume change status from recoverable to recyclable, the
volume mode changes to recyclable. After the volume is relabeled, all existing data on
the volume is unavailable for recovery.
Managing the data lifecycle
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Note: When you relabel a volume for reuse within the same pool, the volume identification (the volume
name as it appears on the volume label) remains unchanged. Even though the volume has the same
label, information required by the NetWorker server to locate and restore data on the volume is
destroyed. All existing data is inaccessible and will be overwritten.

Assigning multiple policies to a single client
Identical versions of a client and save set combination can have a different set of browse and
retention policies assigned for each different backup group to which it belongs. If you create
an identical Client resource with the same name and save set values, but assign it to a
different backup group, you can designate a different set of browse and retention policies. The
NetWorker server employs the Browse Policy and Retention Policy attributes that correspond
to the unique combination of the Client resource’s Name, Save Set, and Group attributes.
Example 17 Assigning different policies for an identical client

You have a Client resource for the host saturn. The Client resource has a save set value of All
and is assigned to backup group general. The browse policy is weekly and the retention
policy is monthly. You create a copy of the Client resource for saturn, but assign it to the
backup group special. This version of saturn has a browse policy of Weekly and a retention
policy of yearly.
◆

If the group special is backed up, then the weekly and yearly policies are applied.

◆

If the group general is backed up, then the policies weekly and monthly are used.

Preconfigured policies
NetWorker software contains these preconfigured browse policies:
◆

Day

◆

Week

◆

Month

◆

Quarter

◆

Year

◆

Decade

You can use these preconfigured policies, or customize policies to best suit data storage needs.
Create the customized policy before you configure the client. Otherwise, the policy name does
not appear in the Client dialog box as an option.
“Task 3: Set up policies for quick access and long term storage” on page 57 provides
information about creating a policy.
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Editing a policy
Note: You cannot change the name of a policy. To rename a policy, delete the current policy
and create a new one.

To edit a policy:
1. In the Administration window, click Configuration.
2. In the expanded left pane, select Policies.
3. In the right pane, select the policy to edit.
4. From the File menu, select Properties.
5. Make any necessary changes in the Properties dialog box and click OK.

Delete a policy
Note: Preconfigured policies cannot be deleted. For more information, see “Preconfigured
policies” on page 164.

To delete a policy:
1. In the Administration window, click Configuration.
2. In the expanded left pane, select Policies.
3. In the right pane, select the policy to delete.
4. From the File menu, select Delete.
5. When prompted, click Yes to confirm the deletion.

Snapshot policies
A snapshot policy is required to perform backups with the NetWorker PowerSnap™
Module software. This policy determines how many snapshots are created, retained,
and backed up to permanent storage. You can specify a preconfigured policy or create
a custom snapshot policy.
The snapshot policy works in conjunction with the Interval attribute of the Group
resource. The value for the Interval attribute must be set low enough that the
specified number of snapshots can be created in the 24-hour period. For example, to
create four snapshots, the Interval value must be set to six hours or less.
For more information on the NetWorker PowerSnap Module software and creating a
snapshot policy, refer to the EMC PowerSnap Module documentation. The EMC
NetWorker Module for Microsoft Applications Administration Guide provides information
about creating a snapshot policy for the VSS Client.

Managing the data lifecycle
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Working with snapshot policies
This section provides information about preconfigured snapshot policies, as well as
instructions for creating, editing, and deleting snapshot policies.
Preconfigured snapshot policies
If a new customized snapshot policy is not manually created, the NetWorker software
provides two preconfigured policies that can be used with the PowerSnap Module
software:
◆

Serverless
With the Serverless snapshot policy, a single snapshot is taken per day. The data
is then backed up to traditional tape and the snapshot is deleted.

◆

Daily
With the Daily snapshot policy, eight snapshots are taken in a single day. The
data in the first snapshot is backed up to tape. Each snapshot has an expiration
policy of 24 hours.

Note: Neither preconfigured snapshot policy may be deleted.

Creating a snapshot policy
To create a snapshot policy:
1. In the Administration window, click Configuration.
2. In the expanded left pane, select Snapshot Policies.
3. From the File menu, select New.
4. In the Create Snapshot Policy dialog box, type a name for the snapshot policy in
the Name attribute and complete other attributes as appropriate.
Note: For information about how to complete the attributes for a snapshot policy, refer to
the EMC NetWorker PowerSnap Module documentation.

5. Click OK.
Edit a snapshot policy
To edit a policy:
1. In the Administration window, click Configuration.
2. In the expanded left pane, select Snapshot Policies.
3. In the right pane, select the snapshot policy to edit.
4. From the File menu, select Properties.
5. Make any necessary changes in the Properties dialog box and click OK.
Copying a snapshot policy
To copy a snapshot policy resource:
1. In the Administration window, click Configuration.
2. In the left pane, select Snapshot Policies.
3. In the right pane, select the Snapshot Policy resource to copy.
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4. From the Edit menu, select Copy. The Create Snapshot Policy dialog box
appears.
5. Type the name for the new Snapshot Policy resource in the Name attribute, edit
any other attributes as appropriate, and click OK.
Delete a snapshot policy
To delete a snapshot policy:
1. In the Administration window, click Configuration.
2. In the expanded left pane, select Snapshot Policies.
3. In the right pane, select the snapshot policy to delete.
4. From the File menu, select Delete.
5. When prompted, click Yes to confirm the deletion.

Browse and retention policies for manual backups
If a browse or retention policy is specified with a manual backup from the command
prompt, the browse or retention policy takes effect for all of the save sets included in
the manual backup. Specify browse and retention policies with a manual backup
from the command prompt by using the save -w -y command. Both the browse and
the retention policies must be entered in time and date formats accepted by the
nsr_getdate program. The EMC NetWorker Command Reference Guide or the UNIX man
pages provide more information about save and nsr_getdate.
If a browse or retention policy is not specified for a manual backup, the policies are
determined as follows:
◆

Browse policy
The save sets included in a manual backup adopt the browse policy of the Client
resource. If there are multiple Client resources for the NetWorker host, the Client
resource with the longest browse time is adopted. For example, if there are three
Client resources for the NetWorker client mars, each with one of these browse
periods:
• One week
• One month
• One year
A manual backup of mars adopts a browse policy of one year.

◆

Retention Policy
The save sets included in a manual backup adopt the retention policy of the
Client resource according to the same rules that were described previously for
browse policies. However, if a retention policy is set up for the media pool to
which the backup is directed, the retention policy will be the longer of either:
• The Client resource retention policy
• The media pool retention policy
There are special considerations for retention policies and clone data. “Specifying
browse and retention policies for clone data” on page 226 provides more
information.

Browse and retention policies for manual backups
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Modifying the browse and retention policy on a save set
Use the nsrmm program to modify the browse and retention policy of a save set after
the backup has occurred. Use nsrmm with these options:
◆

-e retention_time – updates retention time

◆

-w browse_time – updates browse time

Use the -e and -w options with the nsrmm option -S (to specify a save set ID).
Note: The retention time must be later than the browse time, and the browse time must be later
than the insertion time. The insertion time is the time that the save set record was most recently
introduced into the save set database.

When the -e and -w options are used with nsrmm, these must be true:
◆

Retention-time is greater than the browse-time.

◆

Browse-time is greater than the insertion-time.

Both the browse and the retention policies must be entered in time and date formats
accepted by the nsr_getdate program. The EMC NetWorker Command Reference Guide
or the UNIX man pages provide more information about nsrmm and nsr_getdate.
Example 18 Changing browse and retention policies with nsrmm

The examples in this section use nsrmm to change browse and retention policies:
◆

Change the retention time to midnight, January 1, 2016. Change the browse time
to midnight, January 1, 2012:
nsrmm -S 3315861249 -e "01/01/09 23:59:59" -w "01/01/08 23:59:59"

◆

Change the browse time to six months from the current date and time:
nsrmm -S 5315861249 -w "6 months"

◆

Change the retention time to two years from the current date and time:
nsrmm -S 3315861249 -e "2 years"

Reports on browse and retention policies for save sets
The mminfo command can be used with the -p option to display a report on the
browse and retention times for save sets. The EMC NetWorker Command Reference
Guide or the UNIX man pages provide more information about mminfo.
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This chapter covers these topics:
◆
◆
◆
◆
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◆
◆
◆
◆
◆
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Directives overview
Directives are resources that contains special instructions that control how the
NetWorker server processes files and directories during backup and recovery.
NetWorker administrators can create directives to customize the NetWorker software
to your specific needs, maximize the efficiency of backups, and apply special
handling to individual files or directories.
Note: If deduplication is used for a client, directives cannot be applied.

Types of local and global directives
There are three types of directives.

Global directives
Administrators can create global directives by using the NetWorker Administrator
program. These directives are stored as resources on the NetWorker server, and can
be selectively applied to individual clients by using the Directive attribute of the
Client resource.

NetWorker User local directives (Windows only)
On clients that run Microsoft Windows, users with local Windows Administrator or
Backup Operator privileges can create local directives by using the NetWorker User
program. These directives are stored on the client in a file named networkr.cfg, and
are applied throughout the client’s file systems during scheduled backups (or save
operations that do not include the -i option).

Local directive files
Users can create local directive files named nsr.dir (Windows) or .nsr (UNIX)
anywhere on a client file system that they have permission to create files. The
directives these files apply only to the immediate data within the path where the
directive file is located.

Creating a global directive resource
“Format of directive statements” on page 176 provides instructions on the syntax to
use when creating directives.
To create a global directive:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Directives.
3. From the File menu, select New.
4. In the Name attribute, type a name for the new directive.
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5. In the Comment attribute, type a description of the directive.
6. In the Directive attribute, type one or more directives.
7. Click OK.
The directive can now be applied to a NetWorker Client resource. Example 19,
“Applying a global directive” provides more information.

Editing a global directive resource
Note: A directive name cannot be changed, the directive must be deleted and a new one
created with a new name.

To edit a global directive:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Directives.
3. In the right pane, select the directive.
4. From the File menu, select Properties.
5. In the Directive attribute, modify the directive as necessary and then click OK.

Deleting a global directive resource
Note: You cannot delete preconfigured directives or any directives currently applied to a
Client resource.

To delete a global directive:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Directives.
3. In the right pane, select the directive to delete.
4. From the File menu, select Delete.
5. Click Yes to confirm the deletion.

Copying a global directive resource
To copy a global directive:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Directives.
3. In the right pane, select the directive to copy.
4. From the Edit menu, select Copy.
A copy of the directive is created.
5. In the Name attribute specify a name for the directive.
6. In Directive attribute, modify the directive as necessary and then click OK.

Editing a global directive resource
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Applying directives
This section contains some basic examples of global and local directives, and
describes how to apply them to NetWorker clients.
Note: If deduplication is used for a client, directives cannot be applied.

Example 19 Applying a global directive

This example shows how to use a global directive to skip all *.tmp files in a particular
directory for a particular NetWorker client.
1. Create a global directive by using the appropriate format:
• On Windows, skip all *.tmp files in the C:\mydir directory:
<<"C:\MYDIR">>
skip: *.tmp
• On UNIX, skip all *.tmp files in the /mydir directory:
<</mydir>>
skip: *.tmp
2. Apply the directive to the appropriate NetWorker Client resource:
a. From the Administration window, click Configuration.
b. In the left pane, click Clients.
c. In the right pane, select a client.
d. From the File menu, select Properties.
e. From the Directives attribute list, select a directive and then click OK.
When a scheduled backup is performed on the NetWorker client, all files that match
the *.tmp pattern in the specified directories will be skipped.
Example 20 Applying a NetWorker User program local directive (Windows only)

This example shows how to use a Windows local directive to skip all *.tmp files in the
C:\mydir directory on a particular NetWorker client.
Using the NetWorker User program, create a local directive. The directive is saved in
the networkr.cfg file in this format:
<<"C:\mydir">>
skip: *.tmp

When a scheduled backup is performed on the NetWorker client, all files that match
the *.tmp pattern in the C:\mydir directory will be skipped.
“Local directives within the NetWorker User program” on page 173 provides
information on creating local directives.
Example 21 Applying a local file directive

This example shows how to use a local file directive to skip all *.tmp files in a
particular directory for a particular NetWorker client. When a scheduled backup is
performed on the NetWorker client, all files that match the *.tmp pattern in the
specified directory will be skipped.
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On Windows, skip all *.tmp files in the C:\mydir directory:
1. Use a text editor to create a file named nsr.dir and type this directive in the file:
skip: *.tmp

2. Place the nsr.dir file in the C:\mydir directory on the NetWorker client.
Note: To create directive files on a client that is running Microsoft Windows, an authenticated
user must have the appropriate permissions to create files either within the root of a volume, or
in a folder within the volume.

On UNIX, skip all *.tmp files in the /mydir directory:
1. Use a text editor to create a file named .nsr and type this directive in the file:
skip: *.tmp

2. Place the .nsr file in the /mydir directory on the NetWorker client.

Order of precedence of global and local directives
If there is a conflict between directives, global directives are enforced over local
directives. And on Windows hosts, NetWorker User program local directives are
enforced over local directive files (nsr.dir files).

Local directives within the NetWorker User program
On Windows, users can create local directives with the NetWorker User program.
These directives are saved in a file named networkr.cfg.
When you perform a manual backup from the NetWorker User program, only local
directives that were created with the NetWorker User program are enforced. Global
directives and local directive files (nsr.dir files) are not enforced. However, all local
directives are enforced when a NetWorker save without the -i option is run at the
command-prompt.
NetWorker User program local directives are also enforced during scheduled
backups and archive operations.

Set up a NetWorker User program local directive
To set up a User program local directive:
1. Log in to the client computer as a member of either the local Windows
Administrators or Backup Operators Windows security group.
2. Start the NetWorker User Program.
3. From the Options menu, select Local Backup Directives.
4. Set the local directive for each data item. You can clear data items in order to
exclude them from scheduled backups, and select items for password-protection,
encryption, and compression. This applies for both manual and scheduled saves.
Note: If password-protection or encryption is selected, the password must be specified
first. “Encrypting backup data” on page 77 provides information about setting a password.

Local directives within the NetWorker User program
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5. From the File menu, select Save Backup Directives to save changes.
Depending on user privileges and OS version, the User program creates
networkr.cfg in one of these locations:
• If you are logged on with local Windows Administrator or Backup Operator
privileges, networkr.cfg is created in the root of the system volume (usually
C:\).
• If you are not logged on with local Windows Administrator or Backup
Operator privileges, NETWORKR.CFG is created in
%SystemDrive%\Documents and Settings\User_name\Application
Data\Legato
Note: The Application Data directories are hidden by default. To view these directories by
using Windows Explorer, select Tools > Folder Options. On the View tab of the View Options
dialog box, select the Show hidden files and folders option.

Preconfigured global directive resources
The NetWorker software comes with a number of preconfigured global Directive
resources. All preconfigured Directive resources can be modified, but they cannot be
deleted.
Table 24 lists the preconfigured directives and their descriptions.
Table 24
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Preconfigured directives (1 of 3)

Directive resource

Description

AES

Encrypts backup data with the aes ASM, which provides 256-bit
data encryption. For more information about encrypting backup
data, see “Encrypting backup data” on page 77.

DOS standard

Legacy resource that is used to back up Microsoft Windows 95
and Windows 98 clients. By default, this resource has no
directives.

DOS with compression

Legacy resource that is used to back up and compress Microsoft
Windows 95 and Windows 98 clients. Applies the
compressasm ASM to all files.

Mac OS with compression

Contains the same set of directives as the Mac OS standard
directive, along with applying the compressasm ASM to
specific directories.
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Table 24

Preconfigured directives (2 of 3)

Directive resource

Description

Mac OS standard

Contains a set of directives used to back up standard Mac OS
clients. Applies these ASMs:
• The skip ASM is applied to these files and directories:
/Desktop DB
/Desktop DF
/cores
/VM_Storage
/TheVolumeSettingsFolder
/private/var/db/netinfo
/private/var/db/openldap
/private/tmp
/.Spotlight-V100
/.hotfiles.btree
• The allow save environment keyword is applied to the /nsr
directory to ensure that local directives in /nsr and
subsequent subdirectories are applied.
• The logasm ASM is applied to the /nsr/logs and /var
directories.
• The swapasm ASM is applied to the /private/var/vm

NetWare standard

Is used to back up NetWare clients. By default, this resource has
no directives.

NetWare with compression

Is used to back up and compress NetWare clients. Applies the
compressasm ASM to all files.

NT standard

Is used to back up Windows clients. By default, this resource
has no directives.

NT with compression

Used to back up and compress Windows clients. It applies the
compressasm ASM to all files.

UNIX standard

Contains a set of directives used to back up standard UNIX
clients. Applies these ASMs:
• The skip ASM is applied to the tmp_mnt directory.
• The skip ASM is applied to core files on the file system.
• The allow save environment keyword is applied to the /nsr
directory to ensure that local directives in /nsr and
subsequent subdirectories are applied.
• The skip ASM is applied to the /tmp directory.
• The swapasm ASM is applied to the /export/swap directory.
If swap files are located in a different directory, modify this
directive to use the appropriate directory.
• The logasm ASM is applied to the /nsr/logs, /var, /usr/adm,
and /usr/spool directories. You can apply this ASM to other
directories as well.
• The mailasm ASM is applied to the /usr/spool/mail and
/usr/mail directories. If email files are located in different
directories, modify these directives to use the appropriate
locations.

UNIX with compression

Contains the same set of directives as the UNIX standard
directive, along with applying the compressasm ASM to all files.
Note: This directive is only applied to save sets that contain
directories. If the save set is defined by using a filename, this
directive will not be applied.

Preconfigured global directive resources
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Table 24

Preconfigured directives (3 of 3)

Directive resource

Description

VCB directives

VCB directives are valid for backing up virtual machines using
the VCB methodology. This directive is supported in the
following scenarios:
• When file level incremental backups are performed instead of
FULL image level backups.
• When FULL file level or incremental file level backups are
performed when the save set is ALLVMFS.
The vcb directive skips the following files and folders:
• pagefile.sys
• hiberfil.sys (Hibernation file)
• WINDOWS\system folder
• WINDOWS\System32 folder

Format of directive statements
The format of a directives uses three primary types of statements:
◆

Directory specifications

◆

Application-Specific Module (ASM) specifications

◆

Save environment keywords

Comments can be included in directives as well. Any text after a hash (#) character is
treated as a comment.
Note: For more information about directive formats, refer to the nsr and nsr_directive
information in the EMC NetWorker Command Reference Guide or the UNIX man pages.

Directory specifications
Directory specifications indicate the highest-level directory to which these ASMs
apply. Be aware of the following considerations when adding directory
specifications:
◆

You cannot use wildcards in directory specifications.

◆

When multiple directory specifications are used, directives that follow a directory
specification apply to that directory until the next directory specification.

◆

Mount points, including nested mount points, must have their own directory
specification.

◆

For directives applied to clients on Windows systems, pathnames are not case-sensitive. If
there is a colon (:) in the pathname, the entire path must be enclosed in quotation marks.

The format for a directory specification is:
<<directory>>
◆

On Windows:
<<"C:\BIN">>
asm
<<"C:\TEMP">>
asm
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◆

On UNIX:
<<"/etc">>
asm
<<"/tmp">>
asm

ASM specifications
ASMs specify the action to take on one or more files. The syntax for an ASM
specification is:
[+]asm: argument

where:
◆

The optional plus sign (+) indicates that the directive applies to both the current
directory and all subdirectories.

◆

asm is the name of the ASM to be executed

◆

argument is a list of names (files or directories) that are acted upon by the ASM.
The argument can include multiple names, separated by spaces, and can also
specify wildcards. The argument can contain names that are in the current
directory only. Subdirectories cannot be specified in the argument.

If an ASM or argument name includes a space, enclose the name or argument in
double quotes. “Save environment keywords” on page 177 provides a description of
available ASMs and examples.
Note: For directives applied to clients on Microsoft Windows systems, filenames are
case-sensitive.

Using wildcards in ASM specifications
Wildcards can be used in ASM specifications to replace a single character or string of
characters. Standard shell command interpreter filematching patterns are supported.
On UNIX systems, when applying a directive to all files, including hidden files, use
* .?* (insert a space after the first asterisk).
Save environment keywords
Save environment keywords are used to control how the current ASM and
subsequent ASMs that apply to the current directory and subdirectories will be
applied.
Table 25 on page 177 lists the three save environment keywords.
Table 25

Save environment keywords (1 of 2)

Keyword

Instruction

Example

forget

Instructs the NetWorker server
to no longer apply inherited
directives (those directives that
begin with a +).

To skip all *.o files in the directory G:\SRC, except those in the
G:\SRC\SYS directory, type:
<<G:\SRC>>
+skip: *.o
<<G:\SRC\SYS>>
forget
This uses the skip ASM to instruct the NetWorker server to
skip all files named *.o in the SRC directory and all
subdirectories. It then uses the forget keyword to instruct the
server to not apply the skip ASM to the SYS subdirectory.

Format of directive statements
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Table 25

Save environment keywords (2 of 2)

Keyword

Instruction

Example

ignore

Instructs the NetWorker server
to ignore all directives applied
to the subdirectories below the
current directory.

To override any local directives set in users’ home directories,
type:
<<G:\HOME>>
ignore

allow

Used in subdirectories that
currently have the ignore
keyword applied to them, and
overrides the ignore.

Building on the preceding example for the ignore keyword, to
allow directives in the G:\HOME\DOC directory to be applied,
type:
<<G:\HOME>>
ignore
<<G:\HOME\DOC>>
allow

Application Specific Modules (ASMs)
Directives use Application Specific Modules (ASMs) to process files and directories.
ASMs are programs that operate within the NetWorker environment to perform
various tasks during backup and recovery. For example, the compressasm program
instructs the NetWorker server to compress data during backup.
ASMs are specified in a directive and are then executed during the backup of client
data. Directives can contain one or more ASMs. Table 26 describes the NetWorker
ASMs.
Table 26
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NetWorker ASMs (1 of 3)

ASM name

Description

Example

aes

Encrypts backup data when included in a global
directive that is associated with a Client resource.
“Encrypting backup data” on page 77 has
information about using the AES ASM.

+aes: *

always

Always backs up the specified files, independent of
the change time of the file, and ignores the
scheduled level. This ASM can be used to ensure
that important client files that change constantly
are always fully backed up.

always: *.c

compressasm

Compresses files so that they use less network
bandwidth and fewer volumes. This ASM does not
compress directories. The amount of compression
achieved is data-dependent. This ASM uses
considerable amounts of CPU resources, so its
benefits could be limited on low-powered systems.
If your storage device compresses data, you can
also apply this ASM. However, the additional
compression might actually result in slightly more
data being written to tape.

+compressasm: .

holey

Handles holes or blocks of zeros when backing up
files and preserves these holes during recovery.
This ASM is normally applied automatically and
does not need to be specified.

+holey: *

logasm

Instructs the NetWorker server to not generate
errors when the files specified by this ASM are in
use. This ASM is useful for files involved in
logging, and other similar files that might change
during a backup operation.

+logasm: *.log
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Table 26

NetWorker ASMs (2 of 3)

ASM name

Description

Example

mailasm

Uses mail-style file locking and maintains the
access time of a file, preserving "new mail has
arrived" flag on most mail handlers.

+mailasm: *.mbx

mtimeasm

Backs up files by using the modification time,
rather than the inode change time, to determine
which files should be backed up. The modification
time is the last time the file’s contents were
modified, while the inode change time is the last
time the file’s mode, owner, or link count was
changed.

mtimeasm: *.log

nsrindexasm

Used to recover from NetWorker file index backups
performed by NetWorker servers prior to release
6.0. During recovery from these older index
backups, nsrindexasm is invoked automatically
by nsrck and mmrecov.

Not applicable

nsrmmdbasm

Used to process the media database. Normally,
nsrmmdbasm is invoked automatically by
savegrp and mmrecov, and should not be used in
NetWorker directives.

Not applicable

null

Does not back up the specified files, but does back
up the directory containing the files so entries for
the files get added to the online indexes. The
NetWorker server uses this ASM to back up the
online indexes during a scheduled backup.

+null: *.tmp

nullasm

Another name for the null ASM, used for backward
compatibility.

See null.

posixcrcasm

Calculates a 32-bit cyclic redundancy check
(CRC) for a file during backup. This CRC is stored
along with the file and is verified when the file is
restored. No verification occurs during the backup
itself. With this ASM, it is possible to validate a file
at restore time, but it does not provide a way to
correct any detected errors.

posixcrcasm: *.?*

rawasm

Specifies the back up of UNIX raw disk partitions.
The /dev entries (block and character-special files)
and their associated raw disk partition data is
backed up. On some systems, /dev entries are
symbolic links to device specific names. Unlike
other ASMs, this ASM follows symlinks, allowing
the shorter /dev name to be configured.
“Precautions when using rawasm to back up UNIX
raw partitions” on page 180 provides more
information.

rawasm: /dev/oracle1

skip

Omits files and directories from the backup, and
does not place the directory or filename in the
online index.
In the example given, all files and directories with
the name temp will be omitted from the backup.

+skip: temp
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Table 26

NetWorker ASMs (3 of 3)

ASM name

Description

Example

swapasm

Does not back up actual file data, but re-creates a
zero-filled file of the correct size on recovery. This
ASM is used on systems where the swapping
device is a swap file that must be recovered with
the correct size, but the contents of the swap file
are not important and do not need to be backed up
or restored.

swapasm:
compression.doc

xlateasm

Translates file data so that data backed up is not
immediately recognizable

xlateasm: *.*

Precautions when using rawasm to back up UNIX raw partitions
One can specify the rawasm directive to back up raw disk partitions on UNIX.
However, if the raw partition contains data managed by an active database
management system (DBMS), ensure that the partition is offline and the database
manager is shutdown. For greater flexibility when backing up partitions that contain
data managed by a DBMS, use a NetWorker Module application.
Similarly, if rawasm is used to save a partition containing a UNIX file system, the file
system must be unmounted or mounted read-only to obtain a consistent backup.
Note: Do not specify the rawasm directive to backup or recover raw partitions on Windows.
“Backing up raw partitions on Windows” on page 95 provides more information.

Using rawasm to recover a UNIX raw partition
When recovering data, rawasm requires that the file system node for the raw device
exist prior to the recovery. This protects against the recovery of a /dev entry and the
overwriting of data on a reconfigured disk. You can create the /dev entry, having it
refer to a different raw partition, and force an overwrite if needed. If you create the
/dev entry as a symbolic link, the data is recovered to the target of the symbolic link.
Recovery of a raw partition must occur on a system configured with the same disk
environment and same size partitions as the system that performed the backup:
◆

If the new partition is smaller than the original partition, the recovery will not
complete successfully.

◆

If the new partition is larger than the original partition the estimated size reported
upon recovery is not accurate.

File matching with multiple ASMs in a directive
When a file matches multiple ASMs in a directive, the action taken on the file
depends on the order of the ASMs in the directive. For example, if these ASMs are
listed in a directive:
+always: master.mdf master.ldf
+skip *.mdf *.ldf

Then the master.mdf and the master.ldf files will be backed up because the always
ASM is processed first. All other files with a .mdf or .ldf extension will not be backed
up.
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However, if the order of the ASMs is reversed:
+skip *.mdf *.ldf
+always: master.mdf master.ldf

The master.mdf and the master.ldf files will not be backed up because the skip ASM
is processed first.
Note: To simplify directives that include multiple potential matches for the same file, consider
using save environment keywords. “Save environment keywords” on page 177 provides more
information.
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This chapter covers these topics:
◆
◆

Media pools.................................................................................................................. 184
Label templates............................................................................................................ 197
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Media pools
Backup data is sorted onto backup media volumes by using media pools and volume
labels. A media “pool” is a specific collection of volumes to which the NetWorker
server writes data. The server uses media pools to sort and store data. A volume is
identified with a unique label based on configurable label templates.
Media pools act as filters that tell the server which backup volumes should receive
specific data. The NetWorker server uses media pools in conjunction with label
templates (if the Match Bar Code Labels attribute is not used for the library resource)
to keep track of what data is on which specific volume. “Using label templates” on
page 197 provides more information on label templates.
Note: Media pools do not apply when deduplication is used.

Using media pools
Each media pool configuration includes criteria that must be met in order for the data
to be written to associated volumes.
When a scheduled backup occurs, the NetWorker server tries to match the save
stream to a media pool configuration. If the save stream matches the criteria of a
media pool configuration, it is directed to a labeled volume in the media pool. The
server then checks if a correctly labeled volume for that media pool is mounted on a
storage device:
◆

If a correctly labeled volume is mounted on a storage device, the NetWorker
server writes data to the volume.

◆

If there is no correctly labeled volume mounted on a storage device, the
NetWorker server requests that such a volume be mounted and waits until an
operator or an autochanger mounts an appropriate volume.

Default media pool
If the save stream does not match the criteria for any custom (user-created) media
pools, the NetWorker server directs the save stream to the Default media pool. Even if
you use customized media pools, ensure that appropriate storage devices and media
are available for the Default media pool for cases when the NetWorker server directs
save streams there. If the media pools are not properly configured for backup, an
error message similar to this may appear in the Monitoring Alerts tab in the
Administration window:
media waiting (or critical): backup to pool ’Default’ waiting for 1
writable backup tape or disk

NetWorker media pool types
NetWorker software contains preconfigured media pool types to keep different types
of data separate. NetWorker software does not mix these types of data within a media
pool:
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◆

Backup

◆

Backup clone

◆

Archive

◆

Archive clone
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◆

Migration

◆

Migration clone

◆

WORM (Write Once-Read Many)

◆

DLTWORM

Without any special sorting, all backup data is routed to the Default media pool and
all archive data is routed to the Default Archive media pool. Likewise, clone data is
routed to the appropriate Default Clone media pool. “Creating a media pool” on
page 191 provides information on customizing media pools.

Sorting data with media pools
When you configure the NetWorker server, you can create additional media pools
and sort data by media pool type and any combination of the following:
◆

Group (backup group)

◆

NetWorker client

◆

Save sets (file or file systems)

◆

Backup levels (full, levels 1 – 9, incremental, manual)

When you select a group, the media pool accepts only data associated with the
named group. If a second group name is added, the media pool accepts data
associated with either group, but no others. If you enter configuration criteria in both
the Group attribute and Save Set attribute, only data that meets both the group
criteria and the save set criteria is written to volumes from the specified media pool.
Chapter 4, “Backup Groups and Schedules” provides information about groups and
backup levels.
Example 22 Using media pool configurations to sort data

Figure 23 on page 186 illustrates how the NetWorker server uses media pool
configurations to sort data. The save stream contains data from a full backup that was
performed on client and save sets in a group called Accounting. The NetWorker
server looks for a media pool configuration that matches the group named
Accounting and the level full. When the NetWorker server finds the matching media
pool configuration, it writes the data to a volume with a label from the corresponding
Accounting Full media pool of volumes mounted on one of the storage devices.
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Save stream from
full backup of
group Accounting

Pool configuration 1
Name: Accounting Full
Group: Accounting
Level: Full

Accounting

Volume from
Accounting Full
pool

Label:
AccountingFull.001

Pool configuration 2
Name: Accounting
NonFull
Group: Accounting
Level: NonFull

Volume from
Accounting NonFull pool

Label:
AccountingNonFull.001

NetWorker looks for a
matching pool configuration
Pool configuration 3
Name: Default
Group: Non-specific
Level: Non-specific

Volume from
Default pool

Label:
Default.001

Figure 23

Using media pool configurations to sort data

Directing client file indexes and bootstrap to a separate media pool
You can use regular expression matching to direct the client file indexes and
bootstrap to a media pool other than where you send the backup data.
Example 23 Sending bootstrap information and all the client file indexes to the same media pool

To send the NetWorker server’s bootstrap and client file indexes to the same media
pool, create a media pool (in the Media Pool resource) with the values listed for the
attributes in Table 27 on page 186.
Table 27

186

Attributes to direct client indexes and bootstrap to a
separate media pool

Attribute

Value

Name

Index

Pool Type

Backup

Save Sets

Bootstrap
index
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When the group’s scheduled backup runs, the client save sets are written to a volume
labeled for the appropriate save set media pools, while the NetWorker server’s
bootstrap and index save sets are written to a separate volume labeled for the Index
media pool.

Directing consolidated backup data to a specific media pool
By default, save sets from a consolidated backup are written to whatever media is
mounted for the group most recently backed up.
To direct consolidated save sets to a specific set of media:
1. Configure a Group resource for consolidated backups. “How to create a group”
on page 134 provides information.
2. Configure a Media Pool resource for consolidated backups.“Creating a media
pool” on page 191 provides instructions.
3. In the Create Media Pool dialog box, select the name of the Group resource
created in step 1 for the Groups attribute.
4. Add each client that will receive consolidated backups to the group created for
those backups.

Meeting the criteria for more than one media pool configuration
Depending on the media pool that is created, there may be data that matches the
criteria for more than one media pool configuration. For example, if one media pool is
configured to accept data from a group called Accounting and another media pool is
configured to accept data from all full backups, it is not immediately clear which pool
of volumes will be used for a full backup for the Accounting group. The NetWorker
server uses this media pool selection criteria:
1. Group (highest precedence)
2. Client
3. Save set
4. Level (lowest precedence)
When data matches the attributes for two media pools, for example, Group and
Level, the data is written to the media pool specified in the Group attribute. For
example, in the case where the data from the group matched the criteria for two
different media pools, the data is routed to the media pool that accepts data from the
Accounting group.
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Table 28 on page 188 details the hierarchy that the NetWorker server uses to
determine media pool selection when a conflict arises. For example, the media pool
criteria for Group takes precedence over the media pool criteria for client, save set,
and level. Data that meets the criteria for both media pools is written to the media
pool associated with the group. If data does not meet the criteria for any customized
group, it is written to the Default media pool.
Table 28

NetWorker hierarchy for resolving media pool conflicts

Precedence

Group

Client

Save Set

Level

Highest

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x

x
x

x

x

x

x

x

x

x
x

x

x
Lowest

x

When no customized media pool criteria is met
When you sort data by using a customized media pool, you might inadvertently omit
a client or save set. During a scheduled backup, if data does not meet the criteria for
any customized media pool, the NetWorker server automatically sends the data to
the Default media pool. By using the Default media pool, the server ensures that all
data is backed up to a volume.
When the NetWorker server sends data to the Default media pool, it looks for a
labeled volume from the Default media pool mounted on a storage device. If no
Default media pool volume is mounted on a storage device, the server requests the
appropriate volume and waits until an operator mounts the volume. If the
NetWorker server asks for a Default media pool volume in the middle of a scheduled
backup, the backup pauses until it has been mounted. If an operator is available to
monitor backups, keep a Default media pool volume on hand should this situation
arise.
To plan for unattended backups, run a test of the backup after making any
configuration changes. This ensures that all data is written to the appropriate media
pools of volumes, and avoids requests for a Default media pool volume.
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Configuring media pools
This section provides information specific to the configuration of these media pool
types:
◆

Incremental backups

◆

Manual backups

◆

Clone data

◆

Archive data

Note: You can create and edit media pools while a backup session is running. For each change,
a message is written to the daemon log file, located in the <NetWorker_install_dir>\logs
directory. “Viewing log files” on page 661 provides information about viewing log files. You
cannot delete a media pool that has labeled volumes in the media database.

Incremental backups
When creating a separate media pool for incremental backups, the NetWorker
software’s hierarchy of precedence affects the way the data is stored. When a pool has
been configured with a level incremental restriction and an incremental server
initiated backup is performed:
◆

Incremental data will be routed to the media pool.

◆

The client file index will not go to the incremental pool. In an incremental backup,
the associated index will backup at a level 9 to speed the recovery operation, if
needed.

If the client indexes do not meet the criteria for the media pool associated with the
incremental backups (that is, level 9 is not allowed), the indexes are matched to
another media pool (usually the Default media pool) and an appropriately labeled
volume is searched for. To recover the data, a large number of volumes may be
required. To speed the recovery, define the level value of the appropriate pool to
accept both level 9 and incremental data, rather than only incremental.
By using the preconfigured NonFull media pool, you ensure that the client file
indexes belong to the same media pool as their incremental backups. By keeping the
indexes in the same media pool as their incremental backups, you reduce the number
of volumes required for a recovery.
Manual backups
You can create a customized media pool to receive data from a manual backup by
specifying manual in the Level attribute. The NetWorker server, however, sorts data
from a manual backup differently than it sorts data from a regularly scheduled
backup. Since a manual backup is not performed as part of a scheduled backup
group, by default the data is not associated with any group name. When you perform
a manual backup in which only data from a single client or save set is saved, the
group normally associated with that client or save set is not considered in any
sorting. As a consequence, data from a manual backup may be sent to a media pool
other than the one in which data from this client or save set is stored during a
regularly scheduled backup. If you do not create a customized media pool to receive
data from manual backups, the NetWorker server uses the Default media pool and
looks for a mounted volume from the Default media pool on which to write data.
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Note: Manual backups only back up file system data. Unlike scheduled backups, they do not
back up the client file index at the end of the backup. The next server initiated backup of the
client will backup the index. Manual backups can still be browsed at recovery time unless an
index recover is performed before the index containing the save information has been backed
up.

Clone data
To clone data, use a specific media pool to receive the clone data and a minimum of
two devices:
◆

One to read the source volume

◆

One to write the clone

If data to be cloned is not associated with a customized Clone media pool, the Default
Clone media pool is used. Chapter 9, “Cloning” provides more information.
Archive data
To archive data, use a specific media pool to receive the archived data. You can then
store these volumes offsite. If data to be archived is not associated with a customized
Archive media pool, the preconfigured Archive media pool is used. Chapter 8,
“Archiving” provides more information about archive feature.

Using storage devices and media pool configuration to sort data
Data can be sorted by configuring media pools, in conjunction with storage devices,
to either use specific media to receive data, or designate a specific storage device to
receive data from a designated media pool.
Using different media
You can write data across several volumes of different media types (for example,
magnetic disk and tapes) as long as the volumes mounted on the storage devices
have the appropriate label associated with the media pool.
Using a specific device for backup data
You can associate a media pool with a specific storage device. For example, full
backups may be written to optical disk for offsite storage. There are two ways to
ensure that data goes to one specific storage device:
◆

Always keep a labeled volume associated with the appropriate media pool
mounted on the specific storage device.

◆

Associate a specific media pool with the storage device in the Volume Pool
attribute in the Device resource. Then, for the Media Pool resource, select that
device for the Devices attribute. All data will be written only to that device.

Note: The only time you can assign a device to a media pool is when you label it. If you later
want to assign the device to a different volume pool, you must relabel it.
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Creating a media pool
Resource dialog box attributes vary depending on the server. Use the steps presented
here as a general guideline. For additional information about each attribute, click
Field Help.
Before creating a media pool, do either of the following:
◆

If the Match Bar Code Labels attribute is not used for the Library resource, create
a label template for the media pool. “Creating a label template” on page 200
provides more information.

◆

Determine a preconfigured label template to use for the media pool.

If you do not select a label template when creating a media pool, the NetWorker
server notifies you that it will create a label template for the media pool.
To have the NetWorker server create the label template, click OK. “Using label
templates” on page 197 provides more information on label templates.
To create a media pool:
1. In the Administration window, click Media.
2. In the left pane, select Media Pools.
3. From the File menu, select New.
4. In the Name attribute, type a name for the media pool.
Note: A media pool is associated with a label template. Use a name that clearly associates
the media pool with the corresponding label template.

5. In the Comment attribute, type a description of the media pool.
6. Select the Enabled attribute.
7. For the Pool Type attribute, select the appropriate media pool type.
8. In the Label Template attribute, select the matching label template.
9. In the Data Source attribute, select the backup groups that are eligible to back up
to this media pool.
10. Select the Selection Criteria tab.
11. To further restrict which data can back up to this media pool, complete any of
these attributes: Client, Save Sets, or Level. For guidelines about typing save set
paths, see “Expression matching of save sets to media pools” on page 192.
12. Select the Configuration tab.
13. In the Auto Media Verify attribute, select whether automated media verification
will be performed while data is written to a volume associated with this media
pool. For more information, see “Auto media verification” on page 192.
14. Complete the other attributes as necessary, and click OK.
If any of the settings for a new media pool match an existing media pool, this
message appears:
Pool(s) pool_name has overlapping selection criteria.

If this message appears, review the media pool configuration and modify any
overlapping criteria.

Media pools

191

Sorting Backup Data

Expression matching of save sets to media pools
If you enter a save set path, the Save Set attributes in the Media Pool resource are
matched by using regular expression matching. This affects how the save set
filenames are written, and how the path is written in this field for a Microsoft
Windows system. Backslashes and periods must be preceded with a backslash:
◆

A save set path of C:\SomeDir\MyFiles should be written
C:\\SomeDir\\MyFiles.

◆

A filename of MyFile.txt should be written MyFile\.txt.

When using the NetWorker Administrator program, each save set in the Save Set
attribute must be on a separate line. The following is an example of properly written
save set entries:
/
/usr
C:\\Program Files\\bin
*\.doc

The nsr_regexp and nsr_pool entries in the EMC NetWorker Command Reference Guide
or the UNIX man pages provide information about regular expression matching.
Auto media verification
If the Auto Media Verify attribute is enabled, the NetWorker server verifies data
written to volumes from this media pool.
Data is verified by repositioning the volume to read a portion of the data previously
written to the media. The data read is compared to the original data written. This
feature does not verify the entire length of the tape.
If the data read matches the data written, verification succeeds.
Media is verified when the following occurs:
◆

A volume becomes full while saving and it becomes necessary to continue on to
another volume.

◆

A volume goes idle because all save sets being written to the volume are
complete.

When a volume fails verification, it is marked full so that the server will not select
that volume for future saves. The volume remains full until it is recycled or a user
marks it not full. If a volume fails verification while the server is attempting to switch
volumes, all save sets writing to the volume are terminated.
Auto media verification should not be used to verify the integrity of the data written
to the entire tape. To fully verify the data written to the tape, either restore the tape
contents or clone the data.

Supporting WORM and DLTWORM tape drives
NetWorker supports write-once, read-many (WORM) tape drives and media. It is
able to recognize the WORM abilities of tape drives and the presence of WORM
media in those drives. It also supports the creation of DLTWORM (formerly DLTIce)
tapes in drives that are DLTWORM capable.
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Table 29 on page 193 describes the WORM devices that are supported by the
NetWorker software.
Table 29

WORM supported devices

Device

Description

HP LTO Ultrium 3

Unique to HP Ultrium-3
• Inquiry VPD page 0xb0, byte 4 bit 0 indicates WORM capable
• Read attribute # 0x0408 bit 7 to indicate WORM media present

Quantum SDLT600, DLT-S4, and
DLT-V4 (SCSI and SATA)

Any drive with product inquiry data of “*DLT*” tape drive that reports WORM
capability the way these drives do. (“Quantum” not required in the vendor inquiry
data.)
• Inquiry data VPD page 0xc0, byte 2, bit 0 to indicate WORM capable
• Read attribute # 0x0408 bit 7 to indicate WORM media present

Sony AIT-2, AIT-3, AIT-4, and SAIT

Any drive with “Sony” in the vendor inquiry data that reports WORM capability like
these drives do:
• Mode sense page 0x31, byte 5 bit 0 indicates WORM capable
• Mode sense byte 4 bit 6 indicates WORM tape present

IBM 3592

Unique to IBM 03592
• Mode sense page 0x24, byte 7 bit 4 indicates WORM capable
• Mode sense page 0x23, byte 20 bit 4 indicates WORM tape present

STK 9840A/B/C, 9940B, T10000

Any drive with STK as the vendor data that reports WORM capability like these:
• Standard inquiry data byte 55 bit 2 indicates WORM capable
• Request sense data byte 24 bit 1 indicates WORM tape present

IBM LTO Ultrium 3, and Quantum
LTO Ultrium 3

These drives use the SCSI-3 method to report WORM capabilities, so there is not a
match against any of the inquiry data. Any drive that does not match the inquiry data
patterns listed above will have the SCSI-3 method applied to them.
• Inquiry data VPD page
0xb0, byte 4, bit 0 indicates WORM capable
• Mode sense page
0x1d, byte 2 bit 0 indicates WORM tape present
Byte 4, bits 0,1: label restrictions include
- 00 indicates no overwriting allowed
- 01 indicates some labels can be overwritten
• Byte 5, bits 0,1: filemark overwrite restrictions
- 0x02: any filemark at EOD can be overwritten except for the one closest to
the beginning of the tape
- 0x03: any filemark at EOD can be overwritten

The WORM and DLTWORM attributes determine whether or not the NetWorker
software will back up to a write once-read many (WORM) tape. You can apply these
tape attributes to any pool.
Note: Various Quantum drive models (SDLT600, DLT-S4, and DLT-V4) have the ability to
create WORM tapes from ordinary blank DLT tapes supported by that particular drive. You
cannot recycle an existing NetWorker tape to create a DLTWORM volume without first having
bulk-erased the tape. When the DLTWORM attribute is set, labeling one of these drives into a
WORM pool causes the Quantum drive to make the current tape a WORM tape.

Savegroups that belong to pools that have either the WORM or DLTWORM attribute
set, are considered to be WORM savegroups.
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Identifying WORM media
Since WORM media cannot be reused, the tapes are uniquely identified as such so
that they are only used when required. As shown in Figure 24 on page 194, a (W) is
appended to the volume names displayed in the NetWorker Administrator window.
If a volume is both read-only and WORM, an (R) is appended to the volume name.

Figure 24

Identifying WORM tapes in the NetWorker Console
Note: Since WORM tapes can only be used once, attempting to relabel a WORM tape always
results in a write protection error. With the exception of pool selection and relabeling, the
NetWorker software treats WORM tapes exactly the same as all other types of tape.

Configuring WORM and DLTWORM support
To determine if a device is WORM or DLTWORM capable:
1. In the Administration window, click Devices.
2. Select the drive, right-click, and select Properties.
3. Click the Information tab and observe the WORM capable and DLTWORM
capable attribute settings. NetWorker automatically sets these attributes and,
consequently, they are read-only and cannot be changed.
Note: The WORM capable and DLTWORM capable attributes are dimmed out when the
device in use is WORM capable but does not support DLTWORM (not a Quantum DTL-type
drive).

To configure pools to accept WORM or DLTWORM devices:
1. In the Administration window, click Media.
2. In the left pane, select Media Pools.
3. In the right pane, select the appropriate pool.
4. Right-click and select Properties.
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5. Click the Configuration tab and select one of these WORM tape handling attributes:
• WORM pools only hold WORM tapes
• WORM tapes only in WORM pools
6. Click OK when finished making the necessary selections.
Note: If you attempt to assign a non-WORM capable drive to a WORM pool an error message is
generated.
Table 30

WORM/DLTWORM attributes
Attribute

Description

WORM pools only hold WORM tape

By default, the NetWorker software only allows WORM tapes into WORM pools.
Deselecting this option lets you add new (non-WORM) tapes to a WORM pool. This
is useful when you need WORM functionality but do not have WORM tapes available.

WORM tapes only in WORM pools

By default, NetWorker only lets you label WORM tapes into WORM pools. Clear this
option when:
1. You do not want to segregate WORM tapes within WORM pools.
2. A volume is needed to complete a group and a non-WORM tape is unavailable.

WORM capable

This attribute indicates that this drive supports the use of WORM media.

DLTWORM capable

This attribute indicates that this drive can create DLTWORM tapes from a blank tape.

WORM pool

This pool should hold WORM tapes (depending on the setting of “WORM pools only
hold WORM tape” in the server).

create DLTWORM

If selected, before the NetWorker software labels a tape in a drive capable of creating
DLTWORM volumes, NetWorker will try to convert the tape into a DLTWORM tape. If
that conversion fails, the labeling for that tape will fail. If a tape drive in a pool where
this attribute is set cannot create DLTWORM tapes, (that is, the tape drive is not a
Quantum SDLT600, DLT-S4 or DLT-V4 tape drive, this attribute is simply ignored.
Note: Refer to the Quantum web site for information on which tapes can be
converted to DLTWORM tapes.
Not all firmware revisions for all of these devices support WORM operation. Check
the tape drives website to make sure that your drive has up-to-date firmware.

Working with media pools
This section explains how to edit, copy, delete, and create media pools.
Editing a media pool
Note: You cannot change the name of a media pool. Preconfigured media pools cannot be modified.

To edit a media pool:
1. In the Administration window, click Media.
2. In the left pane, select Media Pools.
3. In the right pane, select the media pool.
4. From the File menu, select Properties.
5. In the Properties dialog box, make the necessary changes and click OK.

Media pools
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Copying a media pool
To copy a media pool:
1. In the Administration window, click Media.
2. In the left pane, select Media Pools.
3. In the right pane, select the media pool.
4. From the Edit menu, select Copy. The Create Media Pool dialog box appears,
containing the same information as the media pool that was copied, except for the
Name attribute.
5. In the Name attribute, type a name for the new media pool.
6. Edit any other attributes as appropriate, and click OK.
For details about the Media Pool attributes, click Field Help in the Properties dialog
box.
Deleting a media pool
Note: You can delete a media pool only if there are no active volumes assigned to the media
pool. Preconfigured media pools cannot be deleted.

To delete a media pool:
1. In the Administration window, click Media.
2. In the left pane, select Media Pools.
3. In the right pane, select the media pool.
4. From the File menu, select Delete.
5. When prompted, click Yes to confirm deletion.
Creating an archive media pool
To archive data, the NetWorker server requires an archive media pool to receive the
archive data. If data to be archived is not associated with a custom archive media
pool, the server automatically uses a preconfigured archive media pool. An
appropriately labeled volume must be mounted on a storage device for the archive
process to proceed.
To create an archive media pool:
1. Create a new media pool. “Creating a media pool” on page 191 provides
instructions.
2. From the Pool Type attribute, select Archive from the list.
3. Select the Configuration tab.
4. Clear the Store index entries attribute.
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Label templates
The NetWorker server creates a unique label for each volume by applying a label
template. This section describes how label templates and media pools are used to
sort, store, and track data on media volumes.

Using label templates
The NetWorker server selects the media pool to which a given set of data is written. A
volume is associated with a media pool by its volume label.
The contents of the volume label follow rules that are defined in a specific label
template. You then associate a label template with a specific media pool in the Media
Pool resource. If you do not associate data with a specific media pool, the NetWorker
server uses the preconfigured Default media pool and corresponding Default label
template.
Figure 25 illustrates how a media pool configuration uses its associated label
template to label a volume. For the label template name to appear as a choice in the
Media Pool resource, you must configure a label template before configuring the
associated media pool.

Unlabeled
volume

Label template

Pool
Name:Sales Full
Group:Sales
Level:Full
Label Template: Sales
Full

During the labeling process, the
NetWorker server associates a media
volume with a pool.

Name: Sales Full
Field(s): SalesFull
001-100
Separator: Period
Next: 025

The NetWorker server applies the label
template associated with Sales Full pool.

Resulting volume label:
SalesFull.025
Figure 25

Labeling a volume by using a label template

Using preconfigured label templates
The NetWorker server contains these preconfigured label templates, which
correspond to the preconfigured media pools:
◆

Default

◆

Default clone

Label templates

197

Sorting Backup Data

◆

Archive

◆

Archive clone

◆

Full

◆

Indexed archive

◆

Indexed archive clone

◆

NonFull

◆

Offsite

◆

PC archive

◆

PC archive clone

◆

Two Sided

Label templates have multiple fields separated by periods. The first field represents
the name of the NetWorker server and the final field contains a number to allow for
expansion of the media pool. The number range from 001 to 999. For example:
mars.001
jupiter.054
jupiter.archive.197

Completing Label Template attributes
There are certain guidelines to keep in mind when completing the attributes for a
Label Template resource. Table 31 describes how to complete the key attributes for
this resource. “Creating a label template” on page 200 provides more information on
creating a label template.
Table 31
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Key label template attributes (1 of 2)

Attribute

Guidelines

Name

Keep the label name consistent with the media pool name, so that the label name reflects how the data is
organized. For example, a label template named "AcctFull" would identify volumes that belong to a media
pool called "Accounting Full."
Do not use these characters in label template names:
/\*?[]()$!^;’"’~<>&|{}:-._

Fields

A label template is made up of one or more fields. Each field, or component, provides a layer of specificity to
your organizational structure. There can be any number of components, but it is best to keep the template
simple with as few as necessary. The label cannot exceed 64 characters.
You can use four types of components:
• Range of numbers (for example, 001-999)
• Range of lowercase letters (for example, aa-zz)
• Range of uppercase letters (for example, AA-ZZ)
• Character string (for example, Accounting)
Each range includes a start value, a dash (-), and an end value. The start value and the end value must
have the same number of characters. For example, use 01-99 (not 1-99) or aaa-zzz (not aa-zzz).
The order in which you enter each component of the Field attribute is important. The NetWorker server
applies each component in a left-to-right order, starting with the first one entered. Table 32 on page 199
illustrates how label templates use components to create a number sequence for volume labels.
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Table 31

Key label template attributes (2 of 2)

Attribute

Guidelines

Separator

Choose the symbol to appear between component entries. Use the period, dash, colon, or underscore to
separate each component of the label template. If label components do not have separators (for example,
AA00aa), the labels can be difficult to read.

Next

Choose the next sequence number to write on the label that the NetWorker server places on a volume
(according to the template).
• To force a label to start the label scheme at a particular point, type a start label value. The server
continues to generate labels from that point on, according to the rules of the template.
• To have the NetWorker server generate the first label, leave this attribute blank.
When the NetWorker server recycles a storage volume, the volume label does not change as long as the
volume remains in the same media pool. That is, if a storage volume labeled "Dev.006" is recycled, it retains
the volume label "Dev.006" and does not receive a new label with the next sequence number.

Table 32 lists examples of number sequences for volume labels.
Table 32

Examples of number sequences for volume labels

Type of components

Fields

Number sequence result

Total number of labels

Range of numbers

001-100

001, 002, 003,...100

100

Character string
Range of numbers

SalesFull
001-100

SalesFull.001,...SalesFull.100

100

Range of lowercase letters
Range of numbers

aa-zz
00-99

aa.00,...aa.99,
ab.00,...ab.99,
ac.00,...ac.99,
:
az.00...az.99,
ba.00,...ba.99
:
zz.00,...zz.99

67,600 (262 times 102)

The label template should allow for expansion of the backup media storage system.
For example, it is better to create a template for 100 tapes and not use all of them, than
it is to create a template for only 10 tapes and run out of labels. When the server
reaches the end of the template numbering sequence, it wraps to the starting value.
For example, after zz.99 (used for the 67,600th label), the next label the server uses is
aa.00 for label 67,601.
Note: When the NetWorker server recycles a volume, the volume label does not change if the
volume remains in the same media pool. That is, if a volume labeled Dev.006 is recycled, it will
retain the volume label Dev.006 and will not receive a new label with the next sequence
number. The original data on the volume, however, will be overwritten by the new data.

Naming label templates
The NetWorker server is packaged with preconfigured label templates that
correspond to the preconfigured media pools. If you choose to create the templates,
you can include any number of components in the Fields attribute. However, it is best
to keep the template simple with as few components as necessary for your
organization.

Label templates
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For example, if you create a label template for an accounting department, you can
customize the label template in several ways, depending on the size of the storage
system and media device capabilities.
Table 33 illustrates several ways you can use components to organize labels.
Table 33

Using label template components

Type of organizational structure

Components

Separator

Resulting volume labels

Sequential

AcctFull
‘001-100

period

AcctFull.001
(100 total labels)

Storage oriented (for example, 3
storage racks with 5 shelves each,
each shelf holding 100 tapes)

1-3
1-5
001-100

dash

1-1-001
This label is for the first tape in rack 1 on shelf 1.
(1,500 total labels)

Two-sided media (for example,
optical devices)

AcctFull
000-999
a-b

underscore

AcctFull_000_a (side 1)
AcctFull_000_b (side 2)
(2,000 total labels)

Labeling tips
Naming schemes vary from site to site. One way is to name the volumes with the
name of the NetWorker server followed by a three-digit number, for example:
jupiter.001

Consider that the simpler a convention is, the easier it can be understood by
operators and administrators.
Note: The maximum length for a volume name is 63 characters. With advanced file type
devices (adv_file), the maximum length is 60 characters.

Each volume should have a physical (adhesive) label attached to it. Since the
NetWorker server keeps track of the backups and which volumes they are on, you
can name the volumes with any convenient name. For example, you can label your
volumes 1, 2, 3, or Monday.1, Tuesday.1, Wednesday.1. You can assign a volume any
name as long as each one is unique.
The adhesive label on the volume should match the name generated by NetWorker.
For example, if you physically label a volume mars.1, its NetWorker name should
also be mars.1.

Working with label templates
This section explains how to create, edit, copy, and delete label templates.
Creating a label template
When creating a label template, consider the labeling guidelines described in Table 31
on page 198.
To create a label template:
1. In the Administration window, click Media.
2. In the expanded left pane, select Label Templates.
3. From the File menu, select New.
4. Enter the components for the label template:
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• Name: The name of the new label template.
• Comment: Any user-defined description or explanatory remarks about the
label.
• Fields: A list of label components.
• Separator: The character to be inserted between label components. If no
symbol is selected, the components will have no separators, such as
hostarchive[001-999].
• Next: (Optional) Enter the next label to be generated by the template.
5. Click OK.
Editing a label template
You cannot change the name of a label template. However, to change an individual
label name, delete the existing name in the Next text box, and type a new name.
To edit a label template:
1. In the Administration window, click Media.
2. In the expanded left pane, select Label Templates.
3. In the right pane, select the template to edit.
4. From the File menu, select Properties.
5. In the Properties dialog box, make any necessary changes and click OK.
Copying a label template
To copy a label template:
1. In the Administration window, click Media.
2. In the expanded left pane, select Label Templates.
3. In the right pane, select the label template to copy.
4. From the Edit menu, select Copy. The Create Label Template dialog box appears,
containing the same information as the label template that was copied, except
Name attribute.
5. In the Name attribute, type the name for the new label template.
6. Edit any other attributes as appropriate, and click OK.
Deleting a label template
You cannot delete a preconfigured label template or a label template that is in use.
To delete a label template:
1. In the Administration window, click Media.
2. In the expanded left pane, select Label Templates.
3. In the right pane, select the label template to delete.
4. From the File menu, select Delete.
5. When prompted, click Yes to confirm the deletion.

Label templates
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Overview of archiving
The archive process captures files or directories as they exist at a specific time, and
writes the data to archive storage volumes, which are not automatically recycled.
After the archive process completes, you can delete (“groom”) the original files from
the disk to conserve space.
Archive save sets are similar to backup save sets. The main difference is that archive
save sets have no expiration date. By default, the archive backup level is always set to
full. Archive data must be written to separate pools. Browse and retention policies do
not apply to archive data.
Note: The archive feature must be purchased and licensed separately from other NetWorker
software components. The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides
more information on licensing procedures.

Benefits of using the NetWorker archive feature include:
◆

Files that have been archived can be:
• Deleted from the primary disk storage to make space for newer files.
• Retained in archive volumes for quick retrieval.

◆

Archived data is never subject to automatic recycling, so it cannot be overwritten
accidentally.

◆

Files on archived volumes that use the Indexed Archive pool and the PC Archive
pool can be browsed indefinitely.

Note: NetWorker software does not support archiving of SYSTEM or VSS SYSTEM save sets.

Archive requirements
Before NetWorker archive feature, ensure that you have:
◆

A device, either stand-alone or in an autochanger or silo, connected to a
NetWorker server or storage node. If you are cloning archives, you must have at
least two devices available.

◆

A temporary or permanent enabler code to license the product after any
evaluation period is over. The new for 7.6 Service Pack 1, NetWorker Licensing
Guide provides more information.

How the NetWorker server archives data
The NetWorker software provides three preconfigured pools to receive archived
data:
◆

Indexed Archive pool

◆

PC Archive pool

◆

Archive pool

You can also create custom archive pools. During the archive operation, the
NetWorker server writes data to storage volumes that belong to an Archive pool.
Information about archive data is tracked in the NetWorker server’s media database.
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If you use the preconfigured Indexed Archive pool or PC Archive pool, or if you
create a custom Archive pool that has the Store Index Entries attribute in the Pool
resource set to Yes, information about individual files in the archive save set are
tracked in the client file index. The client file index entries that are generated during
an archive are backed up to volumes from the Default pool during the next scheduled
backup.
Note: Index entries are not generated when the Store Index Entries attribute in the Pool
resource is set to No.

The NetWorker server tracks the volumes used for archives separately from those
used for backups. You cannot archive files to a backup volume, nor can you back up
files to an archive volume. An archive volume must be loaded and mounted in the
server device to complete an archive.
Whether you initiate the archive on the client or the server, the archive is created by
the client’s archive program (nsrarchive), which is initiated by the client’s nsrexecd
service. You can schedule archives from the server or client by using the Archive
Requests resource in the NetWorker Administrator program.
Figure 26 on page 205 illustrates how the NetWorker software archives data.
NetWorker client

NetWorker server

Client file systems

Backup data tracking structures

Data
nsrarchive

Storage media

File index info
nsrindexd (index
archives only

nsrmmdbd

Media database info
nsrmmd
nsrd

Figure 26

Overview of archive operation

Indexed and nonindexed archiving
The NetWorker server supports two styles of archiving:
◆

Indexed archiving for Indexed Archive pools or PC Archive pools

◆

Nonindexed archiving for Archive pools

Overview of archiving
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Indexed archiving (Indexed Archive pool, PC Archive pool)
One can browse and select indexed archives for individual file recovery.
To use indexed archiving, do one of the following:
◆

Use the preconfigured Indexed Archive pool or the PC Archive pool.

◆

Enable the Store Index Entries attribute of the Pool resource associated with the
archive volume.

The client file index entries that are generated during an archive are backed up to
volumes from the Default pool during the next scheduled backup.
Nonindexed archiving (Archive pool)
When data is archived by using nonindexed archiving, entries are not added to the
client file index. When this data is retrieved, the entire save set is retrieved and you
cannot browse or recover individual files.

Permissions for archiving
This section describes the permissions required to use the archive feature.

Enabling archive services for the client
After the archive service is licensed and the enabler code has been entered into the
NetWorker server, all clients of that server are enabled for the NetWorker archive
feature by default. To disable the archive feature for a specific client, set the Archive
Services attribute in the Client resource to Disabled.
To archive data that resides on the NetWorker server, ensure that the Archive
Services attribute is enabled in the Client resource for the server. “Enabling archive
services for a NetWorker client” on page 208 provides instructions.
When you enable the Archive Services attribute for a Client resource, enable the
Archive Services attribute for all other clients of the same name on that server. For
example, if the NetWorker Module for a database application and the NetWorker
client software are installed on the same computer and both back up to the same
NetWorker server, both Client resources have the same name. Ensure that the
Archive Services attribute is enabled for both Client resources.

Enabling or restricting archive access
The Archive Users attribute in the Client resource specifies the users who are allowed
to archive data. If no users are listed in this attribute, only members of the NetWorker
Administrators group with read permissions to the data can archive the data. To
enable users who are not members of the Administrators group to archive data,
include their usernames in this attribute. These users must have read permissions to
the data and Backup Local Data privileges to archive or retrieve the data.
“NetWorker User Groups” on page 442 provides more information about the
Administrators group and the Backup Local Data privilege.
Note: Only members of the Administrators group or users with the Change Security Settings
permission enabled can change the Archive Users attribute.

Users can only retrieve data that they own. If other users need to retrieve data they
do not own, public archives access must be enabled.
206
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Enabling public archive access
To allow users listed in the Archive Users attribute of the Client resource to retrieve
any archived files from that client:
1. In the Administration window, click Configuration.
2. In the left pane of the Configuration window, select the NetWorker server.
3. From the File menu, select Properties.
4. Select the Public Archives attribute and then click OK.
If, during recovery, the operating system allows you to change the ownership of
archived data to that of the original owners, then the retrieved files display the
original ownerships. Otherwise, the user who retrieves the files becomes the owner of
the files.

About archive pools
The NetWorker software provides these three preconfigured pools to receive
archived data:
◆

Preconfigured Indexed Archive pool

◆

PC Archive pool

◆

Preconfigured Archive pool

You cannot change the settings for these preconfigured pools, although you can
create custom pools for archiving data. Custom pools can use either indexed or
nonindexed archiving. “Creating custom Archive pools” on page 207 provides
information on creating custom Archive pools.
If you do not specify a pool to store archived data, the NetWorker software uses the
Indexed Archive pool by default.

Preconfigured Indexed Archive pool and PC Archive pool
The preconfigured Indexed Archive pool and the PC Archive pool store entries for
individual files in the client file index.
Note: Use of the Indexed Archive pool or the PC Archive pool may create a large client file
index that never expires.

Preconfigured archive pool
The preconfigured Archive pool does not have a browsable client file index
associated with it. You cannot retrieve individual files from the archive save set.
Instead, you must retrieve the entire save set.

Creating custom Archive pools
Two attributes in the Pool resource distinguish Archive pools from other pools:
◆

Pool Type - This attribute must be set to Archive, which tells the NetWorker
server that volumes belonging to this pool are used for archiving.

About archive pools
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◆

Store Index Entries - This attribute determines whether the archive is an indexed
or nonindexed archive:
• If this attribute is set to No, entries are not written to the client file index
(nonindexed archiving).
• If this attribute is set to Yes, entries are written to the client file index (indexed
archiving).

“Media pools” on page 184 provides details and procedures about creating pools.

Archiving data procedures
You can request manual archives from the client, or you can schedule archives from
the server.

Enabling archive services for a NetWorker client
To enable archive services for a NetWorker client:
1. In the Administration window, click Configuration.
2. In the left pane of the Configuration window, select Clients:
a. If you are creating a new client, select New from the File menu.
b. If you are editing an existing client, select the client and then select Properties
from the File menu.
3. On the Globals (2 of 2) tab, enable the Archive Services attribute. When you
enable archive services for one Client resource, archive services are enabled for all
Client resources with the same hostname.
4. In the Archive Users attribute, type all appropriate users. “Enabling or restricting
archive access” on page 206 provides details about setting this attribute.
5. Make the remaining configuration choices as appropriate. The computer is now
an enabled archive client. However, an archive will not occur until it is requested.
“Scheduling data archives” on page 209 provides instructions.
Note: If the NetWorker client is set up for encryption with the aes ASM, archive data will also
be encrypted. “Encrypting backup data” on page 77 provides information about setting up
encryption for a NetWorker client.

Manually archiving data
You can manually archive data at any time. Manually archiving data is similar to
performing a manual backup.
Perform a manual archive from a NetWorker client on Windows
Note: Manual archives that are performed from a Windows client do not enforce global or local
file (nsr.dir) directives. However, local directives (networkr.cfg) that are created with the
NetWorker User program are enforced. Scheduled archives, enforce all directives. For more
information about scheduled archives, see “Scheduling data archives” on page 209.

To perform a manual archive for a Windows client:
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1. In the NetWorker User program, click Archive to open the Archive Options
dialog box.
2. Type a comment in the Annotation attribute. This annotation is used to uniquely
identify each archive save set during retrieval.
Note: Consider adopting a consistent naming convention so that one can easily identify
archives based on the annotation name.

3. From the Archive Pool list, select the appropriate archive pool.
Note: Only pools with their Pool Type attribute set to Archive are listed.

4. Select the appropriate settings for these criteria:
• To write a copy of each archive save set to a volume from an archive clone
pool, select Clone.
• If you enable cloning, type or select an archive clone pool for the Archive
Clone Pool attribute.
• To instruct the NetWorker server to check the integrity of the data on the
storage volume, select Verify.
• To instruct the NetWorker server to remove the archived files from the disk,
select Grooming.
5. Click OK. The Archive browse window appears.
6. From the File menu, select Mark to select each file or directory for archiving.
When you select an item for archiving, a check mark appears next to that item.
Note: To clear an item currently marked for backup, select Unmark from the File menu.

7. From the File menu, select Start Archive.
8. Click OK and the Archive browse window appears. The NetWorker server
appears in the Archive Status window, which monitors the progress of the
archive. When the NetWorker server is finished archiving, a message similar to
this appears in the Archive Status window:
Archive completion time: 2-21-09 5:18p

9. If Groom was selected in step 4 , the Remove Archived File dialog box prompts
for confirmation before NetWorker software deletes archived files from the local
disk.
Perform a manual archive from a NetWorker client on UNIX
To perform a manual archive from a UNIX client, use the nsrarchive command. For
information about this command, refer to the EMC NetWorker Command Reference
Guide or the UNIX man pages.

Scheduling data archives
Unlike scheduled backups, scheduled archives run only once. The advantage of a
scheduled archive is that the archive can be run when network traffic and computer
use is low.

Archiving data procedures
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Scheduling an archive
Before you can schedule an archive request, enable the Archive Services attribute in
the Client resource. “Enabling archive services for a NetWorker client” on page 208
provides more information.
To schedule an archive:
1. In the Administration window, click Configuration.
2. In the left pane, select Archive Requests.
3. From the File menu, select New.
4. In the Name attribute, type a name for the archive request.
5. In the Comment attribute, type a description of the archive request.
6. In the Client attribute, type the archive client’s hostname.
7. In the Save Set attribute, type the pathnames of the files and/or directories to be
archived.
Note: If you archive all of the client’s save sets, set the Grooming attribute (on the
Running tab) to None. If this attribute is set to Remove, all of the archived save sets will be
deleted from the client computer.

8. Type a comment in the Annotation attribute. This annotation is used to uniquely
identify each archive save set during retrieval.
Note: Consider adopting a consistent naming convention so that one can easily identify
archives based on the annotation name.

9. In the Directive attribute, select a directive if special processing is to occur during
the archive process. Chapter 6, “Directives” provides more information about
directives.
10. From the Archive Pool attribute, select the appropriate pool from the list:
• To store the entire save set, select the preconfigured Archive pool. This pool
does not store the client file index.
• To store the client file index in addition to the entire save set, select the
preconfigured PC Archive pool.
11. Select the Running tab.
12. For the Status attribute, indicate a start time for the archive:
• To begin the archive immediately, select Start Now.
• To begin the archive at a specified time, select Start Later and indicate a time
in 24-hour format in the Start Time attribute.
13. For the Archive Completion attribute, type a notification for the NetWorker
server to use after completing the archive. “Notifications” on page 447 provides
details.
14. Select the appropriate response for these options:
• To instruct the NetWorker server to remove the archive files from the disk,
select Remove from the Grooming list.
• To instruct the NetWorker server to check the integrity of the data on the
storage volume, select the Verify attribute.
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• To write a copy of each archive save set to a volume in an Archive Clone pool, select
Yes for the Clone attribute and select an archive clone pool from the Archive Clone
Pool list.
15. Click OK.
To view information about the status of an archive request, open the Archive Request Details
window. “Viewing details of a scheduled archive” on page 215 provides more information.
Copying an Archive Request resource
To copy an Archive Request resource:
1. In the Administration window, click Configuration.
2. In the left pane, select Archive Requests.
3. In the right pane, select the archive request to copy.
4. From the Edit menu, select Copy. The Create Archive Request dialog box displays the
same information as the archive request that was copied, except for the Name attribute.
5. Type the name for the new archive request in the Name attribute, edit any other attributes
as appropriate, and click OK.
For details about the Archive Request attributes, click Field Help in the Properties dialog
box.
Changing the archive time
To change the archive time:
1. In the Administration window, click Configuration.
2. In the left pane, select Archive Requests.
3. In the right pane, select an archive request.
4. From the File menu, select Properties.
5. Click the Running tab.
6. In the Start Time attribute, type a new time in this format:
HH:MM [a,p]

7. Click OK.
You can also schedule an existing archive by using the Schedule Archive operation in the
Activities Monitor. “Archive request management” on page 215 provides more information.
Editing an archive request
To edit an archive request:
1. In the Administration window, click Configuration.
2. In the left pane, select Archive Requests.
3. In the right pane, select an archive request.
4. From the File menu, select Properties.
5. Edit the attributes of the archive request and click OK.
Deleting an archive request
Note: You cannot delete an archive request that is currently in use.

To delete an archive request:
Archiving data procedures
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1. In the Administration window, click Configuration.
2. In the left pane, select Archive Requests.
3. In the right pane, select an archive request.
4. From the File menu, select Delete.

Retrieving archived data
This section describes how to retrieve archived data.

Retrieval permissions
The following restrictions apply when retrieving or recovering archived data:
◆

You must have read permissions to the archived data.

◆

If the Server resource’s Public Archives attribute is enabled, all users listed in the
Client resource’s Archive Users attribute can retrieve data (as long as they have
read permissions to the data).

◆

If the Server resource’s Public Archives attribute is disabled, only the NetWorker
administrator or the owner of the file can retrieve the data.

“Permissions for archiving” on page 206 provides more information.
Note: If, during retrieval, the operating system allows you to change the ownership of archived
data to that of the original owners, then the retrieved files display the original ownership.
Otherwise, the user who retrieves the files becomes the owner of the files.

Retrieving nonindexed archives from a client on Windows
Data that was archived with a nonindexed archive pool (such as the Archive pool)
must be retrieved by the entire save set rather than by file selection.
To retrieve nonindexed archived data:
1. Mount the archive volume in the appropriate storage device.
2. Start the NetWorker User program.
3. From the Operation menu, select Archive Retrieve to open the Source Client
window.
4. Select a client to retrieve the archived data from and click OK. The Archive
Retrieve window opens.
5. For the Annotation String attribute, type all or part of the annotation assigned to
the save set when it was archived.
Note: If no annotation is entered, all archived save sets for the client appear.

6. Click OK. The Save Sets dialog box opens.
7. From the Save Sets dialog box, perform either of these functions, if necessary:
• To view a list of volumes required to retrieve the data from this archived save
set, click Required Volumes.
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• To type a new path for the location of the recovered data and to indicate what
the NetWorker server should do when it encounters duplicate files, click
Recover Options.
8. Select the archived save set to retrieve and click OK. The Retrieve Status window
appears.
Note: You can also recover archived save sets by using save set recovery. “Recovering by save
set selection” on page 325 provides more information.

Retrieving nonindexed archives from a client on UNIX
Data that was archived with a nonindexed archive pool (such as the Archive pool)
must be retrieved by the entire save set rather than by file selection.
To retrieve nonindexed archived data:
1. Mount the archive volume in the appropriate storage device.
2. Start the nwrecover program. Type:
nwrecover -s servername

where servername is the name of the server to use when recovering save sets. The
/servers file, located in /nsr/res/servers, contains an entry for each available
server.
If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, which
allows you to choose the server.
After the server is specified, the nwrecover program displays.
3. From the Options menu, select Recover Archived Save Sets.
4. Mark the save sets to be recovered by selecting the save sets and clicking the
Mark button.
5. Click the Start button on the toolbar.

Recovering indexed archive data from a client on Windows
Data archived by using the Indexed Archive pool and the PC Archive pool maintain
information in the client file index about the individual files in the save set.
The archived files are recovered the same way as nonarchived files. To recover
indexed archived files, the archive must have been saved by using the Indexed
Archive pool, PC Archive pool, or be a custom archive pool with the Store Index
Entries attribute in the Pool resource enabled.
To recover indexed archived data:
1. Start the NetWorker User program.
2. Click Recover to open the Source Client dialog box.
3. Select the source client whose data is to be recovered, and click OK. The local
client is the default selection.
4. Select the destination client for the recovered data, and click OK. The local client
is the default selection.
Retrieving archived data
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5. Select the files to be recovered and click the Mark button.
6. Click Start.

Recovering indexed archive data from a client on UNIX
Data archived by using the Indexed Archive pool and the PC Archive pool maintain
information in the client file index about the individual files in the save set.
To recover indexed archived files, the archive must have been saved by using the
Indexed Archive pool, PC Archive pool, or be a custom archive pool with the Store
Index Entries attribute in the Pool resource enabled.
To recover indexed archived data:
1. Start the nwrecover program. Type:
nwrecover -s servername

where servername is the name of the server to use when recovering the data. The
/servers file, located in /nsr/res/servers, contains an entry for each available
server.
If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, allowing
you to choose the server.
After the server is specified, the nwrecover program appears.
2. From the Options menu, select Recover Archived Files.
3. Mark the files to be recovered by selecting the files and clicking Mark.
4. Click Start.

Retrieving archive data from the command prompt
One can also retrieve archive save sets by using the nsrretrieve command. For more
information, refer to the EMC NetWorker Command Reference Guide or the UNIX man
pages.
To identify an archive for retrieval, use the -A option to specify an annotation for the
archive. However, when you use the -A option you must specify a string that
uniquely identifies one annotation.
Example 24 Using the nsrretrieve command

In this example, suppose that archive A is annotated with Accounting_Fed and
archive B is annotated with Accounting_Local.
◆

If you type this command:
nsrretrieve -A Accounting

No match is found and no archive is retrieved.
◆

If you entered this command:
nsrretrieve -A ting_L

Archive B is located.
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Archive request management
This section describes how to work with scheduled archive requests.

Starting a scheduled archive at any time
You can start a scheduled archive immediately rather than wait for the scheduled start time.
To start a scheduled archive:
1. In the Administration window, click Monitoring.
2. Select the Archive Requests tab.
3. Right-click the archive request and select Start.

Stopping a scheduled archive while in progress
To stop an archive request in progress:
1. In the Administration window, click Monitoring.
2. Right-click the archive request and select Stop.

Disabling a scheduled archive
To disable an archive request:
1. In the Administration window, click Monitoring.
2. Right-click the archive request and select Disable Archive.

Viewing details of a scheduled archive
To open the Archive Request Details window:
1. In the Administration window, click Monitoring.
2. Right-click the archive request and select Show Details.
The Archive Request Details window provides information about the completion of an
archive request:
◆

The Completion Time displays the time the archive finished. This is the difference
between the completion and start times of the archive.

◆

The success of the archive request is either completed, failed, or partial.

Archive request management
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Overview of cloning
Cloning allows for secure offsite storage, transfer of data from one location to another
and verification of backups. Cloning can be performed on volumes and on save sets.
Information about the volumes, status, and history of cloning operations can be
viewed and monitored from the Administration window. Clone-related messages are
also logged to the NetWorker message file and the savegrp log file, which are located
in the <NetWorker_install_dir>\logs directory. “Viewing log files” on page 661
provides information about viewing log files.
There are two main methods of cloning:
◆

Save set cloning:
Save sets can be cloned based on a schedule or on-demand by manual selection.
“Save set cloning” on page 218 provides more information.

◆

Volume cloning:
Backup volumes can be cloned on demand by manual selection. “Volume
cloning” on page 227 provides more information.

Note: Cloning works differently for deduplication devices. The NetWorker Avamar
Integration Guide and the NetWorker Data Domain Depulication Devices Integration Guide
provides more information.

Cloning requirements
The following requirements apply when performing cloning operations:
◆

A minimum of two storage devices must be enabled: one to read the existing data
and one to write the cloned data:
• If libraries with multiple devices are used, the NetWorker server mounts the
volumes required for cloning automatically.
• If stand-alone devices are used, mount the volumes manually. A message
displays in the Alert tab of the Monitoring option that indicates which
volumes to mount.

◆

The destination volume must be a different volume from the source volume, and
must belong to a clone pool.

◆

You must be a member of the NetWorker Administrators group. “NetWorker
User Groups” on page 442 provides information.

◆

Only one clone of a particular save set can reside on a single volume. Therefore, if
three clones of the same save set are specified, each clone is written to a separate
volume.

Save set cloning
Prior to NetWorker 7.6 Service Pack 1, the user interface options to set up a scheduled
clone operation were limited in flexibility and were prone to performance issues.
These types of scheduled clones were linked to regular backup group operations and
were enabled through the backup group resource. The only option to get around
these limitations was to use the nsrclone command with scripted solutions.
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In NetWorker 7.6 Service Pack 1 and later, a new Clone user interface option is
available for scheduled clone operations. The new clone option has most of the
flexibility of the nsrclone command and avoids the performance limitations often
associated with the legacy automatic cloning method.
The following topics are included in this section:
◆

“Considerations for scheduled clone jobs” on page 219

◆

“Setting up a schedule clone job” on page 220

◆

“Starting a scheduled clone job manually” on page 222

◆

“Monitoring scheduled clone jobs” on page 222

◆

“Setting up automatic cloning from a backup group” on page 222

◆

“Viewing the clone status of a save set” on page 223

◆

“Cloning a save set manually” on page 223

◆

“Additional manual clone operations” on page 225

Considerations for scheduled clone jobs
Be aware of the following considerations when setting up scheduled clone jobs:
Scheduling multiple clone jobs to start at the same time
Do not schedule more than 30 clone jobs to start at the same time. Scheduling 30 or
more clone jobs to occur at the same time may result in some clone jobs timing out
and not completing.
Mixing save sets from different source devices
Clone operations that mix save sets from different source devices, such as Data
Domain devices, AFTD devices, or NDMP devices, may be written to different target
volumes. Although this behavior is by design, you may prefer to write all save sets in
the clone operation to the same clone volume.
If the clone operation includes save sets from different devices, and you want all save
sets to be written to the same volume, include only one volume in the clone target
pool.
Unmounted clone source volumes on remote storage nodes
If the clone source volume is on a remote storage node and is unmounted, attempting
to start a regular volume clone operation will not complete successfully, even if the
source volume is mounted after the clone operation attempts to start. The clone
program nsrclone will hang with the following message:
Server <server_name> busy, wait 30 second and retry

This issue does not occur in the following situations:
◆

If the storage node is on the NetWorker server, that is, when the storage node is
not remote.

◆

If performing a clone controlled replication (optimized clone) operation.

PowerSnap module and scheduled cloning
To set up a scheduled clone for a PowerSnap module backup, you must specify the
backup group to which the PowerSnap backup belongs. When setting up a scheduled
clone job, specify the backup group in the Save Set Filters tab.

Save set cloning
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Clone resources that are created with the nsradmin program
Clone resources (known as NSR clone resources) that are created with the nsradmin
command line program cannot be edited as scheduled clone resources in the
NetWorker Administration graphical user interface.
To avoid this issue, perform one of the following:
◆

Create scheduled clone resources in the Administration interface. “Setting up a
schedule clone job” on page 220 provides more information.

◆

If you must create a NSR clone resource with the nsradmin program, create a
corresponding NSR task resource with the nsradmin program. Together, these
resources will enable you to edit the clone item as a scheduled clone resource in
the GUI. The corresponding NSR task resource must have its name and action
attributes specified as follows:
• name: “clone.nsrclone_resource_name”
• action: “NSR clone:nsrclone_resource_name"
For example, if the NSR clone resource was named TestClone1, the name and
action attributes of the NSR task resource would be:
• name: clone.TestClone1
• action: NSR clone: TestClone1

These entries are case-sensitive.

Setting up a schedule clone job
To set up a scheduled clone operation:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clones.
3. From the File menu, select New.
4. In the Name attribute, type a unique name to identify the scheduled clone
resource. Type additional information in the Comment attribute if necessary.
5. If you wish to override the saveset’s original browse and retention policies, select
new policies in the Browse and Retention policies attributes.
6. To specify the storage node that will write data during the clone operation, select
a storage node from the Storage node to WRITE save sets attribute. If a selection
is made in this attribute, it will override any selection criteria that is described in
“Storage node selection criteria for writing the clone” on page 231.
This attribute is used primarily in conjunction with the Storage node to READ
save sets attribute to balance access to storage media across different storage
nodes.
7. To specify the storage node that will read data during the clone operation, select a
storage node value from the Storage node to READ save sets attribute. This
attribute is visible only when Diagnostic mode is selected. Additionally, the
selected storage node must be included in at least one of the following:
• The Recover storage nodes or Storage nodes attribute of the NetWorker
server’s client resource.
• The storage node listed in the Read Hostname attribute for the library
resource, if a library is being used.
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• A storage node on which any device in the library is configured, if a library is
being used.
This attribute is used primarily in conjunction with the Storage node to WRITE
save sets attribute to balance access to storage media across different storage
nodes and is not intended for use with standalone devices such as AFTD’s, file
type devices, Data Domain devices, and so on.
8. To specify the clone media pool to write data to during a clone operation, select a
clone type media pool from the Write clone data to pool attribute. If no selection
is made, clones will be written to the default clone pool.
Pools are used to direct backups to specific media volumes. This attribute is
particularly useful when you want to ensure that only certain media types are
used to hold clone data. For example, to ensure that this clone job only replicates
to a certain type of disk, such as a Data Domain type disk, select a clone pool that
uses only Data Domain type disks. Likewise, to ensure that this clone job only
replicates to tape (tape out), select a clone pool that uses only tape devices.
9. Select Continue on save set error to force NetWorker to skip invalid save sets and
to continue the clone operation. If this option is not selected (default setting), an
error message will be generated and the clone operation will not continue if an
invalid save set or invalid volume identifier is encountered.
10. To restrict the number of clone instances that can be created for any save set that is
included in this particular scheduled clone operation, type a value in the Limit
number of save set clones attribute. A value of zero (0) means that an unlimited
number of clones may be created for this scheduled clone operation.
Consider limiting the number of save set clones in cases where the clone
operation has not completed and is being retried. For example, if you type a value
of 1 in this attribute and then retry a partially completed clone operation, only the
save sets that were not successfully cloned the first time will be eligible for
cloning. In this way, unnecessary clone instances will not be created.
Regardless of the value in this attribute, NetWorker always limits the number of
save set clone instances to one per volume. A clone pool can have multiple
volumes. This attribute limits the number of save set clone instances that can be
created for a clone pool in a particular scheduled clone operation.
11. Select Enable to allow the clone job to run at its scheduled time.
12. In the Start Time attribute, click the up and down arrows to select the time to start
the clone job. Alternatively, type the time directly into the attribute fields.
13. From the Schedule Period attribute, select Weekly by day or Monthly by day
depending on how you want to schedule the clone job and then select the day(s)
of the week or month on which the scheduled clone is to occur.
14. To repeat the clone job within a day, specify an Interval time in hours. For
example, if the start time is 6 AM, and the interval is 6 hours, then the clone job
will run at 6 AM, 12 PM, and 6 PM.
If the Limit the number of save set clones value is set, then the repeat clone job
will fail after the limit is reached.
15. Select the Save Set Filters tab to specify the save sets to be included in this
scheduled clone job.
16. Select Clone save sets that match selections to limit save sets by various filter
criteria or select Clone specific save sets to explicitly identify the save sets to be
cloned.
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To clone save sets that match selection criteria:
• Specify selection criteria to limit the save sets that will be included in this
scheduled job. You can select the following criteria:
– Groups (save groups)
Required for PowerSnap clones.
– Clients (client resources)
– Pools (backup pools)
– Filter save sets by level (backup level)
– Filter save sets by name (save set name as specified in the client resource)
– Include save sets from the previous (save sets from the past number of
days, weeks, months, or years)
To display a list of the save sets that will be cloned based on the filter criteria that
you specified, select Preview Save Set Selection.
To clone specific save sets:
• Type the specific save set ID/ clone ID (ssid/clonid) identifiers in the Clone
specific save sets list box. Type each ssid/cloneid value on a separate line.
You can query save set IDs / clone IDs through the Administration > Media
user interface or by using the mminfo command. “Querying the media
database” on page 457 provides more information.
17. Select OK to save the scheduled clone job.

Starting a scheduled clone job manually
You can start a scheduled clone job at any time without affecting the regularly
scheduled start time.
To start a scheduled clone job manually:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clones.
3. Right-click on a clone resource in the right-pane and select Start.
You can also start a scheduled clone from the NetWorker Monitoring feature, which is
described in “Clones window” on page 396.

Monitoring scheduled clone jobs
You can view the status of scheduled clone jobs in the Monitoring window. You can
view the scheduled clone’s last start and end time and you can view the completion
status of each save set that is included in the scheduled clone. “Clones window” on
page 396 provides more information.

Setting up automatic cloning from a backup group
You can use the legacy method for setting up an automatic clone operation based on
the backup group resource. The clone operation will begin after all of the backups for
the group have completed. All of the save sets that are associated with the group will
be backed up. However, be aware that this method lacks the flexibility of the method
described in “Setting up a schedule clone job” on page 220.
To automatically clone the save sets that belong to a group resource:
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1. From the Administration window, click Configuration.
2. In the expanded left pane, select Groups.
3. Select the group in the right-pane.
4. From the File menu, select Properties.
5. In the Setup tab, select:
• The Clones attribute
• A value from the Clone pool attribute.
The clone operation will begin after all the save sets in the group have been
backed up.

Viewing the clone status of a save set
To determine whether a save set on a volume has been cloned, or is itself a clone,
check the Query Save Set tab window. “Cloning a save set manually” on page 223
provides more information.

Cloning a save set manually
To manually clone a save set, first query the database, select the save set, and begin
the cloning operation.
To manually clone a save set:
1. From the Administration window, click Media.
2. In the expanded left pane, select Save Sets.
3. In the right pane, select the Query Save Set tab. Use the Query Save Set tab to
specify options to limit the range of save sets displayed. All query options are
optional except for the date. A date range must be selected.
Note: The text boxes in the Query Save Set tab are case-sensitive.

4. Type values in any of these attributes to limit the search:
• Client Name
• Save Set
• Save Set ID
• Volume
• Pool
5. Use the Copies attribute to limit the search to only those save sets that have
already been cloned:
a. Select a boolean value of greater than (>), equal to (=), or less than (<) from the
list.
b. Type the number of clones to complete the search criteria for the Copies
attribute.
For example, to search for only those save sets that have been cloned at least
twice, select greater than (>) and then type 1 as the number of copies.
6. Use the Save Time attribute to limit the search to a period of time in which the
save set was created.
Save set cloning
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By default, yesterday is used for the start date, and today is used for the end date.
This means that save sets backed up between yesterday at 12:01 A.M. and the
current time will be displayed.
For the From and To date fields, any of these formats are acceptable:
• Written out completely (for example, November 1, 2009)
• Numerically as mm/dd/yy (for example, 11/01/09)
• Date and time selection from the list.
A long date range may result in too many selected save sets. This can increase
response time or even require that you close and reopen the browser connection
to the NetWorker Console.
7. Use the Status attribute to limit the search to save sets that have a particular
status. Table 34 on page 224 lists the values that can be selected.
Table 34

Save set status settings

Status

Description

All

Select all options listed under Select from in the Status area.

Select from

Select one or more of the following options:
• Browsable: Select if the save set still has an entry in the client file index.
• Recyclable: Select if all save sets have passed both the browse and retention policy
time periods; the volume may now be available for automatic relabeling and overwriting
(provided all save sets on the volume are recyclable).
• Recoverable: Select if the entry for the save set has been removed from the client file
index, but is still available for recovery from the media (that is, the volume has not
passed its retention policy).
• In-progress: Select if the save set is currently in the process of being backed up.
In-progress save sets cannot be cloned.
• Aborted: Select if the save set was either aborted manually by the administrator during
a backup, or because the computer crashed. Aborted save sets cannot be cloned.
• Suspect: Select if a previous attempt to recover the save set failed.

8. Use the Maximum Level attribute to limit the search to save sets of a particular
backup level.
The level All is specified by default. All the levels up to and including the selected
level are displayed. For example:
• If you select level 5, save sets backed up at levels full, 1, 2, 3, 4, and 5 are
displayed.
• If you select level Full, only those save sets backed up at level full are
displayed.
• If you select All, save sets for all levels are displayed.
9. Click the Save Set List tab.
The save sets that fit the criteria appear in the Save Sets list.
10. Select the save sets to clone from the Save Set list.
11. From the Media menu, select Clone.
12. From the Target Clone Media Pool list, select a clone pool.
13. Click OK, then click Yes on the confirmation screen.
“Viewing manual clone history” on page 225 provides information on viewing the
status of a manual clone operation or to cancel a clone operation that is in progress.
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Example 25 Manual cloning of a save set

In this example, a user has requested that the NetWorker administrator manually
clone several save sets that are not included in an automatic cloning schedule.
The user must send the data to another company located out of country. The
administrator must clone the most recent full backup, and any incrementals since the
last full backup, to make sure that the most current data is sent.
To clone the save set, the NetWorker administrator must have this information:
◆

NetWorker client name

◆

Name of the save set

◆

Date the data was backed up

To manually clone the save sets:
1. From the Administration window, click Media.
2. In the expanded left pane, select Save Sets.
3. In the right pane, select the Query Save Set tab.
4. In the Client Name attribute, type the client name.
5. In the Save Set attribute, type the save set name.
6. For the Start Date and End Date, type the dates used for the search.
Note: In this case, the administrator does not need to change or select any status choices
other than the defaults.

7. Click the Save Set List tab. All save sets that meet the selection criteria appear in
the Save Sets list.
8. Select the save sets to clone.
9. From the Save Set List, determine the size of the data and the original volume
that contains the data to be cloned.
10. Mount the original volume.
11. From the Media menu, select Clone.
12. From the Target Clone Media Pool list, select a clone pool.
13. Click OK and then click Yes on the confirmation screen.

Additional manual clone operations
This section covers operations that can be performed on both volumes and save sets
that have been manually cloned. “Volume cloning” on page 227 or “Save set cloning”
on page 218 provide information about manually cloning a volume or save set.
Viewing manual clone history
To view history information about manual clone operations:
1. From the Administration window, click Monitoring.
2. From the Monitoring menu, select Show Manual Clone History.
A dialog box appears that shows manual clone history information.
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Stopping a manual clone operation
To stop a manual clone operation that is in progress:
1. From the Administration window, click Monitoring.
2. From the Monitoring menu, select Show Manual Clone History.
3. Select the clone operation to be stopped.
4. Click Stop Selected Operation.
The manual clone operation is stopped.

Specifying browse and retention policies for clone data
The browse and retention policy for clone data can be specified independently of the
original save set. In this way, clone data can be browsed and recovered after the
policies of the original save set have expired.
To specify the browse or retention policy for clone data, perform one of the following:
◆

Specify a browse and retention policy in a scheduled clone job

◆

Specify a retention policy in the Clone pool.

◆

Specify a retention policy from the command prompt.

Specify a browse and retention policy in a scheduled clone job
To specify a browse and retention policy in a scheduled clone job:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clones.
3. From the File menu, select Properties.
4. Select new policies in the Browse and Retention policies attributes. When the
scheduled clone job is next run, the cloned save sets will be given the new browse
and retention policies.

Specify a browse and retention policy from the command prompt
To specify a retention policy from the command prompt, perform one of the
following:
◆

Use the nsrclone command with the -y option when creating a clone save set.

◆

Specify a retention policy for an existing clone save set by using the nsrmm -e
command.

To specify a browse policy from the command prompt:
◆

Use the nsrclone command with the -w option when creating a clone save set.
However, be aware that this will also change the browse policy of the original
save set instance if the original save set’s browse time has not passed and is
earlier than the new browse time for the clone.

Specify a retention policy for a Clone pool
You can only specify a retention policy for cloned data in a pool resource.
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To specify a retention policy for a Clone pool:
1. In the clone pool to which clone backups will be directed, select the
Configuration tab.
2. From the Retention policy list, select a retention policy, then click OK.
“Configuring media pools” on page 189 provides information about editing or
creating a pool.
Note: Retention policies that are specified in a scheduled clone job or from the command
prompt, override the retention policy specified in a clone pool.

Volume cloning
Volume cloning is the process of reproducing complete save sets from a storage
volume to a clone volume. You can clone save set data from backup or archive
volumes.

Creating a clone volume
To create a clone volume:
1. From the Administration window, click Media.
2. In the expanded left pane, select Volumes.
3. In the right pane, select the volume to be cloned.
4. From the Media menu, select Clone.
5. From the Target Clone Media Pool list, select a clone pool.
6. Click Ok, then click Yes on the confirmation screen.

Viewing clone volume details
You can view the details of a clone volume, such as the amount of space used, mode,
expiration date, pool, and save sets.
To view clone volume details:
1. From the Administration window, click Media.
2. In the expanded left pane, select Volumes.
3. In the right pane, details for each volume are displayed in the table.
4. To view save set information for a volume:
a. In the right pane, select a volume.
b. From the Media menu, select Show Save Sets.

Recovering cloned data
No special operation is required to recover cloned data. The volume, either a clone or
original volume, that is selected for a recovery operation is determined as follows:
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1. The highest priority is given to the volume (clone or original volume) that has a
complete, non-suspect save set status. A complete save set that is suspect has a
higher priority than an incomplete non-suspect save set.
“Changing save set status within the Volume Save Sets window” on page 311
provides information about changing the status of a save set.
2. If the volumes still have equal priority, then priority is given to the mounted
volume.
3. If the volumes are mounted, then priority is based on the media type. The media
types from highest to lowest priority are:
a. Advanced file type device
b. File type device
c. Other (such as tape or optical)
4. If the volumes are not mounted, then priority is based on the media location. The
media locations from highest to lowest priority are:
a. Volumes in a library
b. Volumes in an AlphaStor or SmartMedia controlled library
c. Volumes that are not in a library but are onsite (offsite flag is not set).
d. Volumes that are offsite (offsite flag is set)
Use the nsrmm command to specify that a volume is offsite. For example:
nsrmm -o offsite -V volume_id
The volumes required for recovery appear in the Required Volumes window of the
nwrecover (UNIX) or NetWorker User (Windows) programs. “Viewing the volumes
required for data recovery” on page 324 provides more information.
You can also run the scanner program on a clone volume to rebuild entries in the
client file index, the media database, or both. After you re-create the entries, normal
recovery is available. “Restore a save set entry in the online indexes” on page 338
provides more information.

Recovering a cloned save set from the command prompt
Recovery of a cloned save set can be performed at the command prompt, for example:
recover -S ssid/cloneid

The EMC NetWorker Command Reference Guide or the UNIX man pages provide more
information about the recover command.

Recovering a save set when all cloned instances have expired
When all cloned instances of a save set have passed their retention period, the
following procedure must be used to mark a save set as eligible for recovery:
1. Use the nsrmm command with the -e time option to change the retention time for
the clone save set:
nsrmm -e time -S ssid/cloneid

If the cloneid is not identified with the -S option, the following error message is
displayed:
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Save set ssid cannot be marked as notrecyclable. Please specify the
ssid/cloneid of the particular clone instance.

2. Use the nsrmm command with the -o notrecyclable option to instruct the media
database that the save set is no longer expired:
nsrmm -o notrecyclable -S ssid/cloneid

If the -o notrecycable option is used with nsrmm prior to changing the retention
time as described in step 1 , the following error message is displayed:
nsrmm: Save set ssid:ssid cloneid:cloneid eligibility cannot be
cleared, retention time must be adjusted first

After this procedure has been completed, the save set is recoverable.

Cloning archived data
You can schedule a clone job to clone archive data or clone archive data on-demand.
To set up a scheduled clone job for archive data:
◆

Follow the steps in “Setting up a schedule clone job” on page 220 and select an
archive pool as one of your save set filter criteria.

To clone an archive volume on-demand:
1. From the Administration window, click Media.
2. In the expanded left pane, select Save Sets.
3. In the right pane, select the Query Save Set tab.
4. In the Pool attribute, select an archive pool from the list. Make other selections, as
appropriate, to limit the save set search criteria. “Cloning a save set manually” on
page 223 provides more information.
5. Click the Save Set List tab.
6. Select the archive save sets to clone from the Save Set list.
7. From the Media menu, select Clone.
8. From the Target Clone Media Pool list, select an archive clone pool.
9. Click OK and then click Yes on the confirmation screen.

Directing clones to a special storage node
You can direct clone operations to a specific storage node. This section describes the
criteria used to determine the storage node from which the clone data is read (read
source) and the storage node to which the clone data is written (write source).

Storage node selection criteria for reading the clone data
The following logic is used to determine the storage node from which the clone data
will be read (read source):
1. If the source volume is mounted, then the storage node of the device on which the
volume is mounted is used as the read source.

Cloning archived data
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• If the FORCE_REC_AFFINITY environment variable is set to Yes, the selection
criteria in step 1 is ignored and the selection criteria behaves as though the
volume is not mounted as described in step 2.
• When cloning is used in a Virtual Tape Library (VTL) environment such as a
CLARiiON Disk Library (CDL), the NetWorker software behaves as if the
FORCE_REC_AFFINITY environment variable is set to Yes.
2. If the volume is not mounted or if the FORCE_REC_AFFINITY environment
variable is set to Yes, a list of eligible storage nodes is created. The list is based on
the storage nodes that meet the criteria in both step a and step b that follow:
a. The storage nodes listed in the Recover Storage Nodes attribute of the
NetWorker server’s client resource. If this attribute is empty, the NetWorker
server's Storage Nodes attribute is used.
b. If the requested volume is in a media library, the storage nodes on which the
volume can be mounted are determined in the following manner:
– The storage node listed in the Read Hostname attribute for the library
resource is used.
– If the Read Hostname attribute for the library resource is not set, then all
storage nodes on which any device in the library is configured is added to
the list of eligible storage nodes.
– If the volume is not in a media library, then the list of storage nodes is
based on step a only.
Example 26 Selecting a storage node read source

In this example, the volume resides in a media library and is not mounted. The
Recover Storage Nodes attribute in the NetWorker server’s Client resource lists the
following storage nodes in order:
◆

Storage node F

◆

Storage node E

◆

Storage node D

The Read Hostname attribute for the library resource is not set, however, the
following devices in the media library are configured with storage nodes:
◆

Device A is configured on storage node D

◆

Device B is configured on storage node E

◆

Device C is configured on storage node B

The list of eligible storage nodes is the intersection of the two previous lists. Therefore
the list of eligible storage nodes is as follows:
◆

Storage node E

◆

Storage node D

The order in which the storage node is selected is based on the order of the Recover
Storage Node attribute list. In this example, storage node E is selected first as the read
source storage node. If storage node E is not available, then storage node D is
selected.
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In this example, if no matching storage nodes were found in the intersecting list, an
error would be written to the daemon log file that indicates no matching devices are
available for the operation. To correct the problem, make adjustments so that at least
one matching storage node can be found in both lists. “Viewing log files” on page 661
provides information about viewing log files.

Storage node selection criteria for writing the clone
The following criteria are used to determine the storage node to which the clone data
will be written (write source):
1. The Clone Storage Node attribute of the read source storage node’s Client
resource is used as the write source.
2. If the read source host does not have a Client resource, the Clone Storage Node
attribute of the NetWorker server is used as the write source. Otherwise, the
Storage Nodes attribute of the NetWorker server is used as the write source.
No matter where cloned data is directed, the client file index and media database
entries for the cloned save sets still reside on the NetWorker server. This ensures that
browse and retention policies are handled consistently regardless of where the clone
data was directed.
Directing a clone from one storage node to another storage node
To direct a clone from one storage node to another:
1. Open the Client resource for the read source storage node. “Editing a client” on
page 470 provides more information.
2. Click the Globals (2 of 2) tab.
3. In the Clone Storage Nodes attribute, add the hostname of the storage node to
which the clone data will be written. The first entry in the list that has a
functional, enabled device will receive the cloned data from the read source
storage node.
The Clone Storage Nodes attribute applies only to NetWorker servers and storage
nodes. Leave this attribute blank for NetWorker clients that are not also NetWorker
servers or storage nodes.
Directing clones from all storage nodes to a single storage node
To direct clones from all storage nodes to a single storage node:
1. On the Client resource for each storage node, leave the Clone Storage Nodes
attribute blank.
1. Open the Client resource for the NetWorker server. “Editing a client” on
page 470 provides more information.
2. Click the Globals (2 of 2) tab.
3. In the Clone Storage Nodes attribute, add the hostname of the storage node to
which all cloned data is to be written.

Directing clones to a special storage node
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Storage node selection criteria for recovering cloned data
The following logic is used to determine the storage node from which the clone data
will be recovered:
1. If the source volume is mounted, then the storage node of the device on which the
volume is mounted is used as the read source.
If the FORCE_REC_AFFINITY environment variable is set to Yes, the selection
criteria in step 1 is ignored and the selection criteria behaves as though the
volume is not mounted as described in step 2.
When cloning is used in a Virtual Tape Library (VTL) environment such as a
CLARiiON Disk Library (CDL), the NetWorker software behaves as if the
FORCE_REC_AFFINITY environment variable is set to Yes.
2. If the volume is not mounted or if the FORCE_REC_AFFINITY environment variable
is set to Yes, a list of eligible storage nodes is created. The list is based on the
storage nodes that meet the criteria in both step a and step b that follow:
a. The storage nodes listed in the Recover Storage Nodes attribute of the
NetWorker client resource that is being recovered. If this attribute is empty,
the NetWorker client’s Storage Nodes attribute is used.
b. If the requested volume is in a media library, the storage nodes on which the
volume can be mounted are determined in the following manner:
– The storage node listed in the Read Hostname attribute for the library
resource is used.
– If the Read Hostname attribute for the library resource is not set, then all
storage nodes on which any device in the library is configured is added to
the list of eligible storage nodes.
– If the volume is not in a media library, then the list of storage nodes is
based on step a only.
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Using file type devices for clone operations
This section discusses issues related to cloning with file type and advanced file type
devices.

Differences in the cloning process
There are differences in the cloning process for the two types of devices:
◆

For file type devices, automatic and manual cloning begins only after all the save
sets in a savegroup have been backed up.

◆

For advanced file type devices, automatic cloning begins only after all the save
sets in a savegroup have been backed up. However, you can begin manually
cloning a save set as soon as it has finished its backup.

Manual cloning with advanced file type device
In a situation where there are three save sets:
◆

Save set A has a size of 10 KB

◆

Save set B has a size of 10 MB

◆

Save set C has a size of 10 GB

When save set A has completed its backup, you can begin the manual cloning process
while the other two larger save sets are still being backed up.
As each save set is backed up, you can launch the cloning process for that save set.
You can only clone one save set at a time.

Backup-to-tape for Avamar deduplication clients
The NetWorker Avamar Integration Guide provides more information.

Cloning with Data Domain devices
Data Domain devices were introduced in NetWorker 7.6 Service Pack 1 and enable
one to perform clone controlled replication (optimized cloning) from one Data
Domain device to another. You can also clone to tape or to any other device type.
Clone operations with Data Domain devices are set up in basically the same way as
any other scheduled clone operation, which is described in “Setting up a schedule
clone job” on page 220. However, there are some special considerations to be aware
of when setting up Data Domain devices. These are described in the EMC NetWorker
Data Domain Devices Integration Guide.

Using file type devices for clone operations
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Using the nsrclone command
As of NetWorker 7.5, the nsrclone command has been enhanced to provide greater
flexibility in selecting save sets for cloning by clients, groups, save set names, save set
levels, and by number of valid copies or clones not yet created in the target pool.
Also, be aware that as of NetWorker 7.6 Service Pack 1, most of the functionality
provided in the nsrclone command is now provided in the Clone resource user
interface. “Setting up a schedule clone job” on page 220 provides more information.
Table 35 on page 234 provides the descriptions of the new options, in NetWorker 7.5,
that can be used with the nsrclone command.
Table 35

Examples

List of nsrclone options and their descriptions
Options

Description

-C less than copies in target pool

Specifies the upper non-inclusive integer limit such that only save sets with a
lesser number of clone copies in the target clone pool are considered for
cloning. This option is useful when retrying aborted clone operations.
Because the target is a clone pool, each save set's original copy or clone is
never considered when counting the number of copies of the save set.
Likewise, any AFTD read-only mirror clone is not considered because its
read or write master clone is counted and there is only one physical clone
copy between the related clone pair. Recyclable, aborted, incomplete and
unusable save set or clones are excluded in the counting. This option can
only be used with the -t or -e option.

-l level or range

Specifies the level or n1-n2 integer range from 0 to 9 for save sets that are
considered for cloning. Manual for ad-hoc or client-initiated save sets, full for
level full save sets, incr for level incremental save sets, and integers 0
through 9, where save set0 also means full, can be used. More than one level
can be specified by using multiple -l options and the -l n1-n2 range format.
This option can only be used with the -t or -e option.

-N save set name

Specifies the save set name for save sets that are considered for cloning.
More than one save set name can be specified by using multiple -N options.
This option can only be used with the -t or -e option.

-c client name

Specifies the save sets in the particular client. More than one client name
can be specified by using multiple -c options. This option can only be used
with the -t or -e option.

-g group name

Specifies the save sets in the particular group. More than one group name
can be specified by using multiple -g options. This option can only be used
with the -t or -e option.

The following examples show how various options can be used with the nsrclone
command:
Copy all save sets created in the last twenty-four hours for clients mars and jupiter
with save set names /data1 and /data2 for only backup level full:
nsrclone -S -e now -c mars -c jupiter -N /data1 -N /data2 -l full

Copy all save sets that were not copied to the default clone pool in a prior partially
aborted nsrclone session:
nsrclone -S -e now -C 1

Copy all save sets that were not copied to the default clone pool in a previous
partially aborted nsrclone session and with extended retention and browse periods:
nsrclone -S -e now -C 1 -y 12/12/2010 -w 12/12/2009
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This chapter covers these topics:
◆
◆

Save set staging............................................................................................................ 236
Working with staging policies................................................................................... 236

Staging Backups

235

Staging Backups

Save set staging
Save set staging is the process of transferring data from one storage medium to
another medium, and then removing the data from its original location. For example,
the initial backup data can be directed to a high performance file type or advanced
file type device. In this way, the backup time is reduced by taking advantage of a file
or advanced file type device. At a later time, outside of the regular backup period, the
data can be moved to a less expensive but more permanent storage medium, such as
magnetic tape. After the backup data is moved, the initial backup data can be deleted
from the file or advanced file type device so that sufficient disk space is available for
the next backup.
A save set can be staged from one disk to another as many times as required. For
example a save set could staged from disk 1, to disk 2, to disk 3, and finally to a
remote tape device or cloud device. Once the save set is staged to a tape or cloud
device, it cannot be staged again. However, you could still clone the tape or cloud
volume.
Staging can be driven by any of the following:
◆

Calendar-based process, such as keeping the save set for 30 days on the staging
device before moving the data to the next device.

◆

Event-based process, such as when available space in the staging pool drops
below a set threshold. When this happens, the oldest save sets are moved until
available space reaches a preset upper threshold.

◆

Administrator-based process, such as allowing the administrator to either reset
the threshold or manually select save sets to stage.

Staging does not affect the retention policy of backup data. Therefore, staged data is
still available for recovery.
When the nsrstage process encounters an error after successfully cloning specified
save sets, it deletes only those successful save sets from the source volume before the
program is aborted. This ensures that only a single set of save sets exist in either of
the source or clone volumes after staging.

Working with staging policies
This section describes how to work with staging policies.
Chapter 11 page 242 provides information on advanced file type device (AFTD) and
file type (FTD) configuration. The NetWorker Data Domain Deduplication Devices
Integration Guide provides more information on NetWorker data domain devices.

Creating a staging policy
Before creating a staging policy configure all appropriate devices. Otherwise, no
devices will be listed in the Devices attribute.
To prevent an advanced file type device from becoming full during backup, the
staging policy must be set up so that save sets are automatically moved to another
medium to make disk space available in the advanced file type device.
To create a staging policy:
1. In the Administration window, click Configuration.
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2. In the left pane, select Staging.
3. From the File menu, select New.
4. In the Name attribute, type a name for the staging policy.
5. In the Comment attribute, type a description of the staging policy.
6.

To enable staging to begin immediately or to be invoked automatically at a later
time, set the Enabled attribute to Yes.
Note: You can enable or disable staging at any time.

7. In the Devices attribute, select the file type and adv_file type devices as the
source device for staging.
Note: The adv_file device and its corresponding _AF_readonly device will both be selected
automatically, even if only one device was selected as the source of staging.

You can assign multiple devices to the staging policy, but a given device cannot
be controlled by more than one staging policy.
8. For the Destination Pool attribute, select the destination pool for the staged data.
Note: The Default volume can only be staged to the Default or Default Clone pool.
Similarly, the Default Clone volume can only be staged to the Default or Default Clone
pool and Archive data can only be staged to the Archive Clone pool. The other volume
types can be staged to any pool. If the Clone pool you have selected is restricted to storage
node devices, you will also need to modify Clone Storage Node attribute of the Client
resource for the NetWorker server to include the storage node name.

9. In the High-Water Mark (%) attribute, type or select a number.
This value is the point at which save sets should be staged, measured as the
percentage of available space used on the file system partition that the file device
is on. Staging continues until the low-water mark is reached (see step 10 ).
Note: The high-water mark must be greater than the low-water mark.

10. In the Low-Water Mark (%) attribute, type or select a number. This is the point at
which the staging process will stop, measured as the percentage of available
space on the file system partition that the file device is on.
11. From the Save Set Selection attribute, select from the list to determine the save
set selection criteria for staging.
12. In the Max Storage Period attribute, type the number of hours or days for a save
set to be in a volume before it is staged to a different storage medium.
Note: The Max Storage Period attribute is used in conjunction with the File System Check
Interval attribute. Once the Max Storage Period value is reached, staging does not begin
until the next file system check.

13. In the Max Storage Period Unit attribute, select Hours or Days.
14. In the Recover Space Interval attribute, type the number of minutes or hours
between recover space operations for save sets with no entries in the media
database from file or advanced file type devices.
15. In the Recover Space Interval Unit attribute, select Minutes or Hours.
Working with staging policies
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16. In the File System Check Interval attribute, type the number of minutes or hours
between file system checks.
Note: At every File System Check interval, if either the High-Water Mark or Max Storage
Period has been reached, a staging operation is initiated.

17. In the File System Check Interval Unit attribute, select Minutes or Hours.
18. To invoke the staging policy immediately, complete this step. Otherwise, skip this
step.
a. Select the Operations tab.
b. In the Start Now attribute, select one of these operations:
– Recover space — Recovers space for save sets that have no entries in the
media database and deletes all recycled save sets.
– Check file system — Checks file system and stage data, if necessary.
– Stage all save sets — Stages all save sets to the destination pool.
The selected operation applies to all devices associated with this policy.
Note: The choice you make takes effect immediately after clicking OK. After the staging
operation is complete, this attribute returns to the default setting (blank).

19. When all the staging attributes are configured, click OK.

Editing a staging policy
To edit a staging policy:
1. In the Administration window, click Configuration.
2. In the left pane, select Staging.
3. In the right pane, select the Staging policy to edit.
Note: You cannot edit the name of an existing staging policy.

4. From the File menu, select Properties.
5. Make any necessary changes and click OK.

Copying a staging resource
To copy an Staging resource:
1. In the Administration window, click Configuration.
2. In the left pane, select Staging.
3. In the right pane, select the Staging resource to copy.
4. From the Edit menu, select Copy. The Create Staging dialog box appears,
containing the same information as the Staging resource that was copied, except
for Name attribute.
5. Type the name for the new Staging resource in the Name attribute, edit any other
attributes as appropriate, and click OK.
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Deleting a staging policy
Note: The Default staging policy cannot be deleted.

To delete a staging policy:
1. In the Administration window, click Configuration.
2. In the left pane, select Staging.
3. Remove all devices from the Staging policy.
a. In the right pane, select the Staging policy to be deleted.
b. From the File menu, select Properties.
c. In the Devices attribute, ensure that all listed devices are unselected.
d. Click OK.
4. In the right pane, select the Staging policy to be deleted.
5. From the File menu, select Delete.
6. When prompted, click Yes to confirm the deletion.

Consideration for staging a bootstrap backup
Bootstrap backups can be directed to a disk device such as an AFTD or FTD device.
However, if a bootstrap backup is staged to another device, the staging operation will
complete and will be reported as complete even though the "recover space" operation
will not be executed. This means that the staged bootstrap will remain on the original
disk from which it was staged. Therefore, the original disk can be used to scan in the
bootstrap data if the staged bootstrap is accidentally deleted. Also be aware that if the
bootstrap data is not staged from the original disk, the data on the original disk will
be subject to the same browse and retention policies as any other saveset backup and
will, therefore, be subject to deletion after the retention policy has expired.

Staging and cloning from the command prompt
Staging a save set from the command prompt works differently than staging a save
set from the NetWorker Console. When staging from the NetWorker Console, you
select save sets that belong to a single device. When staging from the command
prompt, specify the save set IDs to be staged.
When a save set is cloned, the cloned save sets are given the same save set ID as the
original save set with a new clone ID. When staging a save set from the command
prompt, the NetWorker software stages all the save sets with the specified save set ID
and then removes those save sets. That means that any cloned versions of the save set
are removed when the original is removed.
To ensure that all clones are not removed, specify a clone ID with the save set ID to
indicate the source volume of the staging. For example:
nsrstage -m -S ssid/cloneid

To find the clone ID of a save set, use the mminfo command. For example:
mminfo -avot -r "volume,ssid,cloneid,name"

Working with staging policies

239

Staging Backups

For information about nsrstage or mminfo, refer to the EMC NetWorker Command
Reference Guide or the UNIX man pages.
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Overview of device operations
Chapter 12, “Media Management” provides information on operations involving
storage media.
You can view and access all libraries in the enterprise by selecting the Libraries option
in the Console window. The Libraries option displays a hierarchy of NetWorker
servers, configured NetWorker storage nodes, and devices that exist in the enterprise.
The library information displayed is updated periodically or when a user requests it.
Library information is also updated when NetWorker servers are added to, or deleted
from, the enterprise hierarchy.
The details describing a particular device can be viewed, and often changed, in the
device’s Properties.
To see the full range of settings and options available in the Properties window, select
View > Diagnostic Mode. For a description of the various fields and attributes on a
given Properties tab, click Field Help.
As with other Console functions, users can view and work with only those
NetWorker servers for which they have access permission.

File type (FTD) and advanced file type (AFTD) devices
The NetWorker DiskBackup solution reduces the time it takes to save and recover
data when compared to the use of tape. NetWorker DiskBackup allows data to be
saved to a computer’s local or network-attached disk, instead of using a tape device
to write the data to storage media. The DiskBackup solution requires a DiskBackup
option license.
NetWorker DiskBackup supports these configurations:
◆

A local disk on a NetWorker storage node is supported for both file type devices
(FTDs) and advanced file type devices (AFTDs).

◆

A network-attached disk device that is NFS-mounted to a UNIX version of the
NetWorker storage node. This is supported for both file type devices and AFTDs.

◆

A network-attached disk device that is CIFS-mounted to a NetWorker storage
node running on Microsoft Windows. This is supported only on AFTDs.

“Differences between FTDs and AFTDs” on page 244 provides information on the
key differences between file type and AFTD devices.
Example 27 NetWorker DiskBackup within a system configuration

Figure 27 on page 243 illustrates how to use NetWorker DiskBackup within a system
configuration. In this example:
◆

The AFTDs are created on Disk Device 1, Disk Device 2, and the Local Disk is
created on storage node A.

◆

A file type device is created on Local Disk 2.

◆

Linux/UNIX storage node A writes its backups to one of the following:
• The AFTD through an NFS connection to Disk Device 1.
• The AFTD on Local Disk 1.
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◆

The Microsoft Windows storage node B uses a CIFS connection to back up to the
AFTD on Disk Device 2. The file type device cannot be used on a CIFS
connection.

◆

The Microsoft Windows Storage Node C writes its backups to the file type device
on the Local Disk 2.

NetWorker DiskBackup can be tailored to the specific configuration of the system.
NetWorker server

LAN
NFS

CIFS
UNIX/LINUX
storage
node A
Local disk/file
system1(AFTD)

Figure 27

NAS
device 1
(AFTD)

Windows
storage
node C
Windows
storage
node B

NAS
device 2
(AFTD)

Local disk/file
system2 (FTD)

Sample NetWorker DiskBackup configuration

DiskBackup and staging
To prevent the file system from becoming full when backing up data to FTDs or
AFTDs, a staging policy must be created to move the data off the disk as soon as
possible. To make space for additional backups, perform one of these activities:
◆

Set up a staging policy.

◆

Review and, if required, modify the retention policy of the save sets.

Save set staging is helpful when used with either of these device types. “Save set
staging” on page 236 provides more information.

File type (FTD) and advanced file type (AFTD) devices
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Differences between FTDs and AFTDs
Table 36 lists the functional differences between the file type device and the AFTD.
IMPORTANT
Data loss will result if a full FTD is made appendable while there is a backup
pending completion with a save set partially written to the full FTD. In this case,
the partial save set (currently in "incomplete" state) will be overwritten.
Table 36
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Advanced file type and file type device differences (1 of 2)

Function or operation

AFTD

File type device

Create a device

Select media type: adv_file
UNIX/Linux: local or NFS
Windows storage node:
• Local or Common Internet File System
(CIFS)
Universal Naming Convention (UNC) path for
CIFS:
• Remote user
• Password

Select media type: file
UNIX/Linux: local or NFS.
Windows storage node: local path only

Label a device

• Volume name must not exceed 60
characters.
• Automatically creates an _AF_readonly
device, then labels and automounts
(enables) a volume with a .RO suffix.

• Volume name must not exceed 63
characters.

Concurrent operations:
“Recover savesets by using
AFTD concurrent operations”
on page 260 provides more
information.

Yes

No

Save set ID/clone ID:
“Recover savesets by using
AFTD concurrent operations”
on page 260 provides more
information.

• One save set ID with two clone IDs created
for each save set.
• A second (virtual) clone created on
_AF_readonly device.
• User can specify virtual clone ID for
concurrent operations.

One save set ID created with one clone
ID for each save set.

Reclaiming or recovering
space

• Aborted save sets immediately removed.
• The nsrim program removes expired save
sets, once every 24 hours, from the media
database after a savegroup is completed (if
volume recycle is set to Auto). Space on the
AFTD is removed at the interval defined in
the Reclaim Space Interval of the staging
policy.

The nsrim program removes both
aborted and expired save sets, once
every 24 hours, after a savegroup is
completed (if volume recycle is set to
Auto).

Volume default capacity for
devices

Does not apply.

If the file type device was used prior to
setting the Volume Default Capacity
attribute, the data for that file type device
must be staged or cloned to another
device.

AFTD Percentage Capacity

A configurable setting for determining at what
capacity the NetWorker software should stop
writing to an AFTD spans from 1 to 100%.

Does not apply.
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Table 36

Advanced file type and file type device differences (2 of 2)

Function or operation

AFTD

File type device

When file system or volume is
full

• Message displayed stating file system
requires more space.
• The nsrim program invoked to reclaim
space for expired save set on AFTD.
• Notification sent by email stating device is
full.
• Device waits until space become available.
The volume is never marked as full.

• Waiting message displayed if no
writable volume available or until
volume becomes available.
• Volume marked full and is no longer
available for backups until the volume
becomes appendable.

Save set continuation

No. Save sets that start on an AFTD must be
completed on the same device.

Yes

Save set consolidation

Not supported.

Supported

Data format in device

Save stream (uasm) format (uses less space).

EMC Open Tape Format (OTF).

Differences in the cloning process
For both FTDs and AFTDs, save sets are cloned one at a time. Important differences
exist, however, in the cloning process for the two types of devices:
◆

For file type devices, both automatic and manual cloning begins only after all the
save sets in a savegroup are backed up.

◆

For AFTDs, automatic cloning begins after the save sets are backed up. Manual
cloning of a save set can, however, begin as soon as it has finished its backup.

◆

For AFTDs, two simultaneous clone operations can be run from the
command-prompt, as long as no backup, recover, or stage operations are
running at the same time. The syntax is as follows:
• nsrclone -S [ssid/cloneid1]
• nsrclone -S [ssid/cloneid2]

The EMC NetWorker Command Reference Guide or the UNIX man page provides
information about the nsrclone command.

File type devices
Configure the NetWorker server to back up data to a file type device by creating a
new Device resource in the same way as for any other storage device.
The following restrictions apply to the configuration of a file type device:
◆

Multiple file type devices can be supported on a system. Each device must,
however, have a different name.

◆

Dynamic Drive Sharing is not supported.

◆

To use multiple file type devices on the same disk, partition the disk and create
only one file type device per partition.

◆

For most device types, the Volume Default Capacity attribute is an arbitrary value
that is an estimate of what the volume capacity is likely to be. It has no impact on
how much data is actually written to a volume. If the value is not set correctly, the
percent used calculation will not be correct. For file type devices, the Volume
Default Capacity is a hard limit to the amount of data that can be written to the
device.

File type (FTD) and advanced file type (AFTD) devices
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IMPORTANT
To avoid accidentally filling a file system, set the Volume Default Capacity
attribute to restrict the size of the file type device. For example, if a Volume Default
Capacity of 100 MB is set for a file type device, then the device will be marked full
when the capacity of 100 MB is reached. This is true for any type of file system.
If the Volume Default Capacity of a volume changes, the changes do not take
effect until the volume is relabeled, the directory contents are deleted, and the file
device is re-created.
In the Console Administration interface, the Volume Default Capacity displays in
the Configuration tab of the Properties window of a device when Diagnostic
Mode is enabled. To enable Diagnostic Mode, select View > Diagnostic Mode.
Note: The value for the Volume Default Capacity attribute must be set to less than 4 TB.

Note: The advanced file type device ignores the Volume Default Capacity value to allow
dynamic expansion of disk space.
◆

Save sets from FTDs can be cloned to an AFTD to take advantage of advanced file
type device features.

◆

The following restrictions apply to FTDs created on a UNIX or Linux network file
system (NFS):
• The file system used for the FTD must not be used for any other data.
• There must be one FTD per NFS system.
• The Volume Default Capacity attribute for the FTD must be set to a size that is
less than 100 percent of the total capacity of the file system.

◆

If the FTD was used prior to setting the Volume Default Capacity attribute, the
data for that FTD must be staged or cloned to another device.

◆

When a FTD is used as a backup solution, the upper limits of save set size depend
on either of these:
• The upper limits supported by the operating system
• The file size specified by the disk device vendor
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Creating and configuring FTDs and AFTDs
The advanced file type (adv_file) is designed for large disk devices that use a volume
manager to dynamically extend available disk space if the disk runs out of space
while being accessed as an advanced file type device (AFTD) during backup. The
EMC Software Compatibility Guide provides a list of supported volume managers.
“Differences between FTDs and AFTDs” on page 244 provides

Task 1: Set the AFTD allowed directories attribute
Before creating an AFTD, set the AFTD allowed directories to control access to storage
node file systems. If this attribute is populated it limits the AFTD to the device path in
the list of allowed directories. If the attribute is left empty, then there will be no
restrictions on the path of an AFTD when it is created, with the exception that certain
well known system level directories are always rejected.
1. Login to NMC as administrator.
2. In the Enterprise tab in NMC, right-click the NetWorker host, and select New >
Managed Application....
3. Right-click NetWorker in the Managed Application column, and click Launch
Application....
4. In Devices, right click the storage node on which the AFTD will be created.
5. In the storage node Properties window, type the directory path in the AFTD
allowed directories: field.
If there is a conflict due to an existing AFTD, or if the device path does not exist, a
notification displays, and the change of allowed directories is rejected.

Task 2: Create and configure an FTD and AFTD device
You can create an a FTD or AFTD by using either the Device Wizard or the device
properties window. Choose one of the following methods:
◆

“Create an AFTD by using the Device Wizard” on page 247

◆

“Create an AFTD or FTD by using the Properties window (UNIX and Linux)” on
page 248

◆

“Create and configure an AFTD or FTD by using the Properties window
(Windows)” on page 249

Note: Do not modify directories or files created by file type devices or AFTDs. Changes to the
device path or its contents prevent the NetWorker software from locating the device.

Create an AFTD by using the Device Wizard
To create an AFTD by using the Device Wizard:
1. In the Enterprise tab in NMC, right-click the NetWorker host, and select New >
Managed Application....
2. Right-click NetWorker in the Managed Application column, and click Launch
Application....
3. In Devices, right click Devices, and select New Device Wizard.
4. In the Select the Device Type window, click to select AFTD, and click Next.
Creating and configuring FTDs and AFTDs
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5. In the Select Storage Node window, select a storage node from the list and then
click either:
• Browse Storage Node Filesystem, type the Username and Password in the
respective fields, and click Next.
• Enter device path, type the device path, and click Next.
6. In the Select the Device Path window, do either of these:
• In the required drive, click to select the sub-directory in which to create the
AFTD, and click Next.
• Click New Folder, type a name for the folder, and click Next.
7. In the Label and Mount device window, complete these attributes:
• Label and Mount device after creation... (click to enable this attribute.)
• Pool Type
– Backup
– Backup Clone
• Pool
Select the appropriate pool from the drop down list.
8. In the Configure Device Attributes window, complete the attributes as required,
and click Configure.
9. Verify the device settings in the Review the Device Configuration window. Click Next
to accept, or click Back to change settings if required.

10. Check that the View results window lists all the configuration settings for the
new device, click Finish.
Create an AFTD or FTD by using the Properties window (UNIX and Linux)
To create a FTD or AFTD on UNIX and Linux:
1. Create one directory for each disk (or partition) to be used for an AFTD or file
type device. AFTD and file type devices both require a directory to be created in
the disk file system that the NetWorker server or storage node recognizes as the
device name (and the destination for the data).
Note: Do not use the tmp directory for NetWorker DiskBackup devices because the data
could be overwritten.

2. In the server’s Administration interface, click Devices.
3. Right-click Devices in the navigation tree, and select New.
The Create Device window opens, with the General tab selected, and a default
device name in the Name field of the Identity area of the window.
4. Replace the default name with the complete path of the directory created. For
example:
/directory_name
rd=storage node:/directory_name

For an NFS-mounted file type device or AFTD, ensure the NFS mount point is
available by either automounting or manually mounting it as required:
a. If the device is configured on the server’s storage node (file type or AFTD), the
name is the simple device path, such as /backup/d0.
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b. If the device is configured on a remote storage node, then the name must indicate that
the storage node is remote, by including rd= and the name of the remote storage node
in the device path. For example, if the remote storage node is neptune, then the device
path might be rd=neptune:/backup/d0.
5. In the Identity area:
a. Add a comment (optional) in the Comment field.
b. In the Media Type field, select a type from the menu:
– file, for a file type device.
– adv_file, for an AFTD.
6. In the Status area, make sure that the Auto Media Management feature for AFTD or file
type device is not enabled.
7. In the Cleaning area, leave the options for cleaning at their default (disabled) settings, so
that automatic cleaning is not invoked.
8. Select the Configuration tab to set these attributes as required:
• Target Sessions
• Max Sessions
• Local Backup to a Dedicated Storage Node (maintain the default No setting)
9. Click OK when the configuration is complete.
10. Label and mount theNetWorker DiskBackup Device in the same manner as other offline
media used for NetWorker backups.
• Since the AFTD is never marked full, there is no need to add another device to the
pool.
• Because the AFTD automatically affixes the .RO suffix to a volume name, limit the
volume name to 60 characters when labeling the volume.
Save set staging is especially useful when using either device type of the NetWorker DiskBackup
feature.

Create and configure an AFTD or FTD by using the Properties window (Windows)
To configure an FTD or an AFTD on Windows:
1. Create one directory for each disk (or partition) to be used for AFTD or file type device.
Each disk (or partition) requires a directory that is used for file type device or AFTD
storage. Each of these devices requires a directory in the disk file system that the
NetWorker server recognizes as the device name (and the destination for the data).
Note: Do not use the temp directory for NetWorker DiskBackup devices. The data could be
overwritten. Because AFTDs are never marked as full, there is no need to configure another device
in the same pool.

2. In the server’s Administration interface, click Devices.
3. Right-click Devices in the navigation tree, and select New. The Create Device window
appears, with the General tab selected, and a default device name in the Name field of the
Identity area of the window.
4. Replace the default name with the complete path of the directory created. For example:
H:\device01
rd=mercury:H:\device01

5. In the Identity area:
Creating and configuring FTDs and AFTDs
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a. Add a comment (optional) in the Comment field.
b. In the Media Type field, select a type from the menu:
– For a file type device, select File.
– For an AFTD, select Adv_file.
6. In the Status area, make sure that the Auto Media Management feature for AFTD
or file type device is not enabled.
7. In the Cleaning area, leave the options for cleaning at their default (disabled)
settings, so that automatic cleaning is not invoked.
8. Select the Configuration tab to set these attributes as required:
• Target Sessions
• Max Sessions
• Local Backup to a Dedicated Storage Node (maintain the default No setting)
9. Click OK when the configuration is complete. Label and mount the NetWorker
DiskBackup Device in the same manner as other offline media used for
NetWorker backups.
AFTD device formats for concurrent operations
Two devices are created when the primary (read-write) advanced file type device is
labeled. The NetWorker software creates a secondary device with read-only
accessibility. A second volume with the .RO suffix in its name is also created, and is
automounted in this device. The read-only device and volume enable concurrent
operations, such as reading from the read-only device while writing to the read-write
device. Starting in NetWorker 7.6 SP 2, read-only devices are hidden by default.
“Displaying read-only AFTD or Data Domain devices and volumes” on page 251
describes how to display read-only devices and volumes.
Table 37 on page 250 lists the device formats created when the AFTD is labeled.
Table 37

AFTD names

Device

AFTD name

Type

Volume

UNIX and Linux
format

/mercury/dev1

adv_file

af_1

/mercury/dev1/_AF_readonly

adv_file

af_1.RO

d:\file_devices\dev1

adv_file

af_1

d:\file_devices\dev\_AF_readonly

adv_file

af_1.RO

adv_file

af_2

adv_file

af_2.RO

Windows format

Common Internet
(rd=storage_node:)\\<CIFS_host>\sharepoint\dev1
File System (CIFS)
(rd=storage_node:)\\<CIFS_host>\sharepoint\dev1\_AF_readonly

Note: The terms _AF_readonly name and the .RO suffix are reserved for AFTDs. Do not use
these terms when naming devices or labeling volumes. Also be aware that because the AFTD
automatically affixes the .RO suffix to a volume name, limit the volume name to 60 characters.

The following operations can be performed concurrently on a single storage node
with an AFTD:
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◆

Multiple backups and multiple recover operations.

◆

Multiple backups and one manual clone operation.

◆

Multiple backups and one automatic or manual staging operation.
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It might be required to increase the server parallelism value to complete the
concurrent operations with an AFTD device when the number of simultaneous save
sessions reaches the maximum value for server parallelism.
For example, if server parallelism is set to 4, and there are 4 simultaneous saves going
to an AFTD, set the server parallelism to 5 to complete a concurrent clone/stage
operation from this AFTD while the four saves are in progress.
Displaying read-only AFTD or Data Domain devices and volumes
Starting with NetWorker 7.6 SP2, read-only devices and read-only volumes are not
displayed by default in the NMC console or in reports. For some operations, you may
need to display the corresponding read-only device or volume. For example, if you
attempt to delete an AFTD or Data Domain device, both the read-write and the
corresponding read-only device and volume must be unmounted. If the read-only
device or volume is mounted, you must display the read-only device or volume and
then unmount it.
To display read-only AFTD or Data Domain devices and volumes:
1. Click Devices from the Administration window.
2. Select View > Display read-only devices and volumes.
Note: In some cases, you must propagate changes that are made on the read-write device to its
corresponding read-only device. Details on propagating changes to the read-only device are
available in “Propagate changes from the read-write Enabled attribute to the read-only
Enabled attribute” on page 251.

Propagate changes from the read-write Enabled attribute to the read-only
Enabled attribute
When data is backed up, additional entries are added to the NetWorker media index
for the data backed up to the device.
When a change is made to the Enabled attribute for the user-created, AFTD
read-write device, the same change must immediately be made to the _AF_readonly
device.
To propagate the changes:
1. Ensure that the read-only device/volume attribute is displayed.
a. Click Devices from the Administration window.
b. Select View > Display read-only devices and volumes.
2. Access the read-write device and change the Enabled attribute.
3. Access the read-only device and change the Enabled attribute to match the
change made to the read-write device.
Note: Always make attribute changes first to the read-write device, and then make the
changes to the read-only device.
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Task 3: Provide sufficient disk space for the AFTD
When an AFTD runs out of disk space, the current backup is interrupted and the
following message displays:
Waiting for more available space on filesystem device-name

Immediately following the message, the action associated with the Filesystem Full —
Recover adv_file Space notification occurs. By default, the action for this notification
uses the nsrim command to delete expired save sets. If enough space is cleared, the
backup continues. If the recycle setting for the volume is manual, then the expired
save sets are not removed from the volume.
The AFTD deletes expired save sets depending on the retention policy and the recycle
setting. If sufficient storage space is not available after 10 minutes from when the
expired savesets begin deletion, the associated Filesystem Full—Waiting for
adv_file Space notification action occurs. By default, an email notification is sent to
the root user on the NetWorker server on UNIX and Linux, and a message is logged
in the media log file in NetWorker_install_path\logs on Windows. “Viewing log files”
on page 661 provides information about viewing log files.
When the notification is sent, and the message is logged in the media log file, the
backup stops until space is available for the backup to continue. You can create
customized notifications to change and expand how the NetWorker software behaves
when an AFTD Filesystem Full notification occurs. Custom notifications can also
invoke custom scripts and other programs to expand the capacity of existing AFTDs.
“Notifications” on page 447 and “Configuring NetWorker SNMP notifications” on
page 572 provides information on using notifications.
Create a custom notification to extend disk space
While the NetWorker default Filesystem Full — Recover adv_file Space notification
works by removing its expired save sets, a custom notification could be configured to
expand disk or file system space in other ways:
1. In the server’s Administration interface, click Configuration.
2. Right-click Notifications and select New.
3. For Name, type a unique name for this custom notification, such as First adv_full
notice.
4. For Event, clear all choices except adv_file.
5. For Priority, clear all choices except Waiting.
6. For Action, specify the full path of the custom script configured to expand
diskspace, for example: /mybin/my_first_custom_script.
7. Click OK.
Create a custom notification for insufficient disk space
The NetWorker default Filesystem Full — Waiting for adv_file Space notification
works by sending an email notification, a custom notification could be configured to
do whatever the user indicates. The wait time after the default notification is
approximately 10 minutes.
1. In the server’s Administration interface, click Configuration.
2. Right-click Notifications and select New.
3. For Name, type a unique name for this second custom notification, such as
Second adv_full Notice.
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4. For Event, clear all choices except adv_file.
5. For Priority, clear all choices except Critical, Emergency, and Alert.
6. For Action, specify the full path of the custom script to be invoked, for example:
/mybin/my_second_custom_script.
7. Click OK.
AFTD device target and max sessions
The defaults for AFTD target sessions and max device sessions are now set to the
optimal values for AFTD performance:
◆

Device target sessions is 1

◆

Device max sessions is 32 to avoid disk thrashing

If required, both device target, and max session attributes can be modified to reflect
values appropriate for the environment. Table 38 on page 261 provides default target
and max session values and recommendations for other device types.
AFTD load balancing
You can adjust the target and max sessions attributes per device to balance the data
load for simultaneous sessions more evenly across available devices. These
parameters specify the maximum number of save sessions to be established before
the NetWorker server attempts to assign save sessions to another device.
For AFTDs, all volumes, depending on the selection criteria (pool settings), choose
the AFTD with the least amount of data written to it, and join sessions based on the
device's target and max sessions. If the number of sessions being written to the first
device exceeds the target sessions setting, another AFTD is considered for new
backup sessions and is selected from the remaining suitable AFTDs. The AFTD that is
selected will be the AFTD with the least amount of NetWorker data written to it. The
least amount of data written is calculated in bytes (not by percentage of disk space
used) and only bytes that were written by NetWorker are counted.
To ensure that a new session always writes to the AFTD with the least amount of data
written to it, you can set each AFTD device's max sessions attribute to 1. However,
setting the max sessions attribute to 1 may not be practical. Alternatively, set the
target sessions attribute to 1. In this way, load balancing will occur on a best efforts
basis.
Space management for AFTD
A configurable setting for determining at what capacity the NetWorker software
should stop writing to an AFTD spans from 1 to 100%. Setting the value to 0 or
leaving the attribute empty in the AFTD Percentage Capacity attribute is equivalent
to a setting of 100%. This means that the entire capacity of the filesystem can be used
for the AFTD volume.
When set, the AFTD Percentage Capacity attribute is used to declare the volume full
and to calculate high/low watermarks. When the percentage capacity attribute is
modified, mount and re-mount the volume for the new settings to take effect.
The level watermark is calculated based on the percentage of restricted capacity, not
on the full capacity of the filesystem.
In the Console Administration interface, the AFTD Percentage Capacity displays in
the Configuration tab of the Properties window of a device when Diagnostic Mode
is enabled. To enable Diagnostic Mode, select View > Diagnostic Mode.
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Task 4: (Optional) Share an AFTD between storage nodes in a NAS or SAN environment
In a Network Attached Storage (NAS) environment, NetWorker operations can be
performed concurrently on two storage nodes that share an AFTD. When sharing an
AFTD, one storage node can save to a writable volume, while the other storage node
either recovers or clones from a read-only volume.
In a Storage Area Network (SAN), NetWorker operations are performed sequentially
when two storage nodes share an AFTD. Only one storage node at a time can use the
shared AFTD.
Any staging occurs from the storage node that has the read-only volume mounted.
Certain configuration changes must be made to share an AFTD between storage
nodes. “Task 4: (Optional) Share an AFTD between storage nodes in a NAS or SAN
environment” on page 254 provides more information.
When the configuration completes, however, no change is required in how to start
these operations:
◆

Backup

◆

Recovery

◆

Cloning

◆

Staging

Shared AFTD considerations
Review these considerations before sharing AFTDs:
◆

Ensure that operating system permissions (directory and file) and sharing are set
up properly between storage node hosts for the root user or Windows
administrator, to enable proper sharing of AFTDs on the file system.
Use operating system commands to create, copy, or erase directories or files on
the sharing disk (such as NAS, JBOD in SAN), to ensure that sharing is possible at
file system level between machines. If the operating system does not permit such
sharing, then the NetWorker software cannot change that.

◆

Consider the “Shared AFTD limitations” on page 255 before creating shared
AFTDs.

◆

To share an AFTD between storage nodes, ensure to:
• Set the proper Storage Node and Clone Storage Node attributes in the Client
resource.
• Specify for the Staging resource, the proper Device attribute (the one with the
read-only volume mounted).

◆

To share an AFTD in NAS on Windows storage nodes, ensure to:
• Start the nsrexecd (NetWorker Remote Exec) service is started by a Windows
Administrator account on the storage node.
• Create the CIFS-mapped AFTD with UNC pathnames that have the
appropriate remote user and password specified. An example of UNC path
syntax is:
rd=sn_a:\\nas1\path\shared_aftd

“Create CIFS-mounted AFTD on Windows servers and storage nodes” on
page 258 provides more information.

254

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Device Operations

Shared AFTD limitations
Shared AFTDs include these limitations:
◆

Read-only volumes might be automounted onto the writing storage node during
saves. The workaround is to unmount all sharing instances of read-only and
read-write AFTD volumes from all storage nodes, and then correctly remount
them.

◆

Limitations on sharing AFTD between storage nodes in NAS/SAN:
• Supports only homogeneous storage node platforms when sharing AFTD
(such as Windows with Windows storage nodes, or UNIX with UNIX storage
nodes).
• The sharing read-write or read-only AFTD volume must be manually
unmounted from one storage node before being mounted on another, in order
to prevent a potential out-of-sync state for the volume.
• All instances of the sharing read-write or read-only AFTD volume must be
manually unmounted from all of the sharing storage nodes before relabeling
the sharing AFTD, in order to prevent potential data loss.
• For SAN only:
One storage node at a time can perform NetWorker operations.
Use operating system or SAN commands to mount or enable the sharing disk
on the second storage node after unmounting or disabling from the first
storage node. This ensures that file and directory sharing of the same disk is
supported (set up) in the SAN from the sharing storage nodes, allowing the
sequential sharing of the disk as an AFTD in the NetWorker software.

Configure a shared AFTD in a NAS environment
When sharing an AFTD between two storage nodes in a NAS environment, these
conditions apply:
◆

For UNIX or Linux, NFS mount the NAS file system for AFTD on the sharing
storage nodes.

◆

For Windows, CIFS mapping to the NAS file system is optional on the storage
nodes.

Perform these steps to configure a shared AFTD in a NAS environment:
1. To create and label the AFTD on storage node A (sn_a):
• On UNIX or Linux: rd=sn_a:/shared_aftd
• On Windows: rd=sn_a:\\nas1\path\shared_aftd
The remote user and password must be specified if this requirement is set up in
the NAS file system.
2. To create the same AFTD on storage node B (sn_b):
• On UNIX or Linux: rd=sn_b:/shared_aftd
• On Windows: rd=sn_b:\\nas1\path\shared_aftd
3. In the NetWorker software, mount the AFTD, but do not label it on storage node
B, to create the read-only volume.
4. In the NetWorker software, unmount all volumes of the shared AFTD on storage
nodes A and B.
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5. To write (back up) to storage node A in the NetWorker software:
a. In the NetWorker software, unmount the read-write volume from storage
node B (if it is mounted).
b. Mount the read-write volume on storage node A.
c. Configure the Storage Nodes attribute of the Client resource (sn_a).
d. Ensure that the NetWorker server’s local storage node has a volume available
for a bootstrap backup.
6. To read (recover, clone, or stage) from storage node B:
a. In the NetWorker software, unmount the read-only volume from storage node
A if it is mounted.
b. Mount the read-only volume on storage node B.
c. Configure the Recover Storage Nodes attribute of the Client resource (sn_b).
d. Configure the Clone Storage Nodes attribute in the Client resource with the
target of the clone (or stage) operation.
e. Configure the staging policy’s Devices attribute to select
rd=sn_b:/shared_aftd for autostaging from sn_b.
Configure a shared AFTD in a SAN environment
When sharing an AFTD between two storage nodes in a SAN environment, use the
appropriate operating system command or SAN command to unmount (disable) the
sharing disk from any machine, and mount (enable) the same disk on storage node A.
Perform the following steps to configure a shared AFTD in a SAN environment:
1. Create, label, and mount the sharing AFTD on storage node A.
2. Perform the save, recover, or clone to operation from storage node A (with the
Storage Nodes attribute of the Client resource configured as storage node A).
3. Perform the stage operation from storage node A. Choose the shared AFTD from
storage node A in the Device attribute of the Stage resource.
4. In the NetWorker software, unmount the AFTD volumes from the sharing storage
node A.
5. Use the appropriate operating system command or SAN command to unmount
(disable) the sharing disk from storage node A, and mount (enable) the same disk
on storage node B.
6. Create the AFTD to share in a SAN for storage node B.
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7. In the NetWorker software, mount the AFTD (but do not label it) on storage node
B.
8. Perform the save, recover, or clone to operations from storage node B (with the
Storage Nodes attribute of the Client resource configured as storage node B).
9. Perform the stage operation from storage node B. Choose the shared AFTD from
storage node B in the Device attribute of the Stage resource.

Task 5: Verify FTD and AFTD operations
The FTD and AFTD can be deployed in varying environments with local disks, and
with NFS-mounted or CIFS-mapped disks. The configuration of this feature affects its
operation. Ensure that the AFTD is fully operational in the production environment
before deploying it as part of regularly scheduled operations.
Note: Dynamic Drive Sharing is not supported with the AFTD.

As part of the validation process, test these operations:
◆

Backup

◆

Recover

◆

Staging

◆

Cloning

◆

Maximum file size compatibility between the operating system and a disk device

◆

Use of a volume manager to increase the file system size while the file system is in
use

◆

File system behavior when the disk is full

Note: Some versions of Network File System (NFS) or Common Internet File System (CIFS)
drop data when a file system becomes full. Be sure to use versions of NFS, CIFS, and operating
systems that fully support full file systems.
On some disk devices, the volume labeling process can take longer than expected. This
extended labeling time depends on the type of disk device used and does not indicate a
limitation of the NetWorker software.
The upper limits of save set size depend on either the upper limits supported by the operating
system or the file size specified by the disk device’s vendor.

Do not edit device files and directories, it is not supported, and can cause
unpredictable behavior and make it impossible to recover data.

Creating and configuring FTDs and AFTDs
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Create CIFS-mounted AFTD on Windows servers and storage nodes
This section explains how to start the NetWorker service and configure the AFTD on a
CIFS connection on a Microsoft Windows system. The NetWorker service must be
started by a member of the Administrator group before the AFTD can be configured.

Start the NetWorker service on Microsoft Windows
To start the NetWorker services as a user with administrator rights:
1. Create an Administrators account. For example: NWservice.
2. Ensure that the user account created for the NetWorker Remote Exec service has
Full control on the share where the AFTD is used.
3. Ensure that User must change password at next logon is cleared.
4. Ensure that User cannot change password is selected.
5. Ensure that Password never expires is selected.
6. Do not set the Administrator account to an account that has login as a service
rights.
7. From the Windows Start menu, select Settings > Control Panel > Administrative
Tools > Services.
8. Right-click Services.
9. Stop the appropriate service:
• For a NetWorker server, stop the NetWorker Backup and Recover service and
NetWorker Remote Exec service.
• For a NetWorker storage node, stop the NetWorker Remote Exec service.
10. Right-click the NetWorker Remote Exec service that was stopped in step 9 and
select Properties.
11. Select the Log On tab.
12. Select This Account.
13. Replace Local System with the Administrative user created (NWservice).
14. Type the administrator password in the appropriate field.
15. Click OK.
When a service is given a user account, it is automatically given login as a service
rights. When the NetWorker Backup and Recover service is started, it will
automatically start the NetWorker Remote Exec service.

Configure a CIFS-mapped AFTD on a Windows server and storage node
To configure a CIFS-mapped AFTD:
1. Create one directory for each disk (or partition) to be used for AFTD. AFTD and
file type devices both require the creation of a directory in the disk file system that
the NetWorker server recognizes as the device name and the destination for the
data.
2. In the server’s Administration interface, click Devices.
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3. Right-click Devices in the navigation tree, and select New. The Create Device
window appears, with the General tab selected, and a default device name in the
Name field of the Identity area of the window.
4. Replace the default name with the complete path of the directory created by using
the Universal Naming Convention (UNC):
• \\CIFS_host\share-point-name\path
• rd=sn_host:\\CIFS_host\share-point-name\path
Note: To configure a Microsoft Windows server, do not include rd=<sn_host>: in the UNC.

5. For Media Type, select adv_file.
6. In the Status area, make sure that the Auto Media Management feature for AFTD
or file type device is not enabled.
7. In the Cleaning area, leave the options for cleaning at their default (disabled)
settings, so that automatic cleaning is not invoked.
8. Select the Configuration tab to set these attributes as required:
• Target sessions
• Max sessions
• Local Backup to a Dedicated Storage Node (maintain the default No setting)
9. In the Remote Host area:
• Leave NDMP unselected.
• These are required if the CIFS file system is set up to require password access:
a. Type the CIFS file system username in the Remote User field. For example,
in the configuration illustrated in Figure 28 on page 259, type the
administrator of the CIFS file system.
b. Type the CIFS password in the Password field. For example, in the
configuration illustrated in Figure 28 on page 259, type the password for
the CIFS file system.
10. Click OK, when the configuration completes.
Note: If a new password for the CIFS AFTD is provided, the NetWorker services must be
restarted on both the server and storage node in order for the new password to take effect, and
to reestablish the CIFS connection correctly.

NetWorker server
CIFS
LAN

Storage node
Disk
(AFTD)
Figure 28

NAS or
Windows
server

CIFS-mounted advanced file type device
Create CIFS-mounted AFTD on Windows servers and storage nodes
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Recover savesets by using AFTD concurrent operations
When recovering from an AFTD, save sets are recovered concurrently. Multiple save
sets can be simultaneously recovered to multiple clients.
AFTD save sets can be cloned to two different volumes simultaneously. “Differences
in the cloning process” on page 245 provides more information.
Figure 29 on page 260 shows a system configuration where both NetWorker client A
and NetWorker client B can use NFS to recover files concurrently from AFTD1.
NetWorker
Server

LAN

NFS or CIFS
NetWorker
Client B

NetWorker
Storage Node

NetWorker
Client A

Figure 29

File system

NAS
Device1

AFTD1

AFTD Configuration

Limitations with concurrent AFTD recovery operations
AFTD concurrent recovery currently has these limitations:
◆

Not available to the Windows recover interface (winworkr). Use the recover
command. The NetWorker Command Reference Guide or the recover man page
provides more information.

◆

Not available to nonfile recoveries, such as NDMP and NetWorker database
modules.

◆

NetWorker release 7.2x clients on Windows recover data from AFTD storage
nodes sequentially.
Concurrent recoveries must be performed from the command line by using the
recover command, either by using multiple -S options to identify multiple save
sets, or executing multiple recover commands concurrently.
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Delete FTD and AFTD
“Devices and libraries” on page 98 provides information about deleting file type and
advanced file type devices.

License NetWorker DiskBackup solutions
The NetWorker Licensing Guide provides information on licensing for the NetWorker
DiskBackup option.

Device target and max sessions default values and ranges
Table 38 on page 261 lists the default values and ranges for device target and max
sessions in the NetWorker Administration interface.
Table 38

Default values and ranges for Target and max sessions attributes.

Device type

Default target sessions

Default max sessions

Recommended
sessions*

Range

AFTD (traditional storage)

1

32

1 - 32

1 - 512

AFTD (Data Domain CIFS/NFS)

1

32

1 - 10

1 - 512

Data Domain (Boost)

1

10

1 - 10

1 - 60

Cloud

1

512

Any

1 - 512

NDMP

4

512

1 - 32

1 - 512

FTD

4

512

1 - 16

1 - 512

VTL/Tape (Traditional)

4

512

1 - 16

1 - 512

VTL/Tape (Data Domain /
Deduplicated)

4

512

1-1

1 - 512

* The recommended session values are guidelines only and are subject to bandwidth, data type, and device capabilities.

Compatible block size for UNIX and Windows
Different SCSI hardware limitations exist between UNIX and Microsoft Windows
operating systems. This can lead to compatibility problems (although they are less
likely to occur now than in the past, given larger Fibre-Channel capacities). For
example, with a device defined in UNIX that is physically attached to a Windows
HBA, it is possible to define a block size greater than that allowed by the Windows
hardware. This could lead to I/O errors in both write and read states on the device. In
order to use both operating systems, it is necessary to determine a block size that is
acceptable to both.

Determine the allowable block size
To determine the allowable block size, check the Properties window of a mounted
volume while in Diagnostic Mode:
1. In the server’s NetWorker Administration interface, click Devices.

Delete FTD and AFTD
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2. Select View > Diagnostic Mode.
3. Open the Libraries folder in the navigation tree and select the drive that contains
the mounted volume with the block size being checked. The drive’s detail table
appears.
4. Right-click the drive in the detail table, and select Properties. The Properties
window appears.
5. Select the Volume tab. In the Loaded Volume area, one of the displayed volume
attributes is the Volume Block Size.
6. Click OK.

Set the block size for a device type
To set the block size for an entire device type:
◆

On UNIX, change the block size by setting this environment variable to the
greatest common value for both systems. For example:
setenv NSR_DEV_BLOCK_SIZE_MEDIA_TYPE value

where:
• MEDIA_TYPE is the backup device type available to the NetWorker server
(also found in the Media Type attribute on the General tab of the device’s
properties). The media type syntax must be all uppercase, with underscores
(_) replacing blank spaces and hyphens. Therefore, a device displayed in the
NetWorker software as "8mm Mammoth-2" would be listed as:
8MM_MAMMOTH_2

• value must be a multiple of 32 KB, with a minimum value of 32 KB.
◆

On Microsoft Windows only, install a later model HBA, or upgrade to drivers
that can support up to 128 KB blocks. Windows also accepts the same
environment variable format as UNIX to set block size.

Restart the NetWorker server in order for changed environment variables to take
effect.

Device block size for read and write operations
The blocksize for a volume is defined during the label operation.
The block size for both read and write operations uses the block size defined in the
volume header during the label operation rather than the device block size.

Library device maintenance
This section describes how to maintain storage devices.

Periodic maintenance
Clean a storage device periodically to keep it working correctly. The NetWorker
server provides automatic cleaning of drives located in libraries. The server does not
support automatic cleaning for stand-alone devices. Cleaning is an option set during
configuration.
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The service mode feature allows a library to be taken offline temporarily for cleaning
or other maintenance.

Automatic tape device cleaning
Tape device cleaning is an automated, self-contained operation. It is no longer part of
a media-loading operation. Tape device cleaning is automatically triggered if one of
these conditions exist:
◆

The last time the device was cleaned was a full cleaning interval ago.

◆

The Cleaning Required attribute for the device is set to Yes in one of the following
ways:
• Manually by the user.
• Automatically by the NetWorker server, after it receives a "device needs
cleaning" notification.

When one of these conditions is met for a device, cleaning begins as soon as the
device becomes available. Loaded devices are unloaded before a cleaning operation
begins. Loading a cleaning cartridge (with the nsrjb -l cleaning cartridge command) to
force a cleaning operation is no longer supported.
How to manually select a tape device for cleaning
To set the cleaning attributes of a library:
1. In the server’s NetWorker Administration interface, click Devices.
2. Open the Libraries folder in the navigation tree and select the drive that contains
the mounted volume with the block size being checked. The drive’s detail table
appears.
3. Right-click the drive in the detail table, and select Properties. The Properties
window appears.
4. Select the General tab.
5. Set the Cleaning Required attribute to Yes.
Note: Do not enable automated cleaning for silos in the NetWorker software. The automated
device cleaning feature cannot be used in a silo, because it depends on fixed slot numbers. For
information about how to clean devices in a silo, refer to the silo manufacturer’s software
documentation.

How to delay tape device cleaning
It is sometimes necessary to delay the cleaning of a tape device which is scheduled for
cleaning.
To set the value for cleaning delay:
1. In the server’s NetWorker Administration interface, click Devices.
2. Select View > Diagnostic Mode.
3. Open the Libraries folder in the navigation tree.
4. Right-click the appropriate library in the detail table, and select Properties. The
Properties window appears.
5. Select the Timers tab.
6. Select a value in seconds for the Cleaning Delay attribute.
Library device maintenance

263

Device Operations

Tape alert
The TapeAlert feature provides, among other things, diagnostic information for
devices for which hardware cleaning is enabled. To use this feature, select enabled
for the Cleaning attribute of the Device resource so that automatic cleaning is
enabled.
When the Common Device Interface (CDI) is enabled, TapeAlert attributes provide
tape drive status. SCSI Commands must be selected for the CDI attribute on the
Configuration tab of the relevant device’s Properties. If CDI cannot be enabled,
TapeAlert is not supported. “Common device interface” on page 268 provides more
information about CDI.
Devices that are capable of TapeAlert perform constant self-diagnostics and
communicate the diagnostic information via the nsrmmd program to logs that can be
viewed in the Monitoring task.
TapeAlert attributes are found in the device’s Properties, on the Volume tab. Their
respective descriptions are as follows:
◆

TapeAlert Critical: Displays critical diagnostic information, such as for media or
drive failure, when user intervention is urgent and data is at risk.

◆

TapeAlert Warning: Displays a message when the media or device needs
servicing.

◆

TapeAlert Information: Displays status information.

Table 39 describes the nature of the tape alert levels.
Table 39

Tape alert severity

Severity

Urgently requires user intervention

Risks data loss

Critical

X

X

Warning

X

Informative

Explanatory

X
X

The messages indicate tape and drive states related to tape drive read/write
management, cleaning management, or drive hardware errors.
Informative messages
Informative messages indicate status information:
◆

A data or cleaning tape is nearing its end of life.

◆

A tape format that is not supported.
Note: When automatic cleaning is enabled, a diagnostic message to indicate that a drive
needs cleaning initiates NetWorker drive cleaning.

Warning messages
Warning messages indicate the following types of drive errors:
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◆

Recoverable read or write errors occurred.

◆

Media is at end of life.

◆

Read-only tape format is in the drive.

◆

Periodic cleaning is required.
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Critical messages
Critical messages are warnings that a drive might be disabled and requires
immediate attention to avoid data loss:
◆

Unrecoverable read or write errors occurred.

◆

Tape is marked read-only.

◆

Drive require immediate cleaning.

◆

Drive is predicting hardware failure.

Informative and warning messages should clear automatically by nsrmmd once the
reported issue is handled.
Critical messages about hardware errors are not cleared by nsrmmd because they
might indicate intermittent hardware problems.

Service mode
Use the service mode setting to take a device offline temporarily. Service mode differs
from the disabled state in that the nsrmmd process is not stopped.
While a device is in service mode, save or recover sessions that are either in process
or pending are completed. No new sessions are assigned to the device while it is in
service mode.
Although a drive in service mode is taken out of the collection of drives that the
NetWorker software can select for automated operations, the drive is available for
some manual operations that use the nsrjb or nsrmm command with the -f option.
For more information, refer to the EMC NetWorker Command Reference Guide or the
UNIX man pages.
The device might also go into service mode, rather than become disabled, if
consecutive errors occur in excess of the maximum consecutive error count specified
for the device. This means that if there are no hardware issues, the tape can be ejected
and used in other drives. “Media handling errors” on page 304 provides more
information about how to set the maximum consecutive error count.
Note: The drive must be manually reset to Enabled for the NetWorker software to use the
device again.

To put a device in service mode:
1. Open the device’s Properties window
2. On the General tab, set Status Enabled to Service.

Device parameter settings
In NetWorker release 7.3 and later, device parameters can be set in the NetWorker
Administration interface for individual devices on a server. In earlier releases,
environment variables were used to set device parameters for all devices on a given
NetWorker server.
Environment variables can still be used to adjust several NetWorker device
parameters, but the adjustment of environment variables should only be done by
users who know the server environment and performance tuning (for example, an
administrator who wants to fine-tune performance by changing a certain setting for
all LTO devices on a particular NetWorker server).
Device parameter settings
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The variables (and their equivalent names in the Administration interface) are
described in these sections:
◆

“Device settings in the NetWorker Administration interface” on page 266

◆

“Device settings as environment variables” on page 266

Device settings in the NetWorker Administration interface
To locate and change the device parameters in the Administration interface:
1. In the server’s Administration interface, click Devices.
2. Select View > Diagnostic Mode.
3. Select Devices in the navigation tree. The Devices detail table appears.
4. Double-click the device in the devices table or right-click the device and select
Properties. The Properties window appears, with the General tab selected.
5. Select the Advanced tab. In the Device Configuration area, the device settings
are the first fields shown. The following tables lists the fields and their
corresponding environment variables:
Table 40

Device settings and environment variables

Device setting

Corresponding environment variable

Device Block Size

NSR_DEV_BLOCK_SIZE_MEDIA_TYPE

Device File Size

NSR_DEV_TAPE_FILE_SIZE_MEDIA_TYPE

Device Load Time

NSR_DEV_LOAD_TIME_MEDIA_TYPE

Device Eject Time

None

Device Poll Interval

NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE

Device Min Load Tries

NSR_DEV_LOAD_TRY_LIMIT_MEDIA_TYPE

Device Default Capacity

NSR_DEV_DEFAULT_CAPACITY_MEDIA_TYPE

Device Tape Flags

None

When device parameters are set in this interface, it is not necessary to stop and restart
the NetWorker server in order for the settings to take effect.

Device settings as environment variables
The device-related environment variables are:
◆

NSR_DEV_BLOCK_SIZE_MEDIA_TYPE

◆

NSR_DEV_TAPE_FILE_SIZE_MEDIA_TYPE

◆

NSR_DEV_LOAD_TIME_MEDIA_TYPE

◆

NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE

◆

NSR_DEV_LOAD_TRY_LIMIT_MEDIA_TYPE

◆

NSR_DEV_DEFAULT_CAPACITY_MEDIA_TYPE
where:
MEDIA_TYPE is the backup device type available to the NetWorker server.
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Note: The media type syntax must be all uppercase, with underscores (_) replacing blank
spaces and hyphens. For example, a device displayed in the NetWorker software as "8mm
Mammoth-2" would be listed as: 8MM_MAMMOTH_2
To determine the media type, right-click the device an select the General tab. The Media
Type attribute contains the media type that should be used in these environment variables.

Microsoft Windows users use the Control Panel’s System applet to set these system
environment variables. The NetWorker Backup and Recover Server service must be
restarted in order for the environment variables to take effect.
UNIX/Linux users set these environment variables in the NetWorker startup script
before this line:
echo 'starting NetWorker daemons:') > /dev/console

Type the variables in this format:
ENV_VAR_NAME = value
export ENV_VAR_NAME

The NetWorker server must be restarted in order for the environment variables to
take effect.
Table 41 lists the location of NetWorker startup scripts on UNIX and Linux systems.
Table 41

NetWorker startup script location on UNIX/Linux systems

Operating system

Startup script location

Solaris, Linux, and IRIX

/etc/init.d/networker

HP-UX, HP Tru64

/sbin/init.d/networker

AIX

/etc/rc.nsr

NSR_DEV_BLOCK_SIZE_MEDIA_TYPE
NSR_DEV_BLOCK_SIZE_MEDIA_TYPE is organized in units of kilobytes. This
environment variable will cause NetWorker to override the default block-size setting
defined for the tape drive in the operating system. The value set must be a multiple of
32, with a minimum value of 32. Maximums are determined by platform, SCSI driver,
and device. For example:
NSR_DEV_BLOCK_SIZE_4MM_20GB=64

For information about using this environment variable to set block-size compatibility
between UNIX and Microsoft Windows. “Compatible block size for UNIX and
Windows” on page 261 provides more information.
NSR_DEV_TAPE_FILE_SIZE_MEDIA_TYPE
NSR_DEV_TAPE_FILE_SIZE_MEDIA_TYPE is organized in units of
NSR_DEV_BLOCK_SIZE_MEDIA_TYPE and is the number of blocks written
between filemarks. These filemarks are used to locate a particular spot on the tape
during recovery, and more filemarks generally lead to faster positioning. For
example:
NSR_DEV_TAPE_FILE_SIZE_TZ89=512

On UNIX and Linux platforms, the NetWorker software writes a filemark by closing
and reopening the tape device, which takes one or two seconds. If this value is too
small, throughput could be slowed and recoveries may take longer to complete.

Device parameter settings
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On Microsoft Windows platforms, the NetWorker software writes asynchronous
filemarks. This setting has a minimal effect on performance.
NSR_DEV_LOAD_TIME_MEDIA_TYPE
NSR_DEV_LOAD_TIME_MEDIA_TYPE is the number of seconds that nsrmmd
polls and waits for a drive to become ready after the library inserts a tape into the
device. NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE is used to set the
number of seconds nsrmmd waits between polls during load time.
If the value of NSR_DEV_LOAD_TIME_MEDIA_TYPE is too short, there could be
unnecessary load failures. If it is too long, then labeling new tapes takes longer than
necessary. The minimum allowable value is 10 seconds. The maximum value is 600
seconds. For example:
NSR_DEV_LOAD_TIME_DTL8000=300

NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE
NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE is the number of seconds that
nsrmmd waits between each attempt to read a newly inserted tape. The minimum
allowable value is 1 second, the maximum value is 30 seconds. For example:
NSR_DEV_LOAD_POLL_INTERVAL_DLT=10

NSR_DEV_LOAD_TRY_LIMIT_MEDIA_TYPE
NSR_DEV_LOAD_TRY_LIMIT_MEDIA_TYPE is the number of times that nsrmmd
will attempt to open a drive. The nsrmmd program will poll the drive until the limit
set in NSR_DEV_LOAD_TIME_MEDIA_TYPE is reached. After the limit is reached,
it will retry until the NSR_DEV_LOAD_TRY_LIMIT_MEDIA_TYPE is reached. The
default value and minimum allowable value is 2, the maximum value is 120.
NSR_DEV_LOAD_TRY_LIMIT_DLT=4

NSR_DEV_DEFAULT_CAPACITY_MEDIA_TYPE
NSR_DEV_DEFAULT_CAPACITY_MEDIA_TYPE is the size of the particular tape
used to base the percent full calculation. This variable value has no effect on the
actual tape capacity. Any integer value is allowed, with a KB, MB or GB designation
to indicate a range of values. Any value less than 200 MB will be overridden by the
normal default capacity. There is no obvious maximum, with the only practical
limitation being the actual storage size. For example:
NSR_DEV_DEFAULT_CAPACITY_DTL7000=12GB

Common device interface
The common device interface (CDI) allows the NetWorker server to send commands
to tape devices.
CDI support can be set in the NetWorker Administration interface:
1. In the server’s NetWorker Administration interface, click Devices.
2. Select View > Diagnostic Mode.
3. Select Devices in the navigation tree. The Devices detail table appears.
4. Double-click a device in the Devices table (or right-click the device and select
Properties). The Properties window appears, with the General tab selected.
5. Select the Advanced tab. In the Device Configuration area, locate the CDI
settings:
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• Not Used: Disables the CDI feature and uses standard tape driver calls for
tape operations.
• SCSI Commands: Sends explicit SCSI commands to tape devices.
When enabled, the CDI feature:
• Provides clearer tape status messages.
• Informs when a tape is write protected.
• Enables Tape Alert, which provides diagnostic information for devices.
Although the CDI feature can be disabled through selecting the Not Used option,
it can be time-consuming to disable a large number of devices.
In this situation, access the /nsr/debug directory and create a file named cdidisable.
Then restart the NetWorker server. This file does not need any content, it just needs
to exist. This disables the use of CDI for that server and all storage nodes controlled
by that server.
The CDI feature is not supported in these cases:
◆

Within an NDMP environment.

◆

On an SGI IRIX server or storage node.

The CDI feature is not supported for tape devices connected directly on SGI systems.
It can, however, be used by CDI- supported storage nodes (for example, Solaris)
controlled by a NetWorker server that is running on SGI.
Note: Use of CDI does not change what is written to tape. A tape written with CDI enabled can
be read with CDI disabled. Conversely, a tape written with CDI disabled can be read with CDI
enabled. The CDI feature enables NetWorker software to collect better diagnostic information
and facilitates tape usage when enabled. Only set or disable the CDI feature on the advice of an
EMC Customer Support representative. If tape or SCSI issues occur while the CDI feature is
enabled, go to the EMC Powerlink website.

Device ordering
The NetWorker server uses logical device names assigned by the operating system
when communicating with devices. It is possible for the operating system to
re-associate logical device names with the physical addresses of the devices,
generally after rebooting the host or after plug-and-play events. This may cause
device reordering, where the physical device will have a different device filename. As
a result, tape devices configured in the NetWorker software no longer match the
names of the devices as recognized by the operating system.
If device reordering occurs, the NetWorker software is unable to use any affected
drives until the configuration is manually corrected.
The NetWorker server detects device reordering events by comparing the current
serial number of the device to the serial number of the device at configuration. If the
serial numbers do not match, the NetWorker server stops all operations on that
device and an error message will be posted, similar to the alert identified for device
serial number mismatch in the table “Preconfigured notifications” on page 447. CDI
must be enabled for this functionality. “Common device interface” on page 268
provides more information about enabling CDI.

Device ordering
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Persistent binding and naming
Some operating systems provide the persistent binding option to permanently bind
logical and physical addressing so that the associations are retained. This guarantees
that the operating system always uses and creates the same symbolic path for a
device is known as persistent naming.
Proper configuration of the operating system to use persistent binding and persistent
naming resolves issues related to device ordering by forcing the operating system to
always assign the same device filename regardless of external events.
Persistent binding
Persistent binding guarantees that the operating system always uses the same SCSI
target ID for SAN devices, regardless of reboots or other events, by statically
mapping a target's WWN address to a desired SCSI address. On some operating
systems, this is done by default, while on others it has to be set manually. The
operating system documentation provides further information.
In most cases, persistent binding should also be set on the Host Bus Adapter (HBA)
by using the configuration utility that comes with the Fibre Channel HBA. The HBA
device driver documentation provides details.
Persistent binding is required for consistent library operations within NetWorker,
because the NetWorker server communicates with the library controller over a SCSI
address that is chosen during initial library configuration. If the SCSI address
changes, the library will become unavailable. In this case, disable the library and
change the "control port" address to reflect the new SCSI address of the library
controller.
If devices have already been configured in NetWorker prior to enabling persistent
binding on the host, delete existing devices from the library resource and perform a
re-scan of devices followed by a reconfiguration of the tape library.
Persistent naming
Persistent naming is used to ensure that the operating system or device driver of a
server always creates and uses the same symbolic path for a device (referred to as
device file).
Once persistently named device files are created and present on the host, enable the
use persistent names option when scanning for tape devices from the NetWorker
Management Console.
If devices have already been configured in NetWorker prior to enabling persistent
naming on the host, delete existing devices from the library resource and perform a
re-scan of devices followed by a reconfiguration of the tape library.

Detecting device ordering issues
To determine if there is a problem with device ordering in your environment, you
first determine if the device order that appears in nsrjb output matches the device
order from the inquire and sjisn commands, then verify that the device configuration
within your NetWorker configuration conforms to this.
To detect device ordering issues:
1. Execute the inquire command with the -cl option to determine the device path,
scsi address, and serial number of the device.
2. Execute the sjisn command to determine the current order of the devices:
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sjisn scsidev@bus.target.lun

where bus.target.lun is the SCSI address of the robotic arm returned by the inquire
command in step 1, for example, 1.2.0.
3. Match the serial numbers of the devices in the sjisn output to the device names
that correspond to these serial numbers in the inquire -cl output. This will give
you the current device order by device filename.
4. Execute the nsrjb command to determine the order of devices as configured in
NetWorker. Drive entries towards the end of the nsrjb output list the device order
as configured in NetWorker.
5. Compare the device ordering as determined in step 3 and step 4. If the device
ordering in these two steps do not match, the device ordering has changed and
the library will need to be reconfigured.

Correcting drive ordering changes
After a drive ordering change has taken place and the NetWorker software is no
longer correctly communicating with devices, you can correct the problem within
your NetWorker configuration by using the NetWorker Console or the jbedit
command line program.
Using NetWorker Console to correct drive ordering changes
To correct drive ordering changes by using the NetWorker Console:
1. Ensure that you have a current backup of the resource database.
2. Delete the library resource in the NetWorker Console. “How to delete a library”
on page 125 provides details.
3. Rescan the library. “Scanning for libraries and devices” on page 110 provides
more information.
Using the jbedit command to correct drive ordering changes
To correct drive ordering changes by using the jbedit command:
1. Use the jbedit command with the -d option to delete devices from the NetWorker
configuration
2. Use the jbedit command with the -a option to add the devices again.
“Using the jbedit command” on page 117, or the UNIX man page for jbedit or the
NetWorker Command Reference Guide provides more information on the jbedit
command.
Clearing device ordering/serial mismatch errors from the NetWorker Console
After a device ordering error has been detected, a message is displayed in the Alerts
and Notifications windows of the NetWorker Management Console, as well as the
log files. The error message is similar to the following:
“Check system device ordering. Moving device on %s to service mode. To
correct, scan for devices in NMC and re-enable the device.”

An Event ID for the error is also created, which will be removed along with the alert
when the problem is resolved. To resolve the problem and clear the error message:
1. Disable the drive.
2. Perform one of the above procedures to correct the problem.
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3. Re-enable the drive, and retry the operation that was being performed prior to
receiving the error.
The Alert will be removed and the event dismissed.

Nonrewinding tape device usage (UNIX/Linux only)
Tape drives used as storage devices must be accessed by nonrewinding device files.
The NetWorker server assumes that a tape is in the same position in which it was the
last time it was accessed. If the operating system’s device driver rewinds the tape,
then the position is lost, and previously written data will be overwritten by the next
backup.
The NetWorker configuration software automatically chooses the correct device
pathname for tape devices. If the user specifies the pathname, then it must be
nonrewinding, and it must follow the Berkeley Software Distribution (BSD) semantic
rules.
For example, /dev/rmt/0mbn, where:
◆

The b satisfies the BSD semantics requirement on Solaris and HP-UX.

◆

The n specifies nonrewinding behavior on Solaris, HP-UX, Linux, and HP-Tru64.

On AIX, the number following the decimal selects the BSD and nonrewinding
behavior and must be either 1 or 5 for NetWorker software (for example
/dev/rmt2.1)
Note: Never change a device pathname from nonrewinding (/dev/rmt/0cbn) to rewinding
(/dev/rmt/0cb). When the pathname is changed to rewinding, the data could only be saved,
but never recovered. All but the last save are overwritten by later saves.

Block-size mode (UNIX/Linux only)
Ensure that the block-size mode for tape devices that are used with NetWorker
software is set to variable. Otherwise, data recovery might fail. The procedure for
setting the device block size varies depending on the operating system.
The operating system’s documentation provides information about setting the tape
device block size in the operating system.

Silos
This section describes silos and silo devices. Silos and libraries are managed similarly
by NetWorker software.
A silo tape library (STL) is a peripheral that usually contains many storage devices.
Silos are controlled by silo management software, which is provided by the silo
vendor and installed on a silo server. The silo server cannot be the same computer as
the NetWorker server.
The silo can be shared among many applications, systems, and platforms. As with
libraries, silos make data and media operations more automatic. Silos can load,
change, and manage volumes, and clean the devices automatically.
“Media management in a silo” on page 305 provides information on silo-specific,
media-management concerns.
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NetWorker software interactions with a silo
A NetWorker server acts as a client of the silo management software, which resides
on the silo server. The NetWorker server communicates with the silo through the Silo
Tape Library Interface (STLI), which must be installed on the NetWorker server that
uses the silo.
To access the volumes and devices in a silo, the NetWorker server sends a request to
the silo management software, in the form of an STLI call. For example, to mount a
volume in a silo device, the NetWorker media service sends a request to the silo
management software to mount the volume into a particular device in the silo. The
silo server responds to the request and mounts the volume in the requested device.
The silo management software controls many of the operations that NetWorker
software controls with a library. For example, the silo management software keeps
track of the slot where each silo volume resides, and might control the deposit and
withdrawal of volumes, as well as automated cleaning of silo devices.

Installing a silo
To install a silo for use with NetWorker software:
1. Install the silo management software on the silo server.
2. Install the STLI on the NetWorker server, if required. For more information, refer
to the documentation from the silo vendor.
Note: For example, for a NetWorker server or storage node running Windows to control an
STK silo, the libattach program must be installed.

On UNIX systems, do not install the STLI library on the following models,
because all the necessary software is installed when the NetWorker software is
installed:
• IBM 3494 on Solaris and AIX
• StorageTek on Solaris, AIX, and HP-UX
• DAS on Solaris, AIX, and HP-UX
3. Ensure that the NetWorker server is properly connected to the media devices in
the silo.
4. Add the silo. Chapter 3, “Configuring Libraries and Devices” provides more
information.
Note: When adding a DAS silo, your hostname configuration files (for example, etc/hosts
and etc/inet/ipnodes) must use the shortname for the server.

Naming conventions for silo devices
The silo name of the storage devices is supplied during the configuration process.
The silo name is the name that the silo management software uses to refer to the
storage device. Depending on the type of silo, the device name can take several
forms. This section describes the naming conventions of the currently supported
silos.
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StorageTek
The StorageTek (STK) silo management software uses either a program called ACSLS
that runs on a UNIX system, or a program called Library Attach that runs on a
Multiple Virtual Storage (MVS) system. These programs name devices according to a
coordinate system based on the physical location of the devices in the silo.
For tape drives, the name consists of four digits separated by commas:
◆

The first digit refers to the automated cartridge system (ACS) with which the
drive is associated.

◆

The second digit refers to the library storage module (LSM) in which the drive is
located.

◆

The third and fourth digits refer to the panel and slot location in which the drive
is located.

A typical name for an STK drive is similar to: 1,0,1,0.
Ask the silo administrator for the drive names of the devices that the NetWorker
server can use. There is no way to get this information from the NetWorker server. To
connect to more than one drive, determine the SCSI IDs for each drive and properly
match the IDs to the silo names. If the operating system device names and silo names
are accidentally swapped, it is only possible to mount and unmount volumes.
Volumes cannot be read or written to after they are mounted. To reconfigure the
device names properly, use the Administration program to change the order of the
device names in the STL Device Names attribute of the library’s Properties.
IBM 3494
The silo management software for the IBM 3494 names devices with an eight-digit
number to identify the 3590 drives in the silo. Use the appropriate utility to obtain the
device names, as follows:
◆

On an AIX system, the NetWorker software obtains the name of the device from
the device driver and displays the device name as the default value.

◆

On a Solaris system, the IBM-supplied mtlib command (mtlib -l library_name -D)
must be used to determine the names of all the devices in the 3494, if the silo
name is configured by using the jbconfig command from the command-prompt,
rather than through the configuration interface. Either ask the silo administrator
which device is reserved for the NetWorker software, or test to determine which
silo drive name matches with each Solaris device name.

DAS
The silo management software for the DAS silos is a program called DAS (Dual
Attach Station). DAS acts as a front end for the silo control program called AMU.
When the silo is configured, the silo administrator gives each drive a symbolic name.
The symbolic name can be any alphanumeric string.
Set up DAS to work with NetWorker software
To set up DAS to work with NetWorker software the silo administrator must:
1. Configure DAS to accept commands from the NetWorker server or storage node
computer.
2. Perform one of these tasks:
• Use the dasadmin allocd command to allocate one or more devices to the
NetWorker server or storage node.
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• Configure the NetWorker server or storage node as an administrator, to be
able to execute the dasadmin allocd command to allocate devices from the
NetWorker server or storage node computer.
Note: The Console cannot be used to configure a DAS silo. To configure a DAS silo, use the
jbconfig command.

Find the assigned names for DAS devices in the silo
To find the names assigned to the devices in the silo, use the dasadmin utility, which
is installed with the NetWorker software.
To find the names:
1. Set these three environment variables:
• DAS_SERVER, the hostname of the silo management server, which runs DAS.
• DAS_CLIENT, the hostname of the NetWorker server or storage node.
• ACI_MEDIA_TYPE, one of these values: 3480, CD_THICK, CD_THIN,
DECDLT, 8MM, 4MM, D2, VHS, 3590, CD, TRAVAN, DTF, BETACAM,
AUDIO_TAPE, or DAS_MEDIUM, same value as ACI_MEDIA_TYPE.
2. Type this command to see a list of drives and the hostnames to which they are
allocated:
dasadmin ld

Releasing a silo device
When a silo device is configured for use with a NetWorker server, it is possible to
restrict silo access only to the NetWorker server. These restrictions allow increased
availability to the silo for those with full access. These restrictions can be lifted by
using the Release Device feature.
To release a silo device:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Select a silo in the navigation tree or double-click a silo in the Libraries detail
table to open the double-paned Library Operations view. The silo’s drives are
listed in the Device column. The slots are listed in the Slot column.
4. Right-click a silo in the Slot column, and select Release Device. A window
appears and asks whether to release devices.
5. Click Yes. The Library Operation window appears and displays this message:
The library operation has started.
Please see the Monitoring->Operations screen for its status.

6. Click OK.
7. Repeat step 1 through step 6 for each device to be released.
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Cleaning silo devices
Do not enable automated cleaning for silos in the NetWorker software. The
automated device cleaning feature depends on fixed slot numbers, so it cannot be
used in a silo, which does not have fixed slot numbers. For information about how to
clean devices in a silo, refer to the silo manufacturer’s software documentation.

Environment variables for DAS and StorageTek silos
Environment variables must be set for DAS and StorageTek silos. Table 42 lists the
environment variables to set.
Table 42

DAS and StorageTek environment variables

Silo model

Environment variables

DAS

DAS_SERVER = name_of_DAS_server
DAS_CLIENT = name_of_system_as_defined_to_DAS_server
DAS_MEDIUM = type_of_tape_drive_used
ACI_MEDIA_TYPE = type_of_tape_drive_used
For DAS_MEDIUM and ACI_MEDIA_TYPE, use one of these values:
• 3480
• OD-Thick
• OD-Thin
• DECDLT
• 8MM
• 4MM
• D2VHS
• 3590
• CD
• TRAVAN
• DTF
• BETACAM
• AUDIOTAPE
To specify the cartridge-access port or range of ports for depositing or withdrawing volumes, use
these environment variables rather than the -P ports option with nsrjb:
• DAS_INSERT_AREA_NAME=port
• DAS_EJECT_AREA_NAME=port
The default values for DAS_INSERT_AREA_NAME is I01, and the default value for
DAS_EJECT_AREA_NAME is E01.

StorageTek

For UNIX systems:
• CSI_HOSTNAME = name_of_ACSLS_system
The following commands should also be running on the system and can be included in the
NetWorker startup script:
• <networker_binaries_path>/mini_el &
• <networker_binaries_path>/ssi &
For Windows systems:
The LibAttach Configurator program is available from StorageTek. It creates an ssi process, and a
link is available to start the mini_el process from Start > Programs > LibAttach menu tree.
Once installed and configured, it starts on reboot.

Set the environment variables for UNIX systems
To set environment variables for DAS and StorageTek silos for UNIX systems:
1. Locate the NetWorker startup script.
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2. Using a text editor, open the NetWorker startup script and add the environment
variables after the lines:
(echo 'starting NetWorker daemons:') > /dev/console

3. Type the environment variables by using the format:
ENV_VAR = value
export ENV_VAR

4. Restart the NetWorker server in order for the environment variables to take
effect.
Table 43 lists the locations of the NetWorker startup scripts.
Table 43

NetWorker Startup Commands

Operating system

Startup command

Solaris, IRIX

/etc/init.d/networker

HP-UX, HP Tru64 UNIX

/sbin/init.d/networker

AIX

/etc/rc.nsr

Set the environment variables for Microsoft Windows systems
To set environment variables for DAS silos for Microsoft Windows systems:
1. From the Start menu, select Settings > Control Panel > System > Advanced >
Environment Variables > New > System Variables.
2. Type the environment variable names.
3. Restart the system in order for the environment variables to take effect.

Miscellaneous device operations
This section covers various additional device operation topics.

Refreshing enterprise library views on request
To update enterprise library views on request:
1. From the Console window, click Libraries.
2. In the navigation pane, select a server to update, or select the top item in the
hierarchy to update library information for all NetWorker servers.
3. Right-click the server, and select Refresh.

Changing the polling interval for enterprise library views
Enterprise library views are updated periodically without user intervention.
To change the update interval:
1. From the Console window, click Setup.
2. From the Setup menu, select System Options.
3. In the Polling Interval for NetWorker Libraries field, type the appropriate time,
in hours.
Miscellaneous device operations
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4. Click OK.

Stopping a device operation
To stop a device operation that is in progress:
1. In the NetWorker Administration window, click Monitoring.
2. Select the Operations tab.
3. Right-click an operation, and select Stop.
4. Click Yes to stop the operation, or No to resume it.

Display device operations messages
To display device operations messages:
1. In the NetWorker Administration window, click Monitoring.
2. Select the Operations tab.
3. Right-click an operation, and select Show Details.
The details window for the selected device appears.
4. Click Close to exit the window, or Save to save the message.

Sharing libraries among NetWorker hosts
The NetWorker software permits different NetWorker hosts (a NetWorker server or
storage node) within a datazone to control individual devices within a library. This is
known as library sharing.
The presence of a SAN within the datazone is not required for library sharing.
Dynamic Drive Sharing (DDS) does not support sharing libraries across datazones.
How library sharing works
Library sharing enables one NetWorker host to control the library’s robotic arm,
while other NetWorker hosts (as well as the host controlling the robotic arm) can each
control and use specific library devices. A specific device can be controlled only by a
single NetWorker host. Figure 30 shows how multiple NetWorker hosts can share
library devices.
NetWorker server

Control of device

Control of library
Storage node
Device 1
Device 2
Shared library
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Figure 30

How library sharing works

Sleeping periods for library tasks
Library resources include attributes used by older, slower libraries that specify the
number of seconds a library is inactive after certain operations (such as loading,
unloading, or ejecting a volume). For example, once a tape is loaded, the library must
read and, possibly, reposition the tape before the next operation can begin. This
period of delay is known as sleeping.
While sleeping, the library cannot receive or perform other operations. Without the
sleep period, the loading or unloading of volumes might fail.
The NetWorker software automatically configures default sleep periods. Change
these values only when troubleshooting a library’s performance, or if a NetWorker
technical support specialist requests it. Typically, the higher the sleep values
specified in the attributes, the longer it takes the library to perform the task. Be
cautious when changing these values.
The sleep attributes and their default values are shown in Table 44.
Table 44

Library resource sleep attributes

Attribute

Description

Default value

Load Sleep

Number of seconds that the NetWorker software waits for a
library to complete loading a cartridge.

15 seconds

Unload Sleep

Number of seconds that the NetWorker software waits for a
library to complete unloading a cartridge.

60 seconds

Eject Sleep

Number of seconds that the NetWorker software waits for a an
eject operation to complete.

60 seconds

Deposit Timeout

Number of seconds for a library to wait for a tape to be
deposited in the mail slot before it times out.

15 seconds

Withdraw Timeout

Number of seconds for a library to wait for a tape to be
withdrawn from the mail slot before it times out.

15 seconds

Cleaning Delay

Number of seconds that the NetWorker software waits between
the completion of a drive cleaning operation and the ejection of
the cleaning cartridge from the drive.

60 seconds

Idle Device Timeout

Number of minutes that the NetWorker software waits for a
device to become idle after a backup has completed.

0 minutes

Port Polling Period

Number of seconds for a library to wait before polling a mail slot
to check for the updated status.

3 seconds

Server Network Interface attribute
The Server Network Interface attributes in the Device resource are used to determine
the network address or the hostname used by the nsrmmd program to communicate
with the NetWorker server. Similarly, the Server Network Interface attribute in the
Library resource is used to determine the network address or the hostname used by
the nsrlcpd program to communicate with the NetWorker server. These attributes
are displayed in the NetWorker Console in diagnostic mode only. The Server
Network Interface attributes are only relevant if the device or library is connected to a
storage node.
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Note: For devices, the nsrmmd program will read the Server Network Interface value for the
first enabled device from the list of storage node devices, and each subsequent nsrmmd started
by the NetWorker server will use the same value. Therefore, the NetWorker server will always
use the same Server Network Interface value for every nsrmmd it starts or restarts, regardless
of whether or not the Server Network Interface attribute is different for each device.

Tips for using libraries
This section provides additional suggestions for using libraries effectively and
reliably.

Library notifications
The NetWorker server uses notifications to send messages about NetWorker events.
Several preconfigured notifications, such as the following, provide information about
various situations:
◆

Volumes in the library are 90% full.

◆

Library needs more volumes to continue.

◆

Library has a mechanical problem.

◆

Library device needs cleaning.

◆

Cleaning cartridge needs attention.

“Notifications” on page 447 provides more information about notifications.
The NetWorker software automatically mounts a required volume as long as the
volume is loaded in the library. If a recovery operation requires a volume that is not
loaded in the library, the Tape mount request 1 notification sends an alert to
Monitoring > Alerts, with a request to do something with a specific volume.
After a library problem is corrected, it might be necessary to mount a volume so the
NetWorker server can continue to back up or recover files.

Recycling compared to adding more volumes
The NetWorker server saves files on volumes marked appen (appendable). If the
volumes are marked full, they cannot receive backups.
If volumes are marked full, you can:
◆

Remove the full volumes and replace them with new media if the volumes are
being kept for long-term storage.

◆

Change the volume mode to recyc (recyclable) if the data on the full volumes is
not needed. The NetWorker server overwrites the data with new backups, but
maintains the existing labels. “Changing a volume’s mode” on page 291 provides
information about changing the volume mode.

When all of the save sets on the volume have passed the time period specified by the
retention policy, the mode of the volume automatically changes to recyclable.
There are advantages both to recycling media and adding more media to a pool. With
recycling, the same volumes are used repeatedly, and there is no need to add new
volumes to the pool. The volumes can, however, wear out over time and exhibit a
higher failure rate.

280

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Device Operations

On the other hand, if backups are to be stored for some time, then it might be
necessary to add more media to the pool instead of recycling. For example, a library
might need new volumes every three months if the company policy is to maintain the
backups for a year. In this case, new media must be added to the pool until the
volumes that contain expired or old backups can be recycled.

Resetting a library
A library must be reset each time the library and the NetWorker software become out
of sync. Example 5, “Host crash requires user intervention” provides details. A
library reset can be done using either the Administration interface or the command
prompt.
Reset a library in the Administration interface
To reset a library in the Administration interface:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Select a library in the navigation tree or double-click a library in the Libraries
detail table to open the double-paned Library Operations view.
The library’s drives are listed in the pane on the left in the Device column. The
library’s slots are listed in the pane on the right.
4. Right-click a library in the Device column, and select Reset. You are prompted to
reset the library.
5. Click Yes. The Library Operation window appears and displays this message:
The library operation has started.
Please see the Monitoring->Operations screen for its status.

6. Click OK.
Reset a library from the command-prompt
Use the nsrjb -HE command to reset a library from the command prompt. For
example, the library inventory must be correct after adding drives to an SJI-compliant
library, such as adding DLT7000 drives to an ETL 7/3500 device.
To make the NetWorker software aware of these new drives, execute nsrjb -HE to
reset the library. The -E option reinitializes the library’s element status. Some libraries
can keep track of whether there is media in a component in the library. This feature is
known as an element status capability.
A series of commands exists that allow direct interaction with libraries (sji
commands) and tape drives (cdi commands). These commands should only be used
by the most knowledgeable of NetWorker users, as the consequences of using them
can be unknown. For information about these commands, refer to the EMC NetWorker
Command Reference Guide or the UNIX man pages.
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Using pools with libraries
If the backup strategy includes both full and nonfull backups, estimate the number of
volumes needed for the full backups and assign them to the Full pool. This ensures
that the full backups are located in a consecutive range of slots in the library. This
allows all of the volumes to be removed at the same time. “Media pools” on page 184
provides more information.

Device calibration
For information about the frequency and method for calibrating the loading
mechanism for the device, refer to the library manufacturer’s documentation.

Reordering tape drive numbers (Microsoft Windows only)
If more than one tape drive is attached to the NetWorker server when both the server
and drives are shut down, restart all of the tape drives, either before or immediately
after the NetWorker server is restarted. If Windows does not locate all of its
previously configured tape drives at the time of startup, it automatically reassigns the
tape registry name.
For example, assume that these three tape drives are attached to the server:
◆

The first one, \\.\Tape0, is a 4 mm tape drive.

◆

The second, \\.\Tape1, is an 8 mm tape drive.

◆

The third, \\.\Tape2, is also an 8 mm tape drive.

If only the second and third tape drives are restarted, Windows reassigns the tape
registry numbers so that the second storage device becomes \\.\Tape0 and the third
storage device becomes \\.\Tape1. The tape registry numbers no longer match the
defined storage devices within the NetWorker software. As a result, the server
mishandles the drives and their volumes.
It might be easier to leave a nonoperational drive (device) attached to the server until
a replacement is available. If the drive is removed, the name must be deleted, and
then the new drive must be added.
To disable the drive, select No for the Enabled attribute in the device’s Properties.

Adding and removing media by using the library front panel
Certain media libraries allow for media to be added and removed by using the front
panel display. This operation circumvents the NetWorker server's normal procedures
for adding and removing volumes and may cause the server information to become
out of sync with the library. Normally, you should use the NetWorker server
procedures for adding and removing media, rather than the library's front panel
display. This is more efficient and guarantees that the server and the library will be in
sync.
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If it is necessary to use the library's front panel display to add and remove volumes,
do the following:
1. In the Properties window for the Library, on the General tab, set Status Enabled
to Service.
Note: Putting the library in service mode will cancel all operations or wait for operations to
complete that cannot be canceled, and then put the library into disabled mode.

2. Once the library is in disabled mode, use the library's front panel to add and
remove tapes.
3. In the Properties window for the Library, on the General tab, set Status Enabled
to Enabled.
4. Inventory the library. “Inventorying library volumes” on page 301 has
information about inventorying libraries.
Note: When a library is partitioned, the NetWorker software does not become aware of the
partitioning. This means that the entire physical library will be disabled, not just one partition.
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Storage management operations
This section describes the components involved in the operation of storage volumes
done through the NetWorker server. The details that describe a particular volume
can be viewed, and often changed, by right-clicking the volume and making a
selection from the menu. As with other Console functions, users can view and work
with only those NetWorker servers for which they have access permission.

How the NetWorker server uses volume labels
A volume label is a unique internal code, applied by the NetWorker server, that
initializes the volume for the server to use and identifies a storage volume as part of a
specific pool. “Using media pools” on page 184 provides more information about
pools. Labeling a volume provides a unique name for tracking and recognizing the
media, as well as references to volume labels in the records stored in the media
database. The NetWorker server uses the media database records to determine which
volumes are needed for backing up or recovering data.
When it labels a volume, the NetWorker server:
1. Verifies that the volume is unlabeled.
2. Labels the volume with the name specified in the Volume Name attribute by
using one of the following:
• The next sequential label from the label template that is associated with the
chosen pool.
Note: If a recyclable volume from the same pool is relabeled, the volume label name
and sequence number remain the same, but access to the original data on the volume is
destroyed. The volume becomes available for new data.

• An override volume name that was entered by the user.

How the NetWorker server selects a volume
When a backup takes place, the NetWorker server searches for a volume from the
appropriate pool to accept the data for backup. The available volumes are as follows:
◆

Mounted on stand-alone devices.

◆

Available for labeling and accessible to the NetWorker server through Auto
Media Management or a library.

◆

Labeled for the appropriate pool and already mounted in a device, or are
available for mounting, if a library is being used.

If two or more volumes from the appropriate pool are available, the server uses this
hierarchy to select a volume:
1. Mounted volumes from the appropriate pool with the mode appendable are
selected. This includes newly labeled volumes. If more than one mounted volume
is appendable, the server uses this hierarchy:
a. Device availability. The server writes to the volume from the appropriate pool
that is mounted on the device with the fewest current sessions.
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b. Volume label time. The server writes to the volume with the oldest label time
if the mounted volumes are appendable and session availability is not an
issue.
2. If a library is in use and there is no mounted, appendable volume in the library,
the server determines whether there is an unmounted, appendable volume
available. This includes newly labeled volumes.
3. If multiple unmounted, appendable volumes are available, the volume with the
oldest label time is selected.
4. If no mounted volumes are appendable and Auto Media Management is enabled,
a mounted volume with the mode recyclable is selected. The server relabels and
mounts the volume.
Note: A volume is automatically set to recyclable when all save sets on the volume,
including partial save sets that span other volumes, are marked as recyclable.

5. If a stand-alone device is being used and Auto Media Management is not enabled,
the server sends a mount request notification.
6. If a library is in use and no unmounted, appendable volumes exist, the server
determines whether there is an unmounted, recyclable volume.
7. If Auto Media Management is not enabled, or if there are no appendable or
recyclable volumes, the server sends a mount request notification.
“Volume operations” on page 289 provides information about appendable and
recyclable volumes.
Data recovery and volume selection
The NetWorker server determines which volumes are required for recovery. If the
appropriate volume is currently mounted, the recovery begins. If the volume is not
mounted and a library is used, the server attempts to locate and mount the volume. If
a stand-alone device is used, or if the server cannot locate and mount the volume, the
server sends a mount request notification.
If more than one volume is needed to recover the data, the NetWorker server
displays all the volumes, in the order needed. During the recovery process, the server
requests the volumes, one at a time.
Note: NetWorker will automatically unload volumes that have been placed in a jukebox device
but have never been mounted (for example, nsrjb -l -n <volume>). Any command, such as the
scanner command, that operates on volumes that have never been mounted will be affected by
this behavior. To prevent NetWorker from unloading the volume, the device should be set to
service mode while the command is being run.

Automatic volume relabel
If Auto Media Management is enabled and a volume has the mode recyclable, the
server automatically relabels the volume. A volume is automatically set to recyclable
when all save sets on the volume, including partial save sets that span other volumes,
are marked as recyclable. The mode of a volume can also be manually changed to
recyclable. “Changing a volume’s mode” on page 291 provides information about
changing the mode of a volume.
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Auto Media Management
This section describes how NetWorker works with Auto Media Management.
Auto Media Management gives the NetWorker server automatic control over media
loaded in the storage device. When Auto Media Management is enabled during
device configuration, the NetWorker server automatically:
◆

Labels the volume (recognizes EDM labels and does not overwrite them).

◆

Mounts the volume.

◆

Overwrites volumes it considers to be unlabeled.
The NetWorker server considers a volume to be unlabeled under the following
conditions:
• Has no internal label.
• Is labeled with information other than a NetWorker label.
• Is labeled with a NetWorker label, but the density indicated on the internal
label differs from that of the device where the volume is mounted.

◆

Recycles volumes eligible for reuse that are loaded into the device.

◆

Because the Auto Media Management feature can relabel a volume that has a
different density, it is possible, inadvertently, to overwrite data that still has
value. For this reason, be careful if NetWorker volumes are shared among
devices with different densities.

◆

When the Auto Media Management feature is not enabled, the NetWorker server
ignores unlabeled volumes and does not consider them for backup.

Note: The NetWorker server considers volumes that were labeled by a different application to
be valid relabel candidates if Auto Media Management is enabled. Once the NetWorker server
relabels the volume, the previously stored data is lost.

Using Auto Media Management
This section describes how to use Auto Media Management.
Existing tapes with NetWorker labels
When Auto Media Management is used with tapes that have NetWorker labels that
have not been recycled, the volumes must be removed from the media database
before a utility such as tar is used to overwrite the labels. Also ensure that the tapes
have been fully rewound before overwriting the labels. Auto Media Management can
then properly relabel the tapes.
Enabling for stand-alone devices
The Auto Media Management feature can be enabled for stand-alone devices during
manual device configuration, or from the Properties window after configuration.
When Auto Media Management is enabled for a stand-alone device, the following
processes occur when a volume becomes full during a backup:
◆
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Note: Nothing happens until the full volume has been unmounted by the operator.
◆

The device is monitored and the software waits for another volume to be inserted
into the device.

◆

After a volume is detected, a check is performed to determine whether the
volume is labeled. If so:
• The volume is mounted into the device.
• The NetWorker server checks to see whether the newly mounted volume is a
candidate to receive data:
a. If yes, the write operation continues.
b. If no, the NetWorker server continues to wait for a writable volume to
continue the backup.
Note: Again, nothing happens until the full volume has been unmounted by the operator.

◆

If the volume is recyclable and is a member of the required pool, it is recycled the
next time a writable volume is needed.

◆

If the volume is unlabeled, it is labeled when the next writable volume is needed
for a save.

Note: If a partially full volume is unmounted, the NetWorker server automatically ejects the
volume after a few seconds. If a stand-alone device is shared between storage nodes, then Auto
Media Management should not be enabled for more than one instance of the device. Enabling
Auto Media Management for more than one instance of the stand-alone device will tie up the
device indefinitely. No data is sent to the device and no pending message is sent.

Enabling for libraries
Auto Media Management is not enabled for libraries during autoconfiguration. Auto
Media Management for a library can be set by changing the library’s properties after
configuration.
To enable auto media management:
1. In the server’s Administration window, click Devices.
2. Select the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Right-click the library, and select Properties. The Properties window appears.
4. Select the Configuration tab.
5. In the Media Management area, select Auto Media Management.
6. Click OK.

Volume operations
The volume operations sections describe the tasks involved in the operation of
storage volumes done through the NetWorker server. Information about storage
volumes is available for each device on a NetWorker server. All volume operations
are performed in the Media task in the Administration window.
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If a volume is not mounted when a backup is initiated, then one of three messages
appears, suggesting that one of these tasks be performed:
◆

Mount a volume.

◆

Relabel a volume (only when Auto Media Management is enabled).

◆

Label a new volume (only when Auto Media Management is enabled).

During file recovery, the NetWorker server requests the volume name. If more than
one volume is needed to recover the files, the server lists all the volumes in the order
in which they are needed. During the recovery process, the server requests each
volume, one at a time. If a library is used, the server automatically mounts volumes
stored in the library.
The NetWorker server reports on the status of volumes using values such as:
◆

Volume name

◆

Written

◆

%Used

◆

Location

◆

Mode

Performing volume operations requires that the user have the correct permissions to
use the NetWorker server and its storage nodes.
Viewing volume status information
To find information about a volume and its status:
1. In the server’s Administration window, click Media.
Media-related topics appear in the navigation tree.
2. Select Volumes. The Volumes detail table appears. Table 45 on page 290 lists the
volume-related categories displayed in the Volumes detail table.
Table 45
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Volumes detail (1 of 2)

Category

Description

Volume Name

Within the Administration interface, the volume name is the same as the name that appears on the
volume label. At the end of the name, these designations might appear:
1. (A) indicates an archive volume.
2. (R) indicates a volume that is considered read-only.
3. (W) indicates that the volume is a write once, read many (WORM) device.

Barcode

Barcode label, if one exists.

Used

Indicates the amount of space currently in use on the volume (shown in KB, MB, GB, as
appropriate). When Used is equal to full, there is no more space on the volume and the
end-of-tape marker has been reached or an error with the volume has occurred.

% Used

An estimate of the percentage used, based on the total capacity of the volume, and on the
specified value of the Media Type of the Device resource. When %Used is equal to 100%, it means
that the value is equal to, or exceeds, the estimate for this volume.
When the word "Full" appears in the % Used column, it is not based on an estimate of the volume’s
capacity. "Full" literally means that the volume is full.
This attribute applies only to tape volumes. File type and advanced file type devices always display
0% Used.

Mode

Choices are appendable, read-only, and recyclable. Table 46 on page 291 lists the NetWorker
volume modes and their definitions. “Changing a volume’s mode” on page 291 provides
information on changing volume modes.
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Volumes detail (2 of 2)

Table 45

Category

Description

Expiration

Changing the expiration date is only possible from the command prompt. Use the nsrmm
command to do this.

Location

Refers to an administrator-defined description of a physical location of the volume within the user’s
environment, for example, 2nd shelf, Cabinet 2, Room 42.

Pool

Name of the pool to which the volume belongs.

Volume modes

Table 46

Mode value

Meaning

Description

appen

appendable

This volume contains empty space. Data that meets the acceptance criteria for the pool to
which this volume belongs can be appended.

man

manual recycle

This volume is exempt from automatic recycling. The mode can be changed only manually.
The manual recycle mode and the option to change it are available from the Volumes menu.
The default recycle mode is Auto.

(R)

read-only

The save sets on this volume are considered read-only. The mode can be changed only
manually. “Using the read-only mode” on page 291 provides more information.

recyc

recyclable

The save sets on this volume have exceeded their retention policies.

full

full

The volume is full. There is no more space for data in the volume, and the save sets have not
yet passed the time periods specified by the retention policies. This mode can be set only
from the command-prompt. Use the nsrjb command with the -o option for libraries, and the
nsrmm command with the -o option for stand-alone drives. Refer to the respective UNIX man
pages of those commands (or to the EMC NetWorker Command Reference Guide) for more
information.

Using the read-only mode
When the mode of a volume is read-only, no new data can be written to the volume. A
read-only volume is not a write-protected volume. The save sets on the volume are still
subject to their browse and retention policies, and the volume is not protected from being
overwritten. When all the save sets on the volume have changed their status to recyclable, the
mode of the volume changes to recyclable, and the volume becomes eligible for automatic
recycling.
“Changing a volume’s mode” on page 291 provides information on changing the volume
mode.

Changing a volume’s mode
To change the mode of a volume:
1. In the server’s NetWorker Administration window, click Media.
2. In the navigation tree, select Volumes. The Volumes detail table appears, showing all of
the server’s volumes.
3. Right-click a volume in the Volumes detail table, and select Change Mode. The Change
Mode window appears.
4. Select a mode and click OK.
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Recycling volumes
A volume's retention policy can be overridden by changing it to manual recycle. One
reason to change to manual recycle is when save sets must be kept on a volume
longer than its retention policy specifies. A volume marked for manual recycle can be
changed back to recycle automatically, so that the volume once again uses its original
retention policy.
Change a volume’s recycle policy
To change a volume’s recycle policy:
1. In the server’s Administration window, click Media.
2. In the navigation tree, select Volumes. The Volumes detail table appears.
3. Right-click a volume in the Volumes detail table, and select Recycle. The Recycle
window appears. It names the selected volume.
4. Select the recycle policy: Auto (default) or Manual.
5. Click OK.
Note: A volume that has been set to manual recycle retains that setting, even after relabeling. It
must be explicitly reset to use auto recycle.

Labeling volumes
The NetWorker software labels each storage volume with a unique internal label that
corresponds to a pool. During backup and other operations, this label identifies the
pool to which a volume belongs. NetWorker software applies a label template to
create a unique internal label for each volume. The NetWorker server uses label
templates and pool configuration settings to sort, store, and track data on media
volumes.
Note: Label templates are created in the Media task, but they are applied to volume labels in
the Devices task. Data that exists on a tape is effectively gone after the tape has been relabeled.

Labeling a volume does the following:
◆

Writes a label on the volume.

◆

Adds the volume label to the media database.

◆

Prepares the tape to have data written to it.

During data recovery, the server asks for a specific volume that contains the required
data, identifying the required volume by the name with which it was labeled.
Chapter 7, “Sorting Backup Data” provides information about label templates and
pools.
Label templates
Several preconfigured label templates are supplied with the NetWorker software.
These preconfigured label templates cannot be deleted. “Naming label templates” on
page 199 provides more information about label templates and preconfigured label
template.
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Label or relabel library volumes
Labeling volumes in a library is time-consuming, so consider labeling volumes before
it is time to back up or recover files. Library volumes are labeled in the Devices task.
To label a library volume:
1. In the Administration window, click Devices.
2. Open the Libraries folder. The Libraries detail table appears.
3. In the navigation pane, right-click the appropriate library and select Label. The
selected library’s details appear, including divided tables for devices and slots.
The Label Library Media window also appears.
4. The Default pool name appears in the Target Media Pool field. To select a
different pool, click the field’s down arrow for a list of other pool choices. The
pool determines which label template is used in labeling the volume.
5. If the volume should not be recycled automatically, click Allow Manual Recycle.
If Allow Manual Recycle is enabled when the volume is labeled, the volume is
not automatically marked as recyclable when all of its save sets have expired.
Only an administrator can mark the volume recyclable.
Note: A volume that has been set to manual recycle retains that setting, even after
relabeling. A Manual Recycle policy cannot be changed back to Auto Recycle simply by
unselecting the Manual Recycle checkbox. The volume must be explicitly reset to use auto
recycle. “Recycling volumes” on page 292 provides more information.

6. To be prompted before the existing label is overwritten, select Prompt to
overwrite label.
7. Click OK. The Library Operation window appears, stating that the library
operation has started.
8. Select Monitoring, then the Operations tab, to track the status of the label
operation.
9. If Prompt to overwrite label was selected, right-click the label operation in the
Operations Status window to confirm intent to overwrite the existing volume
label with a new label, and select Supply Input.
A question window appears displaying this message:
Label <labelname> is a valid NetWorker label. Overwrite it with a new
label?

10. Click Yes to overwrite the label with a new label, or No to cancel the label
operation.
Note: When a volume is relabeled, that volume is initialized and becomes available for writing
again.

Verifying the Label when volume is unloaded
If a SCSI reset is issued during a backup, the volume will rewind and NetWorker
may overwrite the volume label. To detect if the label is overwritten in this
circumstance, set the Verify Label On Eject attribute in the Device resource, or the
Verify Label On Unload attribute in the Jukebox resource to Yes. When either of
these attributes is set to Yes, NetWorker verifies that a volume label exists before
ejecting the volume. If the volume label cannot be read, all save sets on the volume
are marked as suspect and the volume is marked as full.
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Empty slots in label operations
Slots that have been intentionally left empty (such as bad slots) are skipped during
labeling operations. The NetWorker software logs a message similar to: "Slot 5 empty,
skipping."

Using barcode labels
The option to label a library volume with a barcode is available during automatic
device configuration. “How to configure devices” on page 35 provides more
information. This option can be set in the library’s Properties tab after configuration.
Barcode labels make volume inventory fast and efficient. They eliminate the need to
mount the volumes in a device. The library scans the external barcode labels with an
infrared light while the volumes remain in their slots. Inventorying with barcode
labels greatly reduces the time needed to locate a volume or determine the contents of
a library.
Barcode labels also provide greater labeling accuracy. The labels are placed on the
volumes before the volumes are loaded and scanned in the library. Once the library
has scanned the barcode, the NetWorker server records and tracks the label in the
media database. The NetWorker server uses barcode labels only to inventory
volumes. A volume must have a label, but it need not have a barcode label.
Note: Libraries include hardware that reads barcode labels. The barcode information is then
forwarded to the NetWorker server. Problems reading barcode labels indicate hardware
problems. In the event of a barcode-related problem, consult the library’s documentation or the
hardware vendor.

Requirements for performing an inventory with barcodes
To perform an inventory by using barcodes, the following requirements must be met:
◆

The library must have a barcode reader.

◆

A barcode label must be present on the tape.

◆

The location field within the NetWorker media database must be correct or null.
To view the location field, use the mmlocate command.

Configure a library to use volumes with barcodes
To select whether barcodes are used or matched after configuration:
1. In the Administration window, click Devices.
2. Open the Libraries folder. The Libraries detail table appears.
3. Right-click the appropriate library, and select Properties. The Properties window
appears.
4. Select the Configuration tab.
5. In the Media Management area of the Configuration tab, select:
• Bar Code Reader
• Match Bar Code Labels
6. Click OK.
“Barcode labeling tips” on page 295 provides more information.
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Use unmatched volume and barcode labels
Note: If unmatched volume and barcode labels are to be used, ensure that labels are attached to
the outside of the volumes.

To use unmatched volume and barcode labels:
1. Apply barcode labels to the volumes.
2. Place the volumes with the barcode labels in the library.
3. In the Administration window, click Devices.
4. Open the Libraries folder. The Libraries detail table appears.
5. Right-click the appropriate library, and select Properties. The Properties window
appears.
6. Select the Configuration tab.
7. In the Media Management area of the Configuration tab:
• Select Bar Code Reader.
• Ensure that Match Bar Code Labels is not selected.
8. Click OK. The NetWorker server uses the next available label from the label
template for the volume name. It labels the volumes and records both labels in the
media database.
9. Inventory the volumes to ensure that the NetWorker server has the most current
volume information.
10. Use Media > Volumes to match the correct volume labels to the barcode labels.
Consider making a list of the name correlations.
Note: If the barcode function is enabled, but no barcode label is affixed to the volume, an error
message indicates that a barcode label does not exist.

Barcode labeling tips
The NetWorker server uses volume labels and barcode labels to identify volumes.
Both label types are recorded in the media database. The volume label is also
recorded internally on the media (internal volume label). The NetWorker server uses
barcode labels to inventory volumes, and uses volume labels to identify the volumes
needed for backup and recovery. A requirement to match the volume label with the
barcode label can be set in the library’s Properties window.
Follow these guidelines when using barcode labels with the NetWorker software:
◆

When NetWorker software relabels volumes automatically, it reuses the original
volume label name. A label name can be changed only if the volume is relabeled
manually. The NetWorker software scans the barcode label during the labeling
process and updates the media database with the new volume name and its
associated barcode label.

◆

Do not use identical barcode labels for any of the NetWorker volumes. The use of
identical labels defeats the purpose of using barcode labels, which is to facilitate
the inventory process and ensure label accuracy.

◆

Volume names must be unique on the NetWorker server. Give each volume a
unique volume label. If a second volume is labeled with an existing barcode label
and the Match Barcode Labels attribute in the library’s properties is enabled, the
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NetWorker server displays an error message and does not allow the second
volume to be labeled. The error message identifies the library slots containing the
two volumes with identical labels and the barcode label.
To correct this problem, either apply a different label to one of the volumes and
restart the labeling process, or disable the Match Barcode Labels attribute in the
library’s properties while labeling the second volume.
◆

It is not necessary to label existing volumes with barcode labels if they are stored
in a vault or offsite for long periods. These volumes are rarely, if ever,
inventoried.

◆

Before using barcode labels on existing volumes, affix the barcode labels to them.
Then, load and mount each volume individually, so that the NetWorker server
can match the barcode label with the existing volume label.

◆

Record the volume label on the tape.

◆

A variety of barcode labels can be purchased from third-party vendors. Choose
from among numeric labels, alphanumeric labels, or a special combination of
numbers and characters. Furthermore, barcode labels can be ordered to match a
current volume labeling scheme.

◆

Use a consistent labeling scheme. If volumes are labeled with the server name and
an extension such as “001,” order a range of labels starting with
“server_name.001” and ending with “server_name.100”, or as wide a range as
necessary. Instructions for barcode labels should be provided with the library
hardware documentation. Contact the hardware manufacturer with questions
about barcode labels. A consistent labeling scheme helps better organize and
track volumes. It also facilitates the inventory process if all of the volumes, use
barcode labels.

Mounting and unmounting volumes
A volume must be mounted before files can be backed up. If no volume is mounted at
the start of a backup, an error message appears and requests that a volume be
mounted.
Mount or unmount a volume in a library
To mount a volume in a library:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Select a library in the navigation tree or double-click a library in the Libraries
detail table to open the double-paned library operations view. The library’s
drives are listed in the Devices column, and its slots are listed in the Slot column.
4. To mount a volume:
a. In the Devices column, select the appropriate drive.
b. In the Volume column, right-click a volume to mount, and select Mount.
– The Library Operation window displays this message:
The library operation has started.

– The Monitoring > Operations screen displays its status.
c. Click OK.
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5. To unmount the volume:
a. Right-click the device or the volume in the double-paned table view of the
library and select Unmount.
– The Library Operation window displays this message:
The library operation has started.

– The Monitoring > Operations screen displays its status.
6. Click OK.
Mount or unmount a volume in a stand-alone tape drive
To mount a volume in a stand-alone drive:
1. Manually insert a volume in the stand-alone drive, or ensure that a volume is
already loaded.
Note: In a stand-alone device, a volume that has been loaded into the drive is not
considered to be mounted until it has been explicitly mounted in the user interface or from
the command-prompt.

2. In the Administration window, click Devices.
3. Select Devices in the navigation tree. The Devices detail table appears.
4. Select the appropriate device. To mount the volume, in the Devices detail table,
right-click the device and select Mount.
5. To unmount the volume, in the Devices detail table, right-click the device and
select Unmount.
• The Library Operation window displays this message:
The library operation has started.

• The Monitoring > Operations screen displays its status.
6. Click OK.
Note: To perform an unattended backup using a stand-alone device, ensure that a labeled
volume is mounted in the device before it is left unattended.

Label and mount a volume in one operation (stand-alone tape drive)
When more than one storage device is connected to the NetWorker server, the device
to be used for labeling must first be selected from the list of available devices.
Remember that labeling a volume makes it impossible for the NetWorker server to
recover original data from that volume.
To label and mount a volume in a single operation in a stand-alone tape drive:
1. In the Administration window, click Devices.
2. Manually insert an unlabeled or recyclable volume in the NetWorker server
storage device, or ensure that a volume of this type is already present for the
NetWorker server to access.
3. Select Devices in the navigation tree. The Devices detail table appears.
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4. Right-click the appropriate stand-alone device in the detail table, and select
Label. The Label window appears:
a. Type a unique label name, or accept the default name associated with the
selected pool.
Note: If the volume is unlabeled, the NetWorker server assigns the next sequential
label from the label template associated with the selected pool. If a recyclable volume
from the same pool is being relabeled, then the volume label name and sequence
number remain the same. Access to the original data on the volume is destroyed,
however, and the volume becomes available.

b. Select a pool on the Pools menu. The NetWorker server automatically applies
the label template associated with the Default pool unless a different pool is
selected.
c. Select the Manual Recycle attribute if the volume should be manually
recycled.
If the Manual Recycle attribute is enabled when the volume is labeled, the
volume cannot automatically be marked as recyclable according to the
retention policy. When a volume is marked manual recycle, the NetWorker
server disregards the assigned browse and retention policies. Therefore, only
an administrator can mark the volume recyclable.
Note: A volume that has been set to manual recycle retains that setting, even after
relabeling. A Manual Recycle policy cannot be changed back to Auto Recycle by
clearing the Manual Recycle checkbox. The volume must be explicitly reset to use auto
recycle. “Recycling volumes” on page 292 provides more information.

d. The Mount After Labeling attribute is selected by default. The NetWorker
server automatically labels the volume, and then mounts the volume into the
device.
5. Click OK.
6. If the volume is recyclable, a message warns that the named volume is about to be
recycled, and asks whether to continue. Click Yes to relabel and recycle the
volume.
7. After a volume is labeled and mounted in a device, the volume is available to
receive data. Since the NetWorker label is internal and machine-readable, place
an adhesive label on each volume that matches that internal volume label.
“Configure a library to use volumes with barcodes” on page 294 provides
information on using barcode labels.
Note: If you are in the process of relabeling a mounted volume and you choose to not
overwrite the existing label, the volume will be left in an unmounted state. To use this volume,
mount it again.

Label without mounting
Volumes can be prelabeled without being mounted.
To label a volume without mounting, follow the same procedures as for labeling and
mounting in one operation, but clear the Mount After Labeling attribute in the Label
window.
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Mount an uninventoried volume
To mount a volume that is not included in the library inventory, but which is a valid
(properly labeled) NetWorker volume:
1. In the Administration window, click Devices.
2. Select View > Diagnostic Mode on the toolbar.
3. Manually insert the volume in an empty library slot.
4. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
5. Select the library in the navigation tree in which the volume was manually
inserted, or double-click the same library in the Libraries detail table. The
Libraries detail table changes to the double-paned library operations view. The
library’s drives are listed in the Devices column, and its slots are listed in the Slot
column.
6. In the Devices column, right-click the library in which the volume was manually
inserted, and select Inventory. The Inventory Library window appears.
7. Type the slot number of the volume in both the First and Last field of the Slot
Range.
8. Select Operation Type: either Slow/Verbose (the default) or Fast/Silent.
• When Slow/Verbose is selected, the Supply Input option and icon on the
Operations screen of the Monitoring window can be used to confirm the
choice to relabel a volume. The device path appears in the Device field.
• When Fast/Silent is selected, the Supply Input option and icon are not
available, and relabeling proceeds automatically, without user input. The
device path does not appear in the Device field. “Supply user input” on
page 400 provides details.
9. Click OK.
• The Library Operation window displays this message:
The library operation has started.

• The Monitoring > Operations screen displays its status.
The NetWorker software then inventories the specified slot.
10. Mount the inventoried volume as described in Chapter 1, “Overview”.
Note: Unlabeled tapes may not be mounted for inventorying. Unlabeled tapes can only be
mounted to be labeled. An attempt to mount an uninventoried volume by using unlabeled
media results in an I/O error. The volume will also be ejected.

Automatic unmounting of volumes (idle device timeout)
At times, a volume that is mounted in one device might be needed by another device
in the same library. For example, data being recovered by one device could span
more than one volume, and the required volume could be mounted on another
device. To address this need, a value can be defined in the Idle Device Timeout
attribute for that particular library.
The Idle Device Timeout attribute, which applies only to shared libraries or libraries
that are managed by AlphaStor software, specifies the number of minutes a mounted
volume can remain idle before it is automatically unmounted from the device and
returned to its slot, where it can then be accessed by another device. This attribute can
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be useful in configuring shared drives. The attribute appears on the Advanced tab of
a device’s Properties when in diagnostic mode. The default value is 0 (zero) minutes,
which means that the device never times out and the tape must be ejected manually.
Select a time that is appropriate for the system configuration.

Using libraries with a volume import and export capability
The NetWorker software supports the use of the SCSI-II import/export feature found
in many brands of library. Depending on the library model, this feature is also known
as cartridge access port (CAP), mail slot, and loading port. The import/export feature
deposits and withdraws (ejects) volumes from slots in the library. This feature
enables the operator to deposit and withdraw cartridges without invalidating the
device inventory list. Normally, if the operator opens the door to load or unload
media, the element status of the autoloader is invalidated, which requires the
reinitialization the library. The NetWorker server does not, however, automatically
inventory the volume after a deposit and withdrawal.
The reinitialization usually consists of the following:
◆

An inventory of all slots

◆

A reset of the robotic arm

◆

A check to see whether each drive is working

The Deposit attribute causes a library to take the first available volume from the CAP
and place it in the first empty library slot. The Eject/Withdraw attribute moves a
volume from a slot (never from a drive) to the CAP.
Depositing a volume by using the import/export feature
Use these general instructions when working with a CAP. Specific instructions for
working with a CAP can vary, depending on the library manufacturer. For specific
instructions, refer to the library’s documentation.
To deposit a volume from the CAP into a library:
1. Ensure that volumes are available in the CAP for deposit.
2. In the Administration window, click Devices.
3. Select Libraries in the navigation tree. The Libraries detail table appears.
4. Double-click the library in which to deposit the volume. The Libraries detail
table changes to the double-paned library operations view.
5. Right-click either the device or the slot, and select Deposit. You are prompted to
deposit the volume.
6. Click Yes. The Library Operation window displays this message:
The library operation has started.
The Monitoring > Operations screen displays its status.

7. Click OK.
8. Click Monitoring to go to the Monitoring window and select the Operations tab.
9. Right-click the User Input icon for the deposit job and select Supply Input. You
are prompted to load the cartridges into the ports and type Yes to continue.
10. Click Yes.
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11. Right-click the User Input icon for the deposit job and select Supply Input again.
You are prompted to continue depositing volumes.
12. Click Yes to continue depositing volumes, or No when done.
Withdrawing a volume by using the import/export feature
To withdraw a volume from a library slot and place it in the CAP:
1. Ensure that the volume to be withdrawn is in a known slot, and that the CAP has
an empty port to hold the withdrawn volume.
2. In the Administration window, click Devices.
3. Select Libraries in the navigation tree. The Libraries detail table appears.
4. Double-click the library from which the volume is to be withdrawn. The Libraries
detail table changes to the double-paned library operations view.
5. Right-click the slot that contains the volume, and select Eject/Withdraw. You are
prompted to withdraw the volume.
6. Click Yes.
• The Library Operation window displays this message:
The library operation has started.

• The Monitoring > Operations screen displays its status.
7. Click OK.
8. Select Monitoring > Log to see the result. A successful Eject/Withdraw
operation ends with a Succeeded comment in the Log.
Note: If the library is partitioned into logical libraries and the import/export slots are shared
between the partitions, you must withdraw volumes by using the nsrjb command with the -P
option to specify the port or ports from which to withdraw volumes. Refer to the nsrjb man
page or the EMC NetWorker Command Reference Guide for more information.

Inventorying library volumes
When the NetWorker software labels the contents of a library, the software registers
the location of the volumes in the library slots when it assigns the volume label. This
is called taking inventory. When the volumes in the library are inventoried, the
NetWorker software reads the label of each volume and records its slot number. If the
volumes are not moved in the library after they have been labeled, then the
NetWorker server can access the volumes because each volume label is assigned to a
specific slot.
If, however, the contents of the library are changed without being labeled, or if
volumes are moved into new slots, the NetWorker software must be notified that the
library now holds a different set of labeled volumes or that the volumes are in a
different order. For example, if the library has more than one magazine, the volumes
must be inventoried each time a magazine is removed and another one is loaded into
the library.
When the volumes in a new magazine are labeled, there is no need to inventory them.
The NetWorker software automatically records the slot number in which each newly
labeled volume is located.
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The NetWorker software can use barcode labels to speed up the inventory process. If
the library supports the use of barcode labels, consider using them if large numbers
of volumes and/or if the library contents change often. “Using barcode labels” on
page 294 provides more information on using barcode labels.
To inventory volumes in a library:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Select a library in the navigation tree or double-click a library in the Libraries
detail table. The Libraries detail table changes to the double-paned library
operations view.
4. Right-click anywhere within the Devices pane, and select Inventory. The
Inventory Library window appears.
5. Type the numbers of the first and last slots to be inventoried in the Slot Range
area.
6. Select Operation Type: either Slow/Verbose (the default) or Fast/Silent.
7. Click OK.
• The Library Operation window displays this message:
The library operation has started.

• The Monitoring > Operations screen displays its status.
8. Click OK. If the volumes do not have barcode labels, the NetWorker software
must mount each volume, read its label, and unmount it. In this case, the
inventory process can take some time to complete.

Working with volumes
This section describes how to work with volumes.
Removing volumes from the media database and online indexes
The main purpose of removing volume-based entries from the online indexes is to
eliminate damaged or unusable volumes from the NetWorker server. A volume entry
should be removed from the media database only if the volume has become
physically damaged or unusable.
Both the client file index and media database entries can be removed. This action
removes all information about the volume from the NetWorker server. Even if the
database entries for a volume are removed, as long as the volume is undamaged, the
data remains recoverable by using the scanner program.
In general, do not remove both the client file index and media database entries at the
same time unless the volume is damaged or destroyed.
The presence of a clone of the particular volume prevents the deletion of the volume
entry in the media database. This is because the NetWorker server accesses the
cloned volume rather than the original volume as needed. The volumes’s entry in the
media database is never actually purged. Because of this, removing volume entries
from the media database is not a particularly effective way to reduce index size,
although it does reduce the size of the online indexes by purging index entries
associated with specific volumes.
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Deleting volume data
To delete a volume:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Select a library in the navigation tree or double-click a library in the Libraries
detail table.
• The Libraries detail table changes to the double-paned library operations
view. The library’s drives and mounted volumes are listed, as well as its slots
and all volumes, mounted or unmounted.
• Only unmounted volumes can be deleted.
4. Right-click the volume to be deleted, and select Delete. The Delete window
appears and displays a request to select from where the volume should be
removed:
a. File and media index entries
b. File index entries only
Note: Do not remove the indexes of save sets on bad volumes.

5. Click the appropriate selection.
6. Click OK.
7. After a bad volume has been removed, type the nsrck command at the command
prompt.
The nsrmm and mminfo UNIX man pages or the EMC NetWorker Command Reference
Guide provide more information.
Marking a volume as full for offsite storage
When removing a volume from a library to store offsite, mark the volume as “full” so
that the NetWorker software will not continue to ask for the volume.
To mark a volume as full, use the nsrjb command (for libraries) or the nsrmm
command (for stand-alone drives) from the command-prompt. Note that the volume
must be unmounted before this operation can be completed.
The format is as follows:
◆

For libraries:
nsrjb -o full volid

◆

For stand-alone drives:
nsrmm -o full volid

Where volid is the volume identifier of the volume. When a volume is marked as full,
it is also marked as read-only.
You can also change the volume’s Location attribute to an informational message,
such as "Move to offsite storage in September 2009".
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To change the volume’s Location attribute:
1. In the Administration window, click Media. Media-related topics appear in the
navigation tree.
2. Select Volumes. The Volumes detail table, which includes information about all
of the server’s volumes, appears.
3. Right-click a volume in the detail table, and select Set Location. The Set Location
window appears.
4. Type a location description.
Note: This is descriptive information. Filling in this field does not send a volume
anywhere.

5. Click OK.
Cloning volumes
“Volume cloning” on page 227 provides information about volume clone operations.

Media handling errors
The architecture of device drivers can produce media handling errors. The
NetWorker software automatically retries a failed operation such as a mount or read
of a volume. The number of times the NetWorker software retries the failed operation
depends on the value of the Max Consecutive Errors attribute, which is set in the
Advanced tab of the device’s Properties window. The default value is 20. When the
device’s Max Consecutive Errors value is reached, the device stops retrying the
operation and becomes disabled.
A mount or read operation might fail for several reasons, for example:
◆

Attempts to mount and read a damaged tape in a library can result in a loop of
failed actions: the device might repeatedly try to mount the tape, replace it in the
slot, and then retry the action with the same result. In this example, to bring the
drive back into use, remove the damaged tape, then reenable the device.

◆

A drive that always reports a fixed number of failures before correctly mounting
and reading a tape, even if the tape is not damaged, can cause a failure loop. In
this example, ensure that the Max Consecutive Errors value is higher than the
number of times that particular drive fails before working correctly.

Reenable a device
Once the number of retries equals the Max Consecutive Errors value, the device
becomes disabled. After the problem that disabled the device has been fixed, the
device (drive) must be reenabled before it can be used again.
To reenable a device:
1. Once the NetWorker computer is idle, remove any volume from the disabled
drive and ensure that the drive is in good working order.
2. In the Administration window, click Devices. The Devices detail table appears.
3. Right-click the drive to be reenabled, and select Properties. The Properties
window appears.
4. In the Status area of the General tab, set Enabled to Yes.
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5. Click OK.
If the disabled drive is part of a library, it might be necessary to reset the device. To
do this:
1. From the command prompt, change the path to the directory that contains the
NetWorker binaries.
2. Type this command:
nsrjb -HE

Media management in a silo
More than one software application can use a single silo. Therefore, media
management in a silo requires extra operations to prevent the NetWorker software
from overwriting volumes used by other programs.

Numbering a silo slot
In a library, the NetWorker software specifies many functions by slot number. A
library has a fixed number of slots, and NetWorker software uses the slot number to
refer to a volume’s physical location.
A silo works similarly, but a silo has a variable number of slots, starting at zero when
it is first configured, and limited by the silo license purchased. The fundamental
identifier of a silo volume is its barcode, or volser (volume serial number). The volser
never changes over the life of a particular volume.
When the nsrjb command lists the contents of a silo, it also lists a slot number. Use
the slot number to specify which volumes to mount, unmount, label, and inventory.
Volumes are not always assigned the same slot number in the silo. The slot numbers
in the silo are assigned dynamically, based on the sorted order of the barcodes that
have been allocated. If additional barcodes that fall earlier in the sort sequence are
allocated later, then the slot numbers change for all volumes that are later in the
sequence.
The nsrjb UNIX man page or the EMC NetWorker Command Reference Guide provide
more information.

Mounting and unmounting silo volumes
Mount and unmount operations for silos are the same as for library volumes:
◆

A volume must be mounted before it can be labeled, read, or had data written on
it. The robotic mechanism mounts volumes in the devices of a silo.

◆

Volumes must be unmounted before they can be inventoried in a silo or removed
from a NetWorker pool.

“Mounting and unmounting volumes” on page 296 provides more information.

Labeling a silo volume
The NetWorker labels for volumes in a silo include both a regular NetWorker volume
label (written on the media of the volume) and a silo barcode identifier. The volume
label is usually based on the volume pool’s label template. The barcode identifier is

Media management in a silo

305

Media Management

written on a physical label on the outside of the volume, which the barcode reader in
the silo can scan during inventory. “Labeling volumes” on page 292 and “Using
barcode labels” on page 294 provide instructions on how to label silo volumes.
The use of barcodes with matching barcode labels and NetWorker volume labels, are
both available for a silo. The Barcode Reader attribute must be selected, however the
Match Barcode Labels attribute is optional. When both attributes are selected, the
internal volume label that NetWorker software writes on the media of each volume
will match the barcode label on the outside of the volume. When the labels match, it
is easier to track volumes. But the NetWorker software does not require the internal
and external labels to match.
With most silo management software, unlabeled volumes can be used. The silo
management software assigns a “virtual” barcode label to those volumes. Although
volumes can be used without barcodes, it is difficult to maintain integrity, since once
the volume has been removed from the silo, the information about the virtual
barcode is lost. Any volume without an actual barcode can be reinserted into the silo
under a virtual barcode that NetWorker software (or another application) associates
with some of the data.

Using a silo with volume import/export capability
NetWorker software supports the use of the import/export feature found in many
brands of silos. Depending on the silo model, this feature is also known as CAP, mail
slot, and loading port. The import/export feature deposits and withdraws volumes
from slots in the silo.
The import/export feature enables the operator to deposit and withdraw cartridges
without invalidating the device inventory list. If the operator opens the door to load
or unload volumes, the element status of the autoloader is invalidated, requiring the
time-consuming operation of reinitializing the silo. Note however, that NetWorker
software does not automatically inventory the volume after a deposit.
Either NetWorker software or the silo management software can be used to control
the import/export feature on the supported silos to deposit and withdraw volumes
in a silo. But it is often more efficient to use the silo management software, especially
to deposit or withdraw a large number of volumes.
On some silos (for example, StorageTek silos with the import/export feature set to
automatic mode), the silo management software inserts volumes automatically. On
these silos, the NetWorker software cannot be used to insert volumes.
To issue deposit and withdraw commands:
◆

To add and deposit volumes, type:
nsrjb -a -T tags -d

◆

To remove and eject/withdraw volumes, type:
nsrjb -x -T tags -w

where tags specifies the tags or barcodes of volumes in a remote silo.
Note: You cannot deposit a volume from the CAP (I/O Port) using the nsrjb -d command. A
silo volume deposit requires the -T and -a options in sequence to add a volume in the media
database.
The sequence of operations is: nsrjb -d -T BarCode
Ignore the error message that appears. nsrjb -a -T Barcode
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Barcode IDs
A list of available barcode-labeled volumes is available from the silo management
software. Refer to the silo manufacturer’s documentation for how to generate the list
of barcode IDs.
To specify a barcode identifier or template for the volumes from a command prompt,
use the -T option with the nsrjb command. The nsrjb UNIX man page or the EMC
NetWorker Command Reference Guide provides more information.
Allocating (adding) silo volumes
When volumes are added, the NetWorker server is directed to the volumes it can use.
Note: Because silos can be used by more than one software application, it is possible that a
different application could read or write to volumes that belong to the NetWorker software. To
prevent this from happening, most silo management software includes methods to limit access
to volumes based on the hostname of the computer on which various programs run. The
NetWorker software does not provide a method for setting up this sort of protection. The silo
management software must configure it.

The addition of a volume causes the NetWorker software to query the silo
management software to verify that the requested volume exists.
If the volume exists, the volume is allocated to the NetWorker software.
Add a silo volume
To add a silo volume:
1. In the Administration window, click Devices.
2. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
3. Double-click a silo in the Libraries detail table to open the double-paned library
operations view. The silo’s drives are listed in the Device column, and its slots are
listed in the Slot column.
4. Right-click a silo in the Device column, and select Add. The Add Library
Volumes window appears, with the option to select either Template or List for
barcode selection.
5. Select either Template or List to enter barcode volume identifiers.
• The Template option allows the use of wildcards in creating a list of barcode
IDs. Each entry should be on a separate line; for example, to name four tapes
A01B, A02B, A03B, and A04B, type:
A0
1-4
B

• The List option allows the entry of barcode IDs, separately. Each entry should
be on a separate line; for example, type the name for each tape:
A01B
A02B
A03B
A04B

6. Type the appropriate volume identifiers in the Barcodes field.
7. Click OK (or Cancel, to continue adding to the list).
Media management in a silo
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• Click "+" to add an entry.
• Click "<-" to insert above a highlighted selection.
• Click "-" to delete an entry.
The Library Operation window displays this message:
The library operation has started.
The Monitoring > Operations screen displays its status.

8. Click OK. On return to the Library detail table, the added volumes will be shown.
Note: Silos do not display empty slots.

Troubleshooting
If the particular silo model does not automatically deposit the volume, then place the
volumes in the insert area, right-click the volume and select Deposit.
To perform the Deposit and Add operations from a command prompt:
◆

On silos that require manual depositing, such as DAS:
nsrjb -a -T tags -d

where tags specifies the tags or barcodes of volumes in a remote silo. The -d flag
performs the manual deposit.
◆

On silos where the silo management software deposits volumes automatically,
such as StorageTek silos:
nsrjb -a -T tags

“NetWorker software interactions with a silo” on page 273 provides more
information on STLIs.
Deallocating (removing) silo volumes
When an STL volume in a silo is no longer needed, the volume can be deallocated
from the silo. Deallocation is basically the same operation as removing a volume from
a library. Although the volume cannot be loaded by the robotic mechanism, the
entries in the NetWorker media database remain intact. If the volume is allocated
again, NetWorker software can retrieve the data from it later.
Use deallocation when the silo license limits the number of usable slots, or when data
is moved offsite for safer storage. When the license limits the number of slots, it might
be possible to leave the volumes in the silo, if it is certain that the volumes will not be
used by another application. That way, the volumes can easily be added again when
the data on them must be accessible.
The allocation operation is not automatic. The volumes must be manually allocated
again and reinventoried to let the NetWorker server access the data. If the volume is
to be removed from the silo for offsite storage, it must be removed with NetWorker
software and then ejected from the silo by using the silo management software.
To remove a silo volume:
1. Unmount the volume from the device. “Mounting and unmounting volumes” on
page 296 provides instructions on unmounting volumes.
2. In the Administration window, click Devices.
3. Open the Libraries folder in the navigation tree. The Libraries detail table
appears.
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4. Double-click a silo in the Libraries detail table to open the double-paned library
operations view. The silo’s drives are listed in the Device column.
5. Right-click a silo in the Device column, and select Remove.
The Remove Library Volumes window appears, with the option to select either
Template or List for barcode selection.
6. Select either Template or List to enter barcode volume identifiers.
• The Template option allows the use of wildcards in creating a list of barcode
IDs. For example, to name four tapes A01B, A02B, A03B, and A04B, type A0,
1-4, and B.
• The List option allows the entry of barcode IDs, separately. For example, type
the name for each tape: A01B, A02B, A03B, and A04B.
7. Type the appropriate volume identifiers in the Barcodes field.
8. Click OK.
• The Library Operation window displays this message:
The library operation has started.

• The Monitoring > Operations screen displays the silo’s status.
9. Click OK. Notice that on return to the Libraries detail table, the removed
volumes are no longer listed.
“NetWorker software interactions with a silo” on page 273 provides information on
STLs.

Inventorying a silo
Taking inventory of the volumes in a silo ensures that the mapping between slot
number and volume name is correct, or reconciles the actual volumes in a silo with
the volumes listed in the NetWorker media database.
The slot number of a silo volume is not a numbered slot inside the silo, as it is in a
library. The slot number of a silo volume is the number of the volume’s position in
the list of volumes in a silo.
The tasks for inventorying volumes in a silo are the same as those for a library.
“Inventorying library volumes” on page 301 provides information about
inventorying a library.
The NetWorker software examines all of the volumes in the silo and compares the
new list of volumes to the NetWorker media database. Then the NetWorker software
produces a message listing any volumes located in the silo that are not in the media
database.
When the NetWorker software inventories a silo, the silo’s barcode label reader reads
the barcode labels on the outside of each volume. When a barcode matches an entry
in the NetWorker media database, the volume does not need to be loaded. The
inventory proceeds rapidly. If, however, the NetWorker software reads a barcode
that does not match any of the entries in the media database, the volume must be
mounted and read in order for a proper inventory to be taken.
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Volume save sets
Information about individual save sets on volumes can be displayed from the
Volumes detail table. Refer to this information to determine how resources are being
used. For example, knowing the size of a save set can help in planning the amount of
disk space needed for the online indexes.

Viewing save set details in the Volume Save Sets window
To view save set information in the Volume Save Sets window:
1. In the Administration window, click Media. Media-related topics appear in the
navigation tree.
2. Select Volumes. The Volumes detail table, which includes information about all
of the server’s volumes, appears.
3. Right-click a volume in the detail table, and select Show Save Sets.
4. The Volume Save Sets window appears. Table 47 on page 310 shows the
attributes and their descriptions.
5. Click OK to close the Volume Save Sets window.
Table 47
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Volume Save Sets window (1 of 2)

Category

Description

Client

Name of the NetWorker client computer that created the save set.

Save Set

Pathname of the file system containing the save set. This column also includes clone information. If the
save set has a clone, the pathname is marked has clones and the cloned save set is marked clone save
set.

SSID

Save set ID number.

Time

Date and time when the save set was created.

Level

Level of backup that generated the save set. This refers only to scheduled backups. For manual backups,
the level is blank.
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Table 47

Volume Save Sets window (2 of 2)

Category

Description

Status

Type of save set. Table 34 on page 224 provides a listing of save set values and descriptions.

Size

Save set size, in appropriate units.

Flags

First flag shows which part of the save set is on the volume:
• c: Completely contained on volume.
• h: Spans volumes, and head is on this volume.
• m: Spans volumes, and a middle section is on this volume.
• t: Spans volumes, and the tail section is on this volume.
Second flag shows save set status:
• b: In the online index and is browsable.
• r: Not in the online index and is recoverable.
• E: Marked eligible for recycling and may be overwritten at any time.
• a: Aborted before completion.
• i: Still in progress.
Optional third flag:
• N: NDMP save set
• R: Raw partition backup (such as for a supported module).
• P: Snapshot
Optional fourth flag:
• s: NDMP save set backed up by nsrdsa_save command to a NetWorker storage node.

Changing save set status within the Volume Save Sets window
To change the save set status within the Volume Save Sets window:
1. Select a save set.
2. Click Change Status. The Change Save Set Status window appears.
3. Select either:
• Normal (default)
• Suspect
4. Click OK, to leave the Change Save Set Status window.
5. Click OK, again, to leave the Volume Save Sets window.

Viewing save set details from the Save Set detail table
To view save set details from the Save Sets detail table:
1. In the Administration window, click Media. Media-related topics appear in the
navigation tree.
2. Select Save Sets.
The Save Sets detail table appears with two tabs for configuring save set queries
and listing save set details:
• The Query Save Set tab
• The Save Set List tab
3. Select either tab. “The Query Save Set tab” on page 312 and “The Save Set List
tab” on page 312 provide more information.
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The Query Save Set tab
The Query Save Set tab allows users to search for save sets that meet specific criteria.
Click the Query Save Set tab to access these query fields:
◆

Query Parameters area:
• Client Name
• Save Set
• Save Set ID
• Volume
• Pool
• Copies
• Save Time (a range)

◆

Status area:
• All
• Select from:
– Browsable
– Scanned-In
– In-Progress
– Suspect
– Recyclable
– Recoverable
– Aborted

◆

Type area:
• All
• Select from:
– Normal
– Deduplication
– NDMP
– Snapshot
– Raw

◆

Maximum level area:
• Full
• 1 through 9
• All

If no save sets are found that match the query parameters, an error message appears
when closing the tab:
No save sets were found that matched the specified query.

The Save Set List tab
The Save Set List tab lists detailed save set information.
Click the Save Set List tab to view this tabular information:

312

◆

Save Set

◆

SSID (Save Set ID)

◆

Level
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◆

Status

◆

Volume Name

◆

Type

◆

Client

◆

Size

◆

Files

◆

Pool

◆

Time

Volume save sets

313

Media Management

314

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

13
Recovering Data

This chapter covers these topics:
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆

Choosing a recovery method.....................................................................................
Recovering by file selection .......................................................................................
Recovering by save set selection ...............................................................................
Recovering deduplication data .................................................................................
Recovering with BMR.................................................................................................
Recovering encrypted data ........................................................................................
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Directing recoveries to another client.......................................................................
Recovering online indexes for a NetWorker server ...............................................
Recovering the Console database .............................................................................
Recovering backed-up client files from an old NetWorker server.......................
Recovering the Windows system configuration.....................................................
Recovering Windows volume mount points ..........................................................
Recovering Windows DHCP and WINS databases ...............................................
Restoring Windows Content Index Server on Windows.......................................
When you restart the service, the CIS re-indexes the entire catalog....................
Restoring BOOT/BCD Data on Windows 2008 R2 and Windows 7 ...................
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Choosing a recovery method
There are two main methods of recovering data:
◆

Recovery by file selection (index-based recovery)

◆

Recovery by save set selection

Recovery by file selection is the most flexible and easy to use method to recover data.
However, save set recovery can be preferable especially when there is a large amount
of data to be recovered or data is not available for quick access because it has passed
its browse policy.

When to recover by file selection
Consider recovering data by file selection when:
◆

The exact name of the file or directory to recover is unknown and you want to
browse the file system.

◆

A directed recovery is required. A directed recovery is a recovery where data that
was backed up from one computer is recovered to another computer. “Directing
recoveries to another client” on page 329 provides information about directed
recoveries.

◆

Only the files that are marked for recovery are recovered (not extra files).

◆

It is important to keep the recovery operation as simple as possible. A save set
recovery can be a more complex operation.

When to recover by save set selection
Consider recovering data by save set selection when:

316

◆

You want to restore a large bulk of lost files, for example, in the event of a total
disk failure. In this case, you do not have to mark individual files for recovery.

◆

The recovery of extra files is acceptable.

◆

Quick access to the backup data is not available because the data’s browse policy
has expired. Quick access can be restored by re-creating the browsable client file
index with the scanner program. However, this can be a time-consuming
process. “Restore a save set entry in the online indexes” on page 338 provides
more information about the scanner program.

◆

Memory on the recovery host is an issue. Recovering by save set selection
requires less memory than recovering by file selection.
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Recovering by file selection
Recovering by file selection enables users to browse and select backed-up files and
file systems for recovery. The earliest versions of files and file systems that are
available for recovery are determined by the browse policy that was applied when
the data was backed up. “About browse and retention policies” on page 158 provides
more information about browse policies.
To recover by file selection, the user on the local host (user@localhost) must:
◆

Belong to a NetWorker usergroup (identified as User Groups in the user interface)
that has the “Recover Local Data” privilege. Members of the default NetWorker
usergroups, Administrators, and Users, automatically have this privilege.
“NetWorker User Groups” on page 442 provides more information.

◆

Have operating system ownership of the files being recovered. The root user on
UNIX or the Windows Administrator automatically have this privilege.

◆

Have local operating system “write“ privileges to the local directories into which
the files will be recovered. The root user on UNIX or the Windows Administrator
automatically have this privilege.

If backed up data has exceeded its browse policy, you can still recover the data by
using save set recovery. “Recovering by save set selection” on page 325 provides
more information about save set recovery. You could also recover data by re-creating
the client file index with the scanner program. Re-creating the client file index
enables users to browse and select files for recovery. However, re-creating the client
file index can be a time-consuming process. “Restore a save set entry in the online
indexes” on page 338 provides more information about re-creating the client file
index.
You can also recover files from other client computers by using directed recovery.
“Directing recoveries to another client” on page 329 provides details.

Recovering data on UNIX systems
To recover data to a UNIX client:
1. Start the nwrecover program by typing this command:
nwrecover
• Use the -s servername option with nwrecover to specify a particular NetWorker
server on the network to use when recovering data. The /servers file, located
in /nsr/res/servers, contains an entry for each available server.
If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there
is more than one server available, the Change Server dialog box appears,
allowing you to choose the server.
• Use the -c client option to specify a particular NetWorker client on the
network. If the -c option is not used, the current client is assumed.
The nwrecover program displays a representation of the client’s file system.
2. Mark each directory and/or file to be recovered by selecting the checkbox next to
each directory or file listed.
Note: To recover data from a scheduled backup other than the most recent one, you must
change the browse time. See “Recovering an earlier version of a file” on page 320.
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3. Click Start to begin the recovery.
4. In Recover Options dialog box, select any appropriate options and click OK.
“Resolving recovered data conflicts” on page 321 and “Relocating recovered
data” on page 323 have more information on options in the Recover Options
dialog box.
The time it takes to recover the files, depends on file size, network traffic, server
load, and tape positioning. During this time, messages appear so that you can
monitor the recovery.
If the recovery is successful, a message similar to this appears:
Received 1 file(S) from NSR server server
Recover completion time: Tue Jan 21 08:33:04 2009

Recovering data on Windows systems
The information in this sections refers to using the NetWorker User program to
recover data. If the NetWorker Module for Microsoft Applications Client User
program is installed on the client computer, VSS data should be recovered with the
NetWorker Module for Microsoft Applications Client User program. The EMC
NetWorker Module for Microsoft Applications Administration Guide provides more
information about the NetWorker Module for Microsoft Applications Client User
program.
Note: If VSS is licensed and enabled, the databases must be taken offline before recovering
Micorsoft Exchange Server or SQL Server data.

To recover data to a Windows client using the NetWorker User program:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. Select the source client with the data you want to recover, and click OK. The local
client is the default selection.
3. Select the destination client for the recovered data, and click OK. The local client
is the default selection.
4. In the left pane of the Recover window, click the appropriate directory folder.
Note: If a drive letter is not present on the server, the drive is highlighted with a red
question mark.

5. Mark each directory and/or file to be recovered by performing one of the
following:
• Select the directory or file, and from the File menu, select Mark.
To clear an item, select Unmark from the File menu.
• Click the checkbox next to the directory or filename.
To clear an item, click the checkbox again.
If you select My Computer for recovery, all drives are recovered.
Note: To recover data from a scheduled backup other than the most recent one, you must
change the browse time. “Recovering an earlier version of a file” on page 320 provides
details.
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6. Click Start to begin the recovery.
• It takes the NetWorker server a few moments to recover the files, depending
on file size, network traffic, server load, and tape positioning. During this
time, messages appear so that you can monitor the progress of the recovery.
Note: If an error occurs while recovering Microsoft Exchange Server or Microsoft SQL
Server data by using VSS, you must restart the recovery process.

• If there is a naming conflict during recovery, you are prompted to select a
workaround. “Resolving recovered data conflicts” on page 321 provides
information about naming conflicts.
• If the recovery is successful, a message similar to this appears:
Received 1 file(S) from NSR server server
Recover completion time: Tue Jan 21 08:33:04 2009

• If the recovery fails due to a problem with VSS or a writer, an error message
appears. Use the Windows Event Viewer to examine the event logs for
additional information. VSS recovery error messages are also written to the
NetWorker log file.
Note: The NetWorker User program does not recover any files in parallel. All files are
recovered sequentially. To recover files using parallelism, perform recoveries from the
command line.

Recovering data from the command prompt
You can also perform a recovery by using the recover program. For example, to
recover C:\myfile from the server jupiter, type:
recover -s jupiter
Enter directory to browse: C:\recover: Current working directory is
C:\recover> add C:\myfile
C:\
1 file(s) marked for recovery
recover> recover
Recovering 1 file into its original location
Volumes needed (all on-line):
jupiter.mars.com.001 at //./Tape.0
Received 1 file(s) from NSR server `jupiter'
Recover completion time: Tue Jan 21 08:33:04 2009
recover>
◆

If you do not specify the -s option with the recover command, the file(s) will be
recovered from the NetWorker server defined in the /nsr/res/servers file that
comes first in alphabetical order.

◆

To recover files or directories that begin with a dash (-) such as -Accounting, try
one of the following options:
• Run the recover command and enter add ./-Accounting to recover the
-Accounting file or directory and its contents.
• Run the recover command and use the cd command to change directories to
-Accounting and then enter add . to add the current directory and its contents
for recovery.
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• If current directory is /temp and -Accounting is located in the /temp
directory, run the recover command and then enter add /temp/-Accounting
and the file or directory -Accounting and its contents will be added for
recovery.
◆

You cannot recover Windows SYSTEM or VSS SYSTEM save sets by using the
recover command in interactive mode. For information about recovering
Windows SYSTEM save sets, see “Recovering the Windows system
configuration” on page 341. The EMC NetWorker Command Reference Guide or the
UNIX man pages provide information about recover command.

◆

To avoid using the Windows version of recover.exe on Windows operating
systems, do one of the following:
• Include <NetWorker_install_path>\bin\recover.exe at the command prompt
• Ensure that <NetWorker_install_path>\bin is listed before
%SystemRoot%\System32 in the $PATH environment variable.

Recovering an earlier version of a file
You can browse previous backups to recover an earlier version of a file. This is useful
if the required data was deleted from the current file system and is not present in the
most recent backup.
The earliest versions of files and file systems that are available for recovery are
determined by the browse policy that was applied when the data was backed up. For
example, to recover a lost file that was backed up six months ago requires the
appropriate browse policy. “About browse and retention policies” on page 158
provides more information about browse policies.
Recovering an earlier version of a file
Before changing the browse time to recover an earlier version of a file, verify that no
files are currently marked for recovery. If files are currently marked for recovery and
the browse time is changed, the marked files will still be selected for recovery even
though they may have been backed up after the selected browse time.
On Windows
To recover an earlier version on Windows:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. Select the source client whose data you want to recover, and click OK.
3. Select the destination client for the recovered data, and click OK.
4. From the View menu, select Change Browse Time.
5. In the Change Browse Time dialog box, select a new day within the calendar.
Select Previous Month or Next Month to change from the current month.
6. In the Time field, change the time of day by typing an hour, minute, and the letter
a (for A.M.) or p (for P.M.). Use the 12-hour format.
7. Click OK.
8. Select the files or directories to recover as described in “Recovering by file
selection” on page 317.
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Note: If there are no entries for files backed up at the time selected in the Time field, the files
that were backed up at the closest preceding time are displayed.

On UNIX
To recover an earlier version on UNIX:
1. In the nwrecover program, select Change Browse Time from the Options menu.
2. In the Choose Date dialog box, select a new day within the calendar. Click the
forward or back arrows to change from the current month.
3. In the optional Time attribute, change the time of day to use by changing the
displayed time. Use the 24-hour format.
4. Click OK.
5. Select the files or directories to recover as described in “Recovering by file
selection” on page 317.
Note: If there are no entries for files backed up at the time selected in the Time attribute, the
files that were backed up at the closest preceding time are displayed.

Resolving recovered data conflicts
By default, the NetWorker server attempts to recover data to its original location. If a
name conflict occurs, the NetWorker software can respond either automatically or on
an file-by-file basis.
Resolving data conflicts on UNIX
The Recover Options dialog box, which appears each time a recovery is started,
provides options for resolving naming conflicts during recovery. Table 48 on
page 321 lists the available conflict resolution options.
Table 48

Options for resolving naming conflicts on UNIX

Option

Action

Relocate files to

Recovers selected files to the specified location.

Rename recovered file

Renames the recovered files by appending each conflicting name with .R.

Discard recover file

Discards the recovered file and keeps the existing file.

Overwrite existing file

Replaces the file on the file system with the recovered version.

Prompt me at every file conflict

If selected, redisplays the Naming Conflict dialog box for every file that has a
naming conflict.

Recovering by file selection

321

Recovering Data

Resolving data conflicts on Windows
By default, the Naming Conflict dialog box appears each time there is a filename
conflict during a recovery. Table 49 on page 322 lists the conflict resolution options
available during a recovery.
Table 49

Options far resolving naming conflicts on Windows

Option

Action

Rename Recovered File

Renames the recovered files. “Rules for renaming file on Windows” on page 322
provides more information.

Discard Recover File

Discards the recovered file and keeps the existing file.

Overwrite Existing File

Replaces the file on the file system with the recovered version.

Suppress Further Prompting

Automatically performs the selected option if additional conflicts are encountered
during this recovery operation.

Rules for renaming file on Windows
When a naming conflict is encountered during recovery, the NetWorker server uses
these guidelines to rename the recovered file:
◆

By default, a tilde (~) is appended to the beginning of the name of the recovered
file:
~<filenname>

◆

If a file named ~<filenname> already exists, the recovered file is renamed
~00_<filenname>.

◆

If a file named ~00_<filenname> already exists, the recovered file is renamed
~01_<filenname>, and so forth to ~99_<filenname>.

◆

If this fails, the file will not be renamed automatically:
• If the recover command is being used, the NetWorker server fails to rename
the file.
• If the NetWorker User program is being used, the user is prompted to type a
name for the file.

Resolve name conflicts automatically on Windows
You can configure the NetWorker software to resolve all name conflicts automatically
before a recovery is started.
To automatically resolve name conflicts before starting a recovery:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. Select the source client with the data to recover, and click OK.
3. Select the destination client for the recovered data, and click OK.
4. Select Recover Options from the Options menu.
5. Select a conflict resolution option, as described in Table 49 on page 322 and then
click OK.
Another way to avoid name conflicts is to relocate the recovered data prior to
recovery. “Relocating recovered data” on page 323 provides more information.
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Relocating recovered data
By default the NetWorker server attempts to copy a recovered file to its original
location. If an existing file on the local disk has the same name as the file being
recovered, the server prompts for instructions on how to recover the file.
Alternatively, you can instruct the NetWorker server to relocate the recovered file
prior to the recovery.
Relocate recovered data on Windows
To relocate recovered data:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. Select the source client with the data to be relocated, and click OK.
3. Select the destination client for the data, and click OK.
4. Select Recover Options from the Options menu.
5. In the Relocate Recovered Data To field, type the directory where the data should
be relocated and then click OK.
Note: Provide the full pathname of the relocation directory.

6. Perform a data recovery as described in “Recovering data on Windows systems”
on page 318.
Relocate recovered data on UNIX
The Recover Options dialog box, which appears each time a recovery is started,
allows you to select the location to which files should be relocated during recovery.
To relocate recovered data:
1. In the nwrecover program, start a recovery.
2. In the Relocate file to field of the Recover Options dialog box, click Browse and
select the directory where the data should be relocated, or type the full pathname.
3. Click OK.

Viewing versions of a directory or file
Use the Versions option to view the backup details of a directory or file. Details
include the name, size, modified time, volume, location, and so on.
View version details on Windows
To view the version details of backed-up data:
1. In the NetWorker User program, select Relocate from the Options menu.
2. Select the source client with the backup versions to view, and click OK.
3. Select the destination client for the recovered data, and click OK.
4. Highlight the file or directory to be recovered.
5. From the View menu, select Versions.
Versions are sorted according to the backup time (the most recent backup first). The
selected version matches the one currently selected in the Recover window.
Recovering by file selection
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View version details on UNIX
To view the version details of backed-up data:
1. In the nwrecover program, select an item to view its details.
2. From the Selected menu, select Versions.
Versions are sorted according to the backup time (the most recent backup first).

Searching for a recoverable file
Users can search for and recover the most recently backed-up version of a file.
On Windows

To search for a recoverable file:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. Select the source client with the data to recover, and click OK.
3. Select the destination client for the recovered data, and click OK.
4. From the File menu, select Find.
5. Type the name of the file or directory. Use wildcards to expand the search;
without wildcards, partial filenames result in a no match being found.

On UNIX

To search for a recoverable file:
1. In the nwrecover program, select Find from the File menu.
2. Type or select the base directory that will be searched.
3. Type the name of the file or directory. Use wildcards to expand the search, or use
the Contains drop-down button to modify search criteria.
4. Click More Options to further modify the search criteria, such as selecting a time
of the backup and an owner of the file.
5. Click Find.

Viewing the volumes required for data recovery
Users can view a list of the volumes needed to recover files and directories.
On Windows

To view a list of the volumes required for data recovery:
1. In the NetWorker User program, click Recover to open the Source Client dialog
box.
2. In the Source Client dialog box, select the client with the data to be recovered and
click OK.
3. In the Destination Client dialog box, select the client to which the data will be
recovered and click OK.
4. In the Recover window, select the item with the volume requirements to be
viewed.
5. Select Required Volumes from the View menu.

On UNIX
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1. In the nwrecover program, select the item with the volume information
requirements to be viewed.
2. Select Required Volumes from the Selected menu.

Recovering by save set selection
Save set recovery enables you to recover data from a save set rather than by browsing
and selecting files for recovery. Generally it is preferable to browse and select files for
recovery. However, save set recovery may be preferable when there is a large amount
of data to recover or when quick access to the backup data is not available because
the data’s browse policy has expired. “Choosing a recovery method” on page 316
provides more information about deciding whether to perform a save set recovery or
a recovery by file selection.
Backed up data that has not exceeded its retention policy is eligible to be recovered by
save set recovery. However, if backed up data has exceeded its retention policy, it may
still be recoverable by using the scanner program. “About browse and retention
policies” on page 158 provides information about retention policies. “Restore a save
set entry in the online indexes” on page 338 provides information about recovering
data that has exceeded its retention policy.
Note: When you perform a save set recover operation, recover the last full backup first, then
recover levels 1 to 9 and incremental backups in the chronological order that they were backed
up. “Backup levels” on page 147 provides information about the relationship between full
backups, backup levels 1 to 9, and incremental backups.

Recover a save set on Windows
Note: Only members of the Windows Administrators group have permission to perform a save
set recovery on Windows. In the case of a remote NetWorker client, members of the client’s
Windows Administrators group must have the Recover Local Data privilege to perform the
save set recover. Members of the server’s Windows Administrators group automatically have
this privilege.

To perform a full save set recovery of a client:
1. In the NetWorker User program, select Save Set Recover from the Operation
menu.
2. In the Source Client dialog box, select the appropriate client and click OK.
3. From the Save Set Name list of the Save Sets dialog box, select the name of the
appropriate save set.
4. Select the particular version of the save set (if there are multiple versions).
You can also select to recover the cloned version of a save set if one is listed.
5. Click OK to begin the recovery. The recovery status appears in the Recover
Status window.
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Recover a save set on UNIX
Note: Only root has the permission to perform a save set recovery on UNIX. In the case of a
remote NetWorker client, root@client must have the Recover Local Data privilege to perform
the save set recover. The root@<networker_server> user automatically has this privilege.

To perform a full save set recovery of a client:
1. In the nwrecover program, select Recover Save Set from the Operation menu.
2. From the Name list, select the name of the appropriate save set.
3. In the Instances list, select the particular version of the save set (if there are
multiple versions).
4. Click the Recover button.
5. Select the appropriate options in the Recover Options dialog box and click OK.

Recover a save set from the command prompt
To perform a save set recovery from the command prompt, use the recover command
with this syntax:
recover -s servername -S ssid -d directory_path

The EMC NetWorker Command Reference Guide or the UNIX man pages provide
information about the recover command.

Recover individual files or directories from a save set on Windows
To recover specific data from a save set:
1. In the NetWorker User program, select Save Set Recover from the Operation
menu.
2. In the Source Client dialog box, select the appropriate client and click OK.
3. From the Save Set Name list of the Save Sets dialog box, select the name of the
appropriate save set.
4. Select the particular version of the save set (if there are multiple versions).
5. Click Files to open the Files dialog box.
6. Type the exact names of the files and directories (including the full case-sensitive
paths) that you want to recover in the Files text box. Each file or directory must
appear on a separate line.
7. Click OK to begin the recovery. The recovery status appears in the Recover
Status window.

Recover individual files or directories from a save set on UNIX
To recover specific data from a save set on UNIX, perform a regular recovery as
described at “Recovering data on UNIX systems” on page 317.
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View volumes required for save set recovery
Use this procedure to display a list of each volume that needs to be available to
recover a save set. If no volumes appear during this procedure, then no entries for the
volume exist in the media database. Use the scanner program to re-create the media
database entries. “Restore a save set entry in the online indexes” on page 338
provides information about using the scanner program to re-create the media
database.
On Windows

To view a list of the volumes required for a save set recovery:
1. In the NetWorker User program, select Save Set Recover from the Operation
menu.
2. In the Source Client dialog box, select the appropriate client and click OK.
3. From the Save Set Name list of the Save Sets dialog box, select the name of the
appropriate save set.
4. Select the particular version of the save set (if there are multiple versions).
5. Click Required Volumes to display the volumes required for the recovery.

On UNIX

To view a list of the volumes required for a save set recovery:
1. In the nwrecover program, select the appropriate save set instance.
2. Select Required Volumes from the Selected menu.

Relocate recovered save set data
You can relocate recovered save set data from the data’s original backup location to
another place on the file system.
On Windows

To relocate recovered save set data:
1. In the nwrecover program, select Save Set Recover from the Options menu.
2. In the Source Client dialog box, select the appropriate client and click OK.
3. Click Options to open the Recover Options dialog box.
4. Type the path in the Relocate Recovered Data To text box or click Browse to
select the destination directory.
5. Click OK.

On UNIX

The Recover Options dialog box, which appears each time a recovery is started,
allows you to select the location to which files should be relocated during recovery.
To relocate recovered data:
1. In the nwrecover program, start a recovery
2. In the Relocate file to field of the Recover Options dialog box, click Browse and
select the directory where the data should be relocated, or type the full pathname.
3. Click OK.

Resolve conflicts with recovered save set data
You can configure the NetWorker server to resolve conflicts during the recovery.
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On Windows

To resolve data recovery conflicts with save set data:
1. In the NetWorker User program, select Save Set Recover from the Operation
menu.
2. In the Source Client dialog box, select the appropriate client and click OK.
3. Click Options to open the Recover Options dialog box.
4. Select the appropriate option for the Duplicate File Resolution attribute. Table 50
on page 328 lists the options and actions taken for the Duplicate File Resolution.
Table 50

Options far resolving save set recovery naming conflicts on Windows

Option

Action

Always Prompt

Indicates that automatic naming conflict resolution is disabled.

Rename the Recovered File

Renames the recovered files. “Rules for renaming file on Windows” on
page 322 provides more information.

Discard the Recover File

Discards the recovered file to prevent overwriting the existing file.

Overwrite the Existing File

Replaces the file with the recovered version.

5. Click OK.
On UNIX

The Recover Options dialog box, which appears each time a recovery is started,
provides options for resolving naming conflicts during recovery. Table 48 on
page 321 lists the available conflict resolution options.

Recovering deduplication data
The NetWorker Avamar Integration Guide and the NetWorker Data Domain Depulication
Devices Integration Guide provides more information on how to recover depulication
data.

Recovering with BMR
Chapter 26, “Support for HomeBase” describes how to perform a BMR recovery or
server migration with Homebase. The EMC HomeBase product documentation
provides details and instructions about HomeBase Server and HomeBase Agents.
“Support for Windows 2008 / 2008 R2 / Windows 7 Disaster Recovery” on page 595
provides information on performing a Windows BMR recovery with NetWorker.

Recovering encrypted data
To recover data that was encrypted with the current AES pass phrase, no special
action is required. However, to recover data that was encrypted with an AES pass
phrase that is different than the current pass phrase, follow the procedure in this
section. The current pass phrase is listed in the Datazone Pass Phrase attribute of the
NetWorker server. “Set the Datazone pass phrase for a NetWorker server” on page 77
provides more information.
To recover AES encrypted data that was not encrypted with the current pass phrase,
use the -p option with the command that is being used to recover data. For example:
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recover -p pass_phrase
winworkr -p pass_phrase
To enter multiple pass phrases with the -p option, type:
recover -p pass_phrase1 -p pass_phrase2 -p pass_phrase3
Note: If an incorrect pass phrase or no pass phrase is entered, encrypted data is not recovered.
Instead, the filenames will be created without data. However, if unencrypted data is also
selected for recovery, it will be recovered.

Disaster recovery
For Windows disaster recovery, there are automated solutions. For more information
see the following:
◆

Chapter 23, “Support for Windows XP and 2003 Automated System Recovery,”

◆

Chapter 24, “Support for Windows 2008 / 2008 R2 / Windows 7 Disaster
Recovery,”

For non-automated Windows and UNIX disaster recovery information, refer to the
EMC NetWorker Disaster Recovery Guide.

Notes on the use of the scanner program
Do not use the scanner program to restore the bootstrap after a disaster in which you
lose the media database or the server’s res files. Instead, use the mmrecov command
to restore these files.
Note: The scanner program can recover only the hash data from deduplication node backups if
the save sets have been deleted from the Avamar server that is the deduplication node. If the
backup-to-tape method described in “Backup-to-tape for Avamar deduplication clients” on
page 233 is used regularly, it provides a tape backup of the deduplicated data up to a particular
point in time.

Directing recoveries to another client
Directed recovery allows a NetWorker administrator to remotely recover backed-up
data from a NetWorker client (the source client) and direct it to another NetWorker
client (the destination client).
Notes: Directed recovery of the Windows SYSTEM STATE is not supported.

Figure 31 on page 330 shows a user on client saturn performing a directed recovery of
data from a remote client (source) to the client mars (destination).
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1. Saturn requests to
browse backups from a
remote client (not
shown)

Neptune
NetWorker server

2. Request to recover
data from tape
storage to client
Mars

3. Data recovered
to client Mars

Saturn
Administering client
Tape storage
Contains backups
from a remote client
Figure 31

Mars
Destination client (OS must
match that of remote client)

A directed recovery from a remote client
Note: For directed recoveries of deduplicated backups, the destination client must also have
NetWorker release 7.4 with Service Pack 1 or later installed.

Uses for directed recovery
A directed recovery is particularly useful in these situations:
◆

When centralized administration is a requirement. All recoveries can be directed
from a single administering computer.

◆

When recovering data to a shared server where users cannot recover the data
themselves.

◆

When a computer is inoperable, a hard disk has crashed, or a network no longer
recognizes a computer. Configure the replacement computer by recovering files
from another client’s backups.

◆

When you want to transfer files between two clients. For example, if one client’s
AUTOEXEC.BAT or .profile file is appropriate for a new client, recover it to the
new client’s hard disk.

Note: The original file ownership and permissions are always retained with directed
recoveries.
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Requirements for directed recovery
This section contains the requirements for directed recoveries and the procedures to
enable directed recovery.
Client restrictions for directed recoveries
The destination client in a directed recovery can be any NetWorker client subject to
these guidelines:
General restrictions:
◆

The source and destination clients must be of the same platform (UNIX-to-UNIX
or Microsoft Windows-to-Microsoft Windows).

◆

The source and destination clients must use the same type of file system (for
example, UXFS-to-UXFS, NTFS-to-NTFS).

◆

The administering host must be a client of the NetWorker server. The
administering host is the host from which the graphical user interface is
displayed.

◆

If the administering client is neither the source nor the destination client, it need
not have the same platform and type of file system as the other clients.

Windows specific restrictions:
◆

For NetWorker clients running Microsoft Windows XP Professional, the
NetWorker server and clients must be in a Microsoft Windows Domain,
regardless of the username and password.

◆

For a Windows destination client, Windows File and Print Sharing must be
enabled. For more information, refer to the Microsoft Windows documentation.

◆

Directed recovery of SYSTEM or VSS SYSTEM save sets is not supported.

◆

Directed recovery to a CIFS share on the destination client is not supported.

◆

“Restrictions for Windows command line directed recovery” on page 335
provides additional restrictions.

UNIX specific restrictions
◆

Restrictions related to relocating non-ASCII directories on UNIX machines:
• If the remote directory is an existing non-ASCII directory, the locale of the
browsing session from which the directed recover is started must match the
locale in which the remote directory was created.
• If the remote directory does not exist, the relocation directory will be created
on the remote machine’s file system based on the locale of the browsing
session.

Enabling directed recoveries
Directed recovery is a restricted NetWorker function available only to users who have
all privileges except for the Change security settings privilege, which is not required
for directed recovery.
Note: Be selective in granting users the ability to perform directed recoveries. Directed
recovery privileges enable users to browse all clients and recover data to any client.
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If directed recoveries will be performed on a regular basis, establish the required
permissions for each NetWorker server and client in the enterprise prior to accepting
data recovery requests. “Managing server access” on page 440 provides general
information about access requirements.
Access requirements to perform directed recoveries are as follows:
◆

Users in the Administrators group on the NetWorker server are automatically
granted the necessary privileges. Table 51 on page 332 provides specific access
privileges that are required if a user is not a member of the NetWorker
Administrators group.

◆

The recovery must be launched by the root user or Windows Administrator on
the administering client.

◆

The root user or Windows Administrator on the administering client must have
the Remote Access All Clients privilege on the NetWorker server.

◆

SYSTEM@destination_client must be listed in the source client’s Remote Access
list.

◆

SYSTEM@destination_client must have the Recover Local Data privilege.

If the user on the destination client does not have Remote Access All Clients
privileges, then the user@destination_client must be listed in the source client’s Remote
Access list. “Editing the servers file” on page 487 provides information about editing
a client.
Table 51 on page 332 shows the access permissions and authorizations required to
perform various combinations of directed recoveries.
Table 51
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Access permissions used in directed recoveries (1 of 2)

Administering
client

Source
client

Destinatio
n client

UNIX

UNIX

UNIX

• The user must have the Remote Access All Clients privilege or the
user@destination_client must be listed in the source client’s
Remote Access list.
• The user@destination_client must have the Recover Local Data
privilege.

Windows

Windows

Windows

• The user must have the Remote Access All Clients privilege or the
user@destination_client must be listed in the source client’s
Remote Access list.
• The user@destination_client must have the Recover Local Data
privilege.
• The user@administering_client must be added to the Windows
Administrator Group on the administering client.

Windows

UNIX

UNIX

• The user must have the Remote Access All Clients privilege or the
user@destination_client must be listed in the source client’s
Remote Access list.
• The user@destination_client must have the Recover Local Data
privilege.
• The recovery must be launched by a system administrator on the
administering client.

Who may perform a directed recovery
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Table 51

Access permissions used in directed recoveries (2 of 2)

Administering
client

Source
client

Destinatio
n client

UNIX

Windows

Windows

Who may perform a directed recovery
• The user must have the Remote Access All Clients privilege or the
user@destination_client must be listed in the source client’s
Remote Access list.
• The user@destination_client must have the Recover Local Data
privilege.
• The recovery must be launched by root on the administering
client.

Note: For security reasons, if a user with incorrect privileges attempts to perform a directed
recovery, no error message will be issued.

Setting the Disable Directed Recover attribute
Directed recovery can be turned on or off for NetWorker clients by using the Disable
Directed Recover attribute in the client’s nsrla.res database. The default setting for the
Disable Directed Recover attribute is No, which means that the client will accept
directed recoveries from remote hosts.
To disable a remote host from directing a recovery to a client, set the Disable
Directed Recover attribute to Yes.
“Editing a client NSRLA database” on page 472 provides information about editing
the nsrla.res database.
Adding a client computer to the remote client’s servers file
“Editing the servers file” on page 487 describes how to add a computer hostname to
the remote NetWorker client’s servers file.

Perform a directed recovery between Windows clients from the GUI
Note: Directed recovery of save sets on Windows is supported from the command line only.
“Perform a directed save set recovery by using the command line” on page 336 provides more
information.

To perform a directed recovery:
1. Start the NetWorker User program by using the -s option to connect to the
NetWorker server to which the source client data is backed up:
winworkr -s servername

If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, allowing
you to choose the server.
Note: Before you can perform a directed recovery of a virtual cluster client, the Client
resource must be configured on the NetWorker server. “Client configuration” on page 470
provides instructions on creating a Client resource. Be sure that the Client resource Remote
Access attribute contains both of the cluster node names.

2. Click Recover to open the Source Client dialog box.
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3. Select the source client, and click OK.
4. Select the destination client for the recovered data, and click OK.
5. In the Recover window, select the files and other items to recover.
6. Click Start to begin the directed recovery.
Special data handling features, such as compression, are not available for the items
you select.
The selected destination client is the recipient of the recovered data. If files with the
same name already exist, they are overwritten unless they have mixed-case names.
Recovered files that contain mixed-case filenames do not replace newer versions of
the same file that have been given a single-case filename.

Perform a directed recovery between UNIX clients from the GUI
To perform a directed file recovery:
1. Start the nwrecover program by using the -s option to connect to the NetWorker
server to which the source client data is backed up:
nwrecover -s servername

The /servers file, located in /nsr/res/servers, contains entries for the NetWorker
servers. If there is more than one server, the Change Server dialog box allows you
to choose which server to connect to.
Note: Before you can perform a directed recovery of a virtual cluster client, the Client
resource must be configured on the NetWorker server. “Client configuration” on page 470
provides instructions on creating a Client resource. Be sure that the Client resource Remote
Access attribute contains both of the cluster node names.

2. Select files and other items to recover.
3. Click the Start a recover operation button.
4. In the Recover Options dialog, click More Options.
5. In the Directed Recover field, enter or select the name of the client to which the
files should be recovered.
6. Click Recover to open the Source Client dialog box.
7. Click OK.
To perform a directed save set recovery:
1. In the nwrecover program, select Recover Save Set from the Operation menu.
2. From the Name list, select the name of the appropriate save set.
3. In the Instances list, select the particular version of the save set (if there are
multiple versions) and click OK.
4. In the Recover Options dialog, select the relocation path in the window.
5. Click the Recover button.
6. Select the appropriate options in the Recover Options dialog box and click OK.
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Perform a directed recovery from the command line
Use the recover command to perform a directed recovery from the command line.
The recover command has a variety of options that you can add to modify the basic
browse and recover functionality. Table 52 on page 335 lists the options available
with the recover command.
Table 52

Recover options

Option

Meaning

-d destination

Specifies the name of the directory for relocated recovered files. With this option,
include a full path for destination, and use the proper syntax for the destination client’s
platform. The use of partial paths is not supported.

-s server

Specifies the name of the source client’s backup server.

-c client

Specifies the name of the source client.

-S SSID

Specifies a save set to recover.

-R recover_destination

Specifies the name of the destination client.

-i (N,Y, R)

Specifies what the NetWorker server should do when there is a naming conflict
between a recovered file and an existing file:
• N — Skip restoring the file.
• Y — Overwrite the existing file.
• R — Rename the file. Each conflicted filename is appended with .R.

directory_name

Specifies the initial directory in which to begin browsing.

The EMC NetWorker Command Reference Guide or the UNIX man pages provide
complete information about the recover command.
Example 28 The recover command

In this example, the source client’s backup server is venus, the source client is mars,
and the destination client is jupiter. All of the files in the specified directory are to be
recovered. The recovered files should overwrite any existing files with the same
name.
Type this command:
recover -s venus -c mars -R jupiter -iY directory_name

Restrictions for Windows command line directed recovery
In addition to the restrictions listed in “Client restrictions for directed recoveries” on
page 331, be aware of the following considerations when performing Windows
directed recoveries from the command line.
◆

If the NetWorker servers and clients are running Microsoft Windows and the
NetWorker server and target recover client are in the same domain:
• Start the NetWorker server (nsrd) as a domain user that is in the Windows
Administrators group on the NetWorker server machine.

◆

If the NetWorker servers and clients are running Microsoft Windows and the
NetWorker server and target recover client are not in a domain, or they are not in
the same domain, ensure that:
• The NetWorker server (nsrd) is started as a local user that exists on both
machines.
Directing recoveries to another client
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• The local user must have the same password on both machines.
• The local user must also be in the Windows Administrators group on the
NetWorker server machine.
◆

To avoid using the Windows version of recover.exe, do one of the following:
• Include <NetWorker_install_path>\bin\recover.exe at the command prompt.
• Ensure that <NetWorker_install_path>\bin is listed before
%SystemRoot%\System32 in the $PATH environment variable.

Note: If a command line directed recovery fails, try to perform the directed recovery from the
NetWorker User program. “Perform a directed recovery between Windows clients from the
GUI” on page 333 provides details.

Perform a directed recovery of specific files and directories by using the command line
To perform a directed recovery of specific files and directories:
1. Type the recover command by using this syntax:
recover -s servername -c source_client -R destination_client -i
recover_option [directory_name]

2. Navigate to the directory with the file to be selected for directed recovery. For
example:
recover> cd /var/adm

3. Select a file or directory by typing this command:
recover> add file_name

4. Repeat step 2 and step 3 for each file or directory to be included in the directed
recovery.
5. View the selected files or directory by typing this command:
recover> list

6. Start the directed recovery by typing this command:
recover> recover

• You can run the recover program from a Windows client to administer
directed recoveries between NetWorker clients on UNIX, but only if both the
source and destination clients are UNIX clients.
• You cannot recover data from UNIX clients to non-UNIX clients, or the
reverse.
Perform a directed save set recovery by using the command line
Perform directed save set recover by using the following command:
#recover -s servername -R destination_client -iR -S SSID1 -S SSID2
Note: You can not recover save sets of different clients to a single client by using the same
command line.
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Recovering online indexes for a NetWorker server
This section includes procedures for recovering the client file index and the media
database.

Recover a client file index
Client file index information is recovered by using the nsrck program.
To recover a client file index:
1. Log in as root or Windows Administrator and run the nsrck command:
nsrck -L5 client_name

The -L5 option purges corrupted save set information from the index.
2. If the volume from which the client file index is being recovered is eligible for
recycling, set the volume to read-only. This ensures that the volume will not be
overwritten during the procedure:
a. Verify whether the volume is eligible for recycling:
– To query by date:
mminfo -mv -c client_name -t time

– To query by save set ID:
mminfo -avot -S ssid
mminfo -mv volume_name

b. If the volume is eligible for recycling, type:
nsrmm -o readonly volume_name

3. Run the nsrck command with the -L7 option to recover the client file index:
nsrck -L7 client_name

To recover the client file index from a specific time, replace this step with the
instructions included in “Recovering a client file index from a specific time and date”
on page 337.
Note: To completely remove a client file index, type nsrck -R -Y client_name, then type nsrck -L7
client_name to recover the index.

Recovering a client file index from a specific time and date
Use the -t time date option with nsrck to recover client file indexes at a specific time.
The time and date formats are in nsr_getdate format. For details on the nsrck and
nsr_getdate commands, refer to the EMC NetWorker Command Reference Guide or the
UNIX man pages.
To recover a client file index for a specific date, type this command:
nsrck -t "time mm/dd/yyyy" -L7 client_name
Example 29 Recovering a client file index from a specific time and date

This command recovers a client file index from March 15, 2010:
nsrck -t "03/15/2010" -L7 client_name
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When you recover a client file index from a time and date in the past, nsrck
adds the full contents of the index from that time and date to a temporary
subdirectory of the client file index directory. If no time value is specified, everything
for the specified date (up to 23:59) will be included. After the index has been read
from the backup media, the required index data is integrated fully into the client file
indexes and the temporary subdirectory is removed. The “required index data”
includes the indexes from the date specified to the first full backup that occurred
prior to the date specified.
Be aware that if a saveset from the specified date runs into the next day, which would
be March 16, 2010 in this example, then the index required to browse the saveset will
not be recovered. To recover this index, you would have to specify March 16, 2010 as
the recovery date as shown in the following command:
nsrck -t "03/16/2010" -L7 client_name

A check on the required index date may be necessary if index backups are set to be
taken once daily. If the backup of the index does not take place until the following
day, the date of the following day must be specified.
The browse policy will be reset on the recovered indexes. These index entries will be
removed automatically after the new browse policy expires or they can be removed
manually by using nsrmm after the file recovery is complete.

Restore a save set entry in the online indexes
These sections describe the process of restoring save set entries into either the client
file index only, or into both the client file index and the media database.
The procedures in this section use the scanner command. When the scanner
command is used to restore entries to the client file index or the media database, the
entries assume the browse and retention policies of the original save set. For example,
suppose a save set originally had a browse time of one month and a retention time of
three months. However, the browse and retention times have expired. When you
restore the save set entry by using the scanner program, the save set then remains
browsable for one month and recoverable for three months.
Using the scanner command efficiently
In NetWorker 7.5 and higher, when a volume is marked with the scan needed flag,
the user can specify the starting file and record numbers that needs to be scanned
from the media database. For example:
scanner -f file -r record -i device

Use these options when a whole volume scan is not needed. This shortens the time
required to run the scanner program. For more information, refer to the EMC
NetWorker Command Reference Guide or the UNIX man pages.
Note: The -i option is not supported for cloud devices.

Restoring a save set entry to the client file index only
If a file is not browsable (which means that the save set’s browse policy has expired),
but its save set is still tracked by the NetWorker server in the media database, you can
make the file browsable by recovering the save set’s entry back into the client file
index.
To recover the save set’s entry back into the client file index:
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1. Log in as root or Windows Administrator.
2. Type the mminfo command at the command prompt:
mminfo -a -v volume_name

where volume_name is the volume that contains the client file index.
3. From the mminfo output, find the ssid that contains the required file. Make sure it
is not the bootstrap ssid.
4. Type the nsrmm command with a new browse time:
nsrmm -S ssid -w browse_time

where browse_time is a time in the future.
5. Type the scanner command:
scanner -i -S ssid

The save set entry is restored to the client file index.
Restoring a save set entry to the client file index and media database
If a volume has a save set that does not appear in the media database and the save
set’s files are not browsable, you can restore these entries in the media database and
the client file index so that the save set’s files can be browsed.
To rebuild the save set’s entry in the media database and the client file index:
1. Log in as root or Windows Administrator.
2. At the command prompt, run the scanner program on the volumes that contain
the appropriate file or files:
scanner device_name

3. Use the output from the scanner program to determine:
• Whether the save set to be rebuilt is on this volume.
• Whether to reintroduce the contents of this volume into the online indexes.
Locate all the volumes that contain this save set ID.
4. If the save set is found on multiple volumes and the order in which the volumes
were written is unknown, complete this step. Otherwise, skip to step 5 .
a. On each volume that will be reintroduced into the online indexes, run this
command:
scanner -m device_name

The media database is updated with information from each volume.
Note: If the volume contains data from an earlier version of NetWorker, there may be
no pool information on the volume. In this case, the volume is considered to belong to
the Default pool. To assign the volume to another pool, use the -b pool_name option in
this step. If the volume already belongs to a pool, the -b option will have no effect.

b. Query the media database to determine the sequence in which the volumes
were written:
mminfo -a -v
In step 5 , the volumes must be reintroduced into the online indexes in the
same order in which they were written.
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5. Starting with the first volume that was written, run the scanner program:
scanner -i device_name

The scanner program prompts for a new volume until you terminate it. Scan in
the remaining volumes in the order in which they were written.
6. Browse for the file to be recovered. “Recovering by file selection” on page 317
provides information about browsing for a file.

Recovering the Console database
The Console database contains management data such as report information.
The EMC NetWorker Disaster Recovery Guide provides information about recovering a
corrupted Console database.

Recovering backed-up client files from an old NetWorker server
This section describes how to move a NetWorker client to a new NetWorker server
without losing the ability to recover the client files that were backed up on the old
NetWorker server. To move a client to a new NetWorker server:
1. Record the Client ID attribute of the NetWorker client on the old server.
a. From the Administration window, click Configuration.
b. In the left pane, click Clients.
c. In the right pane, right-click the client to be renamed, then select Properties.
The Properties dialog box appears.
d. Click the Globals (1 of 2) tab.
e. Record the Client ID attribute listed for the client, then click Cancel to close
the Properties dialog box.
2. On the new NetWorker server, create a new client:
a. In the Name attribute, type a name for the client.
This can be the same name that was used on the old server, but it cannot be the
same name as an existing client on the new server. If a client with the same
name exists on the new server, use this format for the client name:
~hostname-#

where hostname is the hostname of the client.
For example, if the client’s hostname is jupiter, and a client named jupiter
already exists on the new server, type this name:
~jupiter-1

b. Click the Globals (1 of 2) tab.
c. In the Client ID attribute, type the client ID determined in step 1 .
d. Complete other attributes as necessary, and click OK.
3. Import the client file index entries by using the scanner command:
scanner -i -c client_name device_name
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where client_name is the name of the client that was set up on the old NetWorker
server.
You can now recover data that was backed up when the NetWorker client was set
up on the old NetWorker server.
Note: If scanner -i or scanner -m is used to import data before the Client resource is
configured on the new server, the client ID for the imported save sets is maintained in the
media database. If a client of the same name already exists on the new server, scanner
stores the client name in the format described in step 2 . You can then create the client
based on the client ID by completing that step. However, run scanner -i again after
creating the Client resource to import save set information into the client file index.

Recovering the Windows system configuration
To recover a Windows client operating system configuration, recover the SYSTEM or
VSS SYSTEM save sets. Recover all SYSTEM or VSS SYSTEM save sets for a client at
the same time to prevent conflicts.
When All is entered in the Save Set attribute of the Client resource, these SYSTEM
save sets are backed up if no VSS client license exists or VSS is disabled:
◆

SYSTEM STATE

◆

SYSTEM FILES

◆

SYSTEM DB

◆

SHAREPOINT (only if installed on the client to be backed up)

◆

ASR

Note: Non-VSS save sets are not supported with Microsoft Windows Vista or Windows Server
2008.

These VSS SYSTEM save sets are backed up if VSS is licensed and enabled. On
Windows Vista and Windows Server 2008, VSS save sets are enabled automatically
and no VSS license is required:
◆

VSS SYSTEM BOOT

◆

VSS SYSTEM FILESET

◆

VSS SYSTEM SERVICES

◆

VSS USER DATA

◆

VSS OTHER

◆

VSS ASR DISK (Windows Server 2003 only)

If VSS is licensed and enabled, at minimum, back up and recover VSS SYSTEM BOOT,
VSS SYSTEM FILESET, VSS SYSTEM SERVICES, and all boot/system volumes to
properly recover the entire system.
Note: To back up and recover SYSTEM or VSS SYSTEM save sets by using the NetWorker User
program or from the command prompt, you must have local Windows Administrator
privileges.
After recovery of the SYSTEM STATE, SYSTEM FILES, and SYSTEM DB save sets, reboot the
operating system. Additionally, reboot the system if instructed to do so after recovery of any of
the other VSS SYSTEM save sets. This ensures complete recovery of the components.
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Do not attempt to restore the SYSTEM STATE or VSS SYSTEM BOOT save set twice in
succession without rebooting after each operation. If you attempt to restore the VSS
SYSTEM BOOT save set a second time without rebooting after the first restore, this
error message will appear:
regsow:cannot replace Registry key. Access is denied

If you install a service or driver after a backup, then restore the backup, the newly
installed service or driver may not be in the state you expect. Reinstall the service or
driver, or use Control Panel to reconfigure the startup type.
Note: NetWorker software does not determine the Windows operating system version during
recovery of the SYSTEM or VSS SYSTEM save sets. If you attempt to recover SYSTEM or VSS
SYSTEM save sets to a different operating system, the system may be inoperable after the
recovery.

For example, if you back up the SYSTEM or VSS SYSTEM save sets, then upgrade the
Windows software to a new operating system. Do not recover the SYSTEM or VSS
SYSTEM save sets that were backed up under the previous operating system.

Temporary disk space
Restoring the SYSTEM or VSS SYSTEM save sets requires extra disk space on the
system drive for temporary files that are created during the recovery. The process
might require as much extra space as the total size of the SYSTEM or VSS SYSTEM
save sets.
Before restoring the SYSTEM or VSS SYSTEM save sets, run the mminfo command
from the command prompt to check the size of the SYSTEM or VSS SYSTEM save sets
to be restored:
◆

For NetWorker clients running a 32-bit version of Windows 2003, approximately
500MB of extra disk space is usually sufficient.

◆

For NetWorker clients running a 64-bit version of Windows 2003, approximately
1GB of extra disk space is usually sufficient.

◆

For NetWorker clients running a 32-bit or 64-bit version of Windows 2008,
approximately 10GB of extra disk space is usually sufficient.

The default location for the restored system temporary files is a system drive where
the original files reside. For the VSS SYSTEM save sets, the temporary files are placed
in the temp directory on the system drive. For information on how to expand the
available space in the temp directory by moving it to another large partition, refer to
the Microsoft documentation.
When recovering SYSTEM or VSS SYSTEM save sets by using the NetWorker User
program, verify that all save sets were recovered successfully. Do so by reviewing the
messages in the Recover Status window (or the networkr log file) after the recovery
is complete, but before rebooting the client computer.
Note: In Windows 2008 and Windows Vista, the BOOT / BCD (Boot Configuration Data )files
that were in %systemdrive%\boot and %systemdrive%\bootmgr file are recovered to a
temporary location under %systemdrive%\boot_restored-timestamp. A Windows
Administrator can use these files to import BCD settings in a disaster recovery scenario.
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Recovering the Windows SYSTEM from the command prompt
Before attempting to recover Windows SYSTEM components by using the commands
described in this section, be aware of the following limitations:
◆

You cannot recover SYSTEM or VSS SYSTEM save sets by using the recover
command in interactive mode. Instead, use the command line recovery
procedures described in the following sections.

◆

You cannot perform a directed recovery of a VSS SYSTEM save set from the
command prompt.

◆

A maximum of one SYSTEM or VSS SYSTEM save set can be included in the same
recover command. To recover multiple SYSTEM or VSS SYSTEM save sets in one
operation, use the NetWorker User program.

◆

File system directories cannot be specified in the recover command.

◆

A maximum of one SYSTEM or the VSS SYSTEM save set can be specified in an
input file.

◆

File system directories cannot be specified in an input file. An input file is
specified in a recover command with the -I option.

Examples of valid command line entries include:
recover -iY -s servername -N "VSS SYSTEM BOOT:"
recover -iY -s servername -N "VSS SYSTEM SERVICES:"

Examples of invalid command line entries include:
recover -iY -s servername -N "SYSTEM DB:" "SYSTEM STATE:"
recover -iY -s servername -N D:\letters "SYSTEM DB:"

Recover the SYSTEM save sets from the command prompt
To recover the SYSTEM save sets from the command prompt:
1. Recover the SYSTEM save sets in this order:
• SYSTEM DB
• SYSTEM FILES
• SHAREPOINT
• SYSTEM STATE
The command that is used to recover each save set should look similar to:
NetWorker_install_path\bin\recover.exe -iY
[-s NetWorker_server_name] -N "saveset_name"
2. Reboot the computer. The original SYSTEM files will be replaced by restored files.
Note: If the recovery process stops responding, terminate the process and perform the recovery
operation again.

Recover the VSS SYSTEM save sets from the command prompt
To recover the VSS SYSTEM save sets from the command prompt:
1. Recover the VSS SYSTEM save sets in this order:
• VSS SYSTEM SERVICES
• VSS SYSTEM FILESET
• VSS USER DATA
Recovering the Windows system configuration
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• VSS OTHER
• VSS SYSTEM BOOT
The command that is used to recover each save set should look similar to this:
NetWorker_install_path\bin\recover.exe -iY
[-s NetWorker_server_name] -N "saveset_name"
2. Reboot the computer. The original VSS SYSTEM files will be replaced by restored
files.
Note: If the recovery fails, an error message appears. Use the Windows Event Viewer to
examine the event logs for additional information. VSS recovery error messages are also
written to the NetWorker log file.

Recover VSS SYSTEM save set components from the command prompt
You can recover individual components (writers) within these VSS SYSTEM save sets:
◆

VSS SYSTEM SERVICES

◆

VSS USER DATA

◆

VSS OTHER

Note: You cannot recover individual components of the VSS SYSTEM save sets by using the
recover command in interactive mode. Instead, use the procedure described in this section or
use the NetWorker User program.

To recover selected components:
1. Type the following at the command prompt:
NetWorker_install_path\bin\recover.exe -iY [-s
NetWorker_server_name][-t browse_time]-N
"VSS_SYSTEM_SAVESET_NAME:\component_name"

2. Place a semicolon (;) between multiple component names.
For example, to recover the Event Log Writer writer and the WMI Writer writer,
type:
C:\Program Files\Legato\nsr\bin\recover.exe -iY
-s jupiter -N "VSS SYSTEM SERVICES:\Event Log Writer;WMI Writer"
Note: Windows Server 2008 and Windows Vista do not have an event log writer. The event logs
will not be backed up as part of the VSS system save sets. The event logs are backed up as part
of the file system.To back up the event logs, you should perform a regular (non-VSS) backup of
the system32\winevt\logs folder.

Point-in-time recovery of the SYSTEM and VSS SYSTEM save sets
To recover the SYSTEM or VSS SYSTEM save sets to a specific point in time from the
command prompt, specify the ID of the save set to be restored. To browse a list of
valid save set IDs:
1. From the NetWorker Console Administration window, click Media.
2. In the expanded left pane, select Volumes.
3. In the right pane, right-click one of the volumes listed and select Show Save Sets.
4. In the SSID column, note the appropriate save set ID.
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5. Type this command on the NetWorker client host to restore the system state or
system database to a particular point in time:
NetWorker_install_path\bin\recover.exe -iY [-s
NetWorker_server_name] -S SSID

where SSID is the save set ID that was noted in step 4 .
Note: If the recovery fails due to a problem with VSS or a writer, an error message appears. Use
the Windows Event Viewer to examine the event logs for additional information. VSS recovery
error messages are also written to the NetWorker log file.

Point-in-time recovery of Microsoft SQL Server or Exchange Server from earlier versions of
NetWorker
This version of NetWorker can perform a point-in-time recovery of a Microsoft
Exchange Server or Microsoft SQL Server database that was backed up with the
NetWorker Client release 7.2.x.
In NetWorker release 7.3 or later, use the following EMC NetWorker modules for
backup and recovery of Microsoft servers and server applications:
◆

EMC NetWorker Module for Microsoft Exchange to back up and recover the
Exchange Server.

◆

EMC NetWorker Module for Microsoft SQL Server to back up and recover the
SQL Server.

◆

NetWorker Module for Microsoft Applications to back up and recover Exchange
Server, SQL Server, Office Sharepoint Server, and Data Protection Manager
Server.

Performing a point-in-time recovery of an Exchange Server database
If VSS is licensed and enabled, a point-in-time recovery of a Microsoft Exchange
Server database can be performed.
Note: These steps are not required if the NetWorker Module for Microsoft Exchange Server is
being used.

To perform a point-in-time recovery of an Exchange server database:
1. Take the Microsoft Exchange Server databases offline.
2. Go into the storage group and delete all the *.log and *.chk files from the
Exchange data directories.
3. Complete the recovery.
4. Bring the Exchange Server databases back online.
Performing a point-in-time recovery of a SQL Server database
If VSS is licensed and enabled, a point-in-time recovery of a Microsoft SQL Server
database can be performed.
To perform a point-in-time recovery of a SQL Server Database:
1. Take the Microsoft SQL databases offline.
2. Run the NetWorker User program, and in the left pane of the Recover window
expand VSS SYSTEM SERVICES.

Recovering the Windows system configuration
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3. Mark the MSDE Writer folder.
4. Complete the recovery.
5. Bring the SQL Server databases back online.

Preparing to recover the Windows SYSTEM STATE save set
Table 53 on page 346 describes components of the SYSTEM STATE save set that
require special preparation before being recovered.
Table 53

Preparing to recover the SYSTEM STATE save Set

Component

Recover preparation

Active Directory
(if installed)

1. When the computer is restarting, "Directory Services Restore Mode" must be specified.
2. On any domain controller that is a DNS server, ensure that the
%SystemRoot%\system32\drivers\etc\hosts file includes the name and IP address of
the NetWorker server.
The EMC NetWorker Disaster Recovery Guide provides complete details.

Certificate Server (if installed)

1. Reinstall the Certificate Server after reinstalling the operating system.
2. Specify the same name for the Certificate Server database, and the same paths for the
database and log files, as when the system was backed up.
3. Copy the EFS keys. For information about EFS keys. “Encrypting file system” on
page 734 provides more information.

Cluster Server (if installed)

Shut down the Cluster Service on any nodes in the cluster on which the service is running ,
except for the node on which the recover will be performed. To shut down the cluster
service, performing one of the following:
• Type the net stop clussvc command at the command prompt.
• Use the Microsoft Computer Management program.

COM+ Database

Set the TEMP environment variable to a valid temporary directory.

SYSVOL (if installed)

None

Internet Information Server

None

Performance Counters

None

Preparing to recover the SYSTEM DB save set
Table 54 on page 346 describes components of the SYSTEM DB save set that require
special preparation prior to recovery.
Table 54
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Preparing to recover the SYSTEM DB save set

Component

Recovery Preparation

Disk Quota
Database

• Subsystem for drive being recovered must be created with same drive letter as the
original.
• Subsystem must be enabled.
• Drive must be in NTFS format.

Removable Storage

Removable Storage database backup and recovery is not supported.

Terminal Services
Licensing (if installed)

Terminal Services Licensing must be running.

WMI

None
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Recovering Windows volume mount points
A volume mount point (or mount point) is a disk volume that is grafted into the
namespace of a host disk volume. This allows multiple disk volumes to be linked into
a single directory tree, similar to the way DFS links network shares into a unified
structure.
Assigning a drive letter to a mount point is optional. Many disk volumes can be
linked into a single directory tree, with a single drive letter assigned to the root of the
host volume.

Recovering mount points
Perform separate recovery operations to recover the mount point and the mounted
volume’s data.
Note: The NetWorker Save Set Recovery feature does not support recovery of mount points. To
recover mount points and their data, use these special procedures. These procedures do not
apply if Automated System Recovery (ASR) is used. Chapter 23, “Support for Windows XP
and 2003 Automated System Recovery” provides information about support for ASR.

Recovering a mount point and its data
To recover a Windows mount point and its data:
1. Manually create the mountpoint, if it does not exist already.
2. Start the NetWorker User program and recover the data under the mount point.
“Recovering by file selection” on page 317 provides more information about
performing data recoveries.
Recovering nested mount points
To recover nested mount points and their data:
1. If the mount points do not already exist, manually create the top-level mount
point, then work down the hierarchy and create each successive mount point.
2. Start the NetWorker User program and recover the data under the mount points.

Recovering Windows volume mount points
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Recovering Windows DHCP and WINS databases
If VSS is licensed and enabled, the DHCP and WINS databases are automatically
included when performing a backup of save set All, Consequently, these procedures
are not required.

Recover a DHCP database
To recover the DHCP database:
1. Using the NetWorker User program, recover the %SystemRoot%
\System32\dhcp directory.
2. Using Microsoft DHCP administrative tools, restore the DHCP database. The
Microsoft documentation provides detailed instructions about Microsoft DHCP
administrative tools.

Recover a WINS database
To recover a WINS database:
1. Use the NetWorker User program to recover the backup configured in the WINS
backup procedure. “Backing up a WINS database” on page 84 provides more
information.
2. Use Microsoft WINS administrative tools to restore the WINS database.
Note: For detailed instructions about Microsoft WINS administrative tools, refer to the
Microsoft documentation.

Restoring Windows Content Index Server on Windows
The Windows Content Index Server (CIS) indexes the full textual contents and
property values of files and documents stored on the local computer.
The backup and recovery of the CIS occurs as part of the SYSTEM DB save set. If VSS
is enabled, the CIS is automatically regenerated upon system reboot.
Note: If you delete a nondefault CIS database and then try to restore it, the restored database
cannot be active until the registry is restored as part of a SYSTEM STATE save set recovery.

During a CIS restore:
◆

If you are using the CIS in a program that provides search capability (for example,
a website), the search functionality will not be available.

◆

Queries can be issued, but response time might be slow.

After a restore, the CIS automatically updates the catalogs to reflect the current data.
Therefore, if it has been a long time since the last backup, it may be more efficient to
rebuild the catalog than to restore it. However, if the catalog is very large, restoring it
might be faster than rebuilding it.
Note: After a restore, all catalog directories automatically restart, even if they were stopped at
the time of the backup.

348

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Recovering Data

If a restore of the CIS fails, rebuild the CIS:
1. Right-click My Computer and select Manage to open the Computer
Management console.
2. Expand Services and Applications.
3. Right-click the catalog to be rebuilt and select All Tasks>Empty Catalog.
4. Manually stop the CIS and restore the CIS again.
5. Restart the CIS.
When you restart the service, the CIS re-indexes the entire catalog.

Restoring Windows Content Index Server on Windows
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Restoring BOOT/BCD Data on Windows 2008 R2 and Windows 7
In Windows 7 and Windows 2008 R2, the BCD store contains the boot configuration
parameters and controls the computer’s boot environment.
BCDEdit is a command-line tool provided by Microsoft to add, delete, edit, and
modify data in a BCD store.
During recovery, the BCD file is recovered to the folder
C:\boot_restored-{timestamp}. To restore the recovered file, import the file by using
the following command:
bcdedit /import c:\boot_restored-{timestamp}\BCD
Note: Restoring the recovered file is optional.
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Gathering report data
To facilitate trend analysis, capacity planning, and problem detection, NetWorker
software automatically collects data on a continual basis from the NetWorker
enterprise. NetWorker Console stores the collected information in the Console
database for a specified number of days, as described in “Data retention and
expiration policies” on page 353.
NetWorker software then integrates and processes this data to produce a number of
reports on backup status, backup statistics, events, inactive files, hosts, users, and
devices. “Report categories” on page 355 provides detailed information about the
various types of reports.
The following options are available through the NetWorker Console reporting
feature:
◆

Data collection for the entire enterprise or for specific NetWorker servers.

◆

Creating of various types of reports.

◆

User preferences for report data, such as font, size, and whether or not to use
bold. This can be useful in I18N environments.

◆

Selection of columns to display when viewing reports in a table format, and the
order in which to display them.

◆

The ability to save customized reports for repeated use.

◆

The ability to determine how long collected data should be retained.
Only NetWorker administrators can modify these time periods.

◆

The ability to share reports, or restrict the sharing of reports, with other users by
giving them access to the reports.

◆

The ability to hide shared reports of other users when listing reports.

◆

The ability to run reports from the command prompt.

Note: The NetWorker Console is unable to generate reports when deployed in a pure IPv6
environment due to a Sybase iAnywhere 9 limitation.

Enabling/Disabling the gathering of report data
The Gather Reporting Data feature is set by default when a host is added to the
enterprise. If the NetWorker server to be monitored is not yet in the enterprise, you
can enable the Gather Reporting Data feature when adding the NetWorker server to
the enterprise. “Adding a managed host” on page 428 provides details.
To enable or disable the gathering of report data:
1. From the Console window, click Enterprise.
2. Select the NetWorker server for which the collection of report information is to be
enabled.
3. Right-click the NetWorker managed application, then select Properties. The
Managed Application Properties dialog box appears.
4. Under Features, select Gather Reporting Data, then click OK.
To disable the gathering of reporting data, clear the Gather Reporting Data
checkbox, then click OK.
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Data retention and expiration policies
NetWorker Console provides separate expiration polices for retaining different types
of data, in the NetWorker Console database, to meet the needs of the environment as
described in Table 55 on page 353. Only a Console Application Administrator can
modify these policies.
Table 55

Data retention policies

Retention policy

Type of data to be retained

Default

Completion Data (in Backup Status reports, except in the save Savegroup and save set completion data and drive data.
set output).
Retention policy for completion data can affect multiple reports.

One month

Completion Message (in Backup Status reports, only in the
save set output).
Retention policy for completion messages can affect multiple
reports.

Messages, such as error messages for failed save sets.

Two weeks

Save Set Data (in all Backup Statistics reports).
Retention policy for save set data can affect multiple reports.

Save set records.

One year

Audit Data (in User Audit reports).
Retention policy for audit data affects only audit reports.

Reports on all NetWorker tasks (except License Manager
tasks) performed by specified users (but only when the
NetWorker User Auditing system option is activated).

One year

Recover Statistics
Save Set Data in Recover Statistics reports.

Save set records.

One year

You can view the retention policies for data to which they have access by following
the first three steps in “Setting expiration policies for data retention” on page 354.
These different policies give administrators the flexibility to retain certain types of
information for less time than others, as demonstrated in Example 30 on page 353.
Note: Reports not mentioned in Table 55 on page 353 have no retention policies.

Example 30 Retention flexibility

An administrator might want to set the completion message policy to a shorter
period than the completion data policy. The precise error messages about what
caused a save set backup to stop might not be relevant over a longer time period. But
it might be useful to save the completion data for a somewhat longer period to help
with load balancing and trends.
The longest time period (one or more years) might be a suitable selection for save set
data. This data is used to generate the NetWorker Backup Statistics reports. These
reports can be used to determine historical trends about backups and to help guide
capacity planning.
Note: The expiration policies restrict the data that can be retrieved by NetWorker Console. In
other words, reports cannot include data that is older than the data retention policy. Once data
is purged because of the retention policy, it cannot be retrieved except by recovering the full
database.

If, for example, an administrator changed a policy expiration period from 1 year to 1
month and soon afterwards reset it to 1 year, 11 months of data would be lost.

Data retention and expiration policies
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Setting expiration policies for data retention
Note: Only a Console Application Administrator can perform this procedure.

To set expiration policies:
1. From the Console window, click Reports.
2. From the Reports menu, select Data Retention. The Data Retention dialog box
appears.
3. For each policy, type the number of periods and select a period of time (year,
month, week, day).
4. To save the configuration of the data retention policies, click OK.
Note: There must be adequate space in the Console database to hold the data. If the data
retention policy settings cause the Console database to run out of storage space, it stops
running. The NetWorker Installation Guide provides information about estimating the size of the
Console database .

Running a jobquery
The jobquery command is a command that can be used to view jobs by type and by
status. A query is defined by an attribute list that is made of one or more attribute
names with or without values.
In the query, the attribute name (for example, 'type') is preceded by a '.', and
optionally followed by a ':' and a comma-separated list of values (for example, "host:
mars";"job state: STARTED, ACTIVE, SESSION ACTIVE"). When a query consists of
more than one attribute names, attributes are separated by a ';'. When an attribute
name is specified without values, any resource descriptor that contains this attribute
is a match. If an attribute name is followed by one or more values, a resource whose
value list matches at least one of the values for the specified attribute satisfies the
criteria.
Running jobquery -s <server> will connect to specified server and return a prompt
where you can then run a query with the following commands:
◆

types — a command that lists all job types currently known by nsrjobd that does
not take any argument (for example, types will return a list indicating Known
types: save job, savegroup job, and so on).

◆

. — a command that sets the query criteria and is followed by one or more
attribute names, or lists current query criteria when not followed by any
attribute.
Query criteria may contain several attributes, including job type, host, and job
state, with each attribute separated by a semi-colon and each value separated by a
comma, as in the following example:
jobquery> . type: savegroup job; host: mars; job state: ACTIVE,
COMPLETED

The above example would return information on all savegroup jobs from the
machine mars that are either in progress or in completed state.
◆
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show — restricts the list of attributes returned for each resource descriptor that
matches the query. For the above example, specifying the following:
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show name; job id; completion status; completion severity

will return the names, job ids, completion status and completion severity for all
matched completed and active savegroups.
◆

print — executes the query and displays the results. If show list is in effect, each
resource descriptor in the result list is restricted to desired attributes.

◆

all — returns all resource descriptors in the jobs database. If show list is in effect,
result is restricted to desired attributes.

◆

help — displays help text.

◆

quit — exits jobquery.

Note: If no server is specified, jobquery attempts to connect to nsrjobd on the local host. If
there is no nsjrobd running on the specified server or the local host, an error is returned.

Running jobquery -i <input file> reads input from the file for non-interactive usage.

Report categories
Table 56 on page 355 describes the various report categories included in NetWorker
software. Each of these categories is discussed in detail in “Preconfigured reports” on
page 366.
Report categories appear as folders within the Reports window. These reports can be
run either from the Console window or from the command prompt.
Table 56

Report categories(1 of 2)

Category of report

Purpose

NetWorker Backup Statistics

Provide statistical information about save sets from the media database.
Include summaries of size, number of files, and number of save sets backed
up. “NetWorker backup statistics reports” on page 367 provides more
information.

NetWorker Backup Status

Provide status information about savegroup completion and save set backups.
“NetWorker backup status reports” on page 368 provides more information.

Clones

Provides the history of automatic and scheduled clone operations performed
on NetWorker servers on version 7.6 Service Pack 2 and later. “NetWorker
clone reports” on page 370 provides more information.

Events

Provide summary and detailed information about NetWorker events.
“Event reports” on page 376 provides more information.

Hosts

Provide a listing of NetWorker servers in the Enterprise, including information
about event and reporting features. “Host reports” on page 378 provides more
information.

Users

Provide lists of defined NetWorker Console users, logout and login reports,
audit reports, and users with restricted views. “User reports” on page 378
provides more information.

Devices

Provide information about the way devices are being used.
“Device reports” on page 378 provides more information.

Inactive Files

Manages inactive files on a client or group and sets the NetWorker software to
automatically generate a list of inactive files in an environment.
“Inactive files report” on page 380 provides more information.

Report categories
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Table 56

Report categories(2 of 2)

Category of report

Purpose

NetWorker Recover

Provide the history of recovery operations that have been performed by
NetWorker servers. “NetWorker recovery reports” on page 372 provides
detailed information about the reports in this category.

Avamar Statistics

Provide deduplication backup statistics for each selected NetWorker client.
“Avamar Statistics reports” on page 374 provides more information.

Cloud Backup and Recover

Provide information on the Cloud usage for scheduled backups and recovers
that are performed by the NetWorker server to and from the Cloud storage
device. “Cloud backup and recover reports” on page 379 provides more
information.

Data Domain Statistics

Provides deduplication backup statistics for each selected NetWorker client.
NetWorker Data Domain Deduplication Devises Integration Guide provides
more information.

Report types
All of the reports are listed within the report category folders. These folders are seen
in the left pane of the Reports window. Each folder contains basic and drill-down
reports. “Basic reports” on page 356 and “Drill-down reports” on page 357 provide
detailed information.
Different icons represent the different types of reports:
Table 57

Icon

Report icons

Description
Basic report

Shared basic report

Drill-down report

Shared drill-down report

Basic reports
The basic reports organize the collected data in a manner that focuses on a specific
datazone component, time span, or attribute. For example:
◆

A Server Summary of Backup Statistics provides backup statistics in a
server-centric manner.

◆

A Monthly Summary of Backup Statistics provides the backup statistics in a
date-centric manner.

◆

A Priority Summary of Events provides a report in an attribute-centric manner.

Select the basic report that best provides the information you need.
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Drill-down reports
Drill-down reports are preset sequences of basic reports, and can be saved as
customized reports in shared mode.
Move up and down through a sequence to compare the information provided by the
different focal points. For example, from the NetWorker Backup Status category, it is
possible to select the Group Status by a Server drill-down report. This report starts at
the server level, then drills down to display a summary report for each of the
following:
◆

A selected group

◆

A selected monthly summary

◆

A selected daily summary

Note: In “document mode” for drill-down reports, the print and export commands do not print
or export the entire drill-down report, just the basic report that is currently displayed. Also
note that drill-down reports cannot be run from the command prompt.

Customized reports
A report that is included with NetWorker software is known as a “canned report”
and includes several configuration parameters that allow the tailoring of report data.
With customized reports, report versions can be configured—a single time—to fit the
needs of the enterprise, and then saved and rerun whenever necessary, without
having to be configured again. This saves time, especially with regularly run reports
that include complex combinations of parameters. Customized reports can be run
either on demand, or according to a preset schedule. The owner of a saved report can
also allow it to be shared with all users.
The Hide Other Users Reports option toggles the view of reports between:
◆

The owner’s reports (private and shared)

◆

The owner’s reports, plus all shared custom reports

“Customizing and saving reports” on page 381 and “Sharing reports” on page 383
provide more information.

Configuring reports
Each type of report includes its own configuration parameters that act as filters
limiting the data used to build the report output. By default, these parameters are set
to include all the information available in the report, which means that the filters are
turned off to begin with.
For example, the NetWorker Backup Statistics Server Summary report includes these
configuration parameters:
◆

Server name

◆

Backup type

◆

Backup level

◆

Save time

Configuring reports
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In this example, accepting the default configuration of selected parameters results in
a report that includes backup statistics for all the servers in the enterprise. The
statistics reported for each server would include all backup types and levels, and the
time range would include all the data available.
Note: For Drive Utilization reports, the time range cannot exceed eight days. “Date and time
formats” on page 358 provide more information about this limitation, or for details on how to
set this range.

The scope of a report can be limited by filtering out one or more parameter options,
for example:
◆

To exclude certain servers in the enterprise from the report, remove selected
server names from the Server Name Selected box.

◆

To select only full backups, remove the other backup types from the Server Name
Selected box.

◆

To include only the statistics for the past month, specify that time range. Time
ranges are localized. The input format follows the format specified in locale
settings of the operating system.

When a parameter is removed from the Server Name Selected box, it goes into the
Server Name Available box. To include that parameter again, click Add ( ).

How to configure a report
To configure a report:
1. From the Console window, click Reports.
2. Expand a report category folder, then select an available report type.
• When a report type has been selected, the Configure tab for that report
appears in.
• The possible parameters for that report appear by default in the Selected
boxes.
3. To limit the scope of the report, click any of the parameters in the Selected box,
then click Remove ( ).
• To remove all of the parameters from the Selected box, click Remove All (

).

• Removed parameters appear in the Available boxes.
4. To return:
• A single parameter to the Selected box, select it from the Available box and
click Add ( ).
• All available parameters to the Selected box, click Add All (

).

5. To display the report, select the View Report tab.

Date and time formats
If a report includes a date-and-time-range parameter, specify the beginning and end
date and time in the To and From text boxes. Clicking the arrow of a time input field
displays a calendar and clock selector, including adjustment arrows for setting
values.
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In US English locales, the default “From” hour is 12:00:00 (midnight/morning) on the
“From” date, and the default “To” hour is 11:59:59 (night) on the “To” date. The US
English locale is the only one that includes a box for an A.M. or P.M. value.
In non-US English locales, the default “From” hour is 00:00:00 (midnight/morning)
on the “From” date, and the default “To” hour is 23:59:59 (night) on the “To” date.
The option of displaying times in 12- or 24-hour formats is determined by the
Regional and Language Settings on the system.

Input formats
Date and time input formats in the NetWorker software vary. Some acceptable input
formats for a collection of common locales are shown in Table 58 on page 359.
Table 58

Date and time input formats for common locales

Language

Date formats

Time formats

US English

•
•
•
•

• h:mm:ss a z (11:27:30 P.M. PST)
• h:mm:ss a (11:27:30 P.M.)
• h:mm a (11:27 A.M.)

UK English

• DD MMMM YYYY 08 March 2009)
• DD-MMM-YYYY (08-Mar-2009)
• DD/MM/YY (08/03/07)

• HH:mm:ss z (23:27:30 PST)
• HH:mm:ss (23:27:30)
• HH:mm (23:27)

French

•
•
•
•

EEEE D MMMM YYYY (lundi 8 mars 2009)
D MMMM YYYY (8 mars 2009)
D MMM YYYY (8 mar. 2009)
DD/MM/YY (08/03/07)

• HH:mm:ss z (23:27:30 PST)
• HH:mm:ss (23:27:30)
• HH:mm (23:27)

German

•
•
•
•

EEEE, D. MMMM YYYY (Montag, 8. März 2009)
D. MMMM YYYY (8. März 2009)
DD.MM.YYYY (08.03.2009DD)
MM.YY (08.03.07)

• HH:mm:ss z (23:27:30 PST)
• HH:mm:ss (23:27:30)
• HH:mm (23:27)

Japanese

• YYYY/MM/DD (2009/03/08)
• YY/MM/DD (07/03/08)

• HH:mm:ss z (23:27:30 JST)
• HH:mm:ss (23:27:30)
• HH:mm (23:27)

Simplified
Chinese

• YYYY-M-D (2009-3-8)
• YY-M-D (07-03-8)

• HH:mm:ss (23:27:30)

EEEE, MMMM D, YYYY (Monday, March 8, 2009)
MMMM D, YYYY (March 8, 2009)
MMM D, YYYY (Mar 8, 2009)
M/D/YY (3/8/07)

In Table 58 on page 359, note that:
◆

Formats shown as single digits (M, D, h) may also be entered as double digits. For
example, M could be either 7 or 07 for the seventh month.

◆

In the time-formats column:
• The a character denotes a 12-hour format.
• The absence of an a character denotes a 24-hour format.
• The z character indicates time zone. If the z is present, then the output time
will contain a time zone.

Relative times can also be entered in the From and To fields. A valid relative time
consists of an number followed by a unit of time, for example, 2 months. Time units
can include Hour, Day, Week, Month, and Year.

Configuring reports
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Remember that these reports are run by using dates that have already occurred.
Consequently, even the To date is always a past date. The relative time 4 months
would provide report data covering the past 4 months. A report specifying from 9
months to 1 month includes data from nine months ago up to one month ago.
Note: For Drive Utilization reports, the time range cannot exceed 8 days. That is, the date
entered in the To field cannot exceed 8 days from the date entered in the From field. If typing a
relative time in the To field, the value cannot exceed 8 days.

Viewing reports
Before displaying a report, select the scope of the report by specifying Configuration
parameters. “How to configure a report” on page 358 provides information on
configuring reports.
In addition, reports can be printed or exported to various file formats. “Printing
reports” on page 386 and “Exporting reports” on page 384 provide information about
printing and exporting.
The administrative user can restrict a user’s view of the enterprise to certain servers,
affecting the user’s view and scope of his or her reporting.

View reports
To view reports:
1. From Console window, click Reports.
2. Select a report type.
3. To limit the scope of the report, specify parameters on the Configuration tab.
4. Click the View Report tab. Most reports display initially in interactive mode and
table format.
5. To modify the current view, right-click on the View Report tab and select the
appropriate view option.
Reports can be displayed in either interactive or document mode. Depending on the
report, you may also select to display the content of the report as a table or as a chart.
NetWorker supports the following report modes:
◆

“Interactive mode” on page 360

◆

“Document mode” on page 362

◆

“Interactive and document mode chart types” on page 363

In addition, NetWorker includes these restrictions and processing considerations:
◆

“Restricting report views” on page 366

◆

“Background processing of reports” on page 366

Interactive mode
Interactive mode displays a report with dynamic components. The effect of the
dynamic components depends on whether a report is viewed as a table or as a chart.
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Interactive mode allows access to drill-down reports. Drill-down reports
conveniently group related reports to make it easier to view increasing levels of
granularity in report data.
Interactive Mode also offers a set of chart selection choices. These choices limit the
data in a report by including or excluding certain parameters. Examples of
chart-selection parameters include:
◆

Duration

◆

Save set size

◆

Number of files

◆

Amount of data

◆

Number of save sets

Not all parameters apply to each chart type.
Interactive mode table view
In the table view of the interactive mode, you can:
◆

Scroll through rows of the table.

◆

Sort, rearrange, or resize columns in the table.

◆

Choose which columns to display, and the order in which to display them.

Note: In interactive mode, tables can be sorted just as they can be sorted within other Console
windows.

Interactive mode chart view
When a chart is displayed in interactive mode, you can:
◆

Switch back and forth between different chart formats by selecting a format from
the Chart Type list.
A simplified list of chart formats is provided in Table 59 on page 363.
Note: When viewing a Drive Utilization report as a chart, it automatically displays as a
Gantt chart. The chart type cannot be changed.

◆

Change selections by using the Data Selector, where applicable.
The Data Selector is available in select reports, and includes control-column
information that works in conjunction with a graph of numerical data. While the
Data Selector is useful in table format, it can also be used to display interesting
and useful data groupings in chart format.
For example, in a Group Summary by Server report displayed in Bar Chart
format, the bar chart displays the amount of data in each group, and the Data
Selector lists the "Server" control column, making it possible to see—in one
place—a summary of groups across all servers, simply by moving through the list
of servers in the Data Selector. This could be useful for finding the group that
backed up the most data, or for balancing groups on servers.

◆

Limit the set of X and Y axes in the report by clearing one or more options from
the Chart Selector checkboxes. This does not apply to Drive Utilization reports.

◆

For Drive Utilization reports, hover over a chart in Save Set view or Drive view to
display a tool tip that includes this information:
• Drive (Drive view only)
Viewing reports

361

Reporting

• Save Set Name (Save Set view only)
• Start Time
• End Time
• Client Name
• Throughput (B/Sec)
Note: The tool tip feature for Drive Utilization reports is available only in Interactive mode.

Document mode
Document mode displays a static report that resembles the view in Print Preview as
shown by a PDF file viewer. Within Document mode, these options are available:
◆

Orientation (portrait or landscape)

◆

Table or chart format

◆

Size (zoom level)

Note: In Document mode, for any chart type that displays X-Y axes, two graphs are displayed.
If the top graph contains excessive Y-axis data, the data displayed in both graphs could be
truncated.

In Document mode, the columns of a tabular report cannot be sorted, rearranged, or
resized. In addition, you cannot choose which columns to display, and the order in
which to display them. Likewise, the chart format cannot be modified while viewing
a report. NetWorker software does not maintain any customized changes made while
displaying a report in interactive mode (such as sorting or rearranging the columns in
a table), except for charts (in Chart Type and Chart Selector). Instead, document
mode displays the report in a standard table or chart format, as specified by the
internal report definition within NetWorker software.
Unlike Interactive Mode, which offers a set of parameters for chart selection that limit
the data that is displayed, a report in Document mode displays all of the data. As a
result, report views in Document mode often consist of several screens. For this
reason, the viewing choices in Document mode include these options for paging
through the output:
◆

First

◆

Previous

◆

Next

◆

Last

Document mode table view
Document-mode reports displayed as a table contain several columns of information:
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◆

One or more control columns represent report information that cannot be summed
as quantitative data (for example, Server name, Save set name, Backup type, and
so on). The control columns topics are generally shown as X-axis data in charts.

◆

One or more data columns represent report information that can be summed as
quantitative data (for example, Amount of data, number of files, number of save
sets, and duration). The data columns topics are generally shown as Y-axis data
in charts.
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The bottom line of each report gives subtotals and totals of all the columns of
quantitative data shown in the report.
For example, a report on Save Set Details by Client:
◆

Lists each client.

◆

Provides:
• Subtotals of the data columns for each of that client’s save sets.
• Totals of all the data columns for each client.
• Totals of the data for all clients in the report.

This makes it easy to parse the data, visually, on a per-client basis, on a save
set-per-client basis, and for all clients in the report.

Interactive and document mode chart types
These chart types are available in both interactive and document mode:
◆

Bar chart

◆

Pie chart

◆

Plot chart

◆

Stacking bar chart

◆

Gantt chart (for Drive Utilization reports only -- more information is provided in
the section “Types of Device reports and configuration” on page 378).

Note: When displaying reports in chart format, the size and appearance of the chart may differ
depending on the orientation (portrait or landscape) and the presentation format—that is,
whether viewing it in the Console window, or in other file formats, such as PDF, HTML, or
PostScript. When displaying reports as charts in document mode, or when printing or
exporting to HTML or PostScript, the charts are always displayed on a single page, regardless
of their size. As a result, some data and labels may not display. To see full report details, view
the chart in interactive mode.

Table 59 on page 363 shows a simplified version of chart format options.
Table 59

Format

Report chart formats(1 of 2)
Example

Bar

Plot
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Table 59

Report chart formats(2 of 2)

Format

Example

Pie

Stacking Bar

Gantt

Bar chart
A bar chart uses bars to illustrate the different types of data. For example, in a bar
chart of a NetWorker Backup Statistics Server Summary report, the vertical bars
show the amount of data backed up by each server. The additional lines show the
corresponding numbers of files and save sets backed up by each server.
The set of axes displayed in the report depends on the type of report.
To select various elements for display, select or clear the appropriate checkboxes in
the Chart Selector.
Plot chart
Plot charts display data graphed as points along X and Y axes.
To select various elements for display, select or clear the appropriate checkboxes in
the Chart Selector.
Pie chart
Pie charts display data graphically as a percentage of a circular “pie.” When
specifying this chart type from the Console window, the Chart Selector includes a
radio button that allows the display of only one element, or axis, at a time. If an
additional element is selected, it replaces the first. This limitation does not occur
when this chart type is specified from the command prompt:
◆

When this chart type is selected from the Console window, all applicable data
axes are shown.

◆

When this chart type is specified from the command prompt, only the requested
information is included.

Stacking bar chart
The stacking bar charts are most appropriate for reports where the data is grouped
and measured according to more than one category. For example, use of a stacking
bar chart to display a report that measures data according to only a single point of
focus would display just a simple bar chart. Stacking bar chart reports generally
include by in the name, such as by date or by host.
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In Interactive mode, movement of the cursor over a section of stacked color causes a
pop-up legend to appear. The legend describes the data represented by that color.
This chart type is inappropriate for complicated data in Document mode, since the
cursor does not display a legend describing the data represented by that color.
Instead, in Document mode, select a different chart type (bar, pie, or plot) if the report
data is complicated.
When specifying this chart type from the Console window, the Chart Selector
includes a radio button that enables the display of only one element, or axis, at a time.
If an additional element is selected, it replaces the first. This limitation does not occur
when this chart type is specified from the command prompt.
◆

When this chart type is specified from the Console window, all applicable data
axes are shown.

◆

When this chart type is specified from the command prompt, only the requested
information is shown.

Example 31 on page 365 describes appropriate use of the stacking bar chart type.
Example 31 Appropriate usage of the stacking bar chart

To appreciate the different ways in which a stacking bar chart may be used, consider
these reports:
◆

A NetWorker Backup Statistics Group Summary by Server shows statistics
broken down by savegroup for each server. Different blocks of color are used for
the amounts of data backed up by each savegroup within the vertical bars that
represent the amount of data that are backed up by servers.

◆

A NetWorker Backup Statistics Server Summary shows data from only one focus,
a server-centric point of view. If a stacking bar chart is selected to display a
NetWorker Backup Statistics Server Summary, the chart would display solid bars
of color to represent the servers. There would, however, be no blocks of color
within the bars, because the report focuses only on the server level. The result
would therefore look like a simple bar chart.

Gantt chart
When viewing a Drive Utilization report as a chart, it automatically displays as a
Gantt chart, and the chart type cannot be changed. The Drive Utilization report is the
only report that displays as a Gantt chart.
In Save Set view, the X axis displays the time, and the Y axis displays save set data.
Hovering over the chart in Save Set view displays a tool tip that provides this
information:
◆

Save set name

◆

Start time

◆

End time

◆

Client name

◆

Throughput value

In Drive view, the X axis displays the time, and the Y axis displays drive data.
Hovering over the chart in Drive View displays a tool tip that provides this
information:
◆

Drive

◆

Start time
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◆

End time

◆

Throughput value

Chart axis selection
Document mode can display more than one chart in the document. Any or all available Y axes
can be inserted into the report. When a user changes to document mode, prints or exports a
report, or saves a configuration, the axis selection currently set in the Chart Selector section of
the Configuration tab is used.
The exceptions to this are stacked bar and pie charts, which display all axes when the
gstclreport command is used to generate a report.

Restricting report views
When a NetWorker Console user is added or reconfigured, the user’s views of NetWorker
servers, groups, and clients within the enterprise determines the content of reports that he or
she can produce.
Since each user can have different access restrictions, the view of each report can potentially
be different. This applies to all report types, whether customized, private, or shared.
For example, a shared backup summary report entitled “Building C Backups” will show
different data for different users if the users’ access permissions include different NetWorker
servers. This is so even if the reports are run at the same time.
In the Reports function, report parameters for a specific user display only the allowed
NetWorker servers, groups, and clients as sources of report information. The resulting reports
contain data only from those servers. A user may only run reports for servers he or she is
allowed to manage.
Note: If no data is available for a given server, that server will not appear in any lists, regardless of the
user’s view or access.

Background processing of reports
When the View Report tab is selected, the report data is removed from the server. This
process happens in the background and could take awhile. Other portions of the interface are
usable while the report data is being processed. The requested report appears upon returning
to the View tab.
Note: Do not request multiple reports at the same time. Since reports are run sequentially in the
background, a user can navigate around in the user interface while a report is running. If a new report is
started before an earlier report is finished, then the earlier report is terminated and deleted. A report is
either complete or deleted, the results are never partial.

Preconfigured reports
To facilitate the dissemination of information, NetWorker software includes a variety of
reports:
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◆

“NetWorker backup statistics reports” on page 367

◆

“NetWorker backup status reports” on page 368

◆

“NetWorker clone reports” on page 370

◆

“NetWorker recovery reports” on page 372
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◆

“Data Domain statistics reports” on page 374

◆

“Avamar Statistics reports” on page 374

◆

“Event reports” on page 376

◆

“Host reports” on page 378

◆

“User reports” on page 378

◆

“Device reports” on page 378

◆

“Cloud backup and recover reports” on page 379

◆

“Inactive files report” on page 380

NetWorker backup statistics reports
The different types of reports included within the NetWorker Backup Statistics report
category provide backup statistics for each selected NetWorker server within the enterprise.
NetWorker Backup Statistics reports may include this information:
◆

Amount of data backed up.

◆

Number of files backed up.

◆

Number of save sets backed up.

Types of NetWorker backup statistics reports and configuration
The NetWorker Backup Statistics report category includes basic and drill-down reports.
The Configure tab allows you to limit the scope of the report that was selected.
The parameters available within the NetWorker Backup Statistics report category are
described in Table 60 on page 367. The specific parameters available depend on which
NetWorker Backup Statistics report is selected.
Table 60

NetWorker backup statistics parameters

Parameter

Description

Options

Server Name

Selects managed hosts within the enterprise.

Selected server names

Group Name

Selects one or more groups.

Selected group names

Client Name

Selects one or more clients.

Selected client names

Save Set Name

Selects one or more save sets.

Selected save set names

Backup Type

Selects one or more file types.

List of supported file types

Level

Select one or more backup levels.

List of backup levels such as, Full,
Incremental, Skip, or Level 1-9

Save Time

Limits the report to a specified time range. The
default range is one day for save set details reports.

Save time (range)

Note: The date/time format available depends on
the language locale of the operating system.

The parameters available for each report type in the NetWorker Backup Statistics report
category are listed in the user interface.
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Save set data retention policy and configuration
Settings for the save set retention policy impact the data that is available to the
NetWorker Backup Statistics reports. If a save set retention policy of 6 months is
specified, NetWorker software cannot query the database for a time range that
extends back more than 6 months. The report cannot display data that has expired
because that data has been removed from the database. Thus, even if a save time
parameter of one year is specified, the report can display only six months of data if
the limit of the save set retention policy is six months.
Backup statistics basic reports
Within the NetWorker Backup Statistics report category, choose any of the basic
reports listed in the user interface. Once a report is chosen, the Configuration tab
displays boxes with lists of the selected parameters for that report. To exclude
unwanted parameters from the report, delete them from the list. “How to configure a
report” on page 358 provides information on selecting and removing parameters .
Except for the Avamar Backup Summary report, these basic reports do not
distinguish between regular and deduplication clients.
Backup statistics drill-down reports
The drill-down reports consist of multiple NetWorker Backup Statistics basic reports,
connected in a predetermined sequence. “Drill-down reports” on page 357 provides
general information about drill-down reports.
The configuration parameters for a drill-down report are the same as the parameters
for the top-level report in the report sequence. Thus, if the top layer of the drill-down
report is a Monthly Summary report, the configuration parameters are the same as
they would be for the basic report, Monthly Summary.
When a report is chosen, the Configuration tab displays boxes that list the selected
parameters for the top-level report. To exclude unwanted parameters from the
report, delete them from the list. “How to configure a report” on page 358 provides
information on selecting and removing parameters.

NetWorker backup status reports
The NetWorker Backup Status reports consolidate information about the success of
scheduled group backups. As with the NetWorker Backup Statistics reports, these
reports can provide either an enterprise-wide or a more focused summary of activity
over a specified time range.
The NetWorker Backup Status reports provide the same basic function as selecting
Show Details for a group in the Monitoring window of the Administration window.
The NetWorker Backup Status reports, however, allow you to select the scope and
level of detail.
Note: The report calculates the amount of time taken by each backup group individually.
Consequently, if several groups run in parallel, their total combined backup time is greater
than the time elapsed between the start of the first group and the completion of the last group.
For example:
- Group A starts at 13:00 and completes at 15:00.
- Group B starts at 13:30 and completes at 15:30.
- Although the groups both completed within a 2.5-hour period, the total group runtime is
counted as 4 hours.
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NetWorker Backup Status reports can include this information:
◆

Total group runs

◆

Totals of successful, failed, and interrupted group runs

◆

Success ratio

◆

Backup duration

◆

Backup level

◆

Backup type

◆

Save type

These backup status reports cover both regular and deduplication clients.
Backup type and save type information
Backup type is one of the configuration parameters for both NetWorker Backup
Statistics and NetWorker Backup Status reports, and it is one of the fields of
information included in these reports. The backup type indicates whether the files
backed up were regular files, bootstrap files, indexes, or a particular database file.
Specialized NetWorker modules (such the Module for Oracle and Module for SAP)
are used to back up the various databases. Most of these modules apply a distinct
prefix when backing up a save set. This prefix enables NetWorker software to
identify the backup type and include it in the reports.
A couple of the Backup Status reports (Save Set Details and Save Set Details by
Client) include an additional field of information called save type. The save type can
be any one of the following:
◆

Bootstrap

◆

Index

◆

Save

◆

Save (backup command)

Types of NetWorker backup status reports and configuration
The NetWorker Backup Status Report category includes both basic and drill-down
reports. The report’s Configure tab allows you to limit the scope of the report
selected. The choice of available parameters depends on which report is to be
generated.
The parameter options available within the NetWorker Backup Status Report
category are described in Table 61 on page 369.
Table 61

NetWorker backup status parameters (1 of 2)

Parameter

Description

Options

Server Name

Selects one or more NetWorker servers.

Selected server names

Group Name

Selects one or more savegroups.

Selected group names

Group Start Time

Limits the report to a specified time range. The default
range is one day for save set details reports.

Start and end dates

Client Name

Selects one or more clients.

Selected client names

Save Set Name

Selects one or more save sets.

Selected save set names
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Table 61

NetWorker backup status parameters (2 of 2)

Parameter

Description

Options

Backup Type

Selects one or more file types.

List of supported file types.

Level

Selects one or more backup levels.

• Full
• Incremental
• Skip
• Level 1-9
(Partial list of options)

Status

Selects status.

• Successful
• Failed
• Interrupted

The parameters available for each report type are listed in the user interface.
Completion data retention and NetWorker backup status
The settings for the completion data policy impact the data that is available to the
NetWorker Backup Status reports. The report cannot display data that has expired,
because it has been removed from the database.
Thus, even if a one-year time range is specified for the Group Start Time parameter,
the report displays only six months if the limit of the completion data policy is six
months.
Backup status basic reports
Within the NetWorker Backup Status report category, choose any of the basic reports
listed in the user interface. When a report has been chosen, the Configuration tab
displays boxes listing the selected parameters for that report. To exclude unwanted
parameters from the report, remove them from the list. “How to configure a report”
on page 358 provides information on selecting and removing parameters.
Backup status drill-down reports
The drill-down reports are comprised of multiple NetWorker Backup Status basic
reports, connected in a predetermined sequence. “Drill-down reports” on page 357
provides general information about drill-down reports. When a report has been
chosen, the Configuration tab displays boxes with lists of the selected parameters for
the top-level report. Thus, if the top layer of the drill-down report is a Daily Summary
report, the configuration parameters are the same as they would be for the basic
report, Daily Summary.
To exclude unwanted parameters from the report, remove them from the list. “How
to configure a report” on page 358 provides information on selecting and removing
parameters.

NetWorker clone reports
The Clone reports, available from the Reports task pane in the Console window,
allow you to view the history of automatic and scheduled clone operations that have
been performed by NetWorker servers for any server version 7.6 Service Pack 2 and
later.
Four different types of clone reports can be generated:
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◆

Server Summary

◆

Clone Details
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◆

Save Set Details

◆

Clone Summary Over Time

Be aware that clone reports may not be up-to-date because clone records are gathered
by the console server every 12 hours.
Types of NetWorker clone reports and configuration
The NetWorker clone report category includes basic and drill-down reports for each
selected NetWorker server within the enterprise. The Configuration tab allows you to
limit the scope of the report that was selected.
The parameters available for clone reports are described in Table 62 on page 371. The
specific parameters available depend on which clone report is selected.
Table 62

Clone report parameters

Parameter

Description

Options

NetWorker Server

Select one or more NetWorker servers.

Selected server names

Client Name

Name of the NetWorker client whose save sets were
cloned.

Selected client names

Clone Name

Name of the scheduled clone resource used for
cloning.

Selected clone resource

Save Set

Cloned saveset name.

Selected save set names

Level

Backup level of the clone.

• Full
• Incremental
• Skip
• Level 1-9
(Partial list of options)

Status

Final completion status of the clone.

• Successful
• Failed
• No save sets found

Type

Type of clone operation.

• Scheduled
• Manual

Start / End Time

Limits the report to a specified time range. The
default range is one day for save set details reports.

Start time of clone
End time of clone

Note: The date/time format available depends on
the language locale of the operating system.

Clone basic reports
Within the Clone report category, choose any of the basic reports listed in the user
interface. Once a report is chosen, the Configuration tab displays boxes with lists of
the selected parameters for that report. To exclude unwanted parameters from the
report, remove them from the list. “How to configure a report” on page 358 provides
information on selecting and removing parameters.
Clone drill-down reports
The Clone Summary over Time drill-down report consists of the basic clone reports,
connected in a predetermined sequence. “Drill-down reports” on page 357 provides
general information about drill-down reports.
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The configuration parameters for the drill-down report are the same as the
parameters for the Server Summary basic clone report.
To generate the Clone Summary Over Time report, first specify the same parameters
as those in the Server Summary clone report, which will be the first report displayed
in the sequence.
To drill down to the clone detail level, perform one of the following, depending on
your viewing mode:
◆

When in Table mode, double-click on any individual row referencing the desired
NetWorker server.

◆

When in Chart mode, click anywhere in the chart area of the desired NetWorker
server.

The Clone Details report for the selected NetWorker server appears. Return to the
Server Summary report to select another server to explore.
To drill down to the Save Set Details level, perform one of the following, depending
on your viewing mode:
◆

When in Table mode, double-click on any individual row referencing the desired
clone resource name.

◆

When in Chart mode, click anywhere in the chart area of the desired clone
resource name.

The Save Set Details report for the selected clone resource appears. Return to the
Clone Details report to select another client to explore.

NetWorker recovery reports
The Recovery reports, available from the Reports task pane in the Console window,
allow you to view the history of recovery operations that have been performed by
NetWorker servers for any server version 7.3 and later. Additionally, NMC checks for
new recovery operations and stores the recover statistics in the Console database
every 12 hours and every time a scheduled savegroup backup completes.
Note: Since NMC gathers reporting data from pre-7.6 servers, and allows for recovery jobs for
pre-7.6 clients, there may be missing fields in the recover statistics for these jobs. However,
NMC still populates the Console database with information about those jobs and generates the
reports, leaving any missing fields empty.

Reports can be viewed in both Chart and Table modes, with the Table mode set as the
default mode. Four different types of recover reports can be generated:
◆

Server Summary

◆

Client Summary

◆

Recover Details

◆

Recover Summary Over Time

Be aware that recovery reports may not be up-to-date because recover job history is
gathered by the console server every 12 hours and on completion of every scheduled
backup.
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Types of NetWorker recovery reports and configuration
The NetWorker recovery report category includes basic and drill-down reports. The
different types of reports included within the NetWorker Recover Statistics report
category provide recover statistics for each selected NetWorker server within the
enterprise.
The Configuration tab allows you to limit the scope of the report that was selected.
The parameters available within the NetWorker Recovery report category are
described in Table 63 on page 373. The specific parameters available depend on
which NetWorker Recovery Statistics report is selected.
Table 63

NetWorker recovery statistics parameters

Parameter

Description

Options

NetWorker Server

Managed hosts within the enterprise.

Selected server names

Source Client Name

One or more clients whose data is being recovered.

Selected client names

Target Client

The client where the data is being recovered to.

Selected target client names

Initiating Client

The client that initiated the recover.

User

Name of the user who initiated the recover.

Size

The size of the recover

Number of files

For file system recoveries, the number of files in the
recover.

Start time/End time

Limits the report to a specified time range.

Selected usernames

Start time of recover
End time of recover

Note: The date/time format available depends on
the language locale of the operating system.
Completion Status

Final status of the recover

• Successful
• Failed

The parameters available for each report type in the NetWorker Recovery Statistics
report category are listed in the user interface.
Recovery Statistics basic reports
Within the NetWorker Recovery Statistics report category, choose any of the basic
reports listed in the user interface. Once a report is chosen, the Configuration tab
displays boxes with lists of the selected parameters for that report. To exclude
unwanted parameters from the report, delete them from the list. “How to configure a
report” on page 358 provides information on selecting and removing parameters.
Recovery Statistics drill-down report
This drill-down report consists of multiple NetWorker Recovery Statistics basic
reports, connected in a predetermined sequence. “Drill-down reports” on page 357
provides general information about drill-down reports.
The configuration parameters for a drill-down report are the same as the parameters
for the top-level report in the report sequence. Thus, if the top layer of the drill-down
report is a Server Summary report, the configuration parameters are the same as they
would be for the basic report, Server Summary.
When a report is chosen, the Configuration tab displays boxes that list the selected
parameters for the top-level report.
Preconfigured reports
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To exclude unwanted parameters from the report, delete them from the list. “How to
configure a report” on page 358 provides information on selecting and removing
parameters.
Recover Summary Over Time
Recover Summary Over Time is a drill-down report sequence that allows you to
explore the history of recover jobs that were performed by NetWorker servers over a
period of time.
To generate the Recover Summary Over Time report, you must first specify the same
parameters as those in the Server Summary report, which will be the first report
displayed in the sequence.
To drill down to the client level, perform one of the following, depending on your
viewing mode:
◆

When in Table mode, double-click on any individual row referencing the desired
NetWorker server

◆

When in Chart mode, click anywhere in the chart area of the desired NetWorker
server.

The Client Summary report for the selected NetWorker server appears. Return to the
Server Summary report to select another server to explore.
To drill down to the Recover Details level, perform one of the following, depending
on your viewing mode:
◆

When in Table mode, double-click on any individual row referencing the desired
NetWorker client

◆

When in Chart mode, click anywhere in the chart area of the desired NetWorker
client

The Recover Details report for the selected NetWorker client appears. Return to the
Client Summary report to select another client to explore.
Recovery data retention policy and configuration
The retention policy for the recover statistics used to generate these reports can be set
with the other retention policies currently defined from the Data Retention page in
the Reports task pane. The default retention policy for these statistics is 1 year.

Data Domain statistics reports
The Data Domain reports, available from the Reports task pane in the Console
window, provide Data Domain deduplication backup statistics for each selected
NetWorker client.
Information on Data Domain reports is provided in the EMC NetWorker Data Domain
Deduplication Devices Integration Guide.

Avamar Statistics reports
The NetWorker Avamar Statistics reports, available from the Reports task pane in the
Console window, provide deduplication backup statistics for each selected
NetWorker client.
Reports can be viewed in Table mode. There are four different types of reports that
can be generated from the deduplication statistics:
◆
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◆

Save Set Summary

◆

Save Set Details

◆

Backup Summary

Types of Avamar Statistics reports and configuration
The Avamar Statistics report category includes basic and drill-down reports.
The Configure tab allows you to limit the scope of the report that was selected.
The parameters available within the NetWorker Deduplication Statistics report
category are described in Table 64 on page 375. The specific parameters available
depend on which NetWorker Deduplication Statistics report is selected.
Table 64

Avamar Statistics parameters

Parameter

Description

Options

Server Name

Selects one or more servers

Selected server names

Client Name

Selects one or more clients.

Selected client names

Group Name

Selects one or more groups

Selected group names

Save Set Name

Selects one or more save sets.

Selected save set names

Save Time

Limits the report to a specified time range. The
default range is one day for save set details reports.

save time (range)

Note: The date/time format available depends on
the language locale of the operating system.
Backup Level

Select one or more backup levels.

• Full
• Incremental
• Skip
• Level 1-9
(Partial list of options)

The parameters available for each report type in the Avamar Statistics report category
are listed in the user interface.
Avamar Statistics basic reports
Within the Avamar Statistics report category, choose any of the basic reports listed in
the user interface. Once a report is chosen, the Configure tab displays boxes with lists
of the selected parameters for that report. To exclude unwanted parameters from the
report, delete them from the list. “How to configure a report” on page 358 provides
information on selecting and removing parameters.
Avamar Statistics drill-down reports
The drill-down report, Backup Summary, consists of multiple NetWorker
deduplication Statistics basic reports, connected in a predetermined sequence.
“Drill-down reports” on page 357 provides general information about drill-down
reports.
The configuration parameters for the drill-down report are the same as the
parameters for the top-level report in the report sequence. Thus, if the top layer of the
drill-down report is a Client Deduplication Summary report, the configuration
parameters are the same as they would be for the basic report, Client Deduplication.
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When a report is chosen, the Configure tab displays boxes that list the selected
parameters for the top-level report. To exclude unwanted parameters from the
report, delete them from the list. “How to configure a report” on page 358 provides
information on selecting and removing parameters.

Event reports
These reports provide summary information about current events on NetWorker,
Avamar, and Console servers within the Enterprise. Additional details about a
particular event can be displayed, including annotation contents. While the Events
window within the NetWorker Console displays the current events of the NetWorker
servers (and Avamar server system events), the Event reports provide additional
features. The reports enable you to organize, export, and print the event data.
The NetWorker Avamar Integration Guide provides information on Avamar.
Event reports can include this information:
◆

Number of events

◆

Priority of events

◆

Category of events

◆

Server name

◆

Server type

◆

Event time

◆

Notes and annotations

Note: When an event has been resolved, it does not remain in the records.

Types of event reports and configuration
The Events report category includes both basic and drill-down reports.
The report’s Configure tab allows you to limit the scope of the report.
The Event parameters are described in Table 65 on page 377. The specific parameters
available depend on which Event report is being configured.
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Note: Data retention policies do not have any impact on Event reports.
Table 65

Event parameters

Configuration
parameter

Description

Options

Server Name

Selects one or more managed hosts.

Selected server names

Server Type

Selects some or all server types in the enterprise.
Only the names of servers that have current events are shown.

Console
NetWorker
Avamar

Priority

Selects only priority events.
Priority represents the relative severity of the event. Table 70 on
page 390 provides descriptions of the priorities.

Warning
Waiting
Notice
Info
Emergency
Critical
Alert

Category

Selects only category events, or all categories.
Category refers to the source of the event.

Database Backup
Registration
Savegroup

Event Time

Selects a time range.
This parameter applies only to the Annotation Details report.

Event time (range)

Event basic reports
Within the Events report category, select any of the basic reports listed in the user
interface. When a report has been chosen, the Configuration tab displays boxes listing
the selected parameters for that report.
To exclude unwanted parameters from the report, remove them from the list. “How
to configure a report” on page 358 provides information about selecting and
removing parameters.
Additional information
These resources provide more information about the contents of Event reports:
◆

“Working with notes” on page 390 provides information on NetWorker Console
notes.

◆

The EMC NetWorker Error Message Guide provides descriptions of NetWorker
software error messages and troubleshooting procedures.

◆

Chapter 27, “Troubleshooting” provides information on troubleshooting
NetWorker software issues.

Event drill-down reports
The drill-down reports consist of multiple Event basic reports, connected in a
predetermined sequence. “Drill-down reports” on page 357 provides general
information about drill-down reports.
The configuration parameters for a drill-down report are the same as the parameters
for the top-level report in the report sequence. Thus, if the top layer of the drill-down
report is a Server Summary report, the configuration parameters are the same as they
would be for the basic report, Server Summary. When a report has been chosen, the
Configuration tab displays boxes listing the selected parameters for the top-level
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report. To exclude unwanted parameters from the report, remove them from the list.
“How to configure a report” on page 358 provides information on selecting and
removing parameters.

Host reports
The Hosts report category includes only basic reports. There are two basic reports, as
described in Table 66 on page 378.
Table 66

Host reports
Configuration
parameters

Default

Provides an overview of servers in the enterprise, including:
• Whether the Capture Events feature is enabled for the
server.
• Whether the Gather Report Data feature is enabled for the
server.
• Where the server is located in the enterprise path.

None

All servers

Allows movement through the Enterprise. Limit the report’s
scope by first viewing one of the lower-level folders within the
Enterprise:
• Start from Enterprise folder.
• Start from selected folder.

Enterprise Path

Start from
Enterprise folder

Report name

Purpose

Host List

Enterprise
Inventory

“Enterprise” on page 426 provides a description of the Enterprise and its folders.

User reports
The Users report category provides information on NetWorker Console user activity.
Chapter 16, “Console Server Management” provides information about NetWorker
Console users and creating user accounts.
The Users report category includes only basic reports, no drill-down reports. The Full
Name and Description information appears in the User reports only if this
information was specified when the user was created.

Device reports
Device reports provide information about the way devices are being used. They show
scheduled and manual backup activity on one or more selected devices over time.
You can identify periods of heavy activity or inactivity. Device reports aid
NetWorker administrators in performance tuning, and they help identify bottlenecks.
For example, if all drives are being used continuously for a long period of time, at
maximum throughput, backup speeds may improve by adding tape drives or
moving clients to another backup server.
Types of Device reports and configuration
The Devices report category includes only one report, the Drive Utilization report.
This report, which is a drill-down report, supports NetWorker servers running
NetWorker software release 7.3 or later. The report includes backup activity data for
all device types, including advanced file type devices and digital data storage
devices.
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When viewing a Drive Utilization report as a chart, it is automatically displayed as a
Gantt chart, where the backup activity level of one or more devices is depicted in
relation to time. Unlike with other reports, you cannot choose an alternate chart type.
Placing the cursor over the chart in Save Set view displays a tool tip that provides this
information:
◆

Save set name

◆

Start time

◆

End time

◆

Client name

◆

Throughput value

Placing the cursor over the chart in Drive View displays a tool tip that provides this
information:
◆

Drive

◆

Start time

◆

End time

◆

Throughput value

Note: One of the activities included in the Drive Utilization report is throughput. Since the
Drive Utilization Report provides data for backup activities only, throughput values will
normally be non-zero. However, zero (0) is considered a valid throughput value.

Cloud backup and recover reports
Cloud backup and recover reports display information on the Cloud usage for
scheduled backups and recovers that are performed by the NetWorker server to and
from the Cloud storage device.
Types of Cloud backup and recover reports and configuration
The Cloud backup and recover reports category includes basic and drill-down
reports. “Drill-down reports” on page 357 provides general information about
drill-down reports.
The Configure tab allows you to limit the scope of the report that was selected. The
parameters available within the Cloud backup and recover report are described in
Table 67 on page 379. The specific parameters available depends on which Cloud
backup and recover report is selected.
Table 67

Cloud backup and recover parameters
Parameter

Description

Options

Server Name

Selects managed hosts within the
enterprise.

Selected server names

Start Time

Limits the report to a specified time
range. The default range is one day for
the Backup Details report.

start time (range)

Note: The date/time format available
depends on the language locale of the
operating system.
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Table 67

Cloud backup and recover parameters
Parameter

Description

Options

Device Name

Selects the devices used for backup
and recover.

Selected device names

Cloud backup and recover reports
Within the Cloud backup and recover report category, choose any of the basic reports
listed in the user interface. Once a report is chosen, the Configuration tab displays
boxes with lists of the selected parameters for that report. To exclude unwanted
parameters from the report, delete them from the list. “How to configure a report” on
page 358 provides information on selecting and removing parameters.
Cloud backup and recover reports can include this information:
◆

NetWorker server — Name of the server.

◆

Device name — Name of the device used for backup or recover.

◆

Device type — Type of the Cloud storage device, for example, Atmos.

◆

Login Account — Cloud username used for logging in.

◆

Size — Backup or Recover size.

◆

Compression ratio — Ratio of the bytes of information written to or read from the
Cloud to the total size of the backup or recover.

◆

Bytes transferred — Total number of bytes written to or read from the Cloud.

◆

Start time — Start time for the backup or recover.

◆

End time — End time for the backup or recover.

◆

Save Set Name — Displayed only for backup.

◆

User name — Name of the user who initiated the recover. Displayed only for
recover.

◆

Client name — Displays the name of the client that was backed up. In case of
recover, source client name is displayed.

◆

Status — Displays the status of backup or recover. For example: succeeded, failed,
and so on.

The Device Backup Summary and Device Recover Summary reports can be viewed in
both Chart and Table modes. The other reports can be viewed in Table mode.
“Interactive and document mode chart types” on page 363 provides general
information on charts.

Inactive files report
A NetWorker administrator can manage inactive files on a client or group and set the
NetWorker software to automatically generate a list of inactive files in an
environment. Inactive files are files that have not been accessed or modified other
than being backed up regularly. The period of time a file has been inactive is called
the Inactivity Threshold.
The inactivity files report is not supported on releases earlier than release 7.4 of the
NetWorker servers.
Client support for this feature will be enabled only on Windows platforms.
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The Inactive files report is a drill-down report that lists the inactive files from the
latest scheduled backup. The report operates at both the client and group level.
The inactive files report can do the following:
◆

Generate a report on the percentage of inactive files backed up as part of a group.

◆

Set the threshold time periods per group so that the percentage of inactive files in
that group does not exceed the threshold time period.

◆

Set alerts so that the NetWorker software sends an alert when the threshold set
for a group is exceeded.

◆

Provide a report that details the percentage of inactive files backed up as part of a
group.

◆

Report the percentage of inactive files per client.

The range limit specification given to configure File Inactivity Threshold and File
Inactivity alert threshold attributes can be configured within the following ranges:

Group File Details

◆

File Inactivity Threshold attribute can be set between 0-365 days.

◆

File Inactivity Alert Threshold attribute can be set between 0-99.

The Group file Details report provides statistical information about inactive files that
are included in a scheduled backup. Data will be provided for every requested
NetWorker group at the time of the last backup. Chart mode is the default mode for
the report. The data can also be viewed in tabular mode for more detailed
information.
When generating the Group Details report, you can specify the following parameters:

Client File Details

◆

One or more NetWorker servers. Only servers that have the Gather Reporting
Data attribute turned on will appear in the selection list.

◆

One or more NetWorker groups for the selected NetWorker servers.

The Client File Details report provides information about inactive files backed up for
selected NetWorker clients. Data will be provided for every requested NetWorker
client at the time of the last backup. Chart mode is the default mode for the report.
The data can also be viewed in tabular mode for more detailed information.
When generating the Client File Details report, you can specify the following
parameters:
◆

One or more NetWorker servers. Only servers that have the Gather Reporting
Data attribute turned on will appear in the selection list.

◆

One or more NetWorker groups for the selected NetWorker servers.

◆

One or more NetWorker clients for the selected NetWorker servers.

Customizing and saving reports
A customized report is a changed copy of a canned report. Canned reports can be
changed and then saved under different names. You can preserve the report
configuration parameters that are most useful for the enterprise.
A customized report can be rerun exactly the same way at a later time, and even by
another user. This saves time if the same report information must be generated
repeatedly.

Customizing and saving reports
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Customized reports offer these additional options:
◆

Delete

◆

Rename

◆

Save

◆

Save As...

◆

Share

Since it is a copy, a customized report can be changed again and resaved, or even deleted.
Reports can be saved either to preserve particular configurations (such as which servers are
polled) or to save the view type (such as pie or bar chart).
Note: For NetWorker reporting purposes, the terms customized report and saved report are basically
synonymous.

Customized reports appear alphabetically in the report hierarchy below the canned report
from which they were created. They are stored in the Console database, which means that
users can access them from wherever they are logged in to the NetWorker Console. This also
makes them accessible by the command line reporting feature. “Command line reporting” on
page 385 provides more information about command line reporting.
These types of information are stored in customized reports:
◆

All options from the report’s Configure tab

◆

Column display preferences for tables

◆

Orientation (portrait or landscape)

◆

Current view type (table or chart)

If the view type is Chart, then the current chart type (bar, pie, plot, or stacked bar) is also
saved. For charts, the current chart axis selection is also saved. “Chart axis selection” on
page 366 provides more information about chart axis selection.

Naming reports
When naming a report to save, keep in mind that the set of usable characters is limited in the
same way as for hostnames and usernames. Report names may not contain:
◆

Characters having an ASCII representation number less than ASCII 32 (such as carriage
return, bell, newline, escape)

◆

Comma (,)

◆

Slash (/) or backslash (\)

◆

Double quote (“) or single quote (’)

Note: Report names are not case-sensitive. Also, canned reports cannot be deleted or customized, and
then saved under the same name as a report that already exists under the same parent folder or
directory.
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Saved file ownership and deleted users
When a user saves a report by using the Save As command, that user becomes the
owner of the new report. When a Console Application Administrator deletes from
the system a user who owns reports, then the Console Application Administrator
sees a dialog box that shows all of the reports owned by that user, and can choose
either to delete the reports or reset the owner to a different user.

Sharing reports
By default, customized reports are stored as private for each user. This means that if a
user saves a report, it appears only in that user’s report hierarchy. A report’s owner
or the Console Application Administrator may, however, enable it for sharing.
Only the original owner of a customized report or the Console Application
Administrator may select:
◆

Delete, to delete the report.

◆

Rename, to rename the report.

◆

Save, to resave the report.

◆

Share, to add sharing to, or remove sharing from, the report.

◆

If the Console Application Administrator removes sharing, the report becomes
private again to the original owner, the report’s creator.

Any user viewing a sharable report may perform these operations on the report:
◆

Change any runtime parameter of the report (such as configuration or view type).

◆

Run the report, but not save changes to the report.

◆

Copy the report by using the Save As command.

◆

Chose the Hide Other Users’ Reports option to toggle the view of reports
between only those owned by the user (both private and shared) and all shared
custom reports.

If a user copies a sharable report with the Save As command, that user becomes the
owner of the new report, which is initially set as not shared.

Sharing a report
To enable sharing of a customized report:
1. From the Console window, click Reports.
2. Expand the report folder that contains the customized report to share.
3. Right-click the customized report, then select Share. The report is now shared,
and is represented in the report hierarchy by a shared-report icon
or
.
Once a report has been enabled for sharing, all users can see it in the report hierarchy.
Note: The Share option is a toggle. To disable sharing, right-click the shared report and select
Share.

Sharing reports
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Exporting reports
Reports can be converted into other file formats and shared with others. Table 68 on
page 384 lists the file formats available when exporting reports.
Table 68

Report export formats

Format

Purpose

PostScript

For printing.
Shows data totals.

PDF

For printing or viewing with a PDF viewer such as Adobe Acrobat.
Shows data totals.

HTML

For viewing in a browser.
Shows data totals.

CSV

For importing into other programs (such as spreadsheets) that accept the comma separated values
(CSV) format.
Does not show data totals.
Note: For raw data only.

Exporting a report
You can choose to export a report as a file in a different format (for example, HTML,
PDF, CSV, or PostScript). To export a report to a different file format:
1. From the Console window, click Reports.
2. Expand the report folder that contains the report to export, then click the report.
3. Click the View Report tab to display the report.
4. Right-click the View Report tab, select Export, then select a format.
Note: To sort or rearrange table columns in a report, export the report to CSV format. The
columns then can be sorted or rearranged in a spreadsheet program.

5. In the Save dialog box, specify the filename and file location and then click Save.

Exporting non-ASCII characters
Due to a limitation in the embedded reporting tool, reports that contain multibyte
characters cannot be exported to PostScript or PDF formats. Such characters are
replaced by a “?” character.
To obtain a printed version of such a report, print directly from the Console window,
or export to HTML format.
Note: ISO8859-1 characters can be exported to PostScript or PDF formats.
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Command line reporting
Command line reporting offers these features:
◆

Allows reports to be run offline, either as needed or by using scheduling software
that makes reports available at predetermined times.

◆

Makes use of both canned and customized reports, which can be exported in
various formats.

◆

Provides a more advanced feature that requires a fair amount of knowledge
about running and scripting from the command prompt of the Console server.
This feature should be reserved for advanced users.

Note: Command line reports may only be printed or run to generate exported output. They
cannot be saved or shared. Drill-down reports cannot be run from the command line.

The command line reporting program
The command line reporting program is gstclreport. It uses the JRE to run.
Additionally, command line reports must be run on the NMC Console server host.
The options are typical command line options in the form of a hyphen (-) followed by
one or two letters and an argument, if applicable. The EMC NetWorker Command
Reference Guide or the UNIX man pages provide a complete description of the
command and its options.
System performance
Each time the gstclreport command is run, it starts a separate JVM, which can use
many system resources. The gstclreport command runs a database query and
generates report output by using the results. Since this uses both CPU and memory
resources on the host computer, it could affect performance of NetWorker software
and of the host. Consequently, depending on the system used, it is probably not wise
to run more than a few instances of the gstclreport command at the same time.
Security
The gstclreport command must contact the Console server in order to run a report.
The command requires a valid username and password. A user either uses the -P
option to type the password, or the command checks standard input to see whether
the password is there. If a password is not supplied, the program prompts for a
password.
On UNIX systems, use of the -P option is a security concern, because a user may type
the ps command and see the commands that were used to start any program that is
running.
To solve this problem, use scheduling software that can conceal password input.
Alternatively, ensure that the scheduling system sends the password as standard
input. For example:
echo password | gstclreport

A cron command can be used to schedule the report, or the command could be
placed in a secure script file that is invoked by the cron command.

Command line reporting
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Java runtime environment
Support of command line reporting requires JRE version 1.6 or later to run the
gstclreport command. The JRE must be installed before installing NetWorker
software.
Additionally, you must add an environment variable named JAVA_HOME to your
NetWorker server host. Open either the gstclreport.bat or gstclreport.sh file and
follow the instructions at the top of the file to set up the correct environment for
command line reporting.

Printing reports
All reports can be printed. This allows for the sharing of report data with users who
are unable to view it online.
To print a report:
1. From the Console window, click Reports.
2. Expand the report folder that contains the report to print, then click the report.
3. Click the View Report tab to display the report.
4. Right-click anywhere on the View Report tab, then select Print.
5. From the Print dialog box, select the appropriate options on each tab, then click
Print.
The -x print option in the gstclreport command is also available.
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This chapter covers these topics:
◆
◆
◆

Overview of events and monitoring ........................................................................ 388
Events............................................................................................................................ 388
Monitoring window.................................................................................................... 392
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Overview of events and monitoring
The NetWorker Management Console (NMC) provides the ability to view details of
current NetWorker, Avamar, and Data Domain systems. Information that can be
monitored includes activities and operations related to devices and libraries, and
events that require user intervention. NMC makes the administration of servers more
efficient by providing a centralized means of monitoring activity throughout an
enterprise. “Managing various servers in the enterprise” on page 428 provides details
on adding hosts to be monitored.

Events
An event signals that user intervention is required. For example, if a NetWorker
server needs a new tape, the server alerts users to the situation by posting an event to
the Console window.
NetWorker software generates an event based on various factors, including the
following scenarios:
◆

The software or hardware encounters an error that requires user intervention to
resolve.

◆

A NetWorker savegroup has failed.

◆

Drive ordering or serial number mismatch issues — a description of the problem
is provided, along with a corrective action to fix the problem.

◆

Capacity monitoring — for example, reaching the space threshold on the
deduplication node.

◆

NetWorker software is unable to poll a host it is monitoring for events or for
generating reports.

◆

A license or enabler code managed by the License Manager is about to expire.

Some situations do not result in the generation of an event. For example, when a
license managed by the NetWorker Console (instead of by the License Manager)
approaches its expiration date. In this situation, a message is recorded in the
NetWorker logs, but an event is not generated until the expired license causes a
backup to fail. Check the Administration window from time to time for important
messages.

Polling for System Events
From the System Options dialog box, you can set the poll interval for events and
activities generated at system-level for the following:
◆

Events and reporting (in seconds)

◆

NetWorker activities (in seconds)

◆

Data Domain events (in seconds)

◆

NetWorker libraries (in hours)

◆

Avamar events (in hours)
Note: Event polling for NetWorker libraries and Avamar events can only be done to a
maximum of once per hour. “Console system options” on page 416 provides information
on setting polling intervals.
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Enabling or disabling the Capture Events option
The Capture Events option must be enabled for a given server before NetWorker
software can monitor that server for events. This option is selected by default when a
host is added.
To disable or reenable the Capture Events option:
1. From the Console window, click Enterprise.
2. Select the host for which the capturing of events is to be disabled or enabled.
3. Right-click the appropriate application, then select Properties.
4. Complete one of these steps as required:
• To enable captured events, select Features > Capture Events.
• To disable captured events, select Features, clear the Capture Events
checkbox.
For Avamar servers, the Capture Events option monitors only system-level
events. The Avamar documentation provides other event information.
5. If the host is a Data Domain system, select the Configure SNMP Monitoring tab.
a. Enter public in the SNMP community string field.
b. Enter the value of the SNMP process port. The default port is 162.
c. Select the SNMP Traps (Data Domain system events) to be monitored by
NetWorker.
6. Click OK.

Viewing events
To view events, from the Console window, click Events. If any events exist, they are
displayed in the Console window.
The Console window includes columns that provide specific types of information
about each event. Table 69 on page 389 describes the various columns and the
information they provide for NetWorker events.
Table 69

Events columns (1 of 2)

Column

Description

Priority

Represents the relative severity of the problem by displaying one of seven icons. Table 70 on page 390
describes each priority.

Server Name

Identifies the host that caused the event to be generated.

Server Type

Identifies the type of server to which the event belongs. Server types include but are not limited to
NetWorker, Avamar, and Data Domain.

Time

Indicates the day of the week and time that the Console server discovered the problem. The time which an
event is reported is always based on the time zone of the Console server. For example: If a savegroup fails
at 11:00 A.M. in New York, a Console server in Los Angeles reports the event for the savegroup as
occurring at 8:00 A.M.
Note: The time format presented depends on the current locale setting. “Date and time formats” on
page 358 provides more information.

Category

Classifies the source of the problem.

Events
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Table 69

Events columns (2 of 2)

Column

Description

Message

Displays the text of the error message that generated the event.

Annotation

Displays an icon when an annotation has been made. An annotation is a log associated with an event.
“Working with annotations” on page 391 provides more information.

Note

Provides an editable field for making brief notes associated with an event. “Working with notes” on
page 390 provides more information.

Event priorities
Each event is designated one of seven possible priorities. Table 70 on page 390 lists
the event priorities and the information they provide. When the Console window
sorts events by priority, it lists the events in alphabetical order, with Emergency
between Critical and Information.
Table 70

Event priorities

Icon

Priority

Description

Alert

Error condition detected by the NetWorker server that should be fixed by a qualified
operator.

Critical

Severe error condition that demands immediate attention.

Emergency

Condition exists that may cause NetWorker software to fail unless corrected immediately.
This icon represents the highest priority.

Information

Information about the current state of the server. This icon represents the lowest priority.

Notification

Important information.

Waiting

Indication that the NetWorker server is waiting for an operator to perform a routine task,
such as mounting a tape.

Warning

Non-fatal error has occurred.

Working with notes
The Note column of the Console window provides a place to record brief
administrative information about an event. For example, you can enter:
◆

Name of the NetWorker administrator or operator assigned to the event.

◆

Letters or numbers that allow the sorting of events into a preferred order.

A note can contain up to 30 characters, and can be edited or deleted.
Adding a note
To add a note for an event:
1. From the Console window, click Events.
2. Double-click the cell of the Note column corresponding to the appropriate event,
then type the text of the note in the cell.
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3. After entering the text, click outside the cell.
Editing a note
To edit a note for an event:
1. From the Console window, click Events.
2. Double-click the note to edit, then change the text as appropriate.
3. After editing the note, click outside the cell.
Deleting a note
To delete a note from an event:
1. From the Console window, click Events.
2. Double-click the note, highlight the text in the cell, then press Delete.
3. After deleting the note, click outside the cell.

Working with annotations
The Annotation column provides a place to record comments associated with an
event, and can accommodate more information than the Note column. Each
annotation can be up to 12 KB in size. For example, use annotations to log steps taken
to resolve an event.
When an annotation has been added to an event, an icon appears in the Annotation
column of the Events window. Multiple annotations can be added to a single event,
and unlike notes, they cannot be edited or deleted.
Viewing annotations
To view an annotation:
1. From the Console window, click Events.
2. Right-click the event with the annotation to be viewed, then select Annotation.
Annotations are listed in descending order, with the most recently added
annotation at the top of the list.
3. After viewing the annotation, click Cancel to close the dialog box.
Adding an annotation
To add an annotation:
1. From the Console window, click Events.
2. Right-click the event to be annotated, then select Annotation. The Event
Annotation dialog box appears.
3. Type the text of the annotation.
4. To clear the text just entered, click Reset.
5. Click OK.
Dismissing an event
After an event has been viewed and acted on, it can be dismissed from the Console
window. This helps prevent other users from acting unnecessarily on events that
have already been resolved.

Events
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Note: Dismissing an event makes it disappear from the Console window for all NetWorker
users.

To dismiss an event:
1. From the Console window, click Events.
2. Right-click the event to dismiss, then select Dismiss.
3. Click Yes to confirm the dismissal.
There are slight differences in how event dismissals are handled, depending on the
source:
◆

Events from NetWorker software are automatically dismissed in the Console
window when the problem that triggered the event is resolved.

◆

Events from device ordering or serial mismatch issues are automatically
dismissed in the Console window when the problem is resolved via the
corrective action provided.

◆

System events from an Avamar server (deduplication node) are not automatically
dismissed in the Console window when the problem that triggered the event is
solved. These events must be manually dismissed in the Console window.

Monitoring window
Open the Monitoring window from the Administration window taskbar to view
details of current NetWorker server activities and status, such as:
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◆

Running of automatic and manual savegroups

◆

Archiving, cloning, recovering, and browsing of client file indexes

◆

Alerts and log messages, and operations related to devices and jukeboxes
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While the Monitoring window is used primarily to monitor NetWorker server
activities, it can also be used to perform certain operations. These operations include
starting, stopping, or restarting a group backup, as well as, starting and monitoring
save set clones.

Viewing the Monitoring window
To view the full Monitoring window:
1. From the Console window, click Enterprise.
2. Highlight the host’s Managed Application, then right-click and select Launch
Application...
The Administration window appears.
3. From the Administration window, click Monitoring. The Monitoring window
includes a docking panel that displays specific types of information.
4. Select the types of information you want to view from the docking panel.
A portion of the Monitoring window, known as the task monitoring area, is always
visible across all windows . A splitter separates the task monitoring area from the rest
of the window. You can click and move the splitter to resize the task monitoring area.
The arrow icon in the top-right corner of the Monitoring window allows you to select
which tasks you want to appear in this view.

Monitoring window
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Smaller windows appear within the Monitoring window for each window listed in
Table 71. Each smaller window, once undocked, is a floating window and can be
moved around the page to customize your view. You can select multiple types from
the panel to create multiple floating windows that can be viewed at the same time.
Table 71 describes the various types of information available in the docking panel
and the details each one provides.
Table 71

Monitoring window panel

Window

Information provided

Groups

Lists all groups related to the server, the backup status, the time the last backup was run, the duration of
the backup, the completion percentage, and the next time the backup will run.

Clones

Lists all scheduled clone jobs with the last start time, the last end time, and additional details on the
included save sets.

Sessions

Allows you to customize whether to display all session types, or only certain session types. The
information provided depends on which session type you select. For example, if you select Save
Sessions, the window lists clients, save sets, groups, backup level, backup start time, duration of the
backup, devices, rate, and size.

Alerts

Lists the priority, category, time, and message of any alerts.

Devices

Lists devices, device status, storage nodes, libraries, volumes, pools, and related messages.

Operations

Lists the status of all library and silo operations, including nsrjb operations run from the command
prompt. Also lists user input, libraries, origin, operation data, operation start time, duration of the
operation, progress messages, and error messages.
The Operations window will display library data only for servers running NetWorker software release 7.3
or later.
Note: When displaying Show Details from the Operations window, the length of time that the window is
displayed is controlled by the value entered in the Operation Lifespan attribute on the Timers tab of the
Properties dialog box for the corresponding library. To access library properties, click Devices in the
taskbar.

Log

Lists messages generated by the NetWorker server, including the priority of each message, the time the
message was generated, the source of the message, and the category.

Archive Requests

Lists the status of all Archive Requests configured on the server, including the last time the data was
archived, the date and time of the next scheduled archive, and any annotations.

Groups window
The Groups window displays groups that are in the process of completing, or have
completed, their backup. You can use this window to identify which groups backed
up successfully and which groups failed, and also to start, stop, or restart group
backups.
The backup of a client group may fail for one of the following reasons:
◆

The NetWorker server failed.

◆

The NetWorker client failed.

◆

The network connection failed.

To find out more about a backup failure, check Group Backup details. “Viewing
group backup details” on page 396 provides more information.
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Groups window backup status
The backup status is represented by an icon. Table 72 on page 395 lists and describes
each of the icons.
Table 72

Groups window icons

Icon

Label

Description

Being cloned

The group backup is being cloned.

Failed

The group backup failed.

Interrupted

The group backup was interrupted.

Never ran

The group backup never ran.

Running

The group backup is running.

Successful

The group backup successfully completed.

Probing

The group is in a probing state.

When items on the Groups window are sorted by the Status column, they are sorted
in alphabetical order based on the label of the icon.
When a group is in probing state, a message is sent when the group starts and
finishes probing, and the results of the probing (run backup/do not run backup) are
also logged. Probes do not affect the final status of the group, and the group status
does not indicate the results of the probe. If probing indicates that a backup should
not run, then the group status reverts back to its state prior to the group running.
IMPORTANT
Be sure to check the results of the probe in the log window to ensure that the
probes indicated the backup be taken.
Groups backup operations
This section describes how to use the Monitoring window to start, stop, and restart
group backups.
Starting a group immediately
You can override the scheduled backup start time and start the group manually. This
is equivalent to selecting Start Now in the Autostart attribute of the Group resource.
Note: When a group backup is started manually, the NetWorker server runs the backup at the
level of the next scheduled backup, such as full, levels 1 through 9, incremental, or
consolidated.

To manually start a group backup:
1. From the Administration window, click Monitoring.
2. Click Groups in the docking panel.
3. Right-click the group to start, then select Start.
4. Click Yes to confirm the start.
Monitoring window
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The NetWorker server immediately backs up the clients in the group.
Stopping a group
To stop a group backup:
1. From the Administration window, click Monitoring.
2. Click Groups in the docking panel.
3. Right-click the group to stop, then select Stop.
4. Click Yes to confirm the stop.
Restarting groups
To restart a group backup:
1. From the Administration window, click Monitoring.
2. Click Groups in the docking panel.
3. Right-click the group to restart, then select Restart Group.
4. Click Yes to confirm the restart.
The backup continues from the point at which it was stopped.
Viewing group backup details
To view detailed information about a group backup:
1. From the Administration window, click Monitoring.
2. Click Groups in the docking panel.
3. Right-click the group to view, then select Show Details. The Group Backup
Details dialog box appears.
4. View detailed information related to the group backups. If any messages were
generated, the Show Messages button is enabled. Click Show Messages to view
the messages.
5. Click OK to close the Group Backup Details dialog box.

Clones window
The Clones window displays the scheduled clone jobs and their completion status.
This window also identifies which client save sets were cloned successfully and
which save sets were not cloned successfully. You can also use this window to start a
scheduled clone job immediately.
Scheduled clone operations
This section describes how to use the Monitoring window to start a scheduled clone
operation and how to view the clone details for a client’s save set.
Starting a scheduled clone immediately
You can start a scheduled clone job at any time instead of waiting for the scheduled
start time.
To start a scheduled clone job immediately:
1. From the Administration window, click Monitoring.
2. Click Clones in the docking panel.
3. Right-click the scheduled clone to start, then select Start.
4. Click Yes to confirm the start.
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The NetWorker server immediately starts the scheduled clone job.
Viewing the save sets for a scheduled clone
You can view the NetWorker clients and their save sets that are included in a
schedule clone job. You can also determine which save sets were cloned successfully
and which ones were not.
To view the clients and save sets for a scheduled clone job:
1. From the Administration window, click Monitoring.
2. Click Clones in the docking panel.
3. Right-click the scheduled clone to view, then select Show Details. The Clone
Details dialog box appears.
4. Click OK to close the Clone Details dialog box.

Sessions window
Use the Sessions window to view the sessions that are running on a NetWorker
server. You can change the view of this window to display these sessions:
◆

Save

◆

Recover

◆

Clone

◆

Browse

◆

All

The default setting for the Sessions window is to display Save sessions. “Changing
displayed session types” on page 397 provides instructions on viewing other session
types.
Changing displayed session types
To change the type of sessions displayed on the Sessions window:
1. From the Administration window, click Monitoring.
2. Click Sessions in the docking panel.
3. Go to View > Show and select the type of sessions to display. To display all
sessions currently running on the NetWorker Server, regardless of type, select All
Sessions.
The column headings displayed on this window will differ depending on the type of
sessions you chose to display.
Note: The ability to change the type of session being displayed is available only for

NetWorker release 7.3 and higher.

Alerts window
The Alerts window displays alerts generated by a particular NetWorker server or
Data Domain system that has devices configured on the NetWorker server. It
includes priority, category, time, and message information.

Monitoring window
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The alert priority is represented by an icon. Table 73 on page 398 lists and describes
each of the icons.
Table 73

Icon

Alerts window icons
Label

Description

Alert

Error condition detected by the NetWorker server that should be fixed by a qualified
operator.

Critical

Severe error condition that demands immediate attention.

Emergency

Condition exists that could cause NetWorker software to fail unless corrected immediately.
This icon represents the highest priority.

Information

Information about the current state of the server. This icon represents the lowest priority.

Notification

Important information.

Waiting

The NetWorker server is waiting for an operator to perform a task, such as mounting a tape.

Warning

Non-fatal error has occurred.

When items on the Alerts window are sorted by the Priority column, they are sorted
in alphabetical order based on the label of the icon.

Devices window
The Devices window allows you to monitor the status of all devices, including
NDMP devices. If the NetWorker server uses shared and logical devices, the window
is adjusted dynamically to present a set of columns appropriate for the current
configuration.
If the current server configuration includes a shared device, a Shared Device Name
column appears on the Devices window. The name of the shared device appears in
the Shared Device Name column. If other devices for that configuration are not
shared devices, then the Shared Device Name column is blank for those devices.
Additionally, since only a single device per hardware ID can be active at any given
moment, the information for inactive shared devices is filtered out, so only one
device per hardware ID is presented on the window at any time.
If the current server uses an AlphaStor library, then a Logical Name column is added
to the Devices window to accommodate logical devices.
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The device status is represented by an icon. Table 74 on page 399 lists and describes
each of the icons.
Table 74

Devices window icons

Icon

Label

Description

Library device
active

The library device is active.

Library device
disabled

The library device is disabled.

Library device
idle

The library device is idle.

Stand-alone
device active

The stand-alone device is active.

Stand-alone
device disabled

The stand-alone device is disabled.

Stand-alone
device idle

The stand-alone device is idle.

When items on the Devices window are sorted by the Status column, they are sorted
in alphabetical order based on the label of the icon.

Operations window
The Operations window displays information about device operations. It includes
this information:
◆

Status of the operation.

◆

Name of the library.

◆

Whether or not the operation requires user input.
For example, a labeling operation may want the user to acknowledge whether the
system should overwrite the label on a tape. “Supply user input” on page 400
provides instructions on how to deal with a user input notification.

◆

The origin, or source, of the operation.
For example, the interface, nsrjb or the NetWorker server.

◆

Time the operation started.

◆

Type of operation.

◆

Duration of the operation.

◆

Status messages from the operation.

◆

Any error messages.

Note: Only the last error message of the operation will appear in the Error Messages column.
Move the mouse pointer over the cell containing the last error message to display the entire list
of error messages.

Monitoring window
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The operation status is represented by an icon. Table 75 on page 400 lists and
describes each of the icons.
Table 75

Icon

Operations window icons
Label

Description

Failed

The operation failed.

Queued

The operation is waiting in the queue to run.

Retry

The operation failed, but may work if you try again.

Running

The operation is running.

Successful

The operation completed successfully.

User Input

The operation requires user input.

When items on the Operations window are sorted by the Status column, they are
sorted in alphabetical order based on the label of the icon.
View operation details
To view detailed information about an operation:
1. From the Administration window, click Monitoring.
2. Click Operations in the docking panel.
3. Right-click the appropriate operation, then select Show Details.
The Operation Details dialog box opens, providing information about the
completion of the operation. The Completion Time displays the time the operation
finished. The time it took to complete the operation is the difference between the
completion and start times of the operation.
To save operation details to a file, click Save in the Operation Details dialog box.
When prompted, identify a name and location for the file.
Stop an operation
Certain operations can be stopped from the Operations window. To stop an
operation:
1. From the Administration window, click Monitoring.
2. Click Operations in the docking panel.
3. Right-click the operation to stop, then select Stop.
4. Click Yes to confirm the stop.
Note: Operations that were started from a command line program such as the nsrjb command,
cannot be stopped from the Operations window. To stop these operations, press Ctrl-c from
the window where the command was started.

Supply user input
If the system requires user input, select the labeling operation in slow/verbose mode
and the Supply User Input icon appears.
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To supply input:
1. Right-click the operation, then select Supply Input.
2. Confirm whether or not to supply input.
• If Yes, and input is supplied, the icon in the User Input column disappears.
If two users attempt to respond to the same user input prompt, the input of
the first user will take precedence, and the second user will receive an error
message.
• If No, and input is not supplied, the operation will time out and fail.

Log window
To view the most recent notification logs, click the Log window from the docking
panel in the Monitoring window. The Log window provides the priority, time,
source, category, and message for each log.
Note: If a particular log file is no longer available, check the log file on the NetWorker server.
The log files are located in this directory: <NetWorker_install_path>\logs. “Viewing log files”
on page 661 provides information about viewing log files.

The log priority is represented by an icon. Table 76 on page 401 lists and describes
each of the icons.
Table 76

Log window icons

Icon

Label

Description

Alert

Error condition detected by the NetWorker server that should be fixed by a qualified
operator.

Critical

Severe error condition that demands immediate attention.

Emergency

Condition exists that could cause NetWorker software to fail unless corrected immediately.
This icon represents the highest priority.

Information

Information about the current state of the server. This icon represents the lowest priority.

Notification

Important information.

Waiting

The NetWorker server is waiting for an operator to perform a task, such as mounting a tape.

Warning

Non-fatal error has occurred.

When items on the Log window are sorted by the Priority column, they are sorted in
alphabetical order based on the label of the icon.

Archive Requests window
The Archive Requests window displays the current status of all archive requests that
are scheduled on the NetWorker server. Use this window to identify which archive
requests are running, completed, or failed, as well as when they were last run, and
when they are scheduled to run next.
Monitoring window
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The archive status is represented by an icon. Table 77 on page 402 lists and describes
each of the icons.
Table 77

Archive requests window icons

Icon

Label

Description

Disabled

The scheduled archive is disabled.

Failed

The archive failed.

Running

The archive is running.

Scheduled

The archive is scheduled to run.

Successful

The archive completed successfully.

When items on the Archive Requests window are sorted by the Status column, they
are sorted in alphabetical order based on the label of the icon.
Viewing details of an archive operation
From the Monitoring window, you can view the details of an archive request,
including the start time, the most recent completion time, and other information such
as the pool and clone pool to which the archive request will write its data.
To view details of an archive operation:
1. From the Administration window, click Monitoring.
2. Click Archive Requests in the docking panel.
3. Right-click the appropriate archive request, then select Show Details.
The Archive Request Details dialog box opens, providing information about the
completion of the archive request. The Completion Time displays the time the
archive finished. The time it took to complete the archive is the difference between
the completion and start times of the archive.
To save archive request information to a file, click Save in the Archive Request
Details dialog box. When prompted, identify a name and location for the file.
Archive request operations
Use the Monitoring window to perform a number of archive request operations, such
as canceling manual clone jobs, or starting, stopping, restarting, and disabling archive
requests. The Monitoring window can also be used to schedule archive requests to
start at a specific time in the future. These operations are equivalent to changing the
Status attribute of the Archive Request resource, described in “Scheduling data
archives” on page 209.
Starting an archive immediately
You can start an archive immediately from within the Monitoring window. This will
override and disable any scheduled archive for the selected archive request.
To start an archive immediately from the Monitoring window:
1. From the Administration window, click Monitoring.
2. Click Archive Request in the docking panel.
3. Right-click the appropriate archive request, then select Start.
402

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Events and Monitoring

4. Click Yes to confirm the start.
Stopping an archive in progress
To stop an archive in progress:
1. From the Administration window, click Monitoring.
2. Click Archive Request in the docking panel.
3. Right-click the appropriate archive request, then select Stop.
4. Click Yes to confirm the stop.
Scheduling an archive to start automatically
You can also use the Monitoring window to schedule an archive to start
automatically at a later time.
To schedule an archive to start automatically at a later time:
1. From the Administration window, click Monitoring.
2. Click Archive Request in the docking panel.
3. Right-click the appropriate archive request and select Schedule Archive.
4. In the Schedule Archive Request dialog box, type the time that the archive
should start, by using the hh:mm format.
5. Click OK. The Next Run column on the Archive Requests window displays the
entered time.
Disabling a scheduled archive
If an archive request has a scheduled start time, you can disable the scheduled
archiving.
To disable a scheduled archive:
1. From the Administration window, click Monitoring.
2. Click Archive Requests in the docking panel.
3. Right-click the appropriate archive request, then select Disable Archive.
4. Click Yes to confirm the disable.

Monitoring window
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Managing NetWorker Console server users
The NetWorker Console (Console) server restricts user privileges based on the three
roles described in Table 78 on page 406. These roles cannot be deleted and their
privileges cannot be changed.
Table 78

Console roles
User Role

Privileges

Console Security
Administrator

•
•
•
•

Add, delete, and edit users
Configure login authentication
Control user access to managed applications such as a NetWorker server
All tasks available to a Console User role

Console Application
Administrator

•
•
•
•
•
•
•

Configure Console system options
Set retention policies for reports
View custom reports
Specify the NetWorker server to backup the Console database
Specify a NetWorker License Manager server
Run the Console Configuration wizard
All tasks available to a Console User role

Console User

All tasks except for those tasks explicitly mentioned for the Console Security
Administrator and the Console Application Administrator.

When Console is first opened, the default administrator user is assigned to all three
Console user roles.

Login authentication for Console users
Console server supports two types of login authentication:
◆

Native Console authentication

◆

External authentication to an LDAP v3 compliant server

Native Console authentication is enabled by default and requires that user names
and passwords be maintained on the Console server. No additional set up is required
to enable native Console login authentication.
LDAP authentication enables you to log in to the Console server with user names and
passwords that are maintained on a centralized LDAP v3 compliant server such as a
Microsoft Active Directory server. Console user privileges are controlled by mapping
LDAP user roles or LDAP user names to Console user roles. There is no need to add
user names and passwords on the Console server. However, one must still add LDAP
user names to user groups on the NetWorker server to enable privileges on the
NetWorker server.
Note: You must use either native Console authentication or LDAP authentication. To
switch from one mode to the other, use the Configure Logon Authentication wizard.
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Configuring login authentication
To enable LDAP authentication:
1. Log in to the Console server as a user, such as the default administrator, who
belongs to the Console Security Administrator role.
2. On each NetWorker server, add an external LDAP user to the NetWorker server
Administrator's user group. This step ensures that once LDAP is enabled, at least
one user will be able manage the NetWorker server and to add additional
NetWorker users as required.
The LDAP user that you add should also belong to the LDAP user roles or LDAP
user names that you specify later in step 7.
a. Click the Enterprise button on the taskbar.
b. Highlight a host in the navigation tree, right-click NetWorker, and select
Launch Application. The Administration window appears.
c. Click the Configuration button on the taskbar.
d. In the navigation tree, select User Groups.
e. In the User Groups list, right-click Administrators and select Properties.
f. Add the LDAP user to the User attribute. Use the following format to add the
user:
User=LDAP_username, host=console_host

where console_host is the name of the Console server host.
g. Click OK.
3. From the Console Setup menu, select Configure Login Authentication to launch
the Configure Login Authentication wizard.
The Select Authentication Method panel appears.
4. Select the External Repository radio button and click Next. The Manage
Authentication Authorities panel appears.
5. Click Add and then provide information about your authentication authority in
the remaining fields. For help on a field, click the question mark (?) at the bottom
left side of the wizard panel.
6. Click Next when finished. The Setup Console Security Administrator panel
appears.
7. Enter the LDAP user roles or LDAP user names that will be mapped to the
Console Security Administrator role and click Finish.
Note: The LDAP user that was added to the NetWorker Server Administrator’s list in step
2 must also be added to the Console Security Administrator role.

You can now log in to the Console server using an LDAP user name and
password that was mapped in this step.
Note: In LDAP mode, the user name Administrator is not allowed to log in even if it is defined
in LDAP.
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Post LDAP set up requirements
After LDAP authentication is enabled, perform the following tasks:
◆

Map additional LDAP user roles to Console user roles. “Adding Console users
and assigning to Console roles” on page 408 provides more information.

◆

Optionally, restrict access from the Console server to managed servers.
“Restricting a Console user’s view of managed servers” on page 409 provides
more information.

◆

Add LDAP user names to NetWorker server user groups. This task enables users
to perform operations on the NetWorker server. “Granting Console users
privileges on a NetWorker server” on page 410 provides more information.

Adding Console users and assigning to Console roles
This section describes how to add Console users and assign those users to Console
roles. These procedures differ depending on whether native NetWorker login
authentication or external LDAP login authentication is being used.
By default, Console users can view all managed NetWorker servers. However,
Console users must still be granted explicit privileges on a NetWorker server.
“Granting Console users privileges on a NetWorker server” on page 410 describes
how to manage access to NetWorker servers.
Adding Console users when using native authentication
To add Console users when using native login authentication:
1. Log in to the Console server as a Console Security Administrator.
2. From the Console window, click Setup.
3. In the left pane, right-click Users, then select New. The Create User dialog box
appears, with the General tab displayed.
4. Enter a username.
• Do not exceed 20 characters.
• Do not use spaces, or any of these characters:: < > /
• Do not use characters with an ASCII value less than or equal to 32.
• Do not begin a username with an underscore (_) character.
5. (Optional) Enter the full name of the user and a user description.
6. Select the Console user roles to be given to the user. Table 78 on page 406
provides more information about Console user roles.
7. Enter the user password.
Note: Passwords must be at least eight characters long and cannot be the same as the user
name. This requirement is enforced for all newly created or edited users. For customers
upgrading from a previous release, this requirement will be enforced when user
passwords are changed.

8. Reenter the password in the Confirm Password attribute and the click OK.
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Adding Console users when using LDAP authentication
When an LDAP user logs in for the first time, a user object is automatically created on
the Console server. You need only map LDAP user roles or LDAP user names to
Console user roles.
If necessary, you can also create user objects before users log in for the first time. For
example, you may want to restrict user access to managed servers before the user
logs in for the first time.
To add Console users when using LDAP authentication:
1. (Optional) Create the Console user manually:
a. Log in to the Console server as a Console Security Administrator.
b. From the Console window, click Setup.
c. In the left pane, right-click Users, then select New. The Create User dialog box
appears, with the Identity tab displayed.
d. In the User Name attribute, enter the LDAP user name.
e. Optionally, enter the full name of the LDAP user and a general description in
the remaining attributes.
f. Click OK.
2. Map LDAP users to Console roles.
a. In the left pane, select Roles.
b. In the right pane, right-click a Console user role and select Properties.
c. In the External Roles attribute, add each LDAP user role or LDAP user name
that is to be mapped. Add each entry on a separate line.
3. Click OK.

Restricting a Console user’s view of managed servers
You can restrict Console users from viewing NetWorker servers by setting the
permissions on the user object. “Implications of restricting a Console user’s view of
managed servers” on page 410 provides information about the implications of
restricting user views, see . “Restricting report views” on page 366 provides
information on how restricting views affects reporting.
To set permissions for a user to view servers:
1. Log in as Console Security Administrator.
2. From the Console window, click Setup.
3. In the left pane, click Users.
4. Right-click a username, then select Permissions. The Edit User dialog box
appears, with the Permissions tab displayed.
5. To grant permission for the user to view various hosts, use the arrow keys to
select the allowed hosts.
6. Click OK.
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Note: Console users can manage data only on the servers they are allowed to view. However,
to perform operations on the NetWorker server, Console users must also be granted explicit
privileges on the NetWorker server. “Granting Console users privileges on a NetWorker
server” on page 410 provides more information.

Implications of restricting a Console user’s view of managed servers
Users can manage data, such as report data, only on servers they are allowed to view.
However, even when they have permission to view a given server, the management
operations they can perform on it are determined by their privileges on that server.
“Granting Console users privileges on a NetWorker server” on page 410 provides
information on how these privileges are set.
The effects of restricting user views for various functions are as follows:
◆

In the Events window: The user sees only events from allowed NetWorker
servers.

◆

In the Enterprise window: The user sees all of the hierarchy folders, but only the
allowed NetWorker servers appear in those folders.

◆

In the Libraries window: The user sees only the devices controlled by allowed
NetWorker servers.

◆

In the Reports window: The user sees report data only from allowed NetWorker
servers.

◆

In the Setup window:
• The user sees properties for all users, and his or her own properties and
permissions.
• The user can edit his or her own properties, but not permissions. Only the
Console Security Administrator can edit user permissions, and see and edit
permissions.

Note: Because each user can view and manage different sets of NetWorker servers, the contents
of the reports can vary among users. For example, a shared backup summary report entitled
“Building C Backups” will show different data for different users (even if the report is run at
the same time) if the users’ permissions include different NetWorker servers. This applies to all
report types, whether canned or customized, private or shared.
If no data is available for a given server, that server will not appear in any lists or reports,
regardless of the user permissions.

“Restricting a Console user’s view of managed servers” on page 409 provides
information on how to restrict user views.

Granting Console users privileges on a NetWorker server
By default, each Console user must be granted explicit privileges on the NetWorker
servers that they will manage.
Note: If you do not need to control NetWorker server privileges by individual user, you can
disable this feature and give all users the same privileges that are granted to the Console server
by default. To do so, clear the User Authentication for NetWorker system attribute, which is
described in “Setting system options” on page 415.
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To grant Console users privileges on a NetWorker server:
1. Log in to the Console server as a user who belongs to the Administrator’s group
on the NetWorker server to which you are adding users.
• If you are using native Console authentication, the default Console
administrator user has administrator privileges on the NetWorker server.
• If you are using external LDAP authentication, the LDAP user that was added
in step 2 of the section titled, “Configuring login authentication” on page 407,
has administrator privileges on the NetWorker server.
2. Click the Enterprise button on the taskbar.
3. Highlight a host in the navigation tree, right-click NetWorker, and select Launch
Application. The Administration window appears.
4. Click the Configuration button on the taskbar.
5. In the navigation tree, select User Groups.
6. In the User Groups list, right-click a user group and select Properties.
7. Add users to the User attribute. Use the following format to add a user:
User=username, host=console_host

where console_host is the name of the Console server host.
Note: If LDAP authentication is enabled, the username entered in this step must be the
LDAP user name and not the LDAP user role.

8. Click OK.
Chapter 17, “NetWorker Server Management” provides more information about
NetWorker server use groups and their privileges.

Resetting user preferences
An option is available in the Users task of the Console to reset a user’s preferences to
the settings as they were when the user first logged in.
To reset a user’s preferences:
1. From the Console window, click Setup.
2. In the left pane, click Users.
3. Right-click a username, then select Reset User Preferences.
4. A dialog displays asking if you really want to remove all of their preferences
before performing the reset. Click Yes to reset the preferences.

Deleting a user
Once a user has been deleted, that user can no longer log in to the Console server.
Only the NetWorker administrator can delete other users.
To delete a user:
1. Log in as a Console Security Administrator.
2. From the Console window, click Setup.
3. In the left pane, click Users.
Managing NetWorker Console server users

411

Console Server Management

4. Right-click a username, then select Delete.
5. Click Yes to confirm the deletion.
• If the user had saved customized reports, a dialog box prompts for the
username to which to reassign those reports. Otherwise, the reports can be
deleted.
• If you are using LDAP authentication, you must also remove the user from the
LDAP user role, which is maintained on the LDAP server.

Editing user properties
To change a password or other descriptive information about a user, edit the user
properties. All users can edit their own properties. Only a NetWorker administrator,
however, can edit properties of other users.
To edit user properties:
1. From the Console window, click Setup.
2. In the left pane, click Users.
3. Right-click a username, then select Properties. The Edit User dialog box appears,
with the General tab displayed.
4. Change the user information as necessary. Other user information is displayed,
but is not editable, including last-login information.
Note: If you are using native Console authentication, you can also change the
administrator password by using the Console Configuration Wizard. “Accessing the
Console Configuration Wizard” on page 420 provides more information.

5. Click OK.

Resetting the administrator password (native authentication only)
If the default administrator password is lost or forgotten, it can be reset by using the
GST_RESET_PW environment variable.
Note: These steps apply only when native Console authentication is being used.

Microsoft Windows
To reset the native Console security administrator password on Windows:
1. From the Start menu, go to Control Panel > System and set the GST_RESET_PW
variable in the Environment Variables dialog box to a value of 1.
Note: How you navigate to the Environment Variables dialog box differs depending on
which Windows operating system you use. Consult the documentation that accompanies
your operating system for details.

2. Restart the GST Service. When the GST Service starts, the password resets.
3. Log in to the Console server and type administrator as the user name and type
administrator as the password.
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4. Return to the Environment Variables dialog box and delete the GST_RESET_PW
variable. This step prevents the password from being reset at each Console log in
attempt.
UNIX systems
To reset the native administrator password on a UNIX system:
1. Set GST_RESET_PW to a non-null value using the appropriate command for
your shell, for example, in ksh:
export GST_RESET_PW “non null value”

2. Stop and restart the Console server. Table 8 on page 50 provides details. This
should be done in the same shell where the password was set.
3. Log in to the Console server and type administrator as the user name and type
administrator as the password.
4. Set GST_RESET_PW back to null using the appropriate command for your shell,
for example, in ksh:
export GST_RESET_PW=

The next time the Console server is restarted, the password will not be reset again.

Moving the Console server
The Console server of NetWorker can be moved from one computer to another only if
both computers use the same operating system. Reasons to move the Console server
component include:
◆

The current computer has insufficient processing capabilities. For example, if
there is a need for more memory or a faster processor.

◆

The current computer has insufficient space for the Console database.

◆

The current computer was damaged beyond repair.

To move the Console server component to another computer:
1. Back up the existing Console database with the savepsm command. “Performing
a manual backup of the Console database” on page 80 provides more details.
2. Set up the new computer with the same operating system as the one that is
running the current software and is connected to the network.
3. On the new computer, install the NetWorker Client software and the NetWorker
Console server component.
• This step includes meeting the prerequisites for installing NetWorker
software. For example, the NetWorker client must already be installed. If
using NetWorker License Manager, the License Manager software must either
already be installed or be available on another host. For information, consult
the NetWorker Installation Guide.
• If you are using the License Manager and it is moved from one computer to
another, enter the new License Manager hostname in the Console window.
For information, refer to the EMC License Manager Installation and
Administration Guide.
4. On the remote NetWorker server, set up the new target computer as a Client
resource. “Task 6: Create a backup Client resource” on page 59 provides
information about creating a Client resource.

Moving the Console server
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5. For the Client resource of the source Console server, add the appropriate users to
the Remote Access attribute on the Globals (2 of 2) tab.
6. Stop the Console server service on the source Console server. Table 8 on page 50
provides more information.
7. Stop the Console server service on the target Console server.
8. Ensure the GST service is not running on the original backup host or on the host
being used for the directed recover. Use the appropriate command or tools for
your operating system to ensure the GST service is not running.
9. For UNIX systems, set the appropriate library path environment variable to the
following:
Console_install_dir/sybasa/lib64
Console_install_dir/sybasa/lib (Linux)
The environment variable to set varies by platform:
• Solaris/Linux: LD_LIBRARY_PATH
• AIX: LIBPATH
• HP-UX: SHLIB_PATH
Note: If the Console is not installed in the default /opt/LGTOnmc directory on Solaris,
add Console_install_dir/bin to the LD_LIBRARY_PATH environment variable.

10. On the NetWorker server, you must have:
• Client resources for the original backup host and the directed recover host.
• The directed recover host listed in the remote access field of the Client
resource for the original backup host.
11. Run the recoverpsm command on the new host using the -c option to identify the
original host. Also use the -O option to recover only the database and not the
gstd_db.conf credential file.
recoverpsm [-f][-d recover_ directory] -s NetWorker_server -c
original_Console_server -S gst_on_original_Console_server -0

Table 79 on page 415 provides a description of recoverpsm options. The EMC
NetWorker Command Reference Guide or the UNIX man pages provide a complete
description of the command and its options.
12. Use the recover program or the NetWorker User or nwrecover program to
recover the gstd_db.conf configuration file to the new location. This will maintain
your existing database login credentials.
For NetWorker 7.5 and higher, the gstd_db.conf file is located in the save set
named CONSOLE_BACKUP_FILES.
Note: : If you were using LDAP authentication for 7.6.1 and lower versions, you must
configure LDAP authorities again on the new Console server using the Configuration
Login Authentication wizard. For versions 7.6.2 and higher, you can recover your LDAP
authorities configuration from a previous 7.6.2 or higher backup of the Console database
and configuration files. To recover, use the NetWorker User or nwrecover program to
recover all the files under cst directory in the CONSOLE_BACKUP_FILES saveset. These
files should be recovered to the cst directory under your new Console server installation.
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13. If recover_directory is not the same as the Console database directory, copy the
database file and the gstd_db.conf file, to the directory where the Console
database resides.
14. Start the Console server service on the target Console server.
15. If you are using the License Manager and the License Manager host has changed,
obtain a Host Transfer Affidavit from EMC support.
The host ID that is used for the authorization code is that of the License Manager
computer. If the License Manager computer has not changed, then new authorization
codes are unnecessary.
Table 79

The recoverpsm options

Option

Meaning

-f

Instructs the software to overwrite existing Console database files.

-d recover_directory

Specifies the destination directory for the recovered Console database. Include a
full path for the directory. Partial paths are not supported.

-S gst_on_source_Console_server

Specifies the existing Console database on the source Console server. You must
prepend gst_on_ to the name of the source Console server.

-O

Omit the recovery of the database credential file.

-s NetWorker_server

Specifies the name of the NetWorker server where the Console database
backup resides.

-c source_Console_server

Specifies the short name of the source Console server, where the existing
Console database resides.

Setting system options
NetWorker Console includes several options that affect performance. These options
enable users to fine-tune the performance of the Console server. Only Console
application administrators can set or change system options.

Setting a system option
To set a system option:
1. From the Console window, click Setup.
2. From the Setup menu, select System Options. The System Options dialog box
appears.
3. Set a value, or enable or disable the appropriate system option.
4. Click OK.
IMPORTANT
Do not adjust these system options without careful consideration. A mistake in
setting system options or environment variables can seriously degrade
performance.

Setting system options
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Console gets two configuration options from the environment (GST_MAXLOGSIZE
and GST_MAXLOGVERS). Normally the default values are used; these environment
variables can be changed by advanced users. “Setting environment variables” on
page 419 for more information provides more information.
Table 80

Console system options (1 of 2)

System option

Purpose

Log on Banner

Specifies the text to display in the user log on screen.

Debug level

Set the level of debugging information written to the gstd log file. (Increasing this
value increases the number of operation and status messages that Console
records.)
• To increase the number of program messages written to gstd log file, choose
a larger value.
• To use less disk space, choose a smaller value
Range: 1 to 10.

Note: Alternatively, GST_DEBUG can be set as an environment
variable. This allows users to troubleshoot the Console if they cannot
access the Console window. The environment variable overrides the
system option version (Debug level). To avoid having it override the
system option indefinitely, unset the environment variable after use,
and set the system option for general use.
Polling interval for events and reporting (secs)

Set the minimum number of seconds that must pass before Console checks a
NetWorker server for events.
• To make Console more responsive to new events, decrease the value.
• To decrease the load on the CPU, increase the value.
Range: >= 2 Default: 20

Polling interval for NetWorker activities (secs)

Set the minimum number of seconds that must pass before Console checks a
NetWorker server for updates to the Administration windows.
• To make the Administration windows more responsive to changes on the
NetWorker server, decrease the value.
• To decrease the load on the CPU, increase the value.
Range: >= 2 Default: 10

Polling thread factor

Determine the number of programming threads that are used when polling
NetWorker servers.
• To make Console more responsive, increase the value.
• To decrease the load on the CPU, decrease the value.
Range: 1 – 10 Default: 5

Polling interval for NetWorker libraries (hours)

Set the minimum number of hours that must elapse before the Console checks a
NetWorker server for library information.
• To poll the NetWorker server for library information more frequently, decrease
the number of hours.
• To poll the NetWorker server for library information less frequently, increase
the number of hours.
Range: Greater than or equal to 1. Default: 12

Polling interval for Avamar events (hours)

Set the minimum number of hours that must elapse before the Console checks
for Avamar events. Avamar events can include:
• hfscheck — validation of the data stored on the Avamar server.
• Disk health/hardware — status of the disks on the Avamar server (limited to
“bad” or “failed” disk status).
• Replication events that occur on the Avamar server.
Avamar events can be polled at hourly intervals:
• To poll for Avamar events more frequently, decrease the number of hours.
• To poll for Avamar events less frequently, increase the number of hours.
Range: Greater than or equal to 1. Default: 12

Note: In order for Avamar events to appear in NMC, they must be set
to Acknowledge in the Events Management tab of the Avamar
Administrator program.

Maximum number of log messages
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Administration window.
Range: 1- 512 Default 32
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Table 80

Console system options (2 of 2)

System option

Purpose

NetWorker user auditing

Enable auditing of user Console requests.
• When enabled, this function logs all Console user requests to NetWorker
servers.
• When this function is disabled, Console user requests to NetWorker servers
are not logged.
Range: Not applicable Default: Disabled
Audit records are written to the Console database, and the results are viewable
in the Reports task of Console's main window. Chapter 14, page 14-351
provides for information about viewing reports.

User authentication for NetWorker

Set individual user authentication for functions a user can perform on a
NetWorker server.
Note: Requires restarting the Console server to take effect.
This option restricts user access to a given NetWorker server only if the user
groups on that server have been set up to do so. User groups can be created,
modified, or deleted from the Administration window.
• This option does not set restrictions on user views.
• When this function is disabled, all Console users who are allowed to access
a NetWorker server have the same privileges on that server.
• When this function is enabled, access privileges on Console servers can
vary among Console users.
Range: Not applicable Default: Enabled

RPC ping via UDP when connecting to a NetWorker
server

Enable the use of user datagram protocol (UDP) when NetWorker Console first
checks whether a NetWorker server is up and running. Set this option if the
firewall allows for UDP connections. Note that there is a significant trade-off in
performance.
Range: Applicable Default: Enabled

Individual User Authentication
Console security administrators can restrict or grant Console user access to NetWorker

servers based on the Console username if the User Authentication for NetWorker
system option has been enabled (with a subsequent restart of the Console server).
This system option is enabled by default.
Requests to NetWorker servers through the Administration window always come
from the Console server, regardless of any system option settings.
When the User Authentication for NetWorker system option is enabled, the requests
to NetWorker servers appear (from the NetWorker side) to be coming from users on
the Console server, rather than from the gstd process owner on the Console server.
When the system option is enabled, a NetWorker server allows requests only from
users who belong to the Administrators group of the NetWorker server. The
username of the Console daemon process owner must be included in the NetWorker
Administrators group on NetWorker servers to which Console users have access.
NetWorker administrators must also ensure that the usernames of Console users who
have permission to view and manage those servers are included in the NetWorker
server’s Administrators group. Table 81 provides examples. “Administrator
privileges” on page 440 provides detailed information about the Administrators
group.
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Note: The username of the root or system user on the Console server must be specified, regardless of whether
individual user authentication is used.
Table 81

Usernames for individual user authentication

On Console server

Operating system

Example of username to add to the NetWorker Administrators
group1

Root or system user on the
Console server–the
Console daemon process
owner (mandatory)

Microsoft Windows

system@winbox.petropep.com

UNIX

root@unixbox.petropep.com

NetWorker Administrator

Microsoft Windows

administrator@winbox.petropep.com

UNIX

administrator@unixbox.petropep.com

Microsoft Windows

user1@winbox.petropep.com

UNIX

user1@unixbox.petropep.com

User

1

Where winbox.petropep.com and unixbox.petropep.com are Console servers.

Chapter 17, “NetWorker Server Management,” describes how to include the user
names in the NetWorker Administrators group
Impact on network connections
More network connections might need to be available when individual user
authentication is enabled. This could have an impact on firewall considerations.
Appendix B, “Firewall Support” provides information about firewalls.
When the User Authentication for NetWorker system option is set, a separate
network connection is created from the Console server to a NetWorker server for
each Console user that has an Administration window open to that server. This
option is set by default.
When the user authentication for NetWorker system option is not set, there is only
one network connection from the Console server to a NetWorker server that is being
managed through NetWorker.
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Setting environment variables
Table 82 on page 419 describes the three environment variables available in this
NetWorker release. Variables are checked only when the Console server service
starts, which is similar to how the nsrd daemon handles its corresponding variables.
Note: Environment variable names are case-sensitive.
Table 82

Console environment variables

Purpose

Environment variable

Set the maximum size of the gstd log file before a new log file is
created at Console server startup time. If this variable is
undefined, the maximum size defaults to 1 MB.
• To preserve more log information, increase the value.
• To use less disk space, decrease the value.
“The gstd log” on page 702 provides more information about the
gstd log file.
Range: >= 1 Default: 1 MB

GST_MAXLOGSIZE

Set the maximum number of historical versions of the gstd log
file that Console retains. Older versions are deleted when the
number of versions exceeds this value.
• To preserve more log information, choose a larger value.
• To use less disk space, choose a smaller value.
“The gstd log” on page 702 provides more information about the
gstd log file.
Range: 1–999 Default: 4

GST_MAXLOGVERS

Set the level of debugging information written to the gstd log
file. Setting this value higher increases the number of operation
and status messages that Console records.
GST_DEBUG can also be set as a system option (Debug level).
• To increase the number of program messages written to
gstd.log, choose a larger value.
• To use less disk space, choose a smaller value.
Range: 1–20 Default: 0

GST_DEBUG
Note: This environment variable can be used to
troubleshoot the product in cases where the user interface
is not accessible. The environment variable overrides the
system option version (Debug level). To avoid having it
override the system option indefinitely, unset the
environment variable after use, and set the system option
for general use.

Setting environment variables on Solaris and Linux systems
To set environment variables on UNIX systems:
1. Open the gst file in a text editor. (This file is a Bourne shell script.) The file
location varies depending on the platform:
• Solaris and Linux: /etc/init.d/gst
• AIX: /etc/rc.gst
• HPUX: /sbin/init.d/gst
Note: By default, this is a read-only file. Check the file permissions and change them, if
necessary, before editing it.

Setting environment variables
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2. Add these lines to the beginning of the file:
variable_name=variable_value
export variable_name

where:
• variable_name is the name of the environment variable to be set.
• variable_value is the value to be assigned to the environment variable.
3. Save the changes.
4. Stop and restart the Console server. Table 8 on page 50 provides detailed
instructions.
The preceding example is for the Bourne shell. For other shells, refer to the
shell-specific documentation or man pages that describe how to set an
environment variable.

Setting environment variables on Windows systems
To set environment variables in Microsoft Windows:
1. View the system variables.
a. From the Start menu, select Settings>Control Panel>System.
b. Click the Advanced tab.
c. Click Environment Variables.
d. In the Environment Variables dialog box, below System Variables, click
New.
2. In the New System Variable dialog box, enter the variable name and value.
3. Click OK.

Accessing the Console Configuration Wizard
Note: Only Console Application Administrators can use the Console Configuration Wizard.

The following tasks can be performed from the Console menu options or from the
Console Configuration Wizard.
◆

Set the NetWorker Administrator password.

◆

Specify the NetWorker server that will back up the Console database.

◆

Add NetWorker servers to the enterprise.

To access the Console Configuration Wizard:
1. From the Console window, click Setup.
2. From the Setup menu, select Configuration Wizard.
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NetWorker Console server maintenance tasks
This section lists maintenance tasks associated with the NetWorker Console server.

Changing the service port used by the NetWorker Console database
By default, the NetWorker Console database uses port 2638 for TCP/IP
communications. Other applications may also use this port or, as is the case with
EMC AlphaStor or EMC DPA installed with default options, may have their own
instance of the iAnywhere database installed, which can create conflicts if both
applications are installed on the same host.
To resolve this problem, change the service port as follows:
1. Stop the GST Service. Table 8 on page 50 has information about stopping the GST
service.
2. Stop any other products that are using the iAnywhere database, for example,
EMC AlphaStor or EMC DPA.
3. Ensure that no dbsrv9 processes are running. If the dbsrv9 processes are running,
stop them.
4. Open a terminal or command prompt window.
5. Depending on the shell you are using, use the appropriate command (for
example. setenv for csh, export for sh) to update the library path environment
variable in the terminal window to the following location:
• Solaris: /opt/LGTOnmc/bin:/opt/LGTOnmc/sybasa/lib
• Linux/AIX/HPUX: /opt/lgtonmc/bin:/opt/lgtonmc/sybasa/lib
• Microsoft Windows (assumes default installation location):
C:\Program Files\Legato\Management\GST\sybase\bin
The environment variable to set varies by platform, for example:
• Solaris/Linux: LD_LIBRARY_PATH
• AIX: LIBPATH
• HP-UX: SHLIB_PATH
6. Edit the gstd.conf file to add or change the following line:
db_svc_port=port_number
For example:
db_svc_port=2639
The gstd.conf is located in the following locations:
• Solaris: /opt/LGTOnmc/etc
• Linux/AIX/HP-UX: /opt/lgtonmc/etc
• Microsoft Windows: C:\Program Files\Legato\Management\GST\etc
7. Run the gstconfig command to update the port value in the NetWorker Console.
The gstconfig command is located in the following locations:
• Solaris: /opt/LGTOnmc/bin
• Linux/AIX/HP-UX: /opt/lgtonmc/bin
• Windows: C:\Program Files\Legato\Management\GST\bin

NetWorker Console server maintenance tasks
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8. Close the terminal or command prompt window.
9. Restart the GST Service.

Changing database connection credentials
When the NetWorker Console server is started for the first time, it automatically
generates login credentials that it will use to log into the NetWorker Console
database. This information is stored internally by the NetWorker Console server and
the user does not need to know the required credentials. However, it may be
necessary to force the Console server to change the database connection credentials.
To force the server to change the credentials:
1. Stop the GST Service. Table 8 on page 50 has information about stopping the GST
service.
2. Set the environment variable GST_RESET_DBPWD to any value. On Microsoft
Windows system, this should be set as a System Variable and the system should
be rebooted after the variable is set.
3. Restart the GST Service.
4. Delete the GST_RESET_DBPWD environment variable. On Microsoft Windows
system, the system should be rebooted after the variable is set.

NMC server IP address/hostname updates
If the IP address/hostname of the NMC server is modified or protocols such as IPv6
are added or removed, perform the following:
1. Stop the GST Service. Table 8 on page 50 has information about stopping the GST
service.
2. Navigate to the NetWorker bin directory and run the platform-specific command:
• On Windows, go to C:\Program Files\Legato\Management\GST\bin, and
run gstconfig.
• On Solaris, as root:
LD_LIBRARY_PATH=/opt/LGTOnmc/bin:/opt/LGTOnmc/sybasa/lib
export LD_LIBRARY_PATH
./gstconfig
• On Linux, as root:
LD_LIBRARY_PATH=/opt/lgtonmc/bin:/opt/lgtonmc/sybasa/lib
export LD_LIBRARY_PATH
./gstconfig
• On AIX:
LIBPATH=/opt/lgtonmc/bin:/opt/lgtonmc/sybasa/lib
export LIBPATH
./gstconfig
• On HP-UX:
SHLIB_PATH=/opt/lgtonmc/bin:/opt/lgtonmc/sybasa/lib
export SHLIB_PATH
./gstconfig
3. Restart the GST service.
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Displaying international fonts in non-US locale environments
To use or view data from a localized NetWorker server, ensure that the appropriate
font is available to the Console server. The EMC Legato NetWorker Installation
Guide provides more information about displaying international fonts on a Console
server that is operating in English mode.

NetWorker License Manager
The NetWorker License Manager software provides centralized license management,
which enables you to maintain all of an enterprise’s NetWorker licenses from a single
computer.
With the NetWorker License Manager, you can move NetWorker software from one
computer to another, or change the IP address on an existing NetWorker server
without having to reauthorize the software. The NetWorker License Manager can be
installed as an option during the NetWorker software installation.
The latest NetWorker License Manager Installation and Administration Guide provides
more information on how to install and use the NetWorker License Manager.

Entering an enabler code
To enter an enabler code if you are using LLM:
1. From the Console window, click Setup.
2. Right-click Licensing, then select New. The Create dialog box appears.
3. In the Enabler Code attribute, type the enabler code and leave the other attributes
blank.
4. Click OK.

Deleting an enabler code
To delete an enabler code if you are using LLM:
1. From the Console window, click Setup and then click Licensing.
2. Right-click the license to delete, then select Delete.
3. Click Yes to confirm the deletion.

Entering an authorization code
To enter an authorization code if you are using LLM:
1. From the Console window, click Setup and then click Licensing.
2. Right-click the license to be authorized, then select Properties. The Properties
dialog box appears.
3. In the Auth Code attribute, enter the authorization code for the product (the
authorization code assigned to the specified permanent enabler or update enabler
code).
4. Click OK. The license is now permanently enabled.

Displaying international fonts in non-US locale environments
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Changing the License Manager server
The License Manager server that manages NetWorker Console licenses can be
changed at any time.
To change which host runs the License Manager:
1. Log in as a Console Application Administrator.
2. From the Console window, click Setup.
3. Right-click Licensing, then select Change LLM Server. The Change LLM Server
dialog box appears.
4. In the LLM Server attribute, type the hostname of the appropriate server and
click OK.
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Enterprise
The Enterprise is a visual representation of the NetWorker Console control zone.
Various servers in the enterprise such as NetWorker, Data Domain, and Avamar
servers can be monitored for events, and various reports can be generated on events,
backups, and user activity.

Enterprise components
The Enterprise includes these components:
◆

Hosts
A host, also known as a managed node, is the NetWorker, Data Domain, or Avamar
server being monitored. A host terminates a branch in the Enterprise.

◆

Folders
The purpose of folders is to enable the Enterprise to contain multiple levels. Each
folder can contain more folders, more hosts, or more of both.

Organizing NetWorker servers
Use the Enterprise to organize the NetWorker servers by some logical or functional
criteria. Examples of organizational criteria include:
◆

By geography, thus putting all the hosts from the same city or country in the same
folder. Example 32 on page 426 provides information.

◆

By function of the computers backed up by the NetWorker servers, such as
having the servers that back up web servers in one folder, and the servers that
back up mail servers in another.

◆

By administrative divisions within the Enterprise, such as having separate folders
for servers that back up Marketing, Sales, or Engineering computers.

Since there can be multiple copies of a host in the Enterprise, multiple folders can also
be created and maintained. With each folder based on different organizational
criteria, the organization can be viewed in different, yet parallel and complementary
ways.
Example 32 An enterprise arranged by geographic location

Figure 32 on page 427 shows an Enterprise arranged by geographic location. There
are three folders, one for each country where the NetWorker servers are located:
USA, France, and Australia. Each folder contains a number of hosts that correspond
to NetWorker servers named for the city where they are located. The Australia folder,
for instance, contains three host computers labeled perth1, perth2, and sydney.
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Viewing the enterprise
In the Console window, the organization of the NetWorker servers can be viewed in
much the same way as the contents of a file system can be viewed by using a file
manager program.
To view the Enterprise:
1. From the Console window, click Enterprise.
• The left pane displays folders and hosts in a tree-like arrangement to illustrate
the organization of the NetWorker servers.
• The right pane displays the contents of the selected folder or host.
2. Select a view option as described in Table 83 on page 427.
Table 83

Viewing the enterprise

To:

Do this:

Show or hide contents of the Enterprise.

Click Enterprise.

Show or hide contents of a folder.

Click the folder.

Show the managed applications installed on a host computer.

Click the host.

Enterprise
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Managing various servers in the enterprise
NetWorker Console enables centralized management of NetWorker, Data Domain,
and Avamar 3.7 and later servers within the Enterprise. You can add, delete, move,
and copy servers as needed. All of these functions can be performed through the
Console window. When using NetWorker software to manage a large number of
NetWorker servers, it might be more efficient to add or delete multiple hosts by using
a single command from the command prompt. “Adding or deleting multiple servers
by using a hostname file“ on page provides further information.
The server management activities include, but are not limited to, operations related to
devices and libraries, and events that require user intervention.
Adding a managed host
The Console window can display server events, which allow server activity-reports
to be generated.
Note: Data Domain servers are added as managed hosts automatically when a Data Domain
device is configured with the new New Device Wizard. The EMC NetWorker Data Domain
Devices Integration Guide provides more information about Data Domain as a managed host.

NetWorker Console supports hosts that use NetWorker server software release 7.2.x
or later and Avamar release 3.7.2 or later.
To add one of these hosts to the Enterprise:
1. From the Console window, click Enterprise.
2. In the left pane, right-click Enterprise, then select New>Host. The Add New Host
wizard appears.
3. Enter a hostname, IP address, DNS name, or WINS name in the Host Name
attribute, then click Next.
Note: Hostnames and aliases cannot exceed 80 characters.

4. Select the server type and click Next.
5. Follow the instructions for configuring selected host type, then click Finish.
A host can also be added by using the Console Configuration Wizard. “Accessing
the Console Configuration Wizard“ on page provides information.
Deleting a host
You can delete a single host or multiple hosts within a folder.
To delete a host or hosts:
1. From the Console window, click Enterprise.
2. Right-click the host to delete, then select Delete. The Deleting Host dialog box
appears.
• To delete multiple hosts, select multiple hosts in the details pane and select
Delete.
• If additional copies of the host exist in the Enterprise, use the Delete all
existing copies of the host option to delete all instances of that same host in a
single operation.
3. Click Yes to confirm deletion of the host.

428

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

NetWorker Server Management

Copying a host
Multiple copies of a host can be created for a single NetWorker or Avamar server. For
example, one copy of a host can be in its logical position in the Enterprise, while
another copy of the host is in a Hosts-to-Watch folder where it can easily be
monitored. This makes it possible to check the server without navigating through the
Enterprise.
To copy a host:
1. From the Console window, click Enterprise.
2. Right-click the host to copy, then select Copy.
3. Right-click a new location, then select Paste.
Note: Also, the drag-and-drop feature can be used while holding down the Ctrl key to
copy hosts.

Moving a host
To move a host from one location to another in an Enterprise:
1. From the Console window, click Enterprise.
2. Right-click the host to move, then select Move.
3. Right-click a new location, then select Paste.
Note: Also, use the drag-and-drop feature can be used to move hosts.

Managing folders in the enterprise
NetWorker software allows you to manage folders within the Enterprise. This means
that folders can be added, renamed, deleted, and moved as needed.
New folders can be added directly beneath the Enterprise node or beneath other
folders.
Adding a folder
To add a folder:
1. From the Console window, click Enterprise.
2. Right-click the location within the Enterprise where the new folder is to appear,
then select New>Folder. A new folder appears in the Enterprise with the default
name Untitled1.
3. Highlight the default name and type a new name to replace it. The name must
meet these criteria:
• Include at least one, but no more than 80 characters.
• Exclude forward slashes (/).
4. Press Enter.
Deleting a folder
Note: If there are restrictions in place controlling which hosts a user is allowed to see, the folder
might appear empty.

To delete a folder:
Enterprise
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1. From the Console window, click Enterprise.
2. Right-click the folder to delete, then select Delete.
• If hosts are present, a dialog box prompts you to confirm the deletion of each
host. Select Yes to continue with the operation, or No to cancel it.
• If no hosts are present, the folder is deleted.
If the folder contains any unique hosts (meaning hosts that do not have copies
anywhere else in the Enterprise), an additional dialog box appears to confirm
deletion of the unique host.
A separate dialog box with four options appears for each unique host in the
folder:
• To delete the specified host, click Yes.
• To delete all hosts and subfolders in the selected folder, without further
prompts, click Yes to All.
– To cancel the deletion, click No.
– To cancel any further deletion of hosts in the selected folder, and leave the
remaining contents intact, click Cancel.
Non-unique hosts, and folders containing only non-unique hosts, are deleted
without additional prompting.
Copying a folder
To copy a folder:
1. From the Console window, click Enterprise.
2. Right-click the folder to copy, then select Copy.
3. Right-click a new location, then select Paste and a copy of the folder appears in its
new location.
Note: Also use the drag-and-drop feature can be used to copy folders while holding down
the Ctrl key.

4. A folder cannot be copied within the same Enterprise level.
Moving a folder
To move a folder:
1. From the Console window, click Enterprise.
2. Right-click the folder to move, then select Move.
3. Right-click a new location, then select Paste. The folder appears in its new
location.
Note: Also the "drag-and-drop" feature can be used to move folders.

Renaming a folder
To rename a folder:
1. From the Console window, click Enterprise.
2. Right-click the folder, then select Rename.
3. Highlight the folder name and type a new name to replace it. The name must
meet these criteria:
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• Include at least one, but no more than 80 characters.
• Exclude forward slashes (/).
4. Press Enter.

Adding or deleting multiple servers by using a hostname file
For larger enterprises, it may be more convenient to add or delete multiple
NetWorker servers by using the gstmodconf command and a hostname file. With
this method, hosts are added or deleted at the base level of the Enterprise. The hosts
are added as NetWorker managed nodes with the features Capture Events and
Gather Reporting Data enabled. “Using the gstmodconf command“ on page has
more information about the gstmodconf command.
Restrictions
Copies of hosts cannot be added with the gstmodconf command. If a host already
exists anywhere in the Enterprise (either at the base or within a folder), copies of it
cannot be added by this command.
It is not possible to use this command to add a host to a folder. It can only add a host
to the base level. After the host has been added, the graphical user interface can be
used to move the host to a selected folder. “Moving a host“ on page provides
information about this procedure.
When the gstmodconf command is used for deletion, it deletes hosts from the base
level. It does not delete hosts that are within folders.
Creating the hostname file
To add or delete multiple hosts at the same time, specify their names in a hostname
file. The hostname file is a simple text file.
To create a hostname file, use these guidelines:
◆

Only one hostname may be listed on each line of the file.

◆

A non-comment line that contains more than one space-separated or
tab-separated hostname generates an error.

◆

To include a comment in the file, start the line with a "#" character.

◆

Blank lines are treated as comments and ignored, as shown in Example 33 on
page 431:

Example 33 Hostname file

#This is a hostname file for XYZ Corporation
apple
banana
grape
kiwi
mango
nectarine
pineapple
strawberry

Enterprise
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tangerine
Using the gstmodconf command
The gstmodconf command has this syntax:
gstmodconf -i file -f function -s server -k -p port -l login -P password
The EMC NetWorker Command Reference Guide or the UNIX man pages provide a
complete description of the command and its options.
Example 34 on page 432 shows how gstmodconf is used to add nodes from the file,
xyz_hostlist. In this example, the Console server name is myconsole and the
xyz_hostlist file contains:
Example 34 Adding multiple hosts with the gstmodconf command

apple
banana
grape
% gstmodconf -s myconsole -i xyz_hostlist
Trying 111.22.3.444... connected
processing file’xyz_hostlist’
adding host ’apple’
successfully added host ’apple’
adding host ’banana’
successfully added host ’banana’
adding host ’grape’
successfully added host ’grape’
//Closing connection

Error messages generated by the gstmodconf command
Example 35 on page 432 shows the error that is generated if gstmodconf is used to
add a host that already exists in the Enterprise:
Example 35 Attempting to add a host that already exists

% gstmodconf -s myconsole -i xyz_hostlist
Trying 111.22.3.444... connected
processing file ’xyz_hostlist’
adding host ’apple’
///Error!
{
string object_type = "gterror";
int severity = 16;
int reason = 23;
list msg = {
int level = 1;
string text = ’Host name already exists";
};
// Closing connection...

Example 36 on page 432 shows the error that is generated if the gstmodconf
command is entered without specifying the administrator password, when the
password has been changed from its default value.
Example 36 Attempting to Use gstmodconf with an expired default password

% gstmodconf -s myconsole -i xyz_hostlist
Trying 111.22.3.444... auth failed.
gt_session_connect: clnt_create: Remote system error-Connection
refused.
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Configuring a NetWorker server
To use the Administration window to modify a NetWorker server, the server must
meet the following requirements:
◆

The server must be included in the Enterprise.
“Adding a managed host“ on page provides information about adding hosts to
the Enterprise.

◆

The server must not restrict users from viewing the NetWorker server.

The Administration window can be used to modify an existing NetWorker server by
specifying attributes in the Properties dialog box of the NetWorker server. The
configuration of these attributes, such as setting the parallelism level or designating
administrator privileges, can affect backup performance and security.

Set up the server
Note: When setting up the NetWorker server, be sure to enter the NetWorker product serial
number. The product serial number is located on the Enabler Certificate that was sent when the
NetWorker product was ordered.

To set up the NetWorker server:
1. From the Administration window, click Configuration.
2. Select the server name.
3. From the File menu, select Properties.
4. In the Properties dialog box, configure the appropriate attributes.
5. Click the System Summary tab and enter the product serial number for the
server, as well as any other required information.
6. Click Ok.
Licensing the NetWorker server
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information on
how to license the NetWorker server.
Setting the Job inactivity timeout
Use the Job inactivity timeout attribute to specify the maximum time, in minutes that
a job will be declared inactive and will be terminated since it has last been heard from
the NetWorker server. This timeout applies to all processes throughout the entire
runtime operation.
Note: The new Job inactivity timeout attribute applies to all processes throughout the entire
runtime operation regardless of the job type and state. The savegrp inactivity timeout differs in
that it only applies to save processes during a media session.

To set the Job inactivity timeout attribute:
1. In the Administration window, click Configuration.
2. In the left pane of the Configuration window, select the NetWorker server.
3. From the File menu, select Properties.
4. Select the Configuration tab.
Configuring a NetWorker server
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5. For the Job inactivity timeout attribute, specify the maximum time in minutes
that you want a job declared as inactive and terminated from the time it was last
heard from.
6. Click Ok.

Configuring ConnectEMC
If ConnectEMC was selected during the installation of NetWorker 7.6, you will need
to configure the program using NMC and the ConnectEMC Console on the 32-bit
Windows system you specified as the location to install the ConnectEMC software.
The ConnectEMC Console icon appears on the desktop of this system.
IMPORTANT
Ensure that the NetWorker server and ConnectEMC host name are resolved with
short name and fully qualified domain name (FQDN) prior to running
ConnectEMC. You must be able to ping all hosts by IP address, short name and
FQDN name. If not, installing ConnectEMC fails and the NetWorker/ConnectEMC
send home feature fails.
The ConnectEMC for Windows User Guide, available on Powerlink from Support >
Technical Documentation and Advisories > Software ~ C ~ Documentation >
ConnectEMC, provides more instructions for configuring ConnectEMC.

Configure ConnectEMC in the ConnectEMC Console
To configure ConnectEMC in the ConnectEMC Console:
1. Double-click the ConnectEMC Console desktop icon. If the message “Invalid
callhome config file” appears, click Ok to continue.
2. When the Console appears, the left side of the button menu contains an octagonal
STOP icon. If the icon is red, click the STOP icon.
3. In the left pane, click the [+] box next to Connection and select General.
4. From the Connection menu, select Add Connection > Email Connection from
the list box.
5. In the Email window, enter the following values:
In the Connection settings section:
• Recipient — emailalert@emc.com
• EMail Server Hostname/IP — The name or IP address of the local SMTP
server that supports SMTP relaying.
• Sender — The administrator's email address
In the General Settings section:
• Alert Type — Select Use this connection first
• Email Type — Select ACSII
All other values — Leave as default values
6. Click Test to send a test email to the ConnectHome server. Verify that the email
was sent successfully.
7. Click Save.
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8. The left side of the menu contains a green octagonal Run icon.
9. Click the Run icon.
10. From the menu, select File > Exit.
(Optional) Resetting the EMC Polling Interval
The Polling Interval by default is set to 5 seconds. If you want to reset the
ConnectEMC Polling Interval, while still in the ConnectEMC Console and with the
ConnectEMC service set to Stop, perform the following:
1. In the far left pane, click the Settings folder.
2. Click General. POLL_INTERVAL should display in the right pane under
Variable Name.
3. In the Setting Value column for the POLL_INTERVAL, type an interval value in
seconds (for example, type 60 for a 1 minute interval).
4. Select the floppy disk icon on the left side of the menu to save changes.
5. If necessary, restart the ConnectEMC service (see step 8 above).

Configure ConnectEMC in NMC
After configuring the settings for ConnectEMC using the ConnectEMC console, some
tasks need to be performed in the NetWorker Management Console. These tasks are:
◆

Specifying the name of the ConnectEMC host

◆

Setting Autostart to run nsrconnect

Name of the ConnectEMC host
When ConnectEMC is installed, the host is set to the NetWorker server by default, if
no host was specified during installation.
To set or verify the name of the ConnectEMC host:
1. Launch NMC.
2. Click the Configuration button. An entry for ConnectEMC appears in the tree of
the left navigation pane.
3. Click ConnectEMC. In the ConnectEMC window pane, right-click
DefaultConnectEMC and select Properties.
4. In the ConnectEMC host field, type the name of the host that will be used to run
the ConnectEMC daemon if the host specified is not correct.
Configure ConnectEMC to send
To configure ConnectEMC to send:
1. Connect to the NetWorker server using NMC.
2. Click the Configuration button. An entry for ConnectEMC appears in the tree of
the left navigation pane.
3. Click ConnectEMC. In the ConnectEMC window pane, right-click
DefaultConnectEMC and select Properties.
4. Confirm that the correct NetWorker server is specified in the ConnectEMC Host
field.
5. Select Enabled from the Autostart drop-down menu.
Configuring ConnectEMC
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6. Click Ok.
Setting Autostart to run nsrconnect
nsrconnect is the NetWorker interface to ConnectEMC. The nsrconnect task is run to
create the .xml file that contains the system configuration information stored in the
RAP database. When Autostart is set to Enabled, nsrconnect will be launched one day
after the NetWorker server is started (or restarted), and once per month thereafter.
For example, if the NetWorker server (nsrd) is started on Monday, nsrconnect
launches on Tuesday, and then again a month from Tuesday.
To start the nsrconnect task immediately, set AutoStart to Start now.
IMPORTANT
Start Now can only be initiated on the server once every 15 minutes due to the 15
minute throttle limit.
Configure NetWorker to pass contact information to Connect Home server
In order to quickly and accurately identify the source of server information, provide
the company contact information:
1. Right-click the NetWorker server in the navigation pane, and select Properties.
2. Click the Customer Information tab.
3. Complete the following fields:
• Contact Name
• Company
• Street Address
• City/Town
• State/province
• Zip/postal code
• Country
• Phone Number
4. Click Ok.

Enabling BMR server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker
server. This connection enables the delivery of profile data from the NetWorker client
to the HomeBase Server.
“Configuring a client for BMR support“ on page provides information for
configuring and enabling a BMR client.

Parallelism and multiplexing
Parallelism is a general term within the NetWorker software for a number of
configurable options that allow you to adjust the volume of data being processed by
the system, thereby improving performance of servers, storage nodes, and devices.
Multiplexing is the ability to write multiple save streams simultaneously to the same
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storage device. This section identifies attributes related to parallelism and
multiplexing and describes how they work together to optimize your NetWorker
environment.

Parallelism
Several attributes in various NetWorker resources are used to adjust the volume of
data being processed by the system to improve overall performance.
The following attributes are related to parallelism:
◆

Client parallelism

◆

Server parallelism

◆

Savegrp parallelism

◆

Max active devices

◆

Media library parallelism

These attributes are described in detail in the following sections.
Client parallelism
Client parallelism is defined by using the Parallelism attribute of the Client resource,
found in the NetWorker Console on the Globals (1 of 2) tab of the Client property
dialog box.
Client parallelism defines the number of save streams that a client can send
simultaneously during backup. Client parallelism has two default values, depending
on whether the Client resource is a NetWorker server:
◆

For the Client resource for a NetWorker server, the default value for the client
parallelism attribute is 12. This higher default value allows the server to complete
a larger number of index backups even while the server’s filesystem or other
index backups are still running.

◆

For all other clients (that is, clients that are not also NetWorker servers), the
default value is 4. Many features within NetWorker, such as deduplication,
NDMP backups, and VSS, will not work correctly with client parallelism set to a
value that is higher than 4.

For all clients other than the Client resource of the NetWorker server, to avoid disk
contention, you should generally not set the client parallelism higher than the
number of physical disks involved in the client’s backup, along with, on Microsoft
Windows systems, the System State and System DB. Therefore, a typical Windows
system configured with the ALL keyword for the client save set attribute will back up
the C: and D: drives as well as the System State and System DB; in this case the
default parallelism setting of 4 will be adequate. On the other hand, if you define
multiple save sets on the same disk (C:\users, C:\system, C:\docs and so on), higher
client parallelism will result in multiple save streams attempting to access the disk at
the same time.
Server parallelism
Server parallelism is defined by using the Parallelism attribute of the Server resource,
found in the NetWorker Console on the Setup tab of the Server property dialog box.
Server parallelism defines the number of simultaneous save streams supported by
the server. The default and the maximum allowed server parallelism varies
depending on the edition of NetWorker software. Each enabled storage node

Parallelism and multiplexing
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connected to the NetWorker server can increase the parallelism maximum. The
maximum parallelism for any NetWorker server and storage node combination can
vary. The EMC NetWorker Release Notes provides more information.
Optimally, your NetWorker server should be configured to process enough save
streams to keep all backup devices in your datazone writing at their maximum speed.
By tuning the server parallelism setting, along with other settings discussed in this
section, you can maximize the speed that data is written to backup devices.
Savegroup parallelism
Savegroup parallelism is defined by using the Savegrp parallelism attribute of the
Group resource, found in the NetWorker Console on the Advanced tab of the group
property dialog box.
Savegroup parallelism determines the number of simultaneous save streams that will
be allowed for a NetWorker group. The default value for this attribute is 0, which
means that the attribute will have no effect on other parallelism settings. If the value
is greater than zero, it will override any other parallelism considerations that savegrp
would use.
Savegroup parallelism can help tune backups that involve multiple groups that
overlap in their backup schedules, particularly if one group has a large number of
clients. For example, if you have one group with 100 clients and another group with 4
clients, and you have the Savegrp parallelism attribute set to 0, savegrp may start as
many clients in the first group as possible, up to the maximum number allowed by
the server’s server parallelism setting. This will mean that the smaller group will not
be able to start any client backups, because the server parallelism is at its maximum,
and the smaller group may experience timeouts and backup failures. To avoid this
situation, you can set the savegroup parallelism for the larger group to a number
below the server’s server parallelism setting, guaranteeing that the clients in the
smaller group will be able to begin their backups.
Max active devices
The maximum number of active devices for a storage node is defined by using the
Max active devices attribute of the Storage Node resource, found in the NetWorker
Console in the Devices window, on the General tab of the Storage Node property
dialog box.
This attribute sets the maximum number of devices that the NetWorker software may
use from the storage node. In large environments with media libraries with large
numbers of devices, it is possible that the storage node will not have the ability to
optimize all drives in the library. The Max active devices attribute allows you to limit
the number of devices that the storage node will use at a given time, thereby allowing
the storage node to have access to all devices in the library but limiting it to the
number of devices it can fully optimize.
Media Library parallelism
Media library parallelism is defined by using the Max parallelism attribute of the
Library resource, found in the NetWorker Console in the Devices window, on the
Configuration tab of the Library property dialog box.
Media library parallelism allows you to designate the maximum number of available
devices for the following autochanger operations:
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The Max parallelism attribute of the Library resource is normally set to one less than
the number of devices within the library.
Library operations that operate on multiple volumes are more efficient if multiple
devices can be used in parallel for these operations. However, because libraries may
be performing multiple operations simultaneously, you may wish to restrict the
number of devices available for inventorying and labeling operations, to leave some
devices available for other library operations.

Multiplexing
Multiplexing is the ability to write multiple save streams simultaneously to the same
storage device. It is often more efficient for the NetWorker server to multiplex
multiple save sets to the same device; there are also times when limiting the number
of save streams to a particular device will improve performance of your NetWorker
environment.
The NetWorker software has several attributes that can be used to increase or limit
the number of save streams being written to a device.
The following attributes are related to multiplexing:
◆

Target sessions

◆

Max sessions

◆

Pool parallelism

These attributes are described in detail in the following sections.
Target sessions
The optimal number of target sessions per device is defined by using the Target
sessions attribute of the Device resource, found in the NetWorker Console in the
Devices window, on the Configuration tab of the Device property dialog box.
The Target sessions attribute allows you to set the optimal number of backup sessions
accepted by an active device. This is not a hard limit; to set a hard limit for the
number of sessions to a particular device, use the Max sessions attribute, described
below.
Instead of a hard limit, the Target sessions attribute aids in load balancing for devices
by determining when the NetWorker software should begin writing save streams to
another device:
◆

If a device is already receiving the number of backup sessions determined by the
target sessions value, the NetWorker server uses the next underutilized device
for the backups.

◆

If all available devices are receiving the number of backup sessions determined
by their target sessions value, the NetWorker server overrides the set value and
uses the device with the least activity for the next backup session.

Because it is often more efficient for the NetWorker server to multiplex multiple save
sets to the same device, rather than write each save set to a separate device, the
NetWorker server attempts to assign to each device a number of save sets, up to the
value of target sessions, before assigning a save set to another device.
Note: When the NetWorker software assesses how many devices need to be involved in
multiple savestreams assignments with the same storage node, the device with the lowest
target session value is used as a reference. It does not make a difference if the device with the
lowest target session value is associated with a different pool than the incoming savestreams.

Parallelism and multiplexing
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Max sessions
The maximum number of target sessions per device is defined by using the Max
sessions attribute of the Device resource, found in the NetWorker Console in the
Devices window, on the Configuration tab of the Device property dialog. This
attribute defines the maximum number of save sessions for a device. Its value is
never less than the target sessions value.
Pool parallelism
Pool parallelism is defined by using the Max parallelism attribute of the Pool
resource, found in the NetWorker Console in the Media window, on the
Configuration tab of the Pool property dialog box.
Pool parallelism determines the maximum number of simultaneous save streams for
each device belonging to a NetWorker pool. The default value for this attribute is 0,
which means that the attribute will have no effect on other parallelism settings.
Pool parallelism can be used to increase recovery times. For example, you can create a
pool for backups of business critical data and use this attribute to restrict the number
of save sets written in parallel to the media for this pool, which will increase the
speed that data is recovered from that media. However, be aware that if the Max
parallelism attribute of the pool is set to 1, there may be a prolonged delay between
the backup of save sets. If this behavior occurs, try increasing the Max parallelism
attribute for the pool resource.

Managing server access
NetWorker server access is managed by granting access privileges to NetWorker
Console users.

Granting access to manage NetWorker servers from Console server
If the Console server and the NetWorker server are installed on separate hosts, the
Console administrator must be granted access to administer and monitor the target
NetWorker server. To grant access, use the nsraddadmin command from the
command prompt on the NetWorker server. Grant access on each NetWorker server
that is to be managed from the Console server. The NetWorker Installation Guide
provides information about granting access with the nsraddadmin command. The
EMC NetWorker Command Reference Guide or the UNIX man pages provides
information about the nsraddadmin command.

Administrator privileges
Use the Administration window to grant NetWorker administrator privileges to
additional Console users. This is done by adding users to the Administrators group
for the NetWorker server. “NetWorker User Groups“ on page provides more
information.
When granting privileges to users, note the following requirements:
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◆

To change security settings, the user must be a member of the NetWorker
Administrators group.

◆

To perform a scheduled backup of SYSTEM and VSS SYSTEM save sets, the user
must be a member of the NetWorker Administrators group.
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◆

To add to or change the configuration of the server, media devices, and media
libraries, the user must have the Configure NetWorker privilege.

NetWorker software ships with default administrator settings that give root users on
UNIX and Linux, and members of the Windows Administrators group on Windows,
permission to change its configurations. The Administrators group in the Server
resource should include the following entries, depending on the platform of the client
trying to administer the NetWorker server:
◆

Microsoft Windows:
user=administrator, host=server_name

◆

UNIX and Linux:
user=root, host=server_name

Note: If a hostname is used, the NetWorker server must be able to convert the hostname to a
resolved TCP/IP address.

Additional Console users or user groups can be granted administrative privileges by
adding them to the Administrators group.
Usernames should be listed in the form of name/value pairs by using the syntax:
name=value[,name=value, ...]

where name can be one of the following:
◆

user

◆

group

◆

host

◆

domain

◆

domain_sid

◆

domaintype (either NIS or WINDOMAIN)

For example, to grant administrative privileges to a user that is named jdoe on the
host named jupiter, enter this line in the Users attribute:
user=jdoe,host=jupiter
Note: The formats user@host, host/user, and similar formats are supported, but are ambiguous as
to whether host or domain is intended. As a result, the name=value format is preferred.

If the value has spaces, it should be surrounded by quotation marks, for example:
domain="Domain Admins"

You can also enter just a username, which allows that user to administer NetWorker
from any host (this is the same as an entry of user=username). Wildcards can also be
used in place of a value. However, wildcards should be used with caution because
they can compromise your enterprise security. Netgroup names can also be entered
but must be preceded by an ampersand (&).
Example 37 Using the NetWorker Administrators Group

This example shows what to enter to provide NetWorker administrative privileges to
the following:
◆

The user root from any host

Managing server access
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◆

The user operator from the hosts mars and jupiter

◆

Any users, valid hosts for the users, and valid domains for the users and host that
are included in the netgroup netadmins:
user=root
user=operator,host=jupiter
user=operator,host=mars
&netadmins

Microsoft Windows groups and NetWorker administrative privileges
The NetWorker server recognizes domain names and Microsoft Windows groups,
both local and global. For example:
◆

Administrators group

◆

Domain Admins group

If you are logged into a domain, only the global group is recognized. You can find out
the name of your group by running the Windows utility findgrp.exe, which is
available with the Windows Resource Kit.
If you are logged into an individual Windows computer, only the local group is
recognized, because there is no global group.
In cases where a user belongs to a domain that cannot be contacted by the server and
therefore the username cannot be verified, you can use a more specific user
description to guarantee that the appropriate user will have administrative rights to
the server. The syntax for this user description is as follows:
◆

Single user:
user=user_name, domain=domain_name

For example:
user=joe,domain=NT-ENG
◆

Group:
group=group_name, domainsid=domain_id

For example:
group=Administrators,domainsid=S-1-5-32-323121-123

NetWorker User Groups
NetWorker includes an access control feature that is configured through the User
Group resource. This feature allows NetWorker administrators to create user groups,
define the privileges associated with those user groups, and assign users to various
groups. Privileges include such things as permission to monitor NetWorker software,
as well as to back up and recover local data.
To create user groups, you must have an Access Control enabler installed on the
NetWorker server. One enabler per datazone is required. This feature is available
only on servers with NetWorker release 7.0 and later.

Preconfigured User Groups
NetWorker comes with two preconfigured user groups:
◆
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◆

Users

Administrators
Members of the Administrators group have permission to perform all NetWorker
functions, except with regard to some utilities that require root or Microsoft
Windows Administrator access. The UNIX root user and members of the Microsoft
Windows Administrators group are always members of this group and cannot be
removed from the group.The EMC NetWorker Command Reference Guide or the UNIX
man pages provide information on the permission requirements for a specific utility.
Privileges associated with the Administrators group cannot be changed.
Users
By default, members of the Users group are granted permission to back up and
recover local data and to monitor NetWorker operations. They cannot view or edit
configurations.

Customizing privileges
The privileges associated with the Users group can be customized to fit your
requirements. Privileges associated with the Administrators group cannot be edited.
Table 84 on page 443 lists these preconfigured privileges and their associated
permissions.
Table 84

User Group privileges (1 of 2)

Privilege

Permissions

Change security settings

Allows group members to edit these resources and attributes:
• User Group resources
• Remote Access attribute in the Client resource
• Archive Users attribute in the Client resource
• Administrators attribute in the Server resource
• Notification resource
• Owner Notification attribute in the Client resource
Note: If you change the users listed in the Administrator attribute of the Server resource, the changes
are automatically reflected in the Administrators group as well. Similarly, if you change the members of
the Administrators group, the changes are automatically reflected in the Administrator attribute.
Members of groups with this privilege can grant access to restricted functions to any user.
User groups with this privilege must also have these privileges: Configure NetWorker, Operate
NetWorker, Monitor NetWorker, Operate Devices and Jukeboxes, Backup Local Data, and Recover
Local Data.

Remote access all
clients

Allows group members to remotely browse and recover data associated with any client, as well as view
configurations for all Client resources. This privilege is required to perform Directed Recovers.
This privilege supersedes the Remote Access attribute in the Client resource.
User groups with this privilege must also have these privileges: Operate NetWorker, Monitor
NetWorker, Operate Devices and Jukeboxes, Backup Local Data, and Recover Local Data.

Configure NetWorker

Allows group members to configure resources associated with the NetWorker server, its storage nodes,
and clients. This includes creating, editing, and deleting resources.
Users with this privilege cannot configure User Group resources or the Remote Access or Archive
Users attributes in the Client resource. Permission to change these settings is granted only through the
Change Security Settings privilege.
User groups with this privilege must also have these privileges: Operate NetWorker, Monitor
NetWorker, Operate Devices and Jukeboxes, Backup Local Data, and Recover Local Data.

NetWorker User Groups
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Table 84

User Group privileges (2 of 2)

Privilege

Permissions

Operate NetWorker

Allows group members to perform NetWorker server operations. For example, members can:
• Reclaim space in a client file index.
• Set a volume location or mode.
• Start or stop a savegroup.
• Query the media database and client file indexes.
User groups with this privilege must also have these privileges: Monitor NetWorker, Operate Devices
and Jukeboxes, Backup Local Data, and Recover Local Data.

Monitor NetWorker

Allows group members to:
• Monitor NetWorker operations, including device status, save group status, and messages.
• View media databases information.
• View NetWorker configuration information (except the security settings described in the Change
Security Settings privilege).
This privilege is not required to back up and recover local data, although it may be helpful for users to
monitor messages and other information.

Operate devices and
jukeboxes

Allows group members to perform device and autochanger operations, for example, mounting,
unmounting, and labeling. Users with this privilege can also view device status and pending messages,
as well as view information in the media database.
User groups with this privilege must also have Monitor NetWorker privileges.

Recover local data

Allows group members to recover data from the NetWorker server to their local client, as well as view
most attributes in the client's configuration. Members can also query the client's save sets and browse
its client file index.
Note: This privilege does not provide permission to view information about other clients.
This privilege does not override file-based permissions. Users can only recover files with the
appropriate user permissions for that operating system.
User with the privilege still must be logged in as root (UNIX) or administrator (Microsoft Windows) to
perform save set or NDMP recovers.

Backup local data

Allows group members to manually back up data from their local client to the NetWorker server, as well
as view most attributes in the client's configuration. Members can also query the client's save sets and
browse its client file index. This privilege does not provide permission to view information about other
clients.
Note: This privilege does not override file-based permissions. Users can only back up files with the
appropriate user permissions for that operating system.
Users with the privilege still must be logged in as root (UNIX) or administrator (Microsoft Windows) to
run the savegrp command or perform NDMP backups.
To allow scheduled backups to operate correctly, the root user (UNIX) or administrator (Microsoft
Windows) on the client has this privilege automatically.

Working with User Group resources
This section provides procedures for creating, editing, copying, and deleting a User
Group resource.
Creating a User Group resource
To create a User Group resource:
1. From the Administration window, click Configuration.
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2. Right-click User Groups, then select New. The Create User Group dialog box
appears.
3. In the Name attribute, enter the name of the User group. The optional Comment
attribute can be used to enter a description of the User group.
4. In the Users attribute, enter the names of the users that should be members of the
user group by using the format described in “Administrator privileges“ on page .
5. Select the privileges to assign to the user group.
6. Click Ok.
Editing a User Group resource
To edit a User Group resource:
1. From the Administration window, click Configuration.
2. Click User Groups.
3. Right-click the user group to edit, then select Properties. The Properties dialog
box appears.
4. Make any necessary changes, then click OK.
Note: You cannot change the privileges associated with the Administrators group. Also, you
cannot remove the UNIX root user or the Windows Administrator for the server being
configured.

Copying a User Group resource
To copy a User Group resource:
1. From the Administration window, click Configuration.
2. Click User Groups.
3. Right-click the user group to copy, then select Copy. The Create User Group
dialog box appears, and contains the same information as the user group that was
copied, except for Name attribute.
4. In the Name attribute, enter a name for the new user group.
5. Edit any other attributes as appropriate, then click OK.
Deleting a User Group resource
Note: You cannot delete a preconfigured user group.

To delete a User Group resource:
1. From the Administration window, click Configuration.
2. Click User Groups.
3. Right-click the user group to delete, then select Delete.
4. When prompted, click Yes to confirm the deletion.

NetWorker User Groups
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Server communication issues within Microsoft Windows
This sections addresses various client/server communication issues that occur when
running NetWorker software in a Microsoft Windows environment.

Hostname determination
NetWorker software on a Windows server gets its hostname from its TCP/IP setup.
This name is not necessarily the same computer name that is common to other
Windows applications.
To determine the hostname of a Windows computer, type the following at a
command prompt.:
hostname

Name resolution
If the network consists of only Microsoft Windows computers, you may find WINS or
LMHOSTS is adequate for using NetWorker software. However, when using the
software with clients running on other platforms, such as UNIX, you must use a local
host file or DNS name resolution.
You must add the NetWorker server name to either the local hosts file (located in
%SystemRoot%\system32\drivers\etc) or the Domain Name Server that contains
the names of all servers on your network.

Backup Operators group
The Microsoft Windows Backup Operators local group provides its members the
permissions necessary to back up and recover data from a Windows computer. Users
who request backups must be in the Backup Operators or Administrators group of
the domain into which they are logged. The Backup Operators group is assigned on a
computer-by-computer basis, rather than globally by the domain. If you are having
trouble performing tasks on one NetWorker server but not another, check Backup
Operators group on the problematic computer to ensure that you are properly
assigned.

Dynamic Host Configuration Protocol
A NetWorker server requires a static (fixed) hostname address. Typically, addresses
for Dynamic Host Configuration Protocol (DHCP) clients change because they use
dynamic addressing. If the address changes, the authorization code for that
NetWorker server becomes invalid. If the NetWorker server is a DHCP client, a static
TCP/IP address for the server must be preserved. NetWorker clients can still use
dynamic addressing.

Backup and Recover Server service
In Microsoft Windows operating systems, the NetWorker Backup and Recover Server
service is normally started by the Windows System account. This allows backup and
recovery services to run even if no one is logged onto that computer.
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Notifications
A notification provides information about events that occur in a NetWorker
environment. You can configure the events to be reported, as well as how the
NetWorker server reports them to you. Specific programs can be executed when an
event occurs, including third-party programs. By default, the NetWorker server
sends notifications to log files located in the <NetWorker_install_dir>\logs directory.

Preconfigured notifications
NetWorker is preconfigured to provide most of the notifications required to monitor
NetWorker events. Table 85 on page 447 lists these preconfigured notifications and
the associated actions performed by the NetWorker server.
Table 85

Preconfigured notifications (1 of 2)

Notification

Action performed by the NetWorker server

Bootstrap

Sends the bootstrap information to the default printer of the NetWorker server.

Bootstrap backup failure

Sends this email to root/Administrator: Bootstrap backup failed.

Cleaning cartridge expired

Windows: Reports expired cleaning cartridge to the media log file.
UNIX: Sends this email to root: replace the expired cleaning cartridge.

Cleaning cartridge required

Windows: Reports the need for cleaning cartridge to the media log file.
UNIX: Sends this email to root: insert a cleaning cartridge.

Client install

Windows: Reports hostname and NetWorker client software version information to the
media log file.
UNIX: Sends this email to root: host host_name installed product_version.
Where host_name is the name of the NetWorker host, and product_version is the
NetWorker client software release and build number.

Device cleaned

Windows: Reports that a device has been cleaned to the media log file.
UNIX: Sends this email to root: device cleaning is complete.

Device cleaning required

Windows: Reports that a device requires cleaning to the media log file.
UNIX: Sends this email to root: clean the device.

Device disabled

Windows: Reports that a device has been automatically disabled to the media log file.
UNIX: Sends this email to root: a device has been automatically disabled.

Device serial number mismatch

Windows: Reports that a device ordering error has occurred, and moves the device to
service mode.
UNIX: Sends this email to root: Check system device ordering. Moving device to service
mode. To correct, scan for devices in NMC and re-enable the device.

Event log (Windows only)

Logs notification events triggered by events and priorities to the Event Log.

Filesystem full - recovering adv_file
space

Launches the nsrim program to remove aborted and expired save sets. Used with
advanced file type devices only.

Filesystem full - waiting for adv_file
space

Windows: Reports that the advanced file volume is full to the media log file.
UNIX: Sends this email to root: advanced file volume is full.

Index size

Windows: Sends a message about the status of the index to the index log file.
UNIX: Sends this email to root: check the size of the client file index because it will soon
exceed the space available.

Notifications
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Table 85

Preconfigured notifications (2 of 2)

Notification

Action performed by the NetWorker server

Log default

Windows: Sends data about NetWorker events to the messages log file.
UNIX: Directs the UNIX syslog facility (/usr/bin/logger) to log information from the
/nsr/logs/messages file into the appropriate system log file.
SuSE Linux: System log notifications might fail on SuSE Linux Enterprise Server 8 and 9.
The logger binary appears in the /bin directory instead of /usr/bin. This causes the Log
default notification to fail.
To resolve this issue:
• Create a link in the /usr/bin directory to /bin/logger.
Note: The default Tape Mount Request 1 and Tape Mount Request 2 notifications must
be updated if a link is not created.
• Modify the Log Default notification and change the /usr/bin/logger filepath to
/bin/logger.
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NetWorker Daemons Not Running

Sends this email to root/Administrator: NetWorker daemons not running.

New Virtual Machine

Windows: Sends message that new virtual machines have been detected to the
messages log file.
UNIX: Sends e-mail that new virtual machines have been detected.

Registration

Windows: Sends messages about the registration status of your NetWorker products to
the messages log file.
UNIX: Sends this email to root: check the registration status.

Resource File Corruption

Sends this email to root/Administrator: Resource file corruption.

Savegroup completion

Windows: Reports the success of client save sets to the savegrp log file.
UNIX: Sends this email to root: degree of success in completing scheduled backups,
cloning, and archive operations.

Save set marked suspect

Sends this email to root/Administrator: Save set marked suspect.

SNMP notification request

Sends event notifications to a network management console (this notification only
appears if the NetWorker SNMP module has been purchased and enabled). Chapter 21,
“SNMP Module” provides details on SNMP notifications

Storage Node Registration

Registers a client as a storage node.

Tape mount request 1

Windows: Requests media be mounted in a device and displays a pending message.
UNIX: Sends a request to the messages file to mount a backup volume, using a priority of
Waiting.

Tape mount request 2

Windows: Requests media be mounted in a device and displays a pending message.
UNIX: Sends a request to the messages file to mount a backup volume, using a priority of
Critical.

Tape mount request 3

Windows: Sends a request for mounting a backup volume, using a priority of Alert, to the
media.log file.
UNIX: Sends an email to root to request that the tape be mounted.

Tape mount request 4

Sends an email to root/Administrator to request that the tape be mounted.

Verify Label failed on unload

Sends an email to root/Administrator: Unable to read the tape label.

Volume Marked full

Sends an email to root/Administrator: Volume marked full.
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Customizing notifications
Notifications require the following three elements:
◆

“Events“ on page

◆

“Actions“ on page

◆

“Priorities“ on page

Events
Table 86 on page 449 lists the events that trigger a notification.
Table 86

Events

Event

Description

adv_file

The file system is full and is waiting for additional space.

Bootstrap

The bootstrap backup failed.

Cleaning cartridge expired

A cleaning cartridge has expired and needs replacing.

Cleaning cartridge required

Mount the cleaning cartridge.

Client

NetWorker client software has been installed on a host.

Deleted media

A media device has been deleted.

Device cleaned

A device has been cleaned.

Device cleaning required

A device requires cleaning.

Device disabled

A device has been automatically disabled.

Hypervisor

New virtual clients have been auto-discovered, or auto-discovery failed.

Index attention

An index needs attention.

License expiration

A license has expired.

Media

A media related event occurred. For example, a volume may require mounting.

Media attention

Media needs operator attention to mount or unmount backup volumes.

Media capacity

A volume has almost reached the maximum number of save sets allowed in the
media database.

Media request

Media needs operator attention to mount backup volumes.

Potential device ordering issue

A device ordering or serial mismatch error has occurred.

Registration

Product registration needs attention.

Savegroup

A backup group has completed the backup.

Server

Other server events (for example, restarting the NetWorker server).

Storage node

A storage node has been installed.

Write completion

A write operation is complete.

Notifications
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Actions
Table 87 on page 450 lists the actions that the server takes after an event notification
occurs.
Table 87

Actions

Action

Description

eventlog

(Windows only) Logs the notification message to the event log.

nsrlog

(Windows only) Sends a message about an event to a file.

nsrlpr

(Windows only) Prints information to a printer. “Using nsrlpr to print notifications“ on page provides
more information about using nsrlpr.

logger

(UNIX only) Uses the UNIX syslog facility (/usr/bin/logger) to log information or send messages.

lp

(UNIX only) Prints the notification.

mail

(UNIX only) Sends email to the specified user.

nsrtrap

Sends notifications to an SNMP management console.

Third-party programs can also be used for the action, as long as the programs
support reading from standard input. For example:
◆

With UNIX systems, you can use a third-party email program rather than the
mail command.

◆

With Windows systems, you can use a third-party email program to send the
information to other locations, such as an email address or pager system.

Only users who belong to the NetWorker server Administrators group, or users with
the Change Security Settings privilege, can change the Action attribute of an existing
notification.
Using nsrlpr to print notifications
NetWorker Server, on Windows systems only, looks at the printer named in each of
these two sources to determine which to use to print notifications with nsrlpr:
◆

The Printer attribute in the Group resource. This entry is ignored if a printer is
named in the Action attribute for a notification.

◆

The printer named in the Action attribute for a notification, or that you specified
by using the -P option of the nsrlpr command.

Designating a printer for a Notification Resource
To designate a printer for a Notification resource:
1. From the Administration window, click Configuration.
2. Click Notifications.
3. Right-click a notification, then select Properties. The Properties dialog box
appears.
4. In the Action attribute, type:
nsrlpr -P printer_name
where printer_name is the name of the designated printer.
If the printer name has spaces, such as eng printer one, then enclose the printer
name in double quotes, as shown here:
nsrlpr -P "eng printer one"
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If the printer is associated with a particular server, as is the case with Microsoft
LAN Manager printers, use this syntax:
nsrlpr -P \\server_name\printer_name

where:
• server_name is the name of the server to which the printer is attached.
• printer_name is the name of the printer to use.
Send the bootstrap notification printout to its group’s printer
To send the bootstrap notification printout to the printer defined in the Printer
attribute of the Group resource:
1. From the Administration window, click Configuration.
2. Click Notifications.
3. Right-click Bootstrap, then select Properties. The Properties dialog box appears.
4. In the Action attribute, type:
nsrlpr -P %printer

Testing the nsrlpr program
To test the nsrlpr program, enter this at the command prompt:
nsrlpr -P printer_name text_file

where:
◆

printer_name is the name of the printer to use.

◆

text_file is the name of a text file to print.

The printer name was typed incorrectly if you receive this error message:
Error: print server did not accept request. Job aborted.

Once you can print from the command prompt, enter this command to change the
Action attribute to the print command:
nsrlpr -P printer_name
Note: Print jobs sent by the NetWorker Backup and Recover Server service run in the Local
System context. Under certain conditions, it may not have access to network print queues.
Microsoft Knowledge Base articles 132679 and 143138 on the Microsoft website provide more
information.

Priorities
Each NetWorker event has a series of associated messages, and each message has an
associated priority. The preconfigured notifications have selected priorities based on
the importance of the message being sent. For example, the first time the NetWorker
server sends a mount backup volume request, the priority assigned to the message is
Waiting. The priority of the second request is Alert. The priority of the third request
is Critical.

Notifications
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Table 88 on page 452 lists the priorities upon which notifications are based.
Table 88

Priorities

Priority

Description

Information

Information about the current state of the server.

Notice

Important information.

Warning

A non-fatal error has occurred.

Waiting

The NetWorker server is waiting for an operator to perform a routine task, such as mounting a backup
volume.

Alert

A severe condition exists that requires immediate attention.

Critical

The server detected an error that should be fixed.

Emergency

A condition exists that may cause NetWorker to fail unless corrected immediately.

Note: Event priorities are sorted alphabetically, rather than by severity.

Logging event notifications
NetWorker keeps two general notification log files. By default, these files are located
in <NetWorker_install_dir>\logs.
◆

messages log file
The data in the messages log file is generated by nsrlog, which is part of the
NetWorker event notification mechanism. The nsrlog program is triggered by a
notification, and it prints the file to the messages log file.

◆

daemon log file
The nsrd, nsrexecd, and their subordinate processes redirect their output to the
daemon log file.

“Viewing log files“ on page provides information about viewing log files.
To better access and use these event logs on Windows systems, an Event Logging
mechanism enables applications to log messages to the application event log, and
access them from any computer that has the Windows Event Viewer. The Event
Viewer enables you to look selectively at the messages that interest you by filtering
messages based on the categories listed in Table 89 on page 452.
Table 89
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Event Viewer messages

Event Viewer category

Displayed information

Source

Events from NetWorker software always designate NetWorker as the source.

Category

Mapped from NetWorker notification event type (savegroup, server, registration, and so
on).

Severity

Mapped from NetWorker notification priority:
• Critical and Emergency are mapped to Error.
• Priorities between Alert and Warning are mapped to Warning.
• Notification and Information are mapped to Information.

Event ID

Events from NetWorker software always designate the numeral 1 for the ID.

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

NetWorker Server Management

Creating a custom notification
NetWorker also provides preconfigured notifications. “Preconfigured notifications“
on page provides a complete list of preconfigured notifications.
To create a custom notification:
1. From the Administration window, click Configuration.
2. Right-click Notifications, then select New. The Create Notification dialog box
appears.
3. In the Name attribute, enter a name for the notification.
4. In the Event attribute, select the events to be acted on.
5. In the Priority attribute, select the priorities of the corresponding actions.
6. In the Action attribute, enter a command to execute in response to the selected
events and priorities. Table 90 on page 456 provides command options.
7. Click Ok.

Editing a notification
Note: You cannot change the name of a notification.

To edit a notification:
1. From the Administration window, click Configuration.
2. Click Notifications.
3. Right-click the notification to edit, then select Properties. The Properties dialog
box appears.
4. Make any required changes, then click Ok.

Copying a notification
To copy a notification:
1. From the Administration window, click Configuration.
2. Click Notifications.
3. Right-click the notification to copy, then select Copy. The Create Notification
dialog box appears, containing the same information as the notification that was
copied, except for Name attribute.
4. In the Name attribute, enter a name for the new notification.
5. Edit any other attributes as appropriate, then click Ok.

Notifications
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Deleting a custom notification
To delete a custom notification:
1. From the Administration window, click Configuration.
2. Click Notifications.
3. Right-click the notification to delete, then select Delete.
4. When prompted, click Yes to confirm the deletion.
Note: You cannot delete any of the preconfigured notifications.

Indexes
The NetWorker server tracks the files it backs up in two databases, which are stored
on the local file system of the server:
◆

The client file index tracks the files that belong to a save set. There is one client file
index for each client.

◆

The media database tracks:
• Volume name
• Backup dates of the save sets on the volume
• File systems in each save set
Unlike the client file indexes, there is only one media database per server.

The client file indexes and media database can grow to become prohibitively large
over time. “Managing the size of the online indexes“ on page provides information
about managing the size of these indexes.

Characteristics of the online indexes
The size of an index is proportional to the number of entries it contains. The media
database is usually smaller than the client file index, because the media database
stores one entry for each volume, while the client file index stores one entry for each
file saved on that volume. The NetWorker server selects which volume to mount for
recovering a file by mapping the saved files to their volumes.
Each entry in the client file index includes this information for a backed-up file:
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◆

Filename

◆

Number of blocks

◆

Access permissions

◆

Number of links

◆

Owner

◆

Group

◆

Size

◆

Last modified time

◆

Backup time
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The online indexes grow with each backup, as entries are added for each newly
backed-up file and save set. As long as an index entry for a file remains in the client
file index, you can recover the file. Over time, the size of these indexes can grow very
large.
Note: If the file system that contains the indexes gets full, the NetWorker server is unable to
access the media database and is thus unable to access and recover data. Unless you configure
the server to control the size of the online indexes by using browse and retention policies, they
continue to grow until they exceed the capacity of the file system.

NetWorker uses browse and retention policies to manage the lifecycle of data, and to
automatically control the size of the client file index. “About browse and retention
policies“ on page provides information on policies.

Automated index activities
The NetWorker server performs these online index activities:
◆

Inserts entries in the client file index for each file saved during a backup. For each
new backup, the NetWorker server acquires more space from the file system for
the new entries.

◆

Removes entries and returns disk space to the operating system. The browse and
retention policies automatically determine when entries are removed from the
index.

You can also remove index entries manually by clicking Remove Oldest Cycle in the
Index Save Sets dialog box. “Removing the oldest save set cycles“ on page provides
more information.

Checking online indexes
Each time the NetWorker server starts, it uses nsrck -ML1 to perform a level 1
consistency check on the client file indexes. In some circumstances, this consistency
check will not detect corruption in the client file indexes. If you believe an index may
be corrupt, run a higher level check on the index, for example:
nsrck -L5

If the index is still corrupt, recover the index by using the procedure outlined in
“Recovering online indexes for a NetWorker server“ on page .
It is also good maintenance practice to periodically run the nsrck -F and nsrim -X
commands to check the integrity of the client and media indexes. The EMC NetWorker
Command Reference Guide or the UNIX man pages provide more information about
these commands.

Viewing information about the indexes
To view information about the indexes:
1. From the Administration window, click Media.
2. In the left pane, click Indexes. The right pane displays index information for all
clients of the server.
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Table 90 on page 456 identifies the index information displayed for each client.
Table 90

Indexes window information

Column

Description

Client Name

Names of the NetWorker clients that have been backed up by the current server.

Size

Amount of disk space currently allocated to the client file index. As the index size increases, the
allocated disk space automatically grows.

Index save sets
The Index Save Sets dialog box displays the save sets assigned to a particular client,
along with detailed information about each save set. It also includes an option to
remove old save set cycles.
Viewing client save set information
To view the information about client save sets:
1. From the Administration window, click Media.
2. Click Indexes.
3. Right-click the client whose save sets you want to view, then click Show Save
Sets. The Index Save Sets dialog box appears.
4. To view detailed information about a save set, click the save set name.
Table 91 on page 456 identifies the information in the Save Sets dialog box for each
save set.
Table 91

Index save sets dialog box information

Column

Description

Save Set Name

Name of the save set.

Size

Estimated amount of the index space used by the save set in the client file index.

Cycles

Number of backup cycles available for browsing. A cycle starts with a full backup and ends with the
next full backup, and includes any incremental and level 1–9 backups that occur between full backups.

SSID

Unique identification number of the instance of the save set.

Files

Number of files backed up during that instance.

Size

Size of the backup.

Time

Date and time of the backup.

Level

Level of the backup (full, incr [incremental], or 1-9)

“Reducing client file index size“ on page provides information about reducing the
size of the client file indexes by using the Remove Oldest Cycle button.
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Querying the media database
You can query the media database for information about save sets. Queries apply to
all complete, browsable save sets, not just those from the last 24 hours.
To query the media database:
1. From the Administration window, click Media.
2. Click Save Sets.
3. On the Query Save Sets tab, indicate the appropriate query parameters, then
click the Save Set List tab to run the query and view the results.
Note: If the query is unsuccessful, an Error dialog box appears indicating that no save sets
were found that matched the specified query. Click OK to close the dialog box.

You can also query the media database by using the mminfo -av command. The EMC
NetWorker Command Reference Guide or the UNIX man pages provide a complete
description of the mminfo command and its options.

Cross-checking client file indexes
By cross-checking, you can verify the consistency between the client file index and
the media database. If the NetWorker server finds entries in the client file index that
do not have corresponding entries in the media database, it removes the client file
index entries. This feature is useful, for example, if you perform an index operation
and the server crashes before the NetWorker server has completely updated the
indexes. Once the server is running again, cross-check to accurately update the online
indexes.
To cross-check a client file index:
1. From the Administration window, click Media.
2. Click Indexes.
3. Right-click the client with the index to cross check, then select Cross Check
Index.
The NetWorker server displays this prompt:
Cross-checking may take considerable time. Would you like to
cross-check
client_name?

4. Click Yes to continue. The NetWorker server displays a status box until the
cross-checking is complete.

Refreshing index information
Occasionally refresh the information in the Indexes tab, particularly if you are
connected to a server for a long period of time.
To refresh the index information:
1. From the Administration window, click Media.
2. Click Indexes.
3. From the View menu, select Refresh.
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Client file index locations
During the initial client setup, the NetWorker software normally designates a default
location for the client file index on the NetWorker server. This default location is:
◆

For UNIX: /nsr/index/client_name

◆

For Windows: <NetWorker_install_path>\index\client_name

However, you may need to designate a different index location when first
configuring a Client resource, or you might need to move the file index of an existing
client. These sections address these needs.
Designating the client file index location for a new client
To designate a nondefault client file index location when creating a new client:
1. From the Administration window, click Configuration.
2. Right-click Clients, then select New. The Create Client dialog box appears.
3. Click the Globals (2 of 2) tab.
4. In the Index Path attribute, enter the full path of the directory where the client file
index will reside.
5. For the remaining tabs, enter information as necessary to create the new client.
“Setting up a scheduled backup“ on page provides instructions.
6. Click Ok.
Changing the client file index location for an existing client
Note: To change the client file index location to a nondefault location for an existing client, you
must first move the index to its new location. “Moving a client file index“ on page provides
more information.

To change the client file index location to a nondefault location for an existing client:
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click the client with the client file index location to be changed, then select
Properties. The Properties dialog box appears.
4. Click the Globals (2 of 2) tab.
5. In the Index Path attribute, enter the full path of the directory where the client file
index now resides.
6. Click Ok.
7. (Optional) From a command prompt, run the nsrck or nsrls command and check
the output for any errors.
For example, to run nsrck on client jupiter, type:
nsrck -L6 jupiter

The resulting output will be similar to:
nsrck: checking index for 'jupiter'
nsrck: C:\nsr\indexes\jupiter contains 54 records occupying 7 KB
nsrck: Completed checking 1 client(s)
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Note: Depending on the size of the client file index, running either nsrck or nsrls can take a
considerable amount of time. Running the nsrck -L6 command, as shown in the example,
also checks the index for corruption.

If no problems are found, then all future client file index information is saved to
the new location.
Moving a client file index
You can move a client file index from its current location to a new location. For
example, if the size of the client file index is too large, you can move it to a location
with more space.
To move an existing client file index:
1. Ensure that no backup is currently running on the NetWorker server.
2. Copy the client file index from its current location to the new location. For
example:
• For Windows, copy <NetWorker_install_dir>\index\jupiter to
<new_location>\indexes\jupiter.
• For UNIX, type this line at a command prompt:
cp -rp /nsr/index/jupiter /new_location/indexes

3. Update the Index Path attribute of the Client resource to point to the new
location of the index. “Changing the client file index location for an existing
client“ on page provides instructions.

Managing the size of the online indexes
Over time, the size of the online indexes on the NetWorker server can become
prohibitively large. Reduce the size of these indexes by using the solutions suggested
in these sections.
Reducing client file index size
You can reduce the size of the client file indexes on the NetWorker server by using
one or more of these methods:
◆

Remove save sets that comprise the oldest backup cycle from the client file index.
“Removing the oldest save set cycles“ on page provides details.

◆

Delete volume-based entries from the client file index. “Deleting volume-based
online index entries“ on page provides details.

◆

Adjust the Browse Policy and Retention Policy attributes of clients backing up to
the NetWorker server to shorten the period of time that entries remain in the
client file indexes. This solution works only for client backups that occur after
you change these policy attributes.

◆

Modify the browse policy associated with a particular save set by using the
nsrmm -w command. Unless the associated save set contains a large number of
files, this method may not be a practical method to reduce the index size.
“Modifying the browse and retention policy on a save set“ on page provides
details.

If the size of the client file index for a client is still too large, consider moving the
location of the index. “Moving a client file index“ on page provides details.
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Reducing media database size
Reduce the size of media database on the NetWorker server by using one or more of
these methods:
◆

Remove volumes that contain recyclable save sets from the NetWorker inventory.
“Removing volume-based entries from the online indexes“ on page provides
details.
When a volume is removed from the media database, the entries associated with
that volume are removed from the media database and the online file index on
the client. If you select this option, you will still be able to recover the data on the
volume by using the scanner program.
Note: Very little disk space is gained by removing a media database entry. Leaving index
entries of a volume in the media database prevents the accidental labeling of another
volume with the same name.

◆

Recycle volumes that contain recyclable save sets. “Changing a volume’s mode“
on page provides details.
When a volume is recycled, the NetWorker server performs these procedures:
• Relabeling
• Deletion from the media database
• Reinitialization
Once a volume is recycled, its content cannot be recovered.
To increase the number of currently recyclable save sets, modify the retention
policy associated with the current media database by using the nsrmm -e
command. “Modifying the browse and retention policy on a save set“ on page
provides details.

◆

Compress the media database.“Compressing the media database“ on page
provides details.

Removing the oldest save set cycles
Client file index entries for a full save set cycle include the last full backup and any
dependent incremental or level saves. Removing the oldest cycle frees up disk space.
To remove the oldest save set cycles:
1. From the Administration window, click Media.
2. Click Indexes.
3. Right-click the appropriate client, then select Show Save Sets.
4. Select the save set with the oldest cycle to remove, then click Remove Oldest
Cycle.
5. When prompted, click Yes to confirm the removal.
After the Remove Oldest Cycle operation has finished, the statistics in the Index Save
Sets dialog box are updated to reflect the current state of the client file index.
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Removing volume-based entries from the online indexes
The main purpose of removing volume-based entries from the online indexes is to
eliminate damaged or unusable volumes from the NetWorker server. You can also
use this feature to reduce the size of the online indexes by purging index entries
associated with specific volumes.
Removing client file index entries
You can remove just the entries contained in the client file index by using the nsrmm
command. This changes the status of the browsable save sets to recoverable. At the
command prompt, enter:
nsrmm -d -P -S ssid

where ssid is the save set ID for the save set.
Use mminfo to determine the save set ID. At the command prompt, type:
mminfo -v -c client_name

The EMC NetWorker Command Reference Guide or the UNIX man pages provide
information on the nsrmm and mminfo entries.
When save sets are marked recoverable, users may no longer browse and recover
these files by using the NetWorker User program on Windows or the nwrecover
program on UNIX. The save set recover procedure must be used to recover data once
the client file index entries are removed. “Recovering by save set selection“ on page
provides details.
Removing client file index and media database entries
You can remove both the client file index and media database entries. This action
removes all traces of the volume from the NetWorker server. Remove a volume from
the media database only if the volume has been physically damaged and is unusable.
However, if you remove the database entries for a volume, and the volume is
undamaged, the data remains recoverable by using the scanner program.
“Recovering online indexes for a NetWorker server“ on page provides details.
Typically, do not remove both the client file index and media database entries at the
same time unless the volume is damaged or destroyed.
Note: The presence of a clone of the particular volume prevents the deletion of the volume
entry in the media database. This is because the NetWorker server accesses the cloned volume
rather than the original volume as needed. The entry of the volume in the media database is
never actually purged. Because of this functionality, removing volume entries from the media
database is not a particularly effective way to reduce index size.

Deleting volume-based online index entries
To delete volume-based entries from the online indexes:
1. From the Administration window, click Media.
2. Click Volumes.
3. Right-click the volume with the entry to delete from the online indexes, then
select Delete.
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4. Select one of these options to determine how volume entries will be removed:
• File and Media Index Entries. “Removing client file index entries“ on page
provides details about this option.
• File Index Entries Only. “Removing client file index and media database
entries“ on page provides details about this option.
5. Click Ok.
The NetWorker server first cross-checks the indexes before it purges a volume. As a
result, the volume might still appear in the Volumes window for a brief period of
time.
Deleting volume based index entries from the command line

You can also remove online index entries with the nsrmm program. To remove both
client file index and media database entries for a particular save set, enter this line at
the command prompt:
nsrmm -d -S ssid

To remove all information related to a particular volume, enter this line at the
command prompt:
nsrmm -d volume_name

Deleting deduplication save sets
“Deleting Avamar deduplication save sets“ on page provides information on
deleting deduplication save sets.
Compressing the media database
You can free up more space on the server by compressing the media database.
To compress the media database:
1. Delete the appropriate file:
• On Windows:
<NetWorker_install_dir>\mm\.cmprssd
• On UNIX:
/nsr/mm/.cmprssd

2. Type at the command prompt:
nsrim

Querying deduplication save sets using mminfo
“Querying Avamar deduplication save sets using mminfo“ on page provides
information on querying deduplication save sets.
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Updating NetWorker clients by using the software distribution feature
Use the software distribution feature to remotely distribute and update the
NetWorker software from a centralized NetWorker server to one or more NetWorker
clients.
You can update these NetWorker software packages on computers that have the
NetWorker release 7.3 or later client software already installed:
◆

Client

◆

Storage node

◆

Man pages

◆

NMO, NMSQL and NMExch NetWorker Application Modules

Note: The software distribution feature is not supported on HP Tru64 UNIX, IRIX, Mac OS X,
NetWare, Open VMS platforms, and cluster environments.

The software distribution feature can be used to:
◆

Manage the software repository.

◆

Inventory NetWorker software installed on NetWorker clients.

◆

Update NetWorker software packages on existing NetWorker clients.

◆

Monitor software distribution inventory and upgrade operations (only available
from the Software Administration Wizard).

Software distribution can be performed on the NetWorker client software using
either the Software Administration Wizard or the nsrpush command. The NetWorker
Installation Guide or the nsrpush man page provides information on how to update
the NetWorker client software.

Message log management
The NetWorker server stores the messages generated by the NetWorker server
daemons in a message:
◆

On Windows: <NetWorker_install_dir>\logs

◆

On UNIX: /nsr/logs

You can use environment variables and/or UNIX startup scripts to automatically
control the size of the log.
Note: In addition to controlling the log file size through variable settings and startup scripts,
excess logging of messages (for example, the repetition of authentication error messages) has
been reduced in the daemon log file.

Setting the UNIX startup script to trim log files
To modify the way that NetWorker services manage the NetWorker log files, the
NSR_MAXLOGSIZE environment variable can be set in the NetWorker startup script
before the line:
(echo 'starting NetWorker daemons:') > /dev/console

Updating NetWorker clients by using the software distribution feature
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Table 92 on page 464 lists the location of NetWorker startup scripts:
Table 92

NetWorker startup script location
Operating system

Startup script location

Solaris, Linux, and IRIX

/etc/init.d/networker

HP-UX

/sbin/init.d/networker

HP Tru64

/sbin/init.d/NSRstartstop

AIX

/etc/rc.nsr

Enter the environment variables by using the format (bourne shell example):
ENV_VAR_NAME=value
export ENV_VAR_NAME

These environment variables can be used to trim log files at startup:
◆

To change the maximum size of log files, change the NSR_MAXLOGSIZE value.
The default value for NSR_MAXLOGSIZE is 1048576 bytes.

◆

To change the maximum number of log files that are saved, change the
NSR_MAXLOGVERS value. The default value is 4.
For example:
NSR_MAXLOGVERS=3
export NSR_MAXLOGVERS
NSR_MAXLOGSIZE=524288
export NSR_MAXLOGSIZE

Restart the NetWorker server for the environment variables to take effect.
Every time the NetWorker server starts, it checks the size of the daemon log file.
When the daemon log file reaches the size defined in NSR_MAXLOGSIZE or the
default size of 2 MB, the following occur:
1. The existing daemon.raw log file is renamed daemon_<date_time>.raw and a
new empty daemon.raw log file is created.
2. This process is repeated until the value in NSR_MAXLOGVERS is reached, at
which point the oldest log is removed.
Note: The trimming mechanism functions only when you start nsrd on UNIX or the
NetWorker Backup and Recover Server service on Windows. The daemon and service do not
check periodically to determine if the log file has exceeded NSR_MAXLOGSIZE. If the nsrd
daemon or NetWorker Backup and Recover Server service runs for a long time, the log file can
still grow very large.

To activate the trimming mechanism:
◆

On UNIX, enter nsr_shutdown to stop the NetWorker daemons, and then use the
NetWorker startup script to restart the daemons.

◆

On Windows, stop and restart the NetWorker Backup and Recover Server service.

The EMC NetWorker Command Reference Guide or the UNIX man pages provide
information about the nsr_shutdown command and its options.
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Savegroup job information
By default, when a group is backed up, details of the corresponding savegroup’s
child jobs are temporarily saved to files in the following location,
NetWorker_install_dir\nsr\tmp\sg\savegroup_name. There is no easy way to
associate the output of a savegroup’s child jobs with the parent savegroup job.
Additionally, these output files were overwritten when the group is next backed up.
Beginning with NetWorker 7.5, you can specify that the details of a savegroup’s child
jobs be saved in files that are named according to the child job ID. These files are
saved to, NetWorker_install_dir\nsr\logs\sg\savegroup_name\Job_ID where Job_ID
is a file whose name corresponds to a savegroup child job ID.
To help locate and retrieve information about a savegroup’s child jobs, use the
jobsquery command to search the NetWorker jobs database. The man pages or the
EMC NetWorker Command Reference Guide provide more information.
To have savegroup child logs saved by job ID:
1. In the Administration window, click Configuration.
2. In the left pane of the Configuration window, select the NetWorker server.
3. From the File menu, select Properties.
4. Select the Configuration tab.
5. Select the Savegroup log by job id attribute.
6. Click Ok.
Note: When the Savegroup log by job id attribute is enabled, the job files saved to
NetWorker_install_dir\nsr\logs\sg\savegroup_name will be purged based on the settings
in the NetWorker server attributes named, Jobsdb retention in days and Jobsdb maximum

size (KB).

Internationalization
NetWorker releases 7.4 and later have been internationalized. As a result, the
NetWorker software now supports language packs, which can be installed as part of
the NetWorker installation, or can be installed separately after the NetWorker
software has been installed. The NetWorker Installation Guide provides more
information.
Internationalization support in the NetWorker software is dependent on the
underlying operating system's internationalization support. If you are planning on
using non-English data in the NetWorker software, make sure the appropriate
support for that language has been installed and configured on the operating system.
There are a number of issues and limitations related to the use of NetWorker software
in a multi-language environment, which are addressed in the following sections.

Log file viewer

NetWorker log files must be viewed using the nsr_render_log program. “Viewing
log files“ on page provide more information.

Savegroup job information
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Interoperability with previous releases of NetWorker
Multiple locales within the same datazone are fully supported only if all NetWorker
installations in the datazone are at release level 7.4. The following limitations apply:
◆

In datazones with a NetWorker release 7.3 server and NetWorker 7.4 clients,
support for scheduled backups of path or filenames containing non-ASCII
characters is limited to the support provided by NetWorker release 7.3.

◆

Binaries from releases earlier than 7.4 may not correctly display UNIX save sets
containing non-ASCII characters.

Display issues
There are number of issues and limitations associated with displaying characters in
various locales.
Character display at the command line
From the command line, characters supported by the current locale display correctly.
Characters not supported by the user’s current locale will display incorrectly. For
Microsoft Windows systems, if the user and system locales do not match, characters
supported in the user locale but not the system locale may not be displayed correctly.
Character display in graphical user interfaces
Character display from within NetWorker graphical user interfaces varies depending
on the platform on which the graphical user interface is running:
◆

Microsoft Windows:
• Any Unicode encoded data will be displayed correctly.
• When viewing UNIX path and filenames, path and filenames created by using
a character set supported by the current locale or UTF-8 will be displayed
correctly. Paths created by using another character set may not display
correctly. Because Microsoft Windows does not have native support for many
character sets used on UNIX (for example, euc-jp, euc-cn and euc-tw), if a
non-ASCII character is encoded by using these character sets, it will not be
displayed correctly on Microsoft Windows.

◆

UNIX and Linux:
• Characters not supported by current locale may not be displayed correctly.

◆

Mac OS X
• Because of differences in Unicode support, non-ASCII paths and filenames on
Mac OS X machines may not display correctly when browsing the filesystem
from a non-Mac platform.

Maximum path and save set length
For the NetWorker software, the maximum supported length for a pathname is
twelve kilobytes, and the maximum length for a save set name is 1024 bytes. The
number of characters allowed by each of these limits will vary depending on the
locale.
All operating systems have an internal limit for path and filenames. The limit varies
depending on the operating system and file system being used. Typically, the
pathname component size is 256.
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For UNIX and Linux, only the path component length is checked against the limit. As
a result, it is possible to create a path and filename that is greater than the limit
supported by the operating system, but an attempt to access this path will result in a
failure.

Group completion messages
Group completion messages displayed in the NetWorker console, displayed either
through the Group details, Group status, or monitoring, will be displayed in the
language used by the NetWorker server that generated the message.

Locale-specific configuration issues on UNIX/Linux
This section describes certain configuration issues related to Client and Archive
Request resources for clients that run in UNIX/Linux environments.
Configuring the Save Set attribute for Client and Archive Request resources
For clients that run on non-ASCII locales on UNIX and Linux platforms, or for clients
on Microsoft Windows that are being configured from UNIX hosts that use
non-ASCII locales, special considerations apply when typing a path or filename in the
Save Set attribute for Client or Archive Request resources. The path or filename must
be entered in the locale that was used when the path or file was created. If you enter a
path or filename by using a locale other than the one that was used when the path or
file was created, subsequent backups will fail with the following error message:
No such file or directory

To configure a Client resource in this situation, either:
◆

Use the All keyword for the Save Set attribute.

◆

Log into a client host by using the correct locale, and configure the client from this
machine.

Client resources with multiple locales on UNIX/Linux
To back up a UNIX or Linux machine that contains path or filenames with multiple
locales, you must create a separate Client resource for each locale.
For example, to configure a multi-locale UNIX machine with data in both Japanese
and French, you must create two different Client resources, one defining the save sets
for the Japanese data, another defining the save sets for the French data.
“Multiple clients from the same computer“ on page has information about creating
multiple clients.
Locale settings with NDMP
When running NDMP backups, the locale setting has to be consistent in your
environment. All UNIX flavored locale settings on the filer (including UTF-8) must be
the same and the NMC client can be run only on a UNIX client set to the exact same
locale setting as the filer.
Backup and recovery operations can be run on any locale, but if you try to browse on
a locale that is different from the original locale the filenames appear as random
characters.

Internationalization
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NetWorker Client
Management

This chapter covers these topics :
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆

NetWorker client overview........................................................................................
Client configuration ....................................................................................................
Creating a client probe................................................................................................
Associating a probe with a Client resource .............................................................
Configuring a client for BMR support .....................................................................
Lockbox pass phrase management...........................................................................
NetWorker authentication..........................................................................................
Multiple clients from the same computer................................................................
Scheduled backups of non-ASCII files or directories ............................................
Adding or changing the NetWorker servers for a client .......................................
Client priority ..............................................................................................................
Dedicated client/server interface for backup and recover operations ...............
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NetWorker client overview
A NetWorker client is both a physical computer with NetWorker client software
installed on it, and a NetWorker server resource that specifies a set of files and
directories to be included in a scheduled backup. As such, a single NetWorker client
computer can have several Client resources specified that can back up to the same or
even different NetWorker servers.
“Defining a client and save set combination” on page 485 further explains concept of
a client computer with multiple NetWorker Client resources.
NetWorker client software is available for a variety of platforms. No matter which
platform the client resides on, it can be backed up to any NetWorker server. For
example, you can back up a NetWorker client on a Microsoft Windows computer to a
NetWorker server on a Solaris computer.

Client configuration
Before a client can be backed up by a NetWorker server, the client computer must
have the appropriate NetWorker client software installed. The NetWorker Installation
Guide provides more information.

Creating a client
NetWorker client creation is part of the process of creating a scheduled backup.
“Setting up a scheduled backup” on page 55 provides information on how to create a
client.

Editing a client
Use this procedure to change Client resource attributes. You cannot change the name
of a client with this procedure. “Changing a client name” on page 471 provides
information on how to change a client name.
To edit a client:
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click a client, then select Properties. The Properties dialog box appears,
with the General tab displayed.
4. Edit the attributes of the client, then click OK.

Copying a client
Use this procedure to copy Client resource attributes.
To copy a client:
1. From the Administration window, click Configuration.
2. Click Clients.
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3. Right-click a client, then select Copy. The Create Client dialog box appears. By
default, the new client retains the information from the client that was copied,
except the Name attribute, which is blank.
4. Enter the name for the new client and edit other attributes as appropriate, then
click OK.

Changing a client name
The only way to change the name of a client is to re-create the client.
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click the client to be renamed, then select Properties. The Properties dialog
box appears.
4. Click the Globals (1 of 2) tab.
5. Record the Client ID attribute listed for the client, then click Cancel to close the
Properties dialog box.
6. Delete the original client from the Administration window. See “Deleting a
client” on page 471.
7. Stop all NetWorker services.
8. On the NetWorker server that backs up this client, rename the directory
containing the client file index for this client from old_client_name.domain.com to
new_client_name.domain.com. The default location for the client file index is:
• For UNIX/Linux:
/nsr/index/client_name.domain.com

• For Microsoft Windows:
<NetWorker_install_path>\index\client_name.domain.com
9. Restart the NetWorker services.
10. Create a new client, making sure that you enter the client ID that you recorded in
step 5 in the Client ID attribute of the Globals (1 of 2) tab of the Create Client
dialog box. “Setting up a scheduled backup” on page 55 provides instructions on
how to create a client.

Deleting a client
When a client is deleted, the NetWorker server can no longer back up or recover files
from the client computer. The backup history for the client remains in the client file
index and media database until the entries are removed.
To delete a client:
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click the client to be deleted, then select Delete.
4. When prompted, click Yes to confirm the deletion.
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Note: Even if you delete a client from the NetWorker server, the previously backed-up data
from the client is still accessible and recoverable directly from the volume that contains the data
by using the scanner command.

Recovering a deleted client
To recover a deleted client, create a new client, making sure that you enter the name
of the deleted client in the Name attribute on the General tab of the Create Client
dialog box. “Task 6: Create a backup Client resource” on page 59 provides
instructions on how to create a client.
The NetWorker server recalls the client ID for this name and inserts it into the Client
ID attribute on the Globals (1 of 2) tab of the Create Client dialog box.

Editing a client NSRLA database
The NSRLA database contains a NetWorker resource, called the NSRLA resource,
which has attributes that apply to the client, such as the Disable Directed Recover
attribute. In some cases, it may be necessary to edit the NSRLA resource. The NSRLA
resource can be edited by using the character-based nsradmin program.
Note: “Enabling directed recoveries” on page 331 provides information about permissions for
directed recoveries and the Disable Directed Recover attribute in the NSRLA resource.

To edit the NSRLA database:
1. Log in as root or as Windows Administrator on the NetWorker client.
2. Type this at the command prompt:
nsradmin -p nsrexec

The nsradmin prompt appears.
3. To determine the current settings for attributes in the NSRLA resource, perform
the following two steps:
a. To determine the current settings for any hidden attributes (such as the
Disable Directed Recover attribute), type the following at the nsradmin
prompt:
option Hidden

b. To display attributes, type the following:
print type:NSRLA

4. To change the value of attributes in the NSRLA resource, type this line at the
nsradmin prompt:
update attribute:value;

For example, to update the Disable Directed Recover attribute, type:
update disable directed recover:Yes

5. Type Yes when prompted to confirm the change.
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Note: When modifying an attribute with the nsradmin program, the attribute name and value
must be specified correctly. If the attribute name and value are not specified correctly, the
attribute is not updated. No error message is provided.

Restricting access to view the client NSRLA database
By default, a UNIX root user on any host can view the NSRLA database on any UNIX
NetWorker client. In the same way, any Windows administrator can view the NSRLA
database settings on any Windows NetWorker client. You can restrict access so that
only the root (UNIX) or Administrator (Windows) on the local host can view the
NSRLA database.
To restrict the ability to view the NSRLA database:
1. Log in as root or as Windows Administrator on the NetWorker client.
2. Type the following at the command prompt:
nsradmin -p nsrexec

The nsradmin prompt appears.
3. Determine the current settings for the attributes in the NSRLA resource:
print type:NSRLA

By default the Administrator attribute will look similar to the following:
Windows
administrator: Administrators, "group=Administrators,host=saturn";

UNIX
administrator: root, "user=root,host=saturn";

4. Change the value of the Administrator attribute to remove the single
Administrators or root value:
Windows
update administrator: “group=Administrators,host=this_host"

UNIX
update administrator: "user=root,host=this_host"

where this_host is the name of the local host.
5. Type Yes when prompted to confirm the change.
Now, only the Windows Administrator or root on the local host can view the
NSRLA database.

Creating a client probe
Note: Users are responsible for creating and supporting user defined probes.

To create a client probe:
1. From the NetWorker Administration window, click Configuration.
2. Right-click probes, and select New. The Create NSR probe window opens.
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3. Type the name of the probe in the Name: field.
4. (Optional) Include details for the probe script in the Comment: field.
5. Type the name, and path of the probe script in the Command: field. The probe
resource script must be placed in the same directory as the nsr binaries for each
client referencing the probe. For example, /usr/sbin on Solaris and Linux. The
NetWorker Installation Guide provides details on default installation paths for all
operating systems.
A user defined probe is any program which passes a return code. Return codes
are interpreted by NetWorker as follows:
• Return code 0: backup is required
• Return code 1: backup is not required
• All other return codes are interpreted as errors during probe execution, and
backups are not taken
Note: The probe script name must begin with save, or nsr.

6. Associate the probe with a Client resource as described in “Associating a probe
with a Client resource” on page 474.
Note: The Command Options: field is applicable to NetWorker Module probes only.

Associating a probe with a Client resource
To associate a probe resource with a Client resource:
1. Click Clients, and right-click the client in the Configuration screen of the
NetWorker Administration window.
2. Select Properties, and the Properties window opens.
3. In the Apps & Modules tab, select the probe from the Probe resource name: list.
All defined probe resources appear in the list. If the list is empty, then probe
resources were not defined. “Creating a client probe” on page 473 provides
details on creating a probe resource.
Note: Each client in a group can have a probe associated with it, but a probe is not required.
However, a probe-based backup group must have at least one probe-enabled client associated
with it. If a single probe is referenced by multiple clients, make sure that the probe resource
script is in the same directory as the NetWorker binaries for each of the clients referencing the
probe.

Configuring a client for BMR support
The HomeBase Agent is automatically installed with the NetWorker client. After
enabling communication with a HomeBase Server, configure a NetWorker client or
start by editing an existing client. “Configuring a client for BMR support” on
page 655 provides detailed instructions.
Note: A HomeBase Agent license batch code is required to enable the client to generate profiles
and send them to the HomeBase Server. Contact your EMC HomeBase representative for
licensing information.
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Lockbox pass phrase management
The NetWorker server provides NetWorker modules, and certain NetWorker features, such as
AES encryption, with the ability to securely store and retrieve passwords over a network.
To use the lockbox pass phrase management feature for a NetWorker module:
1. Log in as root, or as Windows administrator on the NetWorker server.
2. In the client NetWorker Administration window, click the Configuration tab.
3. Right-click Lockboxes, and select New. The Create NSR Lockbox window opens.
4. Type a name in the Name: field.
5. Type the users that will have permission to store, retrieve, and delete passwords in the
Users: field. Use the user@destination_client or user@hostname format when listing users.
6. Verify that the lockbox is listed in the NetWorker Administration window.

Set the Datazone pass phrase for a NetWorker server
“Set the Datazone pass phrase for a NetWorker server” on page 77 provides information on
how to set the Datazone pass phrase on a NetWorker server.

Set the Remote access attribute for NetWorker client resource when lockbox is created for a
NetWorker server on a cluster
If a lockbox is created for a NetWorker server configured on a cluster, the following step must
be performed in order for the lockbox to work on the cluster node the NetWorker server is
running on:
◆

The Host section for the NetWorker client resource's remote access attribute must list the
names of all the cluster nodes. The values of the names must be in the following form:
• For UNIX cluster nodes, use the hostname command output
• For Windows cluster nodes, use the full computer name (go to Control Panel >
System > Computer name to get the full name)

Note: The lockbox can be created prior to or after performing this step.

This configuration must be performed during the initial startup of the virtual NetWorker
server (that is, before the virtual server fails over to the other cluster). Otherwise, the lockbox
will have to be deleted and then re-created.

Error messages and error handling for the Datazone pass phrase
The following messages are written to the daemon.log file if an error occurs during the
encryption, or decryption of the Datazone pass phrase:
◆

Encryption error:
Error encrypting key. Erasing datazone pass phrase.

The Datazone pass phrase is saved as a blank phrase.
◆

Decryption error:
Error decrypting key. Erasing datazone pass phrase for current use.
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A blank pass phrase is used in place, allowing any backup requiring a key to
continue by using the default key.

NetWorker authentication
This section describes how to configure authentication between NetWorker hosts.
This section also includes special considerations for authentication.
Two types of authentication are supported for NetWorker hosts:
◆

nsrauth

◆

oldauth

Strong authentication (nsrauth)
The nsrauth authentication mechanism (enabled by default) is strong authentication
that is based on the Secure Sockets Layer (SSL) protocol, which is provided by the
OpenSSL library. NetWorker hosts and NetWorker user permissions are
authenticated by using nsrauth. The nsrauth authentication mechanism is available
for hosts that run NetWorker software release 7.3 or later.
Each NetWorker host has a nsrexecd service, which provides authentication services.
Each nsrexecd has its own private key and self-signed certificate for authentication.
The private key is generated by nsrexecd when it starts up or one can be loaded from
a file. The corresponding self-signed certificate is generated by the private key. The
private key is RSA and is 1024 bits in length. The encryption method that is used once
an SSL session is set up is AES-128. The session information sent over the SSL
connection includes:
◆

Session keys

◆

Session ID

◆

User's information

◆

User's NetWorker permissions

Authentication for backwards compatibility (oldauth)
For compatibility with earlier NetWorker releases, oldauth authentication is
supported. If two hosts cannot authenticate by using strong authentication (nsrauth),
you can enable authentication by using oldauth. One can specify the minimum
authentication strength that is allowed for any host relationship. “Specifying the
minimum authentication strength between hosts” on page 477 provides more
information.

Access privileges for authentication configuration
This section describes how to set up access privileges to maintain nsrauth strong
authentication configuration settings.
The Console server must have permission to update resources on each NetWorker
host whose authentication information will be updated:
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To grant authentication update privileges to the Console server:
1. Log in as root or as Windows administrator on the NetWorker host whose
authentication information will be updated.
2. Type the following at the command prompt:
nsradmin -p nsrexec
The nsradmin prompt appears.
3. For each of the following resources:
• NSRLA
• NSR Peer information
• NSR system port ranges
Complete the following steps:
a. Determine the current settings for the attributes in the resource:
print type:resource_name

b. Change the value of the Administrator attribute in the resource:
update administrator:current_values,"user=Console_user,host=
Console_host"

where:
– current_values are the values that are currently listed for the resource’s
Administrator attribute.
– Console_user is the user ID of the Console user.
– Console_host is the name of the Console host.
c. Type Yes when prompted to confirm each change.

Specifying the minimum authentication strength between hosts
You can specify that only certain authentication methods be allowed between specific
hosts. For example, one could specify:
◆

That a NetWorker release 7.3 or later server be allowed to authenticate with
legacy NetWorker clients by using oldauth.

◆

That all other NetWorker release 7.3 or later clients must use only nsrauth Strong
authentication (enabled by default).

The Console server user must have permission to update authentication resources.
“Access privileges for authentication configuration” on page 476 provides more
information.
To specify the authentication strength between NetWorker hosts:
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, right-click the host with the authentication
relationships to be configured and select Configure Local Agent.
4. Select the Advanced tab.
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5. In the Auth Methods attribute, at the top of the list enter the minimum allowable
authentication strength for the NetWorker hosts that will connect to this host.
Type values in this format:
clientgroup_or_host,auth_strength
where:
• clientgroup_or_host is either an IP address that represents a group of hosts or an
explicit hostname. For example:
– pluto.company.com - An explicit NetWorker client name.
– 10.102.0.0/255.255.0.0 - A subnet IP address representing all NetWorker
clients on the subnet. Alternatively, you could type this value as
10.102.0.0/16.
– 0.0.0.0/0 - This value represents all clients in the domain,
• auth_strength is the authentication strength. The allowable values are:
– nsrauth - Use strong authentication only.
– oldauth - Use oldauth authentication only.
– nsrauth/oldauth - Attempt to use strong authentication. If strong
authentication fails, use oldauth authentication.
For example, if all hosts must use only strong authentication, enter:
0.0.0.0/0,nsrauth
IMPORTANT
The order in which values appear in the Auth Methods list is important. The first
client match found starting from the top of the list is the authentication value used.
For example, to specify strong authentication for all clients except for one, ensure
that the explicit entry for the single client appears at the top of the list before the
more general entry that represents all clients in the domain. If no matches are
made, authentication defaults to 0.0.0.0/0, nsrauth, which means that all clients can
only authenticate by using nsrauth. “Enforcing strong authentication on selected
hosts” on page 478 provides details.
6. Click OK.
7. Restart the NetWorker services for the host with the authentication relationships
to be configured. “Stopping and starting a NetWorker server, client, or storage
node” on page 51 provides information about restarting NetWorker services.
Example 38 Enforcing strong authentication on selected hosts

In this example, a NetWorker release 7.3 server has both release 7.3 clients and legacy
clients. The requirement is to ensure that the release 7.3 clients authenticate by using
only nsrauth strong authentication, while the legacy clients authenticate by using
oldauth authentication.
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, right-click the NetWorker server and select Configure
Local Agent.
4. Select the Advanced tab.
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5. In the Auth Methods attribute, type the two legacy hostnames, for example:
jupiter.company.com, nsrauth/oldauth
pluto.company.com, nsrauth/oldauth
In this example, two legacy hosts identified as jupiter.company.com and
pluto.company.com are allowed to use oldauth authentication to ensure backwards
compatibility. All other hosts use only strong authentication (nsrauth).
6. To specify that all other hosts must use strong authentication, type this value at
the bottom of the list in the Auth Methods attribute:
0.0.0.0/0, nsrauth
The entries in the list should now be ordered as follows:
pluto.company.com, nsrauth/oldauth
jupiter.company.com, nsrauth/oldauth
0.0.0.0/0, nsrauth

The more explicit entries, those that identify a single client, are at the top of the
list. The first matching entry, starting from the top of the list, is the entry used to
specify a host’s authentication strength.
7. Click OK.
8. Restart the NetWorker services for the NetWorker server. “Stopping and starting
a NetWorker server, client, or storage node” on page 51 provides information
about restarting NetWorker services.

Maintaining NetWorker local host authentication credentials
Each NetWorker host that uses nsrauth strong authentication has unique credentials
that are used to identify itself to other NetWorker hosts during the nsrauth strong
authentication process. These credentials are known as local host authentication
credentials.
Additionally, each NetWorker host maintains a copy of the local host credentials that
belong to every NetWorker host to which it has authenticated. These credentials are
maintained as part of the local host’s Peer resources.
You can export, import, or create new credentials for a local host. You can also delete
and import host credentials in Peer resources. In most cases, you do not need to
perform any of these maintenance tasks. However, there are some cases in which you
may need to perform these tasks. These examples provide some scenarios in which
these maintenance tasks might be performed.
Note: To complete the procedures in this section, the Console server user must have
permission to update authentication resources. “Access privileges for authentication
configuration” on page 476 provides details.

Example 39 Securing the initial peer host authentication process

When two NetWorker hosts authenticate with each other, no user intervention is
required. Each host keeps a copy of the other host’s authentication credentials in a
Peer resource. The copy is created the first time the hosts authenticate with each
other. Subsequent authentication attempts are verified by matching the host with the
authentication credentials stored in the Peer resource.
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To eliminate the possibility that an attacker could compromise this process, manually
update the Peer resource with authentication credentials rather than have this occur
automatically.
For example, suppose that the NetWorker server jupiter will authenticate with the
NetWorker client pluto.
To manually update the Peer resources:
1. Export authentication credentials.
a. Export authentication credentials for jupiter to a file.
b. Export authentication credentials for pluto to a file.
“Exporting local host credentials” on page 481 provides information about
exporting authentication credentials.
2. Create a Peer resource for pluto on jupiter:
a. Open the credentials file for pluto. Refer to this file in these steps.
b. From the View menu in the Administration window, select Diagnostic
Mode.
c. Open the Local Hosts folder.
d. From the Local Hosts list, click jupiter.
e. Right-click and select New.
f. In the Name attribute, enter the Name value from the credential file.
g. In the Instance ID attribute, enter the NW Instance ID value from the
credential file.
h. In the Peer Hostname attribute, enter the My Hostname value from the
credential file. For example:
certificate:\
"-----BEGIN CERTIFICATE---------END CERTIFICATE-----";
my hostname: pluto.company.com;
name: pluto.company.com;
NW instance ID:
d9b61002-0004-fe5c3a37-42d5a842-00010000-8945657f;
private key:\
"-----BEGIN RSA PRIVATE KEY---------END RSA PRIVATE KEY-----";

i. Click OK. A Peer resource for pluto is created.
3. Create a local host certificate file for pluto. “Creating a local host Peer resource
certificate” on page 483 provides details.
4. Load the certificate for pluto into the Peer resource:
a. Right-click the Peer resource for pluto and select Properties.
b. From the Change Certificate attribute list, select Load certificate from file.
c. In the Certificate file to load attribute, enter the path and name of the
certificate file and the click OK.
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5. Repeat steps 2 through 4 to create a Peer resource for jupiter on pluto.
Example 40 Local host credentials are exported

In most cases, local host credentials are retained. For example, when the NetWorker
software is uninstalled and reinstalled. However, in some cases, such as with
unexpected data loss or corruption, new local host credentials may need to be
re-created.
Creating new local host credentials can be time-consuming, because Peer resources
on all NetWorker hosts that authenticate with the local host must be updated with
the new local host credentials. To avoid these updates and to save time, export the
local host credentials to a file for safekeeping. If necessary, re-import local host
credentials.
In this example, the user can either create new local host authentication credentials or
save the existing credentials to a file and re-import the credentials at a later time. To
save time and simplify the procedure, the user chooses to export the local host
credentials to a file so that the credentials can be re-imported, if necessary.
To complete this scenario:
1. Export the local host credentials to a file. “Exporting local host credentials” on
page 481 provides details.
2. An event occurs in which the local host credentials are lost.
3. Re-import the host credentials to the local host mentioned in step 1 . “Importing
local host credentials” on page 482 provides details.
There is no need to update Peer resources because the local host authentication
information was recovered from the file that was exported in step 1 .
Example 41 Local host credentials are not exported

This scenario is similar to “Local host credentials are exported” on page 481, except
that the local host credentials were not exported before an event such as the
corruption of local host credential data. In this scenario, you must create new local
host credentials and then delete all existing Peer resources for the local host.
To complete this scenario:
1. Create new local host credentials for the NetWorker host. “Creating new local
host certificate keys” on page 482 provides details.
2. Delete all peer certificates that are set up for the NetWorker host whose
credentials were created in step 1 . “Deleting NetWorker local host Peer
resources” on page 483 provides details.
Exporting local host credentials
To export local host credentials:
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, right-click the NetWorker server and select Configure
Local Agent.
4. Select the Advanced tab.
5. From the NW Instance Info Operations attribute list, select Export.
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6. In the NW Instance Info File attribute, enter a directory and name for the
credential file.
7. Click OK. A credential file is saved to the location specified.
Importing local host credentials
Note: On UNIX platforms, the credential file that is imported in this procedure must be set to
read and write permission for root only. For example:
chmod 600 certificate_name

To import local host credentials:
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, right-click the NetWorker server and select Configure
Local Agent.
4. Select the Advanced tab.
5. From the NW Instance Info Operations attribute list, select Import.
6. In the NW Instance Info File attribute, enter the directory and name for the
credential file to be imported.
7. Click OK.
The credential file will be imported from the location specified.
Creating new local host certificate keys
To create new local host certificate keys:
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, right-click the NetWorker host and select Configure
Local Agent.
4. Select the Advanced tab.
5. From the NW Instance Info Operations attribute list, select New Keys.
6. Click OK. A new certificate will be created for the NetWorker host.
7. On all other local host resources, delete the Peer resource that was set up for the
NetWorker host whose certificate was changed in this procedure. “Deleting
NetWorker local host Peer resources” on page 483 provides details.
Note: Consider exporting the new certificate information to a credentials file. “Local host
credentials are exported” on page 481 provides information about the benefits of doing so.

Maintaining local host Peer resources
Each NetWorker host has unique authentication credentials that are used during the
nsrauth strong authentication process. These credentials include certificate
information.
Each NetWorker host retains a record of the certificate of all NetWorker hosts to
which it has successfully authenticated. These records are maintained as part of each
NetWorker host’s Peer resource database.
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Deleting NetWorker local host Peer resources
When the credentials for a NetWorker host change, so does its certificate. All hosts
that have previously authenticated with the changed NetWorker host must be
configured to accept the changed certificate.
Otherwise, authentication will fail because the changed certificate is no longer
recognized.
For example, host A authenticates with host B. Host B will have a Peer resource for
host A, which contains certificate information. Now the credentials for host A change.
Host B will no longer recognize host A and authentication will fail. To solve this
problem, delete host B’s Peer resource for host A. The next time host A attempts to
authenticate with host B, a new Peer resource will be created on host B and
authentication will succeed.
To delete a local host Peer resource:
1. From the Administration window, click Configuration.
2. Open the Local Hosts folder.
3. From the Local Hosts list, click the NetWorker host whose Peer resource must be
deleted.
4. Right-click the Peer resource that corresponds to the NetWorker host whose
credentials were changed, then select Delete.
Creating a local host Peer resource certificate
To update certificate information for a local host Peer resource, delete the existing
Peer resource or update the Peer resource with a certificate from a file. Before you
load the certificate from a file, create the certificate as described in this section.
To create a Peer local host certificate:
1. Export the local host credentials file for the NetWorker host whose credentials
have changed, if this has not already been done. “Exporting local host
credentials” on page 481 provides details.
2. With a text editor that is compatible with UNIX text files, open the credential file
and copy and save the certificate information to a new file. Ensure that the new
file is saved in a UNIX text-file format.
In this sample credential file, copy the information between the begin certificate
and end certificate comments:
certificate:\
"-----BEGIN CERTIFICATE-----

MIIB9...
-----END CERTIFICATE-----";
my hostname: pluto.company.com;
name: pluto.company.com;
NW instance ID: d9b61002-0004-fe5c3a37-42d5a842-00010000-8945657f;
private key:\
"-----BEGIN RSA PRIVATE KEY----MIICW...
-----END RSA PRIVATE KEY-----";
type: NW instance Information;
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resource identifier: 1.0.21.1.139.45.65.23.121.56.111.101(1)

This file can now be loaded into all of the Peer resources that exist for the
NetWorker host whose credentials have changed. “Securing the initial peer host
authentication process” on page 479 provides details.

Creating a custom certificate and private key for a host
NetWorker automatically creates certificate and private keys for each NetWorker
host. However, it is possible to create certificate and private key information for a
host manually. One may want to do this in special cases such as when a company
mandated policy stipulates that certificate and private key information must be
generated on a single host that has a trusted random number generation utility. The
certificate and key information can then be transferred from the trusted host to other
hosts within the enterprise.
To create custom certificate and private key information for a host:
1. On the host that is being used to create the custom certificate and private file, type
this command:
nwinstcreate -ix
Complete the remaining screen prompts as appropriate. The EMC NetWorker
Command Reference Guide or the UNIX man page provide more information about
nwinstcreate.
2. On the host for which the custom certificate and private key file was created,
place the file in the following directory:
NetWorker_install_path\nsr\res

a. On Windows hosts, you must give read, write, and modify privileges for the
custom certificate and private key file to the Windows Local System Account
(SYSTEM).
On Windows, NetWorker services such as nsrexecd, are run with SYSTEM
privileges. By default, NetWorker services do not have adequate privileges to
read and write the custom certificate and private key file.
b. Ensure that the NetWorker client service, nsrexecd, is started on the host.
“Stopping and starting a NetWorker server, client, or storage node” on
page 51 provides information about verifying and starting NetWorker
services.
c. Start the nsradmin program:
nsradmin -p nsrexec

The nsradmin prompt appears.
d. Type this command:
. type: nsrla

e. Import the custom certificate and private key file:
update nw instance info operations: import;
nw instance info file: NetWorker_install_path\nsr\
res\certificate_file

f. Enter Yes when prompted to confirm the update.
The custom certificate and private key information will be used for the host.
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Multiple clients from the same computer
The NetWorker server identifies each of its clients by the client computer name.
To provide optimal flexibility, the server lets you define multiple Client resources for
the same computer, with the same computer name, provided that one of these is true:
◆

Each client save set is unique.

◆

Clients are included in different backup groups.

◆

Clients are associated with different schedules.

◆

Clients are associated with different browse and/or retention policies.

For example, looking at a list of configured NetWorker clients, you might see several
instances of a client named mars. But each instance would contain a unique collection
of save sets or would be configured differently regarding groups, schedules, or
policies.
Defining multiple clients from the same computer or file system can be useful for
backing up specialized files, such as databases. You can use the Comment attribute in
the Client resource to help distinguish between multiple Client resources with the
same name.

Redefining a file system into multiple client and save set instances
If a client has a large volume of data, you can schedule the client computer for
several, separate client and save set backups. By redefining a large file system into
multiple client and save set instances, you are able to:
◆

Automatically back up a large client file system.

◆

Balance the load by avoiding a full backup of the entire file system at one time.

You can then associate each client and save set instance with a different backup
group and/or a different schedule. Associating different client instances with
different backup groups varies the start time of the backups. Staggering the start
times in this way may achieve the load balancing needed.
If different backup start times do not reduce the load adequately, you can associate
the different client and save set instances with different backup schedules. Recall that
a client’s schedule determines the level of backup (if any) that is run on a particular
day. By using different schedules, you can specify that each client and save set
instance run its full backup on a different day of the week. “Schedules” on page 140
provide more information on schedules.

Defining a client and save set combination
The same save set can appear in the Save Set attribute of the Client resource for
multiple client instances. This characteristic permits you to associate the same save
set with more than one group or schedule for backup.
The save sets associated with a specific client instance are visible as a scrollable list in
the Save Set attribute of the Create Client and Properties dialog boxes.
If the default value All appears in the Save Set attribute, all local data for the client
computer is backed up according to the group and schedule in the Create Client and
Properties dialog boxes.

Multiple clients from the same computer
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To define a client and save set combination:
1. Create a new or edit an existing NetWorker client.
2. Click the General tab of the Properties dialog box for the client.
3. In the Save Set attribute, delete the default value All.
4. Complete one of these steps as appropriate:
• To configure the client so that a specific file system is backed up, enter the file
system pathname in the Save Set attribute.
• To define multiple save sets on a client, enter each save set (partition, file
system, or file) on a separate line in the Save Set attribute.

Scheduled backups of non-ASCII files or directories
When the Saveset attribute for a Client resource contains non-ASCII characters, the
Save Operation attribute must set as follows:
◆

UNIX/Linux:
• For NetWorker clients at release 7.4 or later, the value of the Save Operation
attribute should be set to:
I18N:mode=nativepath

• For clients at a release level prior to release 7.4, the value of the Save Operation
attribute should be set to:
I18N:mode=utf8path
◆

For all Microsoft Windows clients, the Save Operation attribute should be set to:
I18N:mode=utf8path

If the Client Backup Configuration Wizard is used, it is not necessary to change the
Save Operation attribute in the Client resource created by the wizard.

Adding or changing the NetWorker servers for a client
NetWorker uses the contents of the /nsr/res/servers (UNIX), or the
NetWorker_install_path\res\servers (Windows) file on each NetWorker client to
control who has client-tasking rights (the right to request a program to be executed
on another client). This client-tasking might be any of the following:
◆

Server that performs an archive request

◆

Scheduled backup

◆

Another client that requests a directed recover

During a NetWorker software installation, you can add the names of NetWorker
servers to this file. To add additional hosts at a later date, a text editor must be used to
add the hostname to the file.
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◆

So that the client with the tasking rights can back up to other NetWorker servers,
the names of the additional NetWorker servers must be added to this file.

◆

So that other clients can perform directed recovers to the client with the tasking
rights, their names must be added to the servers file.
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IMPORTANT
If the servers file is empty, then any NetWorker host has tasking rights. This is a
potential security concern.

Editing the servers file
To give clients client-tasking rights to a NetWorker client:
1. Stop the NetWorker host whose tasking rights are being updated. “Stopping and
starting a NetWorker server, client, or storage node” on page 51 provides more
information.
2. Open the servers file in a text editor.
The default installation location for this file is:
• /nsr/res/servers (UNIX)
• NetWorker_install_path\res\servers (Windows)
3. Enter one hostname per line.
4. Save the changes and exit the text editor.
5. Restart the NetWorker host.

Client priority
The Priority attribute in the Client resource specifies the order in which clients are
contacted for backup. The attribute can contain a value between 1 and 1,000. The
lower the value, the higher the priority.
The client with the lowest value for the Priority attribute is placed at the top of the list
to be contacted by the NetWorker server. If a value is not specified in the Priority
attribute, the backup order is random.
While the Priority attribute specifies the order of client contact, many variables affect
the order in which clients complete their backups, including these scenarios:
◆

The backup operation on a client does not begin until the worklists for each of the
save sets on the client are complete.

◆

The amount of work can vary greatly from one client to the next.

◆

If a client stops responding and times out, the client is put at the end of the
backup list.
To increase the number of times each client in a group is retried before the backup
attempt is considered unsuccessful, change the value in the Client Retries
attribute in the Group resource. “Task 2: Set up a group for backup clients” on
page 57 provides more information.

Note: The only way to guarantee that ClientA backs up before ClientB is to assign ClientA to a
scheduled backup group that starts earlier than the group containing ClientB.

Client priority
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Dedicated client/server interface for backup and recover operations
If a NetWorker client must access a unique network interface on the server that is
used for backup and recover operations, enter the value in the NetWorker client
resource’s Server network interface attribute. The value you enter should correspond
to the unique hostname of the network interface on the server.
The Server network interface attribute is located in the Globals (1 of 2) tab in the client
resource. This attribute does not specify the NetWorker server hostname that is used
for other NetWorker processes, such as monitoring or authentication operations. All
other processes use the hostname of the NetWorker server.
The server network interface attribute is used only for the NetWorker Server. The
hostname of the LAN interface which is dedicated for backup on the NetWorker
server must be entered here. In order to set a dedicated LAN interface for backup on
storage node, use the hostname of the LAN interface which is dedicated for backup
as storage node attribute and enter the hostname of the LAN interface which is
dedicated for backup on NetWorker server.
For example,
To backup a client via NetWorker Server:
Storage Node Attribute : nsrserverhost
Server Network Interface Attribute : A hostname of the LAN interface dedicated for
backup on the NetWorker Server.
To backup a client via the storage node:
Storage Node Attribute : A hostname of the LAN interface dedicated for backup on
storage node.
Server Network Interface Attribute : A hostname of the LAN interface dedicated for
backup on NetWorker server.
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This chapter covers these topics:
◆
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Using autochangers and stand-alone tape devices ................................................
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Microsoft Cluster Server or Microsoft Failover Cluster ........................................
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Cluster terminology
This section defines terms specific to NetWorker cluster support that are used in this
document:
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◆

Node — A physical computer that is a member of a cluster.

◆

Private disk — A local disk on a cluster node. A private disk is not available to
other nodes within the cluster.

◆

Shared disk — A disk that is shared by the cluster nodes.

◆

Failover — A means of ensuring application availability by relocating resources
in the event of a hardware or software failure. Two-node failover capability
allows operations to switch from one cluster node to the other. Failover capability
can also be used as a resource management tool.

◆

Highly available application — An application installed in a cluster environment
and configured for failover capability.

◆

Cluster-aware NetWorker server — A NetWorker server that can recognize
cluster clients.

◆

Cluster client — A NetWorker client within a cluster. This can be either a virtual
client, or a NetWorker Client resource that backs up the private data that belongs
to a one of the physical nodes.

◆

Virtual client — A NetWorker Client resource that backs up data that belongs to a
highly available service or application within a cluster. Virtual clients can fail
over from one cluster node to another.

◆

Stand-alone server — A NetWorker server that runs within a cluster, but not
configured as a highly available application. A stand-alone server does not have
failover capability.

◆

Virtual server — A NetWorker server configured to run as a highly available
application. A virtual server can fail over from one cluster node to another.
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Cluster-aware and cluster-unaware NetWorker servers
To perform scheduled backups within a cluster, you must have a cluster-aware
NetWorker server and NetWorker client. Not all NetWorker servers and clients are
cluster-aware.The EMC NetWorker Software Compatibility Guides provides information
about which versions are cluster aware.
These issues apply if either the server or client are not cluster-aware:
◆

If a NetWorker server does not have cluster-client support, it cannot recognize
cluster clients. When a scheduled backup is performed, the NetWorker server
backs up only the private data of the physical node. The data is backed up to the
same index representing the physical node.

◆

If a NetWorker client does not have cluster-client support, it backs up all data that
belongs to the virtual servers and physical nodes into the same index
representing the physical node. It does not recognize the difference between
virtual and physical clients.

Cluster-aware and cluster-unaware NetWorker servers
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Cluster licensing
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information on
NetWorker licensing support for clusters.

Backing up data on Windows cluster environments
Note: If you manually stop a scheduled backup, the Manual restart option is set automatically,
and overrides the Autorestart setting. For a NetWorker server to have failover capabilities
within a cluster, you must enable the Autorestart setting. Disable the Manual restart option in
the NetWorker Administration program to ensure that the scheduled backup restarts
automatically.

The Manual restart option is enabled each time you stop a scheduled backup
manually. Consequently, you must disable the Manual restart option each time you
manually stop a scheduled backup.

Backing up cluster data
Backing up data from a node or a virtual server within a cluster is similar to backing
up data on a computer that is not part of a cluster. For detailed instructions on how to
back up data, see these chapters:
◆

Chapter 4, “Backup Groups and Schedules,”

◆

Chapter 2, “Backing Up Data,”

To prepare for backups, you must install the NetWorker software on all physical
nodes in the cluster. The NetWorker Installation Guide provides details.
Note: You can back up all nodes and virtual servers in the cluster to a NetWorker server that is
not part of the cluster.

Manual backup of a virtual client with non-administrative privileges
To perform a manual backup of data from a virtual client with non-administrator
privileges, use the following command to modify the security descriptor properties
on the cluster so that the user can access the cluster resources. Otherwise the data of
the virtual client will be backed up under the physical node's index instead of the
virtual client's index:
Cluster <ClusterName> /prop "security
descriptor"=<DOMAIN\USER>,grant,f:security
Microsoft Cluster without Cluster Shared Volumes (CSV)
Cluster Shared Volumes (CSV) is a new failover clustering feature in Windows Server
2008 R2 that allows all nodes in a cluster, concurrent access to data on every
CSV-enabled shared disk. CSV simplifies the configuration and management of
clustered virtual machines. With CSV, multiple clustered virtual machines can use the
same LUN (disk) while still being able to fail over independently.
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NetWorker client on Windows Server 2008 R2 will not support CSV. If Networker
detects configured CSV, it does not back up the CSV. It displays the following error
message:
ALERT: This release of NetWorker does not support the backup of
Cluster Shared Volumes.The save_set_path directory and its contents
will not be saved.

Networker continues to backup the remaining files and directories.

Backing up node data
For a NetWorker client that corresponds to a physical node, NetWorker software can
be configured to back up:
◆

Private disks

◆

SYSTEM and VSS SYSTEM save sets

To back up node data on a cluster client:
1. Create a client. “Task 6: Create a backup Client resource” on page 59 provides
more information.
2. Configure a Client resource for each cluster client in the cluster.
3. For the Save Set attribute:
• To back up SYSTEM or VSS SYSTEM save sets, repair disk information, and all
private disks on the client, enter All.
• To back up only the local drives that exist on a client, specify the drive
volumes of the private disks owned by the virtual client. For example, type:
C:\
Note: If you enter a drive letter for the Client’s Save Set attribute, rather than using All, the
registry and repair information is not backed up. Make sure that the registry and repair
information is backed up. These files are critical for successful disaster recovery.

Backing up virtual server data
On a virtual server, NetWorker software backs up only the shared disk data that
exists on the virtual server. Virtual servers in the cluster become NetWorker virtual
clients.
To back up virtual client data:
1. Create a client.
2. Configure a Client resource for each cluster client in the cluster.
3. For the Save Set attribute for the virtual client:
• To back up all of the shared drives and active physical drives that exist on a
client, specify All.
• To back up only the drive volumes of shared disks that a virtual client owns,
specify the drive volume letter. For example:
G:\

4. For the Remote Access attribute on the Globals 2 of 2 tab, add each NetWorker
client that corresponds to a physical node. For example:
Backing up data on Windows cluster environments
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SYSTEM@physical-client1
SYSTEM@physical-client2

If the virtual NetWorker server is listed in the \nsr\res\servers file, the physical
nodes must also be listed there. A backup fails if a virtual NetWorker server is listed
in the servers file and you create a savegroup to which a physical node is added that
does not own the NetWorker Server resource.
To avoid this problem, do one of the following:
◆

Leave the servers file blank.
Note: If the servers file is blank, any NetWorker server can back up the client.

◆

Ensure that if the virtual NetWorker server is added to the servers file, all physical
nodes are also added to the list.

Backing up data on EMC AutoStart
To perform a manual backup of data from a virtual cluster client with administrator
privileges on EMC AutoStart on Windows, use the ftconsole to add nonroot users to
the security access list for the FT domain.

Backing up the MSCS database
NetWorker software backs up the MSCS database as part of the SYSTEM STATE or
VSS SYSTEM SERVICES save set. If you back up the SYSTEM STATE or VSS SYSTEM
SERVICES save set, the cluster configuration is backed up automatically.
The MSCS database is maintained synchronously on two nodes. Consequently,
backing up the database on one node might not reflect changes made on the other
node.

Backing up data on UNIX cluster environments
This section describes how to configure scheduled saves or data from a physical
cluster client and a virtual cluster client, as well as how to perform a manual backup
of data from a virtual cluster client.
These topics provide more information:
◆

“Configuring a scheduled save from a physical cluster client” on page 494

◆

“Configuring a scheduled save from a virtual cluster client” on page 495

◆

“Performing a manual backup from a virtual cluster client” on page 496

Configuring a scheduled save from a physical cluster client
Backing up data from a physical client within a cluster is similar to backing up data
on a computer that is not part of a cluster. Chapter 2, “Backing Up Data” provides
detailed instructions on how to back up data.
To prepare for regular backups, install the NetWorker client software on all physical
clients within the cluster. The NetWorker Installation Guide provides detailed
installation and configuration instructions.
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Configuring a scheduled save from a physical cluster client on HACMP
To back up a physical client on an HACMP for AIX node, each node requires
persistent IPs or, for pre HACMP 4.5 clusters, an extra network interface card (NIC)
that is configured outside of the control of the HACMP for AIX environment.
For a physical client, the NetWorker software requires an address that uniquely
connects to a physical client. The service and boot addresses of HACMP for AIX do
not meet this requirement because clusters configured with IP address takeover
(IPAT), replace the boot address with the service address when a resource group is
attached.
Service addresses are associated with a resource group, not physical nodes. The
output of the hostname command on a computer must correspond to a pingable IP
address. The computer hostname must also be set to the name equivalent of the
address used by the physical client’s persistent IP or dedicated NIC. With either
method, persistent IP or dedicated NIC, the primary network adapter must be used
(for example, en0).

Configuring a scheduled save from a virtual cluster client
Instructions for how to configure a scheduled save from a virtual cluster client are the
same whether the NetWorker server is inside the cluster or outside the cluster.
To configure a scheduled save from a virtual cluster client under the NetWorker
server:
1. (Optional) Define save groups as required.
Note: Save groups must have the Autorestart attribute enabled and the Manual Restart
option disabled in order for their save sets to restart after a virtual client or NetWorker
server failover.

2. Make each physical client within the cluster a NetWorker client of the NetWorker
server.
For each physical client in the cluster:
a. Create a new NetWorker Client resource.
b. For the Name attribute, enter the name of the physical client.
3. Make each virtual client within the cluster a NetWorker client of the NetWorker
server.
For each virtual client in the cluster:
a. Create a new NetWorker client.
b. For the Name attribute, enter the name of the virtual client.
c. For the Remote Access attribute, add entries for each physical client within
the cluster. For example:
root@clus_phys1

d. For the Group attribute, select a group.
If you are using virtual NetWorker server that resides in a cluster, the first time
the NetWorker server runs, it creates the Client resource for the virtual
NetWorker server.

Backing up data on UNIX cluster environments
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4. Run a test probe to verify that the Client and Group resources are properly
configured.
On the cluster node or stand-alone server on which the NetWorker server resides,
enter this command:
savegrp -pv -c virtual_client group_name
Note: “Tracking scheduled saves” on page 503 provides information on if the test probe does
not display the appropriate scheduled backups and index.

Performing a manual backup from a virtual cluster client
You can perform a manual backup of data from a virtual cluster client by using root
and nonroot administrative privileges.
These topics provide more information:
◆

“Perform a manual backup by using root administrative privileges” on page 496

◆

“Performing a manual backup by using nonroot administrative privileges” on
page 496

Perform a manual backup by using root administrative privileges
Backing up data from a virtual cluster client is similar to backing up data from
noncluster clients. For example:
save -c client saveset

Performing a manual backup by using nonroot administrative privileges
For all cluster platforms except HP MC/ServiceGuard, AutoStart, and VERITAS
Cluster Server, performing a manual backup by using nonroot privileges is similar to
backing up data from noncluster clients by using root privileges. For example:
save -c client saveset

HP MC/ServiceGuard

To perform a manual backup of data from a virtual cluster client with nonroot
privileges on HP MC/ServiceGuard:
◆

On each node on which you want to run the save command, edit or create the
.rhosts file in your home directory to include the names of all the nodes within
the cluster. For example:
nodeA
nodeB

◆

As root on all nodes in the cluster:
a. Edit or create the /etc/cmcluster/cmclnodelist file and add this information
to the file:
nodeA user_name
nodeB user_name
b. Copy the file to each node in the cluster.

Note: If the cmclnodelist file exists, the cluster software ignores any .rhosts file.
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AutoStart for AIX, HP-UX, Linux, and Solaris
To perform a manual backup of data from a virtual cluster client with nonroot
privileges on AutoStart for AIX, HP-UX, Linux, and Solaris, use the ftconsole
program to add nonroot users to the security access list for the FT domain.
VERITAS Cluster Server

You can perform a manual backup of cluster data that belongs to a physical or a
virtual cluster client with nonroot privileges by using VERITAS Cluster Server (VCS)
version 4.0 or lower. To do so, set the server’s AllowNativeCliUsers attribute to 1.
Setting this attribute ensures that the nonroot user is not prompted for a password
when executing the server’s commands. This attribute instructs the server to
authenticate by using the user’s operating system username and password, rather
than the server username and password. The server default Cluster Guest
permissions are sufficient to use the NetWorker client software.
In VCS version 4.1 or later, the AllowNativeCliUsers attribute has been deprecated.
To perform a manual backup of cluster data that belongs to a physical or a virtual
cluster client with nonroot privileges by using VCS version 4.1 or later, use the VCS
halogin command. For more information about the halogin command, see the VCS
documentation.
Note: When a nonroot user is running a NetWorker program such as save or nsradmin on a
VCS cluster, the user must have permissions to query VCS. Otherwise, the NetWorker program
will not be cluster-aware because the user is not authenticated by the VCS cluster. For
information on how to set up VCS authentication, see the VCS documentation.

HACMP for AIX

To back up a physical client on an HACMP 4.5 node, each node requires persistent IPs
or an extra NIC that is configured outside of the control of the HACMP 4.5
environment. For a physical client, the NetWorker software requires an address that
uniquely connects to a physical client.
The service and boot addresses of HACMP 4.5 do not meet this requirement because
clusters configured with IP address takeover (IPAT), replace the boot address with the
service address when a resource group is attached.
Service addresses are associated with a resource group, not physical nodes. The
output of the hostname command on a computer must correspond to a pingable IP
address. The computer hostname must also be set to the name equivalent of the
address used by the physical client’s persistent IP or dedicated NIC. With either
method, persistent IP or dedicated NIC, the primary network adapter must be used
(for example, en0).

Configuring a virtual client to back up to a local storage node
Typically, the NetWorker server backs up the data on a virtual client within a cluster
to the first storage node listed in the virtual client’s Storage Nodes attribute.
You can configure a virtual client within a cluster to direct its backups to the storage
node on the physical host on which it resides. To do this, type the following in the
Storage Nodes attribute of the virtual client:
curphyhost
Note: curphyhost is only applicable to virtual clients and should never be inserted into the
clone storage nodes list even for the NetWorker Server’s NSR resource.

This is done by typing curphyhost in the Storage Nodes attribute of the virtual client.

Configuring a virtual client to back up to a local storage node
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For example, consider a two-node cluster where:
◆

Nodes A and B are the two physical nodes in the cluster.

◆

The virtual client is saturn, which can reside on Node A or fail over to Node B.

In a normal NetWorker backup of saturn—without “curphyhost” listed in the virtual
client’s Storage Nodes attribute—the save data is directed to the remote device (rd=)
on Node A. When saturn fails over to Node B and a backup for saturn is initiated, the
save data is still directed to the remote device (rd=) on Node A.
Listing "curphyhost" first in saturn’s Storage Nodes attribute modifies the NetWorker
operation so that if saturn fails over to Node B and a backup of saturn is initiated, the
save data is directed to the remote device (rd=) on Node B. This action takes place
because, after the failover, saturn resides on Node B—the current physical host.
Note: Do not apply the curphyhost keyword to your virtual server’s Client resource. This can
cause unexpected behavior, such as bootstraps and online indexes being written to the local
storage node for the virtual clients, rather than to a local device on the server.

Directing a virtual client backup to a local storage node
To direct a virtual client to back up to a local storage node:
1. Start the NetWorker Administration Console software.
2. From the Administration window, click Configuration.
3. In the left pane, select Clients.
4. From the File menu, select Properties and then select the Globals 2 of 2 tab.
5. For the Storage nodes attribute, add the curphyhost keyword. Position the
keyword in the list based on the required priority. The top of the list is the highest
priority.

Configuring a virtual client to be recovered from a local storage node
The procedure to configure a virtual client to be recovered from a local storage node
is similar to the procedure describe in “Configuring a virtual client to back up to a
local storage node” on page 497, except that this features is specific to a recover
operation.
To configure a virtual client to be recovered from a local storage node, type the
following in the Storage Nodes attribute or Recover Storage Nodes attribute of the
virtual client:
currechost

With this keyword set, a request is made that the required volume be mounted on the
storage node where the recover operation is running.
The following restrictions apply when configuring a virtual client to be recovered
from a local storage node:
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◆

Ensure that there are no hosts or machines named currechost on the network.

◆

The currechost keyword can not be set in the Clone storage nodes attribute of a
virtual client.

◆

Do not apply the currechost keyword to the virtual server's Client resource.
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Directing a virtual client recovery from a local storage node
To direct a virtual client to be recovered from a local storage node:
1. Start the NetWorker Administration Console software.
2. From the Administration window, click Configuration.
3. In the left pane, select Clients.
4. From the File menu, select Properties and then select the Globals 2 of 2 tab.
5. For the Storage nodes attribute or the Recover storage nodes attribute, add the
currechost keyword. Position the keyword in the list based on the required
priority. The top of the list is the highest priority. Ensure that this keyword is not
the only keyword in the list.

Recovering a virtual client’s data by using the currechost keyword
To recover a virtual client's data by using the currechost keyword, run the recover
operation on the node in the cluster where the virtual client resides. The NetWorker
server requests that the volume be mounted on the local storage node.
Be aware of the following considerations when recovering the virtual client’s data:
◆

Ensure that the local storage node has access to the required volume.

◆

If the required volume is in use by another drive, the recover operation waits until
the volume is unmounted. When the required volume becomes available, the
volume is mounted and the recover operation continues.

Configuring a virtual client to be recovered from a local storage node
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Support for multiple IP addresses for one resource group
NetWorker is able to save or recover a virtual client that has two or more IP resources
on EMC AutoStart, HACMP, VERITAS Cluster Server, SUN Cluster, Microsoft MSCS,
and Microsoft Failover Cluster.
The EMC NetWorker Software Compatibility Guide provides details on supported
operating systems and cluster software versions.
Note: Support for multiple IP addresses in one resource group on AutoStart and HACMP is
new and is available in the NetWorker 7.6.2 release. For VERITAS Cluster Server, this feature
requires the creation of a NetWorker client resource for each resource group that contains two
or more IP addresses.

AutoStart and HACMP clusters
In NetWorker 7.6 Service Pack 2, a virtual client that has two or more IP resources can
be saved or recovered on AutoStart and HACMP clusters. A resource group can
contain as many IP resources as is permitted by the cluster software. However, only
one of these IP addresses corresponds to a NetWorker Client resource defined in a
NetWorker server. The name of the NetWorker Client resource can be the short name,
the FQDN corresponding to the IP address, or the IP address.
Example

resgrp1 is a resource group defined in a cluster and there are two IP resources defined
in the group, IP1 and IP2. If the IP address for IP1 is defined as a NetWorker Client
resource, then all shared paths in resgrp1 are saved under the IP address for IP1 index.
Do not configure both IP addresses as NetWorker Client resources. If this occurs, an
error message displays indicating the save set has two owners defined as NWClient
resources in the NetWorker server. To correct this:
◆

Remove one of the NetWorker Client resources.
or

◆

Use the -c option to direct the client name.

Also, for recovery operations, if a path owned by two IP resources is recovered
without specifying the client name, and both of the IP addresses are defined as
NetWorker Client resources, the same error message displays.
Note: It is not supported to have more than one IP address for the resource group that makes
the NetWorker server application highly available for HACMP and AutoStart clusters.

VERITAS Cluster Server
In NetWorker 7.6 Service Pack 2, a virtual client that has two or more IP resources can
be saved or recovered on a VERITAS Cluster Server (VCS), just like a virtual client
that has two or more IP addresses can be saved or recovered on AutoStart and
HACMP clusters.
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A resource group can contain as many IP resources as is permitted by the cluster
software. The name of the NetWorker client resource can be the short name, the
FQDN corresponding to the IP address, or the IP address.
You can configure more than one IP type resource for the NetWorker resource group
on VCS. To support more than one IP resource, define a NetWorker client resource in
the NetWorker resource group in VCS. This indicates the backup IP for the resource
group. The NetWorker client resource is a customized resource type designed for
VCS.
The NetWorker cluster installation guide provides details on how to configure an
instance of the NetWorker client resource for a virtual client in VCS.

SUN Cluster
More than one IP address for a resource group (including the NetWorker server
resource group) is supported on SUN Cluster. However, a customized resource type,
LGTO.clnt for SUN Cluster is required for every resource group to be saved or
recovered by the NetWorker software. LGTO.clnt is required whether the resource
group contains only one IP address, or if it contains several IP addresses.
The NetWorker cluster installation guide provides details on how to create an
instance of the LGTO.clnt resource for a virtual client on SUN Cluster.

Microsoft Cluster Server (MSCS) and Microsoft Failover Cluster
No matter how many IP addresses are defined in a resource group on MSCS or
Microsoft Failover Cluster, as long as there is only one network name resource, then
that network name should be specified as the NetWorker client to back up or recover
the resource group.
If more than one network name is defined for a resource group on MSCS or Microsoft
Failover Cluster, then the name property of the network name resource used for
backing up the resource group must be configured to have a NSR prefix.
For example, suppose a resource group defined on MSCS, or on the Failover Cluster
server, has two network names, vclient1 and vclient2, whose resource names are
netname1 and netname2 respectively. And, you want to use the network name vclient1
to back up the resource group. Then, the following two configuration requirements
must be met:
◆

The name of the NetWorker client resource for backing up the resource group
should be vclient1 but not vclient2.

◆

The resource name netname1, defined on the cluster, needs to begin with NSR
(such as NSR_netname1). This can be done by using the following command:
cluster res netname1 /ren:NSR_netname1

Support for multiple IP addresses for one resource group
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Configuring an external client to a virtual server
Before a NetWorker server can back up a client, the client must grant the server
access. Granting access is controlled by these files:
◆

On UNIX: /nsr/res/servers

◆

On Windows: <NetWorker_install_path>\res\servers

Only the specific servers listed in this file can back up the client. “Adding or changing
the NetWorker servers for a client” on page 486 provides more information about the
servers file.

Recovering data in a Windows cluster environment
This section discusses how to recover data and cluster configuration in a cluster
environment.

How to recover data
Recovering data backed up from a private disk that belongs to a physical client in a
cluster is similar to recovering data on a computer that is not part of a cluster.
Chapter 13, “Recovering Data” provides detailed instructions.
“Directing recoveries to another client” on page 329 provides instruction on how to
recover data from a shared disk belonging to a virtual client, and for instructions on
completing a directed recovery.
The NetWorker Disaster Recovery Guide describes how to recover:
◆

Cluster configuration data.

◆

A corrupted Console database.

Recovering data in a UNIX cluster environment
This section discusses how to recover data from private disks belonging to a physical
client and shared disks belonging to a virtual client.

Recovering data from a private disk that belongs to a physical client
Recovering data backed up from a private disk that belongs to a physical client in a
cluster is similar to recovering data on a computer that is not part of a cluster.
Chapter 13, “Recovering Data” provides detailed instructions.

Recovering data from a shared disk that belongs to a virtual client
To recover data backed up from a shared disk that belongs to a virtual client:
1. Ensure that you have properly configured the virtual client for remote access
from your current node:
a. From the Administration window, click Configuration.
b. In the left pane, select Clients.
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c. From the File menu, select Properties and then select the select the Globals 2
of 2 tab.
d. Make sure that the Remote Access attribute of the virtual client for which you
want to recover the data contains the name of the physical host you are using
to recover the data. For example:
root@physical_hostname

2. Make sure that the file systems of the virtual client are mounted.
3. Recover data from a shared disk that belongs to a virtual client.
• To recover the data by using the nwrecover program, make sure that you
select the virtual client.
• To perform a command line recovery, enter the recover command with the -c
option at the command prompt. The -c option must be followed by the name
of the client you are attempting to recover. For example:
recover -s server_name -c virtual_client

The recover man page or the EMC NetWorker Command Reference Guide provide
information.

Recovering the Console server database
The Console database contains management data such as report information. The
EMC NetWorker Disaster Recovery Guide provides information about recovering a
corrupted Console database.

Tracking scheduled saves
To verify that the Client and Group resources are properly configured, run a test
probe for each client from the node where the NetWorker server is running:
savegrp -pv -c client_name group_name

If the test probe does not display all the scheduled save sets you want, do one of these
and run a second test probe to verify the configuration:
◆

Check the cluster configuration by using the cluster management software. If
necessary, reconfigure the cluster.

◆

Make sure that the client owns the save sets defined for that client. If necessary,
redistribute the client save sets to the appropriate Client resources.

Note: Misconfiguration of the cluster resources might cause scheduled save sets to be dropped
from the backup. “Path-ownership rules” on page 504 provides more information about
configuring clusters for scheduled backups .

To override scheduled save rules, create an empty file named pathownerignore on
each node in the cluster by running this command:
touch "networker_bin_dir/pathownerignore"

This allows any path to be backed up for a client, whether it is owned by the virtual
or physical node.
Note: Use the pathownerignore file with caution.

Tracking scheduled saves
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The pathownerignore file does not override the default path-ownership rules. It causes
the path-ownership rules to be ignored when determining if a file system should be
backed up during a scheduled save.

Forcing save sets to use a specific index
If you use pathownerignore, check that the NetWorker scheduled save uses the
correct client file index. If it uses the wrong index, you can force save sets to go to a
specific index.
To force save sets to use a specific index:
1. From the Administration window, click Configuration.
2. In the left pane, select clients.
3. In the right pane, select the client that is using the incorrect index.
4. From the File menu, select Properties and then select the Apps & Module tab.
5. For the Backup Command attribute, enter the name of a backup script that
contains save -c client_name.
“Using the save command with a customized backup script” on page 87 provides
detailed information about the Backup Command attribute.

Path-ownership rules
In a cluster environment, the NetWorker software must distinguish between:
◆

File systems associated with a physical client.

◆

File systems managed by a resource group (a virtual client).

The criteria used are called the path-ownership rules. These rules determine which
client file index a save set is written to.
By default, the NetWorker software might not back up scheduled save sets due to
conflicts with path ownership. This prevents a virtual NetWorker client from writing
to multiple client file indexes. The NetWorker software views the client (which owns
the file system) as not having matched the client of the current scheduled save set.
Writing to multiple indexes might cause recovery issues.
These conditions cause a file system to be omitted and not backed up during a
scheduled save:
◆

If a file system owned by a virtual client is defined in the Save Set attribute for a
physical Client resource.

◆

If a file system owned by a physical client is defined in the Save Set attribute for a
virtual Client resource.

Administrative privileges
A user must have administrative privileges to query the cluster database. If a
nonadministrative user performs a save of a file system that belongs to a virtual node,
path ownership resolution fails and the files are saved under the physical node’s
client file index, instead of the virtual node’s index. To force the NetWorker software
to save the files under the virtual node’s client file index, use the -c option. “Forcing
save sets to use a specific index” on page 504 provides details.

504

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Cluster Support

Checking path-ownership rules
To check the NetWorker path-ownership rules:
1. Type this command at the command-prompt on the NetWorker server:
savegrp -p -c client_name

2. Review which file systems client_name owns. This procedure is part of the normal
cluster installation setup. The NetWorker Installation Guide provides details.
To test for misappropriated save sets, run a test probe with the verbose option
set. The command output indicates to which client file indexes a save set is saved.
For example:
savegrp -pv -c client_name group_name

To ignore NetWorker default path-ownership rules, you can create the
pathownerignore file in the NetWorker bin directory:
◆

On Windows:
NetWorker_bin_dir

For example, C:\Program Files\Legato\nsr\bin
◆

On UNIX:
networker_bin_dir

This file causes the NetWorker software to back up the file system in question.
However, the file system is saved under the client file index of its correct owner.
“Forcing save sets to use a specific index” on page 504 provides information if a
situation occurs when the scheduled save uses the wrong index.
Overriding path-ownership rules
Overriding the path-ownership rules causes a save set to be saved under a client file
index different from the save set’s default owner.
How to override path-ownership rules during a manual backup
To override the default path-ownership rules for a manual backup, type the following
at the command-prompt:
save -c client_name

How to override path-ownership rules during a scheduled backup
To override the path-ownership rules during a scheduled backup:
1. From the Administration window, click Configuration.
2. In the left pane, select Clients.
3. In the right pane, select the client that is using the incorrect index.
4. From the File menu, select Properties and then select the Apps & Module tab.
5. For the Backup Command attribute, enter the name of a backup script that
contains save -c client_name.
“Using the save command with a customized backup script” on page 87 provides
detailed information about the Backup Command attribute.

Tracking scheduled saves
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Using a physical storage node and virtual server on UNIX platforms
This section describes how to access a physical storage node with a virtual
NetWorker server.
A NetWorker storage node can be installed and configured on nodes in the cluster.
However, the NetWorker storage node is not a highly available application. These
instructions apply in the cases where you are using storage nodes in the cluster and
storage nodes that are outside of the cluster.
Note: NetWorker release 6.0 and later does not officially support remote virtual storage nodes.

To access a physical NetWorker storage node from a virtual server
(rd=physicalhostname:devxxx):
1. Shut down the virtual NetWorker server by using the cluster management
software.
2. Modify the NetWorker virtual cluster start script to recycle the remote
NetWorker storage node.
On each node to which the virtual NetWorker server can fail over:
a. Open the NetWorker virtual cluster script, networker_bin_dir, for editing.
b. Before the line that starts the nsrd daemons, add the appropriate script edits
from Table 93 on page 506, such as:
rsh remote_hostname "networker_bin_dir/nsr_shutdown -q &&

networker_bin_dir/nsrexecd"
Note: Replace the networker_bin_dir variable with the appropriate path where the
NetWorker binaries are installed on the NetWorker storage node.

c. If necessary, resynchronize the virtual NetWorker server startup script with
the cluster management system.
3. Restart the NetWorker server.
Table 93
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Script changes to support physical storage nodes(1 of 2)
Cluster product and virtual NetWorker
cluster script

Edits for the virtual NetWorker server startup script

HACMP for AIX
<networker_bin_dir>/nwhacmp.lc

rsh remote_hostname "networker_bin_dir/nsr_shutdown -q &&
networker_bin_dir/nsrexecd"

HP MC/ServiceGuard
HP MC/LockManager
<networker_bin_dir>/legato.monitor

remsh remote_hostname "networker_bin_dir/nsr_shutdown -q
&& networker_bin_dir/nsrexecd"

EMC AutoStart for AIX
<networker_bin_dir>/nw_ux.lc

rsh remote_hostname "networker_bin_dir/nsr_shutdown -q &&
networker_bin_dir/nsrexecd"
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Table 93

Script changes to support physical storage nodes(2 of 2)
Cluster product and virtual NetWorker
cluster script

Edits for the virtual NetWorker server startup script

EMC AutoStart for HP-UX
<networker_bin_dir>/nw_ux.lc

remsh remote_hostname "networker_bin_dir/nsr_shutdown -q
&& networker_bin_dir/nsrexecd"

EMC AutoStart for Linux
<networker_bin_dir>/nw_ux.lc

rrsh remote_hostname "networker_bin_dir/nsr_shutdown -q &&
networker_bin_dir/nsrexecd"

Sun Cluster
<networker_bin_dir>/nw_ux.lc

rsh remote_hostname "networker_bin_dir/nsr_shutdown -q &&
networker_bin_dir/nsrexecd"

Using autochangers and stand-alone tape devices
This section describes how to use autochangers and stand-alone tape devices with a
highly available NetWorker server. Device-sharing infrastructure is defined as
hardware, firmware, and software that permit several nodes in a cluster to share
access to a device.

Configurations for autochangers and stand-alone tape devices
If the cluster has a device-sharing infrastructure that supports autochangers and
stand-alone tape devices. To configure your system to use:
◆

Shared autochanger devices and shared stand-alone tape devices, use
“Configuration option 1” on page 507.

◆

Shared autochanger devices, but not shared stand-alone tape devices, use
“Configuration option 2” on page 509.

◆

Nonshared devices, or any configuration, use “Configuration option 3” on
page 510, which does not require device-sharing infrastructure.

Note: Make sure that the device-sharing infrastructure is certified by the cluster software
vendor.

Configuration option 1
This configuration option offers a seamless backup solution that is hands-free. It
allows you to access shared tape devices and shared autochanger devices with a
highly available NetWorker server. Figure 33 on page 508 provides a graphical view
of this configuration option.
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Note: Only one autochanger is required, although you can add more.

Node A

Node B

Local Disk

Local Disk

Shared Disks

Autochanger
rd=A:/dev/...

Figure 33

Autochanger
rd=B:/dev/...

Configuration option 1

To configure shared tape devices and shared autochanger devices to work with a
highly available NetWorker server:
1. Interface all the autochanger devices to all the nodes in the cluster to which the
NetWorker server can fail over. Use a working SCSI or Fibre Channel switch, and
appropriate software as required.
2. Make sure that the shared device infrastructure (SAN bridge, modular data
router) supports complete isolation and protection of the path session between
the autochanger and the node with the NetWorker server currently running. The
path must be protected from stray bus signals and unauthorized session access
from the other nodes.
Note: If processes on nodes other than the one that is running on the NetWorker server can
access the tape devices, data corruption might occur. The NetWorker software might not
detect the data corruption.

3. Modify the virtual NetWorker server startup script by adding any required node
device-reassignment reservation commands (commands for the bridge) before
the line that starts the nsrd daemon.
4. Test that the device-sharing infrastructure supports path isolation. For UNIX
platforms, use the appropriate operating system commands for your platform
against the device. For example, tar or cpio:
a. From Node A, write a significantly large amount of data to tape. During the
write session, turn node B on and off a couple of times.
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b. Verify that the data was properly written by reading the data from tape and
comparing it to the original data. Table 94 explains the verification results.
Table 94

Data verification

Indication

Description

Failure

The switching infrastructure does not properly support path isolation. Try “Configuration
option 2” or “Configuration option 3”, or contact the device-sharing infrastructure vendor.

Success

Reverse the node roles:
• From Node B, write a significantly large amount of data to tape. During the write session,
turn node A on and off a couple of times.
• Verify that the data was properly written by reading the data from tape and comparing it
to the original data.
• If the verification fails, try “Configuration option 2” or “Configuration option 3”, or contact
the device-sharing infrastructure vendor.

5. Configure the autochanger and tape devices.
Configuration option 2
This option offers a seamless backup solution for accessing nonshared tape devices
and shared autochanger devices from a highly available NetWorker server. However,
some intervention might be required during the data recovery process. Figure 34 on
page 509 provides a graphical view of this configuration option.
Note: If N nodes are used, N-1 storage node licenses are required. N indicates the number of
failover nodes for the virtual NetWorker server.

Node A

Node B

Local Disk

Local Disk
Shared Disks

Changer Switch

Autochang
Tape

Figure 34

Tape

Configuration option 2

To configure the devices to work with a virtual NetWorker server:
1. Interface the autochanger device to the NetWorker failover nodes. Use a working
SCSI or Fibre Channel switch and appropriate software if required.
2. Privately attach each tape device to a separate node within the cluster. For
example:
Using autochangers and stand-alone tape devices
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• Attach tape drive 1 exclusively to Node A.
• Attach tape drive 2 exclusively to Node B.
3. Configure the tape devices as remote physical storage nodes. For example:
On Windows:
rd=nodeA:\\.\Tape.0
rd=nodeB:\\.\Tape.1

On UNIX:
rd=nodeA:/dev/tape#1
rd=nodeB:/dev/tape#2
Note: When defining each tape device, assign ownership to the node exclusively connected
to that tape device.

Configuration option 3
This option offers a seamless backup solution for accessing nonshared tape devices
and nonshared autochanger devices from a highly available NetWorker server.
However, some intervention might be required during the data recovery process.
Figure 35 on page 510 provides a graphical view of this configuration option.
Note: N indicates the number of failover nodes for the virtual NetWorker server.
◆

If N nodes are used, N-1 storage node licenses are required.

◆

At least N autochangers are required, one per failover node.
Node A

Node B

Local Disk

Local Disk

Shared Disks

Autochanger
rd=A:/dev/...
Figure 35

Autochanger
rd=B:/dev/...

Configuration Option 3

To configure tape autochanger devices to work with a virtual NetWorker server:
1. Attach the autochanger exclusively to the NetWorker server.
2. Use this command to configure the nonshared tape and nonshared autochanger
devices as remote physical storage node devices. For example:
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On Windows:
jbconfig -s virtual_server
rd=nodeA:\\.\Tape.0
rd=nodeB:\\.\Tape.1
rd=nodeA:\\.\Tape.3

On UNIX:
jbconfig -s virtual_server
rd=nodeA:/dev/tape#1
rd=nodeB:/dev/tape#2
rd=nodeA:/dev/changer

3. Repeat these steps on each NetWorker server failover node.

DDS within a cluster
There are two options for using the DDS feature within a cluster:
◆

“Controlling the robotics inside the cluster configuration” on page 511

◆

“Controlling the robotics from a stand-alone host” on page 513

“Dynamic drive sharing” on page 104 provides information explaining how to
activate the DDS feature.
These sections explain the supported cluster platforms and the two methods for
using DDS within a cluster.
High availability and DDS
The NetWorker software relocates and restarts operations that were in progress when
a failure occurs on a cluster node. Currently, the only operations that are highly
available are the NetWorker server and savegroups.
The nsrjb program high availability limitations
If the NetWorker server fails over from one node to a new target node, standard
jukebox operations (such as performing an inventory, labeling, mounting or
unmounting a volume) will not automatically restart on the new target node.
Example 42 Host crash requires user intervention

You have this scenario: two physical hosts, A and B, with DDS enabled, sharing the
drives on an autochanger.
Physical host A mounts a tape in a shared drive on the autochanger. If physical host
A subsequently crashes, the volume is held in that shared drive until you issue the
nsrjb -H reset command (from host B, in this example).
This command unloads the drive and makes it available for future backups. The reset
command clears the drive by accessing the device through another shared path. In
this example, the other shared path would be on host B.
Successfully unloading a volume requires that the NetWorker software is able to
access the same path through which the initial loading of the volume was completed.
Controlling the robotics inside the cluster configuration
To use DDS in a cluster, with the robotics controlled within the cluster configuration:
◆

One node must be a virtual NetWorker server. This virtual NetWorker server
controls the robotics from within the cluster.

Using autochangers and stand-alone tape devices
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◆

Physical storage nodes of the cluster are configured to share the same drive.

◆

You must run the jbconfig program on the NetWorker server to install the
autochanger.

To configure a highly available cluster, the special device file for the library robotics
must be installed on all the physical nodes in the cluster. The special device file for the
library robotics is provided by the cluster vendors. You must use the same naming
convention across all the cluster nodes. For example, on a Windows cluster, the
special device path would be scsidev@1.4.0.
Note: Some operating systems already have the special device file for the library robotics
bound in. Essentially, these special device files represent a pointer to a generic tape or
autochanger device driver. To determine whether the special device file has been bundled in
with your operating system, run the inquire command.

If the special device files are not bundled in with the operating system, refer to the
appropriate NetWorker Installation Guide.
Note: If you do not have matching special device files across cluster nodes, you may need to
install fibre HBAs in the same PCI slots on all the physical nodes within the cluster.

With most cluster environments, the HBA can be configured to create the same
scsi/FC path on each physical node of the cluster to make the NetWorker robotic
control highly available. As a result, the scsidev@bus.target.lun will be identical for
the robotics from each node in the cluster. Figure 36 illustrates how DDS can be
enabled within a cluster.

Cluster
Ethernet
Storage Nodes

Virtual
NetWorker Server

Fibre Channel Switch
Fibre
SCSI

FC Bridge

SCSI Tape Library or
Fibre Channel Library
Figure 36

DDS enabled with robotics controlled in the cluster

Using the jbconfig program to control the robotics
To control the robotics, you must use the jbconfig program to configure the devices
within the cluster. There are two options for using the jbconfig program to configure
devices with a cluster.
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◆

Using the jbconfig program with special device files

◆

Using the jbconfig program without special device files

The configuration process is similar in both cases, differing only at the prompt:
enter the control port of the jukebox in the following format

The prompt at which the response differs is illustrated in Example 43 on page 513.
This is an example of the jbconfig script with appropriate responses:
jbconfig
1) Configure an AlphaStor/SmartMedia Jukebox.
2) Configure an Autodetected SCSI Jukebox.
3) Configure an Autodetected NDMP SCSI Jukebox.
4) Configure an SJI Jukebox.
5) Configure an STL Silo.
What kind of Jukebox are you configuring? [1] 4
Enter the number corresponding to the type of jukebox you are
installing:
1) ADIC-1200c/ADIC-1200d
2) ADIC-VLS
3) ARC DiamondBack
4) Sun 20Gb 4mm Tape Loader
.
.
.
45) Digital TL800
46) Digital TL810
47) Digital TL820
48) Digital TL893
Choice? 48
Installing an 'Digital TL893' jukebox.
What name do you want to assign to this jukebox device? juke_box_1\

At this point, the jbconfig program differs for configurations without
vendor-supplied drivers and for configurations with vendor-supplied drivers.
Example 43 On Sun Cluster with no special device file

Using scsidev@2.3.0. for the device, enter the following when using the jbconfig
program:
Enter the control port of the jukebox in the following
format:scsidev@3.0.0
Pathname of the control port for the jukebox device? scsidev@2.3.0

Controlling the robotics from a stand-alone host
You can set up a stand-alone physical host outside the cluster to control the robotics,
as follows:
◆

If you are unable to get a uniform nomenclature for the vendor-supplied drivers
and you cannot match bus target LUNs across the cluster nodes.

◆

If you do not have a NetWorker server within the cluster.

Controlling the robotics from outside the cluster creates the opportunity for a single
point of failure. Therefore, evaluate your requirements if you choose this method.
If you choose to have a stand-alone physical host controlling the robotics, you must
ensure that the following binaries are installed:
◆

Client software

◆

Storage node software

Using autochangers and stand-alone tape devices
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◆

Driver software

You would configure the jbconfig program on the stand-alone physical host to
control the robotics.
Figure 37 on page 514 illustrates one manner in which a stand-alone physical host
outside the cluster can be used to control the robotics.
Note: The stand-alone physical host can control the robotics through a Fibre Channel or SCSI
connection.

Cluster

Ethernet
Stand-alone
Physical Host

NetWorker
Storage Nodes
Virtual
NetWorker Server

FC Switch

Fibre
FC Bridge
SCSI
SCSI Tape Library
or FC Library

Figure 37

DDS enabled with the robotics controlled outside the cluster

Considerations when using jbconfig for a virtual server
While running the jbconfig command with the -s virtual_server option on the
cluster node that is also running the virtual server, the name given to the Prefix to
the jukebox name attribute has the following implications:
• If the virtual server name (default) is used for the Prefix to the jukebox name
attribute, the jukebox's devices will be local to the virtual server.
• If the physical cluster hostname is used for the Prefix to the jukebox name
attribute, the jukebox's devices will be local to the physical cluster host.
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Controlling robotics from a NetWorker server on another cluster
A NetWorker server in a cluster can also be configured to control the robotics of the
nodes of another cluster. This configuration is illustrated in Figure 38. The virtual
NetWorker server of cluster B controls the robotics for the physical storage nodes in
cluster A.

Cluster A
Ethernet
Cluster B

Dedicated
Storage Nodes

NetWorker
Server

FC Switch
Fibre
FC Bridge
Robotic
Control

SCSI

SCSI Tape Library
Figure 38

Robotics controlled between clusters

Client Backup Configuration Wizard support requirements
This section contains the requirements to use the Client Backup Configuration
Wizard in a cluster environment.
◆

On a highly available NetWorker Server, the shared servers file must be updated
with the nsrwizcon.res and nsrwizclnt.res files from the local servers file:
• On UNIX:
cp /nsr.NetWorker.local/res/nsrwiz*res /nsr/res

• On Windows:
copy c:\program files\legato\nsr\res\nsrwiz*res
<shared drive>: \nsr\res
◆

The host from which the wizard is being run and the NetWorker server host must
be listed in both the local and shared servers file on the client host that is being
configured for a scheduled backup.

“Using the Client Backup Configuration Wizard” on page 55 provides additional
general considerations that apply to the Client Backup Configuration Wizard.

Client Backup Configuration Wizard support requirements
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NetWorker cluster performance issues
The NetWorker program, lcmap, queries cluster nodes to creates a map that includes
information such as path ownership of resource groups. In large cluster
configurations, lcmap may take a long time to complete and thus make certain
operations occur slowly. This is most often noticed in slow NetWorker server (nsrd)
start times or in very long backup times. In these situations, consider adjusting the
NSRLA attribute named cluster cache timeout. This attribute specifies a time, in
seconds, in which to cache the cluster map information on a NetWorker client.
Edit the cluster cache timeout attribute with caution. Values for the attribute can vary
from several minutes to several days, depending on how often the cluster
configuration changes, the possibility of resource group failover, and the frequency of
NetWorker operations. Too large a value can result in an out-of-date cluster map,
which can cause incorrect path resolution. For example, if the cluster cache timeout
value is set to 86400 (one day), any changes to the cluster map will not be captured for
up to one day. If cluster map information changes before the next refresh period,
some paths may not be resolved correctly. Also be aware that too small a value could
negatively affect performance because the cache is being updated too frequently.
Experiment with one physical cluster node to find a satisfactory timeout value. If a
significant improvement in performance cannot be obtained by adjusting this
attribute, reset the attribute value to 0 (zero) so that the attribute will not be used.

Editing the cluster cache timeout attribute
The cluster cache timeout attribute is available only on NetWorker clients in a
VERITAS Cluster or Sun Cluster environment. Additionally, the cluster cache timeout
attribute resides in the NSRLA database of the NetWorker client and is visible only
when NetWorker is configured for a cluster. For example on UNIX, a NetWorker
client is configured for a cluster when the networker.cluster script is executed and
nsrexecd is restarted.
Note: It is recommended that you edit the initial cluster cache timeout value before bringing
the highly available NetWorker server online.

To edit the cluster cache timeout value:
1. Log in as root or as Windows Administrator on a physical node that is running
the NetWorker client.
2. Type this at the command prompt:
nsradmin -p nsrexecd
The nsradmin prompt appears.
3. Display the current settings for attributes in the NSRLA resource, for example:
print type:NSRLA
4. Change the value of the cluster cache timeout attribute:
update cluster cache timeout:value
where value is the timeout value in seconds. A value of 0 (zero)
specifies that the cache is not used.
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Note: When modifying an attribute with the nsradmin program, the attribute name and
value must be specified correctly. If the attribute name and value are not specified
correctly, the attribute is not updated. No error message is provided.

5. Type Yes when prompted to confirm the change.
6. Perform the previous steps on each physical node in the cluster.
7. Bring the highly available NetWorker server online.
Unlike a standalone environment, there are two types of NSRLA databases when
a highly available NetWorker server is configured in a cluster: a local NSRLA
database on each physical node, and a shared NSRLA database on the highly
available NetWorker server's shared disk. The previous steps set the attribute in
the local NSRLA database on each physical node. Later when the highly available
NetWorker server is brought online for the first time, it will get the cache timeout
value from the local NSRLA database on the physical node where the highly
available server is running.
8. The following steps are optional and can be used if you want to experiment with
different cluster cache timeout values on the highly available NetWorker server.
a. Change the cluster cache timeout value in the shared NSRLA database by
issuing the previous nsradmin commands (steps 2 to 5) on the physical node
where the highly available NetWorker server is running.
b. The updated value will take effect after the next cache update, which is based
on the previous timeout value. To make the timeout value take effect
immediately, delete the cache file on the physical node. On UNIX, the cache
file is located at /tmp/lcmap.out. On Windows, the cache file is located at
C:\Program Files\Legato\nsr\bin\lcmap.out.
c. Once you have found a satisfactory value for the highly available server, you
can also update the cluster cache timeout value on each physical node.
To update the local cluster cache timeout value on the physical node that is
currently hosting the highly available NetWorker server, specify the location
of the NSRLA database when using the nsradmin command, for example:
nsradmin -d directory
where directory is the location of the local NSRLA database. On UNIX, the
directory is located in /nsr.NetWorker.local/res/nsrladb. On Windows, the
directory is located in C:\Program Files\Legato\nsr\res\nsrladb.

Setting NetWorker environment variables in a Sun cluster
In a Sun Cluster environment, the networker.start script is used instead of the
/etc/init.d/networker script to start the nsrd process.
NetWorker environment variables must be added to the networker.start script
instead of /etc/init.d/networker script. Place the environment variables in the
networker.start script before nsrd is started.
The networker.start script is located in the /usr/lib/nsr directory.

Setting NetWorker environment variables in a Sun cluster
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Changing the default timeout of 10 minutes for the NetWorker server in a
Microsoft Cluster Server or Microsoft Failover Cluster
The default timeout for NetWorker server startup in a Microsoft Cluster Server or
Microsoft Failover Cluster has been changed from 3 minutes per daemon to 10
minutes per daemon. You can now set the server's timeout value by modifying the
AdditionalArguments field in the Parameters tab of the NetWorker Server cluster
resource.
Note: Note: If you are upgrading from a version that does not allow you to set the default
timeout to a version that does have this feature, you must re-register the NetWorker resource
using regcnsrd.

To set the timeout parameter for the NetWorker server startup:
1. In the Cluster Administrator program, select the resource group where the
NetWorker Server resource exists.
2. In the Parameters tab of the NetWorker Server cluster resource, edit the value for
the AdditionalArguments field.
3. Type the following keyword and add a value in seconds. For example:
ServerStartupTimeout=200

where 200 is a numeric value.
Note: The ServerStartupTimeout keyword is case sensitive. The time value is represented in
seconds and must be a numeric value. If the entry for the time value is not recognized, the
default of 600 seconds (10 minutes) is used for this variable.
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This chapter covers these topics:
◆
◆
◆
◆
◆
◆
◆
◆

Overview of NDMP ....................................................................................................
Supported NDMP configurations.............................................................................
Requirements for and limitations of NDMP support ............................................
Configuring the NetWorker server for NDMP operations ...................................
Performing NDMP backups ......................................................................................
Performing NDMP recoveries...................................................................................
NDMP cloning .............................................................................................................
Ancillary product information ..................................................................................

NetWorker Server Support for NDMP

520
520
525
529
538
545
552
555

519

NetWorker Server Support for NDMP

Overview of NDMP
“NDMP (Network Data Management Protocol)” is a TCP/IP-based protocol that
specifies how network components talk to each other for the purpose of moving data
across the network for backup and recovery.
NDMP enables disparate vendors to use a common NDMP protocol for the backup
architecture. Data is copied from disk to tape or disk media, regardless of the
operating system or platform. Tracking information is also passed to and from the
backup software by using the same protocol, regardless of the software type.
NDMP works with the NetWorker software for backups, cloning, recoveries, and
updates or queries to resource files. All communications are through NDMP.
The objective of NDMP is to address problems associated with backing up
heterogeneous networks for operating system vendors, backup developers, and
Network Attached Storage (NAS) devices.
NetWorker NDMP support includes library sharing and library management in a
NAS environment. The term library is synonymous with autochanger, autoloader,
carousel, datawheel, jukebox, and near-line storage.

Licensing
The NetWorker NDMP interface is an optional feature that must be licensed
separately from the NetWorker base product according to a tiered licensing structure.
The new for 7.6 Service Pack 1, NetWorker Licensing Guide provides information on
NetWorker licensing support for NDMP.

NDMP connection support
With the NetWorker NDMP interface, you can connect to hosts that have an active
“NDMP service” or an NDMP data module installed. The hosts, clients, or devices
(except for the NetWorker server) do not need to have the NetWorker software
installed. NDMP allows a NAS device to back up data to other NDMP-controlled
tape or disk devices on the network. The tape or disk device does not have to be
directly connected to the NAS device. NDMP passes control of data and file metadata
to and from the NetWorker program.
The respective vendor’s documentation provides information on how to install an
NDMP data module or enable NDMP support on an application server.

Supported NDMP configurations
The NetWorker server with NDMP Connection supports these configurations:
◆

Local backup when using an NDMP Tape Server — The backup is performed to a
tape device attached to the server where the data resides.

◆

NetWorker Storage Node — The backup is performed from an NDMP host to a
NetWorker tape device, disk, optical, and other media type attached to a
NetWorker storage node.
NetWorker storage nodes use a data server agent (DSA). DSA acts as an agent in
the performance of backups between a NetWorker server and any client without
NetWorker software. An example of a DSA is an NDMP host that generates
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proprietary save data and sends that data to a NetWorker storage device to have a
save set associated to it. Similarly, a DSA will act as an agent in the recovery
between a NetWorker server and any client without NetWorker software.
Note: Any backup performed with the DSA feature has a D flag.
◆

Three-party that uses NDMP Tape Server — The backup is performed from one
NDMP server to another NDMP server.

Local backup by using an NDMP tape server
A local backup with an NDMP tape server means the data being backed up is sent
from the NDMP tape/data server (both on the same host) to its directly attached tape
device or library. The data does not traverse the network, thus preventing network
congestion.
With the local backup type, only metadata and NDMP control information (shown in
Figure 39 on page 522 as file history) traverse the network between the backup server
and the NDMP tape and data server. The NetWorker program uses the file history
information to maintain appropriate indexes and media databases.
Figure 39 illustrates a local backup type configuration. The NDMP host is both an
NDMP data service provider (DSP) and tape service.
The NetWorker server, or data management application (DMA) performs these tasks:
◆

Initiates the backup or recovery request through the NDMP connection.

◆

Receives the file history information from the data service and tape service.

The DSP performs these tasks:
◆

Receives the backup requests.

◆

Reads the backup data from disk.

◆

Produces a datastream for backup.

As a result, these actions occur:
◆

During a backup, the tape service reads a datastream from the DSP and writes it
to tape.

◆

During a recovery, the tape service reads data from tape and generates an NDMP
datastream.
The the following occurs:
1. The datastream is sent to the DSP.
2. The DSP reads from the datastream, and it to disk.

Supported NDMP configurations
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NetWorker Server (DMA)
UNIX or Windows

LAN
NDMP
Connection

File History

Backup Data
Cable
NDMP Data Server (DSP)

Figure 39

Autochanger

NDMP local configuration

Backup by using NetWorker storage node support
This section features the supported NDMP client backup configurations which use
non-NDMP based NetWorker devices, such as a tape, disk, or optical.
Figure 40 on page 523 illustrates a NetWorker storage device attached directly to the
NetWorker server. The NDMP backup that uses DSA, is initiated from the
NetWorker server. NDMP save set data may be written to either a file type device or
tape. Metadata, including file history, is processed in the NetWorker server
(nsrmmd).
Table 95 shows how DSA differs in use from NDMP tape server.
Table 95

Distinctions between NDMP tape server and DSA

NDMP Tape Server

DSA

Supports only NDMP type of tape device

Supports any type of NetWorker supported device.

Does not support backup to disk.

Supports backup to disk.

Does not support multiplexing.

Multiplexing is supported.

Record size is fixed for all device types, such as
DLT7000, SDLT, Ultrium.

Record size varies with the type of device, which
improves the write performances.

“Data write technologies” on page 542 provides information on storage technologies
under NetWorker storage node support for NDMP clients.
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Autochanger
NetWorker Server (DMA)

Cable

Backup and Metadata
LAN

NDMP Data Server (DSP)

Figure 40

Backup Initiated from a NetWorker server with an attached storage device

Figure 41 on page 523 illustrates a NetWorker configuration in which the file history
is backed up to the NetWorker server, and the data is backed up to the NetWorker
client with an attached storage node. The backup command, nsrndmp_save, is run
directly on the NetWorker client that has a NetWorker storage node locally attached.
Data is processed and saved to the NetWorker storage node, while the file history is
processed on the designated NetWorker server (nsrmmd).
After the data is backed up and sessions with the NDMP server and the NetWorker
server are closed, the file history is committed to the NetWorker server.
NetWorker
Storage Node

Autochanger

NetWorker Server

Cable
LAN

File History

Backup Data

NDMP Data Server (DSP)

Figure 41

File history and backup data to NetWorker storage node

Supported NDMP configurations
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In Figure 42 on page 524, the file history and data are backed up to the NetWorker
TM
server, which is also an EMC NetWorker SnapImage Module NDMP data server. In
this configuration, the data server does a block-level backup.
The storage technology is the same as in Figure 40 on page 523.
LAN

Backup Data
Cable
NetWorker (DMA) and
SnapImage Data Server

Autochanger
GEN-001254

Figure 42

Backup that uses SnapImage module

Three-party backup with NDMP tape server
A three-party backup, also known as a three-way backup, is completed by using two
NDMP servers. The data flows from the NDMP host (data service provider DSP) to
the NDMP tape server, and then to the library that is locally attached to the tape
server. The DSP might be an EMC, NetApp Filer, Auspex, or SnapImage Module.
Note: The two NDMP servers must be of the same type. For example, backups between an
EMC NAS device and a NetApp server are not supported. A NetApp server must back up
from, and recover to, another NetApp server.

Figure 43 on page 525 demonstrates a three-party configuration, which enables
backup and recovery to a NetWorker device that is attached to another NDMP
server.
◆

One server is the data server.

◆

The second server is the tape server.

◆

The third party is the NetWorker server (DMA).

This configuration is similar to the flow of data between a NetWorker client and a
NetWorker server or storage node, except that it is not necessary to install special
software on either end. Data flows from the NDMP data server over the network to
the tape server and then to tape. Metadata is sent from the data server to the backup
server.
Supported tape servers
The NetWorker software with NDMP supports these tape servers:
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◆

NetWorker NDMP TapeServer 2.0 software installed on the NetWorker server or
another server.

◆

NetWorker SnapImage Module software installed on the NetWorker server or
another server.

◆

DinoStor TapeServer connects one or more libraries to the network. This allows
any NDMP host to be backed up to one location instead of requiring a local
backup device for each server.
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NetWorker Server

NDMP Data Server
File History

NDMP
Connection
LAN

Backup Data
Cable
Autochanger

NDMP Tape Server

Figure 43

NDMP tape server

Requirements for and limitations of NDMP support
These sections contain information about requirements, support, and limitations of
the NetWorker software for NDMP, including “NetWorker storage node support for
NDMP clients” on page 528.

Requirements for NetWorker software with NDMP support
These requirements apply when running the NetWorker software with NDMP
support:
◆

To back up the bootstrap file, a non-NDMP device must be attached to the
NetWorker server. The bootstrap includes the media database and configuration
files needed to recover the NetWorker server after a disk crash.
This requirement does not apply when the backup is to a NetWorker storage node
with a non-NDMP device. In this case, the same non-NDMP device could be used
for a bootstrap device.

◆

To perform either an NDMP backup or recovery operation, you must be one of
these:
• Logged in as root
• Windows Administrator

◆

The media device handle must be a nonrewind device handle.

◆

To perform parallel backups, perform one of these actions.
• Specify multiple save sets in a single Client resource and verify multiple tape
drives are available.
• Specify multiple Client resources in separate groups (with one client/save
stream in each group) are configured with the same start time for each volume
to be backed up.
• Specify Save Set All.

◆

When recovering data in a localized NDMP environment, the Index Recover
status window shows the process in English, rather than the localized language.
Requirements for and limitations of NDMP support
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Limitations of the NetWorker software with NDMP support
The addition of NDMP support to a NetWorker datazone environment renders these
limitations:
◆

Other NDMP hosts cannot be browsed for backups. However, you can browse for
save set recoveries by using the command prompt, the NetWorker User
(Windows), or nwrecover (UNIX) program.

◆

Running the scanner command on a volume that has both NDMP and
non-NDMP save sets.
• Use a non-NDMP device path, an NDMP device path is not supported.
• Use a local device for improved performance.

◆

The following features are not supported:
• Archiving
• Save set consolidation
Save set consolidation interprets save records on the media. The DSA does not
write save records, hence the save set consolidation is not available. The DSA
acts as an agent in the performance of backups between a NetWorker server
and any client without NetWorker software that generates data and sends it to
a NetWorker storage node or device to have a save set associated to it.
• Cloning from NDMP tape device to non-NDMP tape device and vice versa
• The jbexercise utility

◆

NetWorker Server resource attributes (nsrmmd polling interval, nsrmmd restart
interval, and nsrmmd control timeout) do not apply to NDMP hosts, but they do
apply when using NetWorker storage nodes for backup and recovery of data.

◆

The NetWorker software does not support the recovery options Rename
Recovered File and Discard Recovered File for NDMP operations. For both save
set and file-by-file recoveries, current files are always overwritten.

◆

The scanner -i command fails for DSA save sets and skips them. The scanner –i
command is not supported for NDMP backups.

◆

The SIZED| flag is not supported with NDMP. This flag is set in the device
configuration attribute, Device tape flags, which is displayed only in Diagnostic
mode.

◆

The NDMP device block size should not exceed 256k for the NDMP backups to
complete successfully.

Protocol limitations
These protocol limitations apply to versions 1 and 2 of the NDMP protocol:
◆

The Save Set attribute default All is supported for NDMP servers with NDMP
version 3 or later.

◆

The library handle must be determined to run jbconfig.

Important notes on index processing and memory requirements
These notes concern the index processing and memory requirements and other
information about NDMP backups that use NetWorker software.
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Index Database
During an NDMP backup, the NDMP data server sends the file history metadata
information to the NetWorker server. The nsrndmp_2fh binary starts processing the
file history metadata immediately. The generation of the index database occurs at the
end of the backup by the nsrdmpix binary. The file history metadata processing scales
linearly with the increase in the number of entries (files) in the file system (save sets).
Especially during failover of a clustered NetWorker environment, if NDMP indexing
is interrupted, the following results occur:
◆

The nsrdmpix binary will not automatically restart.

◆

The generation of the index database may be incomplete.
• This means that a file-by-file recovery will not be possible.
• A save set recovery may still be performed.

Memory requirements
The nsrndmp_2fh and nsrdmpix binaries interact with the raw database, instead of
virtual memory, to process the file history metadata. Memory requirements for this
process are minimal.
Temporary space required during Backup

To determine the required physical space for the default \nsr\tmp directory per file
entry, use this formula.
2 * (144 + average filename length) * number of entries in the file system
Example 44 Calculating temporary space requirements

For one million file entries with an average filename length of 128, the required
temporary swap space is computed with this formula.
2 * (144 + 128) * 1,000,000 = 544 MB approximately
Changing the location of the temporary space directory

To change the location of the temporary space directory, provide a valid directory
name as a value to the NSR_NDMP_TMP_DIR variable:
1. Change the application information in the Client window.
2. Set an environment variable.
This change moves the creation of the temporary files to that directory.
Potential error messages

If a backup or recovery fails due to an inadequate amount of swap space, error
messages similar to the following appear:
Failed to store index entries

When the nsrndmp_2fh binary runs out of temporary space, this error message
appears.
IO_WritePage write failed - No space left on device (28): No space
left on device

The communication error between nsrndmp_save and nsrndmp_2fh results in this
error:
error in reading the FH entries from save through stdin

Requirements for and limitations of NDMP support
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NetWorker storage node support for NDMP clients
NetWorker storage node functionality includes NDMP save streams. NetWorker
storage node software can be used for both NDMP and non-NDMP based backups in
a unified fashion. For NDMP backups, NetWorker uses the DSA feature.
Clients that generate data have backup history in the form of manageable NetWorker
save sets. These clients are referred to as NDMP clients.
Note: The DSA feature listens on a port number in the “service port range” of that system (DSA
running host).

NDMP backups to non-NDMP based NetWorker devices
With this extension, NetWorker supports backup of an NDMP client to a non-NDMP
based NetWorker device such as:
◆

Tape

◆

Optical

◆

Disk

◆

Other media types

Features with NetWorker storage node support for NDMP
NetWorker storage node support for NDMP backups include these features:
◆

Multiplexing

◆

Staging

◆

Coexistence of NDMP save sets with non-NDMP based NetWorker save sets

◆

Firewall support

◆

Availability on wide variety of platforms

◆

Auto media verification

◆

Backup to disk

◆

True NetWorker client support

◆

Cloning

◆

Direct Access Restore (DAR)

Save set flags in media database
The mminfo program (with the -p option to display a report on the browse and
retention times for save sets) is used to view save sets. NetWorker storage node
support for NDMP clients uses different flags with this program.
Table 96 on page 528 lists the save set flags that are displayed by mminfo output and
their meanings.
Table 96
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DSA feature save set flags

Flag

Description

N

The client of the save set is an NDMP client.

s

The backup was performed to a NetWorker storage node by using DSA.

Ns

The backup was performed by an NDMP client to a NetWorker storage node by using DSA.

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

NetWorker Server Support for NDMP

Performance
An increase in NDMP backup performance can be seen in several instances.
The NDMP tape server is limited to use 60 KB as the record size to write to the tape.
For backup to non-NDMP devices, the size of the record depends on the type of the
media involved. For instance, for an dlt8000 tape device, the record size is 128 KB.
The backup speed increases when compared to the NDMP tape devices.
The nsrndmp_save command does not query the DSA every second to obtain the
backed-up size and update the NetWorker Console, NetWorker User or nwrecover
and nsrmmd, as it does the NDMP tape server while backing up to an NDMP tape
device.
◆

Backup to disk improves the performance.

◆

Staging and cloning do not need to involve the NDMP tape server.

During a volume selection process, loading and positioning the volume does not
occur. This is due to an exchange between nsrmmd and the nsrndmp_save or
nsrndmp_recover commands. This exchange is an overhead situation, which is
avoided by backing up to the NetWorker storage node.

Vendor-specific information
For information regarding the limitations, library configuration, and application
information variables of each vendor, see Table 97 on page 529.
Table 97

Vendor-specific information

Vendor

Refer to these links

Network Appliance

“Network Appliance” on page 556

Celerra

“EMC Celerra” on page 560

EMC IP4700

“EMC IP4700” on page 563

Auspex

“Auspex” on page 563

Procom NetFORCE

“Procom NetFORCE” on page 565

Mirapoint

“Mirapoint” on page 566

BlueArc

“BlueArc” on page 566

DinoStor

“DinoStor TapeServer” on page 567

SnapImage

“SnapImage or NDMP TapeServer Module” on page 568

Configuring the NetWorker server for NDMP operations
Before performing an NDMP backup, configure the NetWorker server for NDMP
operations. Use the NetWorker Console Administration window to configure the
resources listed in Table 98 on page 530 on the NetWorker server before backing up
data. Note that certain attributes of the resources are configured differently than for
non-NDMP clients. “Additional considerations for NDMP operations” on page 538
provides information on other configuration issues.

Configuring the NetWorker server for NDMP operations
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Note: Resources not listed in Table 98 on page 530 should be configured the same as for
non-NDMP operations.
Table 98

Configuring resources for NDMP

Resource

Configuration

Autochanger

Configure a library with the NetWorker Console Administration window. “Configuring library
support for NDMP” on page 530 provides instructions. “Ancillary product information” on
page 555 provides vendor-specific requirements.

Device

To use a stand-alone device, create a Device resource for NDMP backups. “Configuring an
NDMP device resource” on page 534. “Configuring library support for NDMP” on page 530
provides information on how to use a library.

Advanced File Type Device

Configure an advanced file device with the Administration window of the NetWorker Console.

Client

Create a Client resource with specific NDMP attributes. “Configuring an NDMP Client
resource” on page 535 . “Ancillary product information” on page 555 provides vendor-specific
requirements.
To perform NDMP-based backups and recoveries, the Client resource must be set up with
specific NDMP attributes.

Group

Add the NDMP client to a backup group.
If the backup contains more than five million files, set the Inactivity Timeout attribute to zero
(0). “Additional considerations for NDMP operations” on page 538 provides information on
additional issues.

Schedule

Select a schedule for the NDMP client. NDMP supports level full and levels 1-9.

Policy

Specify the browse and retention policies for the NDMP client.

Configuring library support for NDMP
Before performing an NDMP backup or recovery, configure the libraries by using the
server’s NetWorker Administration interface. Depending on the environment, the
library handle may not be required to configure the library:
◆

If the NDMP host is running NDMP version 3 or later and supports
NDMP_CONFIG interfaces, the library handle is not required to configure the
library.

◆

If the NDMP host is running NDMP version 2 or earlier or does not support
NDMP_CONFIG interfaces, the library handle is required to configure the
library.

To determine if the NDMP host supports NDMP_CONFIG interfaces, refer to the
appropriate vendor documentation.
Note: “Configuring an NDMP device resource” on page 534 provides instructions on creating
a Device resource for a stand-alone device.

Obtaining information about NDMP autochangers
Before the library can be configured for an NDMP backup and recovery, obtain the
pathname of the media device. “Ancillary product information” on page 555
provides instructions on obtaining the device pathname for a particular vendor.
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Using the NetWorker Administration window with NDMP devices
To use the NetWorker Administrator window to search for available devices on the
NDMP tape server:
1. From the Console window, click Enterprise.
2. Click the NetWorker server hostname.
3. Double-click NetWorker. The NetWorker Administration window opens.
4. Click Devices.
5. Right-click the NetWorker Server.
6. Select Scan for Devices.
7. Click the Monitoring button.
8. Click the Devices tab to view the device lists.
Using the inquire command with NDMP devices
Use the inquire command to search for available devices on the NDMP tape server.
The NDMP library information can be obtained two ways:
◆

From the location on the local server.

◆

On a specific NDMP host.

To obtain the NDMP library information:
1. Log in as root or as a member of the Windows Administrator’s group.
2. Type this command.
inquire -N ndmp_hostname

3. Respond to the NDMP prompts as they occur.
a. Type the username.
b. Type the password for the NDMP host hostname (characters will not be
echoed). The list of devices appears.
The EMC NetWorker Command Reference Guide or the UNIX man page provide more
information on the inquire command.
IMPORTANT
Use the inquire command with caution. Running inquire sends the SCSI inquiry
command to all devices detected on the SCSI bus. Using inquire during normal
operations may cause unforeseen errors and possible data loss may result.
Configuring an NDMP autochanger
The NetWorker server’s Administration interface and the NetWorker Autochanger
resource configuration tool, jbconfig, are used to configure libraries for NDMP
operations. Once the library is configured, the same interfaces are used to add or
remove drives and devices.
Chapter 3, “Configuring Libraries and Devices” provides information on how to
configure a library with the NetWorker server’s Administration interface.

Configuring the NetWorker server for NDMP operations
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To configure a library with the jbconfig tool:
1. Determine the device pathname information for the NDMP library. “Ancillary
product information” on page 555 provides information on how to obtain this
information.
2. At the command prompt, change to the <NetWorker_install_path>\bin directory.
3. As root or as a member of the Windows Administrator’s group, type the
following command:
jbconfig

The use of jbconfig requires an NDMP password for the computer with the
attached tape device.
4. When prompted, select one of these options and answer the questions that
appear:
• If the library is connected to an NDMP tape server and the robot is controlled
by the NDMP tape server, select the Autodetected NDMP SCSI Autochanger
option.
• If the NetWorker backup server or storage node controls the robot and shares
the library with an NDMP tape server, select the Autodetected SCSI
Autochanger option. Configure the tape drives to be used by the NDMP tape
server.
Example 45 How to configure an NDMP autochanger for a NetApp computer

This partial example demonstrates how to configure an NDMP library for a NetApp
filer by using the jbconfig program. The script uses the term jukebox instead of library.
The terms are interchangeable.
Note: This example might not be valid for some NDMP hosts. To identify valid device names,
refer to the NDMP host documentation.
jbconfig
1) Configure an AlphaStor/SmartMedia Jukebox.
2) Configure an Autodetected SCSI Jukebox.
3) Configure an Autodetected NDMP SCSI Jukebox.
4) Configure an SJI Jukebox.
5) Configure an STL Silo.
What kind of Jukebox are you configuring? [1] 3
Enter NDMP Server name: ? netapp-760-01
Enter NDMP user name: ? root
Enter NDMP password (characters will not be echoed):
Communicating to devices on NDMP Server 'netapp-760-01', this may take
a while...

When using NetWorker server’s Administration interface or the jbconfig program to
configure an autochanger, a new resource is created with the name specified. View
the new Library resource in the Libraries section of the NetWorker Console window.
The EMC NetWorker Command Reference Guide or the UNIX man page provide
information on the jbconfig command.
Chapter 3, “Configuring Libraries and Devices” provides more information on the
NetWorker server’s Administration interface.
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Sharing libraries among NDMP clients
The NetWorker software permits the control and use of individual devices within a
library to different NetWorker hosts within a datazone. If only NDMP hosts have
access to a library, the autochanger has to be defined as NDMP. In this situation, the
tape drives within the library can still be shared and controlled by one host, and
shared by the other hosts.
Robotic arm control
The library is configured for sharing during the initial library setup by using
NetWorker server’s Administration interface or the jbconfig program.
The jbconfig program must be run from the NetWorker server if the robotic arm is
owned by the server or an NDMP host, or from a standard storage node if that node
owns the robotic arm. The jbconfig program provides the following options.
◆

If the NetWorker server owns the robotic arm, run jbconfig from that server and
choose Autodetected SCSI Autochanger when prompted.

◆

If an NDMP host owns the robotic arm, run jbconfig from the NetWorker server
and choose Autodetected NDMP SCSI Autochanger.

◆

If a standard storage node owns the robotic arm, run jbconfig from that node and
choose Autodetected SCSI Autochanger.

While running jbconfig, identify the following when prompted.
◆

The NetWorker hostname and device path of the server that controls the first
library device.

◆

The controlling host for each device in the library.

Example 46 Robotic arm control

In a three-drive library shared among two NDMP hosts and a NetWorker server,
Host1 controls the arm and the first drive.
◆

When prompted for the owner of Host 1, specify the hostname:device path for
Host 1 as the host controlling the library device.

◆

When prompted for the owner of Drive 2, specify the hostname:device path for
Host 2 for the owner of Drive 2.

◆

When prompted for the owner of Drive 3, specify the NetWorker server
hostname:device path.

Chapter 3, “Configuring Libraries and Devices” provides more information on
sharing libraries.
DDS support with NDMP
The NetWorker software includes support for DDS, which provides the capability to
recognize shared drives. DDS enables NetWorker software to skip the shared drives
that are in use and route the backups or recoveries to other available shared drives.
For a list of NDMP disk and tape services that support DDS with the NetWorker
software, refer to the EMC NetWorker Software Compatibility Guide.
The DDS feature may be enabled when configuring a library through the jbconfig
program. Chapter 11, “Device Operations” provides more information about DDS
Support with NDMP.
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Enable the DDS feature
To enable DDS:
1. When prompted by the jbconfig program whether the drive is to be shared, type:
Yes
2. When prompted, assign a hardware ID.
3. Respond to the prompts as required for the first host to have access to the shared
drive.
4. When prompted whether this drive is to be shared with another host, type:
Yes
5. When prompted, type the hostname and device path of the second host to have
access to the shared drive.
6. Complete the prompts for the second device.
All the components of a SAN configuration must be compatible when DDS is enabled
with the NetWorker NDMP feature.
◆

The Fibre Channel switches must be compatible with any NDMP hosts within a
SAN.

◆

NDMP hosts and libraries in the SAN must also be compatible with each other.

Chapter 3, “Configuring Libraries and Devices” for additional information about
standard DDS
Running nsrjb to load tapes
If nsrjb is run to load a tape, include the -f option and rd syntax in the device name.
For example, if the NDMP hostname is nas1 and the device is nrst0a, and a tape is to
be loaded from slot 1, this syntax for loading a tape into that drive is used.
nsrjb -l -f rd="nas1:nrst0a (NDMP)" -S 1

Using nsrjb to load volumes in a jukebox connected to an NDMP server
To load the volume in slot 1 of jukebox mylibrary (connected to NDMP server
10.31.32.220), use the -J and -j options.
nsrjb -J 10.31.32.220 -j mylibrary -l -S 1

Silo support
A NetWorker server with NDMP enabled supports silos controlled by either ACSLS
or DAS controllers. Any silo behind the ACSLS or DAS is supported, since all robotic
control and communication is done by ACSLS and DAS, which receive commands
through TCP/IP from the NetWorker server.

Configuring an NDMP device resource
Chapter 3, “Configuring Libraries and Devices” provides details on how to configure
the Device resource in the standard, non-NDMP NetWorker software. This section
provides instructions for configuring the Device resource information when using a
stand-alone device with NDMP.
The jbconfig program creates the NDMP device for NDMP devices in a library.
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To configure an NDMP device (for non-storage node NDMP support) in the
Administration window of the NetWorker Console:
1. In the Administration window, click Devices.
2. Right-click Devices in the navigation tree, and select New.
3. Complete these attributes in the Create Device window.
a. For the Name attribute, specify the NDMP device by using this syntax:
rd=NDMP_computer:tape_device_pathname (NDMP)
Note: You must add (NDMP) after pathname. If you do not add it, you will receive the
following error message:
NDMP device name shall be in rd=<snode>:<devname (NDMP)> format

b. Set the Target Sessions attribute to 1. Multiplexing is not supported on NDMP
computers.
c. Complete the other attributes in the same manner as a non-NDMP client.
4. On the Configuration tab, complete these new device attributes.
a. Select the checkbox to set the NDMP attribute. This attribute can only be set
when creating the device. The NDMP attribute cannot be changed after the
device has been created. To change the device configuration, first delete the
configuration, then re-create it.
b. For the Remote User attribute, type the NDMP account username for the
computer where the NDMP library robotics or tape device resides.
c. For the Password attribute, type the password for the NDMP user account.
This password should match the password for the NDMP user account for the
computer where the NDMP library robotics or tape device is installed.
5. Complete any other attributes in the same manner as a non-NDMP NetWorker
device configuration.
Note: When configuring an NDMP Device resource, the Dedicated Storage Node attribute
must be set to its default value of No. A dedicated storage node cannot be used with the new
NDMP DSA feature, as a dedicated storage node will not work with nsrdsa_save. “Tips for
troubleshooting storage nodes” on page 103 provides information about the Dedicated Storage
Node.

Configuring an NDMP Client resource
“Task 6: Create a backup Client resource” on page 59 provides information on
creating a Client resource for non-NDMP operations. This procedure covers issues
related to specific attributes of the Client resource that are affected by NDMP.
To create an NDMP client in the Client resource:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clients.
3. On the General tab, complete the following attributes.
a. For the Name attribute, type the client name.
b. For the Save Set attribute, list the file systems to be backed up. To back up all
of the client’s file systems, specify All.
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535

NetWorker Server Support for NDMP

Note: If the NDMP server is running a version earlier than 3, the value All is not
supported. The file systems must be listed manually.

To back up large client file systems, optionally schedule each file system to
back up separately. For example, create two separate clients with the same
name, but with different save sets.
c. Complete the other attributes in the same manner as for a non-NDMP based
backup.
4. On the Globals (2 of 2) tab, specify the appropriate storage node in the Storage
Nodes attribute, depending on the type of backup to be performed.
• For a local backup, type the NDMP server name to which the tape device is
attached, listing this server first, unless -M is a parameter, in which case list
the storage node hostname first.
• For a three-party backup, list the destination server for the data being backed
up first. The client backs up the data to each NDMP server or storage node in
the order in which they appear in the attribute.
Complete the other attributes in the same manner as for a non-NDMP based
backup.
5. On the Apps and Modules tab, complete the following attributes.
a. For the Remote Access attribute, list all computers that will store and retrieve
entries for the client. In addition, list any computer that is used to browse
entries for the NDMP computer. Since the NetWorker server stores the client
file index entries for the NDMP computer, be sure that administrator@server is
listed.
b. For the Remote User attribute, type the NDMP account username for the
computer where the NDMP data module is installed. If this is administrator,
be sure that the administrator has a password.
c. For the Password attribute, type the password for the NDMP user account.
This password should match the password for the NDMP user account for the
computer where the NDMP data module is installed.
d. For the Backup Command attribute, set the value as follows:
– For use with NDMP Tape Server:
nsrndmp_save -T backup_type

– For use with storage node:
nsrndmp_save –s server –c client –M –T backup_type

– To back up an NDMP client to a non-NDMP device, use the -M option.
The value for the NDMP backup type depends on the type of NDMP host. For
example, NetApp, EMC, and Procom all support dump, so the value for the
Backup Command attribute is:
nsrndmp_save -T dump

For a list of backup values supported by a particular NDMP host, refer to the
appropriate vendor documentation.
e. For the Application Information attribute, list the NDMP environment
variables. “Specifying application information” on page 537. provides a list of
the variables and rules for typing their values.
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The NetWorker Command Reference Guide or the UNIX man page provide information on
the nsrndmp_save command.
6. On the Miscellaneous tab, select Yes for the NDMP attribute.
Note: Unless Yes is selected, the client will not be able to perform backups and recoveries. Any
NDMP operations involving a non-NDMP client would have to be run from the NetWorker server.
A non-NDMP client has no ndmpd service (or daemon) to connect to the server or another NDMP
target client for a directed recovery.

7. Complete any other attributes appropriate for a NetWorker client configuration.
Specifying application information
In the Application Information attribute, list environment variables that the NetWorker server
uses for an NDMP backup. For the backups to be successful:
◆

Separate the environment variable name from its value with an equal (=) sign, for
example:
HIST=y

◆

Type each environment variable in the Application Information attribute on a separate
line.

◆

Click Add after each entry.

The values typed depend on the NDMP host.
Required variables for all NDMP hosts
These application variables are required for all (or most) NDMP hosts.
◆

HIST=y
HIST determines whether a file history is created and required for index recovery. This
value must be set to y. This is also the default setting.
Note: For Mirapoint, this value must be set to n to deactivate creation of a file history during a
backup. The (fromimagefull=) option informs level backups about the date of the last full backup.
“Mirapoint” on page 566 provides more information.

Additional considerations for HIST=Y

When HIST=n, NDMP backups with NetWorker 7.2 and later are always run at level
FULL, even with a correct schedule and UPDATE=y (for more information, refer to
“UPDATE=y” on page 538).
A level FULL scheduled backup is performed if there is no previous fully browsable
version of the same save set. Furthermore,
• If HIST=y, full and successive level backups perform properly.
• If HIST=y and at least one browsable save set exists, then future level backups of the
same save set will back up at the specified level correctly.
• If HIST=n and no previous browsable backups of the save set exist, then all backups
will be at level full, regardless of level specified. If there was at least one time this save
set was backed up with HIST=y, all future HIST=n backups will be backed up at the
correct level, not otherwise.
• With NetWorker 7.2 and later, if HIST=n (other variables being DIRECT=y and
UPDATE=y), then all backups are performed at a level FULL, regardless of the level
specified. Note that the index backup is performed at LEVEL 1, but the data is always
at level FULL.
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• The behavior is the same with NDMP DSA and non-DSA NDMP 3. If the level
1 backup is forced outside of NetWorker using nsrndmp_save -T with the -l1
option, then a LEVEL 1 backup is performed.
◆

UPDATE=y
UPDATE forces the timestamp information to be updated with the time, date,
level, and file system that is being backed up. This value must be set to y. If a file
system is backed up at the same level as its previous backup, the old timestamp
information entry is overwritten with the new information.

Note: The environment variables are case-sensitive. Check with the vendor for the latest
information on supported values.

“Ancillary product information” on page 555 provides application information
variables for a specific vendor, see the particular vendor section. These values were
correct at the time of publication and must be set before a backup is performed. For
the latest information, check with the NDMP vendor.

Additional considerations for NDMP operations
These sections provide information about various NetWorker settings to modify for
NDMP operations.
Savegroup parallelism setting for NDMP tape server
By default, savegroup parallelism is set to zero, so the NetWorker server uses the
value of the client parallelism. Rather than depending on client parallelism, set the
Savegrp parallelism attribute for NDMP group backups to equal the number of
available NDMP drives. If the Savegrp parallelism attribute is set to a higher value,
there will not be enough drives to support all the save sets that are queued for a
backup. Large save sets may fail due to the Inactivity Timeout limit. In addition, if
more than one group is being backed up simultaneously, divide the number of drives
by the number of groups. Use that value for each of the Savegrp parallelism
attributes.

Performing NDMP backups
This section describes backups that use configurations with the NDMP Tape Server
and storage node support for NDMP.

Tape server support for NDMP client backup
These sections describe how to perform an NDMP backup by using the
nsrndmp_save command, NetWorker User, or the save program. The EMC NetWorker
Command Reference Guide or the UNIX man pages provides details. The
nsrndmp_save command is used in NDMP operations. This command supports
most of the same arguments as save by referencing the UNIX man page. The
-T backup_type option within nsrndmp_save identifies the NDMP backup type.
Prerequisites
Before performing a test backup, ensure that the following actions have been
performed.
◆
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◆

Add the NDMP host to a backup group.

◆

Select a backup schedule with browse and retention policies.

◆

Select a volume pool for the data.

◆

Install an NDMP data module or enable the application server for NDMP
operations. File systems on hosts without an NDMP data module cannot be
backed up through the NetWorker NDMP Connection.

◆

Configure a non-NDMP device to back up the bootstrap and index information. If
data is to be cloned, a second non-NDMP device must be configured to receive
the cloned bootstrap and index information. Note that the index and bootstrap
information is generated only if the scheduled group is backed up manually or
through the schedule.

Perform the test backup by running a scheduled group backup.
Locale settings with NDMP
When running NDMP backups, the locale setting has to be consistent in your
environment. All UNIX flavored locale settings on the filer (including UTF-8) must be
the same and the NMC client can be run only on a UNIX client set to the exact same
locale setting as the filer. Backup and recovery operations can be run on any locale,
but if you try to browse on a locale that is different from the original locale the
filenames appear as random characters.

Performing a local backup by using the NetWorker User program
Use this program to perform a local backup that is not scheduled. A three-party
backup cannot be performed with this program.
To perform a local backup:
1. In the NetWorker User program, click Backup.
2. In the Backup browse window, select the directories or files to be backed up.
3. To mark the files or directories for backup, click Mark.
4. To start the backup, click Start.

Performing an NDMP backup from the command prompt
Initiate NDMP backups from the command prompt by using the nsrndmp_save
command. To browse files or directories that have been backed up, use the
NetWorker User program, nwrecover, or the recover command.
Note: Configure the client in the Administration window of the NetWorker Console before
performing a backup from the command prompt.

To perform a backup from the command prompt, use this syntax.
nsrndmp_save -T backup_type -s server_name -c client_name
-l backup_level -N name -g save_group -W width -LL local path

where the -T option is the type of backup on the NDMP server, for example, celestra.
The EMC NetWorker Command Reference Guide or the UNIX man page provide
information on the nsrndmp_save command.
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During backup and recovery operations, the NDMP host provides information on the
amount of data moved. This status information is passed back to the NetWorker
server and can be accessed through the NetWorker Console.
Note: When backups are performed through the nsrndmp_save command, the bootstrap is not
automatically backed up. Without the bootstrap, a disaster recovery of an NDMP host cannot
be performed. To perform a bootstrap recovery of an NDMP host, use the savegrp -G
group_name command to back up the data. This command runs the specified backup group as if
it were initiated from within the NetWorker server. All environment settings specified for that
group, such as clients, pools, and schedules, are used.

Performing an NDMP DSA backup from the command prompt
Initiate NDMP DSA backups from the command prompt by using the nsrndmp_save
command with the -M option.
To perform a backup from the command prompt, use the following syntax.
nsrndmp_save -T backup_type -s server_name -c client_name
-I hostname -l backup_level -M -N name -P hostname
-g save_group -W width -LL local path

where
◆

The -M option designates a backup to a non-NDMP device. The NetWorker
software selects a storage node that has non-NDMP devices only. If there is more
than one, ascending order is used.

◆

The -P hostname option designates a host for the non-NDMP based backup.
• This option is valid only if the -M option is also present. If this option is
absent, then the host is assumed to be the host that is local to the
nsrndmp_save command. This hostname must be a valid NetWorker client and
should be listed in the remote access list of the NDMP Client resource.
• Unless the hostname of the client initiating the backup is added to the host for
the non-NDMP based backup’s /nsr/res/servers file (UNIX example), the
backup will fail.

Performing a three-party backup from the command prompt
Three-party backups involve two NDMP servers. “Three-party backup with NDMP
tape server” on page 524 provides details.
Note: For instructions on performing a remote backup, see “How to perform a remote backup
with the SnapImage/NDMP TapeServer software” on page 569.

To perform a three-party backup:
1. Set up the servers as demonstrated in Figure 43 on page 525.
2. Install the NetWorker software on the server designated as the NetWorker server.
Note: If the NetWorker storage node is involved in a configuration which uses a conventional
tape or disk device, then the bootstrap and file history can be saved conventionally. There is no
need then for additional setup and explicit definition for the NDMP storage device.

3. Configure the NetWorker server.
a. For the Name attribute of the Client resource, specify the hostname of the
NDMP host that contains the data to be backed up.
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b. For the Storage Nodes attribute of the Client resource, verify that the
destination server for the data being backed up is listed first.
The client directs the data to the first storage node in the list that has an
enabled device and is able to receive the data.
c. Complete the rest of the required Client resource attributes and configure the
NetWorker server in the same manner as for any other NDMP backup.
“Configuring the NetWorker server for NDMP operations” on page 529 provides
instructions on configuring a NetWorker server.

Performing DAR backups
DAR is an optimized data recovery operation that allows data to be recovered in the
middle of a tape set without the need to parse the tape set sequentially. This
significantly reduces recovery time of large backups.
DAR is supported with SnapImage and the NetWorker DSA feature. Any data server
that supports DAR is able to use this functionality when:
◆

DIRECT=y is set as an information variable

◆

DSA enabled storage node is used.

DSA acts as an agent in the performance of backups between a NetWorker server and
any client without NetWorker software. An example of a DSA is an NDMP host that
generates proprietary save data and sends that data to a NetWorker storage device to
have a save set associated to it. Similarly, a DSA acts as an agent in the recovery
between a NetWorker server and any client without NetWorker software.
When performing a DAR recovery from a tape device, the tape device needs to
support variable length records, refer to the tape device vendor’s manual. If the tape
device is not configured for variable length records, then DAR performance will
degrade. This is true for any tape server as well.
The EMC NetWorker Software Compatibility Guides provides information on how to
determine whether DAR is supported with a particular NDMP vendor.
To specify whether to use DAR, set the application information variables before the
backup, specify these values:
DIRECT=y
HIST=y
DAR is supported in these NDMP configurations.
◆

Local

◆

Three-party

A DAR backup is performed in the same manner as a non-NDMP based backup. A
DAR recovery is performed through the recover command, NetWorker User, or
nwrecover.
Note: The nsrndmp_recover program cannot be used for a recovery with DAR.
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Storage node support for NDMP client backup
In addition to being able to back up to an NDMP tape device, the nsrndmp_save
program enables NDMP clients to back up to a NetWorker non-NDMP storage
device (NetWorker storage node).
The EMC NetWorker Command Reference Guide or the UNIX man page provides more
information on the nsrndmp_save command.
These sections describe how to perform an NDMP backup by using the
nsrndmp_save command and the NetWorker User program. The EMC NetWorker
Command Reference Guide or the UNIX man page provide information on the
nsrndmp_save command.
The nsrndmp_save program starts the nsrdsa_save program (which is part of the
NetWorker client software package) to back up data to a NetWorker storage device.
The nsrndmp_save program receives the file history, then processes and stores the
indexes. The host on which the nsrndmp_save runs is the index host. The data to be
backed up is generated by the NDMP data server. The host on which the nsrdsa_save
program is running acts as a proxy to the NDMP host, which is the proxy host.
The nsrndmp_save program and nsrdsa_save program can be disassociated to run
on different index and proxy hosts. This action helps improve performance and is
highly scalable. For example, nsrndmp_save can be dedicated to run on a high-end
host for processing millions of indexes, while nsrdsa_save can run on another host
that has devices attached to it.
Data write technologies
The nsrdsa_save program, on execution, establishes a save session with the
NetWorker server and listens on a port number. After a DSA receives data from the
NDMP client, there are three different technologies that a DSA can use to write the
data to a NetWorker storage device.
◆

Immediate save technology
The DSA reads the data by using TCP/IP into shared memory. The nsrmmd
program writes the data to a storage device from shared memory. Virtually all the
data from the NDMP client goes directly to nsrmmd.

◆

Direct file access (DFA) technology for a backup to disk
DFA directly writes the data directly to disk, bypassing the storage node
(nsrmmd program). The storage node only plays a role in loading the volume.
This is a highly efficient and high performance approach.

◆

Nonimmediate save technology (or remote save)
The DSA reads the data by using TCP/IP into a local buffer and transmits it to the
nsrmmd program that is also using TCP/IP. The nsrmmd program writes it to the
storage device. This approach is inefficient and has slow performance.

Rather than nonimmediate save technology, configure the setup so that the storage
device is local to the nsrndmp_save program, and that an immediate save technology
is supported. If an immediate save technology is not supported, such as when the
attached storage device is remote, the DSA will fall back to a nonimmediate save
technology.
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Cloning and staging
After a backup is performed to a non-NDMP device, cloning and staging operations
can be performed by using non-NDMP based NetWorker cloning and staging
features and without involving the NDMP data or tape server. When NDMP save
sets are marked as non-NDMP based NetWorker save sets and the volume data
format is compatible with non-NDMP based NetWorker save sets, cloning and
staging operations can be performed normally.
Multiplexing
Based on the server and device parallelism values, simultaneous multiple NDMP
backup sessions can use a common non-NDMP device so that the device is kept busy.
Similarly, multiple simultaneous NDMP recover sessions can read from a common
volume if the data is multiplexed on that volume.
If the data is not multiplexed, then one NDMP save instance waits for the other to
finish in the event that there are no available resources.
Multiple NDMP save instances can coexist with non-NDMP NetWorker save
instances on the same volume. Any DSA save stream can join a non-NDMP
NetWorker save stream. Both can be sent to the same volume.

Incremental backups and token-based backup support
In NetWorker 7.6 Service Pack 2 or higher, NDMP uses token-based backups (TBB) to
perform NDMP full, incremental, and level 1-9 backups on NDMP servers that
support TBB and that have been qualified with NetWorker. Currently, Celerra and
NetApp servers with NDMP version 4 or higher support TBB and have been
qualified. However, check with Celerra and NetApp for the maximum number of
incremental levels supported with TBB incremental backups. NetWorker supports
the same number of incremental levels that are supported by Celerra and NetApp.
A major benefit of TBB support is that true incremental backups can be performed on
supported and qualified NDMP servers. On NDMP servers that do not support TBB
or that have not been qualified with NetWorker, incremental backups are not
supported. However, on these servers, you can use backup levels (1-9) to provide
limited incremental backup support. “Incremental backups on all other platforms”
on page 544 provides more information.
IMPORTANT
Always check with your NAS storage vendor to verify that NDMP incremental
backups are supported before using this feature.
Incremental backups with NetWorker 7.6 SP2 on Celerra or NetApp
If an incremental backup or a level 1 to 9 backup is configured, it will be performed
after the first full backup (including incrementals that are forced to full) after the
upgrade to NetWorker 7.6 SP2 or higher. Subsequent incremental or level 1 to 9
backups are performed as scheduled.
NDMP incremental backups can be scheduled and run from:
◆

A scheduled backup group, like any other NetWorker client.

◆

The NetWorker User program.

◆

The command prompt with the nsrndmp_save command.
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If you are running an incremental backup from the command prompt, specify a date
and time with the -t option along with the -l option. The -t option is the date and time
of the last backup. You can get the date and time of the last backup from the output of
the nsrndmp_save command that was run for the last backup. To find the date and
time, look for a line similar to the following:
42920:nsrndmp_save: browsable savetime=1296694621

Where the value after savetime= is a date and time that can be used with the -t option
when the next incremental or level 1-9 backup is run from the command prompt.
You can also find the date and time of the last backup by using the mminfo
command, for example:
mminfo -v -c nw_client

Where -v enables the display of verbose reports and -c nw_client specifies the
NetWorker client for which the date and time is being sought. The following is an
example of partial output from the mminfo -v -c command:
volume
vol.001
vol.001
vol.001

type
adv_file
adv_file
adv_file

client
date
time
nwclient1 02/16/11 15:23:58
nwclient1 02/16/11 15:39:58
nwclient1 02/11/11 09:24:23

size
ssid
fl lvl name
1853 MB 3864812701 cbNs full /.../set1
815 MB 3848036430 cbNs incr /.../set1
460 MB 3897913543 cbNs full /.../set2

You can specify the date and time with nsrndmp_save -t using the bolded values as
in -t "02/16/11 15:23:58". The double quotes are required when using date and time
information from the mminfo command.
If the -t option is not specified when nsrndmp_save is used from the command line,
then the NDMP server's native level-based backup will be used as described in
“Incremental backups on all other platforms” on page 544.
If the backup is run as part of a NetWorker scheduled backup group, date and time
information is supplied automatically and incremental and level backups work as
expected.
By default, support for incremental backups is provided after upgrading to
NetWorker 7.6 SP2 and if you are using a Celerra or NetApp storage platform. If
necessary, you can disable TBB support and therefore, support for incremental
backups, and revert to the NDMP server’s native level-based backup support by
placing the variable USE_TBB_IF_AVAILABLE=n in the NetWorker NDMP client
resource Application Information attribute. However, disable this attribute only in
consultation with NetWorker Technical Support.
Incremental backups on all other platforms
Prior to NetWorker release 7.6 Service Pack 2, or on storage platforms other than
Celerra and NetApp, the NetWorker software does not support incremental backups
for NDMP backups. If you select the incremental setting, the NetWorker server
performs a full backup. However, you can schedule level backups to function like
incremental backups. For example, a weekly backup schedule of full on day 1 and
incrementals on days 2 through 7 can be accomplished by setting up a weekly backup
schedule of full on day 1, level 1 on day 2, level 2 on day 3, level 3 on day 4, and so on.
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Force incremental and interval attributes for NDMP tape server
Note: This section does not apply to NDMP backups on the Celerra or NetApp storage platforms when
NetWorker 7.6 Service Pack 2 or higher is in use. Incremental backups are supported on these platforms.

If the Force Incremental attribute is set to Yes, and the Interval attribute is set to a value less
than 24 hours, execution of a level 1 to 9 backup from the Console, NetWorker User program,
or save program results in a full backup.

Performing NDMP recoveries
NDMP save set and directory-level recoveries are performed with NetWorker User
(Windows), nwrecover (UNIX), or the nsrndmp_recover command. NDMP file-by-file
recoveries are performed through nwrecover or the recover command.
The nsrndmp_recover command supports most of the same command line operations as
recover(1m), in addition to others that specifically support NDMP. When data is retrieved
with nwrecover (UNIX) or NetWorker User (Windows), the nsrndmp_recover command is
selected automatically.
Note: NDMP does not support the recover options Rename Recovered File and Discard Recovered
File. For both save set and file-by-file recoveries, current files are always overwritten.

Storage node support for NDMP client recovery
The nsrndmp_recover program recovers data from a NetWorker storage device when
nsrdsa_recover is started on the same host. The nsrndmp_recover program is spawned by
the following programs.
◆

recover

◆

nwrecover

◆

winworkr (NetWorker User graphical interface)

◆

command line

The nsrndmp_recover program sends data to the NDMP data server. The nsrndmp_recover
and nsrdsa_recover programs cannot disassociate themselves as with the backup programs,
nsrndmp_save and nsrdsa_save. The nsrndmp_recover program identifies that the save set
is stored on a non-NDMP device and invokes the nsrdsa_recover program to perform a
recovery from the non-NDMP device. There are no changes to the command line options for
nsrndmp_recover when using storage node support for NDMP client recovery.
Note: Data written to a storage device by the nsrdsa_save program can be recovered only by using the
nsrdsa_recover program. A tape that has NDMP data backed up with the nsrdsa_save program cannot
be used by any other recovery tool.

Optimizing recoveries
When a backup is performed with the -P, -I, or -M option, and the intention is to optimize
recovery time, launch a recovery on a host that has locally attached NetWorker devices. If a
recovery is launched on a host other than the device host, then the recovery performance will
degrade as data flows from the device host to the recovery host, and then from the recovery
host to the NDMP data server.

Performing NDMP recoveries
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Performing a save set recovery
These sections describe how to perform a save set recovery from the NetWorker User
or nwrecover programs, or from the command prompt. For , see “Performing a
directed recovery” on page 549 provides more information about directed recoveries.
How to perform a save set recovery with the NetWorker User program
To perform a save set recovery from the User program:
1. From the Operation menu, select Save Set Recover.
2. Select the NDMP client with the save set data to be recovered and click OK. The
save sets available for recovery appear in the Save Set dialog box.
3. From the Save Set Name list box, select the specific save set with the data to be
recovered. After a save set is selected, that save set’s backup instances appear in
the Version window.
4. Select the particular instance of the save set’s backup to recover.
5. If needed, specify a subdirectory in the Path to Recover attribute, and click Start.
Note: The Save Set Recover window contains a Recover Options window for NDMP
recoveries. This window is used if you are recovering the data to a path other than the save
path. “How to perform a directed save set recovery” on page 550 provides instructions on
using this window.

How to perform a save set recovery with the NetWorker Recover program
To recover save sets by using nwrecover:
1. In nwrecover program, select Save Set Recover from the Options menu.
2. In the Save Set window, click the save set to be recovered.
You can select an unlimited number of versions for the same save set for
simultaneous recovery.
• If you do not choose a save set from the list, the NetWorker server
automatically selects the last save set on the list.
• If you do not choose a save set instance to recover, the NetWorker server
automatically selects a save set instance.
3. When all the files to recover are selected, click Recover.
Perform a save set recovery from the command prompt
To perform a save set recovery from the command prompt, type:
nsrndmp_recover -c client -s server -S ssid/cloneid

For example, to recover data to the original location client named venus, with a server
named mars, from the command prompt, type:
nsrndmp_recover -c venus -s mars -S 2485094913
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Destructive save set recoveries
When NDMP data is backed up using the SnapImage Module, save set recoveries are
generally destructive. With a destructive save set recovery, data can recovered to the
original location or an alternate location, and in either case all existing data is
overwritten. Essentially, destructive save set recoveries overlay the data at File system
level and re-impose the saved image of the File system.
Destructive save set recoveries are performed using the nsrndmp_recover command
with the -r raw_device and -m mountpoint options. When -r raw_device is specified, -m
mountpoint is mandatory (however, when -m mountpoint is specified, -r raw_device is
not required). For example, on a Microsoft Windows system, the following command
would perform a destructive save set recovery to the P:\ drive:
nsrndmp_recover -s mars -c venus -m P:\ -r P:\ -S 2674606849

On a UNIX system, the following command would perform a destructive save set
recovery to the /dev/dsk/c1t1d0s0 device, mounted at /:
nsrndmp_recover -s mars -c venus -r /dev/dsk/c1t1d0s0 -S 2674606849 -m
/
Note: Excluding the –r option from the above commands, and then identifying the pathname
of the file to be restored, will make the SnapImage save set recoveries non-destructive and
operate at the file/directory level rather than the filesystem level. This will still overwrite
existing files on the destination that have the same names as those in the restore list, but will
leave other data untouched on the file system. This may be useful when doing a directory level
recovery in a high density filesystem environment to restore everything under one directory
when it is not practical to pass all the file names that use the NetWorker User or nwrecover
graphical interface.

The EMC NetWorker Command Reference Guide or the UNIX man page provide
information on the nsrndmp_recover command.

Performing a directory-level recovery
These sections describe how to perform a directory-level recovery from NetWorker
User or from the command prompt. “Performing a directed recovery” on page 549
provides information about directed recoveries.
How to perform a directory-level recovery from the NetWorker User program
To perform a directory-level recovery from the User program:
1. From the Operation menu, select Save Set Recover.
2. Select the NDMP client from the Source Client window with the save set data to
be recovered and click OK. The save sets available for recovery appear in the
Save Set dialog box.
3. In the Save Set Name list box, select the save set with the data to recover. The
save set’s backup instances appear in the Version window.
4. Select the particular instance of the save set’s backup to recover.
5. Click Start.
Note: The Save Set Recover window contains a Recover Options window for NDMP
recoveries. This window is used to recover data to a path other than the save path. “How to
perform a directed save set recovery” on page 550 provides instructions on using this window.

Performing NDMP recoveries
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How to perform a directory-level recovery from the command prompt
To perform a directory-level recovery:
◆

From a UNIX command prompt, type:
nsrndmp_recover -c client -s server -S ssid -v verify_flag paths

◆

From a Microsoft Windows command prompt, type this command:
nsrndmp_recover -s server -c client -R recover_target {-r rawdev -S
ssid -m mntpnt|-F} -v verify_flag paths

The EMC NetWorker Command Reference Guide or the UNIX man page provides
information on the nsrndmp_recover command.

Performing a file-by-file recovery
A file-by-file recovery only recovers a select group of files or directories. These
sections describe how to perform a file-by-file recovery.
How to perform a file-by-file recovery from the recover program
To recover files by using nwrecover:
1. To open the NetWorker Recover window, type the following at the command
prompt:
nwrecover

You can select a file that is listed in the NetWorker Recover window for recovery.
To perform a recovery:
a. Browse the index for a backups.
b. Select various versions of the file to recover.
c. View your marked files.
d. Relocate files upon recovery (optional).
e. Recover files from another authorized system (optional).
An authorized system is a client from which you have permission to recover data.
2. If necessary, select a server by clicking Change Server on the speedbar.
3. If necessary, change the level of displayed file information.
• To expand the directory display one level, double-click the directory folder in
the directory display.
• To expand a directory branch to display subdirectories, click a directory folder
and select Expand Branch from the tree menu.
• To collapse a branch, double-click the directory folder in the display.
• To view detailed information for files in a directory, select File Details from
the View menu.
4. Select the files (or directories) to be recovered, and click Mark.
5. From the View menu, select Volumes to see whether the volumes are online for
the recovery.
6. Click Start to begin the recovery.
7. In the Conflict Resolution dialog box, click OK.
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8. When the recover completion time message in the Recover Status window
appears, click Cancel to close the window.
How to perform a file-by-file recovery with the NetWorker User program
To perform a file-by-file recovery with the User program:
1. Click Recover to open the Source Client dialog box.
2. Select the source client with the data to recover, and click OK.
The local client is the default selection.
3. In the left pane of the Recover window, select the save set that contains the
required files.
4. In the right pane, select the file or files to recover.
5. Click Mark to select these files for recovery.
6. To recover the files to another path on the same host:
a. From the Options menu, select Recover Options.
b. In the Relocate Recovered Data To text box, specify the path.
c. Click OK.
7. Click Start.
How to perform a file-by-file recovery from the command prompt
To perform a file-by-file recovery:
1. From the command prompt, type:
recover -s server

2. When prompted, type the directory to browse, for example:
cd \.

3. Issue the appropriate commands to add the necessary files to the recover list. The
EMC NetWorker Command Reference Guide provide a complete list of command
options.
4. When all the required files have been added, type:
recover
On a Microsoft Windows a Windows system program named recover.exe is also
located in %SystemRoot%\System32. To avoid using the Windows version of
recover.exe, do one of the following:
◆

Include the full path at the command prompt.

◆

Ensure that <NetWorker_install_path>\bin is listed before
%SystemRoot%\System32 in the PATH environment variable.

Performing a directed recovery
NetWorker software with NDMP supports directed recoveries that enable you to
recover backup data to a host or path other than the one used to back up the original
data.

Performing NDMP recoveries
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Note: The operating system of the target host (hostname) must be the same as the one used to
back up the data, and the target host must be a client of the NetWorker server. If it is not a
client, the server cannot obtain the correct username and password, and the data cannot be
recovered to that host. For example, if the original data was backed up to a NetApp filer, the
data must be recovered to the same NetApp filer or another NetApp filer that is a NetWorker
client.

Note: To perform a directed recovery with an Auspex filer, Auspex requires that you specify an
existing directory as the destination directory. If the directory does not already exist, the
recovery will not complete.

How to perform a directed save set recovery
You can perform a directed save set recovery by using the NetWorker User program
or the nsrndmp_recover command.
◆

When using NetWorker User:
1. From the Operation menu, select Save Set Recover.
2. In the Source Client window, select the source client.
3. In the Save Sets dialog box, select the backup version to recover.
4. Click Recover Options. The NDMP Recover Options window appears.
5. In the Destination Client text box, specify the client to receive the recovered
data.
6. In the Relocate Recovered Data To This Path text box, specify the recovery
path for the volume. If recovering to a Windows platform, this attribute
should contain the same drive letter as the Raw Device attribute.
Note: If you are recovering to a filer or UNIX platform, specify
target_hostname::/mount_point.

7. In the Relocate Recovered Data To This Raw Device text box, specify the
drive letter of the destination drive. If you do not specify the raw device name
of the destination, the save set is recovered and the files are overwritten, but
the current file system structure is retained.
8. Click OK.
9. In the Save Set window, click OK.
◆

When using nsrndmp_recover, type:
nsrndmp_recover -c client -m target_hostname::/mount_point -S ssid

For the mount point, specify the NAS computer hostname. If you are using Data
ONTAP, you might need to add a slash (/) after the mount point. For example,
target_hostname::/mount_point/.
Note: In these command sequences, the host specified is the target host to which the data is
recovered. If a host is not specified, the data is recovered to the original application server. The
mount_point variable remains the previously defined mount point of the application server.

The EMC NetWorker Command Reference Guide or the UNIX man page provide more
information on the nsrndmp_recover command.
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How to perform a directed file-by-file recovery
You can perform a directed file-by-file (Windows) recovery by using either the
NetWorker User program or the recover command.
◆

When using the NetWorker User program:
1. Click Recover to open the Source Client dialog box.
2. Select the source client with the data to be recovered, and click OK.
3. Select the source client with the data to recover, and click OK.
4. In the left pane of the Recover window, select the save set that contains the
files to recover.
5. In the right pane, select the files to recover.
6. Click Mark, then Start.

◆

When using the interactive recover program:
1. From the command prompt, type:
recover -s server
2. When prompted, type the directory to browse, for example:
cd \.

3. Run the appropriate commands to add the necessary files to the recover list.
The EMC NetWorker Command Reference Guide or the UNIX man page provide
a complete list of command options.
4. To recover the files to a different location, type:
relocate target_hostname::\mount_point
Note: In these command sequences, the host specified is the target host. If a host is not
specified, the target is the original application server. For the mount point, specify the
NAS computer hostname. If you are using Data ONTAP, you might need to add a
backslash (\) after the mount point. Here is an example,
target_hostname::\mount_point\.

5. When all the required files have been added, type this command:
recover

The files are recovered to the specified location.
How to perform a directed index recovery
You can perform a directed index (UNIX) recovery using the recover program.
1. From the command prompt, type:
recover -s server

2. When prompted, type the directory to browse, for example:
cd /.

3. Run the appropriate commands to add the necessary files to the recover list.
The EMC NetWorker Command Reference Guide or the UNIX man page provide a
complete list of command options.
4. To recover the files to a different location, type this command:
relocate target_hostname::/mount_point

Performing NDMP recoveries
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Note: In these command sequences, the host specified is the target host. If a host is not
specified, the target is the original application server. For the mount point, specify the NAS
computer hostname. If you are using Data ONTAP, you might need to add a slash (/) after
the mount point, for example, target_hostname::/mount_point/.

5. When all the required files have been added, type:
recover

The files are recovered to the specified location.

NDMP cloning
NDMP cloning is set through the same NetWorker clone interface as non-NDMP
based backups. Chapter 9, “Cloning” provides information on how to clone data.
Note: To support cloning, the source NDMP host must be running NDMP version 3 or later.
The destination server can be running any version of NDMP, but a volume cloned with NDMP
earlier than version 3 cannot be cloned again to another volume.

Cloning between storage nodes
Cloning between storage nodes is accomplished by an NDMP tape server on the
source node by reading from a volume, and another NDMP tape server on the target
node by writing to a volume. However, cloning from a NDMP tape device to a
non-NDMP tape device, and vice-versa, is not supported.
If the save set to be cloned was backed up by nsrndmp_save by using nsrdsa_save
(that is, the DSA feature save set flags are used to differentiate the save set records,
which include N and s), then use nsrclone, and not nsrndmp_clone, to clone these
save sets. The nsrdsa_save generated save sets can be cloned to any NetWorker
storage device other than an NDMP tape device.
The source node is determined by the location of a source volume. The location of the
source volume is determined either by its currently mounted location or, if
unmounted, by its location field (see the mmlocate man page). The target node of a
clone is found by the Clone Storage Nodes attribute of the Client resource in
descending priority.

Cloning functionality
The following functionality applies to NDMP cloning.
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◆

The NetWorker Console and the command line interface support volume cloning,
save set cloning, and the cloning of all save sets as part of a scheduled group.

◆

NDMP tapes from one NDMP host can be cloned to another NDMP host of the
same type. For example, tapes from a NetApp filer that has a library attached can
be cloned to another NetApp filer or to the same filer.

◆

NDMP cloning can copy data from one type of tape device to another, for
example data from DLT to AIT.

◆

Once the cloning is complete, the NetWorker server verifies that the cloned copy
was successfully created. In the Volumes window that contains the save set
information, the cloned save set is marked cloned.
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◆

A cloned volume or save set can be automatically or recovered manually.
“Volume cloning” on page 227 and “Recovering cloned data” on page 227
provide more information.

NDMP index and bootstrap cloning
Index and bootstrap cloning is performed only through a non-NDMP-based cloning
device. Index and bootstrap cloning can be achieved either through the command
prompt by using nsrclone or by using the NetWorker Console through a scheduled
group with automatic cloning.
“Setting up a schedule clone job” on page 220 provides more information on
automatic cloning.
A full device setup for NDMP cloning involves four devices when automatic cloning
is enabled.
◆

An NDMP tape device that is used for NDMP backups and is the source device
for NDMP cloning.

◆

An NDMP cloning device that is used to clone an NDMP save set or volume.

◆

A non-NDMP device that is used for backing up bootstrap information and
indexes.

◆

A non-NDMP cloning device that is used for cloning indexes and bootstrap from
an NDMP backup.

Note: The indexes and bootstrap are non-NDMP save sets, so a non-NDMP device is needed to
clone those non-NDMP save sets. The indexes and bootstrap both go to the same volume,
unless they are configured to go to separate devices.

When cloning is performed manually, a minimum of two devices are required, one to
read the existing data and one to write the cloned data. “Cloning a save set
manually” on page 223 provides more information.

NDMP Path-to-Tape cloning for regular save sets
NetWorker 7.5 and higher supports NDMP path-to-tape cloning of regular save sets
with the nsrndmp_clone command.
Using NDMP cloning, regular NetWorker save sets from a DL3D 1500 or 3000 Virtual
Tape Library (VTL) running version 1.1.2, can be copied directly to a physical tape
library, which is attached to the VTL. This process, also known as path-to-tape, frees
up network bandwidth and offloads NetWorker storage node I/O resources because
save set data does not go through the storage nodes. NetWorker manages the data
movement and catalogs the physical tape copy in the media database as a clone
instance. Both the VTL and the physical tape devices are visible to the NetWorker
storage node and restores can be performed directly from either copy.
IMPORTANT
This feature is available with EMC DL3D models 1500 and 3000 at version 1.1.2,
Version 1.1.2 is available on request from your EMC DL3D account representative.
The path-to-tape feature can also be set up to move data from one physical tape
library to another physical tape library. Additionally, all NDMP clone options work
with the path-to-tape feature.

NDMP cloning
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Requirements and limitations for NDMP cloning regular save sets
Ensure that the following are configured before starting the NDMP cloning process:
◆

An NDMP storage node resource is required for the VTL. The VTL must have
drives configured for NDMP.

◆

An NDMP storage node resource is required for the physical tape library. The
physical tape library must have drives configured for NDMP.

◆

A client resource must be defined for the storage node. For example, if a disk
library/EDL is used as an NDMP storage node, create a client resource for that
storage node.

◆

The Client resource that corresponds to the source save sets or volumes must
have its Clone Storage Node attribute set to the destination storage node host,
which is where the clone data is to be written. The destination storage node is
usually the hostname of the NDMP storage node for the physical tape library.

◆

Do not use the "device tape flags" variable (if you are in Diagnostic Mode) to
restrict the volume size when performing NDMP (including path-to-tape)
cloning.

Path-to-Tape cloning for tapes with different block sizes
From release 7.6 onwards, NetWorker supports path-to-tape cloning between tapes of
different block sizes.
Note that, however, NetWorker does not support cloning of a path-to-tape clone
instance that is cloned from a tape of a different device file size than that of the
original source tape.
For example, consider the case in which you create a back up save set (referred to as
clone instance #1 by default) on an LTO-3 tape that has a block size of 128KB and a
device file size of 4GB. Using path-to-tape, you then create a clone save set (clone
instance #2) to another LTO-1 tape that has a block size of 64KB and a device file size
of 1GB. If you use path-to-tape to clone "clone instance #2" to another LTO-1 tape, the
cloning attempt will fail with the following error messages:
nsrndmp_clone: Error - Incorrect tape file size
<current_tape_file_size>
nsrndmp_clone: Set device file size to <recommended_value> in source
device properties
You will have to change the source device file to the value suggested
by the nsrndmp_clone error messages.

In this scenario, you could perform one of the following options, however, it is
recommended that you perform option 2:
◆

Option 1
Change the source (clone instance #2) device file size to the value suggested in
the error message and restart the clone operation.
IMPORTANT

!

After the cloning operation, change the source device file size back to its
original value; otherwise, subsequent cloning attempts using this source
device would create clone instances that may not be recoverable.
◆
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Option 2
Perform the second clone operation from the original source, which is clone
instance #1 in this example.
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Using the nsrdmp_clone command for cloning regular save sets
For NDMP cloning of regular save sets, use the following command:
nsrndmp_clone -J ndmp_storage_node -p -b clone_pool -S ssid1 ssid2...

where:
◆

The -J option is used to specify the ndmp clone to load the source device on a
specified host.

◆

The -p option is used to create a clone of regular save sets.

◆

The -b option is used to specify the pool type.

◆

The -S option is used to identify the save set ID(s).

Note: NDMP supports cloning of opaque save sets with same block or device file sizes from the
original size.

Recover can be done from the original backup or from the clone copy. You can
perform a regular file-by-file or save set recover. A regular storage node resource is
required both for the VTL and the physical library. The VTL and the physical tape
library must have drives configured for SCSI. The recover process will automatically
load the volume from an NDMP drive to a non-NDMP drive (SCSI path).
Note: The recovery process automatically selects a SCSI path for recovery. It will not select the
NDMP path because the save sets to be recovered are non-NDMP save sets.

Ancillary product information
These sections cover limitations and configuration requirements for specific vendors
and other NetWorker modules:
◆

“Filers that act as data servers” on page 555

◆

“Filers that act as tape servers only” on page 567

Filers that act as data servers
This section contains configuration information for these vendor products that act as
NDMP data servers:
◆

“Network Appliance” on page 556

◆

“EMC Celerra” on page 560

◆

“EMC Centera” on page 562

◆

“EMC IP4700” on page 563

◆

“Auspex” on page 563

◆

“Procom NetFORCE” on page 565

◆

“Mirapoint” on page 566

◆

“BlueArc” on page 566

Ancillary product information
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Backup on NDMP servers is dependent on the data server provider type. Servers use
the commands listed in Table 99 on page 556.
Table 99

NDMP server examples

Server

Command

Function

EMC

dump

Used for backing up filer data to tape. Also used to back up directories, quota
trees, or entire volumes.

NetApp

dump

Used for backing up filer data to tape. Also used to back up directories, quota
trees, or entire volumes.

Auspex

gtar

Used for archiving the contents of a directory to a file or tape.

EMC SnapImage Module

SIDF or dd

SIDF (System Independent Data Format) backups allow users to interchange
media with operating system backup utilities and other tape backup products
from vendors that comply with the SIDF standard.
A dd-compatible command backs up all blocks in the file system. Data is
written in dd image.

Only those variables listed in the sections corresponding to a given NAS filer are
supported by the NetWorker software. Variables documented in NAS filer reference
guides do not necessarily work for NetWorker backups. In these cases, the results
may be unpredictable.
For example, the variable FILESYSTEM is supported by NetApp. With NetWorker
7.2.x, this value is passed to NetApp, which translates the path as required. This is the
path that is backed up, not the one specified by the save set.

Network Appliance
The following sections provide information about limitations, autochanger
configuration, and application information variables for the NetApp filer. For a
complete list of supported Data ONTAP versions, refer to the EMC NetWorker
Software Compatibility Guide.
Features and limitations
These sections cover NDMP issues that are specific to NetApp hosts.
Note: NetApp passwords are limited to eight characters.

Backup and recovery of large number of files
On Network Appliance clients with an operating system of Data OnTap 6.4 and later,
all metadata is read from tape before the files are recovered. As such, with large save
sets (save sets with 20 million files or more), the recovery time for a file can exceed
three hours. This also applies for backup, as the metadata for the whole volume is
recorded onto tape even for a single file backup.
UTF-8 versions supported
The NetWorker software supports the UTF-8 format with CIFS clients. NFS clients of
a NetApp filer are only supported if the NFS clients can generate UTF-8 encoded
data. Support for UTF-8 is specified in the Application Information attribute of the
Client resource.
UTF8=n is the default setting and should remain set.It is no longer required to set the
UTF8=y variable in the Application Information attribute during a NetWorker client
configuration for NDMP clients. If the UTF8=Y variable is set during an NDMP client
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backup and the backup contains pathnames with non-ascii characters, an index based
recovery of this backup will fail with the error “RESTORE: could not create path
<pathname>”.
If upgrading from any NetWorker release previous to 7.3 Service Pack 3, remove the
UTF8=y variable from the client configuration in order to ensure successful backup
and recovery operations:
1. Connect to the NetWorker server using the NetWorker Management Console
(NMC).
2. Click on the Configuration button.
3. Click on Clients.
4. In the clients window, right-click on the NDMP client and select Properties.
5. Click the Apps and Modules tab.
6. In the Application Information section, remove UTF8=Y if defined.
7. Click OK.
For existing backups that were run with UTF8=y in NetWorker 7.3 Service Pack 3 or
later, pathnames with non-ascii characters must be recovered using either a save set
recovery from the command line, or NDMP Directory restore.
Note: Ensure that the NAS filer is configured for UTF8 characters sets. Contact your NAS
vendor for configuration requirements.”

Single save sets support only one code set
A single save set supports data that belong to only one code set. If you have data in
multiple code sets, you must create multiple save groups.
The save set can contain filenames that belong to different languages if all characters
in those languages belong to the same code set. For example ISO 8859-1 and ISO
8859-15 include most Western European languages, such as French, Spanish, and
Portuguese, so filenames from these languages can be backed up in a single save set.
Required NDMP version when running DAR on a NetApp host
To run DAR on a NetApp host, you must have NDMP version 3 or later. Recoveries
fail if an earlier NDMP version is used.
How to verify the NDMP version
To verify the NDMP version:
1. Log in to the NetApp host as root or as a Windows Administrator.
2. Type this command:
ndmpd version

The NDMP version is displayed.
How to change the NDMP version
To change the NDMP version:
1. Log in as root or as Windows Administrator.
2. Stop the NDMP process by typing:
ndmpd off

The NetApp host confirms that the NDMP process has stopped.
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3. To change the NDMP version, type:
ndmpd version 4

The NetApp host confirms that the NDMP version is now set to 4.
Note: The NDMP version can also be set to 3.

4. To restart the NDMP process, type:
ndmpd on

The NetApp host confirms that the NDMP process has started, and DAR can now be
run.
NetApp zoning requirements for DDS in a SAN environment
In order to configure DDS with NetApp filers, a zoned SAN configuration is required.
Zoning is a feature of the Fibre Channel switch.
The NetApp zone, which contains only the NetApp filers and tape devices, must be
configured on the Fibre Channel switch. This NetApp zone may also include the
robotic arm and must also be configured in an arbitrated loop.
All non-NetApp servers that are attached to the same Fibre Channel switch must be
excluded from the NetApp zone. A separate zone must be configured for the
non-NetApp servers, in which an arbitrated loop may or may not be a requirement.
The NetApp zone and all other zones can overlap on the tape devices within the
SAN, so that the tape devices are visible to both zones.
How to find the device pathname for a NetApp host
The pathname of the media device is required before the autochanger for NDMP
backups and recoveries can be configured. Use the pathname to configure the
autochanger with the jbconfig program, as described in “Configuring library
support for NDMP” on page 530.
Note: This procedure is only an example. For the correct syntax and usage, refer to the NetApp
documentation.

To identify the media device pathname:
1. Log in as root or as Windows Administrator
2. Verify that the tape device is installed on the NetApp filer by typing this
command.
sysconfig -v

The host responds with:
NetApp Release 6.2: Sun Mar 12 13:29:37 PST 2009
System ID: 0016784666 (NetAppHost1)
slot 6: SCSI Host Adapter 6 (Qlogic ISP 1040B)
Fast/Wide, Differential
Firmware Version 4.65 Clock Rate 60MHz.
4: QUANTUM Powerstor L200 001F
5: QUANTUM DLT7000
2255

3. Determine the device pathname by typing this command.
sysconfig -t

The host responds with a list of media device names.
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Tape drive (6.5) Digital DLT7000
nrst0a - no rewind device, format is: 85937 bpi 70 GB (w/comp)
nrst0m - no rewind device, format is: 85937 bpi 35 GB

where:
• (6.5) indicates slot 6 and SCSI ID 5. This information must match the output in
the sysconfig -v command.
• nrst0a is the media device name.
If the NDMP tape server is running version 2 or does not support
NDMP_CONFIG interfaces, determine the autochanger handle by typing this
command.
sysconfig -m

The host responds with the devices on the host.
Media changer (6.4)
device

QUANTUM

Powerstor L200 mc0 - media changer

where mc0 is the autochanger handle.
Note: When jbconfig prompts for the hostname and device path for a NetApp device, do not
type a slash before the device name. Although the jbconfig program completes without errors
if the slash is typed, NetApp will not recognize the tape device or autochanger, and you will be
unable to label the tape.

Application information variables
In addition to the standard application information variables, HIST=y and
UPDATE=y, that are required for all vendors, Table 100 lists variables specific to
NetApp that may be required. Type these variables in the Application Information
attribute of the Client resource, as described in “Configuring an NDMP Client
resource” on page 535.

Table 100

NetApp application information variables (1 of 2)

Variable

Required

Values and meaning

FILESYSYTEM=path

No

This variable, if passed to NetApp, will supersede the save set specification.

DIRECT= y/n

Yes for DAR
operations

This value must be set to y if you are performing a DAR recovery. If you are
not performing a DAR recovery, the value is set to n. DAR is supported on
Data ONTAP 6.1 and later.
“Performing DAR backups” on page 541 provides additional information about
DAR.
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Table 100

NetApp application information variables (2 of 2)

Variable

Required

Values and meaning

EXCLUDE=

No

This string value determines which files are excluded from backup. These
rules apply.
• The string is a filename. Only filenames are accepted, not absolute paths.
• The asterisk (*) is accepted as a wildcard, but it must be the first or last
character in the string (or both).
• To list multiple files, separate each name with a comma. A comma cannot
appear as part of the filename. Spaces are not allowed.
• You can specify up to 32 strings.

EXTRACT_ACL= y

Yes to recover
ACLs

To recover access control lists (ACLs) when using DAR with a NetApp host,
you must set the value to y. The default is n.

UTF8=n

For UTF-8
formatted data

The default is n and should remain set

EMC Celerra
These sections provide information about limitations, autochanger configuration, and
application information variables for the Celerra host. The EMC Software Compatibility
Guide provides a complete list of supported versions.
Celerra considerations with NDMP
These sections discuss NDMP issues that are specific to Celerra filers.
Celerra backup of root file system

Instead of specifying a save set of All for an Celerra backup operation, the separate
file systems should be named in the save set definition, excluding the root, or “/” file
system. Including the root file system causes the client index to fail.
Using an earlier version of NDMP on Celerra Data Movers

Celerra data movers are run in the default configuration, which enables support for
the latest version of NDMP. Servers autonegotiate with other NDMP devices so that
the NDMP versions are compatible. At times, the autonegotiation function fails. In
this case, Celerra can be forced to use an earlier version of NDMP to test whether the
devices can still function. This can also help to isolate NDMP issues by determining if
the problem happens with different versions.
Lower the NDMP version on Celerra
The NDMP version must be set individually on each data mover that requires the
modification.
To set the NDMP version on Celerra data movers so that the data mover negotiates
only at the specified NDMP version or an earlier version:
1. Log in as root or as a Windows Administrator to the Celerra Control Station.
2. At the command prompt, type:
cd /nas/server/slot_#

where slot_# refers to the server number.
For example, /nas/server/slot_2/netd contains the configuration files for
server_2.
3. Open the netd file in a text editor such as vi.
4. At the end of the NDMP string in the netd file, type:
proto=ndmp_version_#
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For example, the resulting NDMP string is this when setting the NDMP version to
3.
ndmp port=10000 proto=3
5. Save the file.
6. Reboot the data mover by typing this command.
server_cpu server_name -reboot -m now

How to set the ntape parameter
To help avoid tape drive issues, set the ntape parameter on the Celerra filer. For every
tape drive discovered on a particular data mover there must be a corresponding
value set for the NDMP ntape=# value. For example, if a data mover has five tape
drives configured on it, set the parameter to NDMP ntape=5.
To modify the parameter:
1. With a text editor, open the /nas/server/slot_#/param file, where slot_#
correlates directly to the server number. For example, /nas/server/slot_2/netd
contains the configuration files for server_2.
2. Add or modify this line.
NDMP ntape=n
Note: The value of n cannot be greater than 8.

3. In order for the changes to take effect, reboot the data mover.
How to find the device pathname for a Celerra host
The pathname of the media device is required before the autochanger for NDMP
backups and recoveries can be configured. Use the pathname to configure the
autochanger with the jbconfig program, as described in “Configuring library
support for NDMP” on page 530.
Note: This procedure is only an example. For the correct syntax and usage, refer to the Celerra
documentation.

To identify the device pathname, perform one of these actions.
◆

Re-create all devices and view all nondisks by typing the following commands at
the command prompt:
Celerra server_devconfig movername -create -scsi -all
Celerra server_devconfig movername -list -scsi -nondisks

◆

Obtain the device pathname through the Celerra Administrator program.
To access the Celerra Administrator program:
a. In the browser window, type the following URL:
http://EMCcontrolhostIP:8000/top_level.htm.

b. Type your username and password.
c. Use the Celerra Administrator program to list and/or determine SCSI
devices.
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Note: If the NDMP tape server is running version 2 or does not support
NDMP_CONFIG interfaces, locate the autochanger handle in the Celerra
Administrator program.

Application information variables
In addition to the standard application information variables, HIST=y and
UPDATE=y, that are required for all vendors, Table 101 lists Celerra-specific
variables that may be required. Type these variables in the Application Information
attribute of the Client resource, as described in “Configuring an NDMP Client
resource” on page 535.
Table 101

Celerra variables

Variable

Required

Values and meaning

DIRECT= y/n

Yes for DAR
operations

This value must be set to y if you are performing a DAR recovery. If you are
not performing a DAR recovery, set the value to n.
“Performing DAR backups” on page 541 provides additional information about
DAR.

EMC_EDIRnn=

No

This string value identifies a directory to be excluded from the backup. The
asterisk (*) is accepted as a wildcard as the last character. Multiple directories
an be included by incrementing the number; for example:
• EMC_EDIR01=/fsX/DIRx
• EMC_EDIR02=/fsX/DIRy
This variable is supported with Celerra version 5.5 and greater.

EMC_EFILEnn=

No

This string value determines which files are excluded from backup. The
asterisk (*) is accepted as a wildcard, but it must be the first or last character
in the string (or both). Multiple files an be included by incrementing the
number; for example:
• EMC_EFILE01=*mp3
• EMC_EFILE02=temp*
This variable is supported with Celerra version 5.5 and greater.

OPTIONS=NT

Yes for ACL
restoration

This value must be set to make sure all ACLs are recovered when NT data is
contained in the backup path.
In addition to setting this variable, axttrp must exist in the
/nas/server/slot_#/netd file.

SNAPSURE=Y

No

This option is used to decrease the backup time for an Celerra host when DX
is integrated in the NetWorker environment.

Char and Block Special Files
During recovery, the Celerra filer skips char and block special files. The following
error message will be displayed:
Warning: /fs1/SPE_REL/my.char_file has an unknown file type, skipping

EMC Centera
The EMC Centera Backup and Recovery Module Release 2.01 Installation and
Administrator’s Guide and the EMC Centera Backup and Recovery Module Release
Supplement provide information about the EMC Centera® Backup and Recovery
Module software .
The EMC NetWorker Software Compatibility Guide provides a complete list of
supported versions.
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EMC IP4700
These sections provide information about autochanger configuration and application
information variables for the EMC IP4700 host. The EMC NetWorker Software
Compatibility Guide provides a complete list of supported versions.
How to find the device pathname for an EMC IP4700 host
The pathname of the media device is required before the autochanger for NDMP
backups and recoveries can be configured. The device pathnames can be found
through the IP4700 Administrator web interface. Use the pathname to configure the
autochanger with the jbconfig program, as described in “Configuring library
support for NDMP” on page 530.
To obtain the autochanger and tape drive device pathnames:
1. In the browser window, access the EMC IP4700 Administrator program at this
URL.
http://IP4700name/

2. Click Tape Drives.
3. Type the tape list command.
4. Use the resulting values to configure the autochanger and tape drive devices for
the NetWorker software.
Note: If the NDMP tape server is running version 2 or does not support NDMP_CONFIG
interfaces, locate the autochanger handle in the EMC IP4700 Administrator program.

Application information variables
In addition to the standard application information variables, HIST=y and
UPDATE=y, that are required for all vendors, Table 102 on page 563 lists
IP4700-specific variables that may be required. Type these variables in the
Application Information attribute of the Client resource, as described in “Configuring
an NDMP Client resource” on page 535.

Table 102

EMC IP4700 variables

Variable

Required

Values and meaning

FAST_
INCREMENTAL= y

No

Performs a fast incremental backup. This function works only if fast
incremental is enabled on the volume. You must have the SnapView/IP
option to perform a fast incremental backup. The default is y.

SNAPSHOT= y

No

Backs up a snap copy of the file system. This function only works if
snap copy is enabled on the volume. You must have the SnapView/IP
option to use snap copy. The default is n, unless
FAST_INCREMENTAL is set to y. Then, SNAPSHOT is set to y.

NO_ACLS=y

Yes

On Microsoft Windows systems, set this value to y when backing up a
Windows system to ensure that ACLs are not backed up. Do not set
this value to n when backing up Windows files with ACLs. The default
is n.

Auspex
These sections provide information about limitations, autochanger configuration, and
application information variables for the Auspex host. The EMC NetWorker Software
Compatibility Guide provides a complete list of supported versions.
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Auspex-Specific considerations with NDMP
These are NDMP issues that are specific to Auspex filers.
Auspex NS3000 requirements

In order to support Auspex NS3000:
◆

Connect the robot to channel 6 of the SCSI controller. To confirm that the robot is
connected to the correct channel, inspect the device filename under the /dev/raxac
directory. It should display a channel similar to fsp0c6t0.

◆

To use snapshots, a cache device must be reserved. The appropriate Auspex
documentation provides more information about snapshots.

How to back up large files with Auspex
By default, support for files larger than 2 GB is not enabled for an Auspex backup. This allows
for use of a standard gtar tape format.
To enable support for files larger than 2 GB:
1. Open the /usr/AXndmp/etc/config file on the NDMP host.
2. Remove the comment marks for the line containing this text.
ALLOW_TAR_EXTENSION

3. Save the modified file.
Note: If you modify the system to support large files, the tapes will be in nonstandard gtar format.
DD-Type backup limitations and requirements

DD-type backups have these limitations and requirements.
◆

HIST=y is not supported. Set this value to HIST=n.

◆

DD-type backups are only supported with NetOS V4.1P3 or later.

Autochanger configuration tips

Configure the Autochanger resource to have these minimum timeout values.
◆

Eject Sleep: 10

◆

Cleaning Delay: 60

◆

Unload Sleep: 10

◆

Load Sleep: 90

◆

Deposit Timeout: 15

◆

Withdraw Timeout: 15

◆

Port Polling Period: 3

Auspex limitations

These limitations apply to Auspex backups and recoveries.
◆

Root partition backups are not supported. Do not back up the root partition.

◆

File-by-file recoveries should not exceed 10,000 files per recovery.
To recover a larger number of files, perform one of these steps.
• Set up multiple save sets for a given client to break the file system into directory-level
save sets rather than whole volumes.
• Perform a save set recovery by using the NetWorker User program, nwrecover, or the
nsrndmp_recover command from the command prompt.
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How to find the device pathname for an Auspex host
The pathname of the media device is required before the autochanger for NDMP backups and
recoveries can be configured. The device pathname for an Auspex computer is located in the
messages file at /var/adm/messages. Use the pathname to configure the autochanger with the
jbconfig program, as described in “Configuring library support for NDMP” on page 530.
The Auspex documentation provides information about adding a SCSI device.
The messages file contains the list of devices, for example:
Jan 18 10:32:22 nightcap FSP_0[1611]:fsp0c7t0:STK
9714
[ Medium_Changer ][ Fast ] [ min:1792 ]
Jan 18 10:32:22 nightcap FSP_0[1611]:fsp0c7t1:Quantum DLT4000
[ Not Negotiated ] [ min:1808 ]
Jan 18 10:32:22 nightcap FSP_0[1611]:fsp0c7t2:Quantum DLT4000
[ Not Negotiated ] [ min:1824 ]

[ Tape ]
[ Tape ]

Note: If the NDMP tape server is running version 2 or does not support NDMP_CONFIG interfaces,
determine the autochanger handle from the device list.

Application information variables
In addition to the standard application information variables, HIST=y and UPDATE=y, that
are required for all vendors. Table 103 on page 565 lists Auspex-specific variables that may be
required. Type these variables in the Application Information attribute of the Client resource,
as described in “Configuring an NDMP Client resource” on page 535.

Table 103

Auspex Variables

Variable

Required

Values and Meaning

DIRECT= y/n

Yes for DAR

This value must be set to y if you are performing a DAR recovery. If you are
not performing a DAR recovery, set the value to n. The default is n.
“Performing DAR backups” on page 541 provides additional information
about DAR.

SNAPSHOT= y

No

Enables or disables snapshots. The default is n.

Procom NetFORCE
These sections provide information about autochanger configuration for the Procom host. The
EMC NetWorker Software Compatibility Guide provides a complete list of supported versions.
How to find the device pathname for a Procom NetFORCE host
To determine the device pathname, log in as root and type the following command:
status dm

NetFORCE responds with a list of autochanger and media device names. Use the appropriate
device name when configuring the autochanger with the jbconfig program, as described in
“Configuring library support for NDMP” on page 530.
Note: If the NDMP tape server is running version 2 or does not support NDMP_CONFIG interfaces, you
must determine the autochanger handle. On Procom NetFORCE, the SCSI device name format is
isp1tSSL[L], where isp1 is the autochanger handle. The Fibre Channel device format is ffx1tSSL[L],
where ffx1 is the autochanger handle.

Postconfiguration requirements for Procom NetFORCE host
After using the jbconfig program to configure an autochanger for a Procom NetFORCE host:
1. Reset the autochanger by typing the following command.
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/usr/sbin/nsrjb -HE

2. To read previously-labeled tapes back into the database, inventory the
autochanger.
/usr/sbin/nsrjb -IE

Mirapoint
These sections provide information about requirements and autochanger
configuration for the Mirapoint host. The EMC NetWorker Software Compatibility Guide
provides a complete list of supported versions.
Requirements
These requirements apply to the Mirapoint system.
◆

After restoring a full backup, reboot the Mirapoint system. The system does not
need to be rebooted after an incremental recovery.

◆

The application information variable MIRA_OPTIONS= (fromimagefull=) must
be set. The (fromimagefull=) value allows the user to perform a full image backup
and then perform message (file) based backups by using the date of the image in
order to perform the selection.

Device pathname for a Mirapoint host
The device pathname is required to successfully run the jbconfig program. The
device pathname is /dev/nrstn, where n starts at 0 and increases one number for
each tape drive. This value is constant. Use the pathname to configure the
autochanger with the jbconfig program, as described in “Configuring library
support for NDMP” on page 530.
Once the autochanger is configured, certain attributes must be modified in the
Autochanger resource window. Set the Load Sleep and Eject Sleep attributes to these
values:
◆

Load Sleep to 90

◆

Eject Sleep to 30

Note: If the NDMP tape server is running version 2 or does not support NDMP_CONFIG
interfaces, you must type the autochanger handle, /dev/ch0, when running jbconfig.

BlueArc
BlueArc systems provide network-attached, fixed storage solutions to share, manage,
and protect data. This ensures continuous availability and simplified data
management.
When configuring a BlueArc system, keep these points in mind:
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◆

When performing NDMP recovery operations, a $__NDMP__ directory may be
created at the root level of the file system to which the data is being recovered.
This directory holds the file list that the NetWorker server passes for an index
recovery, if that file list contains more than 1,024 filenames. Do not change the
directory and its contents during an active recovery operation. If no recovery is in
progress, the directory may be deleted.

◆

NDMP_BLUEARC_FH_NAMETYPE=UNIX, an application information variable
(also known as an NDMP Environment Variable), must be specified in the Client
resource.

◆

The backup command type, also known as the backup application name, is
dump.
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◆

While performing NDMP backup and recovery operations, a message similar to
the following may appear:
NDMP session—Unknown environment variable name ignored.

You can ignore this message, as it does not impact the operation.
The BlueArc’s documentation provides a complete information on configuring a
BlueArc system for NDMP operations.

SnapImage software
The NetWorker SnapImage Module is a high-performance storage solution that backs
up and recovers high-density file systems across a LAN or SAN. It is based on NDMP
and provides full-image, block-level backups and recoveries, allowing large amounts
of data to be backed up quickly, which reduces the backup window. The SnapImage
software backs up high-density file systems faster than non-NDMP based file-based
backup systems. It supports full backups as well as differential backups, which back
up only the blocks that have changed since the last full backup. It can recover data at
the block level, and also can recover specific files and directories at the volume level.
The SnapImage Module Installation and Administrator’s Guide and Release Notes
provide instructions on installing, configuring, and using the SnapImage software.

Filers that act as tape servers only
This section provides information about filers that act as tape servers only.
DinoStor TapeServer
These sections discuss the DinoStor TapeServer and the autochanger configurations.
Configuring the DinoStor TapeServer
The DinoStor software provides a web-based interface for administering and
controlling the TapeServer settings.
Ensure that the following are set when configuring the server:
◆

On the Password page of the Configure tab, specify the password for
administering the DinoStor TapeServer, not the NDMP password.

◆

When configuring the DinoStor TapeServer, set the NDMP version to 3 and the
port number to 10000 on the NDMP page of the Configure tab.

◆

When connecting an autochanger to a DinoStor TapeServer, shut down the
DinoStor TapeServer and power down. Attach the new devices and reboot the
system. You can reboot or shut down the system from the web interface.

◆

Only SCSI tape devices are supported.

◆

DDS is not supported, since the DinoStor TapeServer is not fibre-equipped.

◆

GigE and 10/100 Base-T are supported.

How to specify device handles for a DinoStor TapeServer
When configuring the autochanger with the NetWorker Administration window, the
DinoStor TapeServer has one hostname with multiple device handles. Use the
hostname to configure the autochanger with the NetWorker Administration window,
as described in “Configuring library support for NDMP” on page 530.
To specify the device handles:
1. Access the DinoStor TapeServer interface.
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2. Click the Configure page.
3. Click the SCSI tab.
When running jbconfig, specify the DinoStor hostname as the device that controls
the robotics and the device handles as the additional devices.
How to perform a remote backup with a DinoStor TapeServer
To perform a remote backup with a DinoStor TapeServer:
1. Set up the configuration with an NDMP host, a NetWorker server, and the
DinoStor TapeServer with a library attached.
2. Configure the NetWorker server.
a. For the Name attribute of the Client resource, specify the hostname of the
NDMP server that contains the data to be backed up.
b. For the Storage Node attribute of the Client resource, verify that the hostname
of the DinoStor server is listed first. The client directs the data to the first
storage node in the list that has an enabled device and is able to receive the
data.
c. Complete the rest of the required Client resource attributes and configure the
NetWorker server as you would for any other NDMP backup.
“Configuring an NDMP Client resource” on page 535 provides instructions on
configuring the Client resource.
SnapImage or NDMP TapeServer Module
These sections discuss the SnapImage/NDMP TapeServer software configurations
and requirements.
Finding the device pathname for a SnapImage Module device
The required steps for determining the device pathname are different for Solaris and
HP-UX computers. Complete the instructions for the appropriate platform. Use the
pathname to configure the autochanger with the NetWorker Console Administration
window as described in “Configuring library support for NDMP” on page 530.
How to identify the device pathname for a Solaris computer
To identify the device pathname:
1. Log in as root on the host.
2. Determine the media device pathname by typing the following command.
ls -l /dev/rmt/*

The computer responds with the list of device filenames.
lrwxrwxrwx
1 root
root
03 Nov 17 12:03 /dev/rmt/0mbn ->
../../devices/pci@1f.0/scsi@2/st@1,0:mbn

where:
◆

/st@1, 0 is the SCSI ID field for the media device.

◆

/dev/rmt/0mbn is the media device pathname.

If the NDMP tape server is running version 2 or does not support NDMP_CONFIG
interfaces, determine the autochanger handle by typing the following command:
ls -l /dev/rsjb*
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The computer responds with a list of rsjb device handles.
lrwxrwxrwx
1 root
other
45 Jan 11 13:35 /dev/rsjb2 ->
../devices/pci@1f.0/scsi@2,1/sjb@1,0:8r

where:
◆

:8r identifies the autochanger robotics.

◆

/sjb@1, 0 is the SCSI ID field for the rsjb device.

◆

/dev/rsjb2 is the autochanger handle.

How to identify the device pathname for an HP-UX computer
To display the device pathname, log in as root on the host, use one of the following
methods:
◆

Use the ioscan command by typing the following command:
ioscan -fnC tape

◆

Use the SAM utility.
a. Start the utility.
b. Select Peripheral Devices.
c. Select Tape Drives.
d. Highlight the appropriate tape drive and select Show Device Files from the
Action menu.
Note: If the NDMP tape server is running version 2 or does not support NDMP_CONFIG
interfaces, use the ioscan command or SAM utility to obtain the autochanger handle.

How to perform a remote backup with the SnapImage/NDMP TapeServer
software
To perform a remote backup:
1. Install the NetWorker software on the server designated as the NetWorker server.
2. Install the SnapImage Module/NDMP TapeServer software on the server
designated as a tape server.
a. If you are backing up the data to the NetWorker server, install the SnapImage
Module/NDMP TapeServer software on that NetWorker server.
b. If you are backing up the data to a different NDMP server, install the
SnapImage Module/NDMP TapeServer software on the host to which the
data is being backed up.
The EMC NetWorker SnapImage Module Installation and Administrator’s Guide,
and its Release Notes provide instructions on installing the SnapImage
Module/NDMP TapeServer software.
Note: Do not use the configuration instructions in the SnapImage Module guide. Instead,
use the configuration instructions provided in this chapter for the NDMP TapeServer
software.
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3. To allow other servers to access the SnapImage server:
a. Log in as root on the host.
b. Run the ndmp_passwd command, located in /usr/ndmphome/bin.
– Use this syntax:
ndmp_passwd -u user

where user is the root or administrator name of the SnapImage server.
– When prompted, type the password.
4. Configure the NetWorker server.
a. For the Name attribute of the Client resource, specify the hostname of the
NDMP server that contains the data to be backed up.
b. For the Storage Node attribute of the Client resource, verify that the
destination server for the data being backed up is listed first.
The client directs the data to the first storage node in the list that has an
enabled device and is able to receive the data.
c. Complete the rest of the required Client resource attributes and configure the
NetWorker server as you would for any other NDMP backup.
“Configuring an NDMP Client resource” on page 535 provides instructions on
configuring the Client resource.
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SNMP traps
The NetWorker Simple Network Management Protocol (SNMP) Module allows
NetWorker servers to send notification messages to SNMP management agents.
SNMP-enabled network management software must be configured to accept traps
from the NetWorker server. For detailed information about SNMP management
operations refer to your network management documentation.
The NetWorker SNMP Module uses traps to communicate NetWorker event
notifications to SNMP management stations. A trap is an unsolicited notification sent
from the SNMP agent (such as the NetWorker server) to the SNMP event manager.
The types of traps that the NetWorker server sends are determined when the
NetWorker SNMP notification is configured within the NetWorker server. Typical
traps include warnings, critical errors, and other messages from the NetWorker
server. “Configuring NetWorker SNMP notifications” on page 572 provides
instructions on configuring the NetWorker SNMP notification.

Configuring NetWorker SNMP notifications
NetWorker software provides notifications to a variety of resources about NetWorker
server events. The NetWorker SNMP Module is one of those resources. The module
then forwards the notification to the SNMP management software by using the
nsrtrap program. When you configure the SNMP notification, you include the IP
address or hostname of the SNMP management server, along with other nsrtrap
command line options, such as the SNMP community and the trap type.
In order to configure the NetWorker SNMP notification, you must first enable the
NetWorker SNMP module. The NetWorker Installation Guide provides information on
enabling and licensing the NetWorker software.

Command line options for nsrtrap
The NetWorker SNMP Module uses the nsrtrap program to communicate SNMP
traps from the NetWorker server to the SNMP management software. Table 104 lists
the command line options that can be included in the Action attribute when the
SNMP notification is configured.
Table 104

572

Command-line options for nsrtrap (1 of 2)

Option

Description

-c community

Specifies the SNMP community that is authorized to receive traps from the NetWorker server. SNMP
communities are configured on the SNMP server. The default setting for this option is Public, which
means that the public community can receive traps from the NetWorker server.
For security purposes, system administrators often customize SNMP servers to limit the communities
from which the server accepts traps. If a community other than Public is configured on the SNMP server,
include the appropriate community name by using this option when you configure the SNMP notification.

-t trap_type

Sets the type of trap the NetWorker SNMP Module sends to the SNMP server. The default setting is 6,
which means that this is an "enterprise-specific" trap. Because traps that the NetWorker server sends
are notifications (for example, error messages), the default setting is normally correct and should not be
changed. This option should be used only if you intend to send a specific trap other than a normal
NetWorker notification.
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Table 104

Command-line options for nsrtrap (2 of 2)

Option

Description

-s specific_type

A generic setting that can be used to identify the type of trap the NetWorker server is sending. This
option can be set to any integer value and may be used in conjunction with different SNMP notifications
to distinguish different traps from the NetWorker server.
For example, you can create multiple SNMP notifications: one for critical messages, another for
warnings, and another for other events or priorities. You can then use the -s option to differentiate the
various notifications so that the SNMP management software can determine which type of trap is being
sent. You could create one notification called Critical SNMP Notification, and include the -s option in the
Action attribute:
nsrtrap -s 1 host
With this setting, the SNMP management software can be configured to recognize that NetWorker traps
with the specific trap type of 1 are critical messages. Additional SNMP notifications can have other
settings for the -s option to further differentiate various traps from the NetWorker server.

-v

Sets the output mode to verbose. In verbose mode, nsrtrap echoes the community, trap type, specific
trap type, and the hostname or IP address at the command-prompt.

Modifying preconfigured NetWorker SNMP notification
The NetWorker server has a preconfigured SNMP notification that can be modified if
necessary. The only modification that can be made to this notification is to add or
remove command line options to the Action attribute.
To modify the preconfigured notification request:
1. In the Administration window, click Configuration.
2. Select Notifications.
3. Right-click the SNMP notification request and select Properties.
4. In the Action attribute, enter any necessary options for the nsrtrap command,
such as the SNMP community. “Command line options for nsrtrap” on page 572
provides information about command-line options.
5. Click OK.
The events and priorities associated with the preconfigured SNMP notification
cannot be modified. “Creating NetWorker SNMP notifications” on page 573 provides
instructions on how to set different events and priorities for the SNMP notification.

Creating NetWorker SNMP notifications
To create additional NetWorker SNMP notifications:
1. In the Administration window, click Configuration.
2. Select Notifications.
3. Right-click the SNMP notification request and select New.
4. Enter a name for the SNMP notification.
5. (Optional) For the Comment attribute, enter a description of the notification.
6. Select the events and priorities that the notification should communicate to your
SNMP server.
Note: The events and priorities cannot be modified after the notification is created.

Configuring NetWorker SNMP notifications
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7. For the Action attribute, type:
• Windows servers:
<NetWorker_install_path>\bin\nsrtrap network_management_station
• UNIX/Linux servers:
/usr/sbin/nsrtrap network_management_station
where network_management_station is the DNS name or IP address of the host
on which the SNMP management software is running.
Include options for nsrtrap, such as -c community, in this attribute if necessary.
“Command line options for nsrtrap” on page 572 provides more information
about command-line options.
8. Click OK.

Configuring SNMP management software
In order for the SNMP management software to accept traps sent by NetWorker
servers, it must be configured to recognize the traps. Configuration procedures vary
by the type of management software you are using.
For specific instructions on configuring the types of acceptable traps, refer to the
SNMP management software documentation.

NetWorker SMI Network Management Private Enterprise Code
When configuring management software to accept traps, you must also indicate the
specific type of trap to accept. Use the Structure of Management Information (SMI)
Network Management Private Enterprise Code that applies to the specific network
application that will send traps to the software. The Private Enterprise Code for the
NetWorker server is 160 (the complete code is .1.3.6.1.4.1.160).

Receiving traps in the SNMP network management software
Typically, once the network management software is configured to accept traps from
NetWorker servers, an icon of each NetWorker server appears on the network
management console. These examples show how the software can then be
configured:
◆

To indicate that a trap was received (for example, the NetWorker server icon may
blink or change color).

◆

Track pending, alert, and other configured messages.

◆

Separate traps into event categories, such as Error Events, Status Events,
Threshold Events, Configuration Events, Application Alert Events, or All Events.
For information on how to set up SNMP trap templates, refer to the network
management software documentation.

You may also want to create additional SNMP notification schemes in the NetWorker
Administrator program that have different priorities and events. You can use the -s
specific-type command line option for nsrtrap so that the SNMP management software
can differentiate the traps sent by the various notification schemes. “Command line
options for nsrtrap” on page 572 provides more information about setting the -s
specific-type option.

574

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

22
DiskXtender Data
Manager File System
Support

This chapter covers these topics:
◆
◆
◆
◆

Supported configurations ..........................................................................................
DiskXtender Data Manager file system overview..................................................
Backup of DXDM file systems...................................................................................
Recovery of DXDM file systems ...............................................................................

DiskXtender Data Manager File System Support

576
576
578
580

575

DiskXtender Data Manager File System Support

Supported configurations
These configurations are supported for the backup and recovery of DiskXtender Data
Manager (DXDM) file systems:
◆

DXDM software and NetWorker server, client, or storage node software installed
on the same computer.

◆

DXDM software installed on a computer that is a client of a computer that is
running NetWorker server, client, or storage node software.

Note: The Archive feature does not work for DXDM file systems.

The EMC NetWorker Software Compatibility Guide provides information about
supported operating systems and file systems.

Path information
NetWorker backup and recovery requires the /etc/dxuldm.path file when
supporting a DXDM file system. The file is automatically created during DXDM
installation.

Permissions
The NetWorker daemon nsrexecd controls automated backup and recovery of DXDM
file systems. The daemon is configured to run with set user ID (suid) root
permissions. Root permissions are also required to perform manual NetWorker
backup and recovery operations with DXDM file systems.

DiskXtender Data Manager file system overview
DXDM file systems use the following enhancements that are not found in standard
file systems:
◆

The creation and retention of DMAPI information for each file.

◆

The ability to migrate files to a storage target.

◆

The ability to purge file data from the file system after migration.

◆

The retention of a data stub for each purged file.

Through these enhancements DXDM provides file system access to large numbers of
files while storing the bulk of the file data on one or more storage target systems.

File data in a DXDM file system
When a file is placed into a DXDM file system it is available to list, view, access, and
change the same as in any standard UNIX file system. The difference is that as soon as
a file is placed into a DXDM file system, DMAPI metadata is created for the file. This
extended metadata permits the transparent archiving of the file’s data outside of the
file system. Some of the DMAPI information that is tracked on each file includes:

576

◆

The file’s migration status.

◆

The file’s purge status.

◆

The file’s data stub size.
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After a period of time the file’s data is migrated to a storage target. As shown in
Figure 44 on page 577, the storage target can be a DXSM system or an EMC Centera
Storage System (EMC Centera). After a file’s data is migrated it exists on both the
DXDM file system and the storage target.
After a period of time, unchanged files are purged from the file system. The file
system retains the file’s DMAPI metadata and data stub. The data stub consists of a
user-configured number of bytes from the beginning of the file.
User access to file data
Figure 44 depicts eight DXDM file systems on one host system. Four of the file
systems use a DXSM storage target and four use a EMC Centera target. The diagram
shows that the data from each DXDM file system exists in its own namespace on the
storage target.
◆

On a DXSM storage target, relative pathnames and capabilities are used to
identify files.

◆

On a EMC Centera storage target, the EMC C-Clip™ data is created to identify
each file.

This storage target namespace information is not required by DXDM file system users
for access to the files. Users need only know the full pathname of a file on the DXDM
host system or, when access is provided over NFS, its relative pathname from the file
system’s NFS mount point.
When a file on a DXDM file system is changed it is marked as not migrated. Any
previously migrated data for the changed file is retained on the storage target but
renamed with a version label. When a file is deleted from a DXDM file system it is
fully removed. Any previously migrated data is retained on the storage target and
renamed with a version label and a deleted label.
EMC Centera System
DXDM Host System
C-Clip Tagged
Data Storage
Gigabit
TCP/IP

1
2
3
4

DXDM Host
System

100 Mb
TCP/IP

4
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2
1

Local FS
Access

Figure 44

NFS FS
Access

DXSM-Managed
Target

Storage Devices

Prototypical DXDM installation
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Backup of DXDM file systems
A DXDM file system consists of files and metadata. The files can be in a variety of
migration and purge states. The metadata is contained in the file systems’s DMAPI
attributes file. Table 105 shows the types of files and metadata that can exist in a
DXDM file system and notes the types that are included in a NetWorker backup.
Table 105

DXDM file system data types included in a NetWorker
backup

Data type

Included

New files which have not been migrated.

Yes

Changed files which have not been migrated since being changed.

Yes

Files which have been migrated but not purged.

Yes

Data stubs for files which have been migrated and purged.

Yes

File data which exists only on a storage target system.

No

DMAPI metadata.

Yes1

1. The DMAPI metadata is included by default. It can safely be excluded. “Excluding the DMAPI
attributes file” on page 578 provides more information.

File data which has not changed since being migrated is protected by the storage
target. NetWorker backup automatically excludes this data from its client/save sets
when the data has been purged. This results in these benefits:
◆

Smaller client/save sets.
Purged data which is protected on the storage target is excluded from the
client/save set. This is normally the bulk of the data in a DXDM file system.

◆

Much faster backups.
In addition to the time savings derived from the smaller client/save set,
NetWorker backup prevents the lengthy process of retrieving purged file data
from the storage target.

DXDM file system client/save sets should exclude the DMAPI metadata. “Excluding
the DMAPI attributes file” on page 578 provides more information .
Backups of a DXDM file system are performed in the same manner as backups of a
standard file system. Backups can be performed on a scheduled basis or manually.
Both methods require root permissions. Chapter 4, “Backup Groups and Schedules”
provides more information on scheduling backups. Chapter 2, “Backing Up Data”
provides more information on information on manual backups.
Excluding the DMAPI attributes file
Every DXDM file system has a DMAPI attributes file which stores volatile DMAPI
metadata. This file does not need to be backed up because it is re-created during the
recovery process. Since these files can become quite large, create a global Directive
resource to simplify the exclusion process.
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To exclude a DMAPI attributes file:
1. Create a global Directive resource which excludes .DMATTR files. DXDM stores
DMAPI attribute information in files located at the top level of each file system.
The filename for these files is .DMATTR.
2. When creating the global Directive resource, use the Application Specific Module
named Skip to exclude .DMATTR files. Chapter 6, “Directives” provides more
information on directives.
3. Apply the Directive resource when creating client/save sets for the file system.

Aborted backups
A DMAPI process is initiated whenever when a backup of a DXDM file system
occurs. DXDM assigns a DMAPI session label of DXULDMLIB to this type of process.
At the conclusion of a successful backup the process is removed.
If a backup is aborted, the DXULDMLIB process exists as a defunct process. Defunct
DXULDMLIB processes exist as process table entries and use no system resources.
These processes normally do not cause problems and are removed when the system is
rebooted. However, they can be removed manually. “How to remove a defunct
DXULDMLIB process” on page 579 provides details. “Viewing existing DMAPI
processes” on page 579 provides information on how to determine whether a defunct
DXULDMLIB process exists.
Viewing existing DMAPI processes
To view all DMAPI processes on a DXDM host system:
1. Log in as root on the DXDM host system.
2. Create the DXDM environment.
Use the correct command and file for the current shell:
– C shell (csh):
source /opt/dxuldm/etc/dxuldm.login
where /opt/dxuldm is the full path to the DXDM installation directory.
– Korn shell (ksh) or Bourne shell (sh):
. /opt/dxuldm/etc/dxuldm.profile
where /opt/dxuldm is the full path to the DXDM installation directory.
3. Type the prtdmsession command:
prtdmsession

The prtdmsession command lists each existing DMAPI session.
How to remove a defunct DXULDMLIB process
Note: Do not remove active DMAPI sessions. If active sessions are removed, DXDM processes
terminate and file system activity is blocked until those processes are restarted.

To remove a defunct DXULDMLIB process:
1. Log in as root on the DXDM host system.
2. Create the DXDM environment. “Viewing existing DMAPI processes” on
page 579 provides details.

Backup of DXDM file systems
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3. Type the prtdmsession command.
4. Find the listing which has DXULDMLIB in the Session Info field and note the
integer in the listing’s Session ID field.
5. Type the deldmsession command:
deldmsession -s DXULDMLIB -i session-id -n

where session-id is the integer from the defunct DXULDMLIB process’s Session ID
field.

Recovery of DXDM file systems
Recovery of a DXDM file system consists of restoring data from a client save set and
synchronizing the file system’s DMAPI information with the data on the storage
target.

Initiating a recovery
Recovery of backed-up data from a DXDM file system is performed by using the
same procedures that are used for a standard file system. Chapter 13, “Recovering
Data” provides details. DXDM file system recovery can consist of individual files,
directories, or a file system.
With DXDM file systems, file data must be recovered into the same file system from
which it is backed up. Attempting to recover backed up data into a new file system
causes:
◆

The unavailability of all data on the storage target.

◆

The DXDM processes to stop responding.

This requirement is based on the nature of the DMAPI metadata that DXDM file
systems use to locate and access data on the storage target. The DMAPI metadata
uses full pathnames. If the file-system mount point changes because of a recovery
into a new file system, the pathname information in the metadata becomes
inaccurate.
Recovered files list
As part of the recovery process each restored file’s pathname is listed in a file on the
DXDM host system. DXDM uses this information to synchronize its metadata. “File
system synchronization” on page 581 provides details.
When a recovery is complete, all data in the file system is available without waiting
for the synchronization process. Data on the storage target becomes available after
synchronization.
This data require synchronization:
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◆

Migrated and purged file data.

◆

Purged and deleted file data. “Restoring deleted files and previous file versions”
on page 581 provides details.
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Restoring deleted files and previous file versions
DXDM file systems retain file versions. This allows administrators to restore specific
versions of files. In a DXDM file system, a file is migrated when it is first placed into
the file system and again after each change. Each of these migrations cause a new
version of the file to be created on the storage target.
To restore a previous version of a file, whether or not the file still exists in the file
system:
1. Recover the file from the client/save set that backed up the desired version.
“Recovering an earlier version of a file” on page 320 provides information on this
procedure.
2. Complete the synchronization process. “File system synchronization” on
page 581 provides details.
3. To expedite the synchronization of a particular file, complete the procedure
described in “Manually synchronizing a file” on page 582.
The synchronization process restores the data for the version of the file that is
recovered. It will also restore data for a file which has been inadvertently deleted. At
the conclusion of the synchronization process the recovered file version or deleted file
is available.

File system synchronization
As part of a recovery of one or more files into a DXDM file system, the recover
program creates a file that contains a list of each recovered file.
This list file has a pathname with this format:
/opt/dxuldm/adm/recdir/rec.date.pid

where:
◆

/opt/dxuldm is the installation directory for DXDM.

◆

date is the date of the recovery.

◆

pid is the process ID of the NetWorker client process.

DXDM uses the list file to rebuild the file system’s DMAPI attributes file. This process
synchronizes the file system’s metadata with the data on the storage target.
Note: Do not remove a list file created by the recover program. Automatic file synchronization
will not occur if a list file is removed.

Manual synchronization can be conducted without a list file. “Manually
synchronizing a file” on page 582 provides more information. “Automatic
synchronization” on page 582 describes that synchronization is an automatic process
which does not require administrative intervention.
“Manually synchronizing a file” on page 582 describes how make a file’s data
available more quickly.
If NetWorker recover cannot write to the recdir directory, each recovered file is
synchronized as it is recovered. This file-by-file synchronization significantly slows
down the recovery process.

Recovery of DXDM file systems
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The recdir directory is created during the installation of DXDM. NetWorker recover
will be unable to write to it if the directory is removed or if the partition on which it is
mounted becomes full.

Automatic synchronization
DXDM uses the list file created by NetWorker recover to determine which files
require synchronization. Each file on the list is synchronized. If synchronization does
not complete, DXDM retries until all files on the list have been synchronized. After all
files are synchronized, the list file is removed.
Automatic synchronization is performed by the script dxuldmcronscript which is
invoked by root’s crontab every 10 minutes. The cron job to invoke
dxuldmcronscript is placed in root’s crontab when DXDM is installed.

Manually synchronizing a file
To make a file available before automatic synchronization is complete, use manual
synchronization. This uses the DXDM command-line utility dxuldmrecover.
To manually synchronize a file:
1. Log in as root on the DXDM host system.
2. Create the DXDM environment. Step 2 in “Viewing existing DMAPI processes”
on page 579 provides details.
3. Run the dxuldmrecover utility:
dxuldmrecover -p filepath

where filepath is the full path to the file that is being synchronized.
The dxuldmrecover utility takes the full path of a file as its argument. It can be
invoked from a script to manually synchronize multiple files.
When synchronization is complete this message appears:
Successfully recovered file filepath.
Note: A DXDM file system can be manually synchronized by using the dxuldmrecoverfs
utility. The EMC DiskXtender Data Manager, Release 2.6, Installation and Administrator’s Guide
provides more information.
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Microsoft Automated System Recovery
Microsoft Automated System Recovery (ASR) for Windows XP and Windows Server
2003 enables backup and recovery applications to implement an automated disaster
recovery solution.
ASR is similar to the Windows NT Emergency Repair Disk (ERD), but ASR has
additional features. Both ERD and ASR require that you prepare a recovery disk in
advance. While the ERD requires user interaction to repair selected components of
the Windows operating system, ASR provides an automated solution for complete
disaster recovery of a failed computer.
ASR is installed as a standard component of the Windows XP and Windows Server
2003 operating systems. No additional Microsoft software is required.
Note: The automated system recovery feature for Microsoft Windows Server 2008 and
Windows 7 is known as Offline System State Restore (OSSR) and is not covered in this chapter.
NetWorker support for OSSR is covered in Chapter 24, “Support for Windows 2008 / 2008 R2
/ Windows 7 Disaster Recovery.”

Microsoft ASR documentation
Microsoft recommends use of ASR as a last resort, after all other system recovery
options (such as Safe Mode Boot and Last Known Good) have been exhausted.
However, ASR recovery is appropriate in a disaster recovery situation, such as a
failure of the system drive.

NetWorker support for ASR
NetWorker software supports ASR on NetWorker clients that run Windows XP
Professional or Windows Server 2003. ASR is not supported for NetWorker servers or
storage nodes.
ASR is not supported for NetWorker clients configured with a shared disk. This
applies to stand-alone clients, as well as clients operating in an MSCS cluster
environment. The EMC NetWorker Disaster Recovery Guide provides disaster recovery
information about these configurations.

NetWorker ASR save set
The NetWorker ASR save set contains all the information necessary to return the
failed computer to its condition at the time of the last ASR backup, including:
◆

An automated reinstallation of Windows

◆

Restoration of the system configuration

◆

Recovery of one or more disk volumes,

The ASR save set can be backed up by itself, or as a component of the save set All.
Like the NetWorker SYSTEM save sets, ASR is backed up automatically at level full.
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Usage overview
Because ASR is the recommended NetWorker disaster recovery method for Windows
XP Professional and Windows Server 2003 NetWorker clients, perform ASR backups
on a regular basis.
You can perform an ASR backup by using either of these methods:
◆

As part of a regularly scheduled group backup, configured by using the
NetWorker Administrator program.

◆

In a manual backup by using the NetWorker User program.

You can create an ASR disk by using either of these methods:
◆

By restoring the ASR save set on the NetWorker client computer.

◆

By performing a directed recovery of the ASR save set to a different NetWorker
client computer.

In the event of a disaster on the NetWorker client, use the ASR disk to perform an
ASR recovery. This must be done locally, on the failed NetWorker client computer.
Note: If a current ASR disk or ASR save set is not available for the failed NetWorker client
computer, you must use the legacy NetWorker disaster recovery method. The EMC NetWorker
Disaster Recovery Guide provides more information .

Network connection names
Microsoft assigns a default name to each client network connection. If possible, do
not rename these network connections. If a default network connection name is
renamed, one must edit the net.cfg file on the ASR disaster recovery diskette so that
the new names are replaced with the default names that were originally assigned by
Microsoft. “Posting ASR disk creation task” on page 590 provides details.

ASR Limitations and special considerations
This section describes limitations and special considerations that apply to ASR
backup and recovery.
IMPORTANT
Refer to the Microsoft Knowledge Base article, 818903, for information about
supported configurations of Windows XP at the time of backup and recovery.

ASR Limitations and special considerations
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FAT16 partitions are not supported
Microsoft ASR does not support recovery of disk partitions in FAT16 (also called
FAT) format.
To perform an ASR recovery on a computer that has a FAT16 partition:
◆

Select the pause during recovery option while creating the ASR disk. “Creating
an ASR disk” on page 588 provides more information about this option.

◆

When the ASR recovery operation pauses, clear the FAT16 partition to exclude it
from the recovery. “Using the ASR disk to recover a NetWorker client” on
page 590 provides more information about performing ASR recoveries.

After you have completed the ASR recovery and rebooted, recover the FAT16
partition in a separate, non-ASR NetWorker recovery operation. Chapter 13,
“Recovering Data” provides information about recovering data.

OEM recovery CDs are not supported
Many computer manufactures, such as Dell, Hewlett Packard, and IBM provide a
recovery CD or DVD with each system. These recovery disks typically contain the
Windows installation files, plus any additional software included with the system.
Although these recovery disks contain a complete set of Windows installation files,
they cannot be used to perform an ASR recovery.
Note: To perform an ASR recovery, you must have an official Microsoft Windows installation
CD for the version of Windows you are recovering. The EMC NetWorker Disaster Recovery
Guide and the OEM documentation provide information If you have only an OEM recovery
CD that includes the Windows installation files.

Vendor-specific drivers must be installed after Windows installation
ASR recovery can only be done on hardware components supported by the Windows
installation media. Drivers for vendor-specific hardware must be installed after the
Windows installation is complete.
For example, the IBM Thinkpad network interface card (NIC) is not supported by the
Windows installation media, and will cause ASR recovery to fail. For more
information on hardware supported by the Windows installation media, refer to the
Microsoft documentation.

ASR backup
Include ASR in a scheduled group backup for each Windows XP Professional and
Windows Server 2003 NetWorker client. When you use the ASR disk to recover a
NetWorker client computer, any data and configuration changes made since the last
ASR backup will be lost.
Note: The Automated System Recovery (ASR) feature in Microsoft Vista and Microsoft
Windows Server 2008 is not supported with the 7.4 or later releases of the software.
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How to include the ASR or VSS ASR DISK save set in a scheduled backup
Backing up save set All is the preferred method of performing scheduled ASR
backups. This method ensures that the ASR or VSS ASR DISK save set includes
information for all of the client’s disk volumes. If individual save sets are selected,
only the selected save sets are restored during an ASR recovery.
To include the ASR or VSS ASR DISK save set in a client’s scheduled backup:
◆

In the Save Set attribute for the Client resource, enter All.

◆

At a minimum, select the following save sets:
• The drive letter for %SystemDrive% (for example, C:\)
• If VSS is not licensed and enabled, select:
– ASR:
– SYSTEM STATE:
– SYSTEM DB:
– SYSTEM FILES:
• If VSS is licensed and enabled, select:
– VSS ASR DISK:
– VSS SYSTEM BOOT:
– VSS SYSTEM SERVICES:
– VSS SYSTEM FILESET:
– VSS USER DATA:

Chapter 2, “Backing Up Data” provides more information about specifying save sets
for a scheduled backup.

How to include ASR or VSS ASR DISK save set in a manual backup
Backup of data by selecting My Computer is the preferred method of performing
manual ASR backups. This method ensures that the ASR or VSS ASR DISK save set
includes information for all of the client’s disk volumes. By selecting individual save
sets, only the selected save sets are restored during an ASR recovery.
To include the ASR or VSS ASR DISK save set in a manual backup:
◆

In the NetWorker User program, click the Backup button and select My Computer
to save all data.

◆

At a minimum, select the following save sets:
• If VSS is not licensed and enabled, select:
• ASR:
• SYSTEM STATE:
• SYSTEM DB:
• SYSTEM FILES:
• If VSS is licensed and enabled, select:
– VSS ASR DISK:
– VSS SYSTEM BOOT:
– VSS SYSTEM SERVICES:
– VSS SYSTEM FILESET:

ASR backup
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Chapter 2, “Backing Up Data” provides more information about manual backups.

Creating an ASR disk
The information in this section refers to using the NetWorker User program to create
an ASR disk. If NetWorker Module for Microsoft Applications is installed on the
client computer, ASR is not supported. The EMC NetWorker Module for Microsoft
Applications Administration Guide provide information about the NetWorker Module
for Microsoft Applications program.
Before an ASR recovery, create an ASR disk for the NetWorker client computer that
will be recovered. An ASR disk is created by using the NetWorker User program
either locally, or as a directed recovery of the ASR save set.

Prerequisites
◆

The computer used to create the ASR disk must be running NetWorker release 7.x
software.

◆

For critical systems, back up the ASR DISK save set frequently and create an ASR
disk whenever the client computer drive configuration changes. “ASR backup”
on page 586 provides more information about backing up an ASR DISK save set.

◆

Multiple floppy diskettes will be required to create an ASR disk.

Create an ASR disk locally
If the NetWorker client computer for the new ASR disk is not functional, perform a
directed recovery of the ASR save set. “Creating an ASR disk by using directed
recovery” on page 589 provides details.
To create an ASR disk locally:
1. Log in with administrator privileges to the NetWorker client computer for which
you want to create the ASR disk.
2. In the NetWorker User program, click Recover.
3. In the Source Client dialog box, click OK to select the local client.
4. In the Destination Client dialog box, click OK to select the local client.
5. In the Recover window, mark the ASR: save set for recovery.
6. Click Start. The files for the ASR disk are saved locally in the %temp% directory.
7. When prompted to create an ASR disk for this client, click Yes.
8. When prompted, insert the first blank, formatted disk into the A:\ drive and click
OK.
9. When prompted about pausing the ASR recovery to select which save sets to
restore, choose one of these options:
• Yes — During recovery of the NetWorker client host computer, ASR pauses
and prompts for the save sets to restore. If the ASR save set was backed up as a
component of save set All during a scheduled backup, or as a component of a
manual backup, all of the client’s save sets are available to select. If the ASR
save set was backed up individually during a scheduled backup, only those
save sets included in the scheduled backup are available for selection.
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• No — ASR performs a fully automated recovery of the NetWorker client host
computer, without a pause. If the ASR save set was backed up as a component of save
set All during a scheduled backup, or as a component of a manual backup, all of the
client’s save sets are restored. If the ASR save set was backed up individually during a
scheduled backup, only those save sets included in the scheduled backup are restored.
10. Label each ASR disk after it is created.
11. If the network connections for this client were renamed, complete the procedure
described in “Posting ASR disk creation task” on page 590.

Creating an ASR disk by using directed recovery
If the NetWorker client computer is not functional, you can use the directed recovery method
to create an ASR disk. The directed recovery method is also useful for performing centralized
NetWorker administration, and in cases where you cannot access the
%SystemRoot%\Repair\nsr directory on the NetWorker client because the system is
damaged.
To create an ASR disk by using directed recovery:
1. Log in with administrator privileges to a NetWorker client computer.
2. In the NetWorker User program, click Recover.
3. In the Source Client dialog box, select the NetWorker client for which you are creating the
ASR disk and click OK.
4. In the Destination Client dialog box, click OK to select the local client.
5. In the Recover window, mark the ASR: save set for recovery.
6. Click Start. The files for the ASR disk are saved in the %temp% directory on the
destination client (the computer you are using to perform the directed recovery).
7. When prompted to create an ASR disk for this client, click Yes.
8. When prompted, insert the first blank, formatted disk into drive A:\ and click OK.
9. When prompted about pausing the ASR recovery to select which save sets to restore,
choose one of these options:
• Yes — During recovery of the NetWorker client host computer, ASR pauses and
prompts for the save sets to restore. If the ASR save set was backed up as a component
of save set All during a scheduled backup, or as a component of a manual backup, all
of the client’s save sets are available to select. If the ASR save set was backed up
individually during a scheduled backup, only those save sets included in the
scheduled backup are available for selection.
• No — ASR performs a fully automated recovery of the NetWorker client host
computer, without a pause. If the ASR save set was backed up as a component of save
set All during a scheduled backup, or as a component of a manual backup, all of the
client’s save sets are restored. If the ASR save set was backed up individually during a
scheduled backup, only those save sets included in the scheduled backup are restored.
10. Label each ASR disk after it is created.
If the network connections for this client were renamed, complete the procedure described in
“Posting ASR disk creation task” on page 590.

Creating an ASR disk
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Posting ASR disk creation task
When an ASR save set is created, client network connections are saved with the
current client network connection name. During a disaster recovery, Microsoft ASR
requires that the network connections be reconfigured by using the default name
assigned by Microsoft. If the client network connections were renamed before the
ASR save set was created, update the ASR disk to use the original names assigned by
Microsoft.
To update the ASR disk to use the default Microsoft ASR client network connection
names:
1. Using a text editor, open the net.cfg file on the ASR disk.
2. Replace all instances of the renamed client network connection with the default
Microsoft network connection name.
For example, suppose the Microsoft default network connection name Local Area
Connection was renamed Backup Subnet. In this case, one would replace all instances
of the name Backup Subnet with Local Area Connection.
Microsoft uses these conventions to name client network connections:
• Local Area Connection
• Local Area Connection x
where x is the second, third, or fourth connection and so on.
3. Close and save the net.cfg file.

Using the ASR disk to recover a NetWorker client
ASR recovery should typically be used only if the failed computer requires a full
disaster recovery (for example, if the system drive has failed). For information about
other disaster recovery options, refer to the EMC NetWorker Disaster Recovery Guide.
During an ASR recovery, this occurs:
◆

All disk signatures, volumes, and partitions are restored.

◆

The Windows operating system is reinstalled.

◆

If you selected "pause during recovery" while creating the ASR disk, you are
prompted to select which NetWorker backup save sets to recover.

◆

The NetWorker software recovers the selected backup save sets.

If you perform an ASR recovery of a Windows XP Professional client that has any
type of Microsoft Windows licensing other than Enterprise licensing, you are then
prompted to reactivate the Windows license.

Requirements for an ASR recovery
An ASR recovery requires:
◆

A current ASR disk for the computer being recovered. “Creating an ASR disk” on
page 588 provides more information.
If a current ASR disk or ASR save set is not available for the failed computer, use
the legacy NetWorker disaster recovery method. The EMC NetWorker Disaster
Recovery Guide provides details.
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◆

The Microsoft Windows XP Professional or Windows Server 2003 installation CD
for the computer you are recovering.
Note: Recovery CDs provided by computer manufacturer are not supported for ASR
recovery. “OEM recovery CDs are not supported” on page 586 provides more information
about this restriction.

◆

The latest NetWorker backup for the computer you are recovering.

Note: If you routinely move NetWorker backup media to an offsite location for safekeeping,
ensure that all necessary volumes are available before you start the recovery. To list the media
associated with the files you want to recover, run mminfo -mv from the command prompt. The
EMC NetWorker Command Reference Guide provides more information about the mminfo
command.

Performing an ASR recovery
To perform an ASR recovery on a NetWorker client computer:
1. Start the target computer from the Windows XP Professional or Windows Server
2003 installation CD.
Note: You may need to run the BIOS setup program to configure the computer to boot from
the CD-ROM drive. For instructions, refer to the computer manufacturer’s documentation.

2. Watch closely at the beginning of the boot process. If prompted, press a key to
boot from the CD-ROM drive.
3. During the text-mode phase of Windows setup, watch the lower portion of the
screen. When prompted, press [F2] to display the ASR Recovery menu. Follow
the instructions on the screen.
4. When prompted, insert the ASR disk into the A:\ drive and press a key to
continue. ASR formats the system partition, copies files, and begins the Windows
installation.
Note: Due to a Microsoft Windows 2003 ASR mode problem, when prompted to insert the
ASR disk and press a key to continue, you may need to press a key several times before the
system recognizes the disk and proceeds with the recovery. This problem does not occur on
Windows Server 2003 systems.
If multiple diskettes are required for recovery, the recovery process may not prompt
explicitly for the next diskette. Instead, a message may appear that is identical to the
message that prompted you to insert the ASR diskette at the beginning of the recovery
procedure. In this case, insert the next diskette and press a key to continue.

5. If you did not select the "pause during recovery" option while creating the ASR
disk, a fully automated recovery is performed. There is no pause and you are not
prompted to select the save sets to recover.
If you selected the "pause during recovery" option while creating the ASR disk,
the NetWorker ASR Client dialog box appears during the graphical phase of the
Windows installation. Expand My Computer to view the save sets to recover,
then click Continue.

Using the ASR disk to recover a NetWorker client
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The save sets are marked by default and include these legacy save sets:
• SYSTEM STATE:\
• SYSTEM DB:\
• SYSTEM FILES:\
If VSS is licensed and enabled, these VSS save sets are included:
• VSS SYSTEM BOOT:\
• VSS SYSTEM FILESET:\
VSS USER DATA, VSS OTHER, and VSS SYSTEM SERVICES do not appear
because they are not required to boot from ASR mode. “Creating an ASR disk” on
page 588 provides more information about the "pause during recovery" option.
By default, the displayed save sets represent the most recent backup. You can
view and select previous backups by typing a new browse time in the Browse
Time field. The browse time must be entered in time and date the nsr_getdate
format. For example, a date can be specified by using the format mm/dd/yy or
month dd, yy. The EMC NetWorker Command Reference Guide provides more
information about nsr_getdate.
The VSS components and certain components cannot be correctly restored during
ASR recovery. “Components that require special handling after an ASR recovery”
on page 592 provides information on how to ensure that all necessary
components are properly recovered.

Components that require special handling after an ASR recovery
Due to limitations in Microsoft ASR functionality, these system state components
cannot be correctly restored during ASR recovery:
◆

COM+ Registration Database

◆

Disk Quota Database

◆

Windows Management Instrumentation Database

◆

VSS writers

If the NetWorker client being recovered uses any of these components, perform this
procedure after an ASR recovery:
1. Log in with administrator privileges to the target computer.
2. Start the NetWorker User program.
3. Click Recover.
4. In the Source Client dialog box, click OK to select the local client.
5. In the Destination Client dialog box, click OK to select the local client.
6. In the Recover window, if VSS is licensed and enabled, mark all VSS save sets for
recovery, except VSS ASR DISK, and then go to step 9 . If a VSS client license does
not exist, or VSS is disabled, go to step 7 .
7. Check for the presence of the COM+ Registration Database component. If it is
present, select the SYSTEM STATE save set for recovery.
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8. In the Recover window, select the SYSTEM DB save set:
a. Check for the presence of these components:
– Disk Quota Database
– Windows Management Instrumentation Database
b. If either of these components is present, select the SYSTEM DB save set for
recovery.
9. If you selected any save sets for recovery, click Start.

Verifying the NetWorker client recovery
VSS is unavailable during ASR recovery. Once ASR recovery is complete and the
system is rebooted, VSS is available for proper recovery of the writers. Appendix A,
“SYSTEM and VSS SYSTEM Save Sets” has more information about VSS writers.
Appendix D, “Additional Features of the Microsoft Windows Server” provides
information about how the NetWorker software handles the Windows system state
and system-protected files.
To verify the NetWorker client recovery:
1. Reboot the NetWorker client computer and verify that the NetWorker Remote
Exec and NetWorker Power Monitor services have started.
2. Use the Windows Event Viewer to examine the event logs for errors. In particular,
check for these:
• Service startup errors related to the Windows system state.
• Errors regarding the recovery of Windows system-protected files.
3. Verify that any applications (such as Microsoft Office) that were running prior to
the disaster have been properly restored.
To verify:
a. Run each application.
b. Open a previously saved document.

Using the ASR disk to recover a NetWorker client
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Terminology
This section defines terms that are used in this document to describe NetWorker
support for Windows Disaster Recovery technology.
◆

Application data — User data that is created by the application, such as log files
or user data that is created with the application, such as an application database.
For example, a SQL server’s application data includes its databases and log files.
Application data is not included nor is it recoverable from a Windows Disaster
Recovery operation. Application data must be backed up and recovered with a
NetWorker module such as the NetWorker Module for Microsoft (NMM).

◆

ASR Writer — The Volume Shadow Copy Service (VSS) writer that is responsible
for identifying critical data that is needed to perform an offline restore.

◆

Bare Metal Recovery (BMR) — The restoration of a computer operating system
and its data after a catastrophic failure such as a hard disk failure or the
corruption of critical operating system components. A bare metal recovery is an
automated process and does not require the manual installation of an operating
system.

◆

Boot Configuration Data (BCD) — The BCD store contains boot configuration
parameters and controls how the operating system is started for Microsoft
Windows 7 and Microsoft Window Server 2008 operating systems. A backup of
this ASR Writer component is required to perform an offline restore.

◆

Critical Volume — A critical volume includes:
• Any volume containing system state (see definition later in this section) files
or files for an installed service, including volumes mounted as NTFS
directories that contain such files. An example of an installed service would be
the Exchange 2010 application binaries. However, the Exchange database and
log files are not considered critical.
• Any parent volume where a critical volume is mounted.
• All volumes on all dynamic disks if at least one of those volumes is critical.
A current backup of all critical volumes is required to perform a Windows
Disaster Recover.
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◆

Disaster recovery — The restoration of a computer operating system and its data
after a catastrophic failure such as a hard disk failure or the corruption of critical
operating system components. A disaster recovery may or may not be a bare
metal recovery.

◆

NetWorker Windows Disaster Recovery image — a bootable image that contains
NetWorker binaries and a wizard to control the Windows Disaster Recovery
process.

◆

Non-critical volume — A volume containing files that are not part of the system
state or an installed service.

◆

Offline restore — A restore operation performed from the NetWorker Windows
Disaster Recovery boot image. An offline restore is an automated process and
does not require the manual installation of an operating system. A Bare Metal
recovery (BMR) is an offline restore.

◆

Online restore — A restore operation that is performed from the regular
NetWorker recover user interface. An online restore requires that the computer
has been booted from an installed operating system.
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◆

System State — All files that belong to VSS writers with a usage type of
BootableSystemState or SystemService. This is required to perform an offline
restore.

◆

User data — Data that is generated by users, typically for the purposes of a
business function. A Microsoft Word document or an Excel spreadsheet is an
example of user data. User data is not backed up nor is it recovered with
Windows Disaster Recovery unless it resides on a critical volume. The simplest
way to backup all user data is to specify the keyword All in the backup save set of
the client resource. User data can be restored online at any time (on demand) or
after a Windows Disaster Recovery operation.

◆

Windows Disaster Recovery — Also known as Windows DR, is a bare metal
recovery of a host. NetWorker provides an automated bare metal recovery
solution for Windows.

◆

WinPE — A bootable stripped-down version of the Windows operating system.
The NetWorker Windows Disaster Recovery image contains a customized WinPE
with NetWorker binaries and a wizard to control the offline restore process. Be
aware that VSS writers, except for the ASR writer, are not supported in WinPE.
Therefore, VSS writers are not available with a NetWorker Windows Disaster
Recovery.

Windows Disaster Recovery overview
Starting with NetWorker 7.6 Service Pack 2, support has been added for Windows
Disaster Recovery (DR) for NetWorker clients on the following platforms:
◆

Windows 2008 (x86 and x64) and Windows 2008 Server Core

◆

Windows 2008 R2 SP1 (x64) and Windows 2008 R2 Server Core

◆

Windows 7 (x86 and x64)

◆

Windows 7 SP1 (x86 and x64)

To support Windows Disaster Recovery on a NetWorker client, the minimum
required NetWorker server and NMC Console versions are 7.5 SP3 and 7.6 SP1.
NetWorker Windows DR provides an automated Bare Metal Recovery (BMR)
solution by using the Windows ASR writer and other VSS writers to identify critical
volumes that are needed to perform a disaster recovery on a disabled system.
NetWorker DR is performed offline, which means that the Windows operating
system is not active. This avoids the need to reinstall Windows manually and also
avoids the problems that occur when restoring operating system files to an active
Windows system.
To support Windows Disaster Recovery, NetWorker provides a bootable Windows
Disaster Recovery image that contains NetWorker binaries and a wizard to control
the disaster recovery process.
IMPORTANT
Although Windows Disaster Recovery is supported for hosts that are protected
with the NetWorker Module for Microsoft Applications (NMM), there are special
backup and recovery considerations that you need to know. For specific backup
and recovery instructions, refer to the NMM documentation.

Windows Disaster Recovery overview
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Offline versus online recovery
An offline recovery is an automated bare metal disaster recovery operation and does
not require the manual installation of an operating system. Windows Disaster
Recovery is an offline operation. For Windows 2008, 2008 R2, and Windows 7,
Microsoft only supports disaster recovery that is performed offline.
Additionally, the successful recovery of the Windows system state (to the same or
similar hardware) can only be achieved through offline disaster recovery. Disaster
recovery backups should be taken after system components are installed, removed, or
updated. This includes adding, changing, or removing Windows roles and features,
or installing Windows updates.
You cannot select specific files or save sets to recover during an offline recovery. To
select specific files or save sets for recovery, you must perform an online recovery. An
online recovery is a typical NetWorker recovery that is performed when you need to
recover only specific files or save sets. Chapter 13, “Recovering Data” provides more
information about the online recoveries.
The following list contains references to information about specific online recovery
operations:
◆

Active Directory
The NetWorker Disaster Recovery Guide provides more information.

◆

Windows Server Failover Cluster
The NetWorker Disaster recovery Guide provides more information.

◆

DFS-R
Appendix C, “Backing Up and Restoring a Microsoft DFS” provides more
information.

If you are protecting a system that also hosts Active Directory, DFS-R, or Windows
Server Failover Cluster, and you want to have the option to recover these items
online, then you must back up the following save sets explicitly:
VSS SYSTEM BOOT:\
VSS SYSTEM SERVICES:\
VSS SYSTEM FILESET:\
If you do not back up the previously listed save sets explicitly, Active Directory,
DFS-R, or Windows Server Failover Cluster applications are still recovered with a
Windows Disaster Recovery operation. However, these save sets will not be available
for an online recovery operation. “Windows Disaster Recovery backups” on page 611
provides more information about backing up the VSS system save sets explicitly.
IMPORTANT
Online restore of VSS SYSTEM save sets is generally not supported except for the
three applications (Active Directory, failover cluster, and DFS-R) listed previously.
For these applications, online restore of VSS SYSTEM save sets is supported only
if the same Windows OS instance is being used. The incorrect online restore of
VSS SYSTEM save sets could lead to an inconsistent state of the Windows system.
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Backup and recovery roadmap
Table 106 provides a roadmap of the typical Windows DR backup and recovery
process. The roadmap also indicates which steps need to be performed before you
attempt a Windows DR.
Table 106

Windows DR backup and restore roadmap
Do before attempting a
Windows DR?

Backup and restore step

For more information

Understand Windows DR
limitations

“Windows Disaster Recovery
limitations and considerations” on
page 604.

Yes

Plan your backups

“Back up planning” on page 611

Yes

Back up the
DISASTER_RECOVERY:\ save set

“How to include Windows DR in
scheduled backups” on page 612

Yes

“How to include Windows Disaster
Recovery in manual backups” on
page 614
Verify the backup

“How to verify that a valid disaster
Yes
recovery backup exists” on page 614

Create disaster recovery boot
media

“Task 1: Create the NetWorker
Windows Disaster Recovery
bootable media” on page 616

Yes

Meet the restore prerequisites

“Task 2: Prerequisites” on page 618

Yes

Obtain information necessary for
restore

“Task 3: Gather information” on
page 618

Yes

Test the Disaster Recovery wizard

“Task 4: Test the wizard” on
page 619

Yes

Recover critical disks

“Task 5: Run the wizard” on
page 619

Recover non-critical disks and VSS
system state data, if necessary

“Task 6: Post-Restore operations” on
page 630

Windows Disaster Recovery overview
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Changes to the All backup save set
To support Windows DR in a NetWorker 7.6 SP2 client or higher, the behavior of the
NetWorker save set All has changed significantly when backing up Windows 2008 /
2008 R2 and Windows 7 hosts. This section highlights the major changes to be aware
of when using the save set All to protect Windows 2008 / 2008 R2 and Windows 7
hosts. For all other Windows operating systems, the save set All remains unchanged.
Table 107 highlights these changes.
Table 107

Changes to the All save set for Windows 2008 / 2008 R2
and Windows 7

Components of the All save set for Windows
Server 2003 with VSS licensed and enabled

Components of the All save set for
Windows 2008 / 2008 R2 and Windows 7*

VSS SYSTEM BOOT:\
VSS SYSTEM FILESET:\
VSS SYSTEM SERVICES:\
VSS USER DATA:\
VSS OTHER:\
VSS ASR DISK:\ (Windows Server 2003 only)
All local physical drives

DISASTER_RECOVERY:\ (included in Full backup only)
All local physical drives

* For Windows Vista and for Extensible Firmware Interface (EFI) systems, Windows Disaster Recovery backups
are not supported. The All save set components for Vista and EFI hosts are equivalent to a Windows 2003 host
that has VSS licensed and enabled. For Windows 2008 / 2008 R2 and Windows 7, you can also revert the
definition of the All save set to be equivalent to a Windows 2003 host with VSS licensed and enabled by using the
VSS:DISASTER_RECOVERY=off keyword in the Save Operations attribute. “Save Operations attributes for
Windows Disaster Recovery” on page 639 provides more information.

Note: VSS save sets are not included in a DISASTER_RECOVERY:\ save set and cannot be
restored separately from the DISASTER_RECOVERY:\ save set. You can still back up VSS save
sets for special cases such as an online recovery of Active Directory, DFS-R, or Windows Server
Failover Cluster. “Windows Disaster Recovery backups” on page 611 provides more
information.

In addition to Windows DR capabilities, regular file system backup and recovery is
provided by specifying the save set All.
Components of the DISASTER_RECOVERY:\ save set
The new DISASTER_RECOVERY:\ save set encapsulates all of the critical volumes
that are required to provide complete Windows DR capabilities. The disaster recovery
backup also creates save sets for each critical volume. The critical volume save sets
are named OSSR_driveletter where driveletter is the drive letter. For example, if drives
C and D were identified as critical drives, they would be listed as OSSR_C and OSSR_D.
If the critical volume is on a mount point, then the mount point name will also be
included in the save set name. For example, if a critical volume is mounted on
F:\mnt_point, then the save set name would be OSSR_F_mnt_point.
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All save sets that are included in a DISASTER_RECOVERY:\ save set can be displayed in the
NMC Administration window in either the Log tab of the Monitoring window or in the Save
Set tab of the Media window. Figure 45 shows the DISASTER_RECOVERY:\ save sets in the
Save Set tab of the Media window.

Figure 45

Viewing DISASTER_RECOVERY:\ save sets

The following volumes are considered critical and are included in the disaster recovery
backup:
◆

Any volume that contains operating system files or files needed by an installed service.

◆

A non-critical volume that has a critical volume mounted on it, or a non-critical volume
that serves as a parent to a critical volume. This default behavior is user configurable,
“Save Operations attributes for Windows Disaster Recovery” on page 639 provides more
information.

◆

All volumes on all dynamic disks if at least one of those volumes is critical.
For example, supposed you have 4 hardware disks in a RAID 5 configuration, and you
partition the 4 volume RAID set into 3 partitions as seen by the operating system. If you
then installed a service like the NetWorker client's nsrexecd program on one of those
partitions, then that partition would become critical, as would the whole 4 volume set.
This behavior is user configurable, “Save Operations attributes for Windows Disaster
Recovery” on page 639 provides more information.

The following files are not backed up on critical volumes:
◆

Files listed in the FilesNotToBackup registry key

◆

Files excluded by system writers

◆

Files that are backed up by a VSS application writer such as Exchange databases.
These files must be backed up with a backup module application such as NetWorker
Module for Microsoft Applications (NMM).

Windows Disaster Recovery overview
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The following table provides some examples of how critical and non-critical data is
handled in backup and recovery operations associated with the
DISASTER_RECOVERY:\ save set.
Table 108

Volume type
Critical

Critical and non-critical data

DISASTER_RECOVERY:\
backup examples

DISASTER_RECOVERY:\
restore examples

Boot Configuration Data (BCD)
BCD is part of the system state. If the
BCD directory is on a Reserved System
Partition, then that partition is mounted
to a drive letter and backed up.
C:\
All System State data.
Data not backed up by an application
VSS Writer.

The system state files for BCD and C:\ are
restored along with any files not associated
with an application VSS Writer. Files
associated with an application VSS Writer
are not restored.

<drive_letter>:\
Files associated with operating system
services installed on the drive (therefore
part of the System State).
Data not backed up by an application
VSS Writer.

Files associated with installed services
(system state) are restored along with any
files not associated with an application VSS
Writer.

Note: Files that are associated with application VSS Writers are not backed up as part of
the DISASTER_RECOVERY:\ save set and therefore, cannot be not restored unless they
were backed up by an application backup program such as NMSQL, NME, or NMM. These
application backup programs are designed to backup applications such SQL Server,
Exchange, and others.
non-critical

No data is backed as part of the
DISASTER_RECOVERY:\ backup.

No data is recovered as part of a Windows
Disaster Recovery operation.

Full versus incremental backups with the All save set
The DISASTER_RECOVERY:\ save set is backed up only during Full level backups.
During incremental level backups, all other specified save sets are backed up. The
typical size of a backup that is created with the All save set may increase significantly
for Windows 2008 / 2008 R2 and Windows 7. This is because some user data on
critical volumes is backed up twice: once in the DISASTER_RECOVERY:\ save set
and once for regular file system backup of local and mapped drives.
To reduce the size of the All save sets that are created during full level backups,
consider using Avamar or Data Domain deduplication technology with NetWorker.
For more information about deduplication backups with NetWorker clients, refer to
the EMC NetWorker Avamar Integration Guide or the EMC NetWorker Data Domain
Deduplication Devices Integration Guide.
Note: When the save set All is attempted for the first time on a system before a
DISASTER_RECOVERY:\ save set has been saved, the save level will be forced to Full so that a
DISASTER_RECOVERY:\ backup is assured.

602

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Support for Windows 2008 / 2008 R2 / Windows 7 Disaster

Online recovery of VSS system state data
For the purposes of an online recovery, VSS system state data cannot be recovered
from the DISASTER_RECOVERY:\ save set. An online recovery of VSS system state
data may be required in special cases such as the recovery of specific writers for
Active Directory or Windows Server Failover Cluster. To protect these Windows
hosts, you can specify the following VSS save sets in a backup client resource:
◆

VSS SYSTEM BOOT

◆

VSS SYSTEM SERVICES

◆

VSS SYSTEM FILESET

Alternatively, you can disable the backup of the special DISASTER_RECOVERY:\
save set and instead, backup the regular VSS save sets by adding the
VSS:DISASTER_RECOVERY=off keyword to the Save Operations attribute of the
NetWorker client resource. When this keyword is set to off and the All save set is
specified, the following VSS save sets will be available for online restore operations:
◆

VSS SYSTEM BOOT

◆

VSS SYSTEM SERVICES

◆

VSS SYSTEM FILESET

◆

VSS OTHER

◆

VSS USER DATA

For more information, see “Windows Disaster Recovery backups” on page 611.

Windows Disaster Recovery overview
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Windows Disaster Recovery limitations and considerations
This sections includes the following Windows Disaster Recovery limitations and
special considerations to be aware of before performing disaster recovery backup and
recovery operations.
◆

“Regular backups” on page 604

◆

“Capturing disk configuration changes for Windows Disaster Recovery” on
page 604

◆

“Full backups are required for Windows Disaster Recovery” on page 604

◆

“Use deduplication if possible” on page 605

◆

“Windows Disaster Recovery is not available for online recovery” on page 605

◆

“Mixing critical and non-critical volumes on a physical disk” on page 605

◆

“Cloning disaster recovery save sets” on page 605

◆

“Support for NetWorker directives” on page 606

◆

“EFI and uEFI systems are not supported” on page 606

◆

“Only NTFS file systems are recognized as critical volumes” on page 606

◆

“Fat / Fat32 file systems are not recognized as critical volumes” on page 606

◆

“VSS save sets and post-offline recovery tasks” on page 606

◆

“Protecting Windows Server Roles” on page 607

◆

“Protecting Microsoft server applications” on page 608

◆

“SQL cluster with NMSQL as backup software” on page 608

◆

“VMware considerations” on page 610

◆

“Conflict with drive letter X:” on page 610

Regular backups
Ensure that a Full level backup that contains the DISASTER_RECOVERY:\ save set is
performed regularly and after any significant change to your Windows operating
system.

Capturing disk configuration changes for Windows Disaster Recovery
Windows Disaster Recovery uses the Microsoft ASR Writer to reconstruct a disk
configuration during the disaster recovery. ASR is sensitive to the disk numbers and
disk configuration on the original host. This disk information is saved during a
Windows Disaster Recovery backup and is used when the disk configuration is
recovered. After any disk reconfiguration on the protected host, reboot and do a
Windows Disaster Recovery backup to ensure that the new disk configuration is
captured. Examples of a disk reconfiguration are the adding or removing of a disk or
partition on the protected host.

Full backups are required for Windows Disaster Recovery
The DISASTER_RECOVERY:\ save set is backed up only during a Full level backup,
The DISASTER_RECOVERY:\ save set is not backed up with an incremental backup.
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Use deduplication if possible
To reduce the size of the All save sets that are created during full level backups,
consider using Avamar or Data Domain deduplication technology with NetWorker.
For more information about deduplication backups with NetWorker clients, refer to
the EMC NetWorker Avamar Integration Guide or the EMC NetWorker Data Domain
Deduplication Devices Integration Guide as appropriate.

Windows Disaster Recovery is not available for online recovery
The DISASTER_RECOVERY:\ save set and its corresponding OSSR_driveletter save
sets are not available for online recovery. A BMR Windows Disaster Recovery must
be performed offline.

Mixing critical and non-critical volumes on a physical disk
Windows allows a physical disk to be partitioned into multiple volumes. These
volumes can be either critical or non-critical, depending on the data they contain.
During a disaster recovery, the ASR writer may recreate partitions and perform
formatting of those partitions. In some cases, such as a disk replacement scenario, this
could include non-critical partitions as well. If this happens, the data must be
recovered with an on-line recovery. “Task 6: Post-Restore operations” on page 630
provides more information.
IMPORTANT
It is recommended that users do not mix critical and non-critical volumes on the
same physical disk.

Cloning disaster recovery save sets
Be aware of the following considerations when cloning Windows disaster recovery
save sets.
Select DISASTER_RECOVERY:\ and OSSR_driveletter save sets
The disaster recovery backup creates save sets for each critical volume. The critical
volume save sets are named OSSR_driveletter where driveletter is the drive letter. If the
critical volume is on a mount point, then the mount point name will also be included
in the save set name. For example, if a critical volume is mounted on F:\mnt_point,
then the critical volume save set name would be OSSR_F_mnt_point.
When specifying a clone job for disaster recovery save sets, be sure to specify the
DISASTER_RECOVERY:\ save set and its corresponding OSSR_driveletter_mnt_point
save sets.
“Components of the DISASTER_RECOVERY:\ save set” on page 600 provides more
information on how to view the OSSR save sets that are associated with a
DISASTER_RECOVERY:\ save set.
Automatic cloning from a backup group
If you have set up a backup group to automatically clone disaster recovery save sets,
ensure that NetWorker server and client host clocks are synchronized across the
network. Otherwise, some or all of the save sets may not be cloned.

Windows Disaster Recovery limitations and considerations
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Support for NetWorker directives
The following list explains how the three types of NetWorker directives are handled
during a Windows Disaster Recovery backup.
◆

Global directves — All NetWorker global directives are ignored except for the
AES encryption directive.

◆

NetWorker User local directives — All such directives are ignored.

◆

Local directive files — All such directives are ignored.

Chapter 6, “Directives” provides more information on directives.

EFI and uEFI systems are not supported
Systems with Extensible Firmware Interface (EFI) or Universal Extensible Firmware
Interface (uEFI) are not supported for Windows DR backup and recovery.

Only NTFS file systems are recognized as critical volumes
Only critical volumes on NTFS partitions are supported for Windows Disaster
Recovery. This is a Microsoft ASR limitation. If a critical volume is on a non-NTFS
partition, the DISASTER_RECOVERY:\ will fail with the error message:
Disaster Recovery: Critical volume contains non-NTFS drives, but
cannot be included in the savesets

This message is logged in the savegrp.log file. To remedy the situation, find the
service or application that is installed on a non-NTFS volume, remove it, and reinstall
it on a NTFS volume.

Fat / Fat32 file systems are not recognized as critical volumes
Fat/Fat32 file systems are not supported by Windows Disaster Recovery as critical
volumes.

VSS save sets and post-offline recovery tasks
Although VSS system state writers are recovered during a Windows Disaster
Recovery operation, they cannot be selected explicitly during a NetWorker Windows
Disaster Recovery operation. If you want the option to recover just the following
writers, you must select them for recovery in an online recovery operation.
NetWorker supports online recovery of the following VSS writers:
◆

Active directory

◆

Distributed File System Replication (DFS-R)

◆

Windows Server Failover Cluster

To recover the above writers online, you must backup the following VSS SYSTEM
STATE save sets separately from the DISASTER_RECOVERY save set. Also, ensure
that the following VSS system state writers are backed up and recovered together:
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For information about including VSS system state save sets in a back up, see
“Windows Disaster Recovery backups” on page 611. To recover VSS save sets, see
“Task 6: Post-Restore operations” on page 630.
Active Directory considerations
Windows Disaster Recovery of a Domain Controller is non-authoritative by default. If
you need to perform an authoritative restore, you must boot into DSRM mode
directly from the NetWorker disaster recovery wizard. “Post-Restore operations for
Active Directory” on page 632 provides more information.
DFS-R considerations
The Replication folder will be saved with the DISASTER_RECOVERY:\ save set only
if the folder resides on a critical volume. If the replication folder resides on a
non-critical volume that is included in a backup, it can be recovered online after a
Windows Disaster Recovery.

Protecting Windows Server Roles
Several server role components of Windows Server 2008 and 2008 R2 need a database
for their data storage. Examples of Windows server roles with databases include:
◆

Active Directory Rights Management Services (ADRMS)

◆

Windows System Resource Manager (WSRM)

◆

Universal Description, Discovery, and Integrations (UDDI) Services

◆

Windows Server Update Services (WSUS)

When these Windows server roles are installed, you can select either an existing SQL
Server installation or the Windows Internal Database (WID). WID is a variant of SQL
Server Express 2005 and is a feature component of Windows Server 2008. The Volume
Shadow Copy Service (VSS) SQL Server Writer is used to protect the WID databases.
NetWorker Windows Disaster Recovery protects role databases stored in WID but
does not protect role databases stored in a SQL Server outside of WID.
If system state data, such as roles, are stored in a SQL Server dataase outside of WID,
then the data must be protected by using NetWorker Module for Microsoft
Applications (NMM), NetWorker Module for SQL (NMSQL), or a third party SQL
backup product. SQL server system databases (master, model, and msdb) are not
restored as part of NetWorker Windows Disaster Recovery. To perform a SQL Server
disaster recovery, you must:
◆

Perform a SQL Server disaster recovery to rebuild the SQL system databases.

◆

Use the SQL application backup tool such as NMM to restore all the SQL
databases as required.

Backup and recovery workflow for server roles that use WID
Use NetWorker Windows DR to save and restore the WID database.
1. Perform a NetWorker Windows Disaster Recovery backup. All SQL Writer
components for WID will be included in the backup.
2. Perform a NetWorker Windows Disaster Recovery operation. All WID
components are restored.
After the NetWorker Windows Disaster Recovery system reboot, the WID service
is available and Windows server roles have access to their databases.

Windows Disaster Recovery limitations and considerations
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Backup and recovery workflow for server roles that use SQL Server
Use NMM, NMSQL, or a third-party application to restore SQL Server components.
1. Protect the host system state and user data with the NetWorker Windows client.
2. Protect the SQL Server application with NMM, NMSQL, or a third party
application.
3. Perform a NetWorker Windows Disaster Recovery operation.
After the disaster recovery reboot, the system is restored but the SQL Server
service will not run. Any roles with databases in the SQL Server will not work.
4. Perform a SQL Server disaster recovery. Refer to the following Microsoft URL
http://msdn.microsoft.com/en-us/library/ms189302.aspx

5. Restore the SQL system databases (master, model, msdb) with NMM, NMSQL, or
a third party application.
6. Restore the role databases with NMM, NMSQL, or a third party application.
7. Restart the services that require the restored role databases.

Protecting Microsoft server applications
Microsoft server application hosts such as a Microsoft Exchange Server, Microsoft
SQL Server, Microsoft Data Protection Manager (DPM), Hyper-V, or Microsoft Office
SharePoint Service, should be protected with both a NetWorker module and the
regular NetWorker client. The NetWorker module will protect the application data
such as databases and log files. The regular NetWorker client will protect the host’s
critical disks for the purposes of bare metal recovery.
The workflow of a complete disaster recovery operation is:
◆

Back up critical and non-critical disks as part of your regular NetWorker file
system backups.

◆

Back up applications such as Microsoft SQL Server by using a NetWorker module
such as the NetWorker Module for Microsoft Applications (NMM) or the
NetWorker Module for SQL (NMSQL).

◆

Perform a Windows DR of the host’s critical volumes.

◆

Recover any non-critical disks using the NetWorker User Program or if NMM is
being used, the NMM recovery interface. If NMM is being used, refer to the
NMM documentation for details.

◆

Recover application data using a NetWorker module such as NMM.

For more information about recovering application data, refer to the documentation
that comes with your NetWorker module software.

SQL cluster with NMSQL as backup software
If you are using the NetWorker Module for Microsoft SQL Server (NMSQL) to
protect a SQL server that is hosted in a Microsoft cluster, there are special
considerations to aware of in order to use NetWorker Windows Disaster Recovery.
This section provides an example and the steps to follow in order to use NetWorker
Windows Disaster Recovery with a clustered Microsoft SQL server that is protected
with NMSQL.
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Example 47 Protecting a clustered SQL server with NMSQL and Windows Disaster Recovery

This example assumes the following conditions:
◆

Microsoft SQL Server 2008 R2 is hosted on a Microsoft Failover Cluster on
Windows 2008 SP2.

◆

NMSQL 5.2 SP2 is used to protect the SQL server.

◆

Node & File share Majority is the quorum setting.

◆

Cluster node A has SQL installed in C:\Program Files\Microsoft SQL Server.

◆

Cluster node B has SQL installed in C:\Program Files\Microsoft SQL Server.

◆

Shared disks that include the SQL databases can be accessed by node A and B.

To protect the clustered SQL server in this example:
1. Install the NetWorker7.6 SP2 client and NMSQL 5.2 SP2 on both nodes A and B.
2. Perform an instance level backup of the virtual SQL server using NMSQL. Refer
to the NetWorker Module for Microsoft Server Administration Guide for details.
3. Perform a Windows Disaster Recovery backup for Node A. “Windows Disaster
Recovery backups” on page 611 provides more information.
4. Perform a Windows Disaster Recovery backup for Node B.
To recover a clustered SQL server in this example:
1. Perform a Windows Disaster Recovery operation on Node A first and then on
Node B. “Windows Disaster Recovery operations” on page 616 provides more
information.
The Microsoft Failover Cluster should be up and running.
Note: If the host is a virtual machine, first create a new virtual machine with the same
configuration as before the disaster, and then perform the Windows Disaster Recovery
operation.

2. Export the required shared disks. Ensure that the disks have the same properties
as the original ones, and that the disks are shared between node A and node B.
3. From the Cluster Management interface, delete any disk entries that are listed as
failed disks.
4. Add the newly exported shared disks to the SQL group and assign the same drive
letters as before the disaster.
5. On node A, rebuild the SQL server by running the following Setup command.
The Setup command is located in the SQL Server installation media and must be
executed from the command prompt. The command prompt must be run with
Windows Administrator privileges. Before running this command, ensure that
the SQL group is offline except for the shared disks.
Setup /QUIET /ACTION=REBUILDDATABASE /INSTANCENAME=Instance_name
/SQLSYSADMINACCOUNTS=domain_name\administrator

The system databases will be generated on the new shared disk. For more
information on rebuilding SQL Server:
• SQL Server 2005
msdn.microsoft.com/en-us/library/ms144259%28v=sql.90%29.aspx

• SQL Server 2008
msdn.microsoft.com/en-us/library/dd207003.aspx
Windows Disaster Recovery limitations and considerations
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6. After the SQL server is rebuilt, bring the SQL group online.
7. Try to create a new database.
If the new database is not successfully created, check the disk dependencies on
the SQL Server resource and correct them if necessary.
8. Open the NMSQL interface on Node A and recover the backed up database.

VMware considerations
This section contains Windows Disaster Recovery limitations that are specific to
VMware virtual machines.
Network card driver limitations
The Windows Disaster Recovery image does not contain a driver for any of the
VMware VMXNET network interface card (NIC) models. However, the Windows
Disaster Recovery image does contain a driver for the e1000 NIC. If you have at least
one e1000 NIC configured for the virtual machine, you can perform the disaster
recovery. Alternatively, you can add custom NIC drivers when running the Windows
Disaster Recovery wizard.

Conflict with drive letter X:
The drive letter X: is used by the WinPE image as the system drive. This creates a
conflict with any critical volume that uses the drive letter X:. If a critical volume uses
the drive letter X:, the disaster recovery backup will fail with error message:
Disaster Recovery: X drive is detected as a critical volume but cannot
be included in the savesets.

This message is logged in the savegrp.log file. To remedy the situation, do the
following:
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Move any service installed on X: to another drive.

◆

Ensure that no critical volumes are mounted on the X: drive.

◆

Perform a new DR backup.
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Windows Disaster Recovery backups
Windows DR backups can be run on a scheduled basis (full level backups only) or
manually (on demand). This section describes how to plan and set up Windows DR
backups.

Back up planning
Table 109 lists the save sets to backup depending on the Windows host that you are
protecting.
Table 109

Identifying which save sets to back up

To back up this

Specify these save sets in the client
resource Save Set attribute

Considerations

A regular Windows 2008 / 2008 R2 or
Windows 7 desktop host or file server.

Specify the save set All.
By default, the save set All includes:
• the DISASTER_RECOVERY:\ save set
• All local, physical drives

A Windows 2008 / 2008 R2 host so that the
following items can be recovered online,
that is, without requiring an offline Windows
DR operation:
• Active Directory
• Windows Server Failover Cluster
• DFS-R

•
•
•
•

The save set All cannot be listed with other save
sets. To backup a host using the All save set and
the VSS SYSTEM save sets:
1. Create two NetWorker client resources for the
host.
2. Specify the save set All in one resource and
specify the VSS SYSTEM save sets in the
other resource.
3. Ensure that each client resource is included in
a separate backup group.
“Putting disaster recovery backups on a different
schedule” on page 640 provides an example of
setting up two client resources for the same host.

Save set All
VSS SYSTEM BOOT:\
VSS SYSTEM SERVICES:\
VSS SYSTEM FILESET:\

Note: The items listed above are recovered
with the DISASTER_RECOVERY:\ save set
during an offline DR operation. However, to
recover these items online, the VSS
SYSTEM save sets must be explicitly
specified in the client’s Save Set attribute.
A Windows 2008 / 2008 R2 host with server
roles that use a SQL Server database

• Use the NetWorker client and specify
the All save set.
• Use an application backup product
such as NMM or NMSQL to back up
the SQL Server databases. Refer to the
application backup product’s
documentation for details.

1. Recover the host’s system state with
NetWorker Windows Disaster Recovery.
2. Recover the application databases with NMM
or NMSQL.

A WIndows 2008 / 2008 R2 host with
Microsoft server applications such as a
Microsoft Exchange Server, Microsoft SQL
Server, Microsoft Data Protection Manager
(DPM), or Microsoft Office SharePoint
Service

• Use the NetWorker client and specify
the All save set.
• Use an application backup product
such as NMM or NMSQL to back up
the application databases. Refer to the
application backup product
documentation for details.

1. Recover the host’s system state with
NetWorker Windows Disaster Recovery.
2. Recover the application databases with NMM,
NMSQL, or a third party application.

Windows Disaster Recovery backups
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How to include Windows DR in scheduled backups
Although you can back up the DISASTER_RECOVERY:\ save set separately, the
easiest way to schedule Windows DR backups is to specify the save set All.
Specifying the save set All, ensures that all system state data and user data can be
recovered in the event of a disaster.
To set up a Windows 2008 / 2008 R2 or Windows 7 client for scheduled Windows DR
backups, you can use either the NetWorker Client Configuration wizard or the
NetWorker Client properties window.
Configure backups with the Client wizard
To configure a client with the NetWorker Client Configuration wizard:
1. In the NMC Enterprise view, select the NetWorker server name, and double-click
the NetWorker managed application to launch it.
2. In the Configuration view, under the NetWorker server name, right-click Clients
and select Client Backup Configuration > New. Alternatively, if you are
modifying an existing client, right-click the client name and select Client Backup
Configuration > Modify.
3. Follow the instructions on the wizard pages.
On the Select Files to Back Up page, it is recommended that you select all files for
backup. This is the default selection.
• By default, the option Perform disaster recovery for this client is selected.
Un-selecting this option will exclude the DISASTER_RECOVERY:\ save set
from being backed up, and the VSS SYSTEM save sets will be generated
instead.
• If you are protecting a system that also hosts Active Directory, DFS-R, or
Windows Server Failover Cluster, and you want to have the option to recover
these items online, that is, without performing a disaster recovery, create an
additional client resource for the host and specify the following save sets:
VSS SYSTEM BOOT:\
VSS SYSTEM SERVICES:\
VSS SYSTEM FILESET:\
If you do not specify the previously listed save sets explicitly, Active Directory,
DFS-R, or Windows Server Failover Cluster applications are still recovered
with the DISASTER_RECOVERY:\ save set. However, the
DISASTER_RECOVERY:\ save set can only be recovered with an offline
recovery (Windows DR) operation.
4. Complete the wizard screens as instructed.
Configure backups with the Client properties window
To configure a client with the Client properties window:
1. In the NMC Enterprise view, select the NetWorker server name and double-click
the NetWorker application to launch it.
2. In the NetWorker Administration window, click Configuration.
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3. In the browser tree, select Clients:
• To create a new Client resource, select the Clients icon and from the File
menu, click New.
• To edit an existing client resource, select the client name from the list in the
right panel and from the File menu, select Properties.
4. In the Name attribute, type the hostname for the client and, optionally, type a
comment in the Comment attribute.
5. Select values for Browse Policy and Retention Policy:
• The browse policy determines how long the details of individual backed-up
files are maintained in a browsable index for quick recovery through the GUI
or command line.
• The retention policy determines how long backed-up data is protected and
available for recovery even though the browse policy has lapsed. Recovery
might require rebuilding an index.
6. Select the Scheduled Backups checkbox.
7. In the Save Sets attribute,
• In the Save Set attribute for the Client resource, type All. Alternatively, you
can type DISASTER_RECOVERY:\ to create a back up for disaster recovery
purposes only.
• If you are protecting a system that also hosts Active Directory, DFS-R, or
Windows Server Failover Cluster, and you want to have the option to recover
these items online, that is, without performing a disaster recovery, create an
additional client resource for the host and specify the following save sets:
VSS SYSTEM BOOT:
VSS SYSTEM SERVICES:
VSS SYSTEM FILESET:
If you do not specify the previously listed save sets explicitly, Active Directory,
DFS-R, or Windows Server Failover Cluster applications are still recovered
with the DISASTER_RECOVERY:\ save set. However, the
DISASTER_RECOVERY:\ save set can only be recovered with an offline
recovery (Windows DR) operation.
8. In the Group attribute, select a backup group. Ensure that you do not select a
Snapshot group.
9. In the Pool attribute, select a pool that targets the NetWorker devices you want to
use. The pool selected in this attribute overrides any other pool that might be
configured for the client or its save sets.
Note: For pre-NetWorker 7.6 SP1 clients, this setting should not be used.

10. In the Schedule attribute, select a backup schedule.
The schedule selected in this attribute overrides any other schedules that might
be configured for the client or its save sets.
11. When you have completed the client configuration, click OK.
In the NetWorker Administration window, the configured client shows a
checkmark in the Scheduled backup column to indicate that scheduled backup is
enabled.

Windows Disaster Recovery backups
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Chapter 2, “Backing Up Data” provides more information about setting up a
scheduled backup.

How to include Windows Disaster Recovery in manual backups
Backing up data by selecting Computer is the preferred method of performing manual
Windows Disaster Recovery backups. This method ensures that all data is backed up.
To perform a disaster recovery backup manually:
◆

In the NetWorker User program, click the Backup button and select Computer to
save all data.

◆

At a minimum, select the DISASTER_RECOVERY:\ save set.

◆

If you are protecting a system that also hosts Active Directory, DFS-R, or
Windows Server Failover Cluster, you can also select the following save sets so
that they will be available for online recovery.
• VSS SYSTEM BOOT:
• VSS SYSTEM SERVICES:
• VSS SYSTEM FILESET:

Chapter 2, “Backing Up Data” provides more information about manual backups.

How to verify that a valid disaster recovery backup exists
After you perform a Windows DR backup, verify that the backup exists. The save sets
that make up the DISASTER_RECOVERY:\ save set correspond to each critical
volume and are named as OSSR_driveletter, for example if drives C and D were
identified as critical drives, they would be listed as OSSR_C and OSSR_D.
You can verify that the backup exists by checking the NMC Console, the NetWorker
User program, or by using the nsrinfo program.
To verify that a valid disaster recovery exists by using the NMC Console:
1. In the NMC Enterprise view, select the NetWorker server name and double-click
the NetWorker application to launch it.
2. In the NetWorker Administration window, click Media.
3. In the left pane, click Save Sets.
4. In the Save Set Query tab in the right pane, specify search criteria such as the
NetWorker Client Name and a date range for the Save Time.
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5. Select the Save Set List tab in the right pane to display a list of save sets that meet
the search criteria.

Figure 46

Viewing DISASTER_RECOVERY:\ save sets in NMC

To verify that a valid disaster recovery save set exists by using the NetWorker User
Program:
1. Start the NetWorker User program by using the -s option to connect to the
NetWorker server to which the source client data is backed up:
winworkr -s servername

If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, allowing
you to choose the server.
2. Click Recover to open the Source Client dialog box.
3. Select the client whose disaster recovery save set you are verifying and click OK.
4. Select a destination client and click OK.
5. In the Recover window, browse and locate the save set named,
DISASTER_RECOVERY:\.
By default, the most recent backup is listed. You may have to adjust the browse
time if you are verifying older files. You can adjust the browse time by selecting
the View > Change Browse Time menu option.
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To verify that a valid disaster recovery save set exists by using the nsrinfo program:
◆

Type the following command at a command prompt:
nsrinfo -v -s <server> -N "DISASTER_RECOVERY:\\" <client>

where:
• <server> is the name of the NetWorker server
• <client> is the name of the client that performed the disaster recover backup.
This command must be run on a host that has the NetWorker 7.6 SP2 client.
Earlier versions of nsrinfo are not capable of displaying information about
disaster recover backups.

Windows Disaster Recovery operations
This section describes how to use the NetWorker Windows Disaster Recovery image
to perform a bare metal disaster recovery on protected hosts.
Before you ever need to perform a bare metal recovery on a host, you must have, at a
minimum, backed up the DISASTER_RECOVERY:\ save set for that host and have
completed the following tasks in this section:
◆

“Task 1: Create the NetWorker Windows Disaster Recovery bootable media” on
page 616

◆

“Task 2: Prerequisites” on page 618

◆

“Task 3: Gather information” on page 618

◆

“Task 4: Test the wizard” on page 619

This section also includes the following topics to help you complete a Windows DR
operation:
◆

“Task 5: Run the wizard” on page 619

◆

“Task 6: Post-Restore operations” on page 630

◆

“Troubleshooting Windows Disaster Recovery” on page 634

◆

“Additional recover options” on page 638

Task 1: Create the NetWorker Windows Disaster Recovery bootable media
NetWorker provides a Windows Disaster Recovery image that you can use to create a
bootable CD or network boot location. To begin the recovery process, you will boot
the Windows 2008 / 2008 R2 or Windows 7 host from the bootable CD or network
location. The disaster recovery will start a NetWorker System Recovery wizard that
will guide you through the disaster recovery process.
Be aware that although only a 32 bit version of the NetWorker Windows Disaster
Recovery image is provided, this image restores 64 bit hosts as well.
Obtaining the disaster recovery image
To download the disaster recovery boot image:
1. Go to the following location Powerlink:
Home > Support > Software Downloads and Licensing > Downloads J-O >
NetWorker
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2. Select the link for the custom Windows Disaster Recovery image named
NetWorkerWindowsDisasterRecovery_7.6.2-638_x86.iso.
The download process will begin.
Creating a disaster recovery boot CD
To create a bootable CD:
1. Open your CD creation software and select an option to burn an ISO image.
2. Browse to the location of the downloaded NetWorker Windows Disaster
Recovery image and complete the steps required to create a bootable CD with the
image.
Enabling a host to boot from a CD
To ensure that the protected host can boot from a CD:
1. Start the host and enter the BIOS set up program. Typically, you press F2 to enter
the BIOS set up program.
Note: If you are restoring a virtual host such as a VMware virtual machine, you can set up
options such as the host boot location from within vSphere. Refer to your VMware
documentation for specific steps.

2. Select the boot options menu and ensure that the CD boot option is at the top of
the list of locations from which to boot.
3. Save your changes and exit the BIOS program.
Creating a disaster recovery network boot location
The following prerequisites must be met to use the network boot option:
◆

The NetWorker clients that you are protecting must be enabled to boot from the
network with a Pre-Boot Execution Environment (PXE).

◆

A Deployment Services server must be configured and available.

◆

The NetWorker Windows System Recover boot image must be added to the
Deployment Services server so that a client host on the network can boot from it.

For example, the following link provides details on how to configure Windows
Deployment Server in Windows Server 2008:
http://technet.microsoft.com/en-us/library/cc771670(WS.10).aspx

Enabling a host to boot from the network
To enable a host to boot from the network (PXE enabled):
1. Start the host and enter the BIOS set up program. Typically, you press F2 to enter
the BIOS set up program.
Note: If you are restoring a virtual host such as a VMware virtual machine, you can set up
options such as the host boot location from within vSphere. Refer to your VMware
documentation for specific steps.

2. Select the BIOS options necessary so that the network boot option is enabled. If
need be, refer to your BIOS documentation.
3. Save your changes and exit the BIOS program.
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Your host should obtain an IP address from your WDS server and prompt you if
you want to do a network boot. Typically, a network boot is activated by pressing
the F12 key.

Task 2: Prerequisites
The following prerequisites must be met to successfully perform a recovery with the
NetWorker Windows Disaster Recovery image:
◆

The hardware on the host to be recovered (target) is operational.

◆

The hardware configuration on the target host is similar to the hardware
configuration on the host for which the Windows Disaster Recovery backup was
done (source). Any hardware, driver, or firmware differences between the source
and target computers may cause the disaster recovery to fail. For example,
recovering a 64-bit host to a 32-bit host is not supported.

◆

The target host requires a minimum of 512 MB of RAM.

◆

The target host disks must be at least the same size as the source host disks.

◆

There are at least as many disks on the target host as there were on the source
host. The disk LUN numbering on the target host must match the disk LUN
numbering on the source host

◆

The disaster recovery boot image is available from the host’s CD volume or from
the network boot location.

◆

Although the disaster recovery boot image comes with a large number of NIC
and storage device drivers, it may be necessary to load a NIC or storage device
driver while running the wizard. Any required NIC or storage adapter drivers
must be 32-bit versions and they must not require a reboot to complete the driver
installation process.
Note: It is strongly recommended that a 64 bit host that requires special drivers be tested
by booting the NetWorker disaster recovery image and loading the 32 bit version of the
special drivers by using the wizard. After verifying that the drivers can be detected by the
wizard, you can safely exit the wizard before completing the entire recovery process and
reboot to the normal operating system.

Task 3: Gather information
Ensure that you have the following before starting the Windows DR wizard:
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◆

Network or disk drivers that may need to be installed.

◆

The IP address and network name of the host that is being restored.

◆

The network name or IP address of the NetWorker server that will be used to
restore the host.

◆

If a DNS server is being used to resolve IP addresses, you need to know the
default gateway and the name of the DNS server. If a DNS server is not available,
you can use a local hosts file to resolve the NetWorker server name or IP address.

◆

The NetWorker media volumes that are required for the disaster recovery are
available. “Viewing the volumes required for data recovery” on page 324
provides information about using the NetWorker User program to obtain a list of
required volumes.
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Task 4: Test the wizard
Before you need to perform a Windows Disaster Recovery, test the wizard to ensure
that you can run it and that you have the required drivers. This task is especially
important for 64 bit hosts that may require additional drivers to complete the wizard.
For both 64 bit and 32 bit hosts, the wizard must use 32 bit drivers that do not require
a reboot.
After you test the wizard, you can safely exit the wizard before completing the entire
recovery process.
To test the wizard:
1. Complete steps 1 to 10 in “Task 5: Run the wizard” on page 619.
Verify the following as you step through the wizard screens:
• If DNS is not available, the host can resolve the NetWorker server name by
some method such as a local hosts file.
• You can see the network interface that is required to communicate with the
NetWorker server. If you cannot see the network interface, use the wizard to
load the required NIC driver.
• You can see the critical and non-critical disks for the host that is to be
recovered. If you cannot see all of the disks, use the wizard to load the
required disk drivers.
2. Click Exit to safely exit the wizard
3. Exit the command window.
The system will automatically reboot.

Task 5: Run the wizard
To perform a disaster recovery with the wizard:
Note: If DNS is not available, you can manually add and edit a hosts file to add information
about the NetWorker server. Details are provided in the following steps.

1. Boot the host to be restored from the location of the NetWorker Windows Disaster
Recovery image, either a CD or network boot location.
Refer to “Creating a disaster recovery boot CD” on page 617 or “Creating a
disaster recovery network boot location” on page 617 as necessary.
2. Click Next when the Welcome screen of NetWorker System Recovery wizard
appears.
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Figure 47

NetWorker System Recovery Wizard Welcome screen

3. Perform this step only if a DNS server is not available on the network. If DNS is
not available, you can manually add and edit a hosts file to add information
about the NetWorker server.
a. Exit the Disaster Recovery Wizard but do not reboot the host.
You will be returned to the WinPE command line.
b. Edit the hosts file (for example X:\Windows\System32\Drivers\etc\hosts)
and add the IP address and host name for the NetWorker server and Avamar
Deduplication node (if one is being used).
c. Restart the wizard from the X:\Program Files\Legato\nsr\wizard
directory. For example:
X:\Program Files\Legato\nsr\wizard> javaw -jar WinPEWizard.jar

d. When the wizard appears, click Next to continue.
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4. In the Select Network Interface screen, select the NIC (Network Interface Card)
driver so that the host can communicate with the NetWorker server during the
restore process.

Figure 48

Select Network Interface screen

If the required NIC driver is not in the list, click Load Driver to browse to a
location such as a CD or USB drive and locate the required driver.
Be aware that the selected driver cannot require a reboot operation. This is
because the WinPE environment is loaded in memory only and changes are not
persistent across a reboot operation. Also be aware that although some drivers
prompt for a reboot operation, most modern NIC drivers are generally
plug-and-play and ignoring the reboot prompt may actually work.
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5. Click Next to display the Hostname and Network screen.

Figure 49

Configure Hostname and Network screen

a. Enter the host name of the machine that you are recovering in the Host name
field.
b. Enter the name of the domain in which the host resides in the DNS domain
field. If the host resides in a workgroup instead of a domain, this field can be
left blank.
c. In the TCP/IP Address fields, select Obtain an IP address automatically
(DHCP) if host IP addresses are assigned automatically. If the IP address of the
host to be restored is static, enter the IP address in the IP address field. If
applicable, enter the subnet mask and the default gateway used by the host to
be restored in the Subnet mask and Default gateway fields.
d. In the DNS Server fields, select Obtain DNS server address automatically if
the DNS server name is automatically assigned. If the DNS server IP address is
static, enter the IP address of the DNS server in the Preferred DNS server
field. If applicable, enter an alternate DNS server address in the Alternate
DNS server field.
You can ignore the DNS Server fields, if you added the NetWorker server host
name and IP address to the X:\Windows\System32\Drivers\etc\hosts file
in step 3 earlier.
e. Click Next.
6. All local disks that have been detected are displayed in the Available Disks
screen. If the wizard has failed to detect a disk, click Load Driver to browse to a
location such as a CD or USB drive, and locate the correct driver for the disk.
After loading the required disk driver, click Refresh to update the list of disks
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that have been detected.
....

7. Click Next.
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8. In the Select NetWorker Server screen, select the NetWorker server to which the
host was backed up.

Figure 50

Select NetWorker Server

a. Double-click on the appropriate NetWorker server from the list or type the
fully qualified domain name (FQDN) in the Server field. You have to click
Search to update the list of NetWorker servers. The Search function will locate
only those NetWorker servers on the local subnet.
b. In the Client field, make sure the client name matches the client resource name
on the NetWorker server. For example, if the client resource on the NetWorker
server uses a FQDN, then use the client’s FQDN in the Client field.
This field is automatically populated with the values that were typed in the
Host name and DNS Domain fields on the Configure Client screen of the
wizard.
You can modify the Client field if you want to restore a backup that was
created by a different machine. However, the hardware configuration of the
target machine must be similar to the original machine. “Task 2: Prerequisites”
on page 618 provides more information. You must also satisfy the following
requirements for performing a directed recover:
– The NetWorker server must have a client resource for both the source
machine and the target machine.
– The Remote Access attribute of the client resource for the source machine
must allow access to the user / host machine that is performing the
directed recovery operation. Do this by adding "SYSTEM@target_client"
to the source client resource’s Remote Access attribute.
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– Add "user=system,host=target_client" to the Users attribute of the
NetWorker server’s preconfigured Administrators user group.
Note: If a different client (target) is specified, the restored machine will use the same
hostname and IP settings as the source machine. This can cause hostname and IP
address conflicts if the source machine is running on the same network.

c. Click Next.
9. Select the System backup that you wish to restore to the host in the Select System
Recovery screen. System backups are listed in descending order from most recent
to oldest. Click Next.

Figure 51

Select System Recovery Backup
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10. The Critical Volumes to Restore screen lists the volumes that will be restored to
the host.

Figure 52

Critical Volumes to Restore

During the restore process, critical volumes will be reformatted. Non-critical
volumes will be formatted only if the disk signature is different, for instance if the
disk was replaced.
To perform a “quick format“ instead of a full format operation, ensure that
Perform a quick format of disks is selected. This is the default selection.
Although quick formatting is much faster than full formatting, a quick format,
unlike a full format, does not verify each sector on the volume.
The restore process will not recover non-critical volume data even if the
non-critical volume is reformatted. Non-critical volumes can be recovered, if
necessary, by using the NetWorker User program after the wizard has completed
and the host has been rebooted.
11. Click Next.
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12. The System Recovery Summary screen lists the selected restore options.

Figure 53

System Recovery Summary

If you need to specify any non-default restore options, click Options to display
the Non-Default Recover Options screen.

Figure 54

Non-Default Recover Options
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a. Type any required non-default options with their corresponding values in the
Additional Options field. Non-default options are primarily used for
troubleshooting purposes. “Additional recover options” on page 638 provides
more information.
b. Click OK to save and close the Non-Default Recover Options screen and
return to the summary screen.
13. Click Restore to begin the restore process.
A confirmation screen will display. Confirm your choice to begin the restore
process and then click OK.

Figure 55

!

Confirmation screen

IMPORTANT
Be aware that all data will be lost on volumes that are being reformatted.
At the end of the disaster recovery process, log files are backed up to the
NetWorker server. These files can be used to troubleshoot a failed disaster
recovery. Ensure that the NetWorker server has a mounted writable back up
volume available for these log files. Otherwise, the disaster recovery will not
complete because it is waiting for a writable volume. If this occurs, you can cancel
the log file backup without affecting the disaster recover operation. By default,
disaster recovery log files are written to the default backup pool. If desired, you
can set up a special backup pool for log files. To do so, ensure that the backup
pool accepts manual save sets that are named Offline Restore Logs. “Recovering
and viewing Windows DR log files” on page 635 provides more information
about accessing log files.
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The following screen is displayed when the restore process has completed.

Figure 56

Offline System Recovery Results

14. Before selecting Reboot, consider the following:
If you are recovering an Active Directory domain controller, it will be recovered
in non-authoritative mode by default. If you need to recover the domain
controller in authoritative mode, do not select Reboot. Instead, select Exit to
return to the WinPE command prompt and boot into Directory Services Restore
Mode (DSRM). “Post-Restore operations for Active Directory” on page 632
provides more information.
Next steps
Be aware of the following considerations before moving to “Task 6: Post-Restore
operations” on page 630.
◆

After the disaster recovery has completed and the system is rebooted, check the
host’s disk and volume configuration. It is likely that all disks and volumes
appear as they did on the original system. However, it is possible, if disk
signatures do not match the original disks, that non-critical disks may be off-line
or not mounted. In this case, you may need to use Microsoft Disk Manager to
bring online or mount the disks. After the disks are online, a reboot operation
should result in disk drive letter re-assignments. However if it does not, assign
drive letters to non-critical disks as needed. Non-critical volumes that are
accessed by mount points may have similar issues.

◆

To completely restore the host, you may have to perform additional online
recovery steps using the regular NetWorker User program. “Task 6: Post-Restore
operations” on page 630 provides more information. Recovering files on
non-critical volumes is one example of a post-restore operation.
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◆

If a folder has been encrypted in Windows, for example by selecting Folder
Properties > Advanced > Encrypt contents to secure data, it will be recovered as
encrypted. However, the encryption attribute will not be set on the folder. You
can manually reset the encryption attribute after the disaster recovery operation.
This is a Microsoft limitation.

◆

Windows Disaster Recovery can backup critical volumes that are BitLocker
encrypted. However, the recovered volumes will not be encrypted. You can use
the BitLocker icon in the Control Panel to re-apply the volume encryption. This is
a Microsoft limitation.

Task 6: Post-Restore operations
This task explains how to recover data that was not recovered as part of the
Windows Disaster Recovery operation. The following topics are covered:
◆

“Post-Restore operations when using the NetWorker Module for Microsoft
Applications (NMM)” on page 630

◆

“Post-Restore operations when using an application backup tool other than
NMM” on page 630

◆

“File system and VSS system data” on page 630

◆

“Post-Restore operations for Active Directory” on page 632

◆

“Post-Restore operations for hosts with server roles that use SQL Server” on
page 633

◆

“Post-Restore operations for a Microsoft Hyper-V virtual machine” on page 633

Post-Restore operations when using the NetWorker Module for Microsoft Applications (NMM)
If the recovered host was protected with the NetWorker Module for Microsoft
Applications product (NMM), all post-restore operations must be performed by
using the NMM client interface. Do not complete any post-restore operations in this
chapter. Refer to the NMM documentation for post-restore operations.
Post-Restore operations when using an application backup tool other than NMM
If you have backed up a database application with an application backup tool other
than NMM, perform the following post-restore operations:
◆

Recover any required file system or VSS system data by completing the steps in
“File system and VSS system data” on page 630.

◆

Recover the application data using the application backup tool.
Examples of such tools include the NetWorker Module for SQL Server (NMSQL),
NetWorker Module for Exchange Server (NME), or any third-party application
backup tool. Refer to the documentation that comes with your application
backup tool.

File system and VSS system data
Perform an online recovery of user data or VSS system data if any of the following
conditions apply:
• User data on non-critical volumes needs to be recovered, for instance when
disk hardware was replaced due to a disaster prior to the Windows DR
operation.
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• VSS system data needs to be recovered. Although the VSS system data for the
following items is recovered in a Windows Disaster Recovery operation, you
can recover more recent VSS system state backups if they are available.
Additionally, you can restore the following items at any time by performing an
online recovery operation.
– Active Directory
– DFS-R
– Windows Server Failover Cluster
“Back up planning” on page 611 provides more information about backing up
VSS system data so that it is available for an online recovery. If VSS system
data has been backed up, you can restore the previously listed services at any
time with an online recovery operation.
To perform an online recovery:
1. Manually remount any non-critical volumes as needed.
2. Start the NetWorker User program by using the -s option to connect to the
NetWorker server to which the source client data is backed up:
winworkr -s servername

If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, allowing
you to choose the server.
3. Click Recover to open the Source Client dialog box.
4. Select the source client and click OK.
5. Select the destination client for the recovered data, and click OK.
6. In the Recover window, select the files to recover.
7. Click Start to begin the directed recovery.
• Chapter 13, “Recovering Data” provides more information about recovery
options.
• The NetWorker Disaster recovery Guide provides more information about an
Active Directory online recovery and Windows Server Failover Cluster online
recovery.
• Appendix C, “Backing Up and Restoring a Microsoft DFS” provides more
information about a DFS-R online recovery.
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Post-Restore operations for Active Directory
The offline restore of the DISASTER_RECOVERY:\ save set in the case of a domain
controller, is non-authoritative. If a non-authoritative restore is desired, then no
post-restore operations are required. However, if you need to perform an
authoritative restore, follow these steps.
To perform an authoritative restore:
1. From the last screen of the wizard, titled System Recovery Results, do not select
Reboot. Instead, select Exit to exit the wizard so that you can boot into Directory
Services Restore Mode (DSRM). Failure to boot into DSRM mode will result in a
non-authoritative restore. If this occurs, run the Windows Disaster Recovery
again and ensure that you boot into DSRM mode.
a. Exit the wizard to prevent an automatic reboot.
The WinPE command prompt appears.
b. From the command prompt, use the following bcdedit commands to add a
boot loader entry to force the system to boot into DSRM:
X:\> bcdedit /copy {default} /d “Directory Service Repair Mode”

Enter the command exactly as shown above.
A message similar to the following appears:
The entry was successfully copied to
{00000000-0000-0000-0000-000000000000}

The numbers in the previous message, are a Globally Unique Identifier
(GUID) that identifies a new entry. In this example, the GUID is a string of
zeros and is for illustration purposes only. The actual GUID that is generated
when you run the command will be unique.
c. Using the generated GUID, enter the following command to set the safeboot
option for the bootloader entry in the Boot Configuration Data (BCD) store.
X:\> bcdedit /set {GUID_value} safeboot dsrepair

Where {GUID_value} is the GUID displayed by the previous bcdedit
command.
d. Exit the command prompt to reboot the system.
Failure to boot into DSRM will result in a non-authoritative restore.
2. (Optional) If you have VSS system state save set backups and they are more
recent than the DISASTER_RECOVERY:\ save set, you can recover them in
DSRM using the NetWorker User program.
3. Run the Windows ntdsutil command-line utility.
The ntdsutil prompt appears. The ntdsutil utility is a command interface similar
to the NetWorker recover interface. For help in the ntdsutil utility, type ? at the
ntdsutil prompt.
4. At the ntdsutil prompt, type:
NTDSUTIL: activate instance ntds
NTDSUTIL: authoritative restore

5. To perform an authoritative restore of a subtree or individual object, type:
NTDSUTIL: restore subtree “distinguished_name”
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For example,
NTDSUTIL: restore subtree
“OU=engineering,DC=Seattle,DC=jupiter,DC=com”
NTDSUTIL: restore subtree
“CN=mars,CN=users,DC=Seattle,DC=jupiter,DC=com”

The Microsoft Windows Server Resource Kit documentation on AD provides
information.
6. Exit the ntdsutil utility by typing quit at each successive ntdsutil prompt until
the command-prompt appears.
7. Type the following command at the command prompt so that the host does not
boot into DSRM mode upon reboot.
C:\> bcdedit /deletevalue safeboot

8. Restart the domain controller in normal mode and then log in and verify that the
authoritative changes are replicated to the AD replication partners.
Post-Restore operations for hosts with server roles that use SQL Server
1. After performing a NetWorker Windows Disaster Recovery, perform a SQL
Server disaster recovery. Refer to the article located at the following Microsoft
URL for guidance on a SQL Server disaster recovery. However, be aware that this
article provides general guidelines only. There is no need to re-install the
operating system, as mentioned in the article, if you performed a NetWorker
Windows Disaster Recovery. The NetWorker Windows Disaster Recovery
re-installs the operating system automatically.
http://msdn.microsoft.com/en-us/library/ms189302.aspx

2. Restore the SQL system databases (master, model, msdb) with NMM, NMSQL, or
a third party application.
3. Restore the role databases with NMM, NMSQL, or a third party application.
4. Restart the services that require the restored role databases.
Post-Restore operations for a Microsoft Hyper-V virtual machine
A recovery of a Hyper-V parent partition by the Windows Disaster Recovery
operation does not recover the file, InitialStore.xml. Without this file, the Hyper-V
Machine Management Service (VMMS) will not start properly and a third-party
restore of the Hyper-V application may fail.
To recover the Hyper-V application, you must:
◆

Create a new InitialStore.xml file.

◆

Start the VMMS service.

◆

Restore the Hyper-V configuration, including the InitialStore.xml file and all
virtual machines.

◆

Restart the VMMS service.
Note: Do not connect the Hyper-V Manager to the restored machine's local Hyper-V server
before recovering the Hyper-V configuration.
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To create a new InitialStore.xml file:
1. On the recovered Hyper-V host, click Start > Run, type MMC in the Run dialog,
and press Enter.
A default Microsoft Management Console (MMC) shell appears.
2. Add the Authorization Manager so that it can be selected from the File menu:
a. From the File menu, select Add/Remove Snap-In.
b. Select Authorization Manager and then click Add.
3. Switch to Developer Mode by right-clicking Authorization Manager and then
selecting Options > Developer Mode.
4. Create the new InitialStore.xml file.
• From the Action menu, select New Authorization Store, and place the XML
file in the Hyper-V installation location. The standard installation path is:
c:\programdata\microsoft\windows\hyper-v

Ensure that the XML file is named initialstore.xml.
5. Create a new Application named exactly Hyper-V services by right-clicking the
InitialStore.xml file and specifying the Application Name of Hyper-V services.
6. Create a new role named Administrator:
a. Under Hyper-V services, add a role definition named Administrator.
b. Right-click Role Assignments and add Administrator.
7. Add the Administrators group to this role. Alternatively, you can add the Local
System Administrators or Domain Administrators group to this role.
• Right-click Administrator and select Assign Users And Groups and then
complete the steps to add the Administrators group.
8. Start the VMMS service.
You should now be able to recover the Hyper-V configuration, including the
backed up InitialStore.xml file and all virtual machines.
9. After the recovery of the Hyper-V application including the InitialStore.xml file
that was backed up, restart VMMS.
Note: If you started Hyper-V Manager and connected to the restored machine’s local Hyper-V
server before recovering the Hyper-V configuration, then the Hyper-V Manager may display a
message about an inability to access the local Hyper-V server. To resolve this issue, go to the
Hyper-V Manager and remove the local Hyper-V server and then reconnect to it.

Troubleshooting Windows Disaster Recovery
The following topics provide information to help troubleshoot Windows Disaster
Recovery operations.
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◆

“Recovering and viewing Windows DR log files” on page 635

◆

“Wizard cannot locate the NetWorker server or DNS server” on page 636

◆

“Network configuration values may not be retained after reboot” on page 637

◆

“SAN boot devices” on page 637

◆

“Virtual Machines using VMware drivers” on page 637
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Recovering and viewing Windows DR log files
To help troubleshoot unsuccessful disaster recoveries, the following log files are
generated and backed up during the Windows DR operation:
◆

Ossr_director.raw — Contains the recovery workflow of the
DISASTER_RECOVERY:\ metadata save set and the critical volume
(OSSR_volume_name) save sets. This log also contains any errors related to
recovering the metadata files or ASR writer errors.

◆

recover.log — Contains output from the NetWorker recover.exe program. This
information is generated during the recovery of each save set. This log also
contains messages about errors related to critical volume data recovery.

◆

WinPE_Wizard.log — Contains information about the work flow related to the
NetWorker System Recovery wizard user interface.

◆

winpe_nw_support.raw — Contains output from the winpe_nw_support.dll.
The output provides information about the communication between the
NetWorker System Recovery wizard and the NetWorker server.

If the Windows Disaster Recovery fails, you can recover the log files by using FTP
(File Transfer Protocol) on the recover host or by using a directed recovery. If the
Windows Disaster Recovery was successful, you can recover the log files directly to
the recovered host.
To view log files, you can use either a text editor or the nsr_render program,
depending on the log file format.
Accessing the log files
To access the log files by using FTP:
1. Access the WinPE command line on the recover host.
You may have to exit the Disaster Recovery Wizard to access the WinPE
command line. If you exit the wizard, do not reboot.
2. Disable the Windows firewall. For example:
X:\Program Files\Legato\nsr\wizard>wpeutil DisableFirewall

By default the Windows firewall is enabled on WinPE and this blocks the FTP port
from transferring files.
3. Move to the following directory that contains the log files:
X:\Program Files\legato\nsr\logs

4. Use the FTP utility to move the log files to another NetWorker host.
To access the log files by using a directed recover operation:
1. Start the NetWorker User program by using the -s option to connect to the
NetWorker server to which the source client data is backed up:
winworkr -s servername

If the -s option is not entered and there is only one server detected, that server
will be connected to automatically. If there are no servers detected, or if there is
more than one server available, the Change Server dialog box appears, allowing
you to choose the server.
2. Click Recover to open the Source Client dialog box.
3. Select the source client, which is the client that was being restored, and click OK.
4. Select the destination client for the recovered data, and click OK.
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5. From the Options menu, select Options and specify a folder location in which to
relocate the recovered log files and click OK.
6. In the Recover window, select the log files to recover.
The log files are typically located in the following directory:
X:\Program Files\legato\nsr\logs
Note: By default the Windows Disaster Recovery WinPE image is set to Pacific Standard
Time (PST). You may temporarily be unable to browse and recover the Offline Restore Logs
save set if your local time is earlier than PST time. For example, if your local time is PST
plus two hours, then the Offline Restore Log save set would not be available for recovery
by browsing until the two hours have elapsed.

7. Click Start to begin the directed recovery.
Chapter 13, “Recovering Data.” provides more information about the
permissions required for directed recoveries.
Viewing the log files
To view the log files:
◆

The following log files can be viewed with a text editor:
• recover.log
• WinPE_Wizard.log

◆

The following log files can be viewed with the nsr_render program:
• Ossr_director.raw
• winpe_nw_support.raw
For example, type the following command at a command prompt to display
Ossr_director.raw file:
nsr_render_log "C:\logs\Client-bv1\Ossr_director.raw"

To direct the Ossr_director.raw file to a text file that can be viewed in a text editor,
type the following:
nsr_render_log "C:\logs\Client-bv1\Ossr_director.raw" > mylog.txt

Wizard cannot locate the NetWorker server or DNS server
If the NetWorker System Recovery Wizard cannot locate the NetWorker server or the
DNS server (if one is being used), try the following:
◆

If you are using a local hosts file instead of a DNS server, verify that the host
name and IP address of the NetWorker server and Avamar Deduplication node
(if one is being used) was entered correctly.

◆

If you are using a DNS server, verify that the values entered in the Configure
Hostname and Networker screen, were entered correctly.

◆

Verify that the NetWorker server was correctly specified in the Select NetWorker
Server screen.

To verify host name and IP address values, use the ping utility that is included in the
WinPE environment:
1. Exit the Disaster Recovery Wizard but do not reboot the host.
You will be returned to the WinPE command line.
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2. Use the ping utility to locate and verify host names and IP addresses. For
example:
X:\Program Files\Legato\nsr\wizard>ping -a hostname

3. Restart the wizard. For example:
X:\Program Files\Legato\nsr\wizard> javaw -jar WinPEWizard.jar
Note: After the wizard has been restarted, you can switch between the wizard and the
WinPE command line without exiting the wizard.

Multiple NICs and errors locating the NetWorker server

An error message similar to the following may display when trying to recover
a host with multiple NICs:
Error retrieving the list of Networker servers

This is an indication that the NIC selected by the wizard is not the NIC that
was connected to the NetWorker server when the backup was made and may
not have connectivity to the server. This applies when searching for an
available server or specifying a specific server. To resolve the issue, select one
one of the other NICs.
Network configuration values may not be retained after reboot
In some cases, a host does not retain its network configuration data after a Windows
Disaster Recovery and after the host boots. If the recovered host is experiencing
network connectivity issues, confirm that network properties for the local
connections are correct. If necessary, manually update the network configuration data
on the host.
SAN boot devices
When a system is using a SAN boot device and a disaster recovery must be done, the
WinPE environment requires that all but one path to the boot device be temporarily
disabled. Once the operating system has been rebooted the remaining paths can be
re-enabled.
Virtual Machines using VMware drivers
Recovery of a VMware Windows guest using VMware specific drivers requires
special consideration. For example if a guest is built using the VMXNET, VMXNET3
NIC drivers or the VMware Paravirtual SCSI driver, the WinPE environment cannot
see the NIC or any hard disks. These drivers must be loaded in the disaster recovery
wizard.
The drivers are part of the VMware Tools installation and are located in the Program
Files\VMware\VMware Tools\Drivers folder on the virtual machine’s system drive.
Be aware that for the disaster recovery wizard, 32 bit versions of the drivers must be
used.
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Additional recover options
Additional, non-default, recovery options can be entered on the WinPE command
line or in the Additional Options field of the Windows Disaster Recovery wizard.

Figure 57

Additional recovery options in the wizard

Table 110 describes the additional recovery options that can be used with a Windows
Disaster Recovery Operation.
Table 110

Additional recovery options with

Task

Entry

Result

Show additional debug
information in the disaster
recovery logs

-D n
where n is a number from 1
to 9, with 9 providing the
most debug information and
1 providing the least.

More debug information will be included in the Windows Disaster Recovery log
files.

Show additional information
on the progress of the
Windows Disaster Recovery
operation.

-v

More information on the progress of the disaster recovery will display in the
wizard’s System Recovery Status window.

Format non-critical disks to
resolve disk mis-match errors.

-p

By default, the Windows DR recovery skips the formatting of non-critical disks.
By using the -p option, any existing partitions are deleted and all disks are
reformatted on the restored computer to match the layout of the system image.
However, by Microsoft specification, even if the -p option is selected, a
non-critical volume will not be reformatted if the disk signature has not changed
since the backup.
This option may be useful in situations where a system fails to restore because
of disk mis-match errors. In this case, the -p option may resolve those errors.

IMPORTANT
The disaster recovery process will not recover
non-critical volume data even if the volume is
reformatted. Non-critical volumes can be recovered by
using the NetWorker User program after the wizard has
completed and the host has been rebooted.
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Optimizing Disaster Recovery backups
This section provides options and examples that can help you to optimize your
Windows Disaster Recovery backups.

Critical volume management recommendations
The following practices will help to minimize the size of your disaster recovery
backups.
◆

Do not store non-critical data such as MPEG files on critical volumes.

◆

Consolidate critical volumes, for example, install services on the same disk.

◆

Do not mount critical volumes on a non-critical volume.

Save Operations attributes for Windows Disaster Recovery
Table 111 lists the save operation attributes that can be used with Windows DR
backups. These options are specified in the client resource’s Save Operations attribute
and are typically used to reduce the size and improve the speed of back up
operations.
Be aware that by using any of the attributes in Table 111, there is a potential that some
data may not be available for recovery. To avoid this situation, follow the important
recommendations in the table.
Table 111

Save operations attributes for Window disaster recovery

Task

Entry in Save Operations attribute

Result

Completely disable the
DISASTER_RECOVERY:\
save set.

VSS:DISASTER_RECOVERY=off

The DISASTER_RECOVERY:\ save set is not
included in the All save set. Instead, the All save set is
consistent with pre-7.6 SP2 NetWorker. This means
that the save set All will consist of the following save
sets:
• VSS SYSTEM BOOT
• VSS SYSTEM FILESET
• VSS SYSTEM SERVICES
• VSS USER DATA
• All local physical drives

Default:
No value, which means that the All save set will include
the DISASTER_RECOVERY:\ save set.

IMPORTANT
If this option is used, it is recommended that you create a second client resource
for the host and set up a scheduled back up of the DISASTER_RECOVERY:\
save set for the second client resource. This will ensure that you can perform a
Windows DR for the host. “Putting disaster recovery backups on a different
schedule” on page 640 provides an example.
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Table 111

Save operations attributes for Window disaster recovery (continued)

Task

Entry in Save Operations attribute

Result

Limit the backup of dynamic
volumes when only some
dynamic volumes are critical
volumes.

VSS:SAVE_NONCRITICAL_DYNAMIC_DISKS=off

Do not save non-critical dynamic disks when they are
in a critical dynamic disk pack.

Default:
No value, which means that non-critical disks that are
in a critical dynamic disk pack will be saved with the
DISASTER_RECOVERY:\ save set.

IMPORTANT
If this option is used, ensure that the non-critical dynamic disks are backed up.
Otherwise, data loss could occur because all dynamic disks will be reformatted
during a Windows DR operation. You can back up the non-critical dynamic
disks by specifying the save set All in the client resource’s Save Set attribute.
Disable the backup of
non-critical volumes that have
mount points for critical
volumes.

VSS:SAVE_NONCRITICAL_MNTPARENT_DISKS=off If at least one critical volume is mounted on a
non-critical volume, do not back up the non-critical
volume with the DISASTER_RECOVERY:\ save set.
Default:
No value, which means that a non-critical parent
volume that has a critical volume mounted to it will be
saved with the DISASTER_RECOVERY:\ save set.

IMPORTANT
If this option is used, ensure that all non-critical volumes are backed up.
Otherwise, user data may not be available for an online recovery. You can back
up all non-critical volumes by specifying the save set All in the client resource’s
Save Set attribute.

Putting disaster recovery backups on a different schedule
This section includes some examples of how one can optimize backup schedules to
reduce the size and frequency of backups.
Example 48 Taking disaster recovery backups less frequently than regular backups

You may find that taking a disaster recovery backup every two weeks is adequate.
However, you want to take Full backups of your data, including VSS system state
data, more frequently.
To set up different schedules for your disaster recovery backups and your regular
backups, do the following:
1. Set up two NetWorker client resources for the host you are backing up.
2. In the first client resource, set the following attributes:
• Save Operations — VSS:DISASTER_RECOVERY=off
• Save Set — All
• Schedule — select a schedule that performs a Full level backup weekly.
• Group — ensure that the two client resources are not part of the same group.
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The following data will undergo a Full back up every week:
– VSS SYSTEM BOOT
– VSS SYSTEM FILESET
– VSS SYSTEM SERVICES
– VSS USER DATA
– All local physical drives
3. In the second client resource, set the following attributes:
• Save Operations — no value
• Save Set — DISASTER_RECOVERY:\
• Schedule — select a schedule that performs a Full level backup once every two
weeks.
• Group — ensure that the two client resources are not part of the same group.
The DISASTER_RECOVERY:\ save set will be backed up every two weeks.
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This chapter covers these topics:
◆
◆
◆

Overview of VSS.......................................................................................................... 644
VSS and the backup process ...................................................................................... 644
Controlling VSS from NetWorker software............................................................. 646
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Overview of VSS
If the NetWorker Module for Microsoft Applications is installed on the client
computer, information in this chapter may be superseded by information in the
NetWorker Module for Microsoft Applications documentation. The EMC NetWorker
Module for Microsoft Applications Administration Guide provides more information
about the NetWorker Module for Microsoft Applications.
Volume Shadow Copy Service (VSS) is a Microsoft technology that acts as a
coordinator among all the components that create, archive, modify, back up, and
restore data, including:
◆

The operating system

◆

Storage hardware

◆

Applications

◆

Utility or backup programs, such as NetWorker software

VSS allows for the creation of a point-in-time snapshot, or temporary copy, of a
volume. Instead of backing up data directly from the physical file system, data is
backed up from the snapshot. In addition, VSS allows for a single, point-in-time
capture of the system state.
In NetWorker software releases 7.2 and later, if a VSS client license is present,
NetWorker software uses VSS technology to create snapshot backups of volumes and
exact copies of files, including all open files. Microsoft Vista or Microsoft Server 2008
do not require a VSS client license. Databases and files that are open due to operator
or system activity are backed up during a volume shadow copy. In this way, files that
have changed during the backup process are copied correctly.
Shadow copy (snapshot) backups ensure that:
◆

Applications can continue to write data to the volume during a backup.

◆

Open files are no longer omitted during a backup.

◆

Backups can be performed at any time, without locking out users.

Note: VSS backups do not use snapshot policies, which are required to perform backups with
the NetWorker PowerSnap Module software. The EMC PowerSnap Module documentation
provides more information.

VSS and the backup process
In VSS terms, NetWorker software is a requestor — an application that needs data
from other applications or services. When a requestor needs data from an application
or service, this process occurs:
1. The requestor asks for this information from VSS.
2. VSS reviews the request for validity.
3. If the request is valid and the specified application has the requested data, the
request goes to the application-specific writer, which prepares the requested data.
Each application and service that supports VSS has its own writer, which
understands how the application or service works:
1. After the writer signals that it has prepared the data, VSS directs the writer to
freeze I/O to the selected volumes, queuing it for later processing.
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2. VSS then calls a provider to capture the requested data.
3. The provider, which is either software-based or associated with particular
hardware (for example, a disk array), captures the prepared data, creating a
snapshot (or shadow copy) that exists side-by-side with the live volume.
Note: Be aware that hardware providers are not supported by the NetWorker client at this
time. See “Provider support” on page 646 for more information.

The process of creating a snapshot involves interaction with the operating system.
The amount of time it takes to create a snapshot depends on a number of factors,
including the writer activity taking place at the time. Once the snapshot is created, the
provider signals VSS, which tells the writer to resume activity. I/O is released to the
selected volumes and any queued writes that arrived during the provider's work are
processed.
Figure 58 on page 645 provides a graphical representation of the VSS backup process.

Requestor

4. Requestor
asks VSS
to create
shadow
copies.

Writer

1. NetWorker software (the requestor)
asks VSS to enumerate writers and
gather their metadata.
2. Writers provide an XML description
of backup components and define
the restore method.

Writer

Writer

Writer

5. VSS tells the writers to
freeze activity.

Volume
Shadow copy Service

6. VSS tells the providers to
create the shadow copy of
the current state on disk

3. VSS asks which providers can
support a shadow copy for each
of the required volumes.

Provider
(Windows copy-on-write)

Disk 1
Figure 58

Disk 2

Writer

7. VSS tells the writers
to resume activity.

Provider
(EMC CLARiiON hardware)

Disk 3

Provider
(Compaq)

Disk 4

Disk 5

VSS backup process

NetWorker software backs up data from the point-in-time snapshot that is created
during this process. Any subsequent data access is performed on the snapshot, not
the physical file system. The requestor has no direct contact with the provider—the
process of taking a snapshot is seamlessly handled by VSS. Once the backup is
complete, VSS deletes the snapshot.
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Provider support
The NetWorker client does not currently support hardware providers for backup
operations. Only software providers are currently supported. If you are using a
hardware provider, perform one of the following workarounds as appropriate:
◆

Uninstall the hardware providers.

◆

Migrate any data that is backed up by the NetWorker client to a disk LUN
(Logical Unit Number), such as C:\, that is not controlled by a hardware
provider. In this way, the NetWorker client will backup all data using the
software provider.

Be aware that if the NetWorker Module for Microsoft Applications is installed on the
client host, then the previously mentioned workarounds may not be required. Refer
to the NetWorker Module for Microsoft Applications documentation for details.

The importance of writers
Writers play an important role in properly backing up data. They provide metadata
information about what data to back up, and specific methods for properly handling
components and applications during backup and restore. They also identify the type
of application or service that is being backed up, for example System Boot or System
Services. Writers do not play a role in backing up the file system.
Writers are currently only available for active services or applications. If a service or
application is present on a system but is not active, information from its writer will
not be available. Consequently, a writer can appear or disappear from backup to
backup.
In addition, NetWorker software maintains a list of supported writers in the NSRLA
database of the client machine. When backing up data, the software confirms that a
VSS client license exists, and then it checks to ensure that these conditions exist:
◆

The writer associated with the application is present on the system and active.

◆

The writer appears on the list of supported writers in the NSRLA database.

◆

A user has not disabled the writer.

If these conditions are all true for a particular writer, NetWorker software defaults to
backing up data by using VSS technology. If any of the conditions are false for a
particular writer, the data served by that writer is excluded from the backup
operation.
List of supported writers
During a VSS backup operation, NetWorker software validates each writer against a
list of supported writers. As part of a software release, or between releases, there may
be updates to the list of supported writers. The EMC NetWorker Software Compatibility
Guide provides a list of the currently supported writers.

Controlling VSS from NetWorker software
By default, NetWorker software release 7.2 and later uses VSS technology to back up
a client that is also running release 7.2 or later, and is licensed to use VSS. For VSS
SYSTEM save sets, this means NetWorker software uses VSS for most save sets and
writers. Appendix A, “SYSTEM and VSS SYSTEM Save Sets” provides details). For
the file system, this means the software attempts to take a snapshot of each drive, but
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if it fails, then it saves the file system by using the legacy method (that is, no snapshot
is taken). During a given backup for an individual client, either the VSS method or
the legacy method is used, but not both.
There may be times when you need finer control over how NetWorker software uses
VSS. For example, if you need to disable a writer or completely disable VSS. You can
control VSS from the Administration window, the NetWorker User program, or the
command prompt.
Note: With Windows Vista and Windows Server 2008, VSS is the only available backup
method and cannot be disabled.

These sections provide more information:
◆

“Controlling VSS from the Administration window” on page 647 provides details
on how to control VSS from the Administration window.

◆

“Controlling VSS from the NetWorker client” on page 648 provides details on
how to control VSS from the NetWorker User program.

◆

“Control VSS from the command-prompt” on page 649 provides details on how
to control VSS from the command prompt.

◆

“Globally disabling VSS” on page 649 provides details on how to disable VSS
globally.

Note: The documentation that accompanied the VSS client license describes how to control VSS
when backing up a client that is running NetWorker software release 7.2 or later, where the
NetWorker server is running a prior release of NetWorker software.

Controlling VSS from the Administration window
To control VSS from the Administration window:
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click the client for which you want to control VSS, then select Properties.
The Properties dialog box appears, with the General tab displayed.
4. Click the Apps & Modules tab.
5. In the Save Operations attribute, type the appropriate command according to
Table 112 on page 650, then click OK.
• Separate multiple commands with a semicolon (;).
• If the Save Operations attribute is left blank, NetWorker software backs up
data by using VSS if a VSS client license is present.
Notes:
1. The Save Operations attribute does not support NetWorker Module save sets. If a
NetWorker Module save set name is entered in the window, the backup fails.
2. If you enter a VSS command in the Save Operations attribute of the
Administration window, the command runs when the client backup is started as
part of a save set. If you enter a VSS command in the Local Save Operations
dialog box on the client, the command runs only if the backup is started by using
the NetWorker User program on the client.
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3. When typing a writer name in the Save Operations attribute, the name must
match the name that the writer uses to identify itself. If the name does not match,
the command is ignored.
• To confirm the name, open the NetWorker User program and browse the
corresponding save set.
• Remember that the list of writers appearing under each save set is
dynamically determined at runtime.
• A writer might not appear under its corresponding save set under the
following conditions:
– NetWorker software does not support the writer.
– The writer’s associated application, service, or database is not currently
running on the system.
– The writer has already been disabled by using the NetWorker User
program.
4. Use the Save Operations attribute only for clients running NetWorker software
release 7.2 or later. If anything is entered in this attribute for a client that is
running an earlier NetWorker software release, the backup will fail.

Controlling VSS from the NetWorker client
The Local Save Operations dialog box is read-only once the Backup window is
opened. To modify local save operations after opening the Backup window, exit and
restart the NetWorker User program.
To modify Local Save Operations, run only one instance of the NetWorker User
program at a time.
To control VSS from the NetWorker client:
1. Start the NetWorker User program.
2. From the Options menu, select Save Operations.
3. In the Local Save Operations dialog box, type the appropriate command
according to Table 112 on page 650, then click OK. Separate multiple commands
with a semicolon (;).
If the Local Save Operations dialog box is left empty, NetWorker software backs
up data by using VSS if a VSS client license is present:
• Local Save Operations does not support NetWorker Module save sets. If a
NetWorker Module save set name is entered in the window, the backup fails.
• If you enter a VSS command in the Save Operations attribute of the
Administration window, the command runs when the client backup is started
as part of a save set. If you enter a VSS command in the Local Save Operations
dialog box on the client, the command runs only if the backup is started by
using the NetWorker User program on the client.
• When typing a writer name in the Local Save Operations dialog box, the
name must match the name the writer uses to identify itself. If the name does
not match, the command is ignored.
– To confirm the name, browse the corresponding save set in the Backup
window.
– Remember that the list of writers that appear under each save set is
dynamically determined at runtime.
• A writer might not appear under its corresponding save set if:
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– NetWorker software does not support the writer.
– The writer’s associated application, service, or database is not currently
running on the system.
– The writer has already been disabled using the NetWorker User program.

Control VSS from the command-prompt
VSS can be controlled from the command-prompt on a NetWorker client or the
Console server by using the -o option and the Save Operations commands in
Table 112 on page 650, but only while performing a save, savefs, or nsrarchive
operation.
For example, to completely disable VSS while backing up C:\myfile to the server
jupiter, type:
save -s jupiter -o "vss:*=off" "C:\myfile"
Although the server name is not required in the preceding command example,
include the name to ensure that the save command finds the correct server. Separate
multiple Save Operations commands with a semicolon (;).
The EMC NetWorker Command Reference Guide provides more information about the
save, savefs, and nsrarchive commands and command options.
Note: If you change the VSS setting on a client by using the Local Save Operations dialog box
or the command prompt, it does not affect that client’s VSS setting on the server. Likewise, if
you change a client’s VSS setting on the server, it does not affect the Local Save Operations
setting or the command-prompt VSS setting on the client.

Globally disabling VSS
Use the nsradmin program to disable VSS for all clients globally or only for clients
with a certain Windows operating system.
Note: With Windows Vista and Windows Server 2008 and later Windows releases, VSS is the
only available backup method and cannot be disabled.

To disable VSS:
1. Log in as root or as Windows Administrator on the NetWorker server.
To disable VSS for all NetWorker clients:
a. Create an input file for the nsradmin command. The input file will eliminate
interactive prompting as each client gets updated. For example, create a text
file named disable-vss.txt and type the following into the file:
show name; client OS type; Save operations
print type: NSR client
update Save operations: "VSS\:*=off"
print

To disable VSS only for clients on a particular Windows operating system such as
Windows NT:
a. Create an input text file, for example, create a file named disable-vss-nt.txt and
type the following into the file:
show name; client OS type; Save operations
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print type: NSR client; client OS type: "Windows NT Server on
Intel"
update Save operations: "VSS\:*=off"
print

2. Type either of the following at the command prompt:
nsradmin -i <path>\disable-vss.txt
nsradmin -i <path>\disable-vss-nt.txt

where <path> is the directory location of the input file.

VSS commands
Table 112 on page 650 lists the commands and syntax used to control VSS, along with
a description of what each command does. These commands may be entered in any
of these locations:

Table 112

◆

Save Operations attribute of a NetWorker client resource.

◆

Local Save Operations dialog box of the NetWorker User program on the
NetWorker client.

◆

Command prompt on the NetWorker client or the Console server.

VSS commands

Task *

Entry

Enable VSS.

This attribute should be left empty. Leaving the attribute empty will result in NetWorker
software automatically using VSS (if VSS is licensed).

Completely disable VSS.

VSS:*=off

The file system and the system components are
backed up by using the legacy method, which means
that the backup is performed without taking a snapshot.

Disable VSS for a particular
drive.

VSS:drive:\=off
For example:
VSS:c:\=off

The specified drive is backed up by using the legacy
method.

Disable an individual writer.

VSS:writer=off
where writer is the name of the
writer to disable.
For example:
VSS:WINS Writer=off

The application data served by writer is not saved,
unless a NetWorker Module exists for that application
and is installed and configured on the system.

VSS:root drive path=only
To indicate all drives, enter:
VSS:*:=only
For example:
VSS:C:\=only

All VSS SYSTEM save sets, writers, and file systems
are backed up by using VSS. However, if VSS fails,
instead of backing up the file system by using the
legacy method, the specified drive is not backed up at
all.

Instruct NetWorker software
to back up the file system by
using VSS only.

Result

Note: When a writer is disabled, NetWorker software
still processes the writer so its files are skipped during
the file system backup.

* For VSS commands related to Disaster Recovery for Windows 2008, 2008 R2, and Windows 7, see “Save Operations
attributes for Windows Disaster Recovery” on page 639.
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Handling MSDE, SQL Server, and Microsoft Exchange databases
This release of NetWorker software does not support VSS backups of Microsoft
Exchange Server databases or SQL Server databases, but does support VSS backups of
MSDE databases through the MSDE writer. The MSDE writer was designed to
handle backups of both MSDE databases and SQL Server databases. If you perform a
backup operation that includes the MSDE writer, and both MSDE and SQL Server
databases exist on the same system, NetWorker software excludes the SQL Server
databases from the backup operation and backs up only the MSDE databases. If only
SQL Server databases exist under the MSDE writer, NetWorker software excludes the
entire writer from the backup operation.
If you used a previous release of NetWorker software to perform a VSS backup of
Exchange Server databases or SQL Server databases, you can use this release to
recover them. Since they were previously backed up by using VSS, they will be
recovered by using VSS.
Note: Tthe NetWorker Module for Microsoft Applications provides full support for backing up
Microsoft database applications. The EMC NetWorker Module for Microsoft Applications
Administration Guide provides more information.

Authoritative restores of the Active Directory Application Mode (ADAM) writers
Authoritative restores of the ADAM writer must be performed from the command
line. Restores from the NetWorker User GUI are nonauthoritative.
To perform an authoritative restore of the ADAM writer, use the -U option for the
recover command. To recover the ADAM writer, type the following command:
recover -s server -U -N "VSS USER DATA:\ADAM (Address Book) Writer"
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Recovering with BMR................................................................................................. 656

Support for HomeBase

653

Support for HomeBase

Introduction to HomeBase Support (NetWorker Enhanced Server Recovery)
This section provides information on NetWorker Enhanced Server Recovery, which
adds an EMC HomeBase server into the NetWorker environment.

Windows Disaster Recovery versus NetWorker Enhanced Server Recovery
NetWorker Windows Disaster Recovery is built into the NetWorker client and
supports bare metal recovery to the same or similar hardware for Windows Server
2008, Windows Server 2008 R2 and Windows 7.
NetWorker Enhanced Server Recovery with EMC HomeBase (purchased separately)
is an enterprise recovery solution designed to:
◆

Recover multiple servers in parallel.

◆

Support challenging Recovery Time Objectives (RTOs).

◆

Provide levels of automation and customization required for the enterprise
environment.

◆

Provide recoveries to the same or different hardware, from physical to virtual,
and from virtual to physical recoveries.

Supported operating systems include Windows Server 2008 R2, Windows Server
2008, Windows Server 2003 and Red Hat Linux.

NetWorker BMR HomeBase Server
A NetWorker BMR server is an EMC HomeBase Server that manages and restores
operating system and server state data, collected as profiles. The HomeBase Server is
the collection point for profiles produced by HomeBase Agents. HomeBase Agents
are installed on each protected NetWorker client.
The profile data includes:
◆

hardware configurations

◆

operating system levels

◆

system tuning

◆

network connections

◆

security

◆

storage layouts

The HomeBase Agent captures this information on a scheduled basis with a
NetWorker save set, and sends the profile results to a HomeBase Server for
management and analysis.

Installation considerations
The HomeBase Server installation is separate from the NetWorker server installation.
The HomeBase Server must be configured and available when:
◆

The NetWorker BMR client resource is created.

◆

The BMR backup data (profiles) are generated from NetWorker clients.

The EMC HomeBase product documentation provides details about HomeBase
Server installation, profile management, and recovery specifics.
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The NetWorker Installation Guide provides information on how to install and enable
the BMR agent.

NetWorker Enhanced Server Recovery backups
NetWorker clients can be configured to take advantage of EMC HomeBase BMR
technology to ensure that a client can be restored or migrated from one hardware
type to another. When a backup is run on a client, a HomeBase profile is
automatically generated and saved to a specified HomeBase Server. This process is
enabled with a HomeBase Agent license.

Requirements for Windows Enhanced Server Recovery
To provide Enhanced Server Recovery support for NetWorker clients on the
following platforms, the Homebase 6.4.1 or later agent is required. Additionally, the
protected host must be running NetWorker 7.6 Service Pack 1 Cumulative Update 1
(7.6.1.1) or later.
◆

Windows Server 2008 R2

◆

Windows Server 2008 SP2

◆

Windows Server 2003 SP1 or later

◆

Windows Server 2003 R2 SP1 or later

Information about upgrading to and configuring the Homebase 6.4.1 or later agent is
available in the HomeBase Agent Installation and Configuration Guide. Information on
BMR recovery is available in the HomeBase Agent Recovery and Migration Guide.

Configuring a client for BMR support
To configure a NetWorker client for Enhanced Server Recovery support, perform the
following tasks:
Task 1: Enable Homebase server support
Connection with a HomeBase Server is enabled during the set up of the NetWorker
server. This connection enables the delivery of profile data from the NetWorker client
to the HomeBase Server.
To enable Homebase server support:
1. From the Administration window, click Configuration.
2. Select the NetWorker server name.
3. From the File menu, select Properties.
4. In the Properties dialog box, click the Configuration tab.
5. Type the IP address or hostname for the HomeBase Server in the BMR server
field.
6. Click OK.
Note: A HomeBase Agent license batch code is required to enable the client to generate profiles
and send them to the HomeBase Server. Contact your EMC HomeBase representative for
licensing information.

NetWorker Enhanced Server Recovery backups
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Task 2: Configure a client for Homebase backup
After enabling communication with a HomeBase Server, configure a NetWorker
client as follows (or start by editing an existing client).
To configure a Homebase BMR backup for a client:
1. From the Administration window, click Configuration.
2. Click Clients.
3. Right-click the client to be enabled, then select Properties. The Properties dialog
box appears.
4. Click the Globals (2 of 2) tab.
5. Click the BMR check box.
6. Type the following in the BMR options field:
-L license_batch_code

Additional options can be specified in this field that define how the profile is
generated. The EMC HomeBase product documentation for HomeBase Agent
command line options provides more information.
Note: If there is a change to the HomeBase Server or license batch, the new license must be
updated.

7. By default, NetWorker 7.6 Service Pack 2 or later clients do not include VSS
SYSTEM save sets in a backup when the All save set keyword is specified in the
client’s Save set attribute. VSS SYSTEM save sets are required for a BMR backup.
To ensure that VSS SYSTEM save sets are included when the All keyword is
specified, perform the following steps.
a. Click the Apps & Modules tab.
b. Type the following entry in the Save operations attribute:
VSS:DISASTER_RECOVERY=off

“VSS SYSTEM save sets” on page 712 provides more information about the
components of VSS savesets.
8. Click OK.
The HomeBase profile, used during a Homebase BMR recovery, is generated when
the client’s scheduled save set is run. The profile is then stored in the HomeBase
Server.

Recovering with BMR
This section provides an outline of the steps required to perform a Homebase BMR
recovery or server migration. The EMC HomeBase product documentation provides
complete details and instructions about the HomeBase Server and HomeBase Agents.
A Homebase BMR recovery is performed from the HomeBase Server and Console in
the following order:
1. On the new machine, deploy an operating system that matches the operating
system of the profiled client that is being restored.
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Windows and Linux operating systems can be deployed from the HomeBase
Server web pages. UNIX operating systems are deployed manually with package
matching and validation performed through the HomeBase Server web pages.
2. Install a NetWorker client on the machine that will serve as the recovery server.
The machine on which the client data is recovered does not need to match the
hardware of the original client.
Note: The Console server and the HomeBase Server must be able to communicate with the
recovery server.

3. The HomeBase Server will communicate with the client through a HomeBase
Agent license batch. Communication can be established from the client command
line using the hba licensing announce command.The EMC HomeBase Agent
Installation and Configuration Guide provides details, or enter hba -h for command
usage.
4. From the HomeBase Server web pages, restore the base profile onto the new
machine. The EMC HomeBase Agent Recovery and Migration Guide provides
platform specific information.
Note: The base profile will configure the new client to match the IP and network
configuration of the client that was profiled. To avoid IP conflicts on the network, make
sure that the original client is not available.

5. Reboot the client.
6. From the client, recover the client data. “Choosing a recovery method” on
page 316 provides more information.
If recovering a Windows client, also recover the Windows system state. To
recover the Windows system state, recover the VSS SYSTEM save sets in the
following order:
• VSS SYSTEM SERVICES
• VSS SYSTEM FILESET
• VSS USER DATA
• VSS OTHER
• VSS SYSTEM BOOT
7. Ensure that the Options> Exclusion Options> Exclusion File List> Perform
special handling for Bare Metal Recovery checkbox is selected. This
automatically excludes files that the HomeBase Server has recovered with the
base profile restore.
Note: The exclude.NETWORKER file is located in the HomeBase Agent exclude
subdirectory and can be edited to exclude additional data. However, this should be done
with extreme care.

8. From the HomeBase Server web pages or the client command line, restore the
extended profile. The EMC HomeBase Agent Installation and Configuration Guide for
details provides more information, or enter hba -h for command usage.
The extended profile must exist on the client. It can be downloaded from the
HomeBase Server web pages or restored through the data recovery in step 6 .
9. Reboot the recovered client.

Recovering with BMR
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Excluding files for Homebase BMR recovery
A HomeBase profile restore is one of the first steps in a BMR recovery. A NetWorker
client data restore may restore files that were previously restored by HomeBase. An
exclusion file is provided to ensure that there is no overlap between a HomeBase
profile restore and the NetWorker client data restore. The EMC HomeBase Recovery
Guides provide complete information about excluding files from recovery.
Before performing a data restore in a BMR recovery, enable the use of the default
exclude file.
To enable the exclude file:
1. In the NetWorker User program, select Exclusion Options from the Options
menu.
2. In the Exclusion File List dialog box, select the Perform special handling for
Bare Metal Recovery check box.
3. To add a custom exclude file, enter the full path in the field provided and click
Add.
IMPORTANT
Custom exclude lists should be used with caution and tested before recovery to
a production system is performed.
4. Click OK.
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This chapter covers these topics:
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆
◆

Before contacting technical support .........................................................................
Viewing log files ..........................................................................................................
NetWorker functionality issues.................................................................................
Devices and autochangers .........................................................................................
NetWorker locale and code set support...................................................................
Resource database notes.............................................................................................
Network and server communication errors ............................................................
UNIX communication issues .....................................................................................
Microsoft Windows communication issues.............................................................
NetWorker archiving and retrieval...........................................................................
Storage nodes...............................................................................................................
Console error messages and corrective actions ......................................................
Console log files...........................................................................................................
Console troubleshooting notes and tips...................................................................
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Consult the NetWorker Error Message Guide for common error messages and possible
resolutions.
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Before contacting technical support
If the solutions in this chapter do not solve the problem, go to the EMC Powerlink
website for technical assistance. Provide this information:
◆

The software version of the NetWorker component.

◆

The operating system version.
For example:
• For Solaris, at the command prompt type the uname -a command.
• For AIX, at the command prompt type the oslevel command.

◆

The hardware configuration.

◆

Information about devices and other SCSI IDs.
To determine this information, use the following commands:
• For AIX, IRIX, Linux, and Solaris, enter the /usr/sbin/inquire command.
• For HP-UX, enter the /etc/ioscan command.

◆

If you are using an autochanger, the type of connection (SCSI or RS-232). Also,
provide the version of the autochanger driver you are using:
• For Solaris, enter the pkginfo -x command:
# pkginfo LGTOdrvr

• For AIX, enter the lslpp -l | grep EMC command.
◆

Be able to supply this information:
• How to reproduce the problem.
• The exact error messages.
• Number of times you have seen the problem.
• Whether the NetWorker command was successful before you made any
changes and, if so, the changes you made.

Determining the version of NetWorker software running on a client
To determine the version of the NetWorker software running on a client, use either
the NetWorker client interface or the nsradmin command.
Determining the software version by using the client interface
To determine the software version by using the client interface:
1. Open the NetWorker client program:
• On Windows, open the NetWorker User program.
• On UNIX, open the nwrecover program.
Chapter 1, “Overview” provides more information about opening these
programs.
2. From the Help menu, select About NetWorker User. The NetWorker version
number appears in the About dialog box.
3. Click OK to close the dialog box.
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Determining the client software version by using nsradmin
To determine the client version by using nsradmin:
1. At the command prompt, type:
nsradmin -p nsrexecd

2. At the nsradmin command prompt, type:
nsradmin> show NetWorker version
nsradmin> print type: NSRLA

The version of NetWorker software running on each client is displayed.

Displaying diagnostic mode attributes
NetWorker resources such as clients and devices contain diagnostic attributes that are
hidden by default.
To display diagnostic attributes:
1. Open the Administration window.
2. From the View menu, select Diagnostic Mode.
3. Right-click any resource and select Properties to see diagnostic attributes.

Viewing log files
For NetWorker release 7.4 and later, the log files viewed by using the nsr_render_log
(UNIX/Linux) or nsr_render_log.exe (Microsoft Windows) program include:
◆

Daemon log file (daemon.raw)

◆

gstd log file (gstd.raw)

◆

NetWorker User log file (networkr.raw; Microsoft Windows only)

The nsr_render_log program renders internationalized NetWorker log files into the
current locale of the user who is executing the program. All other log files, as well as
messages displayed in the NetWorker Console, use the locale of the service that is
generating the log message.
The nsr_render_log program is non-interactive. You must specify the log file at the
command line when the nsr_render_log program is executed. The output of the
command is printed to stdout, and can be redirected to a file to save the output. A
number of command line options are available with the nsr_render_log program as
well.

Rendering log files in the current locale at runtime
You can also instruct the NetWorker software to render log files into the current locale
at runtime, in addition to creating locale-independent log files. This allows you to
view log files by using a text viewer.
To instruct the NetWorker software to render logs in the current locale of the machine
hosting the file, set the runtime rendered log file in the NSRLA database to the full
path of the location for the rendered log file. This must be a valid path.

Viewing log files
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For backward compatibility with previous releases of NetWorker software, runtime
rendered log files do not display all of the fields that are displayed using the
nsr_render_log program. The runtime rendered log files will contain the message ID
followed by the date and time the message was logged, and then the rendered
message.
How to render log files in the current locale at runtime
To instruct the NetWorker software to render log files into the current locale at
runtime:
1. Log in as root or as Windows administrator on the NetWorker client.
Note: You must have security administrator privileges to view security audit logs.

2. Type this at the command prompt:
nsradmin -p nsrexec

The nsradmin prompt appears.
3. To display a list of all available log file resources:
a. Type the following at the nsradmin prompt:
. type: NSR log

b. Next, type the following:
print

A list of all available log file resources will be displayed.
4. Select the appropriate log file resource for editing by typing the following at the
nsradmin prompt:
. type: NSR log; name: log_file_name

For example, to select the daemon.raw file, type the following:
. type: NSR log; name: daemon.raw

5. Set the path for the Runtime rendered log attribute by typing the following at the
nsradmin prompt:
update runtime rendered log: log_file_location

For example, to set the location of the rendered daemon file to the NetWorker log
file direction on Microsoft Windows, type the following:
update runtime rendered log: "C:\\Program
Files\\Legato\\nsr\\logs\\daemon.log"

How to view log files with the nsr_render_log program
To view log files with the nsr_render_log program, execute the following at the
command line:
nsr_render_log log_file_name

If there are spaces in the log file path name, the path and filename should be enclosed
in double quotes. For example:
nsr_render_log "C:\Program Files\Legato\nsr\logs\daemon.raw"
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Note: The nsr_render_log program is located in the bin directory of the NetWorker
installation. If the bin directory is not in your search path, you must include the
location of the program when executing it from the command line.

The EMC NetWorker Command Reference Guide or the UNIX man page provide a
complete usage information for the nsr_render_log program.
How to redirect nsr_render_log output to a file
To redirect nsr_render_log output to a file, use the > character:
nsr_render_log "C:\Program Files\Legato\nsr\logs\daemon.raw" >
mylog.txt

You can also save the log file by using a special separator character for export to
another program, such as a spreadsheet. To do this, use the -x exportspec option,
where exportspec is a c followed by the separator character.
For example, to create a comma-separated list:
nsr_render_log -x c, "C:\Program Files\Legato\nsr\logs\daemon.raw" >
mylog.csv

Viewing log files from remote host machines
The nsr_render_log program allows you to view log files from remote NetWorker
hosts, by using the -R hostname option:
nsr_render_log -R hostname log_file_name

When the -R option is used, the log file will be rendered in the locale of the user
executing the nsr_render_log program, regardless of the locale that is running on the
remote host.

Log files from previous releases of NetWorker
For log files generated by clients that are running releases prior to release 7.4, or for
preexisting log files that were created before upgrading to from a release prior to
release 7.4, do not use the nsr_render_log program to view the log files. These log
files, which will use the previous naming convention of *.log, should be viewed by
using a standard text editor such as notepad.exe or vi.

Filtering log file information displayed by nsr_render_log
A number of command line options are available for the nsr_render_log program to
narrow the information output by the program. For example, to view only log file
messages referencing a specific device, use the -D devicename option.
The EMC NetWorker Command Reference Guide or the nsr_render_log man page
provide a complete list of available options.

Viewing log files
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Viewing only the most recently logged messages
To view only the most recently logged messages in the log file, use the -B
beginning_line option. If beginning_line is specified using a negative number, this will
instruct the nsr_render_log program to display only the specified number of lines
from the end of the file.
For example, to display only the last 100 lines from the log file, run the following
command:
nsr_render_log -B -100 "C:\Program Files\Legato\nsr\logs\daemon.raw" >
mylog.txt

Locating savegroup job logs
If the Savegroup log by job id attribute on the NetWorker server resource is selected,
you can use the jobsquery command to locate logs for child jobs of a savegroup
operation. This command takes a query, or query file, and searches the jobs database
on the NetWorker server.
Example 49 Using the jobsquery program

This example shows how you could use the jobsquery program to locate the child
jobs of a savegroup job:
1. Open the jobsquery program and use the show option to specify which job
attributes to display.
# jobquery
show type; command; completion status; start time; end time; job id;
parent job id; job log file

2. Use the print option to specify that only savegroup jobs will be displayed.
print type: savegroup job

The output shows that a savegroup with a job ID of 128000 completed
successfully:
type: savegroup job;
command: ;
completion status: succeeded;
end time: 1228409390;
job id: 128008;
job log file: ;
parent job id: 0;
start time: 1228409364;

3. Use the print option to display all jobs whose parent job ID is 128008.
print parent job id: 128008
type: savefs job;
command: \
savefs -s daphne.lego.com -c daphne.lego.com -g Default -p -l full \
-R -v -F /usr/share/man/man1 /usr/share/man/man3;
completion status: succeeded;
end time: 1228409365;
job id: 128009;
job log file: /nsr/logs/sg/Default/128009;
parent job id: 128008;
start time: 1228409365;
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type: index save job;
command: \
"save -s daphne.lego.com -S -g Default -LL -f - -m daphne.lego.com \
-V -l full -LL -W 78 -N
index:c177b9a2-00000004-4936d6d0-4936d6cf-0001c000-69\
7aa04f /nsr/index/daphne.lego.com";
completion status: succeeded;
end time: 1228409388;
job id: 128012;
job log file: /nsr/logs/sg/Default/128012;
parent job id: 128008;
start time: 1228409388;

Notice that the job log file attribute in the previous display shows the location of
the job logs for two child job IDs: 128009 and 128012.
The EMC NetWorker Command Reference Guide or the UNIX man pages provide
more information about the jobsquery command.

NetWorker functionality issues
This section describes workarounds for NetWorker issues.

Backup and recovery
This section covers backup and recovery operations.
Checking the NetWorker services
If you have trouble starting NetWorker programs, the services might not be running
properly. On Windows systems, determine if these processes are running.
If they are not, start them:
◆

On Windows systems, go to Control Panel > Administrative Tools > Services.

◆

On UNIX systems, enter one of these commands:
ps -ef | grep nsr
ps -ax | grep nsr

You should receive a response similar to this:
12217
12221
12230
12231
12232
12234
12410

?
?
?
?
?
?
pts/8

S
S
S
S
S
S
S

0:09
2:23
0:00
0:01
0:00
0:00
0:00

/usr/sbin/nsr/nsrexecd -s jupiter
/usr/sbin/nsr/nsrd
/usr/sbin/nsr/nsrmmdbd
/usr/sbin/nsr/nsrindexd
/usr/sbin/nsr/nsrmmd -n 1
/usr/sbin/nsr/nsrmmd -n 2
grep nsr

If daemons are not present, start the NetWorker daemons.
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Client wizard issues
Improper font size for the Client Wizard with Netscape on Solaris
When using the Netscape browser on Solaris, the font size of the Client Wizard may
be too small.
To change the font type and size:
1. Open the /usr/bin/nwwiz script in a text editor.
2. Edit the following line to change the font size:
NSR_WIZARD_FONT_SIZE=size

3. Save and close the nwwiz file.

Backups fail to start when daylight savings time change occurs
If backups are scheduled to occur during the hour in which the operating system
moves the clock ahead or behind by one hour, the backup operation will be skipped.
For example, suppose that the operating system is configured to move the clock
forward one hour at precisely 2:00 A.M and backups are scheduled to occur at
2:01 A.M. At 2:00 A.M., the clock is moved forward to 3:00 A.M. All times from 2:01 to
2:59 are skipped and scheduled is not initiated.
To avoid this situation, set the backup time to occur at least one minute before the
time change occurs.
Note: Using the mminfo query to get a weekly save set usage summary during the change to
daylight savings time does not display any information for the day of the change.

Clone ID timestamp does not reflect the time the cone was created
To guarantee that cloned save sets created on different storage nodes do not have the
same timestamp, the NetWorker software assigns a timestamp to cloned save sets
that does not reflect the actual time that the clone was created.

Backups fail to stop
Attempting to stop the backup process by clicking Stop in the Group Control window
should stop the process for all clients in the selected group. However, sometimes a
client is missed and messages appear indicating that the server is still busy.
To resolve the problem:
1. From the Administration window, click Monitoring.
2. Select the Groups tab and determine which group is currently being backed up
by looking at the messages that display.
If the group status shows that the save processes are running, but the associated
savegrp process is not running, perform one of these:
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◆

Stop the conflicting group from running by clicking Stop in the Group Control
window. “Stopping a group” on page 396 provides more information.

◆

Shut down and restart the NetWorker services. “Stopping and starting a
NetWorker server, client, or storage node” on page 51 provides more
information.
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Memory usage when browsing large save sets
Browsing or recovering from a large save set, such as a save set with one million or
more files, may consume all of the host’s memory. The workaround is to perform a
save set recovery instead. “Recovering by save set selection” on page 325 provides
information on save set recovery.
The recover command enables you to directly browse the client file index and select
the files and directories that you want to recover. Use this option to browse large save
sets or when memory is limited on the host systems.

Memory usage and nsrjobd
The nsrjobd daemon runs on the NetWorker server and is responsible for monitoring
NetWorker activity during a backup or recovery operation. Depending on the size of
your backup environment, nsrjobd can require large amounts of RAM.

Media position errors encountered when auto media verify is enabled
To verify media, nsrmmd must reposition the volume to read previously written
data. It does not always succeed on the first attempt. These warning messages appear
in the message window of the NetWorker Administration window:
media warning: /dev/rmt2.1 moving: fsr 15: I/O error
media emergency: could not position jupiter.007 to file 44, record 16

If the server can find the correct position, media verification succeeds and a
successful completion message appears:
media info: verification of volume "jupiter.007" volid 30052
succeeded.

If media verification fails:
◆

Reset the device.

◆

Verify the configuration of the device.

◆

Verify that the media can be recognized.

◆

Verify that the device is functioning properly.

PACKET RECEIVE BUFFER and NO ECB counters increase
When the server is waiting for a tape to be mounted or is in the process of changing
an autochanger volume, the PACKET RECEIVE BUFFER and NO ECB counters
increase on a NetWare client.
To resolve this problem, shut down and restart the NetWorker server.
For servers that run on HP-UX, edit the /sbin/init.d/networker file. Add this line
before the line that starts nsrd:
NSR_NO_PING=ok; export NSR_NO_PING
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The scanner program marks a volume read-only
When you use the scanner program to rebuild the index of a backup volume, the
scanner program marks the volume as read-only.
This is a safety feature that prevents the last save set on the backup volume from
being overwritten.
To write to the media without marking it read-only, use the nsrmm -o command:
nsrmm -o notreadonly volume_name

The scanner program requests an entry for record size
If you use the scanner program with the -s option but without an -i or -m option, this
message may appear:
Please enter record size for this volume ('q' to quit)

If this message appears, enter the block size. The block size must be an integer equal
to or greater than 32.

Limitations for groups containing a bootstrap
Backups for a group that generates a bootstrap file can be written to a storage node
only when a tape from the default pool is already labeled and mounted on a local
drive attached to the NetWorker server.

Index recovery to a different location fails
If you attempt to recover indexes to a directory other than the one where they were
originally located, this error message appears:
WARNING: The on-line index for client_name was NOT fully recovered.
There may have been a media error. You can retry the recover, or
attempt to recover another version of the index.

Recover indexes to their original location before moving them to another directory. To
move the indexes, log in as root and invoke this command from within the
/nsr/index directory:
uasm -s -i "client_index_directory_name" | (cd target_directory; uasm
-r)

On Solaris and Linux platforms, uasm is installed in /usr/lib/nsr. On all other
platforms, uasm is installed in the same location as the NetWorker binaries.

Illegal characters in configurations
When naming label templates, directives, groups, policies, and schedules, these
characters are not allowed:
/ \ * [ ] ( ) $ ! ^ ’ " ? ; ‘ ~ < > & | { }
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Error backing up large number of clients
Backing up a large number of clients may cause this CMD.exe application error
message to appear on the NetWorker server:
The application failed to initialize properly (0xc0000142). Click on
OK to terminate the application.

If this problem occurs, increase the desktop heap allocation by editing the following
Windows registry key on the NetWorker server:
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\
Session Manager\SubSystems\Windows

In the following example, the desktop heap allocation has been changed from a value
of 512 KB to 1023 KB.
Previous version, with a desktop heap allocation of 512 KB:
%SystemRoot%\system32\csrss.exe ObjectDirectory=\Windows
SharedSection=1024,3072,512 Windows=On SubSystemType=Windows
ServerDll=basesrv,1 ServerDll=winsrv:UserServerDllInitialization,3
ServerDll=winsrv:ConServerDllInitialization,2 ProfileControl=Off
MaxRequestThreads=16

Updated version, with a desktop heap allocation of 1024 KB:
%SystemRoot%\system32\csrss.exe ObjectDirectory=\Windows
SharedSection=1024,3072,1024 Windows=On SubSystemType=Windows
ServerDll=basesrv,1 ServerDll=winsrv:UserServerDllInitialization,3
ServerDll=winsrv:ConServerDllInitialization,2 ProfileControl=Off
MaxRequestThreads=16

The Microsoft Knowledge Base article 18480 on the Microsoft website provides more
information.

Hostname aliases
Savegroups fail when aliases are improperly defined. Under certain conditions, such
as improperly configured DNS servers or hosts files, the NetWorker software does
not create any aliases for a new client. If you use TCP/IP, every client should have
both its hostname and its fully qualified domain name listed in its NetWorker aliases
field.
If you encounter any of these situations, a client alias problem might be the cause:
◆

This error message appears:
No Client resource for client_name

◆

A client machine always performs full backups, regardless of the level of the
scheduled backup.

◆

Automatic index management, as set up in the browse and retention policies,
does not work.

◆

In the /nsr/index directory, which contains the indexes, there are two directories
for the same client that use two different client names.

A client alias change is needed in the following situations:
◆

Machines have two or more network interfaces.

◆

Sites mix short and fully qualified hostnames for the same machines, for example,
mars and mars.jupiter.com.
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◆

Sites use both (Network Information Services (NIS) and DNS.

Add all network names for the host to the Aliases attribute in the Client resource.
Note: Do not include aliases that are shared by other hosts in the Aliases attribute.

Directory pathname restrictions
A file manager (but not Windows Explorer) restriction causes errors when a
pathname contains too many characters.
To avoid these errors, use pathnames with fewer than 128 characters.

Failed recover operation directly after new installation
If you attempt to start the nwrecover program immediately after installing
NetWorker software for the first time, this error message appears:
nwrecover: Program not found.

To avoid the problem, perform a NetWorker backup on the client.

Recovering files from an interrupted backup
If you terminate a backup by stopping the NetWorker services, you cannot recover
the files because the media database is not updated when the services stop.
Consequently, the NetWorker server does not know on which volumes the requested
files reside.

Backup of a new client defaults to level full
The first time you back up a new client, this message appears:
client: save point: There are no save sets in the media database;
performing a full backup

This message indicates that the specified save set has not been previously backed up.
Before you can perform an incremental or level backup on a save set, perform a full
backup of the save set.
If the save set was previously backed up, the reasons this message appears include:
◆

The clocks on the client and server are not synchronized.

◆

The savegrp session begins before midnight and ends after midnight.

Non-full backup of Solaris files with modified extended attributes
When the extended attributes for a Solaris file are changed, but the file is not
otherwise modified, the change time (ctime) for the file is not updated. As a result,
the NetWorker software does not know that the extended attributes for the file have
changed since the last incremental backup, and any non-full scheduled backup of the
file system will not back up the file.
To ensure the file is backed up, use the touch command or otherwise modify the file
so that the ctime is updated. Alternatively, perform a manual backup of the file.
“Manual backups” on page 64 provides more information.
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Renamed clients cannot recover old backups
The NetWorker server maintains a client file index for every client it backs up. If you
change the name of the client, the index for that client is not associated with the
client’s new name and you cannot recover files backed up under the old client name.
To recover data that was backed up by using the old client name, perform a directed
recovery by directing data saved under the old client name to the new client.
“Directing recoveries to another client” on page 329 provides information about
performing directed recoveries.

Client file index errors
These issues are related to client file indexes:
◆

“Missing client file indexes” on page 671

◆

“Check failure of client file indexes” on page 671

◆

“No notification of client file index size growth” on page 671

Missing client file indexes
The scanner program must have a client file index to rebuild from before it can
proceed. If you attempt to recover a client file index with the scanner -i command
without first using nsrck -L2 to create a new client file index, a message similar to the
following could appear:
scanner: File index error, file index is missing.
Please contact your system administrator to recover or recreate the
index.
(severity 5, number 8)
scanner: write failed, Broken pipe
scanner: ssid 25312: scan complete
scanner: ssid 25312: 91 KB, 13 file(s)
scanner: done with file disk default.001

Check failure of client file indexes
Each time the NetWorker server starts, it uses nsrck -ML1 to perform a level 1
consistency check on the client file indexes. In some circumstances, this consistency
check does not detect corruption in the client file indexes. If you believe an index
might be corrupt, run a higher level check on the index, for example:
nsrck -L5

If the index is still corrupt, recover the index using the procedure outlined in
“Recovering a client file index from a specific time and date” on page 337.
No notification of client file index size growth
The NetWorker server does not notify you when a client file index is getting too large.
Monitor the system regularly to check the size of client file indexes. “Reducing client
file index size” on page 459 provides information on how to manage the NetWorker
client file indexes.
The EMC NetWorker Command Reference Guide or the UNIX man pages provide more
information on the nsrls, nsrck, and nsrim commands.
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Cannot use the Console interface to stop the savegrp command
If you start the savegrp command at the command prompt, and then attempt to stop
the backup from the Console window, this message appears:
Only automatically started groups that are currently running can be
stopped

Manually stop the savegrp process.

Aborting a recovery
When you stop a recovery in progress on a client, the following could occur:
◆

The recovery might stop immediately.

◆

The files that still need to recovered are listed.

◆

Messages similar to this might appear:
Recover: ***Canceled***
Recover: Unable to read checksum from save stream
Recover: error recovering C:\WINDOWS\CURSORS\APPSTART.ANI
Didn't recover requested file C:\WINDOWS\CURSORS\APPSTART.ANI

The messages indicate that a recovery was not stopped cleanly.

RPC error
If NetWorker has trouble backing up a directory path, a message similar to this
appears, which notes the path:
* jupiter:E:\ save: xdr of win32 attributes failed for ’E:\PROGRAMS\’

The rest of the save set completes successfully.
To solve this problem, perform another backup of the directory.

Error message when relocating data
If you attempt to relocate data to a directory that does not exist, this error message
appears:
Cannot create directory directory

Ignore this message. The recovery creates the new directory and completes
successfully.

Desktop heap size limitation
Microsoft Windows XP has a set desktop heap size limitation that might produce the
following error message when exceeded:
The application failed to initialize properly

The Microsoft Knowledge Base article 142676 on the Microsoft website provides
information about this problem and how to correct it.
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Other failures can also cause the desktop heap size to be exceeded. If this occurs, it is
usually the result of numerous NetWorker processes that are running simultaneously.
To determine the number of NetWorker processes that are running on the server, use
the Windows Task Manager.
These conditions can cause the NetWorker server to exceed the desktop heap size
limit:
◆

Large number of system services are running as Local System.

◆

More than 30 backup devices exist on the NetWorker server.

◆

NetWorker parallelism is set above 30.

◆

Performing more than 15 simultaneous recoveries.

If any of these failures occur, or if the “Application failed to initialize properly”
message appears, increase the desktop heap size for system services. To do this,
modify the third parameter to SharedSection as outlined in Microsoft Knowledge
Base article 142676 on the Microsoft website. Increasing the size by 3072 usually
corrects the problem. For example:
%SystemRoot%\system32\csrss.exe ObjectDirectory=\Windows
SharedSection=1024,3072,3072 Windows=On SubSystemType=Windows
ServerDll=basesrv,1 ServerDll=winsrv:UserServerDllInitialization,3
ServerDll=winsrv:ConServerDllInitialization,2 ProfileControl=Off
MaxRequestThreads=16

The All save set and duplicate drive serial numbers
The All save set, which backs up all locally mounted drives as well as the SYSTEM
and VSS SYSTEM save sets, uses the serial numbers assigned to drives as part of its
logic to determine if a drive should be backed up. It is possible for local drives to use
the same serial number. In this case, the All save set results in only one of the drives
being backed up.
If you encounter this problem, there are two possible solutions:
◆

Use the DiskProbe utility to set the serial numbers to unique numbers. The
DiskProbe utility is part of the Windows Support Tools and is available for all
versions of Windows supported by NetWorker software.

◆

Avoid using the All save set. Instead, specify each drive letter and SYSTEM or
VSS SYSTEM save set separately. “Scheduling predefined save sets for backup”
on page 61 provides more information about the All save set.

Disk label errors
If a nonoptical device was configured as an optical device, this error message
appears:
No disk label

Verify that the Media Type attribute in the Device resource matches the expected
media for the device, and correct if necessary.
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Cannot print bootstrap information
If the server bootstraps do not print, enter the printer’s name when configuring the
Group resource:
1. In the Administration window, right-click the group and select Properties.
2. In the Printer attribute of the Setup tab, enter the name of the printer where the
bootstrap is to print.

Server index not forced
If the NetWorker server belongs to a group that is disabled or if it does not belong to
any group, the savegrp program does not back up the NetWorker server.
The information to recover server indexes is stored in the media database on the
NetWorker server.
Note: The savegrp no longer performs a server index backup for servers not in an active group.

Copy violation
If NetWorker software is installed on multiple servers and the same NetWorker
enabler code was used for them all, messages similar to this appear in the save group
completion email:
--- Unsuccessful Save Sets --* mars:/var save: error, copy violation - servers ‘jupiter’ and
‘pluto’ have the same software enabler code, ‘a1b2c3d4f5g6h7j8’
(13)
* mars:/var save: cannot start a backup for /var with NSR server
‘jupiter’
* mars:index save: cannot start a backup for /usr/nsr/index/mars with
NSR server ‘jupiter’
* mars:index save: cannot start a backup for bootstrap with NSR server
‘jupiter’
* mars:index save: bootstrap save of server’s index and volume
databases failed

To successfully rerun the backup:
1. Issue the nsr_shutdown command on each server.
2. Remove the NetWorker software from the extra servers.
3. Restart the NetWorker services on the server where the backups are to go.

Xview errors
If this error message appears when you attempt to start NetWorker client graphical
interfaces (for example, nwrecover), it means that the client is not authorized to
display NetWorker graphical interfaces:
Xlib: connection to "mars:0.0" refused by server
Xlib: Client is not authorized to connect to Server
Xview error: Cannot open display on window server: mars:0.0 (Server
package)
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To correct the situation, configure the client to display the graphical interfaces:
1. From the client machine, invoke the xhost command:
xhost server_name

2. Remotely log in to the NetWorker server and issue the setenv command:
setenv DISPLAY client_name:0.0

For command shells other than csh type:
DISPLAY=client_name:0.0
export DISPLAY

Converting sparse files to fully allocated files
The NetWorker server determines that files are sparse by comparing the allocated
blocks with the byte size. If the allocated blocks do not account for the size of the file,
the file is considered to be sparse and is saved such that long strings of zeroes are
replaced with “holes” in the recovered file.
When you use the HP Tru64 Advanced File System (AdvFS) clone filesets, AdvFS
reports the number of blocks allocated to the clone (which is zero, or the number of
blocks on the real file that have been modified since the clone creation). Thus, files in
a cloned fileset always look sparse to the NetWorker server.
Some files that were not sparse when saved might be recovered as sparse. Oracle
databases are susceptible to this problem because they are zero-filled, fully allocated
files and are not sparse.
To workaround this issue, use the cp command to copy the file after recovery:
cp recovered_filename zero_filled_filename

This converts a sparse file to a fully allocated file.
Note: To perform this workaround, have enough free disk space to accommodate a duplicate of
each sparse file that is copied.

Backing up large sparse files
To conserve backup media, sparse files are compressed before being written to tape.
During this time, the backup job may stop with this message:
savegrp: Aborting inactive job (633).

This can occur because no data is being written to the backup media while the sparse
file is processed. Increase the Inactivity Timeout attribute for the backup group.
To help determine an adequate timeout limit:
1. Set the Inactivity Timeout value to zero. A value of zero results in no timeout
limit.
2. Determine the time required to complete a full save of the file system.
3. Use this time as the inactivity timeout limit. “How to edit a group” on page 134
provides information about setting the inactivity timeout attribute for the group.
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The mminfo -N command is case-sensitive regarding save set names
When querying the media database by using the mminfo command, the -N name
option is case-sensitive. The save set name the -N option references must match the
case of the save set name entered in the Client resource.
However, when backing up drive partitions on Microsoft Windows (for example,
C:\), the NetWorker server stores the save set name in uppercase in the media
database.
For example, if the save set name that represents the drive partition was entered in
the Client resource in lowercase, you must query by using uppercase:
mminfo -N C:\

Renamed directories and incremental backups
If the name of a directory is changed after a full backup, but no files or subfolders in
the directory were changed, the renamed directory is not included in subsequent
incremental backups.
To avoid this issue, select the Backup renamed directories attribute on the Client
resource.
Resolvable names for multiple network interface cards
If any component of NetWorker (client, storage node, server) has multiple network
interface cards (NICs) with unique IPs and hostnames, all NICs must be configured
and must be resolvable names, even if one or more NICs are not being used. Failure
to have all NICs resolvable may cause problems with host connectivity to the
NetWorker server.
Follow these steps to configure NetWorker so that the appropriate hostname is used
for the associated IP, and to ensure the hosts file and routing table on the machine are
configured properly:

Example for configuring
multiple NICs

◆

Set up DNS so that a separate name is associated with each IP

◆

Configure the hosts file and routing table on each machine that has multiple
interfaces with the appropriate IP

◆

Configure NetWorker to use the names configured in steps 1 and 2.

In the following example, a dual-interface client connects to the NetWorker Server
and Storage Node over interface1 having IP 1.1.1.1 and has a dedicated connection to
the Storage Node over interface2 having IP 2.2.2.1. The user wants to send all data to
the Storage Node over interface2 instead of the default interface1.
1. Configure DNS with unique hostnames for IPs 1.1.1.1 and 2.2.2.1. For example,
client-1 maps to 1.1.1.1 and client-2 maps to 2.2.2.1. DNS should also be
configured with unique hostnames for the IPs on the Storage Node. For example,
node-1 maps to 1.1.1.2 and node-2 maps to 2.2.2.2.
2. Configure the routing table on the client to route the traffic through the correct
interface, and add the two IPs to the local hosts file.
3. In NetWorker, enter node-2 in the Storage Node Affinity List of the client.

Libraries entering ready state
When starting NetWorker or after configuring a library, it may take a short amount of
time for the library to enter the Ready state within NetWorker. This is normal
behavior.
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Improper font size for the Client Wizard with Netscape on Solaris
When using the Netscape browser on Solaris, the font size of the Client Wizard may
be too small.
To change the font type and size:
1. Open the /usr/bin/nwwiz script in a text editor.
2. Edit the following line to change the font size:
NSR_WIZARD_FONT_SIZE=size

3. Save and close the nwwiz file.
Successful save sets listed as failed in the Group Backup Details window
Certain backup operations, such as the direct SCSI feature and some NetWorker
modules, create multiple sessions during a single backup job. If one of these sessions
fails, the Console will report the entire backup job as having failed.
To determine the status of each session, click the Show Messages button in the Failed
table of the Savegroup Completion dialog. This information is also available in the
Logs tab, under monitoring, and in the savegroup completion report.
The NetWorker Server window does not appear on HP-UX
On HP-UX, the following error message appears if the RPC ping via UDP when
connecting to NetWorker check box is selected in the NetWorker Console Setup >
Systems Options dialog box is checked and the NetWorker server window does not
appear:
Unable to connect to server: Failed to contact using UDP ping

To resolve this issue:
1. In the NetWorker Console, select Setup.
2. Select Setup>System Options.
3. Unselect the RPC ping via UDP when connecting to NetWorker checkbox.

Devices and autochangers
This section explains how to resolve problems with devices and autochangers.
Note: Device files and directories should not be edited. Editing these files can cause
unpredictable behavior and make it impossible to recover data.

Additional attributes in the Autochanger resource
The Autochanger resource contains attributes that provide a detailed view of options
that the nsrjb program uses. These are hidden attributes. “Displaying diagnostic
mode attributes” on page 661 provides information about displaying hidden
attributes.
The EMC NetWorker Command Reference Guide or the UNIX man pages provide
information about these attributes.
Note: Do not change time related attributes unless advised to do so by a Technical Support
representative.
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Maintenance commands
NetWorker device driver software provides maintenance commands, such as
lusbinfo and lusdebug, for diagnosing problems on tape devices and autochangers.
The EMC NetWorker Command Reference Guide or the UNIX man pages provide
information about these commands .

Autodetected SCSI jukebox option causes server to stop responding
If an autodetected SCSI jukebox is installed using jbconfig, and the server stops
responding:
1. Select the jbconfig option that installs an SJI jukebox.
2. Enter the number that corresponds to the type of jukebox you are installing.
3. Proceed with jbconfig until this message appears:
Jukebox has been added successfully.

Autochanger inventory problems
These situations cause the autochanger inventory to become outdated:
◆

The media is manually ejected from the autochanger drive.

◆

The media is removed from the autochanger.

◆

The autochanger door is opened.

An outdated inventory means that the NetWorker software cannot use the
autochanger.
To make the autochanger usable again:
1. Verify that the media cartridge is correctly installed in the autochanger and that
the autochanger door is closed.
2. Log in as root or administrator on the NetWorker server.
3. Reset the autochanger by typing this command:
nsrjb -Hv

4. Perform an inventory by typing this command:
nsrjb -Iv

The NetWorker server can use the autochanger after the inventory operation
completes.
Chapter 3, “Configuring Libraries and Devices” provides complete information on
the use of the nsrjb command.

Destination component full messages
If a manual operation is performed on an autochanger, for example unloading the
tape drive by using the buttons on the autochanger rather than by using the
NetWorker server, this error message may appear:
Destination component full
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To resolve the problem, use the nsrjb -H command to reset the autochanger.

Tapes do not fill to capacity
Tapes may not always be filled to capacity. For example, a tape with an advertised
capacity of 4,000 MB can be marked full by the NetWorker server after only 3,000 MB
of data have been written to it.
To use the tape to its fullest capacity, select the highest density device driver for the
device. Reasons that the server appears to fill tapes prematurely include:
◆

Write errors occur during a backup.
• With any tape error, the NetWorker server marks the tape as full.
• To prevent tape write errors, clean the tape drive regularly and use only
data-quality tapes. If cleaning the drive does not help, ensure that:
– The device driver is properly configured.
– Any necessary switch settings on the tape drive are set to the
manufacturer’s specifications.
• All cables are secure.
• Other potential SCSI problems have been addressed.

◆

NetWorker filemarks consume space on the tape.
• The NetWorker server periodically writes filemarks to facilitate rapid recovery
of data. These filemarks consume varying amounts of tape depending on the
type of tape drive.
• The number of filemarks the server writes to tape depends on how many save
sets are on the tape. Many small save sets require more filemarks than a few
larger ones.

◆

Tape capacities vary.
Two apparently identical tapes from the same vendor can vary significantly in
capacity. This can cause problems if you copy one full tape to another, especially if
the destination tape holds less data than the source tape.

◆

Data compression affects the tape capacity.
• If you use compression on the tape drive, you cannot predict the effect on tape
capacity. A compressing drive can provide twice the capacity of a
noncompressing drive.
• The capacity could vary depending on the type of data being backed up. For
example, if a noncompressing drive writes 2 GB of data to a specific tape, the
compressing drive could write 10 GB, 2 GB, 5 GB, or some other unpredictable
amount of data.

◆

Length of tape. Verify tape lengths. A 120-meter DAT tape holds more data than a
90-meter DAT tape.

Tapes get stuck in drive when labelling on Linux Red Hat platform
When labeling a tape in a DDS configuration using a NetWorker server that is
running Linux Red Hat, the tape may become stuck in the drive and display the
following error message:
unload failure-retrying 30 seconds
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To prevent a tape from being stuck in the drive, set the auto_lock setting to “0” (Off)
in the /etc/stinit.def file for these drive types:
◆

Sony AIT-2 and AIT-3

◆

IBM LTO Gen1

◆

HP LTO Gen1

◆

IBM LTO GEN2

◆

IBM 3580 drive LTO-1

◆

IBM 3592 J1A

◆

Quantum DLT 7000

By default the auto_lock setting is set to 1 (On).

Increasing the value of Save Mount Time-out for label operations
A label operation may take more than 30 minutes before it fails under these
conditions:
◆

Automedia management is enabled and a backup is initiated, and

◆

The NetWorker software encounters a corrupted tape during label operations.

The NetWorker software keeps a record of the location of the corrupted tape only for
the current backup operation, so a corrupted tape could be used again for the next
backup operation if the operator does not remove it.
To increase the value of the Save Mount Time-out attribute to 60 minutes from the
default 30 minutes:
1. In the Administrator program, select Devices from the Media menu to open the
Devices window.
2. From the View menu, select Details to display the hidden attributes.
3. Set the Save Mount Time-out attribute to 60 minutes.

Server cannot access autochanger control port
The control port controls the autochanger loading mechanism. The autochanger
hardware installation manual contains information about how to verify whether the
control port is properly connected.
If you cannot determine whether the control port is working, contact the autochanger
vendor for assistance.
Modifying the control port
A change in the control port of the robotic arm of a library is characterized by the
inability to perform library operations, such as labeling, mounting and unmounting,
and inventorying. You may see the error "no such file or directory."
To update the NetWorker to use the new control port:
1. Run the inquire command to determine the SCSI device address of the library
arm and to confirm that a serial number is reported. If a serial number is not
reported go to step 5 .
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IMPORTANT
Use the inquire command with caution. Running inquire sends the SCSI inquiry
command to all devices detected on the SCSI bus. Using inquire during normal operations
may cause unforeseen errors and possible data loss may result.
2. If the serial number of the arm is reported, follow the procedure at “Scanning for libraries
and devices” on page 110 to scan the library for devices.
3. Click Monitoring, then click to Logs tab and locate the message:
media info: The control port of the disabled library 'library_name' has
been changed to 'scsidev@b.t.l' on storage node 'storage_node_name'!

4. Enable the library
a. In the Administration window, click Devices.
b. Expand the Libraries folder and right-click the library and select Enabled/Disable.
5. If the serial number was not reported in step 1 , or if scanning for devices does not detect
the control port change, use the nsradmin command to change the control port:
a. Log in as root or as Windows administrator on the NetWorker client.
b. Enter the nsradmin command at the command-prompt. The nsradmin prompt
appears.
c. Disable the library by typing the following at the nsradmin prompt:
– type: NSR jukebox
– update enabled: no
– When prompted to update the resource, type yes.
d. Update the control port by typing the following at the nsradmin prompt:
update control port: scsidev@b.t.l

where b.t.l is the bus.target.lun of the library’s robotic arm (as reported by the inquire
command).
When prompted to update the resource, enter yes.
e. Reenable the library:
– update enabled: yes
– When prompted to update the resource, enter yes.
f. To verify that the control port was changed and the library is now enabled, enter print
at the nsradmin prompt.

Nonrewinding device requirement
Use a nonrewinding device for NetWorker backups. The NetWorker server writes a filemark
on a volume at the end of each backup. When the next backup occurs, the server appends
data to the volume based on the position of the filemark. If the device automatically rewinds
the data, the filemark position is lost and the data is overwritten by the next backup.

Scanner command behaves differently with adv_file type device
The scanner command behaves differently when used with an advanced file type device.
When both primary and _AF_readonly adv_file type devices are unmounted, the following
command results in the _AF_readonly device being mounted:
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scanner -m -S ssid primary_device_name

This is expected behavior.

Sleep times required for TZ89 drive types
If you are unloading a TZ89 drive and receive the following error, your drives require
changes to the sleep attributes in the Autochanger resource.
nsrd: media info: unload retry for jukebox `COMPAQTL895' failed - will
retry again.

To change the sleep attributes:
1. Shut down NetWorker services.
2. Shut down and restart the autochanger with the TZ89 drives.
3. When the autochanger is back online, restart NetWorker services. This resets
NetWorker so that it stops trying to unload the drive.
4. Use these settings for the sleep time attributes:
• Eject Sleep: 18 secs
• Unload Sleep: 40 secs
• Load Sleep: 40 secs
“Additional attributes in the Autochanger resource” on page 677 provides
information about setting the sleep attributes.
5. Attempt to unload the drive again. If the drive fails to unload, repeat this
procedure and increase the sleep times.

Managing optical drives with Solaris 9
With Solaris 9, the Volume Management daemon (vold) is changed so that it
automatically attempts to manage all removable media devices. Because of this
change, the Volume Management daemon may interfere with NetWorker operations
related to optical drives.
To resolve this possible conflict, disable the vold daemon or modify the daemon
configuration file.
Disable the vold daemon

To disable the volume management (vold) daemon:
1. Log in as root on the NetWorker storage node, and remove or rename the
/etc/rc2.d/*volmgt script.
2. Enter the /etc/init.d/volmgt stop command.
Modify the daemon configuration file

To modify the daemon configuration file:
1. Log in as root on the NetWorker storage node, and open the daemon
configuration file, /etc/vold.conf, in a text editor.
2. Comment out this line in the Devices to Use section.
use rmscsi drive /dev/rdsk/c*s2 dev_rmscsi.so rmscsi%d

682

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Troubleshooting

After commenting out this line, the Devices to Use section of the configuration
file looks similar to this:
# Devices to use
# use rmscsi drive /dev/rdsk/c*s2 dev_rmscsi.so rmscsi%d

3. Save the configuration file.
4. Reinitialize the Volume Management daemon with the new configuration file
settings. One way to do this is to send a hang-up signal to the daemon, for
example:
ps -ef | grep vold
kill -HUP vold_pid

where vold_pid is the process ID of the volume management daemon, vold.

Message displayed when CDI enabled on NDMP or disk FTD
If the CDI feature is enabled while using an NDMP tape device or file type device
(FTD), a message similar to this appears in the NetWorker message log:
nsrd: media notice: The CDI attribute for device "/dev/rmt/3cbn" has
been changed to "Not used".

To avoid this message, do not enable the CDI attribute for these device types.

Verifying firmware for switches and routers
If switches or routers are used, make sure that any switch or router firmware on the
network was manufactured after August 1995 to ensure that RPC traffic is handled
properly. Most of the switch and router vendors have significantly improved their
handling of RPC traffic since August 1995.

Commands issued with nsrjb on a multi-NIC host fail
Commands may fail when issued to a NetWorker server or storage node that has
multiple network interface cards (NIC).
To prevent this failure, add the domain name of each additional NIC to the Aliases
attribute in the Client resource that is set up for the NetWorker server or storage
node. “Editing a client” on page 470 provides information about editing a Client
resource.

SCSI reserve/release with dynamic drive sharing
When the NetWorker software uses Dynamic Drive Sharing (DDS) there is a
possibility that the operating system's tape driver might use the SCSI reserve/release
feature in a manner that interferes with the proper operations of the NetWorker
software. This may require that reserve/release be disabled.
To disable the reserve/release feature for the various operating systems:
Solaris

SCSI reserve/release is configurable as a bit setting in the st.conf file for each device
type in use. The Tape Configuration section of the st man page provides more
information. Use the most up-to-date st driver that is available for the version of
Solaris.
Devices and autochangers
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Edit the st.conf file only if one of the following conditions apply:
◆

DDS is used with the NetWorker software.

◆

A tape drive is used that is not supported directly by a Solaris st tape driver.

To determine if the tape drive is supported directly by a Solaris st tape driver, load a
tape in the drive and enter the mt command. For example, with the tape device file
0cbn, type the following:
mt -f /dev/rmt/0cbn status

If the output of the mt command includes the line SCSI tape drive or appears similar
to the following, the st tape driver is using generic settings for that drive and it is not
natively supported:
mt -f /dev/rmt/4cbn status
Vendor 'IBM
' Product 'ULT3580-TD2
' tape drive:
sense key(0x6)= Unit Attention
residual= 0
retries= 0 file no= 0
block no= 0

If this configuration is used with the NetWorker software, the process might appear
to work, but there might be problems recovering any saved data.
If the output of the mt command appears similar to the following, the st tape driver
recognizes the drive and is using correct internal settings:
mt -f /dev/rmt/0cbn status
HP Ultrium LTO tape drive:
sense key(0x0)= No Additional Sense
residual= 0
retries= 0 file no= 0
block no= 0

The only reason to edit the st.conf file is if the drive is being used in a DDS
configuration.
AIX

To reset the reserve/release setting on an AIX operating system:
1. Through the SMIT interface, select Tapes from the Devices menu.
2. Change the value for the RESERVE/RELEASE support attribute from No to Yes.
HP-UX

To reset the reserve/release setting on an HP-UX 11 operating system:
1. Change the st_ats_enable kernel variable to a value other than zero.
2. (Optional) Restart the computer to ensure the change was implemented.
Note: The reserve/release is a fixed setting in HP-UX 10.
Tru64

SCSI reserve/release is only available on version 5.1B and later.

Device ordering issues
“Device ordering” on page 269 provides information about issues related to drive
ordering, including how to determine if drive reordering has happened, and
procedures to correct the problem.
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Recovery of save sets from a VTL
Loading a tape to recover save sets after moving the tape from one VTL of a
NetWorker server to a VTL of another NetWorker server
When it is required to load a tape to recover save sets after moving the tape from a
VTL of the source NetWorker server to a VTL of a different NetWorker server, the
following procedure provides information about how to load the tape prior to
running the scanner command to restore the backed-up save sets to another
NetWorker server, without requiring a NetWorker mount operation:
1. Ensure the destination VTL is the same model, has the same drive names and the
same number of drives as the original VTL.
2. Check the inventory of the VTL in the destination NetWorker node
3. Run the inquire command to get the Control port of the VTL in the destination
NetWorker node.
4. Run the sjimm command to load the tape to the corresponding drive of the
destination NetWorker server.
5. Run the following command to determine the tape status:
mt -f <device> status

After ensuring that the tape has been moved to another VTL, run the scanner
command to restore the backed up save sets.

NetWorker locale and code set support
NetWorker software does not support locales (defined by the operating system) or
code sets that remap characters having special meaning for file systems. Depending
on the file system, these special characters may include the slash (/), the backslash(\),
the colon (:), or the period(.). De_DE.646 is an example of one unsupported locale.
NetWorker software might not function normally if the locale is changed. The
previously existing indexes can become invalid.

Issues with fonts when using X servers on Linux
A number of issues exist in Linux X font support for non-english locales that may
cause problems when displaying the nwrecover program. These problems may be
resolved by switching to a different locale for the same language (for example, by
using ja_JP.eucjp instead of ja_JP.utf8).

Resource database notes
With NetWorker release 6.2 and later, resource information resides in this structure:
<NetWorker_install_path>\res\nsrdb\00
.
<NetWorker_install_path>\res\nsrdb\09

Each resource is stored in a separate numbered file. As new resources are created (for
example, Client, Group, or Pool resources), new files are added in these directories.
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Note: Because Client resources are generally small, the NetWorker client (nsrexecd) continues
to use the <NetWorker_install_path>\res\nsrla.res file.

Viewing resources
You can view all NetWorker resources through the Administration window.
Although you can view the contents of the new NetWorker resource files with a text
editor, direct user edits are not supported.
The only supported access to the resource database is through either of the following:
◆

nsradmin -s server

◆

nsradmin -d NetWorker_install_path\res\nsrdb

If you inadvertently specify the wrong path with the nsradmin -d command, empty
resource directories are created. If this occurs, delete the incorrect directories.

Repairing resource database corruption
Corruption of NetWorker resource database files can be caused by a power outage,
operating system crash, or manual editing of the database. If the NetWorker server is
unable to read the resource files upon startup, messages similar to these are written to
the daemon log file:
nsrd: WARNING: NSR configuration database detected invalid
resource ...\00019803aa14713c89456b41
nsrd: Invalid resource saved at ...\00019803aa14713c89456b41

“Viewing log files” on page 661 provides information about viewing log files.
The NetWorker server removes any invalid resource files from the nsrdb directory
structure and places them in the dbg directory. The dbg directory is created only if
resource database file corruption has occurred. If you encounter this problem, open
the corrupt file with a text editor to determine which resource is corrupted. You can
then re-create the resource using either the Console window or the nsradmin
command.
After you inspect a corrupt resource file, delete it.
Note: If you do not know the cause of the resource file corruption, go to the EMC Powerlink
website for technical assistance.

Network and server communication errors
This section provides general, UNIX and Windows network and communication
issues that you may encounter in a NetWorker environment.
To help ensure successful communication between NetWorker clients and servers,
each host configured in NetWorker must not have any invalid or inactive IP addresses
stored in the hostname resolution service used (DNS, NIS, Active Directory, hosts file,
and so on). Each address mapped to a host must have a configured network interface
(NIC).
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General issues
This section provides information that may be relevant for multiple platforms.
Unapproved server error
If an unapproved server attempts to contact a client to initiate a backup, this message
appears:
client_name: server_name cannot request command execution

1. After installation, if the client is to accept backup requests from other NetWorker
servers, add the NetWorker server names to the servers file.
2. Ensure the servers file on a client contains both the short name and the long name
of the server to use to back up that client’s data. For example, the servers file on a
NetWorker client should contain these names for a NetWorker server named mars
in the jupiter.com domain:
mars
mars.jupiter.com

3. In the Alias attribute of the Client resource, list both the short name and the long
name, plus any other applicable aliases for each client.
4. The preferred method of editing the servers file is to run the NetWorker Setup
program in maintenance mode and edit the Allowed Servers list. The NetWorker
Installation Guide provides details.
Unapproved server error during client setup
If you add a Windows client to a UNIX NetWorker server, and the UNIX server
hostname is not included in the Windows client’s servers file, you might receive this
error message:
client_name: saveset_name
execution
client_name: saveset_name
cannot request command
client_name: saveset_name

Host server_name cannot request command
10/13/00 11:48:26 nsrexec: Host server_name
execution
Permission denied

Ignore the message, and continue to add the client to the UNIX server. To eliminate
the message, add the UNIX server hostname to the servers file on the client after you
finish adding the client to the UNIX server.
Server copy violation
Add all server aliases that are related to any additional network interfaces to the alias
list of the NetWorker server.
If aliases are not recognized, the server may be disabled with this error:
nsrd: registration info event: server is disabled copy violation

Remote recover access rights
You can control client recover access through the Client resource. The Remote Access
attribute displays the users that have recover access to the client’s save sets. Add or
remove usernames depending on the level of security the files require.
Note: If you enter a hostname or host=hostname in the Remote Access attribute, any user on that
host is allowed to recover the client’s files. To enter a username without specifying the host,
enter user=name.
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These users have permission to recover any files on any client, regardless of the users
listed in the Remote Access attribute:
◆

Root

◆

Member of the Administrator group

◆

Members of a group with Change Security Settings rights

Other users can recover only files for which they have read permission, based on file
permissions at the time that the file was backed up. Files recovered by a user other
than root, operator, or the operator group are owned by that user.
Authentication fails due to duplicate hostnames
Authentication with the NetWorker server may fail if multiple NetWorker hosts share
the same short name. For example, suppose hosts from two domains,
accounting.company.com and marketing.company.com, are configured for backup on the
same NetWorker server. However, each domain has a host named jupiter. In this case,
authentication may fail when the second host named jupiter attempts to contact the
NetWorker server.
To enable the host to authenticate to the NetWorker server:
1. On the NetWorker host that cannot authenticate, stop the NetWorker client
service. “Stopping and starting a NetWorker server, client, or storage node” on
page 51 provides more information.
2. Delete the nsrladb database, which is located in
NetWorker_install_path\res\nsrladb.
NetWorker server takes a long time to restart
If the NetWorker media management database is very large, the NetWorker server
may take a long time to establish client connections when it is restarted. The reason is
that a consistency check of the media management database is triggered when the
server is restarted.
To reduce the size of the media management database, run the nsrim -C command.
Be aware that this command may take a long time to run and that the NetWorker
server will be unavailable during this time. Run the command when the NetWorker
server is not busy.
“Reducing media database size” on page 460 provides more information about
reducing the media management database.

Firewall issues
If network communications are not functioning correctly, it may be related to
incorrectly configured firewall rules on one or more of the hosts involved. Determine
if a firewall is enabled and make sure that it is correctly configured to allow
communications with NetWorker programs. Appendix B, “Firewall Support,” has
information about firewall configuration.
1. Type this command:
nwinstcreate -n long_host_name

where long_host_name is the fully qualified host name, for example,
jupiter.accounting.company.com. The EMC NetWorker Command Reference Guide or
the UNIX man page provide more information about nwinstcreate.
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2. Restart the NetWorker client service. “Stopping and starting a NetWorker server,
client, or storage node” on page 51 provides more information.
The host can now authenticate by using the long name.

UNIX communication issues
This section covers communication issues on UNIX networks.

Troubleshoot IP errors
If any of these error conditions occur, there may be an IP naming problem:
◆

RPC errors

◆

Unknown host messages

◆

Failure contacting the portmapper

◆

Connection failures or timeouts

◆

Program unexpectedly exiting

◆

Refused connections

◆

Remote command (the rcmd() function) to active client failures

◆

Name-to-address translation failures

◆

Program not registered messages

◆

NetWorker services failing to start

◆

NetWorker services failing to remain active

◆

Invalid path messages

To troubleshoot IP errors:
1. Document the steps you take and the results, especially error messages, in case
you need to contact EMC Technical Support. This enables you to email or fax the
steps and error message to EMC.
2. Set up a host table for each NetWorker client and NetWorker server. “Setting up a
host table” on page 689 provides details.
3. Disable other name servers to simplify testing. “Disabling the DNS server” on
page 690 provides details.
4. Use ping to establish basic connectivity. “Using ping to verify network
connections” on page 691 provides details.
5. Use rpcinfo to verify that sessions can be established and that portmapping is
correct. “Using rpcinfo to verify that sessions can be established” on page 691
provides details.
Setting up a host table
Troubleshoot IP problems by using only the host table. Troubleshooting by using only
the host table does not mean you cannot use a name service, for example, DNS, with
NetWorker software. Run tests by using only the host table to determine whether you
have the software installed correctly. After you know the software works with the
host table, enable the name server.
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To set up a host table:
1. On the NetWorker client, list the client and the NetWorker servers to which it
connects, for example:
127.0.0.1 localhost loopback
123.456.789.111 client client.domain.com
123.456.789.222 server server.domain.com

2. On the NetWorker server, list the NetWorker server and all of its clients, for
example:
127.0.0.1 localhost loopback
123.456.789.111 server server.domain.com
123.456.789.222 client client.domain.com

Ensure the first alias entered for the NetWorker server matches exactly the current
NetWorker server hostname.
3. Use the guidelines in “Using ping to verify network connections” on page 691 to
ensure the highest success rate for parsing a host table within any operating
system.
Recommendations for host table configuration:
◆

Do not use blank lines in the body of the host table.

◆

The end of the host table should always contain a blank line.

◆

The first un-remarked entry should always be the loopback line in the exact order
and format shown in step 1 and step 2 .

◆

The last character of each unremarked line should be a space, not a carriage
return.

On UNIX platforms, the host table resides in the /etc/hosts file.
Disabling the DNS server
To simplify the troubleshooting of hostname resolution problems, disable services
like DNS, DHCP, and Windows Internet Naming Service (WINS).
Disable DNS just for the initial setup of the NetWorker clients and the NetWorker
server to be tested. Only disable the ability of a client to obtain IP naming information
from a DNS server.
To disable the DNS server on most UNIX platforms, rename the file /etc/resolv.conf
and reboot. Alternatively, set up the IP name search order so that the host table is
searched before DNS.
Note: If the hostname cannot be resolved, the NetWorker server caches this information for five
minutes before attempting the resolution again. If the hostname is successfully resolved, the
information is cached for 30 minutes.

Setting the IP name search order
To set the IP name search order:
1. Edit the /etc/nsswitch.conf file and verify that the /etc/resolv.conf file exists.
2. Set the host file to be first in the search order, with DNS second and NIS last. For
example:
hosts: files [NOTFOUND=continue] DNS [NOTFOUND=continue] nis

For an AIX system, edit the /etc/netsvc.conf file and reboot.
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You can also set the NSORDER environment variable. The InfoExplorer program
provides instruction on specific versions of AIX.
Using ping to verify network connections
After you create the host table, test it using ping.
On the NetWorker client, ping:
◆

Client short name (hostname) from the client

◆

Client long name (hostname plus domain information) from the client

◆

Client IP address from the client

◆

Server short name from the client

◆

Server long name from the client

◆

Server IP address from the client

This example shows how to ping the client short name and client long name from a
NetWorker client called mars in the jupiter domain:
ping mars
ping mars.jupiter.com

On the NetWorker server, ping:
◆

Server short name from the server

◆

Server long name from the server

◆

Server IP address from the server

◆

Client short name from the server

◆

Client long name from the server

◆

Client IP address from the server

Using rpcinfo to verify that sessions can be established
If ping is successful and backup problems still exist, test with rpcinfo. Use rpcinfo to
test the operation of the portmapper. Use the same tests with rpcinfo as with ping.
To use rpcinfo, the host whose hostname you enter must have a portmapper running.
In most cases, EMC portmappers are compatible with third-party portmappers. If
you are using a product that provides its own portmapper, do not load the
third-party portmapper until you have verified that the NetWorker software works
with the rest of the environment.
On Solaris, the rpcbind service must be running. On AIX and HP-UX, the portmap
daemon must be running. The rpcinfo utility is part of the operating system.
The syntax for using rpcinfo to display ports using TCP is:
rpcinfo -p hostname

Substitute the long name and short name for the variable hostname.
View other rpcinfo options by typing rpcinfo at the command-prompt. The UNIX
man page provides more information. Repeat rpcinfo using all the locations and all
the iterations listed in this document for ping.
When rpcinfo runs successfully, the output is a list of port numbers and names. For
example:
rpcinfo for mars
program vers proto

port
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100000
100000
390103
390103
390109
390107
390107

2
2
2
2
2
4
5

tcp
udp
tcp
udp
udp
tcp
tcp

111
111
760
764
764
819
819

portmapper
portmapper

Binding to server errors
NetWorker architecture follows the client/server model, where servers provide
services to the client through the RPC. These services reside in daemon processes.
When the daemons start, they register with the registration service provided by the
portmapper.
If the NetWorker services are not running and a NetWorker service is requested, this
messages appear in the savegroup completion email:
Server not available
RPC error, no remote program registered

These messages indicate that the NetWorker services nsrd, nsrexecd, nsrindexd,
nsrmmd, and nsrmmdbd might not be running.
Table 113

NetWorker Startup commands

Operating system

Startup command

Solaris, Linux, IRIX

/etc/init.d/networker start

HP-UX, HP Tru64 UNIX

/sbin/init.d/networker start

AIX

/etc/rc.nsr

Saving remote file systems
This error messages might appear in the save group completion email when a backup
for a remote client fails:
Host hostname cannot request command execution
hostname: Permission denied

The first message means that the nsrexecd service on the client is not configured to
allow the server to back up its files. The second message means that the nsrexecd
service is not currently running on the client.
To resolve these problems, ensure that the nsrexecd service is running on the client
and that the server’s hostname is listed in the boot-time file. The boot-time file lists all
the servers, in order of precedence, that can contact a client for backups.
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Table 114 lists the location for the boot-time file. The nsrexecd man page provides
information about nsrexecd.
Table 114

Boot-time file locations

Operating system

Boot-time file

AIX

/etc/rc.nsr

HPUX

/sbin/init.d/networker

IRIX (SGI)

/etc/rc2.d/S95networker

SCO

/etc/rc2.d/S95networker

Solaris

/etc/init.d/networker

SunOS 4.1.x

/etc/rc.local

Ultrix

/etc/rc./local

Others

/etc/rc2.d/S95networker
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Microsoft Windows communication issues
This section covers communication issues on Windows networks.
Certified protocols
This release of NetWorker software has been tested and is certified to work on
Microsoft TCP/IP. Other protocols, such as Novell IPX/SPX, Microsoft IPX/SPX, and
Microsoft Proxy Client, are not certified to work with NetWorker software at this
time.
Resolving connection problems
This section addresses DNS and local host file related connection problems and
solutions.
During installation, this error message might appear after an apparently successful
client-server connection.
hostname is not a valid hostname.
This type of error message indicates possible problems with hostname resolution.
This section notes items to check when you encounter connection problems.
IP configuration
If you experience IP configuration problems:
◆

If you are using DNS, ensure the IP address of the Windows computer is correct.

◆

If you are not using DNS, ensure the host table is set up correctly.
• The host table is in the hosts file located in
%SystemRoot%\system32\drivers\etc
• Ensure that the hostname is set correctly.
• Check the host table on both the server and client computers. Check that all
hostnames, fully qualified domain names, and IP addresses are listed.
• Both server and client hostnames should be in the host table with the IP
address, short names, and long names:
Server A Host Table
127.0.0.1localhostloopback
xxx.xxx.xxx.xxxserver_aserver_a.domain.com
xxx.xxx.xxx.xxxclient_a client_a.domain.com
Client A Host Table
127.0.0.1localhostloopback
xxx.xxx.xxx.xxxclient_aclient_a.domain.com
xxx.xxx.xxx.xxxserver_a server_a.domain.com

• Ensure the first alias entered for the NetWorker server matches exactly the
current NetWorker server hostname.
To ensure that the computer returns the correct hostname:
1. In the Control Panel, access the dialog box for DNS configuration.
2. Enter the hostname in the Hostname text box.
3. Edit the domain name in the Domain Name text box. The hostname and the
domain name together make up the fully qualified domain name.
4. To ensure that TCP/IP is set up correctly, check the hostname and fully qualified
domain name by typing this at the command-prompt:
ipconfig /all
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ping hostname

Domain Name Server
If you experience DNS problems, ensure that:
◆

The DNS server address is correct.

◆

The DNS server is running.

◆

The default gateway is set up correctly.

◆

DHCP is set up correctly. If you are using DHCP, the NetWorker server must have
a reserved IP address.

Connectivity
If you experience connectivity problems, ensure that:
◆

The Windows computer can ping its destination using both the destination’s
hostname and its fully qualified domain name.

◆

The Windows computer can ping itself using both its hostname and its fully
qualified domain name.

NetWorker software
If you experience NetWorker software problems, ensure that:
◆

You are using the -s server argument when starting a NetWorker utility from the
command prompt.

◆

There is a space in the path for the -s server argument or the path to the
NetWorker program.

◆

The NetWorker server to which you are connecting is running.

Tips
These tips can help prevent problems using the NetWorker software:
◆

Use the host table instead of DNS to test if DNS is working properly.

◆

Eliminate DHCP and use a static IP address instead.

◆

Use the 8.3 file naming convention for directory names in a path. Do not include
spaces in pathnames.

Changing the NetWorker server address
When the TCP/IP address changes on the NetWorker server, the NetWorker host ID
also changes, which invalidates the authorization code. In this case, reregister the
software. To reregister the software, print out the registration form with the new host
ID and return it to EMC Customer Service. If you do not reregister the software
within 14 days, the NetWorker software stops working.
If you are using DHCP, use a static IP address for the NetWorker server.
New.Net and NetWorker software are incompatible
Software from New.Net, Inc. loads a dynamic link library (DLL) named
newdotnet.dll, which modifies the Windows TCP/IP stack in ways that are
incompatible with NetWorker software. This causes many NetWorker programs,
including save.exe, to fail on exit. This is a New.Net problem that NetWorker
software cannot work around. New.Net software is included in products such as
Go!Zilla, BearShare, Mp3.com, iMesh, Babylon, Cydoor, Webshots, and gDivx.
If you suspect that the New.Net DLL is the cause of problems, search for the
newdotnet.dll file on the system drive. If you find this file, uninstall the New.Net
software.

Microsoft Windows communication issues

695

Troubleshooting

Note: Do not manually delete the newdotnet.dll file. Doing so renders the system unusable.

Troubleshooting port configurations
The following error messages might appear if there are problems with port
configurations:
◆

Cannot bind socket to service port in configured range on system

hostname
This indicates that the configured service port range is not large enough.
To resolve this problem:
1. Increase the service port range configured for the specified hostname.
2. Set the firewall rules to allow inbound and outbound TCP/UDP packets
within the port range specified in step 1 .
◆

Cannot bind socket to connection port in range on system hostname

This indicates that the configured connection port range is not large enough. The
current backup or recovery session has been stopped.
To resolve this problem:
1. Increase the connection port range for the specified hostname.
2. Set the firewall rules to allow inbound and outbound TCP/UDP packets
within the port range specified in step 1 .
Conflicting portmappers
Portmappers used with Hummingbird Maestro and Exceed software earlier than
version 5.1 conflict with the NetWorker portmapper. This conflict occurs because
Maestro and Exceed software install a service named HCL Inetd. You cannot
successfully install the NetWorker software while this service is running. You must
disable the HCL Inetd service through the Services window in the Control Panel
before installing the NetWorker software (the Maestro and Exceed software continue
to run).
If you installed both the NetWorker software and the Hummingbird software and
you have difficulties with portmappers, contact Hummingbird Technical Support.

NetWorker archiving and retrieval
This section explains how to troubleshoot issues with the Archive Module.

Remote archive request from server fails
If a remote archive request cannot be performed from the NetWorker server, the
archive client’s username (for example, root) might not be listed in that client’s
Archive Users attribute in the Client resource.
You can also grant NetWorker administrator privileges for root@client_system in the
Administrator attribute in the Server resource. However, be aware that NetWorker
administrators can recover and retrieve data owned by other users on other clients.
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Multiple save sets appear as a single archive save set
When you combine multiple save sets in an archive, such as /home and /usr, they
end up in a single archive save set. To retrieve archives separately, archive them
separately.

Wrong archive pool is selected
If multiple archive pools exist, the last one created is selected for archive.

Second archive request does not execute
If you create two archive requests with the same name, only the first request is
executed. Do not create two archive requests with the same name.

The nsrarchive program does not start immediately
If nsrarchive is run from the command-prompt, the archive will not start
immediately. Wait a short time until the archive starts. Do not press [Ctrl]+[D]
multiple times.

Archive request succeeds but generates error when nsrexecd
is not running
During an archive request operation, an error is generated when nsrexecd is not
running on a remote client. The archive operations succeeds, but the following error
message is logged to the daemon log file:
Failed to get port range from local nsrexecd: Service not available.

“Viewing log files” on page 661 provides information about viewing log files.

Empty annotations in retrieve list
Older releases of the NetWorker Archive application software installed on DOS,
Windows, and NetWare lack an annotation feature. As a consequence, the
annotations for save sets archived with the older software are empty strings in the
retrieve list.

Storage nodes
This section provides troubleshooting information about storage nodes.

Storage node affinity errors
A storage node affinity problem may exist if a backup fails with this error message:
No matching devices; check storage nodes, devices or pools

Possible reasons include:
◆

No devices are enabled for the storage nodes.

Storage nodes
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◆

The devices do not have volumes that match the pool required by the backup
request.

◆

All devices are set to read-only.

Fix the problem and restart the backup. Do one of the following:
◆

Enable devices on one of the storage nodes.

◆

Correct the pool restrictions for the devices listed in the Storage Nodes attribute.

◆

Add another storage node to the Storage Nodes attribute that has devices that are
enabled and that meet the pool restrictions.

◆

Set one of the devices to read/write.

◆

Adjust the Save Mount Timeout and Save Lockout attributes for the storage
node’s Device resource.

Storage node timeout errors
If nsrd initializes on the server and detects that a setting for NSR_MMDCONTROL
exists, this message appears:
NSR_MMDCONTROL env variable is being ignored
use nsrmmd control timeout attribute instead

If you receive this message:
1. Shut down the NetWorker services.
2. Remove the environment setting for NSR_MMDCONTROL.
3. Restart the NetWorker services.
4. Start the Console server.
5. Adjust the value of the nsrmmd Control Timeout attribute to the value
previously assigned to the NSR_MMDCONTROL variable, or one that best meets
the current requirements. “Modifying timeout attribute for storage node
operations” on page 100 provides more information.

Storage node communication errors
If the nsrmmgd process has not been added to the Windows firewall Allow list on
the NetWorker server, a library configured on the NetWorker storage node will not
enter “ready” state. Multiple nsrlcpd processes are started on the storage node, and
the following error message appears in the daemon.raw file on the storage node:
Unable to obtain a client connection to nsrmmgd (version %u)
on host %s

If you receive this message, ensure that the firewall is turned on, then add the
nsrmmgd process to the Allow list of the Windows firewall on the NetWorker server
host.
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Console error messages and corrective actions
Table 115 provides a list of Console error messages or symptoms and corrective
actions to take.
Table 115

Error messages or symptoms (1 of 3)

Error message or
symptom

Possible cause

Corrective action

If the Console server fails
to load and instead displays
a Save As... dialog box.

In Internet Explorer:
Either the web browser’s security level is
set to High (disabling JavaScript, which is
needed to launch the product), or
JavaScript has been disabled by some
other means.

In Internet Explorer:
Lower the web browser’s security setting or enable
Active Scripting.

Authorization code not
accepted.

NetWorker software temporary enabler
code has already expired.

Log out, then stop and restart the Console server.

Application window is
unresponsive.

Insufficient disk space on the file system
where the Console database is installed.

• Ensure that the Console server is running. “Console
troubleshooting notes and tips” on page 702
provides details. If it is not, close all application
windows and check the gstd log file for errors.
“Viewing log files” on page 661 provides information
about viewing log file.
• Back up and move the Console database, if
necessary.
• On a Windows system, run InstallShield with the
Repair option to move the database to a different
drive.

Application ran out of memory.

Close all instances of the application and restart it.

Another dialog box is open in the Console
window or Administration window.

Close any open dialog boxes or error messages.

Console server is in the process of
crashing or has already crashed.

Check to see if the Console server is running.
• If it is running, stop and restart the Console server.
• If it is not, close all application windows and check
the gstd log file for errors. “Viewing log files” on
page 661 provides information about viewing log
files.

Console server has been started within
the previous few minutes.

Wait a couple of minutes and retry.

Failed to bind to port XXXX
message in the gstd.raw
log file.

The gstd service port (default 9001) is
being used by some other process or is in
a timeout (TIME_WAIT/FIN_WAIT) state.

Close any running NMC GUIs or any processes that
may be using the gstd service port. Wait until the
timeout period passes so that the operating system can
free up the port. The timeout period may differ between
operating systems.

Database fetch operation
failed.

Console database is corrupt.

Recover the database. “Recovering the Console
database” on page 340 provides details.

Connection refused: no
further information.
or
Problem contacting server
server_name:

Console error messages and corrective actions
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Table 115

Error messages or symptoms (2 of 3)

Error message or
symptom

Possible cause

Corrective action

Display problem:

Console server is not running.

Restart the Console server.

Browser is not pointing to the correct
URL.

Check the install log file to determine the HTTP port
used by the Console server. “The install log” on
page 701 provides details.

Network connection is down.

Ping the Console server to confirm the network
connection. If it is available, contact the system
administrator.

In Internet Explorer:
The page cannot be
displayed.

Enabler code not accepted. Temporary enabler code has expired.

1. Close the Console server and log in again.
2. Repeat the procedure of entering the enabler code.
If the enabler code is still not accepted, log out, then
stop and restart the Console server.

Database delete operation
failed: Reference object
does not exist.

Another user has already deleted that
user or folder.

None

Database store operation
failed: An object with
pathname
“pathname” already exists.

• Another user is trying to add a folder
to the same location in the Enterprise
at the same time.
• An object was added with the same
name as an existing object.

• Wait a few moments and try again.
• Check whether there is an existing object with the
same name.

Invalid Object ID.

Another user deleted that host.

None

Could not contact License
Manager on <hostname>.
- or Program not registered.

License Manager hostname has not been
assigned or License Manager is not
running or installed.

If you are using the License Manager and a hostname
has not been assigned:
1. Select the Software Administration task.
2. Click Licensing.
3. Click Software Administration on the menu bar.
4. Click Change LLM Server.
5. Enter the new License Manager hostname.
6. Click OK.
7. If License Manager is installed, but not running,
start it.
Note: The NetWorker License Manager Installation and
Administrator’s Guide provides details.
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NetWorker client was stopped, but the
License Manager was not stopped, and
then the NetWorker client was restarted.
Although both services are now running,
NetWorker client must be started before
License Manager is started. If the
services are not started in the correct
order, an error condition occurs.

1.
2.
3.
4.

License allocation failed.

Temporary license for NetWorker
software is expired.

Enter enabler codes and register the product.

License managed event
indicates that license is
expiring/expired even
though it has been
authorized.

License has been authorized within the
last 24 hours.

None needed. To remove the managed event from the
display, dismiss the event or it will be deleted within 24
hours.
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Stop the NetWorker software.
Stop License Manager if it is running.
Restart License Manager.
Restart the NetWorker software.
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Table 115

Error messages or symptoms (3 of 3)

Error message or
symptom

Possible cause

Corrective action

Logging of debug
messages has stopped.
alloc /opt: file system full.

Disk space on the /opt file system is
nearly depleted.

Allocate more disk space.

Event disappears from the
Events window.

Another user dismissed it, or the problem
that was causing the event no longer
exists.

None

Dialog box: "Java Web
Start –Download Error"
with the message, "Unable
to launch NetWorker
Console".

Java Web Start preferences are set to
something that is incompatible with the
rest of the environment.

Check the Preference settings in the Java Web Start
Application Manager for compatibility with the
environment. Change any settings that prohibit the
download of the Console client software.

gstd.log file error: internal
error: could not end
transaction

(For example, a proxy server has been
set up that stops Java Web Start from
downloading the Console client software
from the Console web server.)

(In the proxy server example, go to the General tab of
the Preferences dialog box and select None, for
Proxies.)

This error message may also occur if the
Console is being launched on a localized
operating system and the Java Web Start
cache path contains non-English
characters.

If the Java Web Start cache path contains non-English
characters, change the path to contain no non-English
characters.

When the system time is moved ahead, a
time out event is initiated and the
database client connection for the gstd
process is closed.

None

Console log files
The Console server produces these log files:
◆

install

◆

gstd

◆

db output

◆

dbstop output

The install log
Refer to install log files when doing one of the following:
◆

Troubleshooting a problem with the Console server.

◆

Tracking decisions made during installation, such as the HTTP service port
chosen for the web interface.

By default, the install log files are located in /opt/LGTOnmc/logs (UNIX) or
C:\Program Files\Legato\Management\GST\logs (Microsoft Windows).

Console log files
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The gstd log
The gstd log file contains messages from the Console server. Whenever the Console
server is restarted, the size of the gstd log file is checked. If the gstd log file has
reached its maximum size, the Console server starts a new gstd log file.
The gstd log file is placed in these default locations:
◆

On UNIX/Linux: /opt/LGTOnmc/logs

◆

On Windows: %SystemDrive%\Program Files\Legato\Management\GST\logs

“Viewing log files” on page 661 provides information about viewing log files.
Table 116 lists the variables that control the gstd.log file.
Table 116

Environment variables for the GSTD log

Variable name

Description

GST_MAXLOGSIZE

Sets the maximum size of the gstd log file before it is renamed on GST restart.

GST_MAXLOGVERS

Sets the maximum value of nnn in gstd.nnn.

GST_DEBUG

Sets the level of verbosity of the gstd log file. Can also be set from the System
Options dialog box.

“Setting system options” on page 415 provides more information .

Console troubleshooting notes and tips
This section provides general troubleshooting tips for the Console server.

Making sure the Console server is running
If the Console server is not responding, answer the following questions:
◆

Is a potentially long-running process such as a device operation (label or
inventory, for example) currently running?
Any process started on the Console server locks the user interface until that
process completes. To perform multiple, long-running operations simultaneously
(that is, to administer multiple NetWorker servers), open a separate instance of
the Console server to run each operation.

◆

Are the following processes running?
• GST server (gstd)
• Database server (dbsrv9)
• Web server (httpd)
These processes must be running to support the Console server.

◆

Is the ntpdate command synchronizing at midnight?
In some cases, having a cron job that has ntpdate synchronize at exactly midnight
can cause the Console server to lose connection to the database. If such a situation
occurs, modify the cron job to have ntpdate synchronize at some time other than
midnight (12:00 A.M.) or have ntp run as a service and synchronize continuously.
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How to determine if the Console server is running on a Windows system
On a Windows computer:
1. From the Start menu, select Control Panel > Administrative Tools > Services.
2. Verify that EMC GST Service is running.
How to determine if the Console server is running on a Solaris system
◆

To check whether the gst server process is running, enter this:
/usr/bin/ps -ef | grep gstd

If the gst process is running, a result similar to this appears:
root
◆

6140

1

0

12:54:10 ?0:03 /opt/LGTOnmc/bin/gstd

To check whether the database process is running, enter this:
/usr/bin/ps -ef | grep dbsrv

If the database server is running, a result similar to this appears:
LGTOnmc root6140
1 0 12:54:10 ?0:03
/opt/LGTOnmc/sybasa/bin/dbsrv9
◆

To check whether the web server process is running, enter this:
/usr/bin/ps -ef | grep httpd

If the web process is running, a result similar to this appears:
LGTOnmc root6140

1

0

12:54:10 ?0:03 /opt/LGTOnmc/bin/httpd

Enabling Java script
If JavaScript becomes disabled, the Console server will not launch. Check the web
browser’s settings and reenable JavaScript if necessary.
Note: The procedure for enabling a given browser’s version of JavaScript might differ from the
instructions shown here. If it does, consult the browser’s Help application for information
about enabling JavaScript on the browser.

Java Web Start jnlp file caching issue after upgrading the NetWorker Console
After the NetWorker Console is upgraded or a client locale is changed, the
gconsole.jnlp file will be different than the original gconsole.jnlp file in the Java Web
Start cache. The NetWorker console may fail to launch.
Workaround
Remove the NetWorker Management Console Application and Language Pack (if
applicable) from the Java Cache Viewer:
1. Run the Java Cache Viewer. From the command line, use the javaws -viewer
command to launch the application.
Two different windows are displayed on the screen.
2. In Java Cache Viewer window, select Applications in the Show drop-down list.
Remove all instances of NetWorker Management Console from the table below.
3. In the Show drop-down list, select Resources. Remove all URL entries in the table
that start with the text, Error! Hyperlink reference not valid.
4. Close the Java Cache Viewer window.

Console troubleshooting notes and tips
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5. In the Java Control Panel window click Settings.
6. Click Delete Files and click OK.
Querying large numbers of save sets in the NetWorker user interface may cause a Java heap space
error
Querying large numbers of save sets in the NetWorker user interface may fail with a
Java heap space error.
Workaround
Increase the Java heap size used by the NMC application:
1. On the Console server host, open the gconsole.jnlp file in a text editor. The
gconsole.jnlp file is located in:
Console_install_dir\web

2. Increase the default max-heap-size value from 700MB to 1400MB. For example,
<resources>
<j2se version="1.5+" initial-heap-size="64M"
max-heap-size="1400M"/>
Note: To provide meaningful query results and to reduce the chance of encountering this error,
narrow the save set search criteria by specifying selection parameters.

“Unable to connect to host” error in the Client Backup Configuration wizard
The following message may appear when attempting to complete tasks that use the
remote agent:
Unable to connect to host: Please check Security setting and daemon
logs on the Networker client and Console server for more details

This message may appear when performing one of the following:
◆

Client Configuration wizard tasks

◆

Device Configuration wizard tasks

◆

Save set browsing when adding or modifying a client resource

Check for one of the following when you receive this error:
1. Verify that the SSL key matches between the NMC Server and the NetWorker
client host. The SSL key is in the NSR Peer Information attribute, which is located
in each host’s nsrladb database. A mismatch can occur when the nsrladb on one
host is corrupted.
To resolve this issue, delete the Console Server’s NSR Peer Information from the
NetWorker Client’s nsrladb, and delete the NetWorker Client’s NSR Peer
Information from the Console Server’s nsrladb as following:
• To delete the Console Server’s NSR Peer Information from the NetWorker
Client’s nsrladb, on the client host, type:
nsradmin –p nsrexec
nsradmin> print type:NSR peer information
Note: Identify the Console Server’s NSR Peer Information, and delete it.
nsradmin> delete type: NSR peer information;name:<Console Server
name>
Delete? Yes
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• To delete the NetWorker Client’s NSR Peer Information from the Console
Server’s nsrladb, on the Console Server host, type:
nsradmin –p nsrexec
nsradmin> print type:NSR peer information
Note: Identify the NetWorker Client’s NSR Peer Information, and delete it.
nsradmin> delete type: NSR peer information;name:<Client name>
Delete? Yes
Note: After the deletion is complete, it is not mandatory to restart the NetWorker or
Console services.

2. The Client cannot resolve hostname of NMC Server or NW Server. Sometimes,
NMC can resolve the client hostname, but, client cannot resolve NMC or
NetWorker Server hostname.
To resolve this issue, ping the NetWorker Server and NMC server from the
Client. If the ping fails, DNS is not resolving the hostname issue and add the
hostname to the client hosts file.
3. Ensure NetWorker users have at least the "Operate NetWorker" privilege to
launch the Client Wizard. To resolve this issue, add the user to the appropriate
user_group in the NetWorker Server.
4. The NetWorker Server may not be present in the client's servers file. To resolve
this issue, add the NetWorker Server to the client's servers file.
5. The NMC Server, NetWorker Server and NetWorker client hosts must only use
nsrauth authentication.
Username/password validation fails when using NMC New Device wizard to configure an AFTD if storage
node is UNIX
When using the NMC New Device Wizard to configure an AFTD,
username/password validation for browsing the file system may fail if the storage
node is a UNIX host. This failure occurs if the system is missing the Pluggable
Authentication Modules (PAM) library, or when the rule in the pam.conf file
(/etc/pam.conf) for OTHER service is set to deny.
Perform the following if validation fails when using the New Device Wizard on a
UNIX storage node:
1. Install the PAM package appropriate to your environment if it is not already
installed.
2. Modify the pam.conf file so that the rule for OTHER service is not set to deny.
The operating system's documentation provides more information.

NMC user interface exits unexpectedly
If the NMC GUI loses its connection to the gstd service because the gstd service was
shutdown or failed, the GUI will give a warning and exit after 10 seconds. This is
normal behavior. “Console error messages and corrective actions” on page 699
provides more troubleshooting information.

Console troubleshooting notes and tips

705

Troubleshooting

706

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

A

Invisible Body Tag

SYSTEM and VSS SYSTEM
Save Sets

This appendix covers these topics:
◆
◆

SYSTEM save sets........................................................................................................ 708
VSS SYSTEM save sets................................................................................................ 712

SYSTEM and VSS SYSTEM Save Sets

707

SYSTEM and VSS SYSTEM Save Sets

SYSTEM save sets
The SYSTEM save sets discussed in this section work with these operating systems:
◆

Windows XP Professional

◆

Windows Server 2003 32 and 64 bit (with no VSS client license, or with VSS
disabled)

The SYSTEM save sets includes the System State, System Files, and System DB.

Components of the SYSTEM STATE save set
As part of the SYSTEM STATE save set, NetWorker software backs up all Windows
system state components except the SFP component. “Components of the SYSTEM
FILES save set” on page 709 provides information about how NetWorker software
treats the SFP component.
Certain basic system state components are present with every Windows Server 2003,
or Windows XP Professional installation. These components are present on every
system, and are always part of the SYSTEM STATE save set. Table 117 lists these basic
components and references to their backup and recovery procedures.
Table 117

SYSTEM STATE save set basic components

SYSTEM STATE basic component

Special backup and restore considerations

COM+ Database

To complete the backup and recovery operation of the COM+ database,
ensure that a valid temporary directory is set with the TEMP
environment variable.

Internet Information Server (IIS)

“Internet information server” on page 736 provides details.

Registry

“Windows registry” on page 737 provides details.

Performance Counters

None

Optional components of the SYSTEM STATE save set
In Windows XP Professional and Windows Server 2003, the SYSTEM STATE save set
can include optional components, under these conditions:
◆

The optional components have been installed.

◆

The components’ corresponding services have been started.

These SYSTEM STATE optional components and their procedures for backup and
recovery are listed in Table 118.
Table 118

708

SYSTEM STATE save set optional components

SYSTEM STATE optional component

Special backup and restore considerations

Active Directory (AD)

“Active Directory” on page 734 provides details.

Certificate Server

None

Cluster Server

Chapter 19, “Cluster Support” provides details.

File Replication Service (FRS, also called SYSVOL)

None
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Components of the SYSTEM FILES save set
In Windows XP Professional and Windows Server 2003, the SFP feature prevents
overwriting of certain essential system files (most commonly, dynamic link libraries
and executables) by application installations. These files are called system-protected
files. By preventing the replacement of these critical system files, file version
mismatches are avoided that might otherwise cause application errors or system
crashes. The SFP component includes SFP catalog files, system protected files, and
system boot files (ntldr, ntdetect.com, and boot.ini). The SYSTEM FILES save set also
includes the IA-64 EFI FAT partition component.
The system state must always be backed up at level full (partial backups are not
allowed). However, the SFP component typically consists of more than 200 MB of
data in over 1,500 files. If the SFP component were part of the NetWorker SYSTEM
STATE save set, backing up or recovering the system state would be extremely
resource-intensive. Therefore, NetWorker software backs up the SFP component in its
own save set called SYSTEM FILES.
System File Protection (SFP)
For a full backup operation, specifying the SYSTEM FILES save set or save set All
results in a full backup of the system-protected files. However, on an incremental or
level 1-9 backup of the SYSTEM FILES save set or save set All, if any system-protected
files have changed since the specified time, all system-protected files are backed up. If
no system-protected files have changed, none will be backed up and no
corresponding save set entry is made in the server's media index.
To ensure a proper recovery of the Windows Server 2003 (with no VSS license, or VSS
disabled) or Windows XP Professional state of the computer, it is safest to restore all
three SYSTEM save sets in the same operation. In the NetWorker User program, if
only the SYSTEM FILES or SYSTEM STATE save set is marked for recovery, a dialog
box displays a warning that both of these save sets should be recovered together. No
such warning is provided for recoveries performed at the command-prompt.
Not all SFP files necessarily exist on a computer at any given time. Additional SFP
files are sometimes installed automatically when a new Windows system component
is installed. When this occurs, the new files have a creation date that corresponds to
the system component installation date. But the files have a modification date that
corresponds to the creation date of the Windows distribution. (The modification date
of a new SFP file is usually the same modification date of the already existing SFP
files.)
When a backup of save set All or the SYSTEM FILES save set detects new SFP files, it
checks for the more recent of the file creation and file modification dates. If the more
recent date is after the as of time, NetWorker software backs up all of the
system-protected files.

SYSTEM save sets
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Components of the SYSTEM DB save set
The NetWorker SYSTEM DB save set is used to back up the Windows Server 2003 (32
and 64 bit) or Windows XP Professional system databases that are installed and
started.
Table 119 on page 710 lists the system databases that are present by default and
references to their backup and recovery procedures.
Table 119

SYSTEM DB save set basic components

SYSTEM DB basic component

Special backup and restore considerations

Content Index Server (CIS)

“Backing up the Windows Content Index Server” on page 82 and
“Restoring Windows Content Index Server on Windows” on
page 348 provide details.

Disk Quota Database

“Granting full permissions for backup of Disk Quota database” on
page 85 provides details.

Removable Storage Database

Removable Storage database backup and recovery is not
supported.

Windows Management Instrumentation

None

Note: The CIS appears in the SYSTEM DB save set only if Indexing Service is started.

Windows databases not included in the SYSTEM DB save set
Table 120 lists the additional Windows Server 2003 and Windows XP Professional
databases that NetWorker software supports. Each of these databases may be
installed optionally. These databases are backed up as part of the file system, and not
as part of any SYSTEM save set.
Table 120
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Windows databases not in SYSTEM DB save set

Database

Backup and restore procedures

Distributed File System (DFS)

Appendix C, “Backing Up and Restoring a Microsoft DFS” provides
details

Encrypting File System (EFS)

“Encrypting file system” on page 734 provides details.

Event logs

“Event logs” on page 736 provides details.

Sparse files

“Sparse files” on page 737 provides details.
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Components of the SHAREPOINT save set
During a Microsoft SharePoint Portal Server (SPS) backup, a single save set called
SHAREPOINT is saved. The SHAREPOINT save set can be restored only in its
entirety.
Note: Microsoft Windows Server 2003 does not support SPS 2001.

The SHAREPOINT save set contains:
◆

Web Storage System files, including database, log, and backup patch files.

◆

Microsoft Search resources, including the property and subscription stores,
full-text index files, and propagated indexes.

◆

Server configuration information for the Web Storage System, content sources,
server properties, and access accounts.

◆

The Applications folder, which contains a subfolder for each workspace on the
server. Each subfolder can include searchable applications designed for the Web
Storage System.
• All application-specific data stored in the Web Storage System is included.
• All application-specific data stored outside the Web Storage System (such as
registry settings) is not included.

◆

Any shortcuts or content sources that reference the local file system. Note that
these do not work if the referenced content does not exist on the computer where
the SHAREPOINT save set is restored. Also, you must restore any shortcuts to
workspaces in My Network Places.

The SHAREPOINT save set does not contain:
◆

Scheduled tasks for processing subscriptions. SPS processes subscriptions based
on default schedules at the time of the recovery operation.

◆

The gather log that SPS creates each time it updates an index. This file contains
data about the URLs that SPS accesses while generating an index.

Components of the ASR save set
The ASR (Automated System Recovery) save set contains all the information
necessary to return the failed computer to its condition at the time of the last ASR
backup, including:
◆

Automated reinstallation of Windows

◆

Restoration of the system configuration

◆

Recovery of one or more disk volumes

The ASR save set can be backed up by itself, or as a component of save set All. Like
other SYSTEM save sets, ASR is automatically backed up at level full.
Chapter 23, “Support for Windows XP and 2003 Automated System Recovery”
provides more information about NetWorker software support for ASR.
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VSS SYSTEM save sets
The VSS SYSTEM save sets discussed in this section work with Windows Server 2003,
where VSS is licensed and enabled, and Windows Server 2008.
The VSS SYSTEM SAVE SET includes the VSS System Boot, VSS System Fileset, and
VSS System Services, along with three non-system components, VSS User Data, VSS
Other and VSS ASR Disk (Windows Server 2003 only).

Components of the VSS SYSTEM BOOT save set
The VSS SYSTEM BOOT save set includes all elements of the Windows system state,
except the VSS System Writer writer and the SFP component. It also includes the ASR
System Files legacy component. All other components are dynamically generated,
and therefore may differ each time NetWorker software runs.
The following new VSS writers were introduced in Windows Server 2008 R2 and
Windows 7:
◆

Performance Counters Writer

◆

Task Scheduler Writer

◆

VSS Metadata Store Writer

NetWorker client on Windows Server 2008 R2 and Windows 7, supports the backup
of these new VSS writers. These writers are backed up as a part of VSS SYSTEM
BOOT FILES save set.
“Components of the VSS SYSTEM FILESET save set” on page 712 provides
information about how NetWorker software treats the SFP component.

Components of the VSS SYSTEM FILESET save set
The VSS SYSTEM FILESET save set includes the VSS System Writer writer, the SFP
component, and the IA-64 EFI FAT partition legacy component. This save set
component is recovered by using the legacy method of recovery.
Most of the elements of the Windows system state are part of the VSS SYTEM BOOT
save set. However, the SFP component typically consists of more than 200 MB of data
in more than 1,500 files. If the SFP component were part of the NetWorker VSS
SYSTEM BOOT save set, backing up or recovering the system state would be
extremely resource-intensive. To relieve the strain on resources, NetWorker software
backs up the SFP component as part of the VSS SYSTEM FILESET save set.
“Components of the SYSTEM FILES save set” on page 709 provides more information
about the SFP component.
System File Protection (SFP)
For a full backup operation, specification of the VSS SYSTEM FILESET save set or
save set All results in a full backup of the system-protected files. However, on an
incremental or level 1-9 backup of the VSS SYSTEM FILESET save set or save set All,
if any system-protected files have changed since the specified time, all
system-protected files are backed up. If no system-protected files have changed, none
will be backed up and no corresponding save set entry is made in the server's media
index.
To properly recover the entire system, especially in a disaster recovery situation, back
up and recover VSS SYSTEM BOOT, VSS SYSTEM FILESET, VSS SYSTEM SERVICES,
712

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

SYSTEM and VSS SYSTEM Save Sets

and all boot/system volumes. During recovery, if you choose not to mark all three
save sets, a warning message will appear with the option to mark the other save sets.
The NetWorker Disaster Recovery Guide provides more information.
Note: When performing a disaster recovery in multiple Windows platforms and copying the
registry, a failure may be reported during the recovery of VSS SYSTEM BOOT: due to the size
of the PendingRenameFileOperations registry value, which is populated during the disaster
recovery. The error message indicates a lack of system resources. If this error appears, it is
recommended to set the variable NSR_RECOV_TEMP_CLEANUP to an appropriate value (for
example, 1) in the system space, and then restart the disaster recovery. Setting this variable
ensures that the error does not appear, and that the recovery and subsequent cleanup of the
temporary recover files after restart occur without this interruption.

Not all SFP files necessarily exist on a computer at any given time. Additional SFP
files are sometimes installed automatically when a new Windows system component
is installed. When this occurs, the new files have a creation date corresponding to the
system component installation date. They also have a modification date that
corresponds to the creation date of the Windows distribution. (The modification date
of a new SFP file is usually the same modification date of the already existing SFP
files.)
When a NetWorker backup of save set All or the VSS SYSTEM FILESET save set
detects new SFP files, NetWorker software checks for the more recent of the file
creation and file modification dates. If the more recent date is after the as of time value,
NetWorker software backs up all of the system-protected files.

Components of the VSS SYSTEM SERVICES save set
The VSS SYSTEM SERVICES save set includes all elements of the Windows System
Services. It also includes the Disk Quota database legacy component, File Server
Resource Manager (FSRM) Disk Quota, and the DFS Replication writer. In addition,
for Windows Server clusters, it includes the Cluster writer.
The Disk Quota database legacy component of the save set is recovered by using the
legacy method of recovery. All other components of this save set are dynamically
generated and may differ each time NetWorker software runs.
The FSRM Disk Quota component can only be backed up with a VSS enabled backup,
which is requires a VSS license.
Windows Server Cluster writers
Backup and recovery of Windows Server cluster is supported for Windows Server
2003 and Windows Server 2008. There are some differences in the Cluster Writer save
set names between Windows Server 2003 and Windows Server 2008.
In Windows Server 2003, the NetWorker software uses the following specifications:
◆

Cluster writer name: Cluster Service Writer

◆

Backup and recovery save set: Under the VSS SYSTEM SERVICES system save set

◆

Mode: Regular recovery mode only, using the NetWorker user interface or
command line.

In Windows Server 2008, the NetWorker software uses the following specifications:
◆

Cluster writer name: Cluster Database

◆

Backup and recovery save set: Under the VSS SYSTEM SERVICES system save set

VSS SYSTEM save sets
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Components of the VSS USER DATA save set
The VSS USER DATA save set includes application data that is not system-critical.
Components of this save set are dynamically generated and may differ each time
NetWorker software runs.

Components of the VSS OTHER save set
The VSS OTHER save set includes application data that is not system-critical.
Components of this save set are dynamically generated and may differ each time
NetWorker software runs.

Components of the VSS ASR DISK save set
The VSS ASR DISK save set includes the ASR legacy component. This is a legacy save
set and is recovered by using the legacy method of recovery.
Note: The VSS ASR DISK save set is not supported by NetWorker for Windows Vista nor
Windows Server 2008.
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Overview
Many differences exist in the number of ports used by NetWorker release 7.3 and
later, from the earlier releases. Also if you operate in a mixed environment,
calculating the ports required by the NetWorker software is more complicated with
the later releases. Consequently, this appendix is divided into sections that
specifically describe each NetWorker release. Separate sections describe mixed
environments and NetWorker add-ons.
This appendix also provides an example of firewall configuration, access control to
local host resources, and firewall port enhancement.

Configuring the port ranges in NetWorker software
NetWorker software and some add-on products use ports from a range that is stored
in the nsrla database. The port ranges are stored in the "NSR system port ranges"
resource and there are several ways to view or update their values. There are two sets
of port ranges:
◆

Connection port range

◆

Service port range

Connection ports range
TCP client side ports are only selected from this range, which should be kept as wide
as possible. There are no security concerns in keeping this range as wide as possible
although NetWorker performance problems or random malfunctions may occur if the
range is too narrow. In release 7.2 the default value for this range is: 10001-30000. In
NetWorker 7.3, the default value, which is 0-0, indicates that the NetWorker software
will allow the operating system to select the port for TCP clients. You can only do this
when using NetWorker 7.3 and later.

Service ports range
The NetWorker TCP/UDP server processes use ports in this range. The default value
for the service ports range is 7937–9936. This range can be narrowed or expanded, as
discussed in this chapter.
The ports used by the NetWorker Management Console (NMC) server are configured
separately from the NetWorker service ports range. The default ports NMC uses are
ports 9000 and 9001. NetWorker services should therefore, at a minimum, not include
these ports in the default range. EMC recommends not including ports 9000–9010 in
the service ports range.
When configuring a firewall, you must open the port range described by the "Service
ports" range in the firewall, for TCP connections. The NetWorker software does use
some ports from this range for UDP services, but these are not essential. UDP service
ports must be opened in the firewall for TCP connections, although there is no need
to allow UDP connections through the firewall. The ports required by various
daemons are selected at random from the service ports range.
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IMPORTANT
The nsrexecd command, when used on every type of NetWorker host, will always
try to listen on ports 7937 and 7938. Both of these ports should therefore be kept
available. Also, rpcbind (portmapper) should be running and available through
the firewall in case port 7938 is not available. Otherwise, the NetWorker software
will not function correctly.
Anytime you change the service or connection port range used by a NetWorker host,
you must restart all NetWorker processes on that computer for those changes to take
effect. You must do this no matter which method you use.
In order to change the port ranges on a system, you must have update access to the
"NSR system port ranges" resource in nsrexecd, that is, you must be in the
"administrator" list for that resource. “Access control to local host resources” on
page 724 provides more information about access control on this resource.

Using the nsrports command to update port ranges
The nsrports program is used to view and update the port ranges. To view port
ranges, enter:
$nsrports -s shadow.emc.com

In this example, the port ranges for NetWorker host shadow.emc.com are displayed:
Service ports: 7937-9936
Connection ports: 0-0

To update the service ports range, enter:
$nsrports -s shadow.emc.com -S 7937-8937

As seen in this example, the service port range on shadow.emc.com was changed
from 7937-9936 to 7937-8937. You can enter multiple ranges for those cases where you
can not have a a solid range. This is illustrated in this example
nsrports -s shadow.emc.com -S 7937-7938 10000-11000 11500

In this case the service ports range for host: shadow.emc.com is set to use ports
7937-7938, 10000-11000, and 11500.

Using the Console to update the port ranges
You can only use the Console to update the port ranges if you are using the Console
server that ships with the current NetWorker release.
To use the Console to update the port ranges on a host:
1. Go to the Configuration screen.
2. Select the Local Hosts entry for the computer on which you want to update the
port ranges. You select the entry from the left side of the screen in tree view.
3. Right-click the Local Hosts entry.
4. Select Configure Port Ranges....
5. Change the value of the desired range. For multiple ranges, type one range per
line.
6. Click OK when complete.
Configuring the port ranges in NetWorker software
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Using nsradmin to update the port ranges
To view the current port ranges on a system, type:
$nsradmin -p nsrexec -s shadow.emc.com
NetWorker administration program.
Use the "help" command for help, "visual" for full-screen mode.
nsradmin> p type: nsr system port ranges
type: NSR system port ranges;
service ports: 7937-9936;
connection ports: 0-0;
administrator: *@localhost;
nsradmin>

To update the service ports range, type:
$nsradmin -p nsrexec -s shadow.emc.com
NetWorker administration program.
Use the "help" command for help, "visual" for full-screen mode.
nsradmin> . type: nsr system port ranges
Current query set
nsradmin> update service ports: 7937-7938, 9011-9100
service ports: 7937-7938, 9011-9100;
Update? y
updated resource id
0.13.3.219.0.0.0.0.0.0.0.0.67.30.89.147.137.69.168.98(6)
nsradmin>

Multiple port ranges were created in the previous example. Notice that each range is
separated by commas.

Ports needed in the service ports range for NetWorker 7.3.x and later
The Console is shipped and installed as part of NetWorker 7.3.x. Because of this, a
new required component called the Console server is available. The NetWorker
Console server must be installed to manage and monitor NetWorker servers. It is best
to install it on just one computer in the network to take full advantage of the
Console's consolidated reporting feature. As in previous versions of Console, the
ports used by the Console server are configured separately, in separate configuration
files, from the ports that the NetWorker software uses. As a result, the ports that the
Console server uses are not calculated by nsrports, in the normal range of ports. This
also means that these ports can be addressed separately from the ports calculated for
the rest of the NetWorker software. “NetWorker Management Console” on page 720
provides additional information on configuring these ports.
These daemons were introduced in NetWorker 7.3 and are shipped with NetWorker
release 7.3.x:
◆

nsrmmgd

◆

nsrlcpd

◆

nsrjobd

Each of these daemons use one port and two new ports are used by nsrexecd. This
demonstrates why the configuration of NetWorker 7.3 is different from that
performed for NetWorker 7.2.x.
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The NetWorker server
These daemons only run on the server:
◆

nsrd

◆

nsrmmdbd

◆

nsrindexd

◆

nsrmmgd

◆

nsrjobd

Each of these daemons uses one port for TCP servers. The nsrexecd daemon also runs
on the server and it uses 4 ports. Both the nsrlcpd and nsrmmd daemons run on
either a storage node or on the server (because the server is acting as a storage node).
These daemons take one port per instance. There is one nsrlcpd daemon for each
jukebox managed by the NetWorker software, and this is started on the computer
that manages that jukebox. This computer can be either the NetWorker server or
storage node.
There is one nsrmmd daemon for each NetWorker configured device, unless that is
an adv_file type device. The adv_file type device requires two nsrmmds be started.
The nsrmmd daemon starts on the computer that manages the device. When
spanning from one medium to another, an extra nsrmmd is started to mount the new
tape. This nsrmmd is known as a 'helper mmd' and each instance requires one port.
Helper mmds take dynamic ports, so that even though the ports are not in use when
you start the NetWorker software, they will be in use when you span media. Since
multiple devices can span simultaneously, it is best to assume that each device
requires two ports.
The processes nsrd and nsrmmgd, each require one port for UDP services. These
ports do not really need to be accessed from outside the firewall, but they are taken
from the service ports range configured using nsrports. Therefore, they need to be
added to the formula to calculate the number of ports needed in the service ports
range.
The formula for how many ports the NetWorker server requires is therefore:
◆

NetWorker 7.3.x
11 + 2 * #devices + #jukeboxes

◆

NetWorker 7.4.x and later
12 + 2 * #devices + #jukeboxes
the additional port is required for the software distribution feature (nsrpush).

where:
◆

#devices is the number of devices configured on the NetWorker server only.

◆

#jukeboxes is the number of jukeboxes configured on the NetWorker server only.

NetWorker storage node
The only storage node daemons that are run are:
◆

nsrexecd

◆

nsrmmd

◆

nsrlcpd

Ports needed in the service ports range for NetWorker 7.3.x and later
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As described previously, nsrexecd uses four ports, nsrmmd uses two ports per
device, and nsrlcpd uses one port per jukebox. From this, the number of ports
required by a NetWorker storage node is:
4 + 2 * #devices + #jukeboxes
where:
◆

#devices is the number of devices configured on the NetWorker storage node only.

◆

#jukeboxes is the number of jukeboxes configured on the NetWorker storage node
only.

NetWorker client
The only daemon running on the NetWorker 7.3 client is nsrexecd and it uses four
ports. Therefore the port usage formula for a NetWorker client is 4.

NetWorker Management Console
The NetWorker Management Console (NMC) is used to administer the NetWorker
server and can also administer some of the NetWorker Client resources.
The NMC server requires the following ports:
◆

A HTTP port that is used for the NMC embedded web server. It is used to
download the NMC user interface, which is a Java application. This port is
selected during the installation process. The default port value is 9000.

◆

An RPC port for calls from the NMC Java client to the NMC server. This port is
selected during the installation process. The default port used is 9001.

◆

The database queries port. The default port value is 2638.

◆

An SNMP port for getting information from the Data Domain system. The default
port value is 161.

◆

An SNMPTRAPD port for capturing Data Domain SNMP traps. The default port
value is 162.

The ports used by NMC are not configured by using nsrports.
How to enable Console client/server connections through a firewall
To enable clients to connect to the Console server through a firewall, configure the
firewall for communication over the HTTP, Client Service, and TDS (Tabular Data
Stream protocol) port numbers:
1. Determine the two port numbers used for connecting to the Console server:
Note: To identify the specified ports, refer to the GST server package in the install.log file.
Look for the following expressions as part of larger expressions:

• http_svc_port -t int -v http_service_port
• clnt_svc_port -t int -v client_service_port
where http_service_port and client_service_port are port numbers. By default, the
HTTP service port is set to 9000 and the client service port is set to 9001.
2. Use the firewall software to accept inbound and outbound (TCP packets from the
HTTP and client service ports determined in step 1.
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3. Use the firewall software to accept inbound and outbound TDS packets from the
database queries port, which is 2638 by default.
4. Use the firewall software to accept inbound and outbound requests for the SNMP
port, which is 161 by default.
5. Use the firewall software to accept inbound requests for the SNMPTRAPD port,
which is 162 by default.
6. Repeat step 2 and step 3 for any other firewalls used with this connection.

Ports needed in the service ports range for NetWorker 7.2.x.
In NetWorker release 7.2.x, the dynamic ports used by nsrexec become redundant.

NetWorker server
These daemons only run on the server:
◆

nsrd

◆

nsrindexd

◆

nsrmmdbd

Each of these daemons uses one port although, nsrexecd also runs on the NetWorker
server and it uses two ports. The nsrmmd process can run on either the server or
storage node. It runs on the computer responsible for managing the device. One
nsrmmd process is started per device (except for adv_file type device which has two
mmds started). During spanning, one additional nsrmmd helper, which uses a
dynamic port, is started. Since spanning can simultaneously take place on all devices,
mmd daemons essentially use two ports per device configured on the host in
question.
Unfortunately, the nsrd process uses one port for a UDP service. This port does not
really need to be accessed from outside the firewall, but the port is taken from the
service ports range configured by using nsrports. Therefore, this port needs to be
added to the formula to calculate the number of ports needed in the service ports
range.
The formula for how many ports the NetWorker server requires is therefore:
6 + 2 * #devices
The #devices only includes those devices that are configured on the NetWorker
server.

NetWorker storage node
Both nsrexecd and nsrmmd are the only daemons that run on the storage node. The
nsrexecd (like on the server) daemon uses two ports, while the nsrmmd daemon uses
two ports for each device configured on the host.
The NetWorker 7.2.x port usage formula is:
2 + 2 * #devices
Note: The #devices only includes the devices configured on the NetWorker storage node in
question.

Ports needed in the service ports range for NetWorker 7.2.x.
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NetWorker client
The nsrexecd daemon, which uses two ports, is the only one running on the
NetWorker client. Therefore, the formula for port usage on the NetWorker client is 2.

Ports used by NetWorker add-on products
This section details the ports used for various NetWorker add-on products. Some
add-on products use ports from the range configured using nsrports, others have
their own configuration files.
If a NetWorker add-on product uses ports from outside the range configured by
using nsrports, they do not need to be included in the formula used to calculate the
range entered using nsrports. However, it is still important that the ports used by that
add-on, not overlap the range used by the NetWorker software on the host where the
add-on is installed. If the add-on product ports do overlap the NetWorker port range,
neither product will be able to use the ports they require.

AlphaStor
If there is a firewall between AlphaStor and NetWorker software, the following ports
should be opened:
◆

With NetWorker release 7.2:
• Port 44444 should be opened between the AlphaStor software and the
NetWorker server.
This port uses long-running connections. The firewall should not be
configured to close the port due to inactivity to prevent media from being
unmounted during backup.
• Port 41025 should be opened between the AlphaStor software and the
NetWorker server and/or NetWorker client for command line operations.

◆

With NetWorker release 7.3 and newer:
• Port 44475 should be opened between the AlphaStor software and the
NetWorker server.

Additionally, if there is a firewall between the AlphaStor software and the host
running the AlphaStor Graphical User Interface, port 44470 should be opened in the
firewall.
Ports required for communication between AlphaStor software and storage libraries
If there is a firewall between the AlphaStor software and a host with an
AlphaStor-controlled library connected to it, the following ports should be opened:
◆

Port 3500 should be opened between the AlphaStor software and the host
controlling the library’s robotics.

◆

Port 3000 should be opened between the AlphaStor software and the host access
the drives.

Client Backup Configuration Wizard
The Client Backup Configuration wizard speeds the process by which a NetWorker
client is configured, on the NetWorker server, for being backed up. Prior to
NetWorker release 7.3, the client backup configuration wizard was shipped as a
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separate add-on product. With NetWorker release 7.3 it became, like the Console, a
part of the main NetWorker product.
The NetWorker Client Backup Configuration wizard uses one port for each open user
interface on the NetWorker client. This is a dynamic port and that is closed when the
wizard is closed.
These ports are selected from the port range configured by using nsrports.

NDMP
The NDMP extension uses 1 transient port (port number 10,000) whenever an NDMP
filer is being backed up. When backing up an NDMP Server to a NetWorker storage
node that uses DSA, DSA is dynamically spawned for each backup and recover. As it
is spawned, DSA listens on a port that falls within the NetWorker service port range
and closes the connection once the backup or recover is finished. DSA listens on an
unused transient port from within the NetWorker service port.

NetWorker modules
SnapImage uses 1 transient port (port number 10,000), specified in /etc/services
much like other standard services, although this can be changed manually during
installation.
The data connection used between the NetWorker storage node and the SnapImage
data server (if they are remote), is within the NetWorker service port range. Another
NDMP service (NDMP tape server) uses the system reserved port (0-1024 range) to
accept the connection. The connecting client (NDMP data server) uses the ephemeral
ports generated by the system.

Example of a firewall configuration
The following is an example of a firewall configuration.
ABC Company has a NetWorker server behind a bi-directional firewall that controls
both incoming and outgoing traffic. The NetWorker server has a locally-attached
media library with six devices. This will require 25 service ports: 12 + 2 * [number of
devices] + [number of libraries]. Therefore, the server must be configured to use 25
service ports and the firewall must allow incoming traffic from outside the firewall to
the server on these 25 ports.
The company also has three storage nodes outside the firewall. Each storage node has
one library with six devices. Each storage node will require 17 service ports: 4 + 2 *
[number of devices] + [number of libraries]. The firewall will need to be configured to
allow outgoing traffic from the server through the firewall to the storage nodes.
However, each storage node can use the same service ports. Therefore, the firewall
only needs to allow outgoing traffic to the storage nodes' IP addresses through a total
of 17 ports. Furthermore, these can be the same ports that the server uses for its
service ports.
The company also has several clients outside the firewall. Each of these clients
requires four service ports. The firewall will have to allow outgoing traffic from the
server to the clients on the clients' service ports. However, all client can use the same
four service ports. Furthermore, the ports can be the same ports that the storage
nodes use for their service ports.

Example of a firewall configuration
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Therefore, the simplest configuration for ABC Company to allow all necessary
communication through their firewall would result in a total of 25 ports opened for
incoming communication to the server, with 17 of those ports also opened for
outgoing communication from the server to the clients and storage nodes.

Multiple firewalls

The ABC Company can include multiple firewalls, with one or more storage nodes
and some clients behind each firewall. In this case, each firewall should be configured
the same.

Additional ports that may be required
If ABC Company also wishes to have the NetWorker Console server installed inside
the firewall, and allow users to launch the Console GUI from outside the firewall,
four additional service ports should be opened through the firewall. The client
backup configuration wizard will use a client-side service port, so they may decide to
configure an additional service port on each client (for a total of five). NetWorker
modules may also require additional ports.

Access control to local host resources
Most resources inherit their administrator list from the NSR resource. The NSR
administrator list is only a copy of the list of users in the Administrators entry from
the NSR usergroup resource. However, there are a few resources for which this is not
true. These exceptions are the resources that you configure using the Local hosts list
in the Console Configuration Window.
When selecting a host from the Local hosts list in the Console Configuration Window,
you are administering resources on the host that you selected. You are not
administering resources on the NetWorker server. It is important to remember this
because all other resources in the Console configuration window reside on the
NetWorker server. The host on which you configure a resource is the one that you
select in the Local hosts tree entry. This selection is made from the left window pane
in the Console configuration window.
The Administrator attribute for resources selected from a Local hosts entry is
different from the Administrator attribute in the NSR resource. The NSR resource
appears when you right click the root of the tree in the Console configuration
window and then select Properties.
The user identified as administrator@gstd_machine is not automatically included in the
Administrator attribute for the these resources. In this case, gstd_machine is the
hostname of the device where the Console server is installed.
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Firewall port enhancement
NetWorker 7.5 uses the sun portmapper on port 111 and its own portmapper (default
port 7937 and 7938) for RPC lookups. If you have a firewall that blocks these ports,
you may see delays up to four minutes per connection. You can reconfigure
NetWorker to use its own portmapper on a different static port number you have
opened through your firewall. Setting the portmapper causes it to avoid using the
system portmapper.
To enable NetWorker portmapper:
1. Add the following lines to your services file:
nsrrpc <portnumber>/udp
nsrrpc <portnumber>/tcp

2. Restart the NetWorker services.
Configure the server, its storage nodes, and its clients in the same way.

Firewall port enhancement
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Overview of a Microsoft Distributed File System (DFS)
Microsoft distributed file system (DFS) is a Windows file system feature that allows
you to create a namespace of shared directories that are physically distributed across
a network. With DFS you can organize a set of distributed directories logically,
according to any scheme you choose, to provide centralized access to files that reside
in a variety of locations.
Benefits of DFS include:
◆

Easy browsing of servers.

◆

Simplified searches for files and data.

◆

Server load balancing.

Domain-based DFS versus registry-based DFS
Windows supports two types of DFS:
◆

Domain-based DFS, where DFS topology information is stored in Active
Directory (AD) on the domain controllers. Because this information is replicated
on multiple domain controllers, domain-based DFS is fault tolerant. The DFS host
server can be any Windows domain controller or member server.

◆

For registry-based DFS (also called stand-alone DFS), the DFS topology
information is stored in the Windows registry on the DFS host server.

DFS junctions
A DFS junction is a DFS root (namespace for files and DFS links) or a DFS link
(connection to a shared file or folder). DFS junctions are file system objects, but are
not files or directories. Therefore, the NetWorker software does not treat DFS
junctions the same as files or directories for backup and recovery. However, DFS
junctions appear as files and directories in the NetWorker User program.
Note: The DFS terminology Microsoft uses with Windows 2003 and later operating systems is
different than that used with Windows NT 4.0. For example, in Windows NT 4.0 DFS junctions
are called DFS components.

DFS-R granular recovery on Windows 2008 and 2008 R2
NetWorker Release 7.5 Service Pack 2 and higher support Windows Distributed File
System Replication (DFS-R) granular recovery. With this support, DFS-R Shared
Directories can be backed up like standard file directories. This allows granular
DFS-R folder and file recoveries on Windows Server 2008 and Windows Server 2008
R2 operating systems. Users will not have to recover the entire VSS SYSTEM save sets
to restore DFS-R shared directories.
Be aware that DFS-R namepaces are not backed up in VSS SYSTEM save sets. Also,
namepaces are skipped when specifying the saveset All. Users must back up
namespaces directly by specifying the path of the namepaces as separate savesets in
the NetWorker client’s Save Set attribute.
For recovery of namespace data, use the NetWorker User program and select
individual files or folders.
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DFS backups and restores for Windows 2003
If the NetWorker Module for Microsoft Applications is installed on the client
computer, refer to the EMC NetWorker Module for Microsoft Applications Administration
Guide for DFS information.
A complete NetWorker backup of a DFS requires backups of the following:
◆

DFS topology information

◆

DFS junctions

◆

DFS destination directories (shared directories connected to DFS links)

Note: The NetWorker software does not traverse DFS links and therefore does not back up DFS
destination directories as a part of the DFS junctions backup. To properly protect data, back up
the DFS destination directories.

DFS topology information
Domain-based DFS topology information is backed up as part of AD, which is a
component of the SYSTEM STATE or VSS SYSTEM BOOT save set on domain
controllers. Registry-based DFS topology information is backed up as part of the
Windows registry, which is a component of the DFS host server’s SYSTEM STATE or
VSS SYSTEM BOOT save set. Appendix A, “SYSTEM and VSS SYSTEM Save Sets”
provides more information about the SYSTEM or VSS SYSTEM save sets.

DFS backup consideration with VSS
If VSS is enabled, a DFS backup or a VSS SYSTEM BOOT backup may fail under the
following conditions:
◆

The namespace folder is not a shared folder target.

◆

Replication is configured for the namespace.

◆

Files exist in the namespace folder and have replicated to the member server.

To avoid this issue, create a namespace in the folder target or do not enable
replication.

Configuring a scheduled DFS backup
To avoid inconsistencies among the various save sets, configure a scheduled backup
that includes the DFS topology information, junctions, and destination directories.
To configure a scheduled backup for a DFS:
1. From the Administration window, include the following clients in the NetWorker
group that will be back up the DFS:
• The DFS host server
• Any computer where remote DFS destination directories reside
• A domain controller (domain-based DFS only)
For example, you could create a NetWorker group named DFS, then make each of
the preceding clients a member of the DFS group. Chapter 2, “Backing Up Data”
provides more information about configuring a scheduled backup.

DFS backups and restores for Windows 2003
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2. Enter these save sets in the Save Set attribute for the DFS host server’s Client
resource:
• The DFS root. For example:
C:\MyDfsRoot
• DFS destination directories that reside on the DFS host. For example:
D:\MyLocalDir
Note: DFS destination directories are also be backed up if you enter the entire volume
(for example, D:\) in the Save Set attribute.

• For registry-based DFS only, include the following SYSTEM save sets in the
DFS host server’s Save Set attribute:
SYSTEM STATE:
SYSTEM FILES:
If VSS is licensed and enabled, include these VSS SYSTEM save sets:
VSS SYSTEM BOOT:
VSS SYSTEM FILESET:
3. For clients where remote DFS destination directories reside, enter the destination
directory paths in the Save Set attribute. For example:
E:\MyRemoteDir
E:\MyOtherRemoteDir
E:\
4. For domain-based DFS only, include the following SYSTEM save sets in the
domain controller’s Save Set attribute:
SYSTEM STATE:
SYSTEM FILES:
If VSS is licensed and enabled, include the following VSS SYSTEM save sets:
VSS SYSTEM BOOT:
VSS SYSTEM FILESET:

Restoring a DFS
Note: The SYSTEM STATE save set, or the VSS SYSTEM BOOT save set and the AD can be
restored as a single unit only. Appendix A, “SYSTEM and VSS SYSTEM Save Sets” provides
more information.

To restore a DFS:
1. Restore the DFS topology information:
• To restore a domain-based system, restore the SYSTEM STATE and SYSTEM
FILES (or VSS SYSTEM BOOT and VSS SYSTEM FILESET) save sets on the
domain controller.
• To restore a registry-based system, restore the SYSTEM STATE and SYSTEM
FILES (or VSS SYSTEM BOOT and VSS SYSTEM FILESET) save sets on the
DFS host server.
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Chapter 13, “Recovering Data” provides recovery procedures.
2. On the DFS host server:
• Restore the DFS root.
Note: You cannot restore individual DFS links. If the DFS root has lost a link, restore the
entire DFS root in which that link resided.

• If necessary, restore any local DFS destination directories.
3. If necessary, restore the remote DFS destination directories.

Authoritative restores of DFS Replication writers
Authoritative restores of the DFS Replication writers must be performed from the
command line. Restores from the NetWorker User program Graphical User Interface
(GUI) will be nonauthoritative.
To perform an authoritative restore of the DFS Replication writer on Windows 2003
systems, use the -U option of the recover command.
To restore the DFS Replication writer on Windows 2003 systems, type the following
command:
recover -s server -U -N "VSS USER DATA:\DFS Replication service
writer"
Note: You cannot select individual components within the writer for recovery.

DFS backups and restores for Windows 2003
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NetWorker Module for Microsoft Applications
NetWorker Module for Microsoft Applications (NMM) was previously known as
NetWorker VSS Client for Microsoft Windows Server 2003. NMM provides
VSS-based backup and recovery of Windows, as well as Microsoft server applications
such as Microsoft Exchange Server, Microsoft SQL Server, Microsoft Data Protection
Manager (DPM), and Microsoft Office SharePoint Services.
If NMM is installed on the client computer, refer to the NetWorker Module for Microsoft
Applications Administration Guide for documentation about that product.
There are also separate modules available for Microsoft Exchange Server and
Microsoft SQL Server:
◆

EMC NetWorker Module for Microsoft Exchange to back up and recover
Microsoft Exchange Server.

◆

EMC NetWorker Module for Microsoft SQL Server to back up and recover
Microsoft SQL Server.

Active Directory
Active Directory (AD) is the Windows directory service and the foundation for the
Windows Distributed File System. AD is a component of the Windows system state
on Windows Server 2008 and 2003 domain controllers. A domain controller is a
computer that stores directory data and manages user interactions with a domain,
including login, authentication, directory searches, and access to other shared
resources.

Backing up Active Directory
The NetWorker software automatically backs up AD as a component of the SYSTEM
STATE or VSS SYSTEM BOOT save set. An AD backup or restore includes the AD log
files, database, patch files, and expiry token.

Recovering Active Directory
The EMC NetWorker Disaster Recovery Guide contains information about the online
recovery of Active Directory. Chapter 24, “Support for Windows 2008 / 2008 R2 /
Windows 7 Disaster Recovery,” provides information about the bare metal recovery
of an Active Directory host.

Encrypting file system
Windows Encrypting File System (EFS) allows NTFS files to be stored in encrypted
format. A user without the private key to the file cannot access the file.
Consider these when backing up or recovering files or folders that are encrypted with
EFS:
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◆

NetWorker software will not encrypt or compress a file already encrypted by
Windows.

◆

Do not use AES encryption when backing up files that are encrypted using EFS.
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◆

Files can become unusable if the encryption keys change on the domain
controller. Reasons include:
• The domain controller functionality is moved from one computer to another
• The domain controller crashes.

◆

NetWorker software does not back up encryption keys. If the EFS is reinstalled
after a disaster, the new security keys will not match the recovered keys and the
recovery will fail. Keep a copy of the keys to ensure a successful recovery.

◆

You cannot perform a directed recovery of encrypted files.

◆

When recovering encrypted files to an encrypted folder that has been removed,
consider the following:
• If you recover the encrypted files and the encrypted folder, the recovered
folder and files are all encrypted.
• If you recover only individual encrypted files (but do not recover the
encrypted folder that contains them) the individual recovered files are
encrypted but the re-created folder is not encrypted. Microsoft Windows
documentation provides instructions on encrypting the re-created folder.

Encrypting file system
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Event logs
Event logs can be used for troubleshooting hardware problems as well as monitoring
security conditions, and system and application software problems.
If no VSS client license exists, or if VSS is disabled, the NetWorker software backs up
event logs for services that are running at the time of the backup. You can restore
event logs to the same location or to a new location on the computer and then view
them with the Microsoft Event Viewer.
The size of a restored event log might be smaller than the size of the corresponding
backed-up log. This is characteristic of Windows event logs and does not cause any
loss or modification of data. The recovered, smaller log can still be viewed in the
Microsoft Event Viewer.
If more than one active event log is marked for backup (for example, SecEvent.Evt
and SysEvent.Evt), all event logs are backed up.
Event logs can be recovered to a location different than the location from which they
were backed up. However, event logs cannot be recovered to a FAT16 or FAT32
partition if they were backed up from an NTFS partition.
If VSS is licensed and enabled, event logs are backed as a component of the VSS
SYSTEM SERVICES save set.
Note: Windows Server 2008 and Windows Vista do not have an event log writer. The event logs
will not be backed up as part of the VSS system save sets. The event logs are backed up as part
of the file system.To back up the event logs, you should perform a regular (non-VSS) backup of
the system32\winevt\logs folder.

Internet information server
Internet Information Server (IIS) is a web server that enables the publication of
information on the Internet or a corporate intranet by using HTTP.
The NetWorker software backs up IIS using its active metabase and restores backup
versions to the metabase location, which can be at the default location
(%SystemRoot%\system32\inetsrv\MetaBase.bin) or in a location specified in the
registry. The Microsoft documentation provides information about creating a registry
key to specify an alternate metabase location.
Relocation of the IIS metabase is not supported in IIS version 6.0.
Note: If you perform a NetWorker recovery of the SYSTEM STATE or VSS SYSTEM BOOT save
set (which includes the active metabase), and reboot, the Network News Transfer Protocol
(NNTP) virtual server might not start. In that case, rebuild the NNTP index and hash table
files. The Microsoft NNTP documentation provides more information.
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Windows registry
For supported Windows Server versions, the registry is a component of the system
state. The registry can be backed up and restored only as part of the SYSTEM or VSS
SYSTEM save set to which it belongs.
In the NetWorker User program, the registry is a component of the SYSTEM STATE
or VSS SYSTEM BOOT save set. The NetWorker software automatically backs up or
recovers the registry as well as this save set.
The registry is always saved and restored at level full.

Backward compatibility with earlier NetWorker releases
The Windows NT registry save set is no longer supported in the NetWorker software.
In supported Windows versions, the registry is part of the system state. The
NetWorker software includes the registry as a component of the SYSTEM STATE or
VSS SYSTEM BOOT save set. Specifying registry as a save set in a Client resource
does not result in a backup of the Windows registry. Backup and recovery of the All
save set includes the SYSTEM STATE or VSS SYSTEM BOOT save set, which includes
the registry.
Note: Attempting to restore a Windows NT 4.0 registry save set to a computer that is running
Windows Server 2003 o r later will yield unpredictable results.

Sparse files
The NTFS sparse files feature enables a program to create huge files without actually
committing disk space for every byte. The NetWorker software provides complete
backup and recovery support for sparse files.

Windows Change Journal
Microsoft Windows Change Journal is a Windows Server 2003, and Windows XP
Professional file system feature that logs a record of each change as it occurs to the
files and directories on a local NTFS 5.0 volume.
The Change Journal enables NetWorker software to detect more types of changes and
save more changed files than is possible when not using the Change Journal.
Additionally, the Change Journal improves NetWorker performance.
The Change Journal can be enabled or disabled independently for each NTFS 5.0
volume. When enabled, the Change Journal stores records of the volume’s file and
directory changes in System Volume Information\tracking.log.
Note: When VSS is used, the Microsoft Change Journal is not used. Microsoft Windows Vista
and Windows Server 2008 are VSS only, so Windows Vista and Windows Server 2008 do not
use the Windows Change Journal.

NetWorker support for Change Journal

Windows registry
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Windows does not have an administrative interface for enabling or disabling the
Change Journal. That functionality is provided with the NetWorker Change Journal
Manager.
The NetWorker Change Journal Manager is installed during the NetWorker software
setup and can be run from Start>Programs>NetWorker.
The NetWorker Change Journal Manager allows you to:
◆

Enable or disable the Change Journal for each NTFS 5.0 volume.

◆

Enable or disable the NetWorker software’s use of each volume’s Change Journal.

◆

Set parameters that control the size of the Change Journal log file.

How NetWorker software uses the Change Journal
When configured to use the Change Journal, the NetWorker software bases its save
decisions for level and incremental backups on the Change Journal log rather than on
the traditional save criteria of modification time and Archive attribute.
“Backup levels” on page 147 provides information about level and incremental
backups.
Note: The NetWorker software does not use the Change Journal for the following types of
backups:
◆

Full backups

◆

Client-initiated backups

◆

Backups with an undefined level

◆

DFS backups

◆

VSS file system backups

◆

Backups of pseudo-volumes, such as the SYSTEM save sets

The Change Journal is only used when the NetWorker save command’s path
argument specifies an entire volume (for example, C:\ but not C:\MyDir). The time a
change occurred continues to control the file save decision.
For a file to be selected for backup, it must have changed more recently than the
changed after time (also called the as of time), as specified in the NetWorker save
command’s -t argument. The EMC NetWorker Command Reference Guide or the UNIX
man page provides information about the NetWorker save command.
NetWorker save criteria when using the Change Journal
A NetWorker save that uses the Change Journal occurs when all of the following
conditions are met:
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◆

The target volume is NTFS 5.0.

◆

The Change Journal is enabled on the target volume.

◆

The NetWorker software is configured to use the Change Journal on the target
volume.

◆

The save path is the entire volume (for example, C:\).

◆

The save set is a level or incremental backup.

◆

One or more of the save triggers occurs.
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Table 121 shows the NetWorker save triggers when using the Change Journal.
Table 121

NetWorker save triggers

Change

Trigger

A file was deleted (or moved to another directory).

Save of the deleted file’s directory.

A directory was deleted.

Save of the parent directory.

A directory was renamed.

Save of all files and subdirectories within the
directory.

A file or directory was compressed or decompressed.

Save of the file or directory.

A file or directory was encrypted or decrypted.

Save of the file or directory.

The NTFS-extended attributes of a file or directory were
changed.

Save of the file or directory.

The access rights of a file or directory were changed.

Save of the file or directory.

An NTFS hard link was added to or removed from a file or
directory.

Save of the file or directory.

Configuring NetWorker software to use the Change Journal
The NetWorker Change Journal Manager enables one to view or edit the Change
Journal configuration of each volume in the NetWorker server or client host
computer.
How to configure NetWorker software to use the Change Journal
To view or edit the Change Journal configuration:
1. On the NetWorker server or client host computer, select
Start>Programs>NetWorker>NetWorker Change Journal Manager.
2. In the NetWorker Change Journal Manager dialog box, select one of the
following:
• All NTFS Volumes — to view or edit the Change Journal configuration of all
local NTFS 5.0 volumes at once.
• A drive letter — to view or edit the Change Journal configuration of an
individual volume.
Note: The status of the selected volume or volumes appears in the scrolling text box. If a
selected volume does not support the Change Journal (FAT volumes, for example) the
configuration options are dimmed.

3. To enable the Change Journal for use with NetWorker software, ensure that the
NetWorker Uses Change Journal checkbox is selected. To disable the Change
Journal, ensure that this checkbox is clear.
If you select All NTFS Volumes, and some (but not all) of the local NTFS 5.0
volumes already have this option enabled, the checkbox appears shaded. To
change the setting of this option for all NTFS 5.0 volumes, click the checkbox until
it is selected or clear, but not shaded.
4. To enable the Change Journal for use with Microsoft, select the Enable Change
Journal For Selected Volumes checkbox.
• To disable the Change Journal, ensure that this checkbox is clear.
Windows Change Journal
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• If you select All NTFS Volumes, and some (but not all) of the local NTFS 5.0
volumes already have this option enabled, the checkbox appears shaded.
• To change the setting of this option for all NTFS 5.0 volumes, click this box
until it is selected or clear, but not dimmed.
Note: When you enable the Change Journal, there may be a delay of several minutes before
logging begins.

5. Edit the following values to control the size of the Change Journal log file. If the
Change Journal is already enabled for the selected volume or volumes, disable it
before changing either of these values.
• % Of Volume For Log File — The maximum amount of the volume’s storage
space that can be used for the Change Journal log file. The allowable range is
0.01% to 2.0% of the volume’s capacity.
• % Of Log For Allocation Delta — The amount by which the Change Journal
log file can expand if additional space is needed. This is also the amount that
will be purged from the beginning of the log when the file has reached its
maximum size. The allowable range is 12% to 25% of the % Of Volume For Log
File.
6. Click Apply to save any configuration changes.
7. Click OK to exit NetWorker Change Journal Manager.

Advanced Configuration and Power Interface
NetWorker software supports the following:
◆

Windows Server 2003

◆

Windows XP Professional

◆

Power Interface (ACPI), which is also called OnNow

NetWorker support for ACPI
Support for ACPI is provided by the NetWorker Power Monitor service. The executable
for this service (<NetWorker_install_path>\bin\nsrpm.exe) is installed and
configured for automatic startup during NetWorker setup.
For scheduled backups of Windows Server 2003, and Windows XP Professional
clients, each client must be able to respond when a NetWorker server contacts it for
backup. Therefore, by default, the NetWorker Power Monitor service does not allow a
NetWorker server or client host operating system and its network interface to enter
the ACPI standby mode.
However, the NetWorker Power Monitor service does not prevent a user from
specifying that a computer can power down to standby state. Also, if line power is
lost and the uninterrupted battery power reaches a critically low state, the NetWorker
software does not prevent the host’s power-management policies from forcing the
system to power down. The NetWorker software shuts down any storage
management operation that is in progress when standby is forced by a user action or
a critical power event.
Considerations for ACPI usage
Before using ACPI, review the following conditions:
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◆

Do not place a NetWorker server host or client host in standby mode during a
time period when either computer is to participate in a scheduled backup.

◆

Do not put a NetWorker client or server host in standby or hibernation mode
while a NetWorker backup or restore operation (involving that host) is in progress.
Doing so will yield unpredictable results.

◆

If a NetWorker server is powered down while NetWorker operations are in
progress, the server’s peripheral devices might be powered down as well.

If this occurs, when the server’s power is restored, the tape devices may rewind and
NetWorker’s tape processes will have incorrect positioning information.

Windows print queues
The following considerations apply to Windows print queues:
◆

Print queues are backed up and recovered as part of the file system and not as
part of any VSS writer.

◆

During a recover operation, you may have to reboot depending on the status of
the print queue.

Windows print queues
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Solaris
This section provides information specific to NetWorker software that runs on the
Solaris platform.

Support for Solaris zones
The NetWorker software provides support for local and global zones for a NetWorker
client, server, and a dedicated storage node. You can install and back up a NetWorker
client, server or storage node on a machine running in a local zone. “Dedicated
storage nodes” on page 102 provides more information about storage node support
in a local zone.
Note: The NetWorker Console (NMC) and the NetWorker License Manager can only be
installed in a global zone.

NetWorker executables not found for Solaris client
On Solaris, NetWorker executables are installed by default in /usr/sbin. If you start a
group backup on a NetWorker server that does not have /usr/sbin in the search path
for root, the backup fails on a client that has its NetWorker executables in /usr/sbin.
This is because the savefs command is not in the search path.
To solve this issue, set the Executable Path attribute for the client.
How to set the Executable Path attribute
To set the Executable Path attribute:
1. From the Administration window, click Configuration.
2. In the expanded left pane, select Clients.
3. In the right pane, select the client name.
4. From the File menu, select Properties.
5. For the Executable Path attribute on the Globals 2 of 2 tab, enter the path of the
executables, /usr/sbin.
6. Click OK.
Alternate solution: Modify the search path for root on the NetWorker server to
include /usr/sbin even if it does not exist locally.

How to obtain support for devices not supported by Solaris
For devices that are not directly supported by Sun Microsystems for use with your
operating system, obtain a st.conf file from the device manufacturer.

Extended file attribute data included in Save Set File Size attribute
The save set file size shown in NetWorker appears to be slightly larger than one
might expect. This is because the extended file attribute data is included in the
calculation of the save set file size.
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The inquire command and Solaris 10
On Solaris 10, the inquire command does not show library information after the
library has been configured for NetWorker.

Solaris
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Linux
This section provides information about NetWorker software that runs on the Linux
platform.

Backup considerations for Linux raw disk partitions
The following considerations apply to backing up Linux raw disk partitions:
◆

The Linux raw device must be unbound before it can be saved.

◆

The save set must be /dev/sd or /dev/hd.

◆

The backup will fail if the /dev/raw device is used.

Configure Linux operating system to detect SCSI devices
Proper configuration of the SCSI subsystem is required to get full use of SCSI devices
and allow the operating system to detect SCSI devices attached to the computer. If the
device is configured with multiple LUNs, set the kernel parameter Probe all LUNs of
each SCSI Device to Yes. The Linux Documentation Project website provides more
information on configuring the Linux SCSI subsystem. For information on the SCSI
device, contact the manufacturer.

Configuration requirements for the inquire command
Depending on the specific OS requirements, and the configuration of the NetWorker
server or storage node, device files may need to be created so that the inquire
command can detect all devices.
For example, on a NetWorker server that is running Red Hat Linux, if devices sg0
through sg15 already exist, create device file sg16 by using the mknod program as
follows:
mknod /dev/sg16 c 21 17

The operating system vendor documentation provides more information on creating
devices.

Linux Journaled file system support
Backup and recovery operations are supported on the following Linux journaled file
systems:
◆

ext3

◆

reiserfs

◆

jfs

◆

xfs

Note: For ext3 file systems with the journal set to visible, do not back up or recover the journal.
Recovering the journal may cause the file system to become unstable. Use a directive to ensure
that this file system is excluded from a backup. Chapter 6, “Directives” provides information
about directives.
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HP-UX
This section provides information specific to NetWorker software that runs on the
HP-UX platform.

Autochanger installation on an HP-UX system
The following sections explain how to install and configure Hewlett-Packard drivers.
Selecting SCSI addresses for the autochanger
Determine which SCSI address is assigned to each SCSI bus and select the SCSI
addresses to be allocated to the autochanger drives and controller.
To select unused SCSI addresses for an autochanger:
1. Log in as root on the NetWorker server or storage node and enter the ioscan -f
command.
2. Use a SCSI address within the range of 0 to 6. The primary hard disk is usually on
SCSI address 6.
Note: For some devices, such as the HP Model 48AL autochanger, select one SCSI address
for the entire autochanger. The 48AL uses a different SCSI logical unit number (LUN) for
the device (LUN 0) and robotics (LUN 1). The SCSI LUN appears as the last digit of the
H/W Path field in the ioscan output.

The following sections provide examples of the command and output to use with
different combinations of hardware and operating systems.
Installing the SCSI pass-through driver
The following procedure describes how to install a GSC, HSC, or PCI pass-through
driver.
How to install a GSC, HSC, or PCI pass-through driver
The following procedure assumes you are using the SAM terminal mode.
To install a GSC, HSC, or PCI pass-through driver:
1. Run SAM.
2. Select Kernel Config and press Enter.
3. Select Drivers and press Enter.
4. Select SCTL from the list. The SCSI_ctl driver is represented by the name SCTL.
• If the current state is in, proceed to “How to verify a device file” on page 748.
• Select any unreserved name for the device. For example, do not select a name
such as /dev/null.
5. From the Actions menu, select Add Drivers to Kernel and press Enter.
6. From the Actions menu, select Create a New Kernel and press Enter.
7. When prompted with “Are you sure?” indicate Yes, and press Enter.
8. The Creating Kernel message appears, followed by the Move Kernel Message.
Select OK and press Enter. The system reboots.
9. Proceed to “How to verify a device file” on page 748.

HP-UX
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How to verify a device file
To verify a device file:
1. Verify that the spt was successfully installed with the following command:
ioscan -kfn

2. Verify that the driver has claimed the autochanger. If the autochanger has been
claimed, CLAIMED should appear under the S/W State header. If not, verify that
the installation has been completed properly.
3. If the device entry was defined by the operating system, use the OS-defined entry
and proceed to verify the installation.
Major number
To determine the value for majornum, type the following commands:
lsdev -d sctl

The output should resemble the following. The assigned number may differ from
those displayed in this example:
Character
HP-PB
HSC or PCI

Block
75 -1
203 -1

Driver
spt
sctl

Class
spt
ctl

The value for majornum is the number in the Character column.
Minor number
To determine the value for minornum, use the ioscan command. The relevant lines in
the ioscan output are those:
◆

For the controller itself (which contains HP C6280-7000 in the Description
column).

◆

For the adapter to which the controller is connected (which is the second line
above the line for the controller and contains “ext_bus” in the Class column).

If the schgr driver is configured on the system, it appears associated with the library.
The ioscan output line resembles:
Class
I
Description
spt
0
C6280-7000

H/W Path

Driver S/W State H/W Type

10/4/4.6.0

schgr

CLAIMED

DEVICE

HP

If the schgr driver is not configured on the system, no driver appears to be associated
with the library. The ioscan output line resembles:
Class
I
Description
unknown -1
C6280-7000

H/W Path

Driver

S/W State

H/W Type

10/4/4.6.0

schgr

UNCLAIMED

DEVICE

How to test the device driver and device file installation
After the device driver is installed and the device file is created, run the inquire
command to list available SCSI devices:
inquire
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!

IMPORTANT
Use the inquire command with caution. Running inquire sends the SCSI inquiry
command to all devices detected on the SCSI bus. Using inquire during normal
operations may cause unforeseen errors and possible data loss may result.
An example of the output from this command (with the -s option) is as follows:
scsidev@0.1.0:HP
C1194F 0.14Autochanger (Jukebox), /dev/rac/c0t1d0
scsidev@0.2.0:Quantum DLT4000 CC37Tape, /dev/rmt/c0t2d0BESTnb
scsidev@0.3.0:Quantum DLT4000 CC37Tape, /dev/rmt/c0t3d0BESTnb
scsidev@0.4.0:Quantum DLT4000 CC37Tape, /dev/rmt/c0t4d0BESTnb
scsidev@0.5.0:Quantum DLT4000 CC37Tape, /dev/rmt/c0t5d0BESTnb

Inquire command does not detect tape drive
When you attach a Tape drive to the HP-UX 11i V2 64-bit host and run the inquire
command, the tape drive is not detected, even if the device is configured, labeled and
mounted and a save was successful.
Workaround
Identify the drive path in the /dev/rmt folder, and using this path configure the
device, as usual.
Whenever a new device is attached to the system, ensure that the cached file
/tmp/lgto_scsi_devlist is updated. Remove this temp file and then run the inquire
command, which will rebuild the file.

The “Hardware address not found” message
The HP-UX system configuration logger may generate the error message:
bootpd pid# Hardware address not found hardware-address

A similar message is written to the NetWorker /nsr/logs/messages file. If this error
message appears:
1. Log in as root and edit the /etc/syslog.conf file to change every instance of
daemon.notice to local7.notice.
2. Edit the Log Default notification in the Notification resource to change the value
for the Action attribute:
• Change daemon.notice to local 7.notice.
3. Apply and save the changes to the Log Default notification.
4. Enter this command:
cat /etc/syslog.pid

5. Use the PID number obtained from the /etc/syslog.pid file to kill the designated
PID number and cause the syslogd daemon to reread its configuration file:
kill -HPU pid#

The local7 facility is provided as an example.
6. View the syslog.h system header file to determine other possibilities for the
facility.
• By default, LOG_LOCAL0 to LOG_LOCAL7 are reserved for local use.

HP-UX
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• If they are not used by other local utilities on the system, the NetWorker server
can use them to avoid the hardware address problems encountered with
bootpd.

Errors from unsupported media in HP tape drives
Certain HP tape drives can only read 4-mm tapes of a specific length. Some, for
example, read only 60-meter tapes. To determine the type of tape that is supported,
refer to the drive’s hardware manual.
If unsupported media is used, the following types of error messages may appear in
the specified situations:
◆

When the nsrmm or nsrjb command is used to label the tape:
nsrmm: error, label write, No more processes (5)

◆

When the scanner -i command is used:
scanner: error, tape label read, No more processes (11)
scanning for valid records …
read: 0 bytes
read: 0 bytes
read: 0 bytes

Unloading tape drives on an HP-UX server or storage node
When the nsrjb -u -S command is used to unload a tape drive in an autochanger
attached to an HP-UX server or storage node, all of the tape drives inside the
autochanger are unloaded to their respective slots. To unload a single drive to its
corresponding slot, use the nsrjb -u -f devicename command instead.

SCSI pass-through driver required for HP-UX autochangers
If an autochanger with a NetWorker HP-UX server is used, refer to the NetWorker
Installation Guide. Read the required procedures to follow before the jbconfig
program is run. Even if the SCSI pass-through driver is installed, follow the
procedures to rebuild the kernel. Then run the jbconfig program to configure the
autochanger.

Symbolic link entries in the fstab file
For HP-UX operating systems, do not use symbolic entries in the /etc/fstab file. If
symbolic links are used in the fstab file, the NetWorker server will not back up the file
system that the symbolic link points to.

Font warnings when exporting display to a Solaris computer
If the NetWorker motif-based graphical interface (nwrecover) is being run on an
HP-UX computer and exporting the display to a Solaris computer, the motif
application may fail to open and the following warnings may appear:
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Warning: Missing charsets in String to FontSet conversion

◆

Warning: Cannot convert string string to type FontSet

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

UNIX and Linux Platform-Specific Notes

If this occurs, set the LC_CTYPE environment variable on the HP-UX computer to the
value C.iso88591. For example, from an xterm window, telnet to the HP-UX computer
and run the following command: export LC_CTYPE=C.iso88591
The nwrecover should work correctly when this environment variable is set. Add this
environment variable setting to your .profile on the HP-UX computer.

Customized backup scripts
On HP-UX, do not use the posix shell (/bin/sh) for customized backup scripts that
are meant to be automatically started by the savegroup. Use the korn shell instead
(/bin/ksh).

HP-UX
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AIX
This section provides information specific to NetWorker software that runs on the
AIX platform.

STK-9840 drives attached to AIX
If you attach an STK-9840 drive to an AIX server, use SMIT to modify the IBM tape
drive definition field to set the value of Use Extended File Mark to Yes.

LUS driver operation on AIX
The operation of the LUS driver on AIX has been changed with NetWorker release 7.6
SP2. When a library comes online, NetWorker now obtains an exclusive lock on the
library. This lock is maintained as long as the library is enabled. As a result,
diagnostic tools such as inquire and the sji utilities cannot be used to access the
library during this time. To access the library using these tools, it will be necessary to
take the library offline.

HP Tru64 UNIX
This section provides information specific to NetWorker software that runs on the HP
Tru64 UNIX platform.
Select the port range
To select the port range:
1. Log in to the NetWorker server and each cluster node.
2. Use the nsrports command to select a unique service port range. For example:
• On Cluster node A, change the port range to 7937-8936:
nsrports -S 7937-8936
• On Cluster node B, change the port range to 8937-9936:
nsrports -S 8937-9936
3. Shut down and restart the NetWorker software on all nodes.

Restoring context-dependent symbolic links
NetWorker software does not correctly handle the restoration of files in a path that
contains CDSLs. This problem exists when a file is backed up through a path that
incorporates a CDSL embedded in the middle of a pathname. The file is backed up,
but the save set cannot be restored or browsed because the file path is ambiguous on
the tape.
Currently, two workarounds are available:
◆

Restore by using the full pathname for any paths containing CDSLs.

◆

Specify a directory above the CDSL during the backup and restore. For example:
• If the mount point /cluster/members/(memb)/ptmp is backed up, then the
files in /ptmp/fred are written to tape, but are not accessible.
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• To work around this problem, replace the <memb> with the real value of
memberN (N is the node number).
• You can also save /cluster/members and
/cluster/members/memberN/ptmp, which saves both the CDSLs and the
data to which they point.
Chapter 2, “Backing Up Data” provides information about backups. Chapter 13,
“Recovering Data” provides more information about recovering data.

HP Tru64 UNIX
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IRIX
This section provides information specific to NetWorker software running on the
IRIX platform.

IRIX displays a “no space left in tape” message
If an IRIX NetWorker server or storage node is used, the following message may
appear if the tape drive is not configured within the machine’s kernel:
BSF invalid argument no space left in tape

This is not a NetWorker error. Ensure that the device is supported and configured by
applying the latest kernel patch from the Silicon Graphics.
Go to the SGI Services and Support website for the required patches and information
about the current drives, robotics, and firmware revisions that IRIX supports.
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Support for Mac OS X
This section describes NetWorker client support for the Mac OS X platform. Mac
hosts can be set up as NetWorker clients by using the NetWorker client for Mac OS X.
Mac hosts that are set up as NetWorker clients can be backed up and restored by
using any supported NetWorker server on UNIX, Linux, or Windows. Currently the
NetWorker server and the Console server are not supported on Mac OS X.

Mac OS X metadata support
The NetWorker client on Mac OS X supports backup and recovery of all file system
metadata including:
◆

Finder information

◆

Resource forks

◆

Extended attributes (Mac OS X 10.4)

◆

Access Control Lists (Mac OS X 10.4)

Supported file systems
The NetWorker client for Mac OS X software supports these file systems:
◆

HFS+ (including journaled)

◆

HFS

◆

UFS

Known limitations
For the NetWorker client for Mac OS X, there is no graphical user interface, however
there is full support of the command line interface.

Mac OS X backup considerations
Use this section to help plan successful backups for NetWorker clients on the Mac OS
X platform.

Scheduling a NetWorker client backup on Mac OS X
This section provides information on configuring backups for a NetWorker client on
Mac OS X.
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MAC OS X required directives
To ensure a consistent state after recovery, certain files and directories must not be
backed up on Mac OS X systems.
To ensure that appropriate files and directories are not backed up:
1. Create or edit the Mac OS Client resource. “Task 6: Create a backup Client
resource” on page 59 provides information about creating a Client resource.
2. Select one of these directives from the Directive attribute list:
• Mac OS Standard Directives
• Mac OS with Compression Directives
“Preconfigured global directive resources” on page 174 provides more
information about Mac OS directives.
3. Click OK.
“Scheduled backups” on page 54 provides more information about scheduling a
backup.
Backing up Mac OS X server’s open directory for disaster recovery
This section describes how to back up the Mac OS X Server’s Open Directory. Open
Directory contains system configuration information that is essential for disaster
recovery. The NetWorker Disaster Recovery Guide provides more information about
disaster recovery.
Note: The NetWorker Mac OS directives do not back up Open Directory database files.

To ensure complete protection of a Mac OS X Server system in the event of a
catastrophic failure:
1. Use the savepnpc script to automatically export and backup the required Open
Directory database files.
2. Open Directory database files remain available during the backup.
To automatically back up Open Directory files:
1. Enter savepnpc in the Backup Command attribute when configuring the Mac OS
X client as a NetWorker Client resource.
“Using the savepnpc command with a customized backup program” on page 91
provides more information about enabling the Client resource to use the
savepnpc command.
2. Create a custom savepnpc script in the /nsr/res directory with the name
<group_name>.res.
where <group_name> is the Group that was selected for the Client resource.

Mac OS X backup considerations
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3. Include entries in the savepnpc script to perform these functions:
• Back up Open Directory’s LDAP directory domain:
# slapcat -l /var/backups/networker.ldif

• If your LDAP server uses SSL, back up Open Directory’s Password Server
database:
# mkdir -p /var/backups/networker.odpdb
# mkpassdb -backupdb /var/backups/networker.odpdb

• Back up the local NetInfo directory domain:
# nidump -r / . > /var/backups/networker.nidump
Example 50

Custom savepnpc script for Mac OS X

A Mac OS X NetWorker client that belongs to the Default group will have a
/nsr/res/Default.res script with this content:
type: savepnpc;
precmd: "/usr/sbin/slapcat -l /var/backups/networker.ldif;
/bin/mkdir -p /var/backups/networker.odpdb;
/usr/sbin/mkpassdb -backupdb /var/backups/networker.odpdb;
/usr/bin/nidump -r / . > /var/backups/networker.nidump"

In this script, the savepnpc command backs up Open Directory’s LDAP directory,
Password Server, and NetInfo databases before each scheduled save.

Performing a manual backup on Mac OS X
Manual backups for Mac OS X clients must be performed from the command prompt.
To perform a manual backup, use the save command, in a Terminal session, as
follows:
$ save "file_or_directory_to_back_up"

By default, the save command contacts the NetWorker server defined in the
/nsr/res/servers file that comes first in alphabetical order.
To specify an alternative NetWorker server, use the save command with the -s
NetWorker_server option.

Recovering files and directories on Mac OS X
These sections provide information on recovering individual files and directories
from a NetWorker client on Mac OS X:
◆

“Task 1: Browse backed-up Mac OS X data” on page 759

◆

“Task 2: Recover individual files or directories” on page 759

Each task in this section uses the NetWorker recover command. The NetWorker
Command Reference Guide or the UNIX man pages provide more information about
this command.
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Task 1: Browse backed-up Mac OS X data
To browse backed-up Mac OS X data:
1. From the Mac OS X Terminal application, start a recover session with a
NetWorker server by using this command:
$ recover

By default, the recover command contacts the NetWorker server defined in the
/nsr/res/servers file that comes first in alphabetical order. To specify an
alternative NetWorker server, use the recover command with the -s
NetWorker_server option.
2. At the recover prompt, browse backed-up Mac OS X data by using common
UNIX shell commands such as cd and ls.

Task 2: Recover individual files or directories
To recover individual files or directories from the client’s recover prompt:
1. At the recover prompt, add all the directories and files to be recovered, by using
the add command, for example:
recover> add directory_name

2. (Optional) To automatically overwrite existing files, enter the force option at the
recover prompt.
3. Start the recovery by typing this command:
recover> recover
Note: Do not recover any Mac OS X operating system boot files. For example do not recover
the Mac OS X operating system kernel, /mach_kernel.

Recovering files and directories on Mac OS X
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Introduction to direct SCSI backup and recover
Direct SCSI backup and recover enables direct backup and recover of Small
Computer System Interface (SCSI) devices without the requirement of mounting it on
the backup host if an access path is available to these devices over a Storage Area
Network (SAN). You can also use this feature to migrate to the NetWorker software to
perform backup and recover of Business continuance volume (BCV) devices on a
Symmetrix server (as well as backup and recover of raw devices) over a SCSI bus.
Backup technologies often protect information as files and directories or as file
systems. But backups also allow information contained on raw disks to be protected
as raw devices. However, this type of backup (known as raw backup) usually does
not provide granular recover capabilities.
The direct SCSI backup and recover feature enables raw backups for the NetWorker
software directly by using a SCSI target, which is usually accessible from a SAN
proxy host. Typically, in an EMC Symmetrix® storage environment, these devices can
be viewed from a primary application host and from a proxy backup host. The direct
SCSI backup and recover feature allows you to protect BCV devices from a proxy
backup host as a raw backup.

System requirements
The direct SCSI feature is only supported on Solaris storage nodes, and you must
have EMC Solution Enabler version 5.5 or later installed.
The following hardware devices are supported:
◆

Raw device path of a SCSI device

◆

Symmetrix device

Note: Be aware that since backup and recover is performed on the proxy client (which is also a
storage node), and a Symmetrix device is accessible, data is accessed from the proxy client,
which may not be the client that originally created the data.

Unsupported features
If performing backup and recover over a SCSI bus, the following features are not
supported with NetWorker release 7.4:
◆

Archiving

◆

Save set consolidation

◆

Index browsing

◆

Conventional recovery by using the command line recover utility

◆

File-by-file recovery

◆

Conventional save set recovery by using the command line recover utility

The EMC Symmetrix device is supported for use with SCSI backup and recover, but
no other vendor device is supported with this feature as of NetWorker release 7.4.
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Performing direct SCSI backup
When performing Direct SCSI backup, you can perform either of the following:
◆

Single device backup

◆

Backup of a device set that consists of a list of devices specified in a resource file.

If the device is vendor-specific, the program loads the vendor-specific plug-in shared
library.
The NetWorker software uses the nsrscsi_save program to start the backup thread for
each device to be backed up. Each backup thread performs the following operations:

!

◆

Finds the host accessible raw device path for the given vendor device.

◆

Starts a save session with the NetWorker server.

◆

Runs scsi asm on the raw device path to move data from the SCSI device to a
storage node (nsrmmd) by using SCSI commands.

IMPORTANT
Before starting a backup, set the backup device to offline or read-only mode, and
the file systems that reside on the device to read-only. If the device is a Symmetrix
BCV, keep the BCV detached from the standard during the backup.

Backing up data on a Symmetrix BCV device
To back up data on a Symmetrix BCV device:
1. Create the .res file (for example, /nsr/res/deviceset.res) if performing backup on
a device set. Within the file, do the following:
a. Specify a list of devices to be backed up as part of a device set. Associate the
device set with each entry in the file. You can identify the devices by their
Symmetrix volume IDs (SYMMIDs) and category names, as in the following
example:
000182504581/011 ##
000182504581/012 ##
# This is a comment
000182504581/07D ##
000182504581/07E ##

These two will be
grouped as OracleDisks
line
These two will be
grouped as ExchDisks

b. Store this file in the nsr/res directory on the storage node.
2. For the AppHost or the host that controls the data, perform either of the following
steps:
• Create a new NetWorker Client resource. “Task 6: Create a backup Client
resource” on page 59 provides more information.
• Edit an existing client by right-clicking the client in the in the Configuration
screen of the Administration window and selecting Properties.
3. For the Save Set attribute, do one of the following:
• If performing multiple device backup, type the following:
<<emc_symm>>/{deviceset.res}
where <<emc_symm>> is the name of the device and {deviceset.res} is the name
of the .res file.

Performing direct SCSI backup
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• If performing single device backup without the .res file, type the following:
<<emc_symm>>
where <<emc_symm>> is the name of the device.
4. On the Apps and Modules tab, select SCSI for the Proxy backup type attribute.
5. In the Proxy Backup host attribute, enter the name of the storage node on which
the nsrscsi_save command will be run.
6. Click OK.
Once you create the Client resource, the nsrscsi_save program reads the .res file for
all the device IDs listed or reads the ID for the single device, and starts the backup
thread. The backup thread performs the following:
◆

validates the SYMMIDs

◆

finds the host-accessible raw device path for the SYMMIDs

◆

starts the save session with the NetWorker server.

The NetWorker software creates a save set for each category name, but does not
create an index for the content within the BCV.

Backing up data on a raw device
The process for backing up raw device data is similar to backing up data on a BCV
device. To perform a SCSI backup of a raw device:
7. For the AppHost or the host that controls the data, perform either of the following
steps:
• Create a new NetWorker Client resource. “Task 6: Create a backup Client
resource” on page 59 provides more information.
• Edit an existing client by right-clicking the client in the in the Configuration
screen of the Administration window and selecting Properties.
8. For the Save Set attribute, type the path for the raw device with the device name.
For example, if the device name is c1t2d0s2 and the path is /dev/rdsk, type the
following:
/dev/rdsk/c1t2d0s2

9. On the Apps and Modules tab, select SCSI for the Proxy backup type attribute.
10. In the Proxy Backup host attribute, enter the name of the storage node on which
the nsrscsi_save command will be run.
11. Click OK.
Once you create the Client resource, associate it to scheduled group. At the scheduled
time, the group starts the nsrscsi_save program on the storage node.
The nsrscsi_save program starts the backup thread. For a single device backup, a
single backup thread is created by nsrscsi_save. The program starts the save session
with the NetWorker server.
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Backing up data from the command line
To perform backup from the command line, run the following command:
nsrscsi_save [ -c clientname ] [ -g group ] [ -N save-set-name ]
[ -I input filename ] [ -s server ] [ -b pool ] [-e expiration ]
[ -y retention time ] Path

where:
◆

-c clientname is the client name for starting the save session. The client name is the
local host by default. If using the local host, you do not need to specify the client
name.
Note: The client-name is not necessarily the host accessible device. For example, a
Symmetrix BCV device may be accessible on a different host for backup than the client
where the standard device is attached (the client that you want to register the backup
against).

◆

-N save-set-name is the name of the save set. The save set name is the pathname by
default. If the pathname is the name of the device set, -N is ignored.

◆

-I input-filename is the filepathname for the file that contains the list of devices to
be backed up (for example, /tmp/testdisks.res). If the input-filename is not
specified, then the default input-filename is taken from device-set-name. For
example, if the device-set-name is oracledisks, the input-filename would be
/nsr/res/oracledisks.res. Also, if device-set-name is used in the path but -I is not
specified, the default location is set to /nsr/res/device-set-name.res.
Note: The input file should contain only entries for the devices that need to be backed up.
Multiple device entries should be separated by a new line. When -I is specified,
device-set-name should also be specified.

◆

Path can be any of the following formats:
• For a raw device path: /dev/rdsk/c1t2d0s2
• For a device-set-name: {OracleDevices}
Note: The braces are mandatory to distinguish device-set-name from a single device path.

◆

-g group is used by savegrp and savefs to specify the group of the save. It is also
used by the NetWorker server to select the specific media pool.

◆

-b pool specifies a particular destination pool for the save. All the save sessions go
to the same pool.

Performing direct SCSI recover
Direct SCSI recover is performed by using the nsrscsi_recover program. This
program starts the recover thread for each save set to be recovered. From the
command line, you can recover single save sets, or multiple save sets specified in a
resource file, with a unique destination for each save set. If the device being recovered
from is vendor-specific, the program loads the vendor-specific plug-in DLL.

Performing direct SCSI recover
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Each recover thread performs the following operations:

!

◆

Finds the host accessible raw device path for the given target vendor device.

◆

Starts a recover session with the NetWorker server.

◆

Runs scsi asm on the raw device path to move data from the storage node
(nsrmmd) to a raw device via SCSI CDB commands.

IMPORTANT
Before starting the recovery, set the backup device to offline or read-only mode
from the application host, and the file systems that reside on the device to
read-only. If the device is a Symmetrix BCV, keep the BCV detached from the
standard during the backup.
Also, note that the data on the target device being used for recovery will be
rewritten and the original data will be lost when using the target device ID and
raw device path for recovery.

Recovering data to a Symmetrix BCV device
Recovering data on a Symmetrix BCV device must be performed from the command
line. You cannot use NMC to perform this function.
To recover a single save set:
1. Perform an mminfo query on the device set name, for example:
mminfo -avVot -q "name=xxx"

The query returns a list of Save Set IDs (SSIDs) that are part of the device set.
2. Find the SSID (for example, 3697521281), and then run the following command:
mminfo -aS -q "ssid=3697521281"

The list of connected save sets displays. The connected save sets are the save sets
that are backed up as part of this device set.
3. Select a save set from this list.
4. If applicable, prepare the target device and retrieve the target vendor device ID.
The target vendor device ID can be original.
5. Run the following command:
nsrscsi_recover -S ssid -T target device

where ssid is the ID for the save set being recovered and target device is the
SYMMID and the device ID (for example, 0034567/0366, where 0034567 is the
SYMMID and 0366 is the device ID).
The NetWorker software recovers the contents of the save set to the destination
location. The destination location is the original location by default.
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To recover multiple save sets:
1. Perform an mminfo query on the device set name. For example:
mminfo -avVot -q "name=xxx".

The query returns a list of Save Set IDs (SSIDs) that are part of the device set.
2. Find the appropriate SSID (for example, 3697521281), and then run the following
command:
mminfo -aS -q "ssid=3697521281",

The list of connected save sets displays. The connected save sets are the save sets
that are backed up as part of this device set.
3. Choose the SSIDs from the list of connected save sets (in the following example,
the SSIDs are 3697521281 and 3680744065):
mminfo -avVot -r "volume,name,savetime(25),ssid" |grep
oraclediskset
scip2b081.legato.com.001 oraclediskset:000187910217/0365 11/21/06
06:14:25 PM 3697521281
scip2b081.legato.com.001.RO oraclediskset:000187910217/0365
11/21/06 06:14:25 PM 3697521281
scip2b081.legato.com.001 oraclediskset:000187910217/0366 11/21/06
06:14:26 PM 3680744065
scip2b081.legato.com.001.RO oraclediskset:000187910217/0366
11/21/06 06:14:26 PM 3680744065

4. If applicable, prepare all target devices and retrieve the target vendor device IDs.
The target vendor device ID can be the same as the original backup device ID.
5. Create a .res file under /nsr/res (for example, /nsr/res/restorelist.res), and
specify an entry for each save set to be recovered.
Note: Each entry in the .res file must have an SSID for every save set being recovered,
mapped to a target device (SYMMID/Device ID), as in the following example:
3697521281=>000187910217/0366
3680744065=>000187910217/0365

6. Run the recover command:
nsrscsi_recover -I input filename

where input filename is the name and location of the .res file (for example,
nsr/dev/restorelist.res).
Once you create the Client resource, the nsrscsi_recover program reads the .res file
for all the device IDs listed, and starts the recover thread. The recover thread
validates the device IDs, finds the host-accessible raw device path for the IDs, and
starts the recover session with the NetWorker server.

Performing direct SCSI recover
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Recovering data to a raw device
To recover data on a raw device:
1. Perform an mminfo query and select an SSID (for example, 3697521281), as in the
following example:
mminfo -aVvot
volume
client size level name
ssid save time
date
time
first
last file rec volid

browse clretent
total fl

scip2b081.legato.com.001 scip2b081.legato.com 8839 MB full
/dev/rdsk/c1t1d0s2
3697521281 1164161665
11/21/06 06:14:25 PM 12/21/06 11/21/07
0 9051405795
0
0 3731075692 9051405796 cr

2. If applicable, prepare the target device and retrieve the target raw device path.
The target raw device path can be the same as the original raw device path.
3. Run the following command:
nsrscsi_recover -S ssid -T target device

where ssid is the ID for the save set being recovered and target device is the raw
device path (for example, /dev/rdsk/c1t1d0s2).
The NetWorker software recovers the contents of the save set to the destination
location. The destination location is the original location by default.

!

IMPORTANT
The destination path for recover must be specified and it must be a raw device or a
vendor device.

Licensing
EMC Solution Enabler version 5.5 or later is required to use the Direct SCSI feature.
There are no other licensing requirements for this feature.
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Access control settings
Access control settings protect resources against unauthorized access.

User authentication
User authentication settings control the process of verifying an identity claimed by a
user when accessing the product.
Default accounts
Table 122 on page 770 describes the default login accounts.
Table 122

Login accounts
User account

Description

root@localhost — for NetWorker server on UNIX platforms

User ‘root’ on the NetWorker server host is
automatically added to the Administrator list.

system@localhost — Windows platforms

User ‘root’ on the NetWorker server host is
automatically added to the Administrator list.

*@*

All users at all hosts are added to the ‘users’
attribute of an instance of the ‘NSR Usergroup’
resource. All privileges associated with that ‘NSR
Usergroup’ instance go to ‘all users @ all hosts’
with no explicit denial of access.

administrator

Default NMC user. First login procedure forces
password change.

Authentication configuration
The NMC Console has two modes of authentication: native mode and LDAP mode.
By default, NMC user authentication is set to native mode.
You can set up user authentication in LDAP mode by using the Configure Login
Authentication wizard. You can also revert back to native NetWorker user
authentication by using the wizard.
“Managing NetWorker Console server users” on page 406 provides more
information.

User authorization
User authorization settings control the privileges that are granted to a user when
accessing a resource managed by the product.
“Console Server Management” on page 405 describes how to set up users and to
control user permissions for the Console server.
“Managing server access” on page 440 and “NetWorker User Groups” on page 442
describe how to set up users and user groups on the NetWorker server.
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Component access control
Component access control settings define the control over access to the product by
external and internal systems or components.
Component authentication
NetWorker hosts and daemons are authenticated by using the nsrauth mechanism,
which is available for hosts that run NetWorker release 7.3 or later. The nsrauth
authentication mechanism is a strong authentication and is based on the Secure
Sockets Layer (SSL) protocol provided by the OpenSSL library or RSA BSAFE SSL,
depending on the platform.
Each NetWorker host has a nsrexecd service, which provides authentication services.
Each nsrexecd service has its own private key and self-signed certificate for
authentication. The private key is generated by nsrexecd when it starts. The private
key can also be loaded from a file. The corresponding self-signed certificate is
generated by the private key. The private key is RSA and is 1024 bits in length. The
encryption method that is used once an SSL session is set up is AES-128.
The session information sent over the SSL connection includes:
◆

Session keys

◆

Session ID

◆

User's information

◆

User's NetWorker permissions

“NetWorker authentication” on page 476 provides more information about
configuring nsrauth authentication.
Component authorization
NetWorker uses the contents of the /nsr/res/servers file for UNIX or the
Install_path\res\servers file for Windows, on each NetWorker client to control the
client-tasking rights.
The client-tasking rights are the rights to request the execution of a program on
another client and may be any of the following:
◆

Server that performs an archive request

◆

Scheduled backup

◆

Another client that requests a directed recover

If the server file is empty, then any NetWorker host can have tasking rights.
◆

Add the names of the additional NetWorker servers to the server file so that the
client with the tasking rights can back up to other NetWorker servers.

◆

Add the client names to the servers file so that other clients can perform directed
recovers to the client with the tasking rights.
• You can add the names of NetWorker servers to the server file during the
software installation.
• To add additional hosts later, use a text editor and add the hostnames to the
server file.
• After adding the additional hosts in the server file, restart the nsrexecd on that
client to enable permissions for the additional server hosts.

Access control settings
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Log settings
A log is a chronological record that helps to examine the sequence of activities
surrounding or leading up to an operation, procedure, or event in a security-related
transaction from beginning to end.

Log files and their descriptions
Table 123 on page 772 shows the log files location.
Table 123

Log files
Component

Location

Server and client daemons

/nsr/logs/daemon.raw

Server-generated syslog
messages and daemon.notice

/nsr/logs/messages

Server-generated syslog
messages local0.notice and local0.alert

/nsr/logs/summary

NMC gstd logs

<install path>/logs/gstd.raw

NMC Web Server logs

<install path>/logs/web_output

NMC DB logs

<install path>/logs/db_output

Log management and retrieval
This section explains how to view and manage logs.
Viewing log files
For NetWorker release 7.4 and later, the following log files can be viewed by using the
non-interactive command line program, nsr_render_log (for UNIX and Linux) or
nsr_render_log.exe (for Microsoft Windows):
◆

Daemon log file: daemon.raw

◆

gstd log file: gstd.raw

◆

User log file: networkr.raw (for Microsoft Windows only)

“Viewing log files” on page 661 provides information about using the nsr_render_log
program.
Managing log files
The Console server gstd log file can be managed with the various Console server
environment variables. “Setting environment variables” on page 419 provides more
information.
The NetWorker server daemon.raw log file can be managed with NetWorker server
environment variables. “Message log management” on page 463 provides more
information.
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Communication security settings
Communication security settings enable the establishment of secure communication
channels between:
◆

Product components

◆

Product components and external systems or components

Port usage
Table 124 on page 773 lists all components, protocols, ports, and services.
Table 124

Port usage

Component

Service

Service Port Range

Protocol

Port

Description

TCP

7937 - 9936

This is the default range of ports that all
NetWorker daemons should use when they
need to start a service. This range can be
configured. Since the daemons may start in
any order, there is no guarantee that any one
daemon will always use any singular port
from this range.

nsrd

RPC

TCP

1 from SPR

nsrindexd

RPC

TCP

1 from SPR

nsrmmdbd

RPC

TCP

1 from SPR

nsrmmgd

RPC

TCP

1 from SPR

nsrjobd

RPC

TCP

1 from SPR

nsrexecd

RPC

TCP

nsrlcpd

RPC

TCP

Per instance running.

nsrmmd

RPC

TCP

1 from SPR, per instance running.

NMC Web Server

HTTP

TCP

9000*

Jumpstart to launch NMC

NMC

GSTD

TCP

9001*

Communicates between Java client and main
daemon.

NMC SQLAnywhere DB

DB

2638*

Database listening port

7937, 7938

Plus 2 from SPR. Regardless of SPR,
nsrexecd always listens to these two ports.
7938 must be allowed through a firewall,
either by NetWorker or another portmapping
service, or NetWorker will not work.

Communication security settings
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Encrypting backup data
Backup and archive data on UNIX and Windows hosts can be encrypted with the
AES Application Specific Module (ASM). The AES ASM provides 256-bit data
encryption. Backup data is encrypted based on a user-defined pass phrase.
Do not use AES encryption when backing up files that are encrypted using the
Microsoft Windows Encrypting File System (EFS).

Encryption for cloud backup data
A cloud backup device can also be set up to encrypt data sent to the cloud. If
encryption is already enabled for the NetWorker host and you enable encryption on
the cloud backup device, backups will be slower because encryption functions will
occur twice. “Support for cloud backup devices” on page 120 provides more
information about cloud backups.
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This glossary provides definitions for terms used in this guide.

A
ACL (Access Control
List)
active group
Administrators group

agent

annotation

A list that specifies the permissions assigned to a specific file or directory.

A NetWorker backup group that has its Autostart attribute enabled.
A Microsoft Windows user group whose members have the rights and privileges of
users in other groups, plus the ability to create and manage the users and groups in
the domain.
A term used by Sun Microsystems to denote a cluster server. Also known as a package
(HP-UX), and a virtual server (Microsoft).
1. A comment associated with an archive save set.
2. A comment associated with an event.

archive

Backing up directories or files to an archive volume to free disk space. Archived data
is not recyclable. See also ”groom.”

archive request

A NetWorker resource used to schedule and manage archiving.

archive volume

A volume used to store archive data. You cannot store archive data on a backup or
cloned volume. See also ”backup volume.” or See ”clone volume.”

ASM (Application
Specific Module)

Atmos
attribute

A program that is used in a directive to specify how a set of files or directories is to be
backed up or recovered. For example, compressasm is a NetWorker directive used to
compress files.
EMC’s cloud storage offering.
A feature, such as an entry field, of a resource. See also ”resource.”
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authentication

authorization
authorization code
autochanger
autochanger sharing
Auto Media
Management

The process by which a user or software process is determined to be trusted or not
trusted.
Privileges assigned to users of the Console and NetWorker server.
A unique code that unlocks the NetWorker software for permanent use.
See ”library.”
See ”library sharing.”
A feature that enables the storage device to automatically label, mount, and overwrite
an unlabeled or recyclable volume.

B
backup

An operation that saves data to a volume.

backup cycle

The period of time from one level full backup to the next level full backup.

backup group

See ”group.”

backup level

See ”level.”

Backup Operators
group

backup volume

base enabler code
bootstrap

browse policy

A Microsoft Windows user group that can log in to a domain from a computer or a
server, and back up and restore its data. Backup operators can also shut down servers
or computers.
A volume used to store backup data. You cannot store backup data on an archive or
cloned volume. See ”archive volume.” or See ”clone volume.”
See ”enabler code.”
A save set that is essential for NetWorker disaster recovery. A bootstrap is composed
of two components that reside on the NetWorker server: the media database, and the
resource database. The bootstrap also provides information that is essential for
recovering client file indexes. See ”media database.” See ”resource database.” See
”client file index.”
A policy that determines how long backed up data is available for quick access. See
”retention policy.”

C
canned report
carousel
client

client file index

client-initiated
backup
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A preconfigured report that can be tailored by the user.
See ”library.”
A computer, workstation, or fileserver whose data can be backed up or recovered.
See ”Client resource.”
A database that tracks every database object, file, or file system that is backed up. The
NetWorker server maintains a single client index file for each client. See ”file system.”
See ”manual backup.”

EMC NetWorker Release 7.6 Service Pack 2 Administration Guide

Glossary

Client resource

Identifies the save sets to be backed up on a client. The Client resource also specifies
information about the backup, such as the schedule, browse policy, and retention
policy for the save sets. Multiple Client resources can be configured for one client
computer. For example, you could create one Client resource to back up business data
and another to back up operating system files. See also ”client.”

clone

A reliable copy of backed up data. Unlike volumes created with a simple copy
command, clone volumes can be used in exactly the same way as the original backup
volume. Single save sets or entire volumes can be cloned.

clone volume

A volume used to store clone data. You cannot store clone data on either an archive or
a backup volume. See ”archive volume.” See ”backup volume.”

cloud

For NetWorker, a cloud refers to an EMC Atmos based configuration of backup disks.

cluster

Two or more nodes that are connected and appear to network users as a single, highly
available system.

command-prompt
CIF (Common Internet
File System)
connection port

The shell prompt, where you enter commands.
Formerly known as Server Message Block (SMB). A message format used by DOS
and Windows to share files, directories, and devices.
A port that NetWorker processes use to perform backup and recovery sessions
through a firewall.

Console Application
Administrator

A Console server user role whose members can configure features (except security) in
the Console sever application.

Console Security
Administrator

A Console server user role whose members can add Console users and assign them to
Console roles.

Console Server

NetWorker servers and clients are managed from the NetWorker Console server. The
Console server also provides reporting and monitoring capabilities for all NetWorker
servers and clients.

consolidate

continued save set
control zone

To create a full backup by merging a new level 1 backup with the last full level
backup.
Save set data that is continued from a previous volume.
A group of datazones managed by the NetWorker software.

D
daemon

data retention policy
datawheel
datazone
DDS

A process that runs in the background and performs a specified operation at
predefined times or in response to certain events.
See ”retention policy.”
See ”library.”
A group of computers administered by a NetWorker server.
See ”DDS (Dynamic Drive Sharing).”
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device

1. A storage unit that reads from and writes to backup volumes. A storage unit can
be a tape device, optical drive, autochanger, or file connected to the server or
storage node. See ”library.” See ”server.” See ”storage node.”
2. When dynamic drive sharing (DDS) is enabled, refers to the access path to the
physical drive.

Device Central
DFS (Distributed File
System)
DFS component

The interface from which one can manage all NetWorker libraries.
A Microsoft Windows add-on that allows you to create a logical directory of shared
directories that span multiple machines across a network.
1. A namespace for files and DFS links, called a DFS root.
2. A connection to a shared file or folder, called a DFS child node

DAR (Direct Access
Restore)

An NDMP data recovery operation that allows you to recover data in the middle of a
tape set without having to parse the tape set sequentially. This reduces recovery time
of large backups.

directed recovery

A recovery method used to recover data that originated on one computer to another
computer.

directive

Instructions to take special actions on a given set of files for a specified client during a
backup.

DMA (Data
Management
Application)
document mode

Initiates a backup or recovery request through the NDMP connection.

A mode that displays static reports (as charts or tables) in a format that resembles the
Print Preview view displayed by a PDF file viewer.

domain controller

A computer that manages user interactions with a domain, including logon,
authentication, directory searches, and access to other shared resources.

drill-down reports

Organizes basic report data in terms of granularity. For example, a user could start
with group summary data, then "drill down" to data for a client within the group, and
then to data for a selected save set.

drive

DSA (Data Server
Agent)

DSA save set
DSP (Data Service
Provider)
DDS (Dynamic Drive
Sharing)

When dynamic drive sharing (DDS) is enabled, refers to the physical backup object,
such as a tape drive, disk, or file. See ”device.”
An agent save or agent recover between a NetWorker server and a non-NetWorker
client. An example of a DSA is an NDMP host that generates proprietary save data
and sends that data to a NetWorker storage device to have a save set associated to it.
Save sets of an NDMP client that are backed up to non-NDMP tape device.
Controls access to disk storage during an NDMP back up.

A feature that allows NetWorker software to recognize shared drives.

E
enabler code

778

A code that allow you to run NetWorker software.
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enterprise

Computers and folders organized into a tree-based visual representation.

event

A notification of an application event. This notification contains information that may
require user action.

exit code

An indicator that specifies whether a backup or recovery session succeeded. An exit
code of zero (0) indicates the session completed successfully. An exit code other than
zero indicates that the session did not complete successfully.

expiration date
expired save set

The date when a volume changes from read/write to read-only.
A save set that has reached its browse time and is no longer browsable.

F
file index
file system

See ”client file index.”
1. A file tree located on a specific disk partition or other mount point.
2. The entire set of all files.
3. A method of storing files.

firewall
folder
full backup

A system designed to prevent unauthorized access to or from a private network.
The graphical representation of a branching node in the Enterprise.
See ”level.”

G
groom
group

GST (Generic Services
Toolkit)

To remove the original files from a disk after an archive.
A client or group of clients configured to back up files to the NetWorker server at a
designated time of day.
Provides the underlying framework of the Console server.

H
heterogeneous
networks

Computers of different platforms that interact across the network.

highly available
system

A system that allows cluster-aware services to continue despite a hardware or
software failure.

high-water mark

The percentage of disk space that when filled, automatically starts the staging
process.

host authentication

host ID

A feature that provides encryption and verification services between NetWorker
hosts. See also ”user authentication.”
A serial number that uniquely identifies a computer.
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I
inactivity timeout

incremental
individual user
authentication
insertion time

Interactive mode

The number of minutes to wait before a client is considered to be unavailable for
backup.
See ”level.”
The process by which Console administrators restrict or grant user access to
NetWorker servers, based on Console usernames.
The time that the save set record was most recently introduced into the save set
database.
A mode that displays reports (as charts or tables) that users can interact with. For
example, one can sort, rearrange, and resize columns in a table-format report that was
run in this mode.

J
JAR (Java Archive)
Java

Java Plug-in
jukebox
JVM (Java Virtual
Machine)

A file that contains compressed components needed for a Java applet or application.
A high-level programming language. The Java Virtual machine (JVM) enables the
same, unmodified, Java program to run on most computer operating systems. See
”JVM (Java Virtual Machine).”
A JVM that can be used by a web browser to run Java applets.
See ”library.”
An execution environment for interpreting the Java programming language. Each
operating system runs a unique JVM to interpret Java code.

L
label

LDAP (Lightweight
Directory Access
Protocol)
legacy method

level

A NetWorker assigned label that uniquely identifies a volume. Templates can be used
to define label parameters.
A set of protocols for accessing information directories. LDAP is based on the X.500
standard, but is significantly simpler.

The use of special-case Microsoft APIs to back up and recover operating system
components, services, and applications.
A measurement that determines how much data is saved during a scheduled or ad
hoc backup.
A full (f) backup backs up all files, regardless of whether they have changed. Levels
one through nine [1-9] back up files that have changed since the last lower numbered
backup level. An incremental (incr) backup backs up only files that have changed
since the last backup.

library
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A mechanism that uses a robotic arm to move media among various components in a
device. The term library is synonymous with autochanger, autoloader, carousel,
datawheel, jukebox, and near-line storage.
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library sharing
license enabler
LLM (License
Manager)
local cluster client

locale settings

logical cluster client
logical device

low-water mark

LUS (EMC User SCSI)

Shared access of servers and storage nodes to the tape drives in a library.
A code that is required to run a feature or product.
An application that provides a central point for managing product licenses.

A NetWorker client that is not bound to a physical machine, but is instead managed
by a cluster manager. It is also referred to as a logical or virtual client.
Settings that specify the input and output formats for date and time, based on local
language conventions.
See ”virtual cluster client.”
A specific NetWorker device used in the integration of NetWorker software with
SmartMedia or AlphaStor. SmartMedia or AlphaStor assigns the logical device to an
actual device.
The percentage of disk space filled that, when reached, automatically stops the
staging process.
A proprietary device driver that sends arbitrary SCSI commands to an autochanger.

M
managed application
manual backup

A program that can be monitored and/or administered from the Console server.
A backup that a user performs from the client, also known as an unscheduled
backup. The user specifies the files, file systems, and directories to back up.

media

The physical storage medium, such as magnetic tape, optical disk, or file system to
which backup data is written.

media database

Indexed entries about the location and the life cycle status of all data and volumes
that the NetWorker server manages. See ”volume.”

media index
member

metadata

mount

See ”media database.”
A physical host in a cluster environment. Each member has its own IP address. A
member can also be a virtual server.
VSS-defined information that is passed from the writer to the requestor. Metadata
includes the writer name, a list of VSS components to back up, a list of components to
exclude from the backup, and the methods to use for recovery. See ”writer.” See
”requestor.” See ”VSS component.”
To make a volume physically available so that backup data can be written to it.

mount point

See ”volume mount point.”

multiplexing

To simultaneously write data from more than one save set to the same storage device.
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N
NDMP (Network Data
Management
Protocol)
NDMP data server
NDMP host
NDMP save set

An NDMP service that either reads from or writes to disk.
The host computer that executes the NDMP server application.
A save set of an NDMP client that is backed up to an NDMP tape device.

NDMP server

An instance of one or more NDMP services controlled by a single NDMP control
connection. Thus a data/tape/SCSI server is an NDMP server providing data, tape,
and SCSI services.

NDMP service

The virtual state machine on an NDMP host that is controlled by the DMA. Examples
of NDMP services include:

NDMP storage node

◆

A general server with direct attached storage (storage appliance)

◆

A system with one or more tape drives

◆

A software process that reads two datastreams and multiplexes them into one
stream

A host having NDMP services or any open system having NDMP services installed.
For instance, Netapp Filer and EMC Filer.

near-line storage

See ”library.”

NFS (Network File
System)

A client/server application that allows users to access shared files stored on
networked computers of different types.

NetWorker client

See ”client.”

NetWorker Console
server

See ”Console Server.”

NetWorker
Management
Console

See ”Console Server.”

NetWorker server

NetWorker
Administrator
NetWorker storage
node
NFS server
node
nonclone pool
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A TCP/IP-based protocol that specifies how heterogeneous network components
communicate for the purposes of backup and recovery.

The host running the NetWorker server software, which contains the online indexes
and provides backup and recovery services to the clients on the same network. See
also ”online indexes.”
A default NetWorker server user group that can add, change, or delete NetWorker
server user groups.
See ”storage node.”

A computer that contains exported file systems that NFS clients can access.
See ”member.”
Pools that contain data that has not been cloned.
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non-NDMP device
notification
nsrd
nsrhost

A device that is not configured as an NDMP type of device.
A message sent to the NetWorker administrator about important NetWorker events.
The master NetWorker server process.
The logical hostname of the NetWorker server.

O
online indexes

Databases on the NetWorker server that contain information about client backups
and backup volumes. See ”client file index.” See ”media database.”

operator

The person who monitors the server status, loads backup volumes into storage
devices, and executes day-to-day NetWorker tasks.

override

A backup level that takes place instead of the scheduled one.

P
package

packet filtering

A term used by HP-UX to denote a cluster server. Also known as an agent (Sun) or
virtual server (Microsoft).
A method of firewall protection that accepts or rejects packets entering or leaving the
network based on user-defined rules. See ”firewall.”

parallelism

A method of backing up or recovering data from several clients or save sets in
parallel.

pathname

Instructions for accessing a file. An absolute pathname indicates how to find a file
starting from the root directory. A relative pathname indicates how to find the file
starting from the current directory.

peer

permanent enabler

physical cluster client

physical host
policy

pool
PowerSnap

probe
purging

A NetWorker host that is involved in an authentication process with another
NetWorker host.
A code that allows the software to be authorized for permanent use. See ”temporary
enabler.” See ”authorization code.”
A NetWorker client that is bound to a physical host in the cluster and can have its
own resources (private or local).
A node or host that forms part of a cluster.
A set of constraints that specify how long data is available for recovery. Each Client
resource has a browse policy and a retention policy.
A feature to sort backup data to selected volumes.
EMC technology that provides point-in-time snapshots of data. NetWorker software
backs up data from the snapshot. This allows applications to continue to write data
during the backup operation, and ensures that open files are not omitted.
A query to determine the directories or files to back up on each client.
Deleting file entries from the client file index.
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R
recover
recyclable save set

To restore files from a backup volume to a client disk.
A save set whose browse and retention policies have expired. Recyclable save sets are
removed from the media database.

recyclable volume

A volume whose data has passed both its browse and retention policies and is now
available to be relabeled.

Registry

A Microsoft Windows database that centralizes all Windows settings and provides
security and control over system, security, and user account settings.

remote device
RPC (Remote
Procedure Call)

A storage device that is attached to a storage node.
The protocol that the NetWorker server uses to perform client requests over a
network.

repository

A Console database that contains configuration and reporting information.

requestor

A VSS-aware application that creates and destroys a shadow copy. NetWorker
software is a requestor. See ”shadow copy.”

resource

resource database

A component that describes the NetWorker server or its clients. Clients, devices,
schedules, groups, and policies are all NetWorker resources. Each resource has
attributes that define its properties.
A database of information about each resource.

resource owner

A logical cluster host that owns the resource. If a Cluster resource, such as a shared
disk, is not owned by a virtual host, it is assumed to be owned by the physical node
that hosts the resource.

retention policy

Determines how long backup data is available for recovery, though not necessarily
immediate recovery. See ”browse policy.”

retrieve
retry mechanism

roles

root

To locate and recover archived files and directories.
The action NetWorker software performs when client operations fail. This situation
might occur when the rate of transmission is either low or non-existent.
Used to assign user privileges to the Console. There are three roles: Console
Application Administrator, Console Security administrator, and the Console User.
See also ”user groups.”
1. (UNIX only) The UNIX superuser account.
2. (Microsoft Windows and UNIX) The highest level of the system directory
structure.

S
save
save set
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The command that backs up client files and makes entries in the online index.
A group of files or a file system that is backed up on storage media.
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save set consolidation

SSID (Save Set ID)

A process that performs a level 1 backup and merges it with the last full backup of a
save set to create a new full backup. See ”level.”
An internal identification number assigned to a save set.

save set recover

To recover data by specifying save sets rather than by browsing and selecting files or
directories.

save set status

An attribute that indicates whether a save set is browsable, recoverable, or recyclable.
The save set status also indicates whether the save set was successfully backed up.

save stream

scanner

server

The data and save set information being written to a storage volume during a
backup.
A command used to read a backup volume when the online indexes are no longer
available.
See ”NetWorker server.” See ”Console Server.”

server index

See client file index.

service port

A port used to listen for backup and recover requests from clients through a firewall.

shadow copy

A temporary, point-in-time copy of a volume created using VSS technology. See ”VSS
(Volume Shadow Copy Service).”

shared disk
shell prompt
silo

skip
snapshot
snapshot policy

snapup
SNMP (Simple
Network
Management
Protocol)

The storage disk that is shared among multiple nodes in a cluster.
A cue in a shell window where you enter a command.
A repository for holding hundreds or thousands of volumes. Silo volumes are
identified by bar codes, not by slot numbers.
A backup in which designated files are not backed up. See ”level.”
A point-in-time copy of data created during an instant backup.
A NetWorker resource used to configure backups using the NetWorker PowerSnap
Module software.
See ”backup.” Snapup is a term previously used by Avamar to refer to backup.
A protocol used to send messages to the administrator about NetWorker events.

staging

Moving data from one storage medium to a less-costly medium, and later removing
the data from its original location.

stand-alone

In a cluster environment, a NetWorker server that starts in noncluster (stand-alone)
mode.

stand-alone device
STL

A storage device that contains a single drive for backing up data.
Silo Tape Library.
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storage device

storage node

The hardware that reads and writes data during backup, recovery, or other
NetWorker operations.
A storage device physically attached to another computer whose backup operations
are controlled by the NetWorker server.

T
tape service

target sessions
temporary enabler

TCP/IP (Transmission
Control Protocol /
Internet Protocol)
trap

An NDMP DSP service that controls access to tape storage. A system can
simultaneously host multiple tape services corresponding to multiple backup
streams.
The number of backup sessions accepted by a backup device.
A code that allows operation of the software for an additional 45 days beyond the
evaluation period. See ”enabler code” and “permanent enabler.”
A standard set of communication protocols that connects hosts on the Internet.

Unsolicited notification sent from the SNMP agent to the network manager’s SNMP
event manager.

U
update enabler

user

A code that updates software from a previous release. Like other temporary enabler
codes, it expires after 45 days.
1. A NetWorker user who can back up and recover files from a computer.
2. A Console user who has standard access privileges to the Console server.

user authentication

A feature that validates user sign-on attempts. NetWorker can validate sign-on
attempts against either a central database, such as an LDAP database, or a local a
Console database. See also ”host authentication.”

user alias

The username seen by the NetWorker server when a Console user connects to the
NetWorker server.

user groups

Used to assign privileges to NetWorker users. See also ”roles.”

V
versions
virtual cluster client

virtual server

volume

786

The date-stamped collection of available backups for any single file.
A NetWorker client that is not permanently bound to a physical machine, but is
instead managed by a cluster manager. It can be bound to more than one physical
machine in the cluster and can own its own data disks. It is also referred to as a logical
cluster client or a virtual client.
A Microsoft term to denote a cluster server. Also known as an agent (Sun)or a
package (HP-UX).
1. The physical storage medium, such as magnetic tape, optical disk, or file system
to which backup data is written.
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2. An identifiable unit of data storage that may reside on one or more computer
disks.
volume ID
volume mount point

volume name
volume pool
VSS (Volume Shadow
Copy Service)

VSS component

An internal identification that NetWorker software assigns to a backup volume.
A disk volume that is grafted into the namespace of a host disk volume. This allows
multiple disk volumes to be linked into a single directory tree, and a single disk or
partition to be linked to more than one directory tree.
The name assigned to a backup volume when it is labeled. See ”label.”
See ”pool.”
Microsoft technology that creates a point-in-time snapshot of a disk volume.
NetWorker software backs up data from the snapshot. This allows applications to
continue to write data during the backup operation, and ensures that open files are
not omitted
A subordinate unit of a writer. See ”writer.”

W
writer

A database, system service, or application code that works with VSS to provide
metadata about what to back up and how to handle VSS components and
applications during backup and restore. See ”metadata” and “VSS component.”
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A
aborting a recover 672
ACPI
NetWorker support 740
OnNow 740
recover considerations 741
scheduled backup considerations 741
actions, notifications 450
Active Directory
backup 734
domain controller 734
explained 734
recover 734
prerequisites 346
SYSTEM STATE save set 708, 734
adding
annotation 391
enabler code 423
folder 429
host 428
license 423
multiple hosts 431
addresses
server, changing 695
Administration window 38
administration window
opening 40
administrator
adding 441
privileges 433, 440
Windows groups and NetWorker privileges 442
administrators
group 45
Advanced Configuration and Power Interface. See ACPI
Advanced File Type Device
concurrent access 260
concurrent operations 250
notification 252
retention policy 252
simultaneous recovery of save sets 260
aes encrypted data
implementing 77
recovering 328

AFTD load balancing 253
AIX
EMC AutoStart, using with 494, 497
alert priority 390, 398, 401
alerts
lists priority, category, time, and message 394
Alias attribute 687
aliases, host sharing restriction 670
AlphaStor
firewall issues 722
annotation
adding 391
attribute 390
icon 391
viewing 391
ansrd service 49
application data
recovering on NetWorker client
UNIX 759
application information field
Auspex 565
EMC 562, 563
NetApp 559
application specific module (ASM) 178
archive
changing time of 211
request, starting automatically later 403
stopping request in progress 403
Archive attribute 151
Archive button 45
archiving
archive pools
errors 697
archive requests
creating 210
defined 209
deleting 211
disabling 215
editing 211
archive services
enabling 208
archive volume pool 204
compared to backups 204
copying an archive request 211
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disable scheduled archive 403
enabling 206, 207
grooming files 204
indexed 206
licensing 204
managing 215
manual 208
naming archive requests, errors 697
NDMP 526
NetWorker User program
toolbar function 45
nonindexed 206
nsrarchive program considerations 697
permissions 206
permissions
Archive feature 207
pools
configuration 190
creating 196
types of pools 207
remote requests, failure 696
requesting an archive 402
requesting an archive’s status 394
requirements 204
retrieving from client machine 212
save sets 204
multiple 697
retrieving 212, 213
scheduled 209
scheduling 215
starting 215
stopping 215
time change 211
tracking entries 205
troubleshooting 696
viewing details 215
volumes, cloning 229
ASM (application specific module) 178
ASR save set 584, 711
ASR. See Automated System Recovery
attribute
Administrator 441
annotation 390
auth code 423
category 389
enabler code 423
Grooming
limitation 210
message 390
note 390
priority of managed event 389
See also specific attribute name
server name 389
time 389
auth code attribute 423
authentication
considerations for 476
login 406
nsrauth 476
oldauth 476
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authorization code
error message 699
Auto Media Management
recyclable volumes 161
auto media verification
media position errors 667
Autochanger parallelism 438
autochangers
AIX considerations 752
attributes
new 677
Auspex support 565
autodetection 678
control ports access 680
destination component 678
EMC Celerra support 561
EMC IP4700 support 563
HP-UX considerations 750
installation, HP-UX considerations 747
maintenance commands 678
NDMP support 530, 531
NetApp support 558
sharing
NDMP clients 533
sharing with NDMP support 533
STK-9840 752
Automated System Recovery
2008, 2008 R2, Windows 7 595
ASR save set 584, 711
cluster database, special handling 592
COM+ database, special handling 592
disk quota database, special handling 592
documentation 584
FAT16 partitions 586
NetWorker software support 584
OEM recovery CD 586
overview 584
recovering a client 590
scheduled backup of ASR save set 587, 588, 589, 614
Sun StorageTek EBS software support 584
usage overview 585
verifying client recovery 593
WMI database, special handling 592
Autorestart attribute 133, 495
Autostart attribute 133

B
back ups, manual 80
backing up Console 79
backing up renamed directories 60, 96
Backup button 45
backup configuration wizard 55
backup groups. See groups
backup levels
1-9 147
described 147
options 147
overriding 145
planning 147, 149
types
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consolidated 142, 147, 149, 150, 153
full 147, 149, 150, 670
incremental 147
level 150
skip 147
usage 149, 150
backup schedules. See schedules
backups
Backup and Recover Server service 446
balancing resources 130, 143
bootstrap 138
client-initiated 189
commands 86
example 88
savepnpc program 91
completed 138
consolidated 142
customization scripts 87
cycle, using levels 141
data in a cluster environment 492
database in a cluster environment 494
directives 170
failed 85
filesystems 143
force incremental 136
groups. See groups
hard links 85
incremental
pool for 189
large client filesystems 485
large filesystems 144
levels 149, 156
log file 85
managing 137
manual 54, 65
policies 167
pool for 189
NDMP 525
consideration with Auspex 564
NetWorker cluster clients 493
NetWorker User program
browse windows 45
nonscheduled 54, 65
nsrndmp_save command, using 539, 540
online indexes 150
operations
stopping 666
operators group 45, 446
permissions, backup operators group 446
pools 184
previewing 137
recoveries 665
RPC errors 672
save sets. See save sets
server, forced 674
time intervals, setting 135
troubleshooting 665
types of backups. See backup levels
virtual server 493
Windows NT registry 67

bar chart 364
basic reports 356
best practices for cloud backups 121
BlueArc
requirements 566
BMR support
configuring a client 474, 655
establishing the HomeBase Server 436
recovery process 328, 656
specifying profile options 474, 655
bootstrap
emailing 138
NDMP limitation 525
pools 186
printing 138
failure 674
boot-time file 693
browse policies
about 157, 158
client file index growth 455
clones, storage nodes 231
defined 158
save set recoveries 338, 339
usage 158
browse windows
described 45
toolbar 45
browser
unresponsive 699

C
capture of managed event 389
case sensitivity 382, 419
category attribute of managed event 389
centralized
license management 37
Certificate Server
recovery prerequisites 346
SYSTEM STATE save set 708
certified protocols 694
changing
name of folder 430
password 412
changing password, user 412
changing servers 46
characters
illegal 429, 431
characters, not permitted 408, 429, 431
chart formats 361
checkpoint restart backups 69
CHKDSK, running 65
client 470
client alias, changing 669
client backup configuration wizard 55
client file index
backup level, pool for 189
browse policies 158, 459
checking 671
clones and storage nodes 231
cross-checking 457
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defined 454
entries
adding 455
removing 455, 459, 461
growth 455
location, designating 458
managing size 459
operations
backups 150
checking 455
moving 459
recovery 316, 337
policies 459
pools 186
restoration 338
save sets
cycles, removing 460
entries 161
removing 459
size 454
management 459
notification 671
Client parallelism 437
Client Retries attribute 133
client-initiated backups
pool for 189
clients
aliases, problems 669
backup commands 86
backups
ad-hoc 49
scheduled 49
client ID
creating new client 340
client/server communication errors 689
cloning
examples 225
cluster, backup 493
configuration 470
defined 470
DHCP 446
DNS name resolution 446
editing 470
groups 130
large filesystems 144
manual backups 54
multiple 485
NetWorker
definition of 470
NetWorker User program 44
of NetWorker server 79
operations
archive retrieve 212
backing up renamed clients 671
backups 485
creating 470
editing 470, 471, 477, 478, 481
indexes, moving 459
installation 470
manual backups 54
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recovery, failure 671
policies, multiple 164
priority 487
programs 49
save sets 485
services 49
Solaris binary location 744
clone pools, configuring 190
Clone reports 355, 370, 371
Clone Volumes dialog box 227
cloning
archives 229
defined 218
destination volume, defined 218
examples 225
manual 223
online indexes, storage nodes 231
recovery
save sets 228
volumes 227
save sets 219, 223
manually 225
performing 223
source volume, defined 218
storage nodes
online indexes 231
volumes 227
creating 227
details, viewing 227
process 227
cloning to cloud 125
cloud
best practices 121
cloning 125
compared to other device types 120
data consumption information 124
prerequisites 120
reports 379
setting up a cloud device 122
staging 125
support for 120
cluster
performance issues 516
Cluster Server
recovery prerequisites 346
SYSTEM STATE save set 708
clusters
backups 494, 496
client 493
data 492
database 494
clients 495
data corruption 508
devices 507
jbconfig program considerations 509
MC/ServiceGuard 496
recovery types 502
storage node 506
tape libraries 507
virtual client backing up to a local storage node 497
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virtual server backup 493
COM+ Database
recovery prerequisites 346
SYSTEM STATE save set 708
command
export 420
gst 51
savepsm 79
command line
reporting 357, 385, 386
reporting program 385
Common Device Interface
SCSI command 269
Completion Data Retention 353
completion data retention 353
completion message retention 353
compression, data 78
computer damage, recovery from 413
configuration
IP issues 694
configuring
Host reports 378
NetWorker Backup Statistics reports 367, 373, 375
reports 358
connection
problem 699
refused 699
connections, server
problem resolution 694
Console
environment variables 415
Console client
starting, after the first time 40
Console Configuration Wizard 420
console security administrator
resetting administrator password 412
Console software
as NetWorker client 79
improving performance 415
License Manager 424
load on CPU 416
logging on 39
managing window 36
URL 39
user roles in 406
Console window
opening 39
console window 37
consolidated backups 149, 153
consolidating save sets
nsrssc command 155
contacting server, problem with 699
Content Index Server
backing up 82, 83
backup 83
defined 82
recover 82, 348
SYSTEM DB save set 82, 348, 710
control zone 426
copying host 429

corrupted database 699
CPU load 416
creating
folder 429
host 428
label templates 200
pools 191
staging policies 236
criteria for organizing hosts 426
critical priority 390, 398, 401
cross-checking online indexes 457
cross-platform
name resolution 446
CSV 384
cutting and pasting host 429

D
daemon log file 463
daemon.log 464
damaged computer 413
data
backing up in a cluster environment 492
compression 78
encryption with aes ASM 77
life cycle
cloned data 226
managing 162
recovery, name conflicts 322
relocating, errors 672
sorting
into pools 185, 187, 188
to storage devices 190
verify 69
data compression 679
Data Domain deduplication 30
Data Retention dialog box 354
database
backing up 79
corrupted 699
corruption 699
delete failed 700
failed to store 700
fetch operation 699
database backup in a cluster environment 494
database, fetch operation failure 699
db-output 701
dbsrvr9 702
dbstop output 701
DDS (dynamic drive sharing)
clustering 511
robotics control 513
debug level 416, 419
debug messages
logging stopped 701
deduplication
Data Domain 30
default backup schedules 141
default pool 184, 188, 189
definition of
NetWorker client 470
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delete operation failed 700
deleting
folder 429
host 428
label templates 201
license 423
managed event note 391
multiple hosts 431
note 391
problem 700
staging policies 239
user 411
device 244
lists of 394
related messages 394
Device configuration wizard 247
devices
device drivers
maintenance commands 678
device ordering 269
correcting device order problems 271
detecting device order problems 270
disk label errors 673
filesystem
staging 236
labeling errors 673
load balancing 253
nonrewinding 681
pools 190
DFS (Distributed File System)
junctions 728
not in SYSTEM save sets 710
recover 730
DHCP (Dynamic Host Configuration Protocol)
database 83, 348
static IP address for NetWorker server 695
DHCP (dynamic host configuration protocol) 690
clients 446
dialog box
Data Retention 354
DinoStor TapeServer
configuration 567
directed recoveries 336
directed recovery
access 331
advantages 330
defined 329
NDMP 549
performing 325, 326, 336
recover program 334, 335
UNIX clients 336
use of 330
directives
ASM (application specific modules) 178
copying 171
creating 170
defined 170
deleting 171
editing 171
naming restrictions 668
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preconfigured 174
disabling
managed event capture 389
disabling user datagram protocol 417
disallowed characters 408, 429, 431
disappearing managed event 392, 701
disaster recovery 329
Windows 2003, XP 583
Windows 2008, 2008 R2, Windows 7 595
disk quota database
recovery prerequisites 346
SYSTEM DB save set 710
disk space
insufficient 699
disk space, gstd log file 416, 419, 702
disk space, gstd.log 419
display problem 700
displaying
annotation 391
reports 360
DNS
hostname alias, troubleshooting 669
DNS (Domain Name System) 690
host name determination 446
document view 366
domain controller
Active Directory, configured by 734
defined 734
encryption keys
not supported 735
drag-and-drop, column 40
drill-down reports, Managed Event 377
DSA 520
DSA and NDMP Tape Server distinctions 522
duplicating host 429
dynamic addressing 446
dynamic host configuration protocol (DHCP) 690

E
ECB (Event Control Block) 667
editing
clients 470
folder 430
label templates 201
pools 195
staging policies 238
user 412
emailing the bootstrap report 138
EMC AutoStart 494, 497
EMC, application information values 562
emergency priority 390, 398, 401
enabler code 423
enabler code, entering 423
enabler code, problem 700
enabling
debug information 416, 419
JavaScript 703
software 423
encrypting data
aes 77
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Encrypting File System
backup 734
directed recover 734
encryption keys 735
explained 734
not in SYSTEM save sets 710
recover 734
entering
enabler code 423
license 423
enterprise
button 37
enterprise hierarchy
adding folder 429
adding host 428
copying folder 430
copying host 429
deleting folder 429
deleting host 428
folder 426
host 426
managing host 428
managing multiple hosts 431
moving folder 430
moving host 429
renaming folder 430
viewing 427
Enterprise Summary report 378
environment variable 419
GST_DEBUG 702
GST_MAXLOGSIZE 419, 702
GST_MAXLOGVERS 419, 702
setting 419
environment variables
format 464
NSR_DEV_BLOCK_SIZE_MEDIA_TYPE 262, 267
NSR_DEV_LOAD_POLL_INTERVAL_MEDIA_TYPE
268
NSR_DEV_LOAD_TIME_MEDIA_TYPE 268
NSR_DEV_LOAD_TRY_TIMEOUT_MEDIA_TYPE
268
NSR_DEV_TAPE_FILE SIZE_MEDIA_TYPE 267
NSR_DEV-DEFAULT_CAPACITY_MEDIA_TYPE
268
error
database store 700
relocating data 672
RPC (remote procedure call) 672
error messages 699
copy violation 674
destination component 678
disk label 673
environmental variables 698
hardware address not found 749
illegal record size 668
media verification 667
no space left in tape 754
nwrecover program 670
print server 451
RPC errors 692

save sets 670
server, unavailable 692
xview 674
Event Control Block (ECB) 667
event logs
backup 736
explained 736
not in SYSTEM save sets 710
recover 736
Event Time 377
Event Viewer 452
example
organizing hosts 426
sorting managed event 40
export command 420
export formats 384
exporting
non-ASCII characters 384
reports 384
external authentication to LDAP server 406

F
failed
operation 700
failed operation 699
failover, save group requirements 495
FAT16 partitions, ASR limitation 586
fetch operation 699
Figure 105
file conversion, sparse to fully-allocated 675
file handling
indicators 46
file index missing, message 671
File Manager 670
File Replication Service
backup 736
SYSTEM STATE save set 708
filemarks 679
filename, support for short names 84
files
compressing 78
encrypting 77
HOSTS 446
log 701
naming conflicts on recovery 322
open files, backing up 139
relocating during recovery 323
servers 487, 687
verify 69
filesystem devices 236
filesystems
backups, large 485
firmware, verification 683
folder 426
adding 429
deleting 429
editing 430
Force Incremental attribute 144
force incremental attribute 136
formats
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export 384
full backups 149

G
grooming 210
limitation 210
grooming files 204
group
backup, stopping 396
restarting backup 396
start immediately 395
viewing control details 396, 400
viewing status 394
Group resource
groups 130
attributes 133
backup operators 446
backups
management 137
previewing 137
bootstrap 138
client policies, multiple 164
completed 138
containing bootstrap 668
defined 130
filesystems, large 143
force incremental, setting 136
listing of per server 394
naming restrictions 668
NetWorker User program privileges 44
operations
copying 135
deleting 135
editing 134
previewing 137
time intervals, setting 135
types 133
gst command 51
GST server process 702
GST_DEBUG 702
GST_MAXLOGSIZE 419, 702
GST_MAXLOGVERS 419, 702
gstd 702
environment variable 419
log 416, 419, 702
process 51
size of log 416, 419, 702
gstd log file 702
gstd service 50
gstmodconf command 431, 432

H
hard links, backup and recovery 85
hardware
upgrade 413
HomeBase Server 655
host
adding 428
copying 429
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deleting 428
managing 428
moving 429
organization of 426
transfer affidavit 415
Host List 378
host name determination
DHCP clients 446
TCP/IP 446
Host Reports 355
types and their configuration 378
hostname alias 669
hostname file 431
HOSTS file 446
hosts table, setting up 689
How 358
HP MC/ServiceGuard
clusters 496
HP Tru64 See Tru64. 752
HP-UX
creating device files 748
EMC AutoStart, using with 494, 497
installing autochangers 747
pass-through drivers 747
HTML 384
HTTP service port 39
hung browser 699

I
icon
annotation 391
priority 390
IIS (Internet Information Server)
defined 736
recovery prerequisites 346
SYSTEM STATE save set 708
Importing save set information to a different server 340
Inactivity Timeout attribute 133
incremental backup
NDMP limitation 544
incremental backups
pool for 189
Index Save Sets dialog box 456
indexed archives 206
individual user authentication 417
info priority 390, 398, 401
information, sorting table 40
inquire program 531, 746
install log 701
Interactive view 360
interface
overview 36
Internet Information Server See IIS
Interval attribute 133
Invalid Object id, error message 700
ioscan program 747
IP
errors
hosts table 689
troubleshooting 689
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name search order, setting 690
IP configuration, issues 694
IPAT (IP address takeover) 495

J
Java Runtime Environment 386
JavaScript 703
jbconfig program
autochangers
HP-UX 750
clusters 509
hanging 678
jbexercise program
NDMP, not supported 526
jobsd service 50
JRE 39, 385, 386
Jukebox parallelism 438

L
label templates
attributes 199
components 200
creating 200
deleting 201
editing 201
naming restrictions 668
naming strategies 199
number sequences 199
preconfigured 197
labeling
tips 200
labels
silos, volumes 197
launch button 39
lcmap, improving performance of 516
LDAP login authentication 406
level of debug 416, 419
Library parallelism 438
license
adding 423
deleting 423
License allocation failed, error 700
License Manager 424
licensing
archiving 204
copy violation 674
License Manager 424
Linux, EMC AutoStart, using with 494, 497
list command 561
List Report, User 378
LMHOSTS 446
load balancing 253
local backups with NDMP
introduction 521
localized environments 359
location of
gst command 51
lockbox for pass phrases 475
log file 419, 701, 702

log files
backup/recovery attempts 85
cloning information 218
management 463
viewing 661
logging on
to Console software 39
logging, events 452
login
authentication 406
name 408
password 408
lsdev program 748

M
Mac OS X 756
managed application 426
managed event
define 388
deleting note 391
disabling capture of 389
disappearing 392, 701
polling 416
priority 390
response time
modifying 416
sorting example 40
Managed Event configuration
parameters 377
Managed Event drill-down reports 377
Managed Event Reports 355
Managed Events button 37, 38
managed node 426
adding 428
copying 429
deleting 428
moving 429
managing
host 428
license 424
manual backups 80
manual backups. See backups, manual 54
Manual Restart option 495
Many 716
Max active devices 438
Max parallelism, media libraries 438
Max parallelism, pools 440
Max sessions 440
MC/ServiceGuard
clusters 496
media database
backups 150
cloned data 226
clones and storage nodes 231
compression 460, 462
cross-checking 457
entries, removing 461
managing size 454, 460
restoration 339
retention policies 158
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save sets, entries 161
Media Library parallelism 438
media pools. See pools
media position errors 667
memory
NDMP requirements 526
message attribute of managed event 390
message logs
failed backup/recovery attempts 85
management 463
reducing size 463, 464
message retention 353
messages file
Event Viewer 452
Microsoft Automated System Recovery. See Automated
System Recovery
Microsoft Windows
backup operators group 446
Event Viewer 452
Windows 2000
databases
not in SYSTEM save sets 710
SYSTEM DB save set 710
Windows Management Instrumentation
SYSTEM DB save set 710
Mirapoint
requirements 566
mminfo program
reports 168
modifying
log size 419
response time 416
user 412
modules
NDMP 538
moving host 429
multiple hosts
adding or deleting 431
Multiplexing 439
multiplexing
performance issues 32

N
name
conflicts on recover 322
folder, editing of 430
resolution cross-platform 446
servers, issues 695
name resolution 690
name servers, disabling 690
naming restrictions 668
native login authentication 406
NDMP (Network Data Management Protocol) 520
application information variables 537
archives 526
Auspex
autochanger handle 565
autochangers
configuration 531
list command 561
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sysconfig program 558
backups
command line options 539, 540
parallel 525
bootstrap limitation 525
changing location of temporary space directory 527
clients
definitions 525
configuration
NetWorker server 529
options 520
Sun StorageTek EBS server 529
device pathname 530
directed recoveries 549
EMC Celerra
autochanger handle 561
EMC IP4700
autochanger handle 563
Force Incremental setting 545
incremental backup limitation 544
inquire program 531
memory requirements 526
NetApp
autochanger handle 558
NetWorker
changes with NDMP 526
index database 527
index processing and memory requirements 526
nsr resource attributes 526
operations
browsing 526
recoveries 545
recoveries, directory level 546, 547
prerequisites 538
protocol limitations 526
save set operations
consolidation 526
recovery 526
savegroup Parallelism setting 538
scanner program 526
sharing autochangers 533
silo support 534
storage node support for NDMP client backup 542
storage node support for NDMP clients 528
temp storage space requirements 527
Nested Mountpoints 347
network
DNS connection issues 694
IP configuration issues 694
TCP/IP certified 694
NetWorker 447
clustering
clients
backup 493
interfaces 47
NDMP
effects on 526
server
organization of 426
startup commands 665
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User program. See NetWorker User program
virtual server backup 493
NetWorker Backup Statistics drill-down reports 368, 373
NetWorker Backup Statistics Reports 355
NetWorker Backup Statistics reports
types and their configuration 367, 373, 375
NetWorker Backup Status drill-down report 370
NetWorker Backup Status Reports 355
NetWorker Backup Status reports 368
NetWorker client
definition of 470
NetWorker DiskBackup
advanced file type concurrent operations 250
file type and advanced file type differences 244
notification 252
retention policy 252
NetWorker Management Console See Console
NetWorker server
organizing 426
NetWorker User program
backing up registry, Windows NT 67
browse windows 45
changing servers 46
compression 78
connecting to a server 46
encryption 78
manual backups 65
overview 44
password protection 78
privileges 44
server connection 46
starting 44
toolbar 45
NMC See Console
node
adding 428
copying 429
deleting 428
managed 426
moving 429
nonindexed
archives 206
note
attribute 390
deleting from managed event 391
notifications 453
defined 447
deleting 454
operations
customizing 449
preconfigured 447
printing 450
priorities 451
programs 450
SNMP
configuring 572
creating 573
modifying 573
nsrtrap 572
nsr_getdate program 167, 168

nsr_render_log 661
nsr_shutdown program 464, 667
nsradmin program
editing the nsrla.res database 472
starting 48
nsrarchive program 205
nsrauth authentication 476
nsrck program 337
nsrd daemon 464
nsrd service 49, 464
nsrexecd 51
nsrexecd daemon 464
nsrexecd service 49, 464
nsrindexd service 49
nsrjb program
troubleshooting, HP-UX 750
nsrla.res database 472
nsrlpr program 450
nsrmm program 168, 339, 459, 668
nsrmmd daemon 268
NDMP
unsupported options 526
nsrmmd service
NDMP
unsupported options 526
nsrmmdbd service 49
nsrmmgd service 49
nsrndmp_recover program 545, 546, 547
nsrndmp_save program 542
backing up data 539, 540
nsrssc program 155
nsrtrap 572
command line options 528, 572
verbose mode 573
numeric order 40
nwrecover program 47, 214
browse policy 158

O
object, reference 700
OEM recovery CD, ASR limitation 586
offline disaster recovery, Windows 595
oldauth authentication 476
online indexes
cross-checking 457
entries
checking 455, 671
removing 455, 461
information
refreshing 457
viewing 455
management
manual 454
size 459
moving 459
recovery
location 668
restoration 338
save sets, viewing 456
size considerations 455
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volumes
removing 461
OnNow
Advanced Configuration and Power Interface (ACPI)
740
recover considerations 741
scheduled backup considerations 741
open files, backing up with VSS 140
operation failed 699, 700
optimizing Console 415
organizational criteria 426
organizational structure, labeling for 200
organizing
NetWorker Servers
example 426
out of memory 699

P
page cannot be displayed 700
Parallelism 437
parallelism
performance 32
password
changing 412
pathname restrictions 670
Path-to-Tape support 553
PDF report format 384
performance
features 32
Performance Counters
SYSTEM STATE save set 708
performance of Console software 415
permissions
Archive feature 206
backup operators group 446
Persistent binding 270
Persistent naming 270
pie chart 364
pie report format 364
plot chart 364
policies 165
backups, manual 167
browse
about 157, 158
data life cycle 162
defined 158
modifying 168
usage 158
clients 164
data life cycle 162
multiple 164
naming restrictions 668
overriding 167
planning 143
retention 160
about 157, 158
data life cycle 162
defined 158
modifying 168
usage 158
800

volume relabeling 158
setting expiration 354
policy
deleting 165
polling 416
pool
configuration 613
consolidated backup 187
copying resource 196
Pool parallelism 440
Pool Type attribute, with archive pools 207
pools
archive 190
errors 697
archives, creating 196
archiving 196
bootstrap 186
client file index 186
clones 190
configuration
archive 190
clone 190
creating 191
criteria 185, 187
data sorting 185, 188
default 184, 188, 189
clone pool 190
defined 184
devices 190
editing 195
expression matching 186
incremental backups 189
manual backups 189
precedence 187
restrictions 185
save set consolidation 155
sorting data 190
volume labels 197
port
HTTP service 39
port range
troubleshooting 696
portmappers
verifying 691
POSIX hard links, problems recovering 85
PostScript report format 384
Power Monitor service 740
precedence for pools 187
preconfigured notifications 453
priorities, notifications 451
priority
of managed event 390
symbol 390, 398, 401
Priority attribute 389
privileges
administrator 433
probe based backups 69
problem
contacting server 699
process, stopping and restarting 51
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processor load 416
Procom NetFORCE
requirements 565
Program not registered 700
program not registered 700
programming thread 416
properties
user 412
Properties dialog box
NetWorker User program 46
protocols, certified 694
provider 645
ps command 703

R
rearranging enterprise hierarchy 429
rearranging information in table 40
Recover button 45
recover program
clusters, using with 503
media database 161
options 334, 335
retention policy 160
recoveries 317
archives 212
Backup and Recover Server services 446
backup operators group 446
client file index 337
clients, renamed 671
clone volumes 227
cluster 502
conflict resolution 322
conflicts 321
directed 336
access 331
advantages 330
defined 329
recover program 334, 335
usage 330
disaster-related 329
failed 85
failure 670
files, finding for recovery 324
hard links created by POSIX 85
index-based
advantages 316
interrupted backups, from 670
log file 85
methods, comparing 316
NDMP 545, 546, 547
NetWorker User program
browse windows 45
planning 143
relocation 323
save set recovery 325
save sets
client file index 338
media database 339
type, determination 316
volumes

required 324
recovery
aborting 672
ASR 590
recycling. See volumes
reference object 700
refused connection 699
registering program 700
registry
backups 737
backward compatibility 737
explained 737
REGISTRY save set 737
SYSTEM STATE save set 708, 737
relocating data 672
remote access
recoveries 687
Remote Access list 687
remote archives, failure 696
remote backups with NDMP TapeServer software
performing 569
Remote NDMP backups with DinoStor TapeServer
performing 568
remote NDMP backups with SnapImage software
performing 569
Removable Storage Manager
recovery prerequisites 346
SYSTEM DB save set 710
removing
folder 429
host 428
license 423
user 411
renamed directories, backing up 60, 96
renaming folder 430
report
background processing 366
chart types 363
document mode 362
export formats 384
interactive mode 360
restricted views 366
User List 378
reports
basic and drill-down 356
command line reporting program 385
customized 357
daemon log file 463
daemon.log 464
date and time formats 358
Managed Event Drill-Down 377
message logs
management 463
reducing size 463
save set policies 168
saved 381
viewing 360
Reports button 37, 39
requirements
NetWorker User groups 44
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resetting administrator password 412
resolved events 391
resource
archive
changing archive time 211
request
copying 211
status 394
label template
copying 201
notification
copying 453
deleting 454
policy
deleting 165
pool
copying 196
directing data from consolidated backup 187
staging
copying a policy 238
user group
copying 445
creating 444
customizing privileges 443
deleting 445
editing 445
preconfigured 442
resources
configuring for NDMP 529
response time
managed event 416
Restart Window attribute 133
restrictions on pathnames 670
retention policies 160
about 157, 158, 160
clones, storage nodes 231
defined 158
usage 158
volumes, relabeling 158
retention, completion data 353
retention, completion message 353
retention, save set 353
retrieval
annotations, empty 697
troubleshooting 696
retrieving archives 212
retrieving save sets 212, 213
RPC (remote procedure call)
errors 672
rpcinfo program 691

S
save program 87, 167, 168, 503
save set
All save set 62
Save Set Data Retention
and NetWorker Backup Statistics Reports 368
Save Set Details 369
Save Set Name 369
save set retention 353
802

save sets
archives, retrieving 212, 213
backup commands 86
backups 485
client combination 485
client file index, entries 161
client priority 487
cloning
described 219
manually 225
status 223
consolidation
files, large 153
limitations 154
NDMP 526
nsrssc command 155
pools 155
usage 153, 154
defining 485
indexes, viewing 456
information, viewing 456
load balancing 485
media database, entries 161
multiplexing 439
policies
modification 168
reports 168
predefined 61
recoveries 325, 326, 327
client file index 338
conflicts 327
media database 339
NDMP 526
online indexes 338
relocating 327
requirements 326
usage 325
volumes 327
recovery
compared to index-based recovery 316
REGISTRY, backward compatibility 737
staging. See staging
status
clone 223
retention policy 160
suspected 228
SYSTEM
manual backups 65
point-in-time recovery
command prompt 344
recover
command prompt 343
SYSTEM DB
backup levels 152
basic components 710
databases not included 710
recovery prerequisites 346
SYSTEM FILES
backup levels 152
basic components 709
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SYSTEM STATE
backup levels 152
basic components 708
optional components 708
recovery prerequisites 346
VSS ASR DISK
backup levels 153
components 714
VSS OTHER
backup levels 153
components 714
VSS SYSTEM
manual backups 65
point-in-time recovery 344
VSS SYSTEM BOOT
backup levels 152
components 712
VSS SYSTEM FILESET
backup levels 153
components 712
VSS SYSTEM SERVICES
backup levels 153
components 713
VSS USER DATA
backup levels 153
components 714
savegroup completion report 448
Savegroup parallelism 438
savegrp program
backup limitation 674
save set consolidation from command line 155
savepnpc program
message logging by 94
using with customized backup program 91
savepsm 79
savestream 184
scalability 33
SCANDISK, running 65
scanner program
NDMP 526
record size 668
recovering clone volumes 227
recovering save sets from volumes 163
recreating online indexes 327
recreating volume entries 327
retention policy 160, 161
volumes, read-only 668
Schedule attribute 133
Schedule resource 130
schedules 140
attributes 144
backup cycle 141
balancing 143
copying 145
default 141, 142
deleting 145
editing 145, 155
large filesystems 143
load balancing 485
naming restrictions 668

overriding 145
planning 143
preconfigured 141
staggered 142
usage 140
Schedules window 144
scheduling backups 79
SCSI address selection for HP-UX 747
SCSI ID 106
security
application authentication 476
backup server access 440
backup server user groups 442
console server users 406
lockbox for pass phrases 475
login authentication 406
overview of settings 769
server
problem contacting 699
setting up 433
web address 39
server name
attribute of managed event 389
Server parallelism 437
servers
address, changing 695
administrators
adding 441
backup
operators Group 446
client/server communication errors 689
clients
tasking rights 486
DCHP 446
DNS name resolution 446
dynamic addressing 446
errors, binding to 692
file 487, 687
index
backup, failure 674
management 454
notifications
priorities 451
ping command, testing 691
testing 691
service
gstd 50
jobsd 50
nsrd 49
nsrindexd 49
nsrmmdbd 49
nsrmmgd 49
port, HTTP 39
services
Backup and Recover Server 446
described 49
Power Monitor service 740
session management 32
sessions
lists of backup, recover, or browse sessions 394
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Setting 354
setting
data retention policies 354
environment variable 419
expiration policies 354
severity of managed event 389
shadow copy 644
short filename support 84
silos
NDMP support 534
Simple Network Management Protocol. See SNMP
size of
gstd log 702
log file 419
sleep state
defined 740
SnapImage
autochanger handle 568
snapshot 644
snapshot policy
creating 166
SNMP (Simple Network Management Protocol) 572
configuring 572, 574
defined 572
notifications
configuring 572
creating 573
modifying 573
nsrtrap 572
traps 572
Software Administration button 37
Solaris
EMC AutoStart, using with 494, 497
troubleshooting 744
unsupported devices 744
sorting managed event, example 40
sorting table 40
Source Client dialog box 325, 326, 327, 328
sparse files 737
not in SYSTEM save sets 710
sparse files, converting 675
Special Handling dialog box 78
stacked bar report format 364
stacking bar chart 364
staging
defined 236
filesystem devices 236
policies
creating 236
deleting 239
editing 238
to cloud 125
Start Time attribute 133
starting
server process 51
status
viewing
group status 394
status values, scanned-in 338
stopping Console server 51
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storage nodes
affinity
problems 697
clusters
startup script 506
virtual storage nodes, support 506
timeouts 698
troubleshooting 697, 698
virtual server 506
Store Index Entries attribute, with archive pools 208
storing database failed 700
support
for firewall 716
suspected save sets 228
symbolic links
Tru64 752
symptom of problem 699
sysconfig command 558
System File Protection
backup 709
defined 709
explained 709
recover 709
SYSTEM FILES save set 709
system standby 740
SYSVOL
SYSTEM STATE save set 708

T
tables
display or hide columns in 41
multicolumn sorting 41
rearranging columns 40
sorting 40
Target sessions 439
TCP/IP
certification 694
changing NetWorker server address 695
DHCP clients 446
host name determination 446
troubleshooting hostname alias problems 669
technical support, troubleshooting information 660
temporary enabler code
expired 699, 700
temporary notes 390
Terminal Services Licensing
recover
prerequisites 346
This 677, 747
thread, programming 416
three-party NDMP backups
introduction 524
performing 540
time attribute of managed event 389
time range 358
Together 130
toolbars
User program 45
tracking
cloned data 226
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online index information 454
traps
categories 574
SNMP 572
troubleshooting 416, 419
aborted recover 672
AIX
STK-9840 752
archive pools 697
archive requests
naming 697
archives 696
multiple save sets 697
nsrarchive program 697
remote request failure 696
auto media verification 667
autochangers
AIX considerations 752
attributes 677
autodetected scsi errors 678
control port access 680
destination component 678
HP-UX 750
HP-UX considerations 749, 750
maintenance 678
backups 665
backups levels 670
backups, stopping 666
bootstrap printing, failure 674
client file index
size growth 671
clients
alias 669
Solaris, location 744
connectivity issues 695
daemons 665
devices
maintenance 678
nonrewinding 681
Solaris, unsupported 744
disk label errors 673
DNS connection problems 694
DNS hostname alias 669
ECB counter 667
file conversion 675
firmware 683
hosts table 689, 691
HP-UX
error messages 749
SCSI pass-through driver 750
unloading drives 750
unsupported media 750
illegal characters 668
IP configuration issues 694
IP errors 689
IRIX 754
licensing, copy violation 674
name resolution 690
name server issues 695
name servers, disabling 690

nsrexec processes 665
online indexes 668
packet receive buffer 667
pathname restrictions 670
port range configuration 696
portmappers, verifying 691
recoveries 665
interrupted backups 670
new installation 670
online indexes 668
remote access 687
recovering POSIX hard links 85
renamed client backups 671
retrievals 696, 697
routers 683
rpcinfo command 691
scanner program 668
server errors, binding to 692
server index 674
Solaris 744
storage nodes 697, 698
technical support information 660
Tru64
restoring symbolic links 752
xview errors 674
Tru64
symbolic links 752

U
uasm program 668
unresponsive browser 699
URL
Console software 39
user
authentication 417
deleted 383
deleting 411
editing 412
properties 412
user authentication 417
user datagram protocol
disabling 417
user groups 442
creating 444
privileges 443
user interface
overview 36
setting preferences 43
User List Report 378
user privileges 44
User Reports 355
user roles in Console server 406

V
vanishing managed event 701
variable
case sensitivity 419
for gstd log 702
GST_DEBUG 702
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GST_MAXLOGSIZE 419
GST_MAXLOGVERS 419, 702
setting 419
verification
NetWorker User program
browse windows 45
of files 69
Verify button 45
verifying ASR recovery 593
versions of the gstd log file 419
view
document view 366
viewing
annotation 391
enterprise hierarchy 427
reports 360
VMware 654
volume pool
See also pools
archive 204
defined 184
Volume Shadow Copy Service
commands 650
controlling from Administration window 647
controlling from command-prompt 649
controlling from NetWorker client 648
limitations with Microsoft Exchange Server 318
limitations with Microsoft SQL Server 318
overview 644
writers 646
volumes
archive 229
client file index
removing 461
cloning 227
archive data 229
creating 227
recovery 227
labeling 197
maximum size 200
tips 200
modes
types 291
nonrewinding 681
recoveries, required for 324
recycling 460
relabeling 288
removing 460
save sets
recoveries 327
verify 69
VSS. See Volume Shadow Copy Service
VTL
path-to-tape support 553

unresponsive 699
Console
server name 39
Windows disaster recovery
2003, XP 583
2008, 2008 R2, Windows 7 595
WINS (Windows Internet Naming Service) 446
WINS (Windows Internet Naming Service) database 83,
348
Wizard
Console Configuration 420
wizard
client backup configuration 55
device configuration 247
writer 646

X
xview, errors 674

Z
zone, control 426

W
waiting priority 390, 398, 401
warning priority 390, 398, 401
web
browser
806
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